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Bem-vindo ao
Autodesk Navisworks
Manage 2012

O software Autodesk Navisworks Manage 2012 é uma solução completa de revisão
de projeto para análise, simulação e comunicação da intenção do projeto e da
capacidade de realizar construção. Dados de projetos multidisciplinares criados em
aplicativos de modelagem de informações de construção (BIM), protótipo digital e
projeto de plantas de processo podem ser combinados em um único modelo de
projeto integrado. As ferramentas de gerenciamento e detecção de interferências
ajudam os profissionais de projeto e construção a prever e evitar problemas em
potencial antes de começar a construção, minimizando atrasos e retrabalho
dispendiosos. O Navisworks Manage combina coordenação espacial com o
planejamento do projeto para entregar uma simulação 4D e análise. Modelos de
projeto inteiros podem ser publicados e visualizados livremente nos formatos NWD
e DWF™.

O que há de novo nesta versão?
O Autodesk Navisworks Manage 2012 contém muitos novos recursos e
aprimoramentos.

Instalação

A tela de instalação fornece links para as opções de instalação, opções de
implementação, ferramentas e utilitários de instalação. Você também tem a
opção de selecionar leitores de arquivos DWG que requerem a instalação, além
dos plugins do exportador que deseja instalar e o visualizador do Autodesk
Navisworks Freedom.

1
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Interface do usuário

Acesso fácil às ferramentas de navegação e revisão mais usadas para aumentar
a produtividade da revisão.

■ A guia Viewpoint agora inclui o painel Navigate, fornecendo acesso a
ferramentas como Navegar, Pan, Zoom e Órbita, os menus de rastreamento
SteeringWheels, o mouse 3D 3Dconnexion e as configurações de
realismo.

■ Os gizmos foram atualizados, tornando mais fácil manipular objetos e
planos de corte.

■ Os planos de corte também foram aprimorados para fornecer melhor
feedback visual de sua posição e orientação.
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■ Os conjuntos de seleção agora podem ser criados de forma mais rápida

com a adição da opção Save Selection  (Salvar seleção) (guia Home
painel  ➤ Select & Search).

Appearance Profiler

O Appearance Profiler permite definir perfis personalizados de aparência
com base em conjuntos (pesquisa e seleção) e valores de propriedade e usá-los
para codificar em cores os objetos no modelo para diferenciar os tipos de
sistemas e identificar visualmente seu status. Os perfis de aparência podem
ser salvos e utilizados em outros projetos ou compartilhados entre outros
usuários do Autodesk Navisworks.

Consulte Appearance Profiler na página 467.
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TimeLiner

A ferramenta TimeLiner foi aprimorada para fornecer mais controle e
flexibilidade ao trabalhar com simulações 4D. Uma nova interface e um gráfico
de Gantt editável e integrado permitem criar, editar e comunicar seu
planejamento de construção de forma mais eficaz. A nova API do TimeLiner
permite estender e ajustar o conjunto de ferramentas 4D para atender aos
requisitos de projeto e de negócios.

■ Agora, as guias Tasks, Gantt View e Rules estão consolidadas em uma
única guia Tasks.

■ Um seletor de colunas permite selecionar seu layout de grade preferencial
entre três opções padrão ou escolher suas próprias colunas.
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■ O Gantt Chart (Gráfico Gantt) interativo permite manipular datas no
planejamento arrastando e posicionando tarefas, datas iniciais e datas
finais.

■ Uma visualização de Gantt agora está disponível durante as simulações 4D
na guia Simulate.

■ A habilidade de adicionar e editar tarefas rapidamente no planejamento
do projeto.

■ A habilidade de filtrar tarefas por seu status.

■ A habilidade para importar/exportar regras do TimeLiner para reutilização.

■ Nova API .NET do TimeLiner. Agora, usando a API, é possível obter uma
lista de tarefas, dos tipos de tarefas, dos tipos de simulação e das origens
de dados; adicione, edite e exclua tarefas, tipos de tarefas, tipos de simulação
e origens de dados e modifique suas propriedades; inscreva-se em eventos
que serão acionados quando a interface gráfica de usuário ou outros usuários
da API efetuarem alterações nas tarefas, nos tipos de tarefas, nos tipos de
simulação e nas origens de dados.

Consulte Visão geral da ferramenta TimeLiner na página 647.

Clash Detective

A ferramenta Clash Detective tem um número de aprimoramentos para
oferecer um melhor gerenciamento das interferências até sua resolução. As
ferramentas de fluxo de trabalho permitem atribuir a propriedade das
interferências e as ferramentas aprimoradas de relatório fornecem um resumo
do lote do status das interferências e a habilidade de exportar um relatório
formatado para uso direto no Microsoft® Excel. Uma melhor visualização das
interferências é suportada por uma nova vista de estrutura de arame e pela
operação Focus on Clash (Foco na interferência).
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■ Novo atributo de interferência Assigned To, que permite atribuir as
interferências e os grupos de interferências a um indivíduo ou negócio,
além de controlar as interferências por meio da lista Results (Resultados)
e de Clash Reports (Relatórios de interferências).

■ Agora, as informações de resumo dos status de resultado para cada um dos
testes de interferência são exibidas na guia Batch (Lote).

■ Agora, as informações de resumo do teste de interferência são exibidas na
parte superior das guias do Clash Detective.

■ Notificação automática de todas as alterações do modelo que podem
invalidar os resultados das interferências.

■ Novo relatório tabular de interferências em HTML, que pode ser aberto
diretamente no Microsoft Excel.

■ A opção para visualizar os resultados de interferências utilizando o modo
de estrutura de arame.

■ A habilidade de redefinir um ponto de vista para focar nos resultados de
interferência novamente.

Consulte Visão geral da ferramenta Clash Detective na página 711.

Suporte a formatos de arquivo da Autodesk

Agora, o Autodesk Navisworks oferece suporte a DWF 2D e DWF de várias
folhas, permitindo que você abra, revise e explore os conjuntos de dados 2D
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ao lado de seus modelos 3D. Importante: a vista 2D é integrada ao ambiente
3D. Ele permite selecionar um componente no modelo 3D e, a seguir, localizar
e revisar o mesmo componente em uma representação 2D (como uma planta
baixa ou corte), fornecendo a você a visualização mais apropriada dos dados
para a tarefa que está executando. Ao trabalhar com o formato de arquivo de
visualização FBX, agora é possível obter uma transferência precisa de materiais,
texturas e luzes ao importar ou exportar dados entre o Autodesk Navisworks
e outros aplicativos compatíveis com FBX.

■ Suporte para abrir arquivos DWF e DWFx 2D/3D. Consulte o Leitor de
arquivos DWF na página 192.

■ Suporte para exportar arquivos DWFx e DWF 3D. Consulte Exportar
arquivos DWFx/DWF 3D na página 524.

■ Suporte a arquivos de múltiplas folhas. Consulte Arquivos de múltiplas
folhas e 2D na página 228.

■ Suporte à associação de objetos 2D/3D. Consulte Localizar todas as folhas
e os modelos que contêm o objeto selecionado na página 381.

■ Suporte a materiais consistentes de FBX para iluminação, materiais e
texturas. Consulte Leitor de arquivos FBX na página 849.

Suporte estendido para Revit

Diversos aprimoramentos de interoperabilidade para os fluxos de trabalho do
Revit/Autodesk Navisworks aumentam a produtividade ao trabalhar com os
dois aplicativos.

■ O SwitchBack do Revit permite que você faça a transição rapidamente entre
as vistas no Autodesk Navisworks e no Revit que facilita a navegação e a
localização dos elementos. Consulte SwitchBack do Revit na página 466.

■ Suporte para modelagem de construções do Revit permite passar as peças
da construção no Autodesk Navisworks para simulação 4D.

■ Suporte para arquivos vinculados do Revit.

■ Suporte para regiões divididas do Revit.

■ Suporte para propriedades do Revit, incluindo áreas, volumes e pontos.

O que há de novo nesta versão? | 7



Consulte Exportador de arquivos Revit na página 214.

Integração ao Vault

O Autodesk Navisworks agora oferece integração ao conjunto de ferramentas
de gerenciamento de dados do Autodesk Vault. O Autodesk Vault oferece um
ambiente amplo para gerenciar o grande volume de dados que é gerado em
seus projetos.

■ Recupere/salve os dados.

■ Faça check-in/check-out dos dados.

■ Gerencie a criação de versões de arquivos e o relacionamento entre os
arquivos NWF e os dados de projeto.

Consulte Utilizar o complemento Autodesk Vault na página 767

Aprimoramentos gerais de integração

■ Suporte para arquivos .skp do Google SketchUp v7 com compatibilidade
inversa.

8 | Capítulo 1   Bem-vindo ao Autodesk Navisworks Manage 2012



■ Agora, o TimeLiner oferece suporte para os serviços Web do Primavera
P6 v7.

■ Suporte para os formatos de arquivo .prt, .asm, .g e .neu do Pro/Engineer.

■ Suporte ao servidor da nuvem de ponto. O Autodesk Navisworks agora
suporta a recuperação de dados de mecanismos externos da nuvem de
ponto para exibir no modelo do Autodesk Navisworks. A ferramenta é
criada como uma extensão da API do NWCreate existente. Um exemplo
genérico simples e um exemplo personalizado que demonstrem conexão
com o servidor LFM Z+F estão disponíveis dentro dos recursos da API do
NWCreate.

Aprimoramentos do Autodesk Navisworks Freedom 2012

■ Agora, a guia Review contém o acesso a um campo de suporte a
ferramentas Measure para dimensionamento e cálculo da área.

■ Agora, é possível abrir arquivos 2D DWF e DWF de várias folhas, bem como
arquivos NWD.

■ Uma visualização Gantt agora está disponível durante as simulações 4D
do TimeLiner.
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Aprimoramentos diversos

■ Suporte aprimorado para o mouse 3D

■ por meio de uma interface estendida. Consulte Mouse 3D 3Dconnexion
na página 321.

■ O Centro de comunicações agora suporta atualizações em tempo real.

■ Novos avatares a serem utilizados em uma variedade de funções, variando
operários de construção e profissionais de segurança até funcionários do
escritório. Já que os avatares podem variar de acordo com o ponto de vista,
você pode exibir, com facilidade, como os interessados no projeto irão
interagir em uma determinada fase do projeto no contexto relevante.

■ Implementação contínua da API .NET do Autodesk Navisworks.
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Como obter Ajuda
Há diversas maneiras de se encontrar informações sobre como usar este
programa e múltiplos recursos estão disponíveis.

Encontrar informações utilizando o
InfoCenter

É possível utilizar o InfoCenter para pesquisar o arquivo de Ajuda do Autodesk
Navisworks para obter informações. Também é possível acessar com facilidade
atualizações e avisos de produtos.

Visão geral do InfoCenter

Você pode utilizar o InfoCenter para procurar ajuda relacionada ao produto,
exibir o painel Subscription Center para os serviços de assinatura, exibir o
painel Centro de comunicações para os avisos e as atualizações de produtos e
exibir o painel Favoritos para acessar os tópicos salvos.

É possível usar o InfoCenter para:
■ Pesquisar informações na Ajuda principal do produto através de

palavras-chave (ou inserindo uma frase)

■ Acessar os serviços de assinatura através do painel "Subscription Center"

■ Acessar as atualizações e os avisos relativos a produtos através do painel
"Communication Center"

■ Acessar os tópicos salvos através do painel "Favorites"

Para exibir a caixa InfoCenter em um estado retraído, clique na seta à sua
esquerda.
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Para reorganizar os tópicos exibidos no painel.

1 Exiba um painel ao efetuar um dos seguintes:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique e arraste um cabeçalho de categoria ou grupo para a posição
desejada.

DICA Para manter os painéis Subscription Center, Centro de comunicações
e Favorites expandidos, clique no ícone de pino no canto inferior direito do
painel.

OBSERVAÇÃO É possível organizar as categorias em um grupo, mas não é possível
movê-las para outros grupos.

Procurar por informações

É possível inserir palavras-chave ou uma frase na caixa InfoCenter para
pesquisar informações.

Quando você insere palavras-chave ou uma frase na caixa InfoCenter, você
procura o conteúdo do arquivo principal de ajuda do Autodesk Navisworks.

Pesquisas por palavra-chave produzem melhores resultados. Os resultados são
listados na guia Help Search. Clique em um tópico para exibi-lo na Ajuda.

Quando você utiliza o InfoCenter para procurar por informações, poderá
utilizar os seguintes símbolos especiais em sua consulta para efetuar seu ajuste
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fino ou expandi-la. Estes símbolos podem ser usados sozinhos ou podem ser
combinados.

DescriçãoSímbolo

Substitui um ou mais caracteres quando usado no começo, meio
ou fim de uma palavra. Por exemplo, “*lish”, “p*lish”, e “pub*” irá

*

encontrar “publish”. Também, “anno*” irá encontrar “annotative”,
“annotation”, “annoupdate”, “annoreset”, e assim por diante.

Substitui um único caractere. Por exemplo, “cop?” irá encontrar
“copy”, mas não “copybase”.

?

Adiciona formas de variações gramaticais em uma palavra-chave,
quando adicionada no início ou fim de uma palavra. Por exemplo,

~

“plotting~” irá encontrar “plots”, “plotted”, e assim por diante.
Também, “~plot” irá encontrar “preplot”, “replot”, e assim por
diante.

Ao executar uma pesquisa pela frase exata, utilize aspas (" ") para incluir
palavras que precisam aparecer perto uma das outras na seqüência de texto
especificada. Por exemplo, insira "especificar unidades de medida" para
encontrar somente os tópicos com todas estas palavras nesta ordem. Também
é possível utilizar os símbolos previamente mencionados em uma seqüência
de texto entre aspas duplas.

Para pesquisar o principal arquivo de ajuda para obter informações

1 Na caixa InfoCenter, insira uma palavra-chave ou frase.

2 Clique no botão Pesquisar.

O arquivo de ajuda principal é aberto e os resultados da pesquisa são exibidos
na guia Help Search.

Acessar o Subscription Center

O Subscription Center exibe links para informações sobre os serviços de
assinatura, como aprimoramentos do produto, suporte na web personalizado
dos técnicos da Autodesk e e-Learning de ritmo próprio.
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Se você for um membro de assinatura, poderá acessar os serviços de assinatura

ao clicar no botão Communication Center  na caixa InfoCenter, e a
seguir clicando no link Subscription Center. Para aprender mais sobre
membros de assinatura Autodesk, visite
http://www.autodesk.com/subscriptioncenter.

Sobre o Subscription Center

Com o Autodesk Subscription, você obtém as versões recentes do software da
Autodesk, aprimoramentos incrementais do produto, suporte da Web
personalizado por técnicos especializados da Autodesk e aprendizado eletrônico
autodidático. Os serviços de assinatura estão disponíveis somente para membros
com assinatura.

Ao clicar no botão Communication Center  na caixa InfoCenter, os
membros têm acesso às seguintes opções (no Subscription Center):
■ Subscription status. Verifica o status de sua assinatura.

■ Create support request. Fornece uma comunicação direta um-a-um
com técnicos de suporte da Autodesk. Você recebe respostas rápidas e
completas para suas perguntas sobre instalação, configuração e solução de
problemas.

■ View support requests. Acompanha e gerencia suas perguntas e respostas
por meio do sistema de suporte de ponta da Autodesk.

■ Edit Subscription Center profile. Configura e mantém sua conta de
assinatura.

■ View support requests. Contém lições interativas organizadas em
catálogos de produtos.

■ e-Learning Lessons. (Somente para os membros de assinatura). Cada
lição dura 15-30 minutos e contém exercícios ao vivo, com uma opção
para usar uma simulação ao invés do software aplicativo. É possível usar
uma ferramenta de avaliação on-line que identifique falhas de qualificações,
determine quais lições serão mais úteis e avalie o progresso do aprendizado

Recursos e Privacidade de Assinatura

Os recursos de assinatura fornecem funções interativas de produtos por meio
da Internet. Cada vez que você acessa os recursos de assinatura (como o
e-Learning ou Create Support Request) do Communication Center em um
produto da Autodesk, as informações do produto (como o número de série,
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versão, idioma e ID do contrato de assinatura) são enviadas para a Autodesk
para verificar se seu produto está com uma assinatura.

A Autodesk compila estatísticas usando as informações enviadas para os
recursos de assinatura, para monitorar como estão sendo usados e como podem
ser aprimorados. A Autodesk mantém a informação fornecida por ou coletada
de você de acordo com a política de privacidade publicada da Autodesk, que
está disponível em http://www.autodesk.com/privacy-ptb.

Para abrir o Subscription Center

1 Clique no botão Communication Center  na caixa InfoCenter.

2 No painel Communication Center, em Subscription Center, clique
no recurso de assinatura que deseja acessar.

OBSERVAÇÃO  O Subscription Center não está disponível para todos os usuários
do produto. Se o Subscription Resources não estiver disponível em seu produto,
este não tem o direito aos benefícios da assinatura.

Gerenciar arquivos com o Autodesk Vault

Se você for um cliente de assinatura, tem acesso ao Autodesk Vault, uma
ferramenta de gerenciamento de arquivos que fornece um repositório onde
os documentos e arquivos são armazenados e gerenciados.

O Autodesk Vault lhe fornece mais poder para gerenciar arquivos e acompanhar
alterações. Cópias de versão dos arquivos mestre são mantidos, permitindo a
fácil reversão para versões anteriores dos arquivos. Você pode retirar arquivos
para edição e mais tarde devolvê-los. A cópia mestre nunca é diretamente
editada.

O Autodesk Vault consiste em dois componentes requeridos: o Autodesk Data
Management Server e o Vault Client. Opcionalmente, você também pode
instalar o Vault Office Add-in.

Para obter informações sobre o uso do Vault, consulte a ajuda do sistema Vault.

DICA Os principais componentes do Autodesk Vault podem ser descarregados
do site de Assinatura da Autodesk.
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Utilizar o Communication Center

O Communication Center fornece informações atualizadas sobre produtos,
atualizações de software, avisos de suporte de produtos e outros avisos relativos
aos produtos.

Visão geral do Centro de comunicação

É possível clicar no botão Centro de Assinaturas para exibir links de
informações sobre atualizações e avisos de produtos, e incluir links para fontes
RSS.

Sempre que novas informações estão disponíveis, o Communication Center
lhe notifica exibindo uma mensagem em balão abaixo do botão
Communication Center na caixa InfoCenter.

O Communication Center fornece os seguintes tipos de anúncios:
■ Canais da Autodesk: Receba informações de suporte, atualizações de

produto, e outros avisos (incluindo artigos e dicas).

■ Alimentações RSS.Receber informações sobre alimentações RSS as quais
você se subscreve. As fontes RSS geralmente lhe notificam quando um novo
conteúdo é lançado. Você é automaticamente inscrito em diversas fontes
RSS padrão quando instala o programa.

■ Informações sobre suporte a produtos. Obtenha notícias recentes
da equipe de Suporte de Produto da Autodesk, incluindo quando as
correções de manutenção Live Update são liberadas.

■ Avisos de assinatura. Receber avisos de assinatura e notícias do programa
de assinatura, assim como vínculos para e-Learning Lessons, se você for
um membro de assinatura da Autodesk (disponível em países/regiões onde
a assinatura da Autodesk é oferecida).

Para obter mais informações sobre a Autodesk Subscription, consulte Acessar
o Subscription Center na página 13.

■ Articles and Tips. Seja notificado quando novos artigos e dicas estejam
disponíveis nos websites da Autodesk.

■ Live Update Maintenance Patches. Receba notificações automáticas
sempre que novas correções de manutenção forem liberadas pela Autodesk.

■ Tecnologias e conteúdo apresentados. Aprenda mais sobre os
aplicativos e conteúdo de desenvolvedores terceiros.
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Você pode personalizar os itens que são exibidos no painel Communication
Center. Para obter mais informações, consulte Especificar as configurações
do InfoCenter na página 24.

Política on-line do Centro de comunicação

O Centro de comunicação é um recurso interativo que precisa estar conectado
à Internet para poder fornecer conteúdo e informações. Cada vez que o Centro
de comunicação está conectado, envia suas informações para a Autodesk para
que o usuário receba as informações corretas. Todas as informações são enviadas
anonimamente para a Autodesk para manter sua privacidade.

O Centro de comunicação envia as seguintes informações para a Autodesk:
■ O nome do produto (no qual se está usando o Centro de comunicação)

■ Número de versão do produto

■ Idioma do produto

■ O país/região (especificado nas configurações no Centro de comunicação)

■ Sua ID única do Programa de Participação do Cliente (CIP) caso esteja
participando do programa CIP.

A Autodesk compila estatísticas usando as informações enviadas do
Communication Center para monitorar como ele está sendo utilizado e
como pode ser aprimorado. A Autodesk mantém a informação fornecida por
você ou coletada de acordo com a política de privacidade publicada da empresa,
que está disponível em http://www.autodesk.com/privacy.

Para abrir o Communication Center

■ Na caixa InfoCenter, clique no botão Communication Center  .

Para receber novas notificações sobre informações

■ Clique no link, no balão da mensagem, para abrir o artigo ou anúncio.

Salvar e acessar tópicos favoritos

É possível clicar no botão Favoritos para exibir links salvos para tópicos ou
locais da web.
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Qualquer link exibido no painel Subscription Center ou no
Communication Center pode ser marcado como um favorito.

Um link marcado como favorito é exibido como um ícone de estrela no painel
Subscription Center ou no painel Communication Center.

Para exibir o painel Favoritos do InfoCenter

■ Na caixa InfoCenter, clique no botão Favoritos.

OBSERVAÇÃO Os links exibidos no painel Favoritos são organizados nos mesmos
grupos ou categorias em que foram adicionados.

Para salvar um vínculo no InfoCenter como um favorito

1 Exiba um painel ao efetuar um dos seguintes:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

2 Clique no ícone de estrela que é exibido próximo ao link que você deseja
salvar como um favorito.

Para remover um link favorito do painel Favoritos do InfoCenter

1 Na caixa InfoCenter, clique no botão Favoritos para exibir o painel
Favoritos.

2 Clique no ícone de estrela que é exibido próximo ao link que você deseja
remover do painel Favoritos.

Utilizar o sistema de Help

Clique no botão Ajuda para exibir os tópicos na Ajuda.
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Você poderá aproveitar muito mais o sistema de Help quando aprender a
utilizá-lo com eficiência. É possível encontrar rapidamente descrições gerais,
procedimentos, detalhes sobre caixas de diálogo e paletas, ou definições de
termos.

O sistema de Help contém informações completas sobre como usar este
programa. Na janela Help, use o painel esquerdo para localizar informações.
As guias acima do painel esquerdo fornecem várias maneiras de localizar os
tópicos que você deseja visualizar. O painel direito exibe os tópicos
selecionados.

Para exibir tópicos na Ajuda

■ Na caixa InfoCenter, clique no botão Ajuda.

Como os tópicos do Help estão organizados

A maioria dos tópicos neste sistema de Help têm três guias acima do painel
direito da janela Help. Essas guias exibem diferentes tipos de informações.

■ Guia Concept. Descreve um recurso ou função. Quando você clica na
guia Concept, a lista Help Contents no painel esquerdo da janela Help
expande e realça o tópico atual. A guia Contents exibe a estrutura do Help
nesse tópico. Você pode com facilidade exibir facilmente os tópicos
próximos clicando neles na lista.

■ Guia Procedure.Fornece instruções passo-a-passo para procedimentos
comuns relativos ao tópico atual. Depois de exibir um procedimento, você
poderá clicar na guia Procedure para exibir novamente a lista atual de
procedimentos.

■ Guia Quick Reference.Lista as informações de referência relativas ao
tópico atual:

Quando se clica uma guia diferente, o tópico permanece o mesmo. Somente
o tipo da informação é exibido—conceitos, procedimentos ou vínculos de
referência rápida—são diferentes.

Pesquisar no Help

Use a guia Search do Help para localizar tópicos relevantes com base nas
palavras-chave inseridas.
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As regras de pesquisa básica são:
■ Digite suas palavras-chave caracteres maiúsculos ou minúsculos; as pesquisas

não fazem distinção entre caracteres maiúsculos e minúsculos.

■ Procure qualquer combinação de letras (a-z) e números (0-9).

■ Não utilize marcas de pontuação como ponto, dois-pontos, ponto-e-vírgula,
vírgula, hífen e aspas simples; elas serão ignoradas durante uma pesquisa.

■ Agrupe os elementos da pesquisa utilizando aspas duplas ou parênteses
para separar cada elemento.

Usar caracteres curinga

Você pode usar os seguintes caracteres curinga em uma palavra-chave:

DescriçãoSímbolo

Substitui um ou mais caracteres quando
usado no começo, meio ou fim de uma

*

palavra. Por exemplo, “*lish”, “p*lish”, e
“pub*” irá encontrar todos “publish”.
Também, “anno*” irá encontrar
“annotative”, “annotation”, “annoupdate”,
“annoreset”, e assim por diante.

Substitui um único caractere. Por exemplo,
“cop?” irá encontrar “copy”, mas não
“copybase”.

?

Expande o tempo do verbo da palavra no
começo ou fim de uma palavra. Por

~

exemplo, “plotting~” irá encontrar “plots”,
“plotted”, e assim por diante. Também,
“~plot” irá encontrar “preplot”, “replot”, e
assim por diante.

Pesquisar por frases

Ao pesquisar por uma frase, use aspas duplas (" ") entre as palavras que devem
ficar próximas entre si na sequência especificada. Por exemplo, insira
"especificação de unidades de medida" para localizar somente os tópicos com
todas essas palavras nessa ordem. Se as aspas não forem utilizadas no texto, a

20 | Capítulo 1   Bem-vindo ao Autodesk Navisworks Manage 2012



ajuda encontrará todos os tópicos que contenham qualquer uma das palavras
listadas, ou seja, todos os tópicos que contenham "especificação", "unidades",
"de" e "medida".

DICA Se não puder encontrar as informações que precisa com uma pesquisa,
tente usar a guia Contents.

Usar operadores Booleanos

Com os operadores AND, OR, NOT e NEAR, é possível definir uma pesquisa
precisamente criando uma relação entre os termos dessa pesquisa. A tabela a
seguir mostra como você pode utilizar cada um desses operadores. Se nenhum
operador for especificado, será utilizado E. Por exemplo, a consulta spacing
border printing é equivalente a spacing AND border AND printing.

ResultadosExemploPesquisar por

Tópicos contendo as palavras
"tree view" e "palette"

"tree view" AND “palette”Os dois termos no
mesmo tópico

Tópicos contendo ou a palavra
"viewpoint" ou a palavra
"animation" ou ambas

viewpoint OR animationUm dos dois termos em
um tópico

Tópicos contendo a palavra
"NWD", mas não a palavra "NWC"

nwd NOT nwcO primeiro termo sem
o segundo

Tópicos contendo a palavra "user"
a oito palavras da palavra "menu"

user NEAR menuOs dois termos no
mesmo tópico e juntos

OBSERVAÇÃO Os caracteres |, & e ! não funcionam como operadores Booleanos.
Deve-se utilizar AND (também +), OR e NOT (também -).

Localizar informações nos tópicos do Help

As guias no lado esquerdo da janela Help fornecem diferentes métodos para
localizar informações.
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Guia Contents

■ Apresenta uma visão geral da documentação disponível em uma lista de
tópicos e subtópicos.

■ Permite que você pesquise selecionando e expandindo tópicos.

■ Fornece uma estrutura para que você sempre possa visualizar o ponto em
que se encontra na Help e saltar rapidamente para outros tópicos.

Guia Index

■ Exibe uma lista em ordem alfabética de palavras-chave relacionadas a todos
os tópicos listados na guia Contents

■ Acessa rapidamente as informações, quando já se conhece o nome da
função, comando ou operação, ou quando já se conhece que ação você
deseja que o programa execute.

Guia Search

■ Oferece uma pesquisa por palavra-chave de todos os tópicos listados na
guia Contents.

■ Aceita os operadores Booleanos AND (+), OR, NOT (-) e NEAR.

■ Aceita os caracteres curinga *, ?, e ~.

■ Permite executar a pesquisa por uma frase quando esta está dentro de aspas
duplas.

■ Exibe uma lista de tópicos classificada contendo a palavra ou palavras
digitadas no campo da palavra-chave.

■ Organiza os resultados alfabeticamente por título ou localização se você
clicar nos cabeçalhos de coluna Title e Location.

Para localizar uma palavra ou frase específica no tópico do Help exibido no
momento

1 Clique no texto do tópico e pressione CTRL+F.

2 Na caixa de texto Find, insira uma palavra-chave ou frase.

3 Clique em Next. Se a palavra-chave ou frase for localizada, o tópico é
rolado para exibir o resultado.
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Imprimindo tópicos do Help

A forma mais rápida para imprimir o tópico atual é a de clicar com o botão
direito do mouse e a seguir clicar em Print.

O botão Print na barra de ferramentas Help fornece três opções de impressão:
■ Imprimir o tópico selecionado (recomendado)

■ Imprimir o título selecionado e todos os subtópicos

OBSERVAÇÃO Quando a segunda opção é selecionada, você pode obter várias
páginas impressas, dependendo do número de subtópicos presentes no tópico
atualmente selecionado.

Para imprimir um tópico da Help

1 Exiba o tópico que você deseja imprimir.

2 Clique com o botão direito do mouse no painel do tópico. Clique em
Print.

3 Na caixa de diálogo Print, clique em Print.

Para imprimir um cabeçalho selecionado e todos os subtópicos

1 Exiba o tópico que deseja imprimir e assegure que a guia Contents esteja
exibida.

2 Na barra de ferramentas Help, clique em Print.

3 Na caixa de diálogo Print Topics, clique em Print the Selected
Heading and All Subtopics.

4 Clique em OK.

Mostrar e ocultar o painel Conteúdo

Você pode controlar o tamanho da janela de Ajuda.

Utilize o botão Hide  na barra de ferramentas Help para diminuir a
janela Help para um tamanho compacto ao ocultar o painel que contém as
guias Contents, Index e Search. Esse tamanho compacto de janela é mais
adequado para a exibição dos procedimentos enquanto você trabalha.
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Utilize o botão Show  para expandir a janela Help para exibir o painel
que contém as guias Contents, Index e Search. Esse tamanho expandido
de janela é mais adequado para a localização e exibição de informações
conceituais e de referência.

Especificar as configurações do InfoCenter

É possível especificar as configurações do Centro de comunicações na caixa
de diálogo InfoCenter Settings.

Na caixa de diálogo InfoCenter Settings, você pode especificar as seguintes
configurações:
■ General. Sua localização atual, freqüência de verificação de conteúdo

on-line e a opção de ativar ou não os efeitos de transição animada para os
painéis do InfoCenter.

■ Communication Center. Defina a idade máxima dos artigos exibidos
no painel Communication Center.

■ Autodesk Channels. Canais a serem exibidos no painel Communication
Center, assim como o número de artigos a serem exibidos para cada canal.

■ Notificação em balão. Notificações para novas informações de produto,
atualizações de software, e avisos de suporte do produto. Também, é possível
personalizar a transparência e a hora de exibição do balão.

■ RSS Feeds. Assinatura de alimentação RSS. É possível adicionar ou remover
fontes RSS. As fontes RSS geralmente lhe notificam quando um novo
conteúdo é lançado.

Para especificar canais a serem exibidos no painel Centro de comunicação

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique no botão InfoCenter Settings  (Configurações do InfoCenter).

3 Na caixa de diálogo InfoCenter Settings, no painel esquerdo, clique em
Autodesk Channels.

4 No painel direito, selecione ou desmarque os canais que deseja exibir no
painel no Communication Center.
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5 Clique em OK.

Para especificar as configurações de notificações em balão do InfoCenter

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique no botão InfoCenter Settings  (Configurações do InfoCenter).

3 Na caixa de diálogo Configurações do InfoCenter, no painel esquerdo,
clique em Notificação em balão.

4 No painel direito, selecione ou desmarque as opções para ativar ou
desativar as notificações em balão.

5 Insira o número de segundos para definir a duração de tempo para
notificações em balão a serem exibidas:

6 Insira o valor de transparência do balão ou defina o valor usando o
deslizador.

7 Clique em OK.

Para adicionar uma fonte RSS no Centro de comunicação

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

2 Clique no botão InfoCenter Settings. 

3 Na caixa de diálogo InfoCenter Settings, no painel esquerdo, clique em
RSS Feeds.

4 No painel direito, faça um dos seguintes:
■ Clique em Adicionar.

■ Clique com o botão direito do mouse em qualquer lugar do painel
direito. Clique em Adicionar.

5 Na caixa de diálogo Adicionar alimentação RSS, insira a localização da
alimentação RSS que deseja adicionar. Clique em Adicionar.

6 Na caixa de diálogo InfoCenter - Confirmação da alimentação RSS, clique
em Fechar.

7 Clique em "OK".
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Para remover uma fonte RSS do Centro de comunicação

1 Exiba um painel ao efetuar um dos seguintes procedimentos:
■ Na caixa InfoCenter, clique no botão Centro de Assinaturas.

■ Na caixa InfoCenter, clique no botão Centro de comunicação.

■ Na caixa InfoCenter, clique no botão Favoritos.

2 Clique no botão InfoCenter Settings  .

3 Na caixa de diálogo InfoCenter Settings, no painel esquerdo, clique em
RSS Feeds.

4 No painel direito, faça um dos seguintes:
■ Clique em Remove.

■ Clique com o botão direito do mouse em uma alimentação RSS. Clique
em Remove.

5 Na caixa de diálogo InfoCenter - Remover alimentação RSS, clique em
Sim.

6 Clique em "OK".

Obter mais ajuda

Você pode acessar diversas fontes de ajuda adicionais.

■ Use o Communication Center.Exiba o painel Communication
Center para obter atualizações e avisos relacionados a produtos.

■ Pressione F1.Exibe as informações de referência sensíveis ao contexto.

■ Clique no botão Help em diversas caixas de diálogo. Exibe as
informações de referência para a caixa de diálogo.

■ Visualizar o Readme do produto.Exibe informações mais recentes
sobre este produto.

Outros recursos ajudam a obter informações sobre os produtos da Autodesk e
ajuda à suas perguntas sobre este programa.
■ Site da Autodesk na Web. Acesse http://www.autodesk.br.

■ Local support. Consulte seu revendedor ou o escritório do país/região
da Autodesk.
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Conhecendo o produto

Programas de treinamento e produtos da Autodesk ajudam a aprender as
funções técnicas chave e aprimorar sua produtividade.

Para obter as informações mais recentes sobre o treinamento da Autodesk,
visite http://www.autodesk.com/training-ptb ou contate o escritório local da
Autodesk.

Autodesk Authorized Training Centers

A rede Autodesk® Authorized Training Center (ATC®), oferece treinamento
autorizado e conduzido por instrutor da Autodesk para profissionais de desenho
que usam o software da Autodesk. Centros de Treinamento Autorizado da
Autodesk possuem instrutores experientes e qualificados. Mais de 1.200 locais
do ATC estão disponíveis no mundo todo para atender às suas necessidades
de treinamento local com disciplinas específicas.

Para encontrar o centro de treinamento mais próximo, contate o escritório
local da Autodesk ou visite http://www.autodesk.com/atc.

Autodesk Official Training Courseware

O Autodesk Official Training Courseware (AOTC) é um material técnico de
treinamento desenvolvido pela Autodesk. Projetado para o treinamento
tradicional em sala de aula conduzido por instrutor com 1/2 dia a 5 dias e
usado pelos Centros Autorizados de Treinamento e outros parceiros da
Autodesk, o AOTC é bem adequado para o aprendizado independente e de
ritmo próprio do usuário. Os manuais cobrem os conceitos chave e a
funcionalidade do software com exercícios ao vivo, passo-a-passo e do mundo
real. É possível comprar o AOTC com seu revendedor ou distribuidor, ou é
possível encomendá-lo on-line na Loja da Autodesk em
http://www.autodesk.com/aotc-ptb.

e-Learning

O Autodesk e-Learning para clientes de Assinatura da Autodesk, apresenta
lições interativas organizadas em catálogos de produtos. Cada lição dura de
20 a 40 minutos e apresenta exercícios práticos, com uma opção de simulação
do produto ou aplicativo real. É possível usar uma ferramenta de avaliação
on-line que identifica falhas de qualificações, determina quais lições serão
mais úteis e avalia o progresso do aprendizado.
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Se você for membro com assinatura da Autodesk, poderá acessar o e-Learning
e outros serviços de assinatura a partir de seu produto Autodesk.

Para obter mais informações sobre como acessar o e-Learning no produto,
consulte Acessar o Subscription Center na página 13.

Para obter mais informações sobre os recursos de assinatura da Autodesk, visite
http://www.autodesk.com.br/subscription.

Autodesk Developer Network

O programa Autodesk Developer (ADN) para membros ADN fornece o suporte
para desenvolvedores profissionais em tempo integral, que desejam desenvolver
software com base nos produtos Autodesk. Como um membro ADN, você
receberá as indicações comerciais, software, suporte e treinamento para obter
êxito. Se você é um desenvolvedor, visite http://www.autodesk.com/adn.

Autodesk Consulting

A Consultoria da Autodesk fornece serviços que ajudam a definir os processos
e fornece treinamento crítico que irá ajudar a aumentar a produtividade, para
que você possa capitalizar a potência de seus produtos. Para obter mais
informações sobre a consultoria geral, integração de sistemas ou serviços de
treinamento personalizado, visite http://www.autodesk.com/consulting-ptb.

Serviços e produtos de parceiros

A Autodesk trabalha em conjunto com milhares de parceiros de software em
todo o mundo. Esses parceiros fornecem produtos e serviços que aprimoram
os produtos da Autodesk para profissionais de desenho. Visite a página Partner
Products & Services em http://www.autodesk.com/partnerproducts para obter uma
lista do recursos disponíveis para seu produto da Autodesk ou de sua indústria.

Visualizar o Readme do produto

Você pode encontrar as informações mais recentes sobre este software no
Readme.

Convém ler todo o Readme do Autodesk Navisworks para obter informações
sobre componentes de hardware recomendados, instruções de instalação
atualizadas e problemas de software conhecidos. O arquivo Leiame está
disponível no grupo do programa do produto no menu Iniciar do Windows.
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Juntar-se ao Programa de Participação do
Cliente

Você está convidado a participar na ajuda de direcionamento do projeto de
software da Autodesk.

Se você participa no Programa de Participação do Cliente (CIP), informações
específicas sobre como você utiliza o Autodesk Navisworks são enviadas para
a Autodesk. Estas informações incluem quais recursos você mais utiliza,
problemas encontrados e outras informações úteis na direção futura do produto.

Consulte os links a seguir para obter mais informações.
■ Aprenda mais sobre o Programa de Participação do Cliente da Autodesk:

http://www.autodesk.com/cip

■ Leia a Desclaração de privacidade da Autodesk:
http://www.autodesk.com/cipprivacy

Quando você passa a fazer parte, será capaz de visualizar relatórios que podem
ajudá-lo a otimizar seu uso do Autodesk Navisworks.

Para ativar ou desativar o CIP

1 Na barra de ferramentas InfoCenter, à direita do botão Ajuda, clique na
seta suspensa.

2 Clique em Programa de Participação do Cliente.

3 Na caixa de diálogo Programa de Participação do Cliente, escolha se
deseja começar ou parar de participar.

4 Clique em "OK".
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Instalação

Guia de Início Rápido da Instalação
Independente

Esta seção oferece instruções passo a passo sobre como preparar e, a seguir,
instalar o Autodesk Navisworks.

A instalação independente é recomendada para usuários individuais ou grupos
pequenos. O ponto principal é que você repetirá o processo de instalação em
cada computador. Para uma licença independente, este é o único tipo de
instalação válida, mas também pode ser usado com uma licença de rede ou
independente com múltiplas instalações.

Caso você nunca tenha instalado o produto, deverá se familiarizar com todo o
processo e as opções de instalação antes de iniciar.

Para obter informações sobre como instalar versões do programa com
licenciamento de rede ou independente com múltiplas instalações, consulte
Instalar o Autodesk Navisworks para múltiplos usuários na página 47.

Preparar para a instalação

Para se preparar para a instalação, é necessário consultar os requisitos de sistema,
entender os requisitos de permissão administrativa, localizar o número de série
e chave de produto de seu Autodesk Navisworks Manage 2012, e fechar todos
os aplicativos em execução.

Ao concluir estas tarefas, você estará pronto para iniciar a instalação do Autodesk
Navisworks Manage 2012.
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OBSERVAÇÃO Também é recomendado que você instale o Microsoft. Net
Framework 4.0 antes de instalar o produto. Consulte Instalar o Microsoft .NET
Framework 4.0 na página 33.

Requisitos do sistema para a instalação
independente

A primeira tarefa a ser completada é a de assegurar que seu computador atenda
os requisitos mínimos de sistema. Se o sistema não corresponder a estes
requisitos, poderão ocorrer problemas, tanto no Autodesk Navisworks como
no nível do sistema operacional.

A detecção se o sistema operacional Windows é da versão de 32 bits ou de 64
bits é automaticamente feita durante a instalação.

Consulte na tabela a seguir os requisitos de hardware e software.

Requisitos de hardware e software para a máquina cliente

RequisitoHardware/Software

Microsoft® Windows 7 (32 bits ou 64 bits) Home
Basic, Home Premium, Professional, Enterprise ou
Ultimate (recomendado)

Sistema operacional

Microsoft® Windows Vista® SP2 (32 bits ou 64 bits)
Home Premium, Business, Enterprise ou Ultimate

Microsoft® Windows XP SP3 (32 bits) Home ou
Professional

Microsoft® Windows XP SP2 (64 bits) Professional

Microsoft® Internet Explorer® 7.0 ou posteriorNavegador da Web

AMD Athlon™, 3.0 GHz ou mais rápido (no

mínimo); Intel® Pentium® 4, 3.0 GHz ou mais
rápido (recomendado) - com tecnologia SSE2

Processador
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Requisitos de hardware e software para a máquina cliente

512 MB (mínimo); 2 GB ou mais (recomendado)Memória (RAM)

1024 x 768 com True Color (no mínimo)Tela VGA

Placa adaptadora de vídeo de 1280 x 1024 32 bits
com True Color (recomendado)

Placa gráfica compatível com Direct3D 9® e

OpenGL® com Shader Model 2 (no mínimo)

Placa gráfica

11 GB de espaço livre em disco para a instalaçãoDisco rígido

Dispositivo apontador compatível com o mouse da

Microsoft®
Dispositivo apontador

Qualquer velocidade (somente para a instalação)DVD-ROM

Impressora ou plotadoraHardware opcional

Modem ou acesso a uma conexão de Internet

Placas de interface de rede

Instalar o Microsoft .NET Framework 4.0

O Autodesk Navisworks Manage 2012 requer que o Microsoft .Net 4.0 seja
instalado antes da instalação do produto.

A maioria das atualizações do Windows deve incluir o Microsoft .NET
Framework 4. No entanto, para versões antigas do Windows, é possível fazer
o download e instalar os Microsoft .NET Framework 4 redistribuíveis em
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-
4fc0-919f-b21f31ab88b7 ou instale o Microsoft .Net Framework 4 no seguinte
diretório da mídia de instalação: \3rdParty\NET\4\wcu\dotNetFramework\.

Guia de Início Rápido da Instalação Independente | 33

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=0a391abd-25c1-4fc0-919f-b21f31ab88b7


O assistente de instalação  instalará o Microsoft .Net Framework 4 se ele detectar
as atualizações necessárias não foram instaladas.

OBSERVAÇÃO  Se o assistente de instalação solicitar que você instale o Microsoft
.NET 4.0 Framework, o instalador do .NET 4.0 Framework poderá solicitar que
você instale primeiro o Windows Imaging Component (WIC). Isto pode ocorrer
se você não possui as últimas atualizações do Microsoft Windows ou Service Packs.
É mais provável precisar do WIC se você estiver executando o Windows XP SP2
sem determinadas atualizações do Windows instaladas. Se necessário, o Microsoft
WIC installers estão disponíveis nas seguintes localizações:
■ Instalador de 32 bits:

http://www.microsoft.com/downloads/en/details.aspx?FamilyID=8e011506-
6307-445b-b950-215def45ddd8&displaylang=en

■ Instalador de 64 bits:
http://www.microsoft.com/downloads/en/details.aspx?FamilyID=f64654ac-6e26-
41d9-a90a-0e7783b864ee

Compreender os requisitos de permissão
administrativa

Para instalar o Autodesk Navisworks, você precisa ter permissões de
administrador.

Não é necessário ter permissões de administrador de domínio. Consulte o
administrador do sistema para obter informações sobre permissões de
administrador.

Para executar o Autodesk Navisworks, não é preciso ter permissões
administrativas. Você pode executar o programa como um usuário limitado.

Localizar o número de série e a chave do produto
do Autodesk Navisworks

Quando você instala o Autodesk Navisworks, são solicitados o número de série
e a chave do produto na página User and Product Information.

O número de série deve conter um prefixo de três dígitos seguido por um
número de oito dígitos. A chave do produto consiste em cinco dígitos.
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O número de série e a chave do produto estão localizados no lado externo da
embalagem do produto ou no e-mail recebido se você efetuou o download de
seu produto. Assegure que você os tenha disponíveis antes de instalar o
programa para que não tenha que parar no meio da instalação. Também
assegure-se de que você tem esses números antes de ativar o programa.

As informações que você insere são permanentemente retidas com o produto.
Como não é possível alterar estas informações posteriormente sem desinstalar,
seja cauteloso ao inserir as informações. Para analisar as informações do
produto posteriormente, na caixa InfoCenter clique na seta para baixo ao
lado do botão Help ➤ About Autodesk Navisworks Manage 2012.

OBSERVAÇÃO Caso tenha perdido seu número de série ou a chave do produto,
contate o escritório local da Autodesk para obter ajuda.

Evitar a perda de dados durante a instalação

O processo de instalação do Autodesk Navisworks pode parar se alguns
aplicativos (como o Microsoft® Outlook® ou programas de verificação antivírus)
estiverem sendo executados.

Feche todos os aplicativos em execução para evitar uma possível perda de
dados.

Escolher um idioma

É possível selecionar um outro idioma para instruções de instalação e um
idioma para as instalações individuais do produto no mesmo processo de
instalação.

Ao iniciar o processo de instalação, o instalador automaticamente determina
o idioma de seu sistema operacional. Se um idioma suportado for detectado,
suas páginas de instalação serão exibidas naquele idioma. Se você deseja alterar
aquele idioma, basta escolher outro idioma na lista Idioma do Instalador na
primeira página do assistente de Instalação.
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OBSERVAÇÃO Alguns produtos podem não ter o suporte para múltiplos idiomas
no momento da liberação do produto. Suporte de idiomas adicionais pode estar
disponível em outro momento. Consulte http://support.autodesk.com para verificar
a disponibilidade de pacotes de idiomas adicionais.

Utilizar pacotes de idiomas

O pacote de idioma apoia o uso de diferentes idiomas em cada produto
Autodesk Navisworks, incluindo exportadores. Os nomes dos pacotes começam
com NAVFREE_, NAVSIM_, NAVMAN_ e exporters_ respectivamente.

OBSERVAÇÃO É preciso instalar ao menos uma pacote de idioma para cada
produto.

É possível instalar pacotes adicionais de idiomas nos produtos do Autodesk
Navisworks posteriormente. É possível instalar manualmente os pacotes de
idiomas necessários ao clicar com o botão direito do mouse no arquivo MSI
do pacote de idioma.

Os pacotes de idioma estão localizados no DVD de instalação e em mídia não
empacotada baixada da pasta x86 para produtos de 32 bits e da pasta x64
para produtos de 64 bits.

■ Os pacotes de idiomas para produtos específicos estão incluídos nas
subpastas NAVFREE , NAVSIM, NAVMAN e NWEXPORT das pastas
x86 e x64.

■ Pacotes de idioma para idiomas específicos estão incluídos nas subpastas
en-US (Inglês), de-DE (Alemão), es-ES (Espanhol), fr-FR (Francês), it-IT
(Italiano), ja-JP (Japonês), ko-KR (Coreano), pt-BR (Português do Brasil),
ru-RU (Russo) e zh-CN (Chinês PRC) das pastas dos produtos.

Portanto, por exemplo, para instalar o pacote de idioma Francês de 32 bits
para o Autodesk Navisworks Manage, clique duas vezes em
x86/NAVMAN/fr-FR/NAVMAN_LP.msi.

Configuração

Durante o processo de instalação, você escolhe uma instalação típica (instalar
os produtos com as configurações padrão) ou uma instalação personalizada.
Na página Install  ➤ Configure Installation, para qualquer produto que
você selecionou para instalar, você verá um controle triangular para acessar
um painel de configuração.
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Clique em qualquer lugar na caixa do produto para abrir o painel de
configuração:
■ Tipo de instalação Se você selecionar a instalação Typical (configurações

padrão), o produto instalará as operações de aplicativos mais comuns. A
instalação Custominstala somente os recursos do aplicativo selecionados
na listaSelect Features To Install. As operações disponíveis dependerão
do produto que está sendo instalado:

Contém o controle ActiveX redistribuível
do Autodesk Navisworks.

Redistributable ActiveX Control

Contém a interface Component Object
Model para personalizar e estender os
recursos do Autodesk Navisworks.

API

Contém diversos arquivos de amostras de
recursos.

Exemplo de arquivos NWD

Contém um complemento para os
comandos de executar e agendar.

Utilitário de Lote

Contém o conjunto completo dos arquivos
do Autodesk Navisworks.

Programa

Contém diversos arquivos do Rich
Photorealistic Content.

RPCs de amostra
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OBSERVAÇÃO Para os plug-ins do exportador do Autodesk Navisworks, é
possível alterar quais plug-ins são instalados.

 Indica o software de terceiros já instalado no computador.

 Indica plugins para o software de terceiros, que não estão instalados ou
não foram detectados pelo assistente Installation.

Selecione as caixas de seleção para todos os plugins requeridos. Se o software
de terceiros não foi detectado pelo assistente, é possível ativar manualmente
os plugins para o software. A seleção da caixa de seleção automaticamente
abre a caixa de diálogo, que permite procurar pelo diretório correto de
instalação do software.

■ Create the Desktop Shortcut (Criar o atalho na área de trabalho).
Selecione a caixa de seleção para criar o atalho na área de trabalho para o
Autodesk Navisworks.

■ Pastas de projeto e terreno. Utilize os botões Browse para selecionar
os diretórios que irão conter as configurações do Autodesk Navisworks que
podem ser compartilhadas em todo um local de projeto ou por um grupo
de projetos específico (consulte Selecionar as pastas Projeto e Site na página
69).

■ Service Packs. Se um service pack estiver disponível, é possível incluí-lo
na instalação.

Uma vez configuradas as configurações conforme necessário, clique no nome
do produto para fechar o painel de configuração.

Instalar múltiplos produtos ou produtos
combinados

Alguns pacotes da Autodesk são compostos de múltiplos produtos ou são parte
de produtos de múltiplos pacotes.

O assistente de Instalação para pacotes que são compostos por múltiplos
produtos, lhe fornece a opção de escolher quais produtos deseja instalar.

No assistente de Instalação para pacotes contendo múltiplos produtos, é
possível escolher quais produtos e idiomas que você deseja instalar. Durante
o processo de instalação você é informado se já existe um cópia do software
instalado. Também é avisado se seu sistema não atende os requisitos mínimos
para o produto. Cada nome de produto é exibido no seu próprio painel com
abas; é possível configurá-los individualmente.
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Se você comprou um pacote que é um pacote com múltiplos produtos, como
um pacote educacional ou institucional, poderá ter um pacote que inclui
diversos produtos da Autodesk. Para estes pacotes combinados, um disco
Instalador contém informações para todos os produtos no pacote. O disco do
Instalador ajuda na instalação dos produtos.

Instalar e executar o Autodesk Navisworks
Manage 2012

Para usar o produto, você precisa instalar o produto, registrá-lo e ativá-lo, para
depois iniciá-lo.

É preciso ter permissões administrativas para instalar o Autodesk Navisworks.

Esta seção fornece instruções para instalar e ativar o Autodesk Navisworks para
um usuário individual em um computador independente.

Para obter informações sobre como instalar versões do programa com
licenciamento em rede ou independente com múltiplas instalações, consulte
o Instalar o Autodesk Navisworks para múltiplos usuários na página 47.

Após ter instalado com êxito o Autodesk Navisworks Manage 2012, você está
pronto para registrar seu produto e começar a utilizar o programa. Para registrar
o produto, inicie o Autodesk Navisworks Manage 2012 e siga as instruções na
tela. Para obter mais informações, consulte Como registrar e ativar o Autodesk
Navisworks? na página 82

OBSERVAÇÃO A Autodesk não recomenda nem suporta a distribuição de um
produto Autodesk usando um software de imagens.

Instalar o Autodesk Navisworks

O assistente de instalação do Autodesk Navisworks contém todos os materiais
relativos à instalação em um só lugar.

No assistente de Instalação você pode acessar a documentação do usuário,
alterar o idioma do instalador, selecione um produto específico para o idioma,
instalar ferramentas suplementares, visualizar soluções de suporte e aprender
sobre como instalar seu produto em uma rede.
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OBSERVAÇÃO As versões de 32 bits e de 64 bits do Autodesk Navisworks Manage
2012 estão em DVDs separados. Insira o DVD apropriado do Autodesk Navisworks
na unidade de DVD para iniciar o processo de instalação. Siga os prompts para
completar a instalação. Desde que o DVD esteja na unidade, você pode acessar a
documentação de usuário clicando no link Installation Help.

■ Verifique a documentação de instalação antes de instalar.
Recomenda-se dedicar algum tempo para se familiarizar com o processo
completo de instalação antes de instalar o Autodesk Navisworks. A
documentação é acessada a partir de links no canto inferior esquerdo do
instalador.

■ Instalar o Autodesk Navisworks Manage 2012. No assistente de
Instalação, clique em Instalar. Siga as instruções exibidas na tela para
completar a instalação.

Instalar o Autodesk Navisworks utilizando valores
padrão

Esta é a maneira mais rápida de instalar o Autodesk Navisworks em seu sistema.

Somente valores padrão são utilizados, o que significa que uma instalação
típica está sendo instalada em C:\Program Files\Autodesk\Navisworks Manage

2012.

Para instalar o Autodesk Navisworks usando valores padrão em um
computador independente

1 Feche todos os aplicativos em execução no seu computador e inicie o
assistente de Instalação.

2 No assistente de instalação, se necessário, selecione um idioma
alternativo para o assistente de instalação no menu suspenso
Installation Instructions e, a seguir, clique em Install.

3 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.
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OBSERVAÇÃO Se não concordar com os termos da licença e desejar terminar
a instalação, clique em Cancelar.

4 Na página Product Information, selecione Stand-Alone, insira o
número de série e a chave do produto e clique em Next.

5 Na página Configure Installation, selecione os produtos a serem
instalados e, se necessário, adicione pacotes de idiomas do menu suspenso
Product Language (consulte Choose a Language na página 35).

6 Se necessário, utilize o botão Installation PathBrowse para selecionar
a unidade e a localização onde o produto será instalado.

7 Clique em Install. O assistente instala os produtos selecionados
utilizando uma instalação Typical, que instala os recursos mais comuns
do aplicativo. Para verificar quais recursos estão incluídos em uma
instalação Typical, consulte Recursos típicos instalados na página 79.

OBSERVAÇÃO Por padrão, o assistente de Instalação ativa
automaticamente os plugins do exportador para todos os produtos de
terceiros já instalados no computador.

8 Clique em Concluir.

Instalar o Autodesk Navisworks usando valores
configurados

Com este método de instalação, é possível selecionar exatamente o que será
instalado.

É possível alterar o tipo de licença, o tipo de instalação, o caminho da
instalação e especificar a localização das pastas Projeto e Local.

Para instalar o Autodesk Navisworks usando valores configurados em um
computador autônomo

1 Feche todos os aplicativos em execução no seu computador e inicie o
assistente de Instalação.

2 No assistente de instalação, se necessário, selecione um idioma
alternativo para o assistente de instalação no menu suspenso
Installation Instructions e, a seguir, clique em Install.

3 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
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instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.

OBSERVAÇÃO Se não concordar com os termos da licença e desejar terminar
a instalação, clique em Cancelar.

4 Na página Product Information, selecione License Type
(Stand-Alone [Independente] ou Network [Rede]), insira o número
de série e a chave do produto e clique em Next.

5 Na página Configure Installation, selecione os produtos a serem
instalados e, se necessário, adicione pacotes de idiomas do menu suspenso
Product Language (consulte Choose a Language na página 35).

6 Clique no nome do produto para abrir o painel de configuração, onde
é possível revisar e alterar as configurações. Consulte Configuração na
página 36. Uma vez configuradas as configurações conforme necessário,
clique no nome do produto para fechar o painel de configuração.

7 Se necessário, utilize o botão Installation PathBrowse para selecionar
a unidade e a localização onde o produto será instalado.

8 Clique em Install. O assistente instala os produtos selecionados
utilizando as configurações de instalação Custom (Personalizadas).

9 Clique em Concluir.

Inicie o Autodesk Navisworks

Considerando que todos os passos anteriores destacados na seção do Início
rápido foram seguidos corretamente, é possível iniciar Autodesk Navisworks
e começar a usufruir das operações novas e atualizadas.

Você pode iniciar o Autodesk Navisworks das seguintes maneiras:
■ Ícone de atalho na área de trabalho.Quando você instala o Autodesk

Navisworks, um ícone de atalho é colocado em sua área de trabalho. Clique
duas vezes no ícone do Autodesk Navisworks para iniciar o programa.

■ BotãoIniciar. Clique em Start ➤ All
Programs ➤ Autodesk ➤ Navisworks Manage 2012 ➤ Autodesk
Navisworks Manage 2012.

■ Local onde o Autodesk Navisworks é instalado. Se você tem
permissões administrativas, poderá executar o Autodesk Navisworks do
local em que foi instalado. Se o usuário for um usuário restrito, é possível
executar Autodesk Navisworks a partir do botão Iniciar ou a partir do
ícone de atalho na área de trabalho. Se desejar criar um atalho
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personalizado, verifique se o diretório Iniciar em do atalho aponta para
um diretório no qual você tem permissões de gravação.

OBSERVAÇÃO Quando o produto é iniciado, por padrão, ele utiliza o idioma que
melhor coincida com as configurações em seu computador. Também é possível
iniciar o Autodesk Navisworks em outro dos idiomas suportados.

Como iniciar o Autodesk Navisworks em outro
idioma

Para executar o Autodesk Navisworks em outro dos idiomas instalados, é
preciso adicionar um dos argumentos do seletor de idiomas no atalho da área
de trabalho.

Para executar o Autodesk Navisworks em outro idioma

1 Clique com o botão direito do mouse no atalho do Autodesk Navisworks
na área de trabalho e clique em Properties no menu de atalho para
abrir a caixa de diálogo Autodesk NavisworksProperties.

2 Na guia Atalho , insira um espaço no campo Destino após ..\roamer.exe,
e a seguir insira um dos seguintes argumentos:
■ -lang en-US para a localização em Inglês

■ -lang de-DE para a localização em Alemão

■ -lang es-ES para a localização em Espanhol

■ -lang fr-FR para a localização em Francês

■ -lang it-IT para a localização em Italiano

■ -lang ja-JP para a localização em Japonês

■ -lang ko-KR para a localização em Coreano

■ -lang pt-BR para a localização em Português do Brasil

■ -lang ru-RU para a localização em Russo

■ -lang zh-CN para a localização em Chinês (PRC)

3 Clique em OK para salvar as alterações.
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Adicionar ou remover recursos

É possível adicionar ou remover recursos do Autodesk Navisworks Manage
2012 a qualquer momento. Por exemplo, você escolheu uma opção de
instalação Custom na primeira instalação do Autodesk Navisworks e agora
quer adicionar recursos que não foram originalmente instalados. Ou você não
mais precisa usar todos os recursos que foram originalmente instalados.

É possível adicionar ou remover operações utilizando o Painel de controle.

Para adicionar ou remover recursos

1 Execute um dos procedimentos a seguir:
■ (Windows XP) Clique no menu Iniciar ➤ Configurações ➤ Painel

de controle ➤ Adicionar ou remover programas.

■ (Windows Vista e Windows 7) Clique em Iniciar ➤ Painel de
controle ➤ Programas e recursos.

2 Na lista de programas, clique em Autodesk Navisworks Manage 2012 e
então em Alterar/Remover (Windows XP) ou Desinstalar/Alterar
(Windows Vista e Windows 7).

O assistente de instalação do Autodesk Navisworks Manage 2012 reabre
em modo de manutenção.

3 Clique em Adicionar ou Remover recursos. Na página
Adicionar/Remover recursos, selecione um recurso a ser instalado
ou desinstalado. Os ícones à esquerda das seleções lhe fornece uma
indicação da ação que será tomada.

 Indica um recurso que foi marcado para instalação que estará em
uma instalação típica.

 Indica um recurso que no momento não está programado para ser
instalado.

 Indica um recurso que não foi originalmente marcado para instalação,
mas que foi adicionado na lista de recursos instalados.

 Indica um recurso instalado que foi selecionado para ser removido.

OBSERVAÇÃO Para reverter para os recursos do Autodesk Navisworks
Manage 2012 selecionados na instalação original, clique em Cancel.

Clique em Update.
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4 Na página Atualização completada , você é informado que as
atualizações foram executadas. Clique em Concluir.

Reparar Autodesk Navisworks Manage 2012

Se você excluir ou alterar por engano arquivos necessários para o Autodesk
Navisworks Manage 2012, o Autodesk Navisworks pode não funcionar
corretamente e você receberá mensagens de erro quando tentar executar um
comando ou localizar um arquivo. É possível tentar resolver este problema
reparando Autodesk Navisworks Manage 2012.

A reparação utiliza operações que são parte do tipo de instalação selecionado
ao iniciar o programa.

Para reparar o Autodesk Navisworks Manage 2012

1 Efetue um dos seguintes procedimentos:
■ (Windows XP) Clique no menu Iniciar ➤ Configurações ➤ Painel

de controle ➤ Adicionar ou remover programas.

■ (Windows Vista e Windows 7) Clique em Iniciar ➤ Painel de
controle ➤ Programas e recursos.

2 Na lista de programas, clique em Autodesk Navisworks Manage 2012 e
então em Alterar/Remover (Windows XP) ou Desinstalar/Alterar
(Windows Vista e Windows 7).

O assistente de instalação do Autodesk Navisworks Manage 2012 reabre
em modo de manutenção.

3 Clique em Reparar ou Reinstalar.

4 Na página Repair or Reinstall, clique em RepairAutodesk Navisworks
Manage 2012. Esta opção substitui todas as entradas do registro que o
Autodesk Navisworks instalou inicialmente e restaura o Autodesk
Navisworks Manage 2012 para seu estado padrão. Clique em Repair.

OBSERVAÇÃO ReinstallAutodesk Navisworks Manage 2012 repara o
registro e reinstala todos os arquivos da instalação original. Utilize essa opção
se a opção RepairAutodesk Navisworks Manage 2012 não solucionar o
problema.

5 Na página Reparo completado, clique em Concluir.
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Desinstalar o Autodesk Navisworks Manage 2012

Quando você desinstala o Autodesk Navisworks Manage 2012, todos os
componentes são removidos. Isso significa que mesmo se você adicionou ou
removeu componentes anteriormente, ou se você reinstalou ou reparou o
Autodesk Navisworks Manage 2012, a desinstalação remove todos os arquivos
de instalação do Autodesk Navisworks de seu sistema.

IMPORTANTE  Não utilize programas de limpeza de registro nem tente modificar
as entradas de registro sozinho para desinstalar o Autodesk Navisworks Manage
2012. Não seguir o procedimento oficial de desinstalação resultará na
impossibilidade de instalar o software.

Para desinstalar o Autodesk Navisworks Manage 2012

1 Efetue um dos seguintes procedimentos:
■ (Windows XP) Clique no menu Iniciar ➤ Configurações ➤ Painel

de controle ➤ Adicionar ou remover programas.

■ (Windows Vista e Windows 7) Clique em Iniciar ➤ Painel de
controle ➤ Programas e recursos.

2 Na lista de programas, clique em Autodesk Navisworks Manage 2012 e
então em Alterar/Remover (Windows XP) ou Desinstalar/Alterar
(Windows Vista e Windows 7).

O assistente de instalação do Autodesk Navisworks Manage 2012 reabre
em modo de manutenção.

3 Clique em Desinstalar.

4 Quando informado que o produto foi desinstalado com êxito, clique em
Concluir.

OBSERVAÇÃO Mesmo se o Autodesk Navisworks Manage 2012 for removido
do sistema, a licença do software permanecerá. Se você reinstalar o Autodesk
Navisworks Manage 2012 futuramente, não será necessário registrar e ativar
o programa novamente.
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Mover para o Autodesk Navisworks a partir
de uma versão anterior

Se você tiver uma versão anterior do Autodesk Navisworks instalada em seu
sistema, pode instalar o Autodesk Navisworks Manage 2012 e manter outras
versões do programa no mesmo sistema. Isto é chamado de uma instalação
lado a lado.

Se você adquiriu a versão de atualização do Autodesk Navisworks Manage 2012,
é necessário desinstalar a versão anterior até 120 após a instalação do Autodesk
Navisworks Manage 2012. Consulte o contrato de licença para obter mais
informações.

Instalar o Autodesk Navisworks para múltiplos
usuários

Esta seção fornece informações passo a passo sobre como instalar versões do
programa com licenciamento de rede ou independente com múltiplas
instalações do Autodesk Navisworks Manage 2012.

Início rápido para a administração e
implementação em rede

A implantação para redes deste programa requer planejamento e execução
meticulosos.

A instalação da implementação é recomendada para os administradores de
rede, utilizando uma licença de rede ou uma licença independente com
múltiplas instalações. No processo de implementação, a instalação é
configurada uma vez, armazenada na rede e, a seguir, distribuída de maneira
eficaz para os computadores dos usuários.

Se não estiver familiarizado com a administração e implementação em rede,
deveria se familiarizar com os seguintes tópicos antes de tentar implementar
e administrar o programa através de uma rede.
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Preparação da implementação

Para preparar para uma implementação, você deve dedicar tempo para rever
os seguintes requisitos e opções.

Requisitos do sistema para uma implementação

Esta seção contém os requisitos de sistema para o local da imagem
administrativa criada, o servidor de licença de rede e a estação de trabalho
cliente.

Antes de instalar o programa em uma rede, certifique-se de que os servidores
e as estações de trabalho cliente atendam aos requisitos mínimos recomendados
para hardware e software em uma implantação.

Na instalação do Autodesk Navisworks, é realizada a detecção automática se
o sistema operacional é de 32 ou 64 bits. Você pode escolher quais versões do
Autodesk Navisworks serão instaladas.

Consulte as tabelas a seguir para conhecer os requisitos da imagem
administrativa, do servidor de licença e da estação de trabalho cliente.

Requisitos de hardware e software para o local da imagem administrativa

RequisitoHardware/Software

6 GBDisco rígido

Requisitos de hardware e software para a máquina cliente

RequisitoHardware/Software

Microsoft® Windows 7 (32 bits ou 64 bits) Home Basic,
Home Premium, Professional, Enterprise ou Ultimate
(recomendado)

Sistema operacional

Microsoft® Windows Vista® SP2 (32 bits ou 64 bits) Home
Premium, Business, Enterprise ou Ultimate
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Requisitos de hardware e software para a máquina cliente

Microsoft® Windows XP SP3 (32 bits) Home ou
Professional

Microsoft® Windows XP SP2 (64 bits) Professional

Microsoft® Internet Explorer® 7.0 ou posteriorNavegador da Web

AMD Athlon™, 3.0 GHz ou mais rápido (no mínimo);

Intel® Pentium® 4, 3.0 GHz ou mais rápido
(recomendado) - com tecnologia SSE2

Processador

512 MB (mínimo); 2 GB ou mais (recomendado)Memória (RAM)

1024 x 768 VGA com True Color (mínimo)Tela VGA

Placa adaptadora de vídeo de 1280 x 1024 32 bits com
True Color (recomendado)

Placa gráfica compatível com Direct3D 9® e OpenGL®

com Shader Model 2 (no mínimo)

Placa gráfica

11 GB de espaço livre em disco para a instalaçãoDisco rígido

Dispositivo apontador compatível com o mouse da

Microsoft®
Dispositivo apontador

Qualquer velocidade (somente para a instalação)DVD-ROM

Impressora ou plotadoraHardware opcional

Modem ou acesso a uma conexão de Internet
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Requisitos de hardware e software para a máquina cliente

Placas de interface de rede

Requisitos de hardware e software para o servidor de licença de rede (Windows)

RequisitoHardware/Software

Microsoft® Windows 7 (32 bits ou 64 bits)Sistema operacional

■ Windows 7 Enterprise

■ Windows 7 Ultimate

■ Windows 7 Professional

■ Windows 7 Home Premium

Microsoft® Windows Vista® SP2 ou posterior (32 bits ou 64 bits)

■ Windows Vista Enterprise

■ Windows Vista Ultimate

■ Windows Vista Business

■ Windows Vista Home Premium and Basic (32 bits)

■ Windows Vista Home Premium (64 bits)

Microsoft® Windows XP SP2 ou posterior (32 bits ou 64 bits)

■ Windows XP Professional

■ Windows XP Home

Windows Server SP1 ou posterior (32 bits ou 64 bits)

■ Windows 2008 Server R2

■ Windows Server 2008

■ Windows 2003 Server R2

■ Windows 2003 Server

Intel® Pentium® III ou superiorComputador/processador

450 Mhz (mínimo)
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Requisitos de hardware e software para o servidor de licença de rede (Windows)

RequisitoHardware/Software

Compatível com a infra-estrutura de rede Ethernet existentePlaca de interface de rede

OBSERVAÇÃO O Gerenciador de Licença de Rede suporta múltiplas placas
de interface de rede, mas ao menos uma tem de ser uma placa Ethernet.

TCP/IPProtocolo de comunicação

OBSERVAÇÃO O Gerenciador de licença de rede utiliza tipos de pacotes
TCP.

Internet Explorer® 6.1Navegadores

Internet Explorer 7
Internet Explorer 8

11.9.0.0FLEXnet

Determinar o tipo de instalação

Ao configurar sua implementação, especifique o tipo de instalação por
plataforma de destino e tipo de licença.

Plataforma de destino

Especifique uma plataforma de 32 bits ou de 64 bits, dependendo do sistema
operacional dos computadores que irão utilizar a implementação. Para alguns
produtos da Autodesk, você pode instalar a versão de 32 bits em um sistema
operacional de 64 bits.

Tipo de licença

Especifique um dos seguintes tipos de licença, com base no tipo de licença
que você comprou:

■ Instalação da Licença de Rede.Com este tipo de instalação, você instala
o programa em estações de trabalho com arquivos e entradas de registro
que permitem ao programa se comunicar com o Gerenciador de Licença
de Rede. Também é possível definir a configuração do Gerenciador de
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Licença de Rede para que as licenças possam ser acessadas. A execução
do programa em estações de trabalho com base na instalação da rede não
exige ativação individual. O Licenciamento deste programa é gerenciado
no mínimo por uma licença de servidor.

A vantagem principal é que é possível instalar Autodesk Navisworks Manage
2012 em um número de sistemas superior ao número de licenças adquiridas
(por exemplo, 25 licenças foram adquiridas, mas é possível instalar em 40
estações de trabalho). A qualquer momento, o Autodesk Navisworks Manage
2012 será executado no número máximo de sistemas para os quais você
tem licenças. Isto significa que você obtém uma verdadeira licença
flutuante.

■ Instalação independente com múltiplas instalações (opção
Independente) Escolha este tipo de instalação para instalações
independentes onde um único número de série e chave de produto são
utilizados para múltiplas instalações. Instalações independentes com
múltiplas instalações não se apoiam em um Network License Manager
para gerenciar licenças de produtos; no entanto, ainda é possível usar o
assistente de instalação do Autodesk Navisworks Manage 2012 para criar
imagens administrativas e implantações. O registro e a ativação são mais
automatizados para instalações independentes em múltiplas instalações.
Após a primeira ativação usando o número de série independente de
múltiplas instalações, a ativação ocorre automaticamente para todas as
estações de trabalho baseadas nesta instalação, desde que seus sistemas
estejam conectados à Internet.

■ Instalação independente (opção Independente) Escolha este tipo
de instalação para instalações independentes onde um número de série e
chave de produto únicos são utilizados para um única instalação. Como
com instalações independentes com múltiplas instalações, não se usa o
Gerenciador de Licença de Rede para gerenciar o licenciamento do
produto, mas a instalação, registro e ativação que ocorrem em cada estação
de trabalho.

Se você escolher um dos tipos de instalação autônoma, é possível prosseguir
para a seção Distribuir o programa na página 56.

Escolher um modelo de servidor de licenças

Se você escolher a opção Licença de Rede, será necessário decidir qual modelo
de servidor de licenças a ser utilizado para distribuir as licenças do produto.
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DICA Se estiver instalando um tipo de implementação independente ou um tipo
de instalação independente com múltiplas instalações, não precisará usar um
modelo de servidor de licença. Siga para a seção Distribuir o programa na página
56.

Para a instalação de licença de rede, use um dos seguintes modelos de servidores
de licença:
■ Modelo de servidor de licença único. O Gerenciador de Licença

de Rede é instalado em um único servidor, portanto, a gerência e atividade
da licença está restrita a este servidor. Um único arquivo de licença
representa o número total de licenças disponíveis no servidor.

■ Modelo de servidor de licença distribuído. As licenças são distribuídas
em mais de um servidor. Um arquivo de licença exclusivo é necessário para
cada servidor. Para criar um servidor de licença distribuído, é necessário
executar o Gerenciador de Licença de Rede em cada servidor que faz
parte do pool de servidores distribuídos.

■ Modelo de servidor de licença redundante.Usa-se três servidores
para autenticar um arquivo de licença única. Um servidor atua como o
servidor principal, enquanto os outros dois fornecem recursos de backup
em caso de falha nesse servidor principal. Com essa configuração, as licenças
continuarão a ser monitoradas e emitidas enquanto pelo menos dois
servidores permanecerem operacionais. O arquivo de licença em todos os
três servidores é o mesmo. O Gerenciador de Licença de Rede deve
ser instalado em cada servidor.

Cada um desses modelos de servidor de licença está descrito detalhadamente
no Guia de Licenciamento da Autodesk. É altamente recomendado que o guia
seja lido antes de se implementar o programa. É possível encontrar o Guia de
Licenciamento da Autodesk ao clicar no link Installation Help no canto
inferior esquerdo do assistente de implementação do Autodesk Navisworks
Manage 2012.

Configurar ferramentas de rede e seu servidor de
licenças

Se estiver planejando que os usuários executem o programa utilizando licenças
de rede, será necessário utilizar o Gerenciador de Licença de Rede.

O Gerenciador de Licença de Rede o ajudará a configurar e administrar
servidores de licença.
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Instalar o Gerenciador de Licença de Rede

O Gerenciador de Licença de Rede é usado para configurar e administrar
os servidores de licença.

Para instalar o Gerenciador de Licença de Rede

1 No assistente de Autodesk Navisworks Manage 2012Autodesk
Navisworks Manage 2012, clique em Install Tools and Utilities.

2 Na página Configure Installation, selecione Network License
Manager e clique em Install.

OBSERVAÇÃO É possível aceitar o caminho padrão de instalação (C:\Program

Files\Autodesk) ou clique em Procurar para especificar outro caminho. Se
você inserir um caminho não existente, será criada uma nova pasta com o
nome e o local fornecido.

AVISO Não instale o Gerenciador de Licença de Rede em uma unidade
remota. Quando você instala os arquivos do Gerenciador de Licença de
Rede, é preciso fornecer um caminho para uma unidade local. Especifique
a letra da unidade; não há suporte para a Convenção universal de
nomenclatura (UNC).

3 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.

4 Quando a página Instalação completada for exibida, clique em
Concluir.

Para ativar uma Licença de Rede através de
Autodesk.com

Se o seu produto não inclui o utilitário de Ativação de Licença de Rede, você
poderá ativar sua licença ao visitar https://registeronce.autodesk.com, e seguir as
instruções na tela.
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Configurar seu servidor de licenças

Configure um servidor de licença para poder gerenciar as licenças do produto
do Autodesk Navisworks.

Você pode configurar o servidor de licença com o utilitário lmtools.exe.

Você deve estar conectado com os direitos de Administrador ao trabalhar com
o utilitário LMTOOLS.

Para configurar seu servidor de licença

1 Execute um dos procedimentos a seguir:
■ (Windows XP) Clique em Iniciar ➤  Todos os

programas ➤ Autodesk ➤ Network License
Manager ➤ LMTOOLS.

■ (Windows Vista e Windows 7) Clique duas vezes no ícone LMTOOLS
na área de trabalho.

2 No programa Lmtools , na guia Service/License File , selecione a
opção Configure Using Services.

3 Clique na guia Config Services.

4 Na lista Service Name , selecione o nome do serviço que deseja utilizar
para gerenciar licenças.

Por padrão, o nome do serviço é FLEXnet Service 1. Se o FLEXnet® estiver
gerenciando outro software em seu computador além do software da
Autodesk, é possível alterar o nome do serviço para evitar confusão, por
exemplo, você pode renomear o FLEXnet Service 1 para Autodesk Server1.

OBSERVAÇÃO Se você tiver mais de um fornecedor de software que utiliza
o FLEXnet para o gerenciamento de licenças, a lista Service Name contém
mais de uma opção. Garanta que somente o serviço Autodesk esteja listado.

5 No campo Path to Lmgrd.exe File , insira o caminho para o domínio
Gerenciador de licença de rede (lmgrd.exe), ou clique em Procurar
para localizar o arquivo.

Por padrão, esse domínio é instalado na pasta C:\Program Files\Autodesk
Gerenciador de licença de rede.

6 Na caixa Caminho para o arquivo de instalação , insira o caminho
para seu arquivo de licença, ou clique em Procurar para localizar o
arquivo.
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7 Na caixa Caminho para o arquivo de registro de depuração ,
insira o caminho para criar o registro de depuração, ou clique em
Procurar para localizar um arquivo de registro existente.

Recomenda-se salvar na pasta \Program Files\Autodesk Gerenciador de
licença de rede . O arquivo de registro precisa ter uma extensão de arquivo
.log . Para novos arquivos de registro, você precisa inserir manualmente
a extensão .log .

8 Para executar o lmgrd.exe como um serviço, selecione Use Services.

9 Para iniciar automaticamente o lmgrd.exe quando o sistema inicia,
selecione Start Server at Power Up.

10 Clique em Save Service para salvar a nova configuração sob o nome
do serviço que você selecionou na etapa 4. Clique em Yes quando
perguntado se deseja salvar as configurações para o serviço.

11 Na guia Start/Stop/Reread faça um dos seguintes:
■ Se um serviço ainda não foi definido para a Autodesk, clique em

Start Server para iniciar o servidor de licença.

■ Se um serviço para a Autodesk já está definido e sendo executado,
clique em Ler novamente o arquivo de licença para atualizar o
Gerenciador de licença de rede com as alterações feitas no
arquivo de licença ou no arquivo Options.

O servidor de licença começa a ser executado e já está pronto para
responder às solicitações de clientes.

12 Feche o lmtools.exe.

Distribuir o programa

Após ter se preparado por completo para criar uma implementação, você estará
pronto para configurar e distribuir o Autodesk Navisworks utilizando o
assistente de Implementação e escolhendo um método de implementação.

Criar um compartilhamento de rede

Um compartilhamento de rede é uma pasta de instalação que você disponibiliza
para os computadores dos usuários em uma rede. Você aponta os usuários
para esta localização para instalar o programa. Crie um compartilhamento de
rede que será utilizado pelo assistente de Implementação do Autodesk
Navisworks durante a criação de uma implementação cliente.
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É necessário ter uma pasta compartilhada para os métodos de instalação de
licença de rede e independente com múltiplas instalações.

Recomenda-se nomear a pasta compartilhada de rede como Implementações
na área de trabalho do sistema onde deseja armazenar as implementações. É
possível então adicionar subpastas dentro da pasta compartilhada
Implementações que claramente indicam o nome do produto que planeja
implementar. Também é benéfico se planejar implementar múltiplos produtos.

Quaisquer subpastas que são colocadas dentro de uma pasta compartilhada
são automaticamente compartilhadas.

DICA Você precisa ter permissões de Controle completo definidas para sua
pasta compartilhada quando estiver criando suas imagens de implementação. Os
usuários devem ter permissões de leitura para acessar o compartilhamento de rede
e permissões administrativas nas estações de trabalho que tenham o programa
instalado.

Para criar seu compartilhamento de rede

1 Na área de trabalho de um servidor de rede, crie uma pasta denominada
Implementações.

2 Clique com o botão direito do mouse na pasta Implementações e clique
em Compartilhamento e Segurança (ou Compartilhamento).

3 Na caixa de diálogo Properties [nome da pasta], na guia Sharing,
selecione Share This Folder.

4 Especifique um Nome de compartilhamento, como Implementações,
se necessário.

5 Clique no botão Permissões. Na caixa de diálogo Permissões assegure
que Controle completo esteja ativo. Clique em OK.
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No Windows Vista e no Windows 7, clique com o botão direito na pasta
Implementações e então clique em Compartilhar. Na caixa de diálogo
Propriedades selecione Compartilhamento , e a seguir
Compartilhamento avançado para compartilhar a pasta. Clique no
botão Permissões para assegurar que Controle completo esteja ativo.
Clique em OK.

Estas etapas são importantes ao criar suas imagens de implementação.

6 Clique em OK ou em Fechar para fechar a caixa de diálogo
Propriedades.

7 Para cada produto que planeja instalar, crie uma subpasta na pasta
Implementações . Nomeie cada pasta com o nome de produto pertinente.

Minimizar as chances de falha na instalação

O processo de instalação do Autodesk Navisworks pode parar se alguns
aplicativos, como o Microsoft Outlook ou programas de verificação de vírus,
estejam em execução quando você estiver criando uma implementação. Feche
todos os aplicativos em execução e desative temporariamente os utilitários de
verificação de vírus.

Distribuir um produto Autodesk Navisworks

É possível escolher entre diversos métodos de distribuição de um programa
da Autodesk. O compartilhamento de rede é o método padrão.
■ Compartilhamento de rede.  Os usuário iniciam o programa com o

ícone de atalho criado com o assistente de Implementação. O programa é
instalado no computador local do usuário e um ícone do produto aparece
na sua área de trabalho.

OBSERVAÇÃO Os usuários devem ter permissões de leitura para acessar o
compartilhamento de rede e permissões administrativas nas estações de
trabalho que tenham o programa instalado.

■ Scripts. Um script executa um comando ou conjunto de comandos. Scripts
são semelhantes a arquivos de lote, porém mais flexíveis. Scripts de
instalação são úteis para a instalação independente de programas em
computadores conectados a uma rede. Scripts também são úteis para a
instalação de atualizações, extensões e ativadores em uma rede.
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■ Software de imagens. Você pode utilizar software de imagem, como o
Norton Ghost, para criar uma imagem mestre para distribuir os produtos
Autodesk. Uma vez criadas, as imagens mestre podem ser duplicadas para
outros computadores em sua instalação.

É preciso ter cuidado no uso de software de imagens, pois poderá resultar
em conflitos com o licenciamento do produto, instalações incompletas e
problemas com ativação.

Configurar uma implementação

O processo de implementação fornece diversas opções para criar e personalizar
suas implementações, portanto, você deve dedicar tempo suficiente para
completar o processo em uma etapa.

Para obter êxito, recomenda-se rever as seguintes informações e a lista de
verificação antes de iniciar. O processo de instalação é iniciado a partir do
assistente de Implementação. Após uma implementação ter sido criada, os
usuários acessam a implementação para instalar os produtos em seus
computadores.

Tarefas preliminares para uma implementação de
rede

Esta lista de verificação identifica tarefas preliminares a serem concluídas,
informações a serem coletadas e decisões a serem tomadas antes de criar uma
implementação de rede.

DICA Para revisar as configurações de implantação, incluindo detalhes da
configuração do produto, é possível criar uma implementação de teste. Após o
processo de aprendizado, é possível excluir a implementação de teste.

Lista de verificação de implementação

Revise os requisitos do sistema ao clicar no link Requisitos
do sistema no instalador. Confirme se a rede, os
servidores e as estações de trabalho cliente atendem aos
requisitos do sistema.

Instalar o Autodesk Navisworks para múltiplos usuários | 59



Lista de verificação de implementação

Você entende o tipo de licença que comprou. Se você
planeja uma implementação de licença de rede, também
deve estar familiarizado com o tipo de modelo de
servidor de licença que deseja usar e os nomes dos
servidores de licença.

Quaisquer ferramentas de suporte e utilitários foram
instaladas e ativadas. Por exemplo, se você estiver usando
uma licença de rede, instale o Network License Manager
do instalador.

É preciso localizar seu número de série e a chave do
produto. O número de série e a chave do produto estão
localizados no lado externo da embalagem do produto
ou no e-mail recebido se você efetuou o download de
seu produto ou uma atualização da Autodesk.

Ter identificado a localização (como uma pasta
compartilhada) onde as instalações irão residir para cada
programa se que planeja instalar.

Todos os outros programas foram fechados e o software
antivírus foi desativado.

Que tenha decidido quais idiomas serão incluídos em
sua imagem administrativa, e quais idiomas serão
utilizados para seu pacote de implementação.

OBSERVAÇÃO Os idiomas podem ser incluídos quando
você cria inicialmente uma implementação ou quando
você cria uma nova configuração da implantação, mas
não quando você modifica uma implementação.

Determine se deseja criar arquivos de log em
computadores individuais, na pasta de implementação
ou em ambos.
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Lista de verificação de implementação

Determine se deseja executar as instalações em modo
silencioso.

OBSERVAÇÃO Quando os produtos são instalados no
modo silencioso, o sistema do usuário pode ser
reinicializado automaticamente sem aviso quando a
instalação for concluída.

Identifique outras definições de configuração aplicáveis,
como localizações de arquivos de suporte, e se deseja
instalar os service packs automaticamente.

Você decidiu se deseja incluir configurações centralizadas
do produto com sua implementação, como opções
globais. espaços de trabalho, ferramentas de dados,
avatares, regras e testes personalizados do Clash
Detective, arquivos do Presenter, scripts de animação de
objetos etc.

Escolher um idioma

É possível selecionar um outro idioma para instruções de implementação e
um idioma para as instalações do produto no mesmo processo de
implementação.

Por exemplo, se for necessário fornecer o Autodesk Navisworks para usuários
em um ou mais idiomas diferentes do seu, você poderá fazer o download de
pacotes de idiomas do instalador, o que permitirá implantar o produto nos
idiomas que precisa suportar.

OBSERVAÇÃO Os pacotes de idiomas somente podem ser incluídos em uma
imagem administrativa durante a criação da implementação e não durante a
modificação.

Quando você inicia o processo de implementação, o instalador
automaticamente determina o idioma de seu sistema operacional. Se um
idioma suportado for detectado, suas páginas de implementação são exibidas
naquele idioma. Se você deseja alterar aquele idioma, basta escolher outro
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idioma na lista Idioma do instalador na primeira página do assistente de
Instalação.

OBSERVAÇÃO Alguns produtos podem não ter o suporte para múltiplos idiomas
no momento da liberação do produto. Suporte de idiomas adicionais pode estar
disponível em outro momento. Consulte http://support.autodesk.com para verificar
a disponibilidade de pacotes de idiomas adicionais.

Utilizar pacotes de idiomas

O pacote de idioma dá suporte ao uso de diferentes idiomas em cada produto
do Autodesk Navisworks, incluindo exportadores. Os nomes dos pacotes
começam com NAVFREE_, NAVSIM_, NAVMAN_ e exporters_
respectivamente.

OBSERVAÇÃO Somente um pacote de idioma pode ser selecionado para cada
produto para implementação.

É possível instalar manualmente, mais tarde, pacotes de idiomas adicionais
aos produtos do Autodesk Navisworks, clicando duas vezes no arquivo MSI
do pacote de idiomas. Alternativamente, é possível definir e executar scripts
para instalar pacotes de idiomas adicionais.

Os pacotes de idioma estão localizados no DVD de instalação e em mídia não
empacotada baixada da pasta x86 para produtos de 32 bits e da pasta x64
para produtos de 64 bits.

■ Os pacotes de idiomas para produtos específicos estão incluídos na pastas
NAVFREE , NAVSIM, NAVMAN e nas subpastas NWEXPORT de x86
e x64.

■ Pacotes de idioma para idiomas específicos estão incluídos nas subpastas
en-US (Inglês), de-DE (Alemão), es-ES (Espanhol), fr-FR (Francês), it-IT
(Italiano), ja-JP (Japonês), ko-KR (Coreano), pt-BR (Português do Brasil),
ru-RU (Russo) e zh-CN (Chinês PRC) das pastas dos produtos.

Suas escolhas de implementação

Ao criar uma instalação, serão feitas diversas escolhas durante o processo, para
a criação de diversas imagens de instalação de cliente e tipos de instalação. As
seções a seguir descrevem suas escolhas em mais detalhes.
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O que é o modo silencioso?

Quando o modo silencioso está ativo e o usuário inicia a implementação, esta
prossegue sem nenhuma entrada explícita pelo usuário.

Nenhuma caixa de diálogo é apresentada que exija a interação do usuário.
Isso inclui as caixas de diálogo de erros e de avisos. Verifique se há erros no
arquivo de registro que podem ocorrem no caso de haver problemas de
instalação.

Ative o modo silencioso clicando na caixa de seleção Run installations in
silent mode (Executar instalações no modo silencioso) na página Configure.

Para evitar a falha de uma instalação silenciosa em computadores cliente:
■ Instale o Microsoft .NET Framework 4.0 nos computadores cliente

■ Reinicie os computadores cliente antes de instalar Autodesk Navisworks
Manage 2012

Especificar localizações de arquivos de registro

Na página Create Deployment ➤ Configure (Criar a
implementação/Configurar) do processo de implementação, você decide se
criará ou não um arquivo de registro selecionando a caixa de seleção apropriada
na área Installation Settings (Configurações da instalação). O programa
possui dois tipos de arquivos de registro com os quais é possível monitorar
informações sobre as implantações e instalações.

■ Registro de rede. O arquivo de registro de rede mantém um registro de
todas as estações de trabalho que executam a implementação. O registro
lista o nome do usuário, nome da estação de trabalho e o status da
instalação. Consulte este arquivo para obter informações de status e detalhes
sobre os problemas encontrados pelos usuários durante a instalação (por
exemplo, pouco espaço em disco ou permissões inadequadas).
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O registro de rede é nomeado com o mesmo nome escolhido para a
implementação. É possível especificar onde o arquivo de registro será criado
ao inserir um caminho UNC (universal naming convention) válido ou
caminho codificado em sua rede, por exemplo
\\MyComputer\Autodesk\<Autodesk product>. Os usuários devem utilizar
seu nome real do computador, em vez de Meu Computador.

OBSERVAÇÃO O diretório que contém o registro de rede deve ser uma pasta
compartilhada, onde os usuários que instalam o programa possuem permissões
de alteração. Senão, as instalações de usuários bem ou mal sucedidas não
poderão ser gravadas no arquivo de registro.

■ Registro de cliente. O registro de cliente contém informações detalhadas
sobre instalação para cada estação de trabalho. Essas informações podem
ser úteis para o diagnóstico de problemas de instalação. O registro do cliente
está localizado no diretório "Temp" de cada estação de trabalho cliente.

Para especificar a localização de um arquivo de registro

1 Ao criar uma implementação, na página Configure Deployment,
selecione a caixa de seleção Create a Network Log File. Insira o nome
da pasta onde deseja que o registro de rede esteja localizado.

2 Se você deseja criar um registro de cliente, selecione a opção Create a
Log File in Each Workstation's Temp Folder (Criar um arquivo
de log na pasta Temp de cada estação de trabalho).

3 Clique em Avançar.

Selecionar um tipo de licença

Ao configurar sua implementação, é necessário escolher o tipo de instalação
com base no tipo de licença de software comprado: independente ou de rede.
Também deve-se selecionar o modelo do servidor de licença que deseja usar
para distribuir licenças do produto.

IMPORTANTE Dependendo do tipo de opção escolhida, licença de rede ou
independente, observe que é preciso utilizar o mesmo tipo de instalação para
todos esses produtos em sua sessão de implementação. Caso selecione produtos
que não suportam o tipo de licença adquirida, não será possível ativar estes
produtos.
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Especificar o tipo de licença a ser usada durante a implementação

■ Licença independente (um único número de série único para um único
local). Para uma Licença independente, é necessário instalar, registrar
e ativar o programa em cada estação de trabalho.

■ Licença de rede. Neste tipo de instalação, é necessário instalar o programa
nas estações de trabalho com os arquivos e as entradas de registro que
permitem que o programa se comunique com o Gerenciador de licença
de rede. Também é possível definir a configuração do Gerenciador de
licença de rede para que as licenças possam ser acessadas. A execução
do programa em estações de trabalho com base na instalação da rede não
exige ativação individual. O Licenciamento deste programa é gerenciado
no mínimo por uma licença de servidor.

Especificar o modelo de servidor de licença durante a implementação

Se você escolhe a opção Licença de Rede é preciso decidir qual modelo de
servidor de licença será usado para distribuir as licenças de produto - modelo
de servidor de licença único, distribuído ou redundante.

Se estiver implantando um tipo de instalação independente ou um tipo de
instalação independente com múltiplas instalações, não precisará usar um
modelo de servidor de licença. Para obter mais informações sobre modelos de
servidores, consulte Escolher um modelo de servidor de licenças na página
52.

Para implementar uma Licença independente

1 Ao criar uma implementação, na página Product Information,
selecione Stand-Alone (Independente).

2 Clique em Avançar.

Para implementar uma licença de rede usando um modelo de servidor de
licença único

1 Ao criar uma implementação, na página Informações de produto
Product Information (Informações do produto), selecione a opção
Network (Rede).

Instalar o Autodesk Navisworks para múltiplos usuários | 65



2 Selecione Servidor de licença único como o modelo de servidor de
licença a ser usado com Gerenciador de licença de rede.

Se você já tiver utilizado o Gerenciador de licença de rede para criar
um modelo de servidor de licença, será necessário selecionar o mesmo
modelo de servidor de licença nessa etapa. Se você ainda não utilizou o
Gerenciador de licença de rede para criar um modelo de servidor
de licença, certifique-se de selecionar no Gerenciador de licença de
rede as mesmas configurações escolhidas aqui.

3 Insira o nome do servidor que irá executar o Gerenciador de licença
de rede, ou clique no botão Procurar para localizar o servidor. Clique
em Avançar.

Para obter mais informações sobre modelos de licença de rede e como
configurar seu servidor de licenças, consulte Escolher um modelo de servidor
de licenças na página 52 ou Configurar seu servidor de licenças na página 55.

Para implementar uma licença de rede usando um modelo de servidor de
licença distribuído

1 Ao criar uma implementação, na página Informações de produto
Product Information (Informações do produto), selecione a opção
Network (Rede).

2 Selecione Servidor de licença distribuído como o modelo de servidor
de licença que deseja usar com o Gerenciador de licença de rede.

Se você já tiver utilizado o Gerenciador de licença de rede para criar
um modelo de servidor de licença, será necessário selecionar o mesmo
modelo de servidor de licença nessa etapa. Se você ainda não utilizou o
Gerenciador de licença de rede para criar um modelo de servidor
de licença, certifique-se de selecionar no Gerenciador de licença de
rede as mesmas configurações escolhidas aqui.

3 Insira o nome de um dos servidores que irá executar o Gerenciador de
licença de rede, ou clique no botão Procurar para localizar o servidor.
Clique em Adicionar para adicionar ao Conjunto de servidores. Um
vez que todos os servidores estejam adicionados na lista Conjunto de
servidores , utilize os botões Mover acima e Move abaixo para
organizar os servidores na ordem que deseja que sejam procurados por
uma estação de trabalho cliente. Deve-se inserir ao menos dois servidores.
Clique em Avançar.

Para obter mais informações sobre modelos de licença de rede e como
configurar seu servidor de licenças, consulte Escolher um modelo de servidor
de licenças na página 52 ou Configurar seu servidor de licenças na página 55.
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Para implementar uma licença de rede usando um modelo de servidor de
licença redundante

1 Ao criar uma implementação, na página Informações de produto
Product Information (Informações do produto), selecione a opção
Network (Rede).

2 Selecione Servidor de licença redundante como o modelo de servidor
de licença que deseja usar com o Gerenciador de licença de rede.

Se você já tiver utilizado o Gerenciador de licença de rede para criar
um modelo de servidor de licença, será necessário selecionar o mesmo
modelo de servidor de licença nessa etapa. Se você ainda não utilizou o
Gerenciador de licença de rede para criar um modelo de servidor
de licença, certifique-se de selecionar no Gerenciador de licença de
rede as mesmas configurações escolhidas aqui.

3 No campo Nome do primeiro servidor , insira um nome de servidor
para um servidor que irá executar o Gerenciador de licença de rede,
ou clique no botão Procurar para localizar o servidor Insira os nomes
dos servidores para os dois últimos servidores que serão usados no pool
de servidores redundantes. Clique em Avançar.

OBSERVAÇÃO Se você não está seguro sobre como obter o nome de host
do servidor, consulte Plan Your License Server Configuration no Guia
de Licenciamento da Autodesk ao clicar no link Ajuda da Instalação no
canto inferior esquerdo do assistente de Implementação.

Para obter mais informações sobre modelos de licença de rede e como
configurar seu servidor de licenças, consulte Escolher um modelo de servidor
de licenças na página 52 ou Configurar seu servidor de licenças na página 55.

Personalizar a implementação

Ao criar uma implementação, é possível aceitar as configurações padrão para
os produtos que você decidir instalar ou você pode definir essas configurações
para criar uma implementação personalizada. Para definir as configurações
do produto, na página Create Deployment do instalador, assegure-se de
que o produto está selecionado para a instalação e, a seguir, selecione o produto
na lista de rolagem. O painel de configuração é aberto. A maioria dos produtos
permite escolher um tipo de instalação, que pode ser Typical (Típica), para
selecionar as opções mais comuns, ou Custom (Personalizada) para revisar
as opções mais detalhadamente. Você também pode selecionar as Project
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and Site Folders (pastas Projeto e Local) e definir configurações adicionais
de implementação.

Uma vez configuradas as configurações conforme necessário, clique no nome
do produto para fechar o painel de configuração.

OBSERVAÇÃO Os parâmetros de configuração que você seleciona se aplicam a
todas as instâncias do produto instalado a partir da implementação. Após uma
implementação ter sido criada, essas configurações somente podem ser alteradas
modificando a implementação. Para obter mais informações, consulte Modificar
uma implementação na página 75.

Configurar produtos individuais

Como parte do processo de opções de implementação, é possível aceitar a
configuração padrão para os produtos que você decidir instalar ou você pode
definir essas configurações para criar uma implementação personalizada.

■ Típica. Instalar os recursos mais comuns do aplicativo. Esta opção é
recomendada para a maioria dos usuários.

■ Personalizada. Instala apenas os recursos selecionados do aplicativo.

Para uma implementação típica, especifique uma localização para o produto

1 Durante a implementação, Typical (Típico) é o tipo de instalação padrão.
É possível confirmá-lo na página Configure Deployment (Configurar
implantação) clicando em um nome de produto para abrir o painel de
configuração no qual é possível visualizar o tipo de instalação.

2 Insira o caminho na estação de trabalho cliente, onde deseja instalar o
programa, por exemplo C:\Arquivos de programas\<produto da Autodesk>.

3 Clique no nome do produto novamente para fechar o painel de
configuração.

Para uma implementação personalizada, escolha os recursos opcionais e
especifique uma localização para o produto.

1 Durante a implementação, na página Configure Deployment, clique
em um nome de produto para abrir o painel de configuração.

2 Selecione a opção Custom como o tipo de instalação que deseja.

3 Na lista Selecionar os recursos a serem instalados, selecione os
recursos que deseja instalar.
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As opções são as seguintes:

Contém o controle ActiveX redistribuível
do Autodesk Navisworks.

Redistributable ActiveX Control

Contém a interface Component Object
Model para personalizar e estender os
recursos do Autodesk Navisworks.

API

Contém diversos arquivos de amostras de
recursos.

Exemplo de arquivos NWD

Contém um complemento para os
comandos de executar e agendar.

Utilitário de Lote

Contém o conjunto completo dos arquivos
do Autodesk Navisworks.

Programa

Contém diversos arquivos do Rich
Photorealistic Content.

RPCs de amostra

OBSERVAÇÃO Para os plugins do exportador do Autodesk Navisworks, no
momento não é possível alterar quais plugins são instalados. Por padrão, os
plugins de exportação para todos os produtos de terceiros instalados em
um computador cliente serão ativados automaticamente.

Se, após efetuar alterações nos recursos, você decidir que deseja ter as
seleções originais, clique no botão Restore Defaults.

4 Clique no nome do produto para fechar o painel de configuração.

5 Insira o caminho na estação de trabalho cliente, onde deseja instalar o
programa, por exemplo C:\Arquivos de programas\<produto da Autodesk>.

Selecionar as pastas Projeto e Terreno (opcional)

Quando você define sua implementação, poderá compartilhar diversas
configurações do Autodesk Navisworks através de todo um terreno de projeto,
ou através de um grupo de projetos específico, dependendo no nível de
granularidade requerido.
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Consulte também:

Como compartilho as configurações do Autodesk Navisworks com base
no projeto e terreno? na página 80

Para selecionar as pastas Projeto e Terreno

1 Na página Configure Installation, clique no nome do produto para
abrir o painel de configuração no qual é possível revisar e alterar as
configurações.

2 Na caixa Project Folder, clique no botão Browse para selecionar o
diretório que contém as configurações do Autodesk Navisworks específicas
para um grupo de projetos.

3 Na caixa Site Folder, clique no botão Browse para selecionar o diretório
que contém as configurações padrão do Autodesk Navisworks por todo
o local do projeto.

Selecionar outras opções de configuração

É possível personalizar as preferências do usuário, incluir arquivos e service
packs adicionais, além de especificar as opções do Communication Center
(Centro de comunicações) e o acesso aos recursos on-line para cada um dos
produtos que você decidir instalar. Consulte Outras opções de configuração
da implementação na página 86.

Criar uma implementação

Uma implementação contém um arquivo MST (Microsoft Transform) que
modifica o comportamento-padrão do programa de instalação do AutoCAD.

Ao iniciar uma implementação, é necessário selecionar a localização de sua
imagem administrativa, o nome da implementação e se seus sistemas-alvo são
sistemas operacionais de 32 ou 64 bits.

Criar uma implementação utilizando valores
padrão

Esta é a maneira mais rápida de criar imagens de implementação de cliente.
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Para criar uma implementação padrão usando valores padrão

1 Feche todos os aplicativos em execução no seu computador e inicie o
assistente de Instalação.

2 No assistente de Instalação, se necessário, selecione um idioma
alternativo para o assistente de Instalação no menu suspenso
Installation Instructions (Instruções de Instalação) e, a seguir, clique
em Create Deployment (Criar implementação).

3 Na página Configure Deployment, seção Administrative Image,
especifique os seguintes dados:

a No campo Deployment Configuration Name (Nome da
configuração de implementação), insira um nome descritivo para
a implementação que identifique o grupo de usuários, a plataforma
ou outro atributo para diferenciar essa implementação das outras.
O nome aqui inserido corresponde ao nome do atalho que os
usuários acessarão para instalar o produto.

b No campo Administrative Image Path, insira o caminho de
sua localização de rede compartilhada existente ou utilize o botão
Browse para navegar para essa localização. Esta área é onde você
cria e armazena sua imagem administrativa. Os usuários instalam
o programa a partir desta localização.

OBSERVAÇÃO Para obter instruções sobre como criar um
compartilhamento de rede, consulte Criar um compartilhamento de
rede na página 56.

c Em Target Platform, selecione 32 bits ou 64 bits para seu sistema
operacional alvo. Esta seleção não identifica o sistema em que a
implementação foi criada. Ela identifica o sistema alvo.

d Escolha se quer Include Only the Products Required by this
Configuration (Incluir somente os produtos requeridos por esta
configuração).
■ Se a opção estiver selecionada, a implementação não poderá ser

modificada no futuro para incluir produtos adicionais.

■ Se não estiver selecionada, a imagem administrativa incluirá
todos os produtos possíveis; assim, a implementação atual pode
ser modificada de qualquer forma.
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DICA  Recomenda-se incluir todos os produtos disponíveis se você planeja
criar várias implementações desta imagem administrativa com outras
combinações de produtos e se preferir não utilizar a mídia de instalação
novamente. Se existem produtos que nunca são utilizados ou não se espera
criar instalações adicionais, você deve selecionar um subconjunto de produtos.

4 Na seção Installation Settings, selecione uma ou mais destas opções:
■ Silent Mode (Modo silencioso). A instalação é executada no plano

de fundo, sem que seja solicitada qualquer entrada para o usuário.

OBSERVAÇÃO O modo silencioso reiniciar automaticamente o
computador do usuário sem aviso após a instalação.

■ Workstation Log (Registro da estação de trabalho). O arquivo de
log em cada estação de trabalho pode possibilitar aos usuários reverem
e solucionarem problemas de suas próprias instalações.

■ Network Log (Registro de rede). O arquivo de log em uma
localização central dá suporte ao administrador de rede na revisão
dos dados para todas as instalações.

OBSERVAÇÃO O arquivo de log de rede deve estar em uma pasta
compartilhada à qual os usuários da implementação tenham acesso de
leitura e gravação. Caso contrário, os dados de registro das instalações
de usuários não poderão ser gravadas no arquivo de log. Para obter mais
informações a respeito de arquivos de registro, consulte Especificar
localizações de arquivos de registro na página 63.

5 Clique em Avançar.

6 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.

OBSERVAÇÃO Se não concordar com os termos da licença e desejar terminar
a instalação, clique em Cancelar.

7 Na página Product Information, selecione um License Type na página
64 (Tipo de licença) e insira seu Serial Number (Número de série) e a
Product Key (chave do produto). Se os dados forem válidos, marcas de
seleção verdes aparecerão. Clique em Avançar.

8 Na página Configure Deployment, selecione os produtos a serem
incluídos na implementação e, se necessário, adicione pacotes de idiomas
do menu suspenso Product Language (consulte Choose a Language
na página 35).
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9 Clique em Create.

Após a criação da implantação, a página Deployment Configuration
Complete é aberta, apresentando caminhos úteis para a nova
implementação e um link para registrar os produtos on-line.

10 Após terminar de utilizar esta tela, clique em Finish.

Criar uma implementação utilizando valores
configurados ou personalizados

Caso planeje alterar sua implementação, como a remoção de recursos ou a
restrição de acesso aos recursos on-line, você pode criar uma implementação
configurada ou personalizada.

Para criar uma implementação personalizada

1 Feche todos os aplicativos em execução no seu computador e inicie o
assistente de Instalação.

2 No assistente de Instalação, se necessário, selecione um idioma
alternativo para o assistente de Instalação no menu suspenso
Installation Instructions (Instruções de Instalação) e, a seguir, clique
em Create Deployment (Criar implementação).

3 Na página Configure Deployment, seção Administrative Image,
especifique os seguintes dados:

a No campo Deployment Configuration Name (Nome da
configuração de implementação), insira um nome descritivo para
a implementação que identifique o grupo de usuários, a plataforma
ou outro atributo para diferenciar essa implementação das outras.
O nome aqui inserido corresponde ao nome do atalho que os
usuários acessarão para instalar o produto.

b No campo Administrative Image Path, insira o caminho de
sua localização de rede compartilhada existente ou utilize o botão
Browse para navegar para essa localização. Esta área é onde você
cria e armazena sua imagem administrativa. Os usuários instalam
o programa a partir desta localização.

OBSERVAÇÃO Para obter instruções sobre como criar um
compartilhamento de rede, consulte Criar um compartilhamento de
rede na página 56.

Instalar o Autodesk Navisworks para múltiplos usuários | 73



c Em Target Platform: selecione 32 bits ou 64 bits para o sistema
operacional de destino. Esta seleção não identifica o sistema em
que a implementação foi criada. Ela identifica o sistema alvo.

d Escolha se quer Include Only the Products Required by this
Configuration (Incluir somente os produtos requeridos por esta
configuração).
■ Se a opção estiver selecionada, a implementação não poderá ser

modificada no futuro para incluir produtos adicionais.

■ Se não estiver selecionada, a imagem administrativa incluirá
todos os produtos possíveis; assim, a implementação atual pode
ser modificada de qualquer forma.

DICA  Recomenda-se incluir todos os produtos disponíveis se você planeja
criar várias implementações desta imagem administrativa com outras
combinações de produtos e se preferir não utilizar a mídia de instalação
novamente. Se existem produtos que nunca são utilizados ou não se espera
criar instalações adicionais, você deve selecionar um subconjunto de produtos.

4 Na seção Installation Settings, selecione uma ou mais destas opções:
■ Silent Mode (Modo silencioso). A instalação é executada no plano

de fundo, sem que seja solicitada qualquer entrada para o usuário.

OBSERVAÇÃO O modo silencioso reiniciar automaticamente o
computador do usuário sem aviso após a instalação.

■ Workstation Log (Registro da estação de trabalho). O arquivo de
log em cada estação de trabalho pode possibilitar aos usuários reverem
e solucionarem problemas de suas próprias instalações.

■ Network Log (Registro de rede). O arquivo de log em uma
localização central dá suporte ao administrador de rede na revisão
dos dados para todas as instalações.

OBSERVAÇÃO O arquivo de log de rede deve estar em uma pasta
compartilhada à qual os usuários da implementação tenham acesso de
leitura e gravação. Caso contrário, os dados de registro das instalações
de usuários não poderão ser gravadas no arquivo de log. Para obter mais
informações a respeito de arquivos de registro, consulte Especificar
localizações de arquivos de registro na página 63.

5 Clique em Avançar.

6 Revise o contrato de licença de software da Autodesk para o seu país ou
região. É necessário aceitar os termos do contrato para prosseguir com a
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instalação. Escolha seu país ou região, clique em Aceito e a seguir clique
em Avançar.

OBSERVAÇÃO Se não concordar com os termos da licença e desejar terminar
a instalação, clique em Cancelar.

7 Na página Product Information, selecione um License Type na página
64 (Tipo de licença) e insira seu Serial Number (Número de série) e a
Product Key (chave do produto). Se os dados forem válidos, marcas de
seleção verdes aparecerão. Clique em Avançar.

8 Na página Configure Deployment, selecione os produtos a serem
implantados e, se necessário, adicione pacotes de idiomas do menu
suspenso Product Language (consulte Choose a Language na página
35).

9 Se precisar configurar parâmetros para um produto, clique no nome do
produto para abrir o painel de configuração, onde é possível revisar e
alterar as configurações. Consulte Personalizar a implementação na
página 67.

OBSERVAÇÃO Os parâmetros de configuração que você seleciona se aplicam
a todas as instâncias do produto instalado a partir da implementação. Após
uma implementação ter sido criada, essas configurações somente podem
ser alteradas modificando a implementação.

10 Clique no nome do produto para fechar o painel de configuração.

11 Clique em Create.

Após a criação da implantação, a página Deployment Configuration
Complete é aberta, apresentando caminhos úteis para a nova
implementação e um link para registrar os produtos on-line.

12 Após terminar de utilizar esta tela, clique em Finish.

Modificar uma implementação (opcional)

Após a criação de uma implementação, pode ser necessário modificar a
implementação para algumas estações de trabalho cliente.

É possível aplicar uma correção ou selecionar diversos arquivos personalizados
que não fazem parte da imagem administrativa base. É possível realizar
modificações tais como alteração do diretório de instalação do drive C para o
drive D.
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Para modificar uma implementação

1 Abra a pasta de rede compartilhada onde originalmente decidiu colocar
a implementação de seu produto.

2 Na pasta Ferramentas , clique duas vezes no atalho Criar e modificar
uma implementação.

Isso reabre o assistente de Implementação.

3 Clique nas páginas de implementação e faça as alterações necessárias.

4 Após todas as modificações terem sido feitas, clique em Criar a
implementação.

Apontar usuários para a imagem administrativa

Quando tiver completado o processo de implementação, estará pronto para
que os usuários instalem a implementação recém-criada ou modificada.

Os usuários devem ser notificados sobre o atalho criado na imagem
administrativa. O atalho tem o mesmo nome que foi escolhido ao criar a
implementação na página 70.

Para apontar usuários para a imagem administrativa

■ O método mais simples de notificar os usuários sobre como instalar a
implementação é enviar um e-mail contendo instruções sobre como
executar o atalho. Essas instruções devem incluir pelo menos a localização
da implementação e outras instruções sobre como clicar duas vezes no
atalho para essa implementação.

Desinstalar um produto da Autodesk

Quando você desinstala um produto da Autodesk, todos os componentes são
removidos no processo.

Isso significa que, mesmo se você já tiver adicionado ou removido componentes
ou se tiver reinstalado ou reparado um produto da Autodesk, a desinstalação
removerá todos os arquivos de instalação do programa de seu sistema.
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IMPORTANTE  Não utilize programas de limpeza do registro nem tente modificar
as entradas de registro sozinho para desinstalar um produto da Autodesk. Não
seguir o procedimento oficial de desinstalação resultará na impossibilidade de
instalar o software.

Para desinstalar o programa

1 Execute um dos procedimentos a seguir:
■ (Windows XP) Clique no menu Iniciar ➤ Configurações ➤ Painel

de controle ➤ Adicionar ou remover programas.

■ (Windows Vista e Windows 7) Clique em Iniciar ➤ Painel de
controle ➤ Programas e recursos.

2 Na lista de programas, clique em Autodesk Navisworks Manage 2012 e
então em Alterar/Remover (Windows XP) ou Desinstalar/Alterar
(Windows Vista e Windows 7).

O assistente de instalação do Autodesk Navisworks Manage 2012 reabre
em modo de manutenção.

3 Clique em Desinstalar.

4 Na página UninstallAutodesk Navisworks Manage 2012, clique em
Next para remover o Autodesk Navisworks do sistema.

5 Quando informado que o produto foi desinstalado com êxito, clique em
Concluir.

OBSERVAÇÃO Mesmo se o Autodesk Navisworks for removido do sistema, a
licença do software permanecerá. Se você reinstalar o Autodesk Navisworks
futuramente, não será necessário registrar e ativar o programa novamente.

Solução de problemas de instalação
Esta seção fornece soluções para questões de instalação e respostas para
perguntas frequentes que podem surgir ao instalar seus produtos.

Informações adicionais para resolução de problemas e suporte estão disponíveis
em http://support.autodesk.com.
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Questões gerais sobre a instalação

Esta seção fornece soluções para questões de instalação e respostas para
perguntas frequentes que podem surgir ao instalar seus produtos.

Como posso verificar se meu driver de placa
gráfica precisa ser atualizado?

É recomendável assegurar que o seu computador possui a placa gráfica mais
atual para obter o melhor desempenho de exibição possível.

Para identificar o driver de sua placa gráfica

1 Inicie o Autodesk Navisworks Manage 2012.

2 Na caixa InfoCenter, clique na seta para baixo ao lado do botão
Help ➤ System Info.

A caixa de diálogo de informações do Autodesk Navisworks Manage 2012
é aberta.

3 Reveja as informações sobre seu sistema, incluindo o driver da placa
gráfica e a versão do driver, e clique em OK para fechar a caixa de diálogo.

Para procurar na Web por um driver de placa gráfica atualizado

■ Use o Windows Update. Se um driver de placa gráfica mais recente estiver
disponível, selecione-o para que o Windows possa efetuar o download e
instalar.

■ Pesquise no website do fabricante da placa gráfica pelo tipo de placa gráfica
instalada. Se um driver de placa gráfica mais recente estiver disponível,
instale-o seguindo as instruções fornecidas pelo fabricante.

Para instalar um driver de placa gráfica atualizado

1 Consulte a Web para saber se um driver atualizado está disponível.
■ Use o Windows Update.

■ Pesquise no website do fabricante da placa gráfica pelo tipo de placa
gráfica instalada.

2 Se um driver de placa gráfica mais recente estiver disponível, siga as
instruções do site para efetuar o download e instalá-lo.
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Como trocar minha licença de independente para
rede ou de rede para independente?

Se você apenas inseriu o tipo de licença errado por engano e ainda estiver
executando o instalador, utilize o botão Back para retornar para a página
Product Information e alterar o License Type.

Se você deseja alterar o tipo de licença para um produto instalado, entre em
contato com o revendedor ou fornecedor de licenças oficial da Autodesk para
obter a nova licença e o número de série. Depois, desinstale o produto e execute
uma nova instalação para alterar o tipo de licença e inserir o novo número de
série.

Ao executar uma instalação Típica, o que é
instalado?

Uma instalação Típica inclui os seguintes recursos:

Contém o controle ActiveX redistribuível
do Autodesk Navisworks.

Redistributable ActiveX Control

Contém a interface Component Object
Model para personalizar e estender os
recursos do Autodesk Navisworks.

API

Contém diversos arquivos de amostras de
recursos.

Exemplo de arquivos NWD

Contém um complemento para os
comandos de executar e agendar.

Utilitário de Lote

Contém o conjunto completo dos arquivos
do Autodesk Navisworks.

Programa

Contém diversos arquivos do Rich
Photorealistic Content.

RPCs de amostra
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Porque preciso especificar a pasta do projeto e a
pasta de terreno?

Você pode compartilhar configurações globais, espaços de trabalho, ferramentas
de dados, avatares, regras e testes personalizados do Clash Detective, arquivos
do Presenter, scripts de animação de objeto etc. do Autodesk Navisworks com
outros usuários.

Estas configurações podem ser compartilhadas através de todo um local de
projeto, ou através de um grupo de projetos específico, dependendo no nível
de granularidade.

O Autodesk Navisworks examina o perfil do usuário atual e os perfis de todos
os usuários na máquina local e, a seguir, verifica as configurações no Project
Directory e no Site Directory. Os arquivos no Project Directory tem
prioridade.

Como compartilho as configurações do Autodesk
Navisworks com base no projeto e terreno?

Compartilhar configurações do Autodesk Navisworks requer exportar as
configurações desejadas como um arquivo XML para a pasta global_options
apropriada dos diretórios Site ou Project. O nome do arquivo XML não é
significante. No entanto, ele precisa ser armazenado na pasta global_options.

DICA Quando você configura opções globais, poderá bloquear algumas das opções
para prevenir que os usuários ou editem em outro momento em máquinas locais.
Para criar um arquivo de opções globais bloqueadas, execute o Options Editor
independente a partir da linha de comando ao digitar
“drive:pathname\OptionsEditor.exe” -l. O Options Editor é aberto com o
recurso de bloqueio.

Para compartilhar configurações com base um terreno e projeto

1 Crie diretórios Terreno e Projeto e subpastas apropriados em uma
localização central para ser acessa por outros usuários do Navisworks.
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2 No Autodesk Navisworks, clique no botão do aplicativo  ➤ Options
Editor.

3 Clique em Export.

4 Na caixa de diálogo Select Options to Export, verifique todas as
opções que deseja exportar e clique em OK.

5 Na caixa de diálogo Save As, nomeie o arquivo XML como desejado e
salve-o na pasta global_options no diretório Site ou Project apropriado.

Consulte também:

Opções de localização na página 166

Opções do Autodesk Navisworks na página 161

Selecionar as pastas Projeto e Terreno (opcional) na página 69

Como é possível alterar quais plugins do
exportador são instalados?

Para os plugins do exportador do Autodesk Navisworks, é possível alterar quais
plugins são instalados clicando em um plugin do exportador a fim de abrir o
painel de configuração na página Configure Deployment do assistente
Installation.

 Indica o software de terceiros já instalado no computador.

 Indica plugins para o software de terceiros, que não estão instalados ou não
foram detectados pelo assistente Installation.
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Selecione as caixas de seleção para todos os plugins requeridos. Se o software
de terceiros não foi detectado pelo assistente, é possível ativar manualmente
os plugins para o software. A seleção da caixa de seleção automaticamente
abre a caixa de diálogo, que permite procurar pelo diretório correto de
instalação do software.

Como registrar e ativar o Autodesk Navisworks?

Quando você inicia o Autodesk Navisworks Manage 2012 pela primeira vez,
o assistente Product Activation é exibido. Você pode ativar o Autodesk
Navisworks agora ou executar o Autodesk Navisworks e ativá-lo posteriormente.

Até você registrar e inserir um código de ativação válido para o Autodesk
Navisworks Manage 2012, estará operando o programa no modo de teste e o
assistente Product Activation será exibido por 30 dias a contar do dia da
primeira execução do programa. Se depois de 30 dias executando o Autodesk
Navisworks Manage 2012 no modo de teste você não tiver registrado e
fornecido um código de ativação válido, sua única opção será registrar e ativar
o Autodesk Navisworks Manage 2012. Não será possível executar o modo de
teste após os 30 dias terem expirado. Depois de registrado e ativado o Autodesk
Navisworks Manage 2012, o assistente Product Activation não será mais
exibido.

DICA A forma mais rápida e confiável de registrar e ativar o produto é pela Internet.
Basta inserir as informações de registro e enviá-las para a Autodesk pela Internet.
Depois que você enviar as informações, o registro e a ativação serão quase
instantâneos.

Se você instalou Autodesk Navisworks como parte de um conjunto, um único
período de teste, normalmente 30 dias, se aplica a todos os produtos da
Autodesk no conjunto. Quando o primeiro produto é iniciado, a contagem
regressiva do período de teste começará para todos os produtos. Se você não
ativar um dos produtos antes que o período de teste termine, o acesso a todos
os produtos será negado. Após o período de teste terminar, você poderá
restaurar o acesso aos produtos ao inserir um código de ativação.

Para registrar e ativar o Autodesk Navisworks Manage 2012

1 Clique em Iniciar ➤ Todos os programas ➤ Autodesk ➤ Autodesk
Navisworks Manage 2012 ➤ Autodesk Navisworks Manage 2012.

2 No assistente de ativação do produto do Autodesk Navisworks Manage
2012, selecione Activate the Product e, a seguir, clique em Next.
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Isto inicia o processo Registrar hoje,

3 Clique em Registrar e Ativar (Obter um código de ativação).

4 Clique em Avançar e siga as instruções na tela.

Se você não tem acesso à Internet, ou se deseja usar outro método de
registro, é possível registrar e ativar o Autodesk Navisworks Manage 2012
de uma das seguintes formas:

■ E-mail. Cria uma mensagem de e-mail com suas informações de
registro e a envia para a Autodesk.

■ Fax ou correio postal. Insira suas informações de registro e envie
as informações por fax ou pelo correio para a Autodesk.

Execute o instalador novamente a partir da mídia original e clique em Install
Tools & Utilities (Instalar ferramentas e utilitários) na primeira tela. O
instalador o guiará pelo processo de seleção, configuração e instalação de
ferramentas e utilitários.

Quando devo reinstalar o produto em vez de
repará-lo?

Reinstale o produto se, por acidente, você excluir ou alterar arquivos que são
requeridos pelo programa.

Arquivos faltando ou alterados de forma adversa afetam o desempenho do
produto e causam mensagens de erro quando se tenta executar um comando
ou encontrar um arquivo.

Se o reparo de uma instalação falhar, reinstalar é a próxima melhor opção.

Quando eu desinstalo meu software, quais arquivos
são deixados no meu sistema?

Se o produto for desinstalado, alguns arquivos permanecem no seu
computador, como arquivos criados ou editados (por exemplo, desenhos ou
menus personalizados).

Seu arquivo de licença também permanece no computador quando você
desinstala o produto. Se você reinstalar no mesmo computador, as informações
de licença permanecem válidas e não é preciso reativar o produto.
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Questões de instalação

Esta seção descreve as questões comuns e suas soluções em relação à instalação
do software.

Existe um checklist que posso usar ao executar
uma instalação?

O capítulo Instalação contém uma seção completa que descreve as ações
preliminares e todo o processo de implementação. Consulte Tarefas
preliminares para uma implementação de rede na página 59.

Onde as instalações devem estar localizadas?

Pastas compartilhadas são requeridas para os métodos de instalação de licença
de rede e de licença independente de múltiplas instalações.

A pasta compartilhada (compartilhamento de rede é criada antes da execução
do assistente de Instalação), e é onde as implementações do produto são
armazenadas. Recomenda-se nomear a pasta compartilhada de rede como
Implementações na área de trabalho do sistema onde deseja armazenar as
instalações. Você pode então adicionar subpastas na pasta compartilhada
Implementações que possam indicar com clareza os nomes dos produtos que
você planeja instalar. Por exemplo:

Quaisquer subpastas que são colocadas dentro de uma pasta compartilhada
são automaticamente compartilhadas.
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OBSERVAÇÃO Você precisa ter permissões de Controle completo definidas
para sua pasta compartilhada quando estiver criando suas imagens de
implementação. Os usuários devem ter permissões de leitura para acessar o
compartilhamento de rede e permissões administrativas nas estações de trabalho
que tenham o programa instalado.

Onde posso verificar se atualizações estão
disponíveis para o meu software?

Para saber se uma correção ou uma Atualização está disponível para seu
produto, visite a página Autodesk Product Support em
http://www.autodesk.br/support.

Como escolho entre uma implementação de 32
bits e de 64 bits?

Você pode escolher entre uma implementação de 32 bits e de 64 bits. Esta
escolha controla para qual sistema operacional a implementação está dirigida,
NÃO que tipo de produtos incluir na implementação.
■ A seleção de uma implementação de 32 bits oferece uma escolha de

produtos de 32 bits, e somente irá instalar em sistemas operacionais de
32 bits.

■ A seleção de uma implementação de 64 bits oferece uma escolha de
produtos de 32 bits e de 64 bits, e somente irá instalar em sistemas
operacionais de 64 bits.

Portanto, por exemplo, se você deseja instalar produtos de 32 bits disponíveis
em um sistema operacional de 64 bits, será preciso escolher uma
implementação de 64 bits.

OBSERVAÇÃO Você pode efetuar qualquer tipo de implementação de qualquer
tipo de sistema operacional.
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O que são canais de informação?

O Communication Center permite receber avisos de vários canais de
informações. Através dos canais de informações, você pode receber o seguinte:
■ Informações de suporte de produto, incluindo notificações de correções

de manutenção.

■ Subscription Center avisos e notícias do programa de assinatura, assim
como links para e-Learning Lessons, se você for um membro de assinatura
da Autodesk.

■ Notificações sobre novos artigos e dicas postadas nos websites da Autodesk.

Quais são as opções adicionais de configuração da
implantação?

As seguintes opções estão disponíveis no painel de configuração na página
Configure Deployment do assistente Installation.

Preferências do usuário

■ Requer o Internet Explorer para a instalação (não se aplica ao
Autodesk Navisworks)

■ Configurar o DWFx como formato de publicação padrão (não se
aplica ao Autodesk Navisworks)

■ Configurar o nome de perfil padrão (não se aplica ao Autodesk
Navisworks)

■ Criar um atalho na área de trabalho para Autodesk Navisworks
Manage 2012

Service packs

■ Incluir service pack(s) de uma unidade local ou de uma rede
local

■ Não incluir service pack(s)

DICA Consulte Onde posso verificar se service packs estão disponíveis para o meu
software? na página 85
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Opções do Centro de comunicações

■ Enable Live Updates

■ Enable CAD Manager Channel (não se aplica ao Autodesk Navisworks)

■ Enable RSS Feeds

■ Allow User to Add RSS Feed

Acesso aos recursos on-line

■ Especificar a habilidade de acessar ferramentas on-line (não se
aplica ao Autodesk Navisworks)

■ Especificar as configurações de erro do cliente (CER)

■ Especificar as configurações de pesquisa do InfoCenter (não se
aplica ao Autodesk Navisworks)

Questões de licenças

Esta seção descreve as questões comuns e suas soluções em relação às licenças
do software e ao licenciamento de seus produtos.

Qual a diferença entre uma licença independente
e uma licença de rede?

Os produtos com licença independente são registrados e ativados em uma
estação de trabalho individual. Enquanto o software pode ser instalado em
múltiplos sistemas em sua instalação, a licença somente permite que um
sistema seja operacional. O Utilitário de Licença Portável pode ser usado
se uma licença precisa ser transferida para outro sistema. Se você precisa
executar em mais sistemas, será necessário comprar mais produtos com licença
independente ou considerar a conversão para licenças de rede.

Produtos licenciados em rede dependem do Gerenciador de licença de
rede para se manter em dia as licenças de produto. O software pode ser
instalado e executado em múltiplos sistemas, até o número máximo de licenças
que você comprou. ONetwork License Manager "checks out" as licenças
até que estejam todas em uso. Nenhum outro sistema pode executar o programa
até que uma licença "seja devolvida". Uma das principais vantagens de uma
licença de rede é a possibilidade de instalar os produtos em mais computadores
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do que o número de licenças adquiridas. Por exemplo, é possível comprar 25
licenças, mas instalá-las em 40 computadores para facilitar o acesso. A qualquer
momento, os produtos podem ser executados no número máximo de
computadores para os quais você tem licenças. Isto significa que você obtém
uma licença verdadeiramente flutuante. Um sistema de licenciamento de rede
também pode ser configurado para permitir que os usuários obtenham a
concessão de uma licença por tempo limitado para utilização em um
computador desconectado da rede.

Qual o benefício em usar uma versão de licença
de rede do software?

Os produtos licenciados para rede são recomendados para grandes instalações
de desenho/projeto, como salas de aula e ambientes de laboratório.

A principal vantagem é a de que você pode instalar produtos em mais sistemas
do que o número de licenças que você comprou (por exemplo, comprar 25
licenças mas instalar em 40 estações de trabalho). A qualquer momento, os
produtos irão ser executados no número máximo de sistemas para os quais
você tem licenças. Isto significa que você obtém uma licença verdadeiramente
flutuante. Se o software precisa ser executado em mais sistemas, licenças
adicionais podem ser compradas.

O registro e a ativação somente ocorrem uma vez e as licenças são mantidas
em seu Gerenciador de licença de rede.

Para que é usado o Internet Explorer?

Quando você decide ativar o software, o Internet Explorer torna este processo
muito mais rápido.

Após instalar seu produto, você pode operar no modo de teste por um
determinado número de dias. Sempre que iniciar o programa, será solicitado
a ativá-lo.

Uma vez que tiver inserido os dados de registro e os enviado para a Autodesk,
um código de ativação será retornado e você não será solicitado outra vez ao
iniciar.
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Questões de rede

Esta seção descreve as questões comuns e suas soluções em relação à execução
de uma instalação em rede ou à configuração de seus servidores de licença de
rede.

Onde encontro o nome de meu servidor?

Ao instalar um produto com licença de rede, você precisa especificar o nome
do servidor que irá executar o Gerenciador de licença de rede.

Se você não conhece o nome do servidor, poderá encontrá-lo rapidamente ao
abrir um prompt de comando do Windows no sistema que será o Gerenciador
de licença de rede. No prompt, insira ipconfig /all e observe a entrada
Host Name.

Se eu decidir criar um arquivo de registro, que
tipo de informações contém o arquivo de registro?

Há dois tipos de arquivos de registro que podem ser gerados e com os quais é
possível monitorar informações sobre as instalações.

■ O arquivo de registro de rede mantém um registro de todas as estações de
trabalho que executam a instalação. O registro lista o nome do usuário,
nome da estação de trabalho e o status da instalação. Consulte esse arquivo
para obter informações de status e detalhes sobre os problemas que os
usuários possam ter encontrado durante a instalação.

■ O registro de cliente contém informações detalhadas sobre instalação para
cada estação de trabalho. Essas informações podem ser úteis para o
diagnóstico de problemas de instalação. O registro do cliente está localizado
no diretório \Temp de cada estação de trabalho cliente.

O que é um arquivo de imagem administrativa
(MSI)?

Uma imagem administrativa é uma coleção de recursos de arquivos
compartilhados criados durante o processo de instalação, e é usada por
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instalações para instalar o programa em estações de trabalho em rede. Um
arquivo MSI é um arquivo Microsoft Installer.

Qual o impacto de selecionar todos os produtos
para serem incluídos na imagem administrativa?

Se decidir incluir todos os produtos em sua instalação, a imagem administrativa
será maior.

Selecione os produtos apenas ao criar múltiplas implantações para esta imagem
e recomenda-se não utilizar o DVD de instalação. Se existem produtos que
raramente ou nunca são utilizados, e não se espera criar instalações adicionais,
você deveria somente selecionar um sub-conjunto de produtos.

Ainda é possível criar uma instalação posteriormente, e incluir produtos
adicionais, mas é preciso criar uma nova imagem administrativa. A mídia de
instalação é necessária para realizá-lo.

Como devo configurar um servidor de licenças de
rede para um servidor

Se você tiver um firewall entre o servidor de licenças e os computadores cliente,
é necessário abrir algumas portas TCP/IP no servidor para as comunicações
relacionadas às licenças. Abra a porta 2080 para adskflex e abra as portas 27000
a 27009 para lmgrd.

Questões de desinstalação e de manutenção

Esta seção descreve as questões comuns e suas soluções em relação a adição e
remoção de recursos, reinstalação ou reparação da instalação, e desinstalação
de produtos.

IMPORTANTE  Não utilize programas de limpeza de registro nem tente modificar
as entradas de registro sozinho para desinstalar o Autodesk Navisworks Manage
2012. Não seguir o procedimento oficial de desinstalação resultará na
impossibilidade de instalar o software.
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Ao adicionar ou remover recursos, como posso
saber quais recursos são instalados por padrão?

Para ver rapidamente o que é instalado durante uma instalação típica padrão,
clique no botão Restaurar padrões na página Adicionar/Remover
recursos.

É possível alterar a pasta de instalação ao adicionar
ou remover recursos?

Uma vez instalado seu produto, você não pode alterar o caminho de instalação
na página Adicionar/Remover recursos. Modificar o caminho enquanto
se adiciona recursos resulta em uma corrupção do programa, portanto não é
uma opção.

Quando devo reinstalar o produto ao invés de
reparar?

Você deve reinstalar seu produto se por acidente exclui ou altera arquivos que
são requeridos pelo programa. Arquivos faltando ou alterados de forma adversa
afetam o desempenho do produto e causam mensagens de erro quando se
tenta executar um comando ou encontrar um arquivo.

Se o reparo de uma instalação falhar, reinstalar é a próxima melhor opção.

Os dados da instalação estão armazenados localmente em sua unidade e tais
dados são reutilizados ao reinstalar. Se qualquer arquivo não puder ser
localizado ao reinstalar o produto, você será solicitado a carregar a mídia
original. Se o produto for instalado a partir de uma implantação de rede, é
necessário acessar a implementação original, inalterada por mais tarde as
alterações, como a adição de uma atualização.

Quando eu desinstalo meu software, quais arquivos
são deixados no meu sistema?

Se o produto for desinstalado, alguns arquivos permanecem no seu sistema,
como arquivos criados ou editados.
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Seu arquivo de licença permanece na estação de trabalho quando você
desinstala o seu produto. Se você reinstala na mesma estação de trabalho, as
informações da licença permanecem válidas e não é preciso reativar o produto.
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Início rápido

Iniciar e sair do Autodesk Navisworks
Após ter instalado na página 31Autodesk Navisworks Manage 2012, você poderá
iniciá-lo a partir da área de trabalho do Windows ou da linha de comando.

Para iniciar o Autodesk Navisworks, siga uma das seguintes opções a partir
da área de trabalho do Windows:
■ Clique duas vezes no ícone do Autodesk Navisworks ou

■ Clique em Start ➤ All Programs ➤ Autodesk ➤ Navisworks Manage
2012 ➤ Manage 2012.

O Autodesk Navisworks é iniciado no idioma que melhor se encaixar nas
configurações em seu computador. Você também pode iniciar o Autodesk
Navisworks em qualquer outro dos idiomas instalados na página 43.

OBSERVAÇÃO Você pode adicionar opções de linha de comando para especificar
diferentes rotinas de inicialização para o programa. Consulte Opções da linha de
comando na página 96.

Para sair do Autodesk Navisworks, clique no botão do aplicativo  .
Na parte inferior do menu do aplicativo, clique em Exit Autodesk Navisworks.

Se nenhuma alteração tiver sido feita no projeto atual, o projeto é fechado e o
Autodesk Navisworks é encerrado. Se alterações foram feitas no projeto atual,
você é solicitado a salvar as alterações. Para salvar as alterações no projeto, clique
em Yes. Para continuar fechando e descartando as alterações, clique em No.
Para retornar para Autodesk Navisworks, clique em Cancelar.
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Salvar e recuperar automaticamente arquivos
do Autodesk Navisworks

Quedas de energia, falhas de sistema e de software podem causar o fechamento
do Autodesk Navisworks antes que você possa salvar as alterações de seu
arquivo.

O Autodesk Navisworks pode salvar automaticamente versões de backup de
um arquivo no qual você esteja trabalhando, permitindo-lhe recuperar seu
trabalho caso o Autodesk Navisworks seja fechado de modo anormal.

Os arquivos salvos automaticamente têm uma extensão .nwf e são nomeados
como <Nome_do_arquivo>.AutoSave<x> onde <Nome_do_arquivo> é o nome
do arquivo atual do Autodesk Navisworks e <x> é um número que aumenta
a cada salvamento automático. Então, por exemplo, se estiver trabalhando
com um arquivo chamado Enviro-Dome.nwd, o primeiro arquivo salvo
automaticamente é chamado de Enviro-Dome.Autosave0.nwf, o segundo arquivo
salvo automaticamente é chamado de Enviro-Dome.Autosave1.nwf e assim por
diante.

É possível controlar um número de opções de Auto-Save, tais como com que
frequência o Autodesk Navisworks salva o trabalho, a localização dos arquivos
de backup e o número máximo de arquivos de backup que deseja manter.

Para personalizar as opções de salvamento automático

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó General , e clique em Auto-Save.
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3 Ajuste as opções Auto-Save, se necessário. Por exemplo, se deseja que
o Autodesk Navisworks salve um arquivo de backup a cada 20 minutos
de uma alteração significante do arquivo, insira 20 na caixa Time
Between Saves (minutes).

4 Clique em OK.

Para recuperar seu trabalho

1 Inicie o Autodesk Navisworks. Você será automaticamente instruído a
recarregar o último arquivo em que estava trabalhando.

2 Clique em Yes para abrir a versão mais recente salva do arquivo.

OBSERVAÇÃO Clique em No, caso não deseje recuperar seu trabalho ou
se deseja carregar manualmente um outro arquivo de backup.
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Para carregar manualmente um arquivo de backup no Autodesk Navisworks

1 Inicie o Autodesk Navisworks. Você é solicitado a recarregar o último
arquivo em que estava trabalhando, clique em No.

2 Clique no botão de aplicativo  ➤  Open  ➤  Open  .

3 Na caixa de diálogo Open, procure pela pasta que contém os arquivos
de backup. Por padrão, é <USERPROFILE>\ Application
Data\<PRODUCTFOLDER>\AutoSave.

4 Clique em Open.

5 Quando for solicitado a salvar um arquivo com outro nome, clique em
Save As.

6 Na caixa de diálogo Save As , insira um novo nome do arquivo e procure
pela localização desejada.

7 Clique em Save.

Menu:  Interface de usuário Classic: File ➤ Open
Entrada do comando: Ctrl+O
Barra de ferramentas:  Interface de usuário Classic: Standard, barra

de ferramentas Quick Access

Opções da linha de comando
Os argumentos da·linha de comando podem especificar diferentes rotinas de
inicialização para o Autodesk Navisworks.

É possível usar opções de linha de comando para especificar diversas opções
ao iniciar o programa. Por exemplo, você pode executar o Autodesk Navisworks
em outro idioma, executar verificações adicionais de memória, carregar e
anexar arquivos e efetuar a saída de relatórios de erros. Com opções de linha
de comando, também é possível definir diversos ícones de programa, cada um
com diversas opções de inicialização.

As chaves da linha de comando são parâmetros que você pode adicionar na
linha do comando roamer.exe associado com um ícone de atalho do Microsoft®

Windows® ou a caixa de diálogo Executar do Windows. É possível incluir
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diversos argumentos em uma única linha de comando. Os argumentos válidos
estão listados na tabela a seguir.

DescriçãoArgumentoChave da linha de
comando

Efetua a saída de um relatório
de erros para o arquivo

[file_name.dmp]-dump

especificado. É preciso fornecer
o nome e o caminho do
arquivo entre aspas.

Inicia o Autodesk Navisworks
no idioma especificado. É

en-US = Inglês-lang

de-DE = Alemão possível executar o Autodesk
Navisworks em um idioma
diferente do local padrão (por

es-ES = Espanhol exemplo, é possível executar
uma versão em japonês do

fr-FR = Francês Autodesk Navisworks com um
local padrão inglês).

it-IT = Italiano

ja-JP = Japonês

ko-KR = Coreano

pt-BR = Português do Brasil

ru-RU = Russo

zh-CN = Chinês (PRC)

Efetua a saída do registro para
o arquivo especificado. É

[filename.txt]-log

preciso fornecer o caminho
completo do arquivo entre
aspas. Por exemplo,
“C:\temp\log.txt"
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DescriçãoArgumentoChave da linha de
comando

Executa o Autodesk Navisworks
com verificações adicionais de
erros de memória.

-memcheck

O Autodesk Navisworks
converte um arquivo de

[inputfile]-nwc

entrada no formato NWC em
segundo plano. É preciso
fornecer o caminho completo
do arquivo entre aspas. Por
exemplo, “C:\temp\a.dwg"

O Autodesk Navisworks
converte um arquivo de

[outputfile.nwd] [input file]-nwd

entrada no formato NWD em
segundo plano e o coloca no
diretório especificado. É preciso
fornecer o caminho completo
do arquivo entre aspas. Por
exemplo, “C:\temp\b.dwg"

Inicia o Autodesk Navisworks e
importa as opções globais do

[filename.xml]-options

arquivo de opções globais
especificado. É preciso fornecer
o caminho completo do
arquivo entre aspas. Por
exemplo,
"C:\temp\my_global_options.xml"

Registra o roamer.exe com
COM.

-regserver

A sintaxe para utilizar as chaves da linha de comando é:

“drive:pathname\roamer.exe” [switches] [“file1”] [“file2”] [“fileN”],
onde [switches] são as chaves válidas de linha de comando em qualquer ordem,
e [file1]...[fileN] são os arquivos a serem carregados e anexados, se necessário.
É preciso fornecer o caminho completo do arquivo entre aspas.
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Por exemplo, a entrada a seguir inicia o programa a partir de uma pasta
denominada Autodesk Navisworks no idioma Russo, carrega o arquivo de opções
globais options.xml e cria um arquivo de registro log.txt.

"C:\Autodesk Navisworks\roamer.exe" -options "C:\temp\options.xml"

-lang ru-ru -log "C:\temp\file.log"

Para iniciar o programa com a chave de linha de comando

1 Clique com o botão direito do mouse no ícone do programa na área de
trabalho do Windows. Clique em Properties.

2 Na caixa de diálogo Properties do Autodesk Navisworks, guia Shortcut,
na caixa Target, edite os parâmetros para a chave utilizando a seguinte
sintaxe:

“drive:pathname\roamer.exe” [switches] [“file”] [“file2”]

[“fileN”], onde [switches] são as chaves válidas de linha de comando
em qualquer ordem, e [file1]...[fileN] são os arquivos a serem carregados
e anexados, se necessário. É preciso fornecer o caminho completo do
arquivo entre aspas.

Por exemplo, insira: “D:\Autodesk Navisworks\roamer.exe" -log

"D:\temp\nw_log.txt" "D:\temp\a.nwd" "D:\temp\b.dwg".

3 Clique em OK.

A interface do usuário
A interface do Autodesk Navisworks contém um número de elementos
tradicionais do Windows, como o menu de aplicativos, barra de ferramentas
Quick Access, faixa de opções, janelas encaixáveis, caixas de diálogo e menus
de atalho, nos quais você completa tarefas.

Partes da interface do Autodesk Navisworks

Esta seção descreve brevemente os componentes principais da interface padrão
do Autodesk Navisworks.

A interface do Autodesk Navisworks é intuitiva e fácil de aprender e usar. Você
pode ajustar a interface do aplicativo para coincidir com sua forma de trabalho.
Por exemplo, é possível ocultar janelas encaixáveis raramente usadas, para
que não tumultuem a interface. É possível adicionar e remover botões da faixa
de opções e da barra de ferramentas Acesso rápido.
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Você pode aplicar um tema diferente à interface padrão. Também é possível
voltar para a interface clássica do Autodesk Navisworks com menu e barras de
ferramentas do estilo antigo.

5. Scene View1. Botão e menu do aplicativo

6. Barra de navegação2. Barra de ferramentas Quick Access

7. Janelas encaixáveis3. InfoCenter

8. Barra de status4. Faixa de opções

Consulte também:

Visão geral do InfoCenter na página 11

Para alterar o tema da interface do usuário padrão

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção User
Interface.

3 Na página User Interface, selecione o tipo de tema requerido a partir
da lista suspensa Theme.

4 Clique em OK.
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Botão e menu do aplicativo

O menu do aplicativo permite que você acesso ferramentas comuns.

Ele fornece acesso a diversas ações de arquivo comuns, e também permite que
você gerencie seus arquivos usando ferramentas mais avançadas, como Import,
Export e Publish. Algumas escolhas do menu do aplicativo possuem menus
adicionais que mostram comandos relacionados.

Para abrir o menu do aplicativo, clique no botão do aplicativo  . Clicar
novamente fecha o menu do aplicativo.

DescriçãoOpção

Fecha o arquivo no momento aberto e cria
um novo arquivo. (Novo)

Abre arquivos. (Abrir)
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DescriçãoOpção

Importa dados no projeto atual.
 (Importar)

Salva o arquivo atual.
 (Salvar)

Salva seu projeto como um dos formatos
nativos do Autodesk Navisworks (NFW ou
NWD).

 (Salvar como)

Exporta dados do projeto atual.
 (Exportar)

Publica o projeto atual.
 (Publicar)

Imprime a cena e define as configurações
relativas à impressão. (Imprimir)

Cria um novo e-mail com o arquivo atual
como um anexo. (Enviar por e-mail)

Inicia o Vault cliente independente e
permite efetuar login e logout do servidor (Servidor do Vault)

do Vault, e efetuar o check-in e check-out
nos arquivos. Por padrão, esta opção não
é exibida. Para ativá-la, use o Options Editor

(Tools ➤ Vault ➤ Show in User
Interface).

Abre o Options Editor.Opções

Sai do programa.Sair do Navisworks
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Lista de documentos recentes

É possível visualizar, classificar e acessar arquivos suportados que foram abertos
recentemente.

Os arquivos mais recentes são exibidos na lista Recent Documents. A lista
é ordenada com o arquivo usado mais recentemente no topo.

Por padrão, são exibidos até quatro arquivos. Caso deseje modificar o tamanho
da lista, utilize o Options Editor.

É possível fixar os arquivos ao usar o botão de pino à direita. Fixar lhe permite
manter um arquivo na lista até que desative o botão de pino.

Classificar e agrupar arquivos

Utilize a lista suspensa no topo da lista Recent Documents para classificar
ou agrupar arquivos por:

■ By Ordered List

■ By Access Date

■ By Size

■ By Type

Visualizar documentos

Ao mover o mouse sobre o arquivo na lista Recent Documents, é exibida a
seguinte informação:

■ Caminho onde o arquivo está armazenado

■ Data em que o arquivo foi modificado por último

■ Nome da pessoa que está trabalhando com o arquivo atualmente

Para alterar o número de documentos recentes listados

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó General, e clique na opção
Environment.

3 Na página Environment, insira o número de documentos recentes a
serem listados na caixa Maximum Recently Used Files.
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4 Clique em OK.

Para manter um documento na lista Recent Documents

■ Clique no botão de pino à direita do documento.

Para visualizar a lista Recent Documents por data de acesso

■ No canto superior esquerdo da lista Recent Documents, na lista suspensa
By Ordered List, selecione By Access Date.

Para visualizar a lista Recent Documents por tamanho

■ No canto superior esquerdo da lista Recent Documents, na lista suspensa
By Ordered List, selecione By Size.

Para visualizar a lista Recent Documents por tipo

■ No canto superior esquerdo da lista Recent Documents, na lista suspensa
By Ordered List, selecione By Type.

Barra de ferramentas Acesso rápido

No topo da janela do aplicativo, a barra de ferramentas Acesso rápido exibe
os comandos usados frequentemente.
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É possível adicionar um número ilimitado de botões à barra de ferramentas
Acesso rápido. Os botões são adicionados à esquerda dos comandos padrão.
Você pode adicionar separadores entre os botões. Os comandos que se estendem
além do comprimento máximo da barra de ferramentas são exibidos em um

botão desdobrável  .

OBSERVAÇÃO Apenas comandos da faixa de opções podem ser adicionados à
barra de ferramentas Acesso rápido.

É possível mover a barra de ferramentas Acesso rápido acima ou abaixo da
faixa de opções.

Para adicionar um botão da faixa de opções à barra de ferramentas Acesso
rápido

1 Exiba a guia e painel que contêm o botão que você deseja adicionar à
barra de ferramentas Acesso rápido.

2 Clique com o botão direito na faixa de opções, e clique em Add to
Quick Access Toolbar.

Para remover um botão da faixa de opções da barra de ferramentas Acesso
rápido

1 Clique com o botão direito no botão na barra de ferramentas Acesso
rápido

2 Clique em Remove from Quick Access toolbar.

Para exibir a barra de ferramentas Acesso rápido abaixo da faixa de opções

■ Clique no botão suspenso Customize Quick Access Toolbar, e clique
em Show Below the Ribbon.
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Menu de atalho: Clique com o botão direito em qualquer botão na barra
de ferramentas Acesso rápido. Clique em Show Quick Access Toolbar
below the Ribbon.

Para exibir a barra de ferramentas Acesso rápido acima da faixa de opções

■ Clique no botão suspenso Customize Quick Access Toolbar, e clique
em Show Above the Ribbon.

Menu de atalho: Clique com o botão direito em qualquer botão na barra
de ferramentas Acesso rápido. Clique em Show Quick Access Toolbar
above the Ribbon.

Por padrão, ela contém as seguintes ferramentas:

DescriçãoOpção

Fecha o arquivo no momento aberto e cria
um novo arquivo.

 (Novo)

Abre arquivos. (Abrir)

Salva o arquivo atual. (Salvar)

Imprime o ponto de visão atual. (Imprimir)

Atualiza os arquivos no projeto. (Atualizar)

Cancela a ação mais recente (Desfazer)

Refaz a ação mais recente (Refazer)

Seleciona itens com um clique do mouse. (Selecionar)

Personalize os itens exibidos na barra de
ferramentas Quick Access. Para ativar ou

 (Personalizar barra de ferramentas Acesso
rápido)

desativar um item, clique junto ao menu
suspenso Customize Quick Access
Toolbar.
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Faixa de opções

A faixa de opções é uma paleta que exibe ferramentas e controles com base
nas tarefas.

A faixa de opções é dividida em guias, cada guia suporta uma atividade
específica. Em cada guia, ferramentas são agrupadas em uma série painéis com
base em tarefa.

Para especificar quais guias da faixa de opções são exibidas, clique com o botão
direito do mouse na faixa de opções e, no menu de atalho, clique ou desmarque
as guias ou os painéis.

É possível personalizar a faixa de opções dependendo de suas necessidades,
nas seguintes formas:
■ Altere a ordem das guias da faixa de opções. Clique na guia que deseja

mover, arraste-a para a posição desejada e solte.

■ Altere a ordem dos painéis da faixa de opções em uma guia. Clique na
painel que deseja mover, arraste-o para a posição desejada e solte.

Você pode controlar a quantidade de espaço que a faixa de opções ocupa na
janela do aplicativo. Existem dois botões à direita das guias da faixa de opções
que lhe permitem escolher os estados de alternância e de minimizar da faixa
de opções.
■ O primeiro botão alterna entre o estado completo da faixa de opções

completa  e o estado de minimizar da faixa de opções. 

■ O segundo botão suspenso  lhe permite selecionar um dos quatros estados
de minimizar da faixa de opções:
■ Minimizar para guias: minimiza a faixa de opções para que somente

os títulos das guias sejam exibidos.

■ Minimizar para títulos dos painéis: minimiza a faixa de opções
para que somente os títulos das guias e dos painéis sejam exibidos.

■ Minimizar para os botões do painel: minimiza a faixa de opções
para que somente os botões do painel e os títulos das guias sejam
exibidos.

■ Navegar entre todos: navega entre todos os quatro estados da faixa
de opções na ordem, faixa de opções completa, minimizar para botões
do painel, minimizar para títulos de painéis, minimizar para guias.
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Guias contextuais

Algumas das guias são contextuais. Quando alguns comandos são executados,
uma guia contextual especial da faixa de opções é exibida, em vez de uma
barra de ferramentas ou caixa de diálogo. Por exemplo, assim que você começa
a selecionar itens na Scene View, a guia Item Tools anteriormente oculta
é exibida. Quando nada é selecionado, ela é ocultada novamente.

Painéis deslizantes

Uma seta para baixo  à direita de um título de painel indica que é possível
expandi-lo para exibir ferramentas e controles adicionais. Por padrão, uma
painel expandido se fecha automaticamente quando se clica em outro painel.

Para manter um painel expandido, clique no ícone de pino  no canto inferior
esquerdo do painel deslizante.

Painéis flutuantes

Se você puxar um painel para fora de uma guia da faixa de opções e para uma
área diferente na janela do aplicativo ou área de trabalho, aquele painel flutua
onde for colocado. O painel flutuante continua aberto até que seja retornado
para a faixa de opções, mesmo que você troque de guias na faixa de opções.

Inicializador de ferramentas

Alguns painéis da faixa de opções exibem uma caixa de diálogo ou uma janela
encaixável relacionadas aquele painel. Uma seta de inicializador de ferramenta
 no canto inferior esquerdo do painel indica que você pode exibir uma

ferramenta relacionada. Clique no ícone para exibir a caixa de diálogo ou
janela encaixável relacionadas.
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Caixas de seleção

As caixas de seleção permitem alternar entre a ativação e desativação de uma
opção.

Deslizadores

Quando uma opção pode ser executada com intensidade variável, o deslizador
permite controlar a configuração de mais baixa para mais alta ou o inverso.

Para exibir a faixa de opções

Se você estiver usando a interface de usuário Classic, poderá voltar para a
faixa de opções.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção User
Interface.

3 Na página User Interface, selecione Standard (recomendado) na
lista suspensa User Interface.

4 Clique em OK.

Para ocultar ou exibir uma guia da faixa de opções

1 Clique com o botão direito do mouse em qualquer lugar dentro da faixa
de opções.

2 Em Show Tabs, clique ou desmarque o nome de uma guia.

Para ocultar ou exibir um painel da faixa de opções

1 Clique na guia da faixa de opções que deseja organizar.

2 Clique com o botão direito do mouse na guia da faixa de opções.

3 Em Show Panels, clique ou desmarque o nome de um painel.

OBSERVAÇÃO Por padrão, o painel Collaborate na guia Review é oculto.

Para exibir ou ocultar legendas de texto nos painéis da faixa de opções

■ Clique com o botão direito em uma guia da faixa de opções, e clique ou
desmarque Show Panel Titles.
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Para retornar um painel flutuante para a faixa de opções

■ Passe o mouse sobre o lado direito do painel flutuante e clique no ícone
Return Panels to Ribbon.

Para alternar o tamanho da faixa de opções

1 Clique na seta suspensa na barra da guia da faixa de opções e selecione
o estado desejado minimizado da faixa de opções.

2 Clique duas vezes no nome da guia da faixa de opções ativa ou em
qualquer lugar na barra de guias da faixa de opções.

A faixa de opções alterna entre o estado de minimizar e o estado completo
selecionado da faixa de opções.

Para redefinir a faixa de opções e a barra de ferramentas Acesso rápido

1 Clique com o botão direito do mouse em qualquer lugar dentro da faixa
de opções.

2 Clique em Restore Default Ribbon.

Guia Home

Contém ferramentas para...Painel

controlar toda a cena, incluindo anexar
arquivos e atualizar arquivos CAD, redefinir

Project

alterações feita no Autodesk Navisworks e
configurar opções de arquivos.

selecionar itens e salvar seleções na cena
através de uma faixa de métodos, incluindo
utilizar pesquisas.

Select & Search
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Contém ferramentas para...Painel

exibir e ocultar itens na geometria do
modelo.

Visibility

exibir e ocultar informações, incluindo
propriedades e links.

Display

iniciar ferramentas de simulação e de análise
do Autodesk Navisworks.

Tools

Guia Ponto de visão

Contém ferramentas para...Painel

salvar, gravar, carregar e reproduzir pontos
de visão salvos e animações de ponto de
vista.

Salvar, Carregar e Reproduzir

aplicar várias configurações à câmera.Camera

definir a velocidade angular e linear do
movimento, selecionar ferramentas de

Navigate

navegação e configurações de mouse 3D,
além de aplicar configurações de realismo,
como gravidade e colisões.

controlar as configurações de iluminação e
renderização.

Render Style

permitir o corte cruzado do ponto de vista
em um espaço de trabalho 3D.

Sectioning

Guia Review

Contém ferramentas para...Painel

medir distâncias, ângulos e áreas.Medir
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Contém ferramentas para...Painel

desenhar linhas de marcação no ponto de
vista atual.

Linhas de marcação

adicionar e localizar identificadores na cena.Identificadores

exibir e localizar comentários na cena.Comentários

conectar com outros usuários do Autodesk
Navisworks através de uma conexão de
rede. Este painel é oculto por padrão.

Colaborar

Guia Animation

Contém ferramentas para...Painel

criar animações de objeto usando a
ferramenta Animator ou gravar animações
de ponto de vista.

Criar

selecionar e reproduzir animações.Reproduzir

ativar scripts, ou criar outros novo na
ferramenta Scripter.

Script

Guia View

Contém ferramentas para...Painel

ativar visão estereoscópica, desde que o
hardware adequado esteja disponível.

Estéreo

definir a velocidade angular e linear do
movimento, selecionar ferramentas de

Navigate

navegação e configurações de mouse 3D,
além de aplicar configurações de realismo,
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Contém ferramentas para...Painel

como gravidade e colisões. Este painel é
oculto por padrão.

alternar entre controles de navegação,
como a Barra de navegação, ViewCube,
elementos HUD e vistas de referência.

Ajuda para a navegação

controlar a janela Scene View, incluindo ir
para tela cheia, dividir a janela e configurar
o estilo/cores do segundo plano.

Vista da cena

controlar quais janelas flutuantes são
exibidas, e carregar/salvar configurações de
espaço de trabalho.

Espaço de trabalho

Guia Output

Contém ferramentas para...Painel

imprimir e visualizar o ponto de vista atual,
e definir as configurações de impressão.

Imprimir

enviar um e-mail com o arquivo atual como
um anexo.

Send

publicar a cena atual como um arquivo
NWD.

Publicar

publicar a cena atual como um arquivo
Google Earth, FBX ou DWF/DWFx 3D.

Export Scene

gerar imagens e animações.Visuals

exportar dados do Autodesk Navisworks,
incluindo identificadores PDS e dados de

Export Data

ponto de vista, de pesquisa, TimeLiner e
Clash.

A interface do usuário | 113



Guia Item Tools

Contém ferramentas para...Painel

voltar para aplicativos de projeto
compatíveis na vista atual.

Retornar

reter itens selecionados para que eles se
movam com você, conforme navega ao
redor de uma cena.

Suspender

focar e aplicar zoom nos itens selecionados
na vista atual.

Look At

controlar a visibilidade dos itens
selecionados.

Visibility

mover, rotacionar e dimensionar os itens
selecionados.

Transform

alterar a cor e transparência dos itens
selecionados.

Appearance

gerenciar os links anexados aos itens
selecionados.

Vínculos

Guia Sectioning Tools

OBSERVAÇÃO Disponível somente em um espaço de trabalho 3D.

Contém ferramentas para...Painel

ativar/desativar seccionamento do ponto
de vista atual.

Enable

alternar os modos de seccionamento entre
os modos de plano e caixa.

Mode
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Contém ferramentas para...Painel

controlar os planos de corte.Planes Settings

mover, rotacionar e dimensionar os
planos/caixas de corte.

Transform

salve o ponto de visão atual.Save

Vault

Contém ferramentas para...Painel

abrir o Vault e fazer login, logout e anexar
arquivos.

Acesso

atualizar e efetuar o check-in e o check-out
de arquivos.

File Status

Dicas de ferramentas

Posicionar o ponteiro do mouse sobre uma opção do menu ou botão exibe
uma dica de ferramenta contendo o nome da ferramenta, uma atalho de
teclado (se aplicável), e uma breve descrição da ferramenta.

Algumas dicas de ferramentas no menu do aplicativo, barra de ferramentas
Acesso rápido, e faixa de opções são progressivas. Se você deixar o cursor
sobre a opção do menu ou um botão por mais um momento, a dica de
ferramenta pode se expandir para exibir informações adicionais.

Enquanto a dica de ferramenta estiver visível, é possível pressionar F1 para
obter ajuda sensível ao contexto que fornece mais informações sobre aquela
ferramenta.
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Atalhos de teclado

O Autodesk Navisworks fornece teclas de aceleração, ou dicas de teclas, para
permitir que você use o teclado, ao invés do mouse, para interagir com a janela
do aplicativo.

Dicas de teclas são fornecidas para o menu do aplicativo, barra de ferramentas
Acesso rápido, e faixa de opções. É possível usar também os atalhos de
teclado "old style", tais como CTRL + N para abrir um novo arquivo e CRTL +
P para imprimir o arquivo atual.

Para exibir dicas de teclas, pressione ALT. As dicas de teclas (letras ou números)
são exibidas na tela próximas do comando correspondente ou elemento da
interface do usuário. Pressione a tecla de aceleração exibida para imediatamente
invocar o comando desejado ou para exibir o elemento da interface do usuário.
Por exemplo, ao pressionar ALT, e a seguir, pressionar 1 criará um novo arquivo.

Para ocultar as dicas de tecla, pressione ALT novamente.

Consulte também:

Atalhos de teclado padrão na página 153
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Ferramentas de navegação

A barra de navegação fornece acesso a ferramentas relacionadas à navegação
interativa e orientação no modelo incluindo Autodesk®, ViewCube®,
SteeringWheels® e o mouse 3D 3Dconnexion®.

É possível personalizar a barra de navegação com base naquilo que você
considera importante exibir. Você também pode alterar a posição de encaixe
da barra de navegação na Scene View.

A interface de usuário clássica

Se preferir, pode voltar à interface de usuário Classic e usar as barras de
ferramentas e menus suspensos da barra de menu ao invés da faixa de opções.

OBSERVAÇÃO A interface de usuário Classic não está mais sendo atualizada com
aprimoramentos para Autodesk Navisworks. Recomenda-se que você trabalhe
usando a interface do Autodesk Navisworks.

Para alternar para a interface de usuário clássica

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção User
Interface.

3 Na página User Interface, selecione Classic na lista suspensa User
Interface.

4 Clique em OK.

Barra de menus

A barra de menus contém todos os comandos disponíveis no Autodesk
Navisworks, agrupados por funcionalidades similares ou parecidas.

Por exemplo, todos os comandos relativos a funcionalidade de revisão estão
localizados no menu Review , todos os comandos relativos a ajuda ao usuário
estão localizados no menu Help, e assim por diante.
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Quando um menu tiver uma seta apontando para a direita, como

 , há um submenu associado com aquela escolha.

Quando um menu é seguido por uma série de pontos, como

 , há uma caixa de diálogo associada com aquela escolha.

Menu File

Este menu contém os comandos para gerenciar arquivos.

DescriçãoOpção

Reinicializa o programa e fecha o arquivo do
Autodesk Navisworks aberto atualmente.

New

Atualiza sua tela com as versões mais recentes dos
arquivos de modelo no momento carregados.

Atualizar

Exibe a caixa de diálogo Open.Abrir

Exibe a caixa de diálogo Open URL.Abrir o URL

Exibe a caixa de diálogo Append.Append

Exibe a caixa de diálogo Merge.Merge

Salva o arquivo do Autodesk Navisworks aberto
atualmente.

Save

Exibe a caixa de diálogo Save As.Salvar como

Exibe a caixa de diálogo Publish.Publicar

Exibe a caixa de diálogo Print.Imprimir

Ativa o modo de visualização de impressão.Visualização de impressão

Exibe a caixa de diálogo Print Setup.Configurações de impressão
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DescriçãoOpção

Exclui os arquivos selecionados. Você somente
pode excluir arquivos anexados.

Delete

Salva o arquivo do Autodesk Navisworks aberto
atualmente, acessa seu programa de e-mail e

Send by Email

adiciona o arquivo salvo como um anexo de e-
mail.

Exibe a caixa de diálogo Import e permite
importar dados de revisão do Intergraph PDS e
diversos dados do Autodesk Navisworks.

Import

Exibe a caixa de diálogo Export e permite
exportar dados do Autodesk Navisworks.

Export

Exibe atalhos para os arquivos mais recentemente
abertos.

Recent Files

Sai do programa.Exit

Menu Edit

Este menu contém os comandos para localizar, selecionar e editar geometria
em seu modelo.

DescriçãoOpção

Reverte a última operação executada.Undo

Reverte a última operação executada pelo
comando Undo.

Redo

Fornece o acesso a funcionalidade de seleção.Select

Exibe a caixa de diálogo Quick Find.Quick Find
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DescriçãoOpção

Repete a execução anterior da pesquisa rápida.Quick Find Next

Ativa a barra de controle Find Items.Find Items

Ativa a caixa de diálogo Find Comments.Find Comments

Ativa o modo oculto para itens selecionados.Hidden

Ativa o modo requerido para itens selecionados.Required

Ativa o modo oculto para itens com o
cancelamento da seleção.

Ocultar objetos não selecionados

Permite sobrepor a cor, transparência e
transformação para itens selecionados.

Override Item

Permite reinicializar os itens selecionados de volta
para seu estado original.

Reset Item

Permite reinicializar todos os itens sobrepostos de
volta para seu estado original.

Reset All

Permite classificar os itens da Selection Tree na
ordem alfabética.

Sort

Exibe a caixa de diálogo File Units and
Transform.

File Units an Transform

Menu View

Este menu contém comandos que controlam a interface do Autodesk
Navisworks.

DescriçãoOpção

Permite alternar a exibição das barras de controle.Control Bars

120 | Capítulo 3   Início rápido



DescriçãoOpção

Permite controlar os espaços de trabalho.Workspaces

Permite controlar as vistas na Vista da cena.Vista da cena

Permite alternar entre controles de navegação,
como o ViewCube, Barra de navegação e
elementos HUD.

Exibição para acima

Permite controlar o SteeringWheels.SteeringWheels

Coloca o vídeo de saída no modo estéreo.Ativar estéreo

Exibe a caixa de diálogo Stereo Options.Opções de estéreo

Exibe estatísticas de cena úteis.Estatísticas da cena

Menu Viewpoint

Este menu contém um conjunto de comandos que afetam o ponto de vista
atual, incluindo a aparência do modelo, a navegação e o corte.

DescriçãoOpção

Permite utilizar pontos de visão salvos.Saved Viewpoints

Permite olhar de um ponto de vista predefinido.Look From

Define o vetor acima do ponto de visão para
alinhar com a orientação selecionada.

Set Viewpoint Up

Permite selecionar o modo de renderização.Rendering

Permite selecionar o modo de iluminação.Lighting

Permite exibir primitivos.Display

A interface do usuário | 121



DescriçãoOpção

Permite selecionar o modo de navegação.Navigation Mode

Permite controlar a câmera durante a navegação
interativa.

Ferramentas de navegação

Permite criar um volume limitado de seu modelo.Sectioning

Exibe a caixa de diálogo Edit Current
Viewpoint para o ponto de vista atual.

Editar ponto de vista atual

Menu Review

Este menu contém comandos para revisão e marcação.

DescriçãoOpção

Permite adicionar e gerenciar comentários.Comentários

Permite adicionar e gerenciar anotações.Linhas de marcação

Permite utilizar as ferramentas de medição.Medir

Permite adicionar e gerenciar links.Vínculos

Permite localizar identificadores de revisão.Identificadores

Envia a vista atual do arquivo no momento
carregado de volta para o programa com base no
AutoCAD ou MicroStation.

Retornar

Renumera todas as IDs de comentários, tornando-
as únicas para a cena.

Renumerar IDs de comentário

Renumera todas as IDs de identificadores,
tornando-as únicas para a cena.

Renumerar IDs de identificador
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Menu Tools

Este menu contém comandos para a análise e revisão avançada do modelo e
também comandos para personalizar o Autodesk Navisworks.

DescriçãoOpção

Ativa a janela da ferramenta Clash Detective.Clash Detective

Ativa a janela da ferramenta Presenter.Presenter

Ativa a janela da ferramenta TimeLiner.TimeLiner

Ativa a janela TimeLiner Playback.TimeLiner Playback

Exibe a caixa de diálogo DataTools.Ferramentas de dados

Ativa a janela da ferramenta Animator.Animator

Ativa a janela da ferramenta Scripter.Scripter

Ativa a janela Batch Utility.Batch Utility

Exibe a caixa de diálogo Compare.Comparar

Ativa a janela da ferramenta Redline Tools.Linhas de marcação

Ativa a exibição de links.Vínculos

Ativa a exibição das propriedades rápidas.Propriedades rápidas

Ativa a janela da ferramenta Measure Tools.Medir

Permite controlar a reprodução da animação e
gravar animações de pontos de visão .

Animation

Permite selecionar uma cor de segundo plano para
a Scene View.

Background
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DescriçãoOpção

Exibe a caixa de diálogo File Options.File Options

Exibe a caixa de diálogo Customize.Personalizar

Exibe o Options Editor.Global Options

Barras de ferramentas

As barras de ferramentas do Autodesk Navisworks fornecem acesso rápido aos
comandos utilizados com frequência.

Cada botão em uma barra de ferramentas inclui uma dica da ferramenta, que
descreve a função que o botão ativa. Colocar o mouse sobre um botão exibe
na barra de Status um breve instrução de como utilizar este recurso.

É possível reorganizar, abrir e fechar barras de ferramentas.
■ Para mover uma barra de ferramentas, clique na linha tracejada an borda

da barra de ferramentas e a arraste para outra localização.

■ Para abrir ou fechar barras de ferramentas, clique com o botão direito do
mouse em uma área vazia próxima a última barra de ferramentas na tela,
e escolha na lista de barras de ferramentas disponíveis no menu de atalho.

Além de reorganizar as barras de ferramentas do Autodesk Navisworks
existentes, é possível personalizar sua aparência e conteúdo e criar suas próprias
barras de ferramentas.

OBSERVAÇÃO Para rapidamente personalizar uma barra de ferramentas, clique

no botão Toolbar Options  à direita e clique em Add or Remove Buttons
no menu de atalho.

Quando um botão da barra de ferramentas do Autodesk Navisworks tem uma

seta apontando para baixo, como  , uma barra de ferramentas de submenu
está associada a essa escolha. Clique no triângulo para abrir o menu e selecione
uma opção específica. Quando você move através do menu, uma ajuda
adicional é exibida na barra de Status. Quando a opção é selecionada, ela se
torna o comando atual e é exibida como um botão na barra de ferramentas.
Para repetir o comando, clique no botão na barra de ferramentas. Para escolher
outro comando, clique novamente no triângulo.
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Alguns botões da barra de ferramentas permitem escolher um modo de
programa. Por exemplo, para olhar em torno de seu modelo, é preciso estar
no modo de olhar em torno. Para girar o modelo, é necessário estar no modo
Free Orbit e assim por diante. O Autodesk Navisworks permanece no modo
selecionado, salvo instrução em contrário. Para identificar em qual modo você
está olhe os botões. Se o botão está realçado e tem uma borda azul escura em
torno do mesmo, o modo correspondente está no momento ativo.

Para sair do modo, clique novamente no mesmo botão ou escolha outro modo.

Alguns botões são utilizados para alternar a exibição de caixas de diálogo e
janelas encaixáveis (por exemplo, a janela Presenter , a janela Animator ,
etc.). Novamente, se um botão está realçado e tem uma borda azul escura em
torno do mesmo, significa que a exibição do elemento correspondente está
no momento aberta.

Quando você abre mais barras de ferramentas na tela ou redimensiona a janela
do Autodesk Navisworks, as barras de ferramentas podem se sobrepor para
não encher demais a tela. Quando isso acontece, alguns botões estarão ocultos
abaixo das sobreposições. Para acessar com rapidez todo o conjunto de
comandos em uma barra de ferramentas, clique no botão com barra  na
extremidade direita da barra de ferramentas. Os comandos remanescentes
disponíveis para aquela barra de ferramentas irão aparecer.

Nesta seção, você irá encontrar uma lista completa das barra de ferramentas
do Autodesk Navisworks e os botões associados a elas.

OBSERVAÇÃO O conteúdo real da barra de ferramentas pode diferir desta
referência dependendo do espaço de trabalho que você utiliza.

Barra de ferramentas Standard
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Esta barra de ferramentas fornece o acesso rápido para os comandos de
gerenciamento de arquivo. Também permite desfazer/refazer suas ações e abrir
o sistema de ajuda.

DescriçãoBotão

Reinicializa o programa e fecha o arquivo
do Autodesk Navisworks no momento
aberto.

Atualiza sua tela com as versões mais
recentes dos arquivos de modelo no
momento carregados.

Exibe a caixa de diálogo Open.

Exibe a caixa de diálogo Append.

Exibe a caixa de diálogo Merge.

Salva o arquivo do Autodesk Navisworks
aberto no momento.

Exibe a caixa de diálogo Publish.

Salva o arquivo do Autodesk Navisworks no
momento aberto, acessa seu programa de
e-mail e adiciona o arquivo salvo como um
anexo de e-mail.

Reverte a última operação executada.

Reverte a última operação executada pelo
comando Undo.

Exibe a caixa de diálogo Print.
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DescriçãoBotão

Exibe as informações de direito autoral e de
licença sobre sua cópia do Autodesk
Navisworks.

Abre o sistema de ajuda.

Barra de ferramentas Selection Tools

Esta barra de ferramentas fornece o acesso aos comandos de seleção e permite
ocultar objetos de geometria.

DescriçãoBotão

Ativa o modo Select.

Ativa o modo Select Box.

Ativa o modo requerido para itens
selecionados.

Ativa o modo oculto para itens
selecionados.

Ativa o modo oculto para itens com o
cancelamento da seleção.

Barra de ferramentas Navigation Mode
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Esta barra de ferramentas inclui nove modos e seis SteeringWheels para a
navegação interativa em torno de seus modelos 3D.

DescriçãoBotão

Seleciona o círculo.

Ativa o modo Walk.

Ativa o modo Look Around

Ativa o modo Zoom.

Ativa o modo Zoom Box.

Ativa o modo Pan.

Ativa o modo Orbit.

Ativa o modo Free Orbit.

Ativa o modo Fly.

Ativa o modo Constrained Orbit.

Barra de ferramentas Rendering Style

Esta barra de ferramentas controla a aparência no Autodesk Navisworks.

DescriçãoBotão

Seleciona o modo Lighting .
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DescriçãoBotão

Seleciona o modo Rendering.

Ativa a renderização de superfícies.

Ativa a renderização de linhas.

Ativa a renderização de pontos.

Ativa a renderização de pontos de snap.

Ativa a renderização de texto 3D.

Barra de ferramentas Workspace

Esta barra de ferramentas fornece o acesso rápido às ferramentas de revisão e
de análise do Autodesk Navisworks.

DescriçãoBotão

Ativa a janela da ferramenta Redline Tools.

Ativa a exibição de links.

Ativa a exibição das propriedades rápidas.

Ativa a janela da ferramenta Measure
Tools.

Ativa a barra de controle Viewpoints.

A interface do usuário | 129



DescriçãoBotão

Ativa a barra de ferramentas Sectioning.

Ativa a barra de controle Plan View.

Ativa a barra de controle Section View.

Ativa a barra de controle Selection Tree.

Ativa a barra de controle Sets.

Ativa a barra de controle Comments.

Ativa a caixa de diálogo Find Comments.

Ativa a barra de controle Find Items.

Ativa a barra de controle Properties.

Ativa a janela da ferramenta Clash
Detective.

Ativa a janela da ferramenta Presenter.

Ativa a janela da ferramenta TimeLiner.

Ativa a janela TimeLiner Playback.

Ativa a janela da ferramenta Animator.

Ativa a janela da ferramenta Scripter.
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DescriçãoBotão

Controla os espaços de trabalho.

Barra de ferramentas Model Views

Esta barra de ferramentas controla as vistas na Scene View.

DescriçãoBotão

Divide sua vista da cena ativa na vertical.

Divide sua vista da cena ativa na horizontal.

Adiciona barras de títulos em todas as vistas
de cenas personalizadas.

Barra de ferramentas Sectioning

Esta barra de ferramentas permite criar um volume limitado de seu modelo.

DescriçãoBotão

Alterna a ativação e desativação do
seccionamento.

Permite vincular dois planos de corte
opostos.

Exibe a caixa de diálogo Set Sectioning
Box Size.
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DescriçãoBotão

Restringe a distância de corte para os limites
da caixa de delimitação dos objetos
selecionados na Scene View

Exibe a caixa de diálogo Sectioning
Plane.

Ativa/desativa o plano de corte atual.

Permite escolher o método de alinhamento.

Exibe a caixa de diálogo Section Plane
Settings.

Barra de ferramentas Animation

Esta barra de ferramentas permite gravar animações de ponto de vista,
reproduzir animações de objeto e de ponto de vista, e alternar a funcionalidade
de script.

DescriçãoBotão

Rebobina a animação atual de volta ao
início.

Volta um quadro ou um quadro-chave da
animação.

Reproduz a animação atual no sentido
inverso.

Grava a animação do ponto de vista.
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DescriçãoBotão

Pausa a animação.

Pára a reprodução da animação atual e
rebobina de volta ao início.

Reproduz a animação no momento
selecionada.

Avança um quadro ou um quadro-chave.

Avança rápido a animação atual para o fim.

Ativa e desativa o mecanismo Scripter no
arquivo do Autodesk Navisworks.

Barra de ferramentas Collaborate Bar

Esta barra de ferramentas permite participar em sessões de revisão de projeto
através de uma Rede de Área Local (LAN).

DescriçãoBotão

Inicia o Windows™ NetMeeting.

Permite ao usuário a ter controle da sessão
e se tornar o "Condutor".

Atualiza os dados do Autodesk Navisworks
nas máquinas de todos os participantes.

Barra de ferramentas Object Manipulation
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Esta barra de ferramentas permite editar a geometria em seu modelo.

DescriçãoBotão

Ativa a exibição da meta-alça de tradução.

Ativa a exibição da meta-alça de rotação.

Ativa a exibição da meta-alça de escala.

Permite aplicar sobreposição de cor.

Ativa/desativa o snap.

Barra de ferramentas Navigation Tools

Esta ferramenta permite controlar a câmera durante a navegação interativa.

DescriçãoBotão

Efetua a elevação e pan da câmera para que
todos o modelo esteja na Vista da cena.

Efetua o zoom da câmera para que os itens
selecionados preencham a Vista da cena.

Coloca a Vista da cena no modo de foco.

Armazena os itens selecionados. Ao
percorrer o modelo, este objetos irão mover
juntos.

Utiliza uma câmera em perspectiva.
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DescriçãoBotão

Utiliza uma câmera ortogonal.

Ativa a colisão.

Ativa a gravidade.

Ativa o agachar-se.

Ativa a vista da terceira pessoa.

Alinha o ponto de vista atual com o eixo X.

Alinha o ponto de vista atual com o eixo Y.

Alinha o ponto de vista atual com o eixo Z.

Personalizar as barras de ferramentas

Você pode personalizar a aparência e o conteúdo das barras de ferramentas
do Autodesk Navisworks utilizando a caixa de diálogo Customize.

Para adicionar uma barra de ferramentas personalizada

1 Clique em Tools ➤ Customize.

2 Na caixa de diálogo Customize, guia Toolbars, clique no botão New.

3 Insira um nome para a barra de ferramentas na caixa Toolbar Name.
Por padrão, as novas barras de ferramentas são nomeadas como "Custom
X" onde 'X' é o próximo número disponível adicionado à lista.
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4 Clique em OK.

A nova barra de ferramentas aparece na área de barras de ferramentas.

5 Feche a caixa de diálogo Customize.

Para renomear uma barra de ferramentas personalizada

1 Clique em Tools ➤ Customize.

2 Na caixa de diálogo Customize , guia Toolbars , clique em sua barra
de ferramentas.

3 Clique em Rename.

OBSERVAÇÃO Você somente pode renomear barras de ferramentas
personalizadas.

4 Insira o novo nome para sua barra de ferramenta.

5 Clique em OK.

6 Feche a caixa de diálogo Customize.

Para excluir uma barra de ferramentas

1 Clique em Tools ➤ Customize.

2 Na caixa de diálogo Customize , guia Toolbars , clique na barra de
ferramentas que você não precisa.

3 Clique em Delete.

OBSERVAÇÃO Você somente pode excluir barras de ferramentas
personalizadas.

4 Feche a caixa de diálogo Customize.
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Para adicionar comandos

1 Clique em Tools ➤ Customize. Isto abre a caixa de diálogo Customize.

2 Há diversas formas para adicionar comandos em uma barra de ferramentas
ou em um menu:
■ Na caixa de diálogo Customize , guia Commands , clique na

categoria desejado, e arraste o comando da lista de comandos para a
barra de ferramentas. Se o comando tem um ícone padrão a ele
atribuído (mostrado junto ao comando na lista de comandos), o ícone
irá aparecer como um botão em sua barra de ferramentas. Se nenhum
ícone está atribuído ao comando, o nome do comando irá aparecer
como um botão na barra de ferramentas. Para menus, o comando irá
aparecer exatamente da forma mostrada na lista de comandos.

■ Arraste o comando de outro menu ou barra de ferramentas para sua
barra de ferramentas ou menu. Isto move o comando de sua
localização original para um novo local.

■ Mantenha pressionado Ctrl e arraste o comando de outro menu ou
barra de ferramentas para sua barra de ferramentas ou menu. Isto cria
uma cópia do comando e não remove o comando de sua localização
original.

3 Se você deseja editar a aparência do comando, clique como botão direito
do mouse na barra de ferramentas ou menu, e utilize as opções no menu
de talho.

4 Feche a caixa de diálogo Customize.
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Para excluir comandos

1 Clique em Tools ➤ Customize. Isto abre a caixa de diálogo Customize.

2 Arraste o comando para fora do menu ou barra de ferramentas até que
o cursor exiba uma pequena cruz.

3 Solte o botão esquerdo do mouse para excluir o comando.

4 Feche a caixa de diálogo Customize.

Scene View

Esta é a área onde você visualiza e interage com seus modelos 3D.

Ao iniciar o Autodesk Navisworks, a Scene View contém somente uma vista
da cena, mas caso seja necessário, é possível adicionar mais. Vistas de cenas
personalizadas são nomeadas como "VistaX" onde "X" é o próximo número
disponível. A vista de cena padrão não pode ser movida.
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Olhar para diversas vistas de seu modelo simultaneamente é útil quando você
compara estilos de iluminação e renderização, efetua a animação de diferentes
partes de seu modelo, e assim por diante.

Somente uma vista de cena pode estar ativa de cada vez. Uma vista da cena
se torna ativa quando você trabalha nela. Se você clica com o botão esquerdo
do mouse na vista, a vista da cena é ativada e seja o que for clicado é
selecionado, ou se for clicado em uma área vazia, tudo tem a seleção cancelada.
Clicar com o botão direito do mouse em uma vista da cena a ativa e abre um
menu de atalho.

Cada vista da cena lembra o modo de navegação sendo utilizado. A gravação
e reprodução de animações somente ocorre na vista ativa no momento.

Cada vista da cena pode ser redimensionada. Para redimensionar vistas da
cena, mova o cursor sobre a intersecção da vista da cena e arraste a barra

divisora  .

Você pode tornar vistas de cenas personalizadas encaixáveis. As vistas de cenas
encaixáveis têm barras de título e podem ser movidas, encaixadas, colocadas
lado a lado e automaticamente ocultadas da mesma forma que as janelas
encaixáveis na página 142. Caso deseje utilizar várias vistas de cenas
personalizadas, mas não queira ter nenhuma divisão na Scene View, poderá
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movê-las a qualquer outro lugar. Por exemplo, você pode colocar a cena
lado-a-lado na barra de controle Viewpoints.

OBSERVAÇÃO Você não pode cancelar o encaixe da vista de cena padrão.

Modo de tela cheia

No modo Full Screen a vista da cena atual ocupa toda a tela.

Para interagir com o modelo na vista de cena, é possível usar o ViewCube, a
Barra de navegação, os atalhos de teclado, e o menu de atalho.

DICA Caso você utilize dois monitores, sua vista de cena padrão é colocada na
tela principal e a interface pode ser colocada na segunda tela para controlar a
interação.

Conteúdo da vista de cena

O Autodesk Navisworks permite alterar o tamanho do conteúdo exibido em
uma vista de cena. Isto pode ser particularmente utilizado se você estiver
compondo uma cena para a exportação da imagem ou da animação. Ao definir
o tamanho do conteúdo para as mesmas proporções de sua saída pretendida,
você pode visualizar exatamente sua aparência.

Para criar uma vista de cena padrão

■ Para dividir a sua vista de cena ativa horizontalmente, clique na guia

View ➤ painel Split View ➤ Split View ➤ Split Horizontal  .

■ Para dividir a sua vista de cena ativa verticalmente, clique na guia

View ➤ painel Scene View ➤ Split View ➤ Split Vertical  .

Barra de ferramentas:  Interface de usuário Classic: Model

Views ➤ Split Horizontal  e Model Views  ➤ Split Vertical

Para tornar uma vista de cena personalizada encaixável

■ Clique na guiaView ➤ painel Scene View ➤ Show Title Bars.

Todas as suas vistas de cenas personalizadas agora têm barras de títulos.

Barra de ferramentas:  Interface de usuário Classic: Model

Views ➤ Toggle Title Bars
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Para excluir uma vista de cena personalizada

1 Se a vista da cena não for encaixável, clique na guia View painel
 ➤ Scene View ➤ Show Title Bars.

2 Clique em  para fechar a vista da cena.

OBSERVAÇÃO Você não pode excluir a vista de cena padrão.

Para alternar o modo Full Screen

■ Clique na guiaView painel  ➤ Scene View ➤ Full Screen  .

Entrada do comando: F11
Menu de atalho: Viewpoint ➤ Full Screen

Para redimensionar o conteúdo da vista da cena ativa

1 Clique na guia View ➤ painel Scene View ➤ Window Size  .

2 Na caixa de diálogo Window Size , lista suspensa Type, selecione o
tipo de dimensionamento.

■ Use View - faz com que o conteúdo preencha a vista da cena ativa.

■ Explicit - define a largura e a altura exata para o conteúdo.

■ Use Aspect Ratio - utiliza a relação de aspecto da vista da cena atual
para calcular automaticamente a largura do conteúdo quando a altura
é inserida, ou a altura do conteúdo quando a largura é inserida.

3 Se você selecionar a opção Explicit , insira a largura e a altura para seu
conteúdo em pixels.

Se você seleciona a opção Use Aspect Ratio, insira a largura ou a altura
para seu conteúdo em pixels.
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4 Clique em OK.

Janelas encaixáveis

A maioria dos recursos do Autodesk Navisworks podem ser acessados a partir
de janelas encaixáveis.

Há várias opções de janelas, que são agrupadas em várias áreas funcionais:

Janelas de ferramentas principais

Essas janelas fornecem acesso à principal funcionalidade do Autodesk
Navisworks:

■ Clash Detective

■ TimeLiner

■ Presenter

■ Animator

■ Scripter

■ Appearance Profiler

Revisar Windows

Estas janelas contêm ferramentas necessárias para executar operações de
selecionar/pesquisar/revisar:

■ Selection Tree

■ Sets

■ Find Items

■ Properties

■ Comments

■ Find Comments

■ Measure Tools
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Janelas de ponto de vista

Estas janelas contêm ferramentas necessárias para configurar e usar pontos de
visão :

■ Saved Viewpoints

■ Tilt - somente em um espaço de trabalho 3D.

■ Plan View - somente em um espaço de trabalho 3D.

■ Section View - somente em um espaço de trabalho 3D.

■ Section Plane Settings - somente em um espaço de trabalho 3D.

Janelas de múltiplas folhas

Estas janelas permitem trabalhar com arquivos de múltiplas folhas:

■ Project Browser

■ Find Item in Other Sheets and Models (Localizar itens em outras
folhas e modelos)

As janelas podem ser movidas e redimensionadas, e flutuar na Vista da cena
ou encaixar (fixadas ou ocultas automaticamente).

DICA É possível encaixar e desencaixar rapidamente uma janela clicando com o
botão direito na janela da barra de título.

Uma janela encaixada compartilha uma ou mais bordas com janelas e barras
de ferramentas adjacentes. Se uma aresta compartilhada é movida, as janelas
mudam de forma para compensar. Você também pode flutuar as janelas em
qualquer ponto na tela, se necessário.

OBSERVAÇÃO  A janela Tilt só pode ser encaixada verticalmente na esquerda
ou na direita, recebendo toda a altura da tela, ou flutuando.

Por padrão, uma janela encaixada é fixa, significando que a janela continua
a ser exibida em seu tamanho atual e pode ser movida. Quando você oculta
automaticamente uma janela e move o mouse para longe dela, a janela é
reduzida para uma guia exibindo o nome da janela. Mover o ponteiro do
mouse sobre a guia exibe a janela completa, mas temporariamente, sobre a
tela. Ocultar automaticamente uma janela pode mostrar mais da tela, enquanto
mantém a janela disponível. Ocultar automaticamente também previne que
ela seja desencaixada, agrupada ou desagrupada.
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OBSERVAÇÃO Ao encaixar a janela dentro da vista da cena padrão, as
funcionalidades para selecionar e ocultar automaticamente não estarão disponíveis.
Isto não afeta vistas de cena personalizadas.

Uma janela desencaixada é uma que foi separada da janela do programa. Cada
janela desencaixada pode ser movida ao redor da tela ou telas, se necessário.
Mesmo que janelas desencaixadas não possam ser fixadas, elas podem ser
redimensionadas e agrupadas.

Um grupo de janelas é uma forma de ter mais de uma janela ocupando a
mesma quantidade de espaço na tela. Quando janelas são agrupadas, cada
janela é representada por uma guia na parte inferior do grupo. Em um grupo,
clique em uma guia para exibir aquela janela. É possível agrupar ou desagrupar
janelas como necessário e salvar os espaços de trabalho personalizados. Após
alterar as posições das janelas, você pode salvar suas configurações como um
espaço de trabalho personalizado.

Posição de ocultar automático

Quando você oculta automaticamente uma janela, ele se retrai contra um lado
específico da tela - Superior, Esquerdo, Direito, ou Inferior. O lado para o qual
ela se retrai é determinado pela posição de encaixe. Portanto, por exemplo, se
você encaixar uma janela à esquerda da tela, ela se retrai para a esquerda.

O menu de atalho

Clicar com o botão direito do mouse em uma janela encaixável exibe um
menu de atalho de comandos disponíveis. Se você clicar com o botão direito
do mouse em um item único, ou seleciona um ou mais itens e clica com o
botão direito do mouse, este menu contém comandos relativos aos itens. Se
você clicar com o botão direito do mouse em uma área que não contenha
itens ou dados, o menu contém comandos relativos a janela encaixável, se
apropriado.

Para exibir uma janela encaixável

1 Clique na guia View painel  ➤ Workspace ➤ Windows  .

2 Selecione a caixa de verificação próxima da janela desejada na lista
suspensa.

Para mover uma janela encaixável

1 Clique e arraste a barra de título no topo ou lateral da janela.
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2 Opcional: para impedir que uma janela encaixe automaticamente
enquanto é arrastada, mantenha a tecla Ctrl pressionada.

DICA A ferramenta de encaixe lhe permite posicionar janelas em uma relação
específica às áreas da tela.

Para agrupar janelas encaixáveis

1 Clique a arraste a barra de título da janela a ser adicionada a outra janela
ou grupo.

2 Solte a janela na barra de título da janela ou grupo que está recebendo.
Uma guia com o nome da janela arrastada é adicionada na parte inferior
da janela que está recebendo.

Para desagrupar janelas encaixáveis

1 No grupo, clique na guia da janela que deseja remover.

2 Clique e arraste a guia da janela para fora do grupo.

3 Solte a janela para desagrupá-la.

Para ocultar automaticamente janelas encaixáveis

1 Em uma barra de título de janela, clique em  .

A janela continua a ser exibida até que você mova o ponteiro do mouse
para longe dela. Quando você move o ponteiro do mouse, a janela é
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retraída até que o ponteiro do mouse seja posicionado sobre a guia da
janela no lado da tela onde ela foi encaixada.

OBSERVAÇÃO Para mover ou agrupar janelas, é preciso fixá-las primeiro.

Para fixar janelas encaixáveis

1 Mova o cursor do mouse sobre a barra de título para exibir a janela oculta.

2 Clique em  na barra de título. A janela agora está fixada, e pode ser
movida e agrupada.

Para redimensionar uma janela encaixável ou um grupo de janelas

1 Posicione o ponteiro do mouse sobre a borda de uma janela até que ele

mude para a barra de divisão  .

2 Clique e arraste a borda para o tamanho desejado.

DICA É possível redimensionar janelas fixadas e ocultas automaticamente. Em um
grupo oculto automaticamente, cada janela pode ser redimensionada
separadamente das outras janelas. Em um grupo fixado, redimensionar uma janela
redimensiona o resto das janelas.

Ferramenta de encaixe

A ferramenta de encaixe indica a relação de uma janela arrastada com o resto
da tela, e permite apontar destinos para arrastar e soltar.

A ferramenta contém uma zona interna e zona externa de controles
representando o destino para soltar. Cinco encaixes da zona interna são usados
para encaixar janelas relativas à área adequada mais próxima da tela, enquanto
que quatro encaixes da zona externa são usados para encaixar janelas relativas
à própria tela.
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A ferramenta de encaixe também fornece visualizações de quais espaços serão
ocupados por uma janela. Essas visualizações são exibidas quando você move
uma janela e quando o seu mouse estiver sobre um dos encaixes.

DICA Para criar rapidamente um grupo de janelas, use o encaixe no centro da
ferramenta de encaixe ao arrastar uma janela para a sua localização. Isto funciona
em qualquer lugar da tela excluindo a vista de cena padrão e a janelaTilt. Vistas
de cena personalizadas podem ser agrupadas com outras janelas.
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Para mover uma janela com a ferramenta de encaixe

1 Clique e arraste a barra de título no topo ou no lado da janela em direção
ao local onde deseja encaixá-la. Isto ativa a ferramenta de encaixe.

2 Arraste a janela sobre o encaixe na ferramenta de encaixe que representa
a área que você deseja que a janela ocupe.

3 Solte o botão do mouse para encaixar a janela. A janela é
automaticamente redimensionada para preencher a área.

Status Bar

A barra de Status aparece na parte inferior da tela do Autodesk Navisworks.
Ela não pode ser personalizada ou movida

O canto esquerdo da barra de Status é usado para exibir pequenas instruções
sobre como utilizar os recursos do Autodesk Navisworks (se aplica somente à
interface de usuárioClassic).

O canto direito da barra de Status inclui quatro indicadores de desempenho
que fornecem feedback constante sobre como está o desempenho do Autodesk
Navisworks em sua máquina, um botão para alternar para a janela Project
Browser e controles para navegar entre folhas/modelos em arquivos de

múltiplas folhas. 

Controles de navegação de múltiplas folhas

Clique nas setas anterior/próximo e primeiro/último para abrir o modelo/folha
desejado na Scene View. Isso é equivalente a clicar duas vezes no
modelo/folha na janela Project Browser. O modelo/folha será
automaticamente preparado para utilização no Autodesk Navisworks, se
aplicável.

OBSERVAÇÃO Esses controles estão disponíveis somente para arquivos de múltiplas
folhas.

Botão Navegador de projeto

Clique no botão Project Browser  para alternar a janela Project Browser
na página 230.
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Barra de andamento do lápis

A barra de andamento sob o ícone (lápis) no lado esquerdo, indica quanto da
vista atual foi desenhado, ou seja quando de espaço existe no ponto de vista
atual. Quando a barra de andamento estiver em 100%, a cena está
completamente desenhada, sem nenhum espaço. O ícone muda de cor quando
um redesenho está em andamento. Embora a cena esteja sendo desenhada, o
lápis irá mudar para amarelo. Se houver excesso de dados a serem manipulados
e sua máquina não puder processar isso o suficientemente rápido para o
Autodesk Navisworks, então o lápis ficará vermelho para indicar um gargalo.

Barra de andamento do disco

A barra de andamento sob o ícone (disco) central indica quanto do modelo
atual foi carregado do disco, ou seja quanto está carregado na memória. Quando
a barra de andamento estiver em 100%, todo o modelo, incluindo a geometria
e as informações da propriedade, estão carregados na memória. O ícone muda
de cor quando um carregamento de arquivo está em andamento. Embora os
dados estão sendo lidos, o disco muda para amarelo. Se houver excesso de
dados a serem manipulados e sua máquina não puder processar isso o
suficientemente rápido para o Autodesk Navisworks, então o disco ficará
vermelho para indicar um gargalo.

Barra de andamento do servidor da web

A barra de andamento sob o ícone (servidor da web) no lado direito indica
quanto do modelo atual foi descarregado, ou seja quanto foi descarregado de
uma servidor da web. Quando a barra de andamento estiver em 100%, todo
o modelo foi descarregado. O ícone muda de cor quando um carregamento
de arquivo está em andamento. Embora os dados estão sendo descarregados,
o servidor da web muda para amarelo. Se houver excesso de dados a serem
manipulados e sua máquina não puder processar isso o suficientemente rápido
para o Autodesk Navisworks, então o servidor da web ficará vermelho para
indicar um gargalo.

Barra de memória

O campo à direita dos ícones reporta o montante de memória sendo utilizado
no momento pelo Autodesk Navisworks. Isto é reportado em Megabytes (MB).
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Comandos desfazer/refazer

Você pode desfazer ou refazer ações no Autodesk Navisworks.

As configurações padrão são adequadas para a utilização normal do Autodesk
Navisworks, mas é possível ajustar na página 810 o montante de espaço alocado
para o buffer de desfazer/refazer, se necessário.

Para desfazer uma ação

■ Clique em Undo  na barra de ferramentas Quick Access.

Entrada do comando: Ctrl+Z
Barra de ferramentas:  Interface de usuário Classic: Standard ➤ Undo

Para refazer uma ação

■ Clique em Redo  na barra de ferramentas Quick Access.

Entrada do comando: Ctrl+Y
Barra de ferramentas:  Interface de usuário Classic: Standard ➤ Redo

Espaços de trabalho do Autodesk
Navisworks

Os espaços de trabalho retêm informações sobre quais janelas estão abertas,
suas posições e o tamanho da janela do aplicativo.

Os espaços de trabalho retêm alterações feitas na faixa de opções, mas não na
barra de ferramentas Quick Access.

OBSERVAÇÃO No modo de interface de usuário Clássica (que é quando a faixa
de opções está desativada), os espaços de trabalho retêm as informações sobre
as janelas de encaixe e sobre as barras de ferramentas.

Os espaços de trabalho podem ser compartilhados com outros usuários. Por
exemplo, você poderia criar espaços de trabalho separados para usuários
ocasionais ou avançados do Autodesk Navisworks ou definir sua própria norma
corporativa.
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O Autodesk Navisworks é fornecido com diversos espaços de trabalho
pré-configurados:
■ Safe Mode - seleciona o layout com os recursos mínimos.

■ ONavisworks Extended - seleciona o layout recomendado para usuários
avançados.

■ ONavisworks Standard - seleciona o layout com as janelas ocultas
automaticamente usadas com frequência como guias.

■ ONavisworks Minimal - seleciona o layout permitindo o maior espaço
possível à Vista da cena.

Você pode utilizar estes espaços de trabalho como estão ou modificá-los de
acordo com suas necessidades. Ao iniciar o Autodesk Navisworks, o espaço de
trabalho Navisworks Minimal será usado. É possível escolher um espaço
de trabalho diferente a qualquer hora, clicando na guia View ➤ painel
Workspace ➤ Load Workspace  e, a seguir, selecionar na lista o espaço
de trabalho necessário.

Barra de ferramentas:  Interface de usuário Classic:

Workspace ➤ Workspaces

Para salvar o layout atual em um novo espaço de trabalho

1 Defina seu layout de revisão do projeto. Por exemplo, é possível agrupar
as janelas Properties e Saved Viewpoints.

Caso esteja utilizando o modo de interface de usuário Clássica, por
exemplo, é possível fechar todas as barras de ferramentas, exceto as
Standard,Selection Tools, Navigation Mode, e Workspace.

2 Clique na guia View ➤ painel Workspace ➤ Save Workspace  .

3 Na caixa de diálogo Save Current Workspace  , insira um nome para
o novo espaço de trabalho. Você também pode selecionar o nome de
um espaço de trabalho existente para sobrepô-lo com sua configuração
modificada.
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4 Clique em Save.

Para carregar um espaço de trabalho salvo no Autodesk Navisworks

1 Clique na guia View ➤ painel Workspaces ➤ Load Workspace
.

2 Na caixa de diálogo Load Workspace , procure pela pasta que contenha
o espaço de trabalho desejado e selecione-o.
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3 Clique em Open.

Atalhos de teclado padrão

Os atalhos de teclado são alternativas de teclado que podem ser utilizados para
iniciar comandos normalmente acessados com o mouse.

Por exemplo, para abrir a janelaSelection Tree, pode pressionar Ctrl + F12,
para abrir a janela Comments, pode pressionar Shift + F6 e assim por diante.
Os atalhos de teclado oferecem um meio de trabalhar mais rápido e com maior
eficácia. Algumas caixas de diálogo ou janelas encaixáveis podem ser fechadas
como mesmo comando utilizado para abri-las.

Muitos atalhos de teclado já estão definidos para as ações de uso mais comum.
Você pode modificar os atalhos padrão ou adicionar novos atalhos, se
necessário.

DescriçãoAtalho de teclado padrão

Aplica zoom para exibir todos os objetos na Vista da cena.PgUp

Aplica zoom para ampliar todos os objetos selecionados na Vista da cena.PgDn
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DescriçãoAtalho de teclado padrão

Leva você para a vista Home. Este atalho de teclado somente se aplica para
as janelas Scene View. Isso significa que somente irá funcionar quando
esta janela tiver foco.

HOME

Cancela a seleção de tudo.Esc

Usado para modificar as ações do botão do meio do mouse.Shift

Usado para modificar as ações do botão do meio do mouse.Ctrl

Ativa ou desativa as dicas de teclas.ALT

Fecha a janela encaixável no momento ativa quando esta tiver seu encaixe
cancelado ou sai do aplicativo se a janela principal do aplicativo estiver ativa.

ALT + F4

Ativa o modo Turntable.Ctrl+0

Ativa o modo Select.Ctrl + 1

Ativa o modo Walk.Ctrl+2

Ativa o modo Look AroundCtrl+3

Ativa o modo Zoom.Ctrl+4

Ativa o modo Zoom Window.Ctrl + 5

Ativa o modo Pan.Ctrl+6

Ativa o modo Orbit.Ctrl+7

Ativa o modo Free Orbit.Ctrl+8

Ativa o modo Fly.Ctrl+9
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DescriçãoAtalho de teclado padrão

Exibe a caixa de diálogo Append.Ctrl+A

Alterna o modo Collision. É preciso estar no modo de navegação apropriado
(ou seja, Walk ou Fly) para que este atalho de teclado funcione.

Ctrl+D

Exibe a caixa de diálogo Quick Find.Ctrl+F

Alterna o modo Gravity.Ctrl+G

Alterna o modo Hiddenpara itens selecionados.Ctrl+H

Exibe a caixa de diálogo Select File.Ctrl+I

Exibe a caixa de diálogo Merge.Ctrl+M

Reinicializa o programa, fecha o arquivo do Autodesk Navisworks aberto no
momento e cria um novo arquivo.

Ctrl+N

Exibe a caixa de diálogo Open.Ctrl+O

Exibe a caixa de diálogo Print.Ctrl+P

Alterna o modo Requirepara itens selecionados.Ctrl+R

Salva o arquivo do Autodesk Navisworks aberto no momento.Ctrl+S

Alterna o modo Third Person.Ctrl+T

Reverte a última operação executada pelo comando Undo.Ctrl+Y

Reverte a última operação executada.Ctrl+Z

Exibe a folha anterior.CTRL + PgUp

Exibe a próxima folha.CTRL + PgDn
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DescriçãoAtalho de teclado padrão

Abre o sistema de Help.Ctrl + F1

Abre a janela Clash Detective.Ctrl + F2

Ativa a janela TimeLiner.Ctrl + F3

Ativa a janela Presenter.Ctrl + F4

Ativa a janela Animator.Ctrl + F5

Ativa a janela Scripter.Ctrl + F6

Alterna a janela Tilt.Ctrl + F7

Aplica à interface de usuário Clássica. Ativa a barra de ferramentas
Sectioning.

Ctrl + F8

Ativa a janela Plan View.Ctrl + F9

Ativa a janela Section View.Ctrl + F10

Ativa a janela Saved Viewpoints.Ctrl + F11

Ativa a janela Selection Tree.Ctrl + F12

Efetua a elevação e pan da câmera para que todo o modelo esteja na vista.Ctrl + HOME

Reproduz a animação selecionada.Ctrl + Seta para baixo

Reprodução reversa da animação selecionada.Ctrl + Seta para esquerda

Grava a animação do ponto de vista.Ctrl + Seta para cima

Para a reprodução de animação.Ctrl + Seta para baixo
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DescriçãoAtalho de teclado padrão

Pausa a reprodução de animação.Ctrl + Espaço

Abre a caixa de diálogo Animation Export.Ctrl + Shift + A

Abre a caixa de diálogo Export e permite exportar a pesquisa atual.Ctrl + Shift + C

Abre a caixa de diálogo Image Export .Ctrl + Shift + I

Abre a caixa de diálogo Export Rendered Image.Ctrl + Shift + R

Abre a caixa de diálogo Export e permite exportar conjuntos de pesquisa.Ctrl + Shift + S

Abre a caixa de diálogo Export e permite exportar a tabela atual do
TimeLiner.

Ctrl + Shift + T

Abre a caixa de diálogo Export e permite exportar pontos de visão .Ctrl + Shift + V

Abre a caixa de diálogo Export e permite exportar relatórios de ponto de
vista.

Ctrl + Shift + W

Define a vista atual como Home.Ctrl + Shift + HOME

Define a vista atual como Front.Ctrl + Shift + END

Leva você para o identificador de linha de marcação anterior.Ctrl + Shift + Seta para esquerda

Leva você para o próximo identificador de linha de marcação.Ctrl + Shift + Seta para direita.

Leva você para o primeiro identificador de linha de marcação.Ctrl + Shift + Seta para cima

Leva você para o último identificador de linha de marcação.Ctrl + Shift + Seta para baixo

Abre o sistema de Help.F1

Renomeia o item selecionado quando apropriado.F2
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DescriçãoAtalho de teclado padrão

Repete a pesquisa de execução anterior Quick Find.F3

Atualiza sua tela com as versões mais recentes dos arquivos de modelo no
momento carregados.

F5

Alterna o modo Full Screen.F11

Abre o Options Editor.F12

Abre o SteeringWheel utilizado por último.Shift + W

Permite obter a ajuda sensível ao contexto.Shift + F1

Ativa a janela Sets.Shift + F2

Ativa a janela Find Items.Shift + F3

Ativa a janela Find Comments.Shift + F4

Ativa a janela Comments.Shift + F6

Ativa a janela Properties.Shift + F7

Abre um menu de atalho.Shift + F10

Abre a caixa de diálogo File Options.Shift + F11
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Navegação com o botão de rolagem
Se você possui um mouse com rolagem, é possível usar o botão do meio do
mouse para aplicar zoom, pan e orbit.

Faça isto...Para

role o botão de rolagem para frente.Aumentar o zoom

role o botão de rolagem para trás.Diminuir o zoom

mantenha o botão do meio do mouse
pressionado, e em seguida mova o mouse
para efetuar a panorâmica.

Efetuar panorâmica

mantenha pressionado Shift e pressione o
botão do meio do mouse, em seguida mova

Orbitar

o mouse para orbitar ao redor do ponto de
giro definido atualmente. Essa função não
está disponível em um espaço de trabalho
2D.

mantenha pressionadas as teclas SHIFT e
CTRL e pressione o botão do meio do

Alterar o ponto de giro

mouse, em seguida arraste para o ponto no
modelo que deseja usar como ponto de
giro. Essa função não está disponível em
um espaço de trabalho 2D.

OBSERVAÇÃO O acima citado não se aplica quando se está usando Walk, Fly, ou
qualquer outro modo de navegação clássico, que possuem os seus próprios
comportamentos de botão de rolagem/botão do meio.

Navegação com a roda / botão do meio do mouse
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OBSERVAÇÃO Em um espaço de trabalho 2D só é possível efetuar o pan e zoom.
Além disso, a função Shift + botão do meio está disponível somente em um espaço
de trabalho 3D.

Shift + Botão do
meio

Botão do
meio

Roda

Ferramentas de não-navegação

OrbitPanZoom In/OutSelect

OrbitPanZoom In/OutMedir

OrbitPanZoom In/OutLinhas de marcação

Modos de navegação clássicos

Glide Camera (Faster)Glide CameraLook Up/DownWalk

OrbitPanZoom In/OutLook Around

-Zoom (Drag)Zoom (Roll)Zoom

-Zoom (Drag)Zoom (Roll)Zoom Box

-Zoom (Drag)Zoom (Roll)Pan

-Glide CameraZoom (Roll)Orbit

-PanZoom (Roll)Examine

-Roll-Fly

-PanTilt Up/DownTurntable

Modos de navegação padrão
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Shift + Botão do
meio

Botão do
meio

Roda

OrbitPanZoom In/OutPan

OrbitPanZoom In/OutZoom Window

OrbitPanZoom In/OutZoom

OrbitPanZoom In/OutOrbit

OrbitPanZoom In/OutFree Orbit

OrbitPanZoom In/OutConstrained Orbit

OrbitPanZoom In/OutLook At

OrbitPanZoom In/OutSteeringWheels

Opções do Autodesk Navisworks
Há dois tipos de opções: File Options e Global Options.

File Options

Em cada arquivo do Autodesk Navisworks (NWF e NWD), é possível ajustar a
aparência do modelo e a velocidade de navegação do mesmo. As opções de
exibição são armazenadas com os arquivos do Autodesk Navisworks (NWF ou
NWD) e recarregadas cada vez que estes arquivos forem abertos.

A caixa de diálogo File Options é usada para personalizar várias opções de
arquivo e pode ser acessada clicando na guia Home ➤ painel Project ➤ File
Options  .
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Global Options

Por outro lado, as opções globais são definidas para todas as sessões do Autodesk
Navisworks. O Options Editor pode ser acessado ao clicar no botão do

aplicativo  ➤ Options ou pode ser lançado como um aplicativo separado.
Para fazer isso, clique em Iniciar ➤ Todos os
programas ➤ Autodesk ➤ Navisworks Manage 2012 ➤ Options Editor.
As opções são agrupadas e apresentadas na estrutura em árvore, tornando mais
rápido encontrá-las e alterá-las.
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As opções globais podem ser exportadas e importadas, tornando mais rápido
e fácil para que os gerentes de projeto ou os administradores de sistemas
assegurem que as configurações do Autodesk Navisworks sejam idênticas em
todas as máquinas.

Para configurar as opções de arquivo

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Utilize a caixa de diálogo File Options para personalizar diversas
configurações de arquivo.

3 Clique em OK para salvar as alterações.

Menu:  Interface de usuário clássica: Tools ➤ File Options

Consulte também:

Caixa de diálogo File Options na página 799

Para configurar opções globais

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor expanda o nó desejado, e clique na opção que deseja
configurar.

3 Clique em OK para salvar as alterações.
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Menu:  Interface de usuário: Classic: Tools ➤ Global Options

Consulte também:

Caixa de diálogo Options Editor  na página 809

Para exportar opções globais

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor clique no botão Export.

3 Na caixa de diálogo Select Options to Export, selecione as caixas de
verificação para todas as opções que deseja exportar (ou "serializar"). Se
uma opção não puder ser exportada ela é acinzentada.

DICA Para selecionar/cancelar a seleção rapidamente de todas as opções
para uma determinada categoria, utilize as caixas de seleção do nível superior.
Por exemplo, a seleção da caixa de seleção General , seleciona
instantaneamente todas as opções sob este nó.

4 Clique em OK para exportar as configurações selecionadas.

5 Na caixa de diálogo Save As insira um nome para o arquivo de
configurações. Você também pode selecionar o nome de um arquivo de
configurações existente para sobrescrevê-lo com sua configuração
modificada.
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6 Clique em Save.

7 Clique em OK para fechar o Options Editor.

Menu:  Interface de usuário Classic: Tools ➤ Global Options

Para importar opções globais

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor clique no botão Import.

3 Na caixa de diálogo Open procure pela pasta que contém o arquivo de
configurações, selecione-o, e clique em Open.
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4 Clique em OK para fechar o Options Editor.

Menu:  Interface de usuário Classic: Tools ➤ Global Options

Opções de localização
Estas opções permitem o compartilhamento centralizado de configurações
globais do Autodesk Navisworks, espaços de trabalho, ferramentas de dados,
avatars, regras do Clash Detective, arquivos do Presenter, testes personalizados
do Clash Detective, scripts de animação de objeto, e assim por diante, com
outros usuários.

Estas configurações podem ser compartilhadas através de todo um local de
projeto, ou através de um grupo de projetos específico, dependendo no nível
de granularidade requerido.

Consulte também:

Como compartilho as configurações do Autodesk Navisworks com base
no projeto e terreno? na página 80
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Para configurar opções de localização

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó General no Options Editor, e clique na opção
Locations.

3 Na caixa Project Directory, navegue até o diretório que contém as
configurações do Autodesk Navisworks específicas de seu grupo de
projetos.

4 Na caixa Site Directory, navegue até o diretório que contém as
configurações padrão do Autodesk Navisworks através de todo o local
do projeto.

5 Clique em OK.

Menu:  Interface de usuário: Classic: Tools ➤ Global Options

OBSERVAÇÃO Quando você executa o Autodesk Navisworks pela primeira vez,
as configurações são obtidas no diretório de instalação. Subsequentemente, o
Autodesk Navisworks examina o perfil do usuário atual e os perfis de todos os
usuários na máquina local e, a seguir, verifica as configurações no Project
Directory e no Site Directory. Os arquivos no Project Directory tem
prioridade.
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Sistema de gráficos
O Autodesk Navisworks Manage 2012 suporta dois sistemas de gráficos: gráficos
do Presenter e gráficos da Autodesk.

Por padrão, o Autodesk Navisworks seleciona automaticamente o sistema de
gráficos mais apropriado para uso. Por exemplo, os modelos 3D são
renderizados com gráficos do Presenter, com exceção de arquivos FBX em
3D com materiais consistentes, que irão utilizar gráficos da Autodesk. As folhas
2D são renderizadas com gráficos da Autodesk. É possível utilizar o Options
Editor para especificar qual sistema de gráficos é utilizado.

Os materiais do Presenter somente estão disponíveis quando for utilizado o
sistema de gráficos do Presenter, e os materiais da Autodesk (também
denominados materiais consistentes) somente estão disponíveis quando for
utilizado o sistema de gráficos da Autodesk. A navegação em tempo real é
suportada pelos dois sistemas de gráficos, mas é preciso utilizar o sistema de
gráficos do Presenter se você deseja criar visualizações fotorrealistas.

Drivers suportados

É possível visualizar uma lista de todos os drivers suportados no Options
Editor (Interface ➤ Display ➤ Drivers). Por padrão, todas as opções de
drivers ficam selecionadas.

Para especificar o sistema de gráficos

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó Interface no Options Editor e clique na opção Display.
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3 Na área Graphics System, desmarque a caixa de seleção Auto-Select.
A caixa suspensa System agora está ativa.

4 Utilize a caixa suspensa do sistema para selecionar o sistema de gráficos
que você deseja que o Autodesk Navisworks utilize.

5 Clique em OK.

Unidades de exibição
As unidades de exibição determinam a escala do modelo no Autodesk
Navisworks.

As unidades de exibição são utilizadas para medir a geometria em sua cena.
alinhar modelos anexados, definir tolerâncias para a detecção de interferência,
definir tamanhos de textura, e assim por diante.

Quando você abre arquivos CAD e de digitalização a laser, o Autodesk
Navisworks lê as unidades do arquivo diretamente dos arquivos. Se isso não
for possível (por exemplo, o arquivo não tem unidade), o Autodesk Navisworks
usa as unidades padrão para aquele tipo de arquivo no Options Editor,
sempre que for possível. Os arquivos carregados são dimensionados de forma
apropriada para as unidades de exibição configuradas.

É possível redimensionar as unidades do arquivo, se for determinado que estão
incorretas para a cena.
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Para personalizar as unidades de exibição

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó Interface no Options Editor, e clique na opção Display
Units.

3 Selecione Linear Units na lista suspensa. Assegure ter escolhido o
formato exato requerido.

4 Selecione Angular Units na lista suspensa.

5 Insira o número de casas decimais que deseja ver na interface para suas
unidades na caixa Decimal Places. Se a unidade escolhida for fracional
ao invés de decimal, então você tem a escolha de qual nível de fração
para exibir as unidades da lista Fractional Display Precision.

6 Clique em OK.

Menu:  Interface de usuário: Classic: Tools ➤ Global Options

Perfis
O Autodesk Navisworks pode ser ajustado para seu nível de conhecimento
técnico de CAD.

Por padrão, um perfil padrão é utilizado. Se necessário, você pode utilizar um
perfil de desenvolvedor para exibir propriedades adicionais do objeto.

170 | Capítulo 3   Início rápido



Para utilizar um perfil de desenvolvedor

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó Interface , e clique na opção Developer.

3 Selecione a caixa de verificação Show Internal Properties para
adicionar propriedades de objeto adicionais à janela Properties.

4 Clique em OK.

Menu:  Interface de usuário: Classic: Tools ➤ Global Options

Pesquisar diretórios
O Autodesk Navisworks busca diversos arquivos de configuração em
subdiretórios de três diretórios padrão.

Estes arquivos podem ser sobrepostos com base em usuário, todos os usuários
ou por instalação. As pesquisas de diretórios são:
■ Application Data\Autodesk Navisworks Manage 2012 no perfil do usuário

atual. Por exemplo, C:\Documents and Settings\user\Application
Data\Autodesk Navisworks Manage 2012 onde user é o nome do usuário
atual.

■ Application Data\Autodesk Navisworks Manage 2012 dentro do perfil padrão
de todos os usuários. Por exemplo, C:\Documents and Settings\All
Users\Application Data\Autodesk Navisworks Manage 2012.
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■ No diretório de instalação do Autodesk Navisworks. Por exemplo,
C:\Arquivos de Programas\Autodesk Navisworks Manage 2012.

OBSERVAÇÃO Se você estiver usando o Windows 7, então os caminhos do
diretório de pesquisa serão diferentes. Em vez de \Users\Application Data\Autodesk
Navisworks Manage 2012, o caminho será \Users\AppData\Roaming\Autodesk
Navisworks Manage 2012.

Dois diretórios adicionais, Site e Project, podem ser usados para compartilhar
várias definições de configuração com outros usuários. Quando você executa
o Autodesk Navisworks pela primeira vez, as configurações são obtidas no
diretório de instalação. Subsequentemente, o Autodesk Navisworks examina
o perfil do usuário atual e todos os perfis de usuário na máquina local e, em
seguida·verifica as configurações em Project Directory e em Site Directory. Os
arquivos no diretório Project têm precedência.

Consulte também:

Opções de localização na página 166

Meta-alça
O Autodesk Navisworks fornece ferramentas com base em meta-alças para
interagir com objetos 3D. Os seguintes tipos de meta-alças são usados:
■ Transforme as meta-alças. Manipule globalmente a transformação dos

objetos (translação, rotação e escala) (como se tivessem sido alterados no
modelo original do CAD). Consulte Transformar objetos na página 410.

■ Meta-alça de animação. Manipule temporariamente a transformação dos
objetos para fins de animação. Consulte Manipular objetos de geometria
na página 568.

■ Meta-alça de seccionamento. Manipule os planos de corte e a caixa de
seção. Consulte Mover e rotacionar planos de corte na página 493 e Ativar
e usar a caixa de corte na página 497.

Cada meta-alça exibe três eixos coloridos nos ângulos corretos relevantes a
posição atual da câmera. As meta-alças agem como objetos 3D pelo fato de
que o eixo rotaciona com o ponto de vista. No entanto, elas são colocadas
como subjacências no topo da cena 3D e podem ser obscurecidas pro outros
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objetos. Ao passar o mouse sobre uma peça segurável da meta-alça, o cursor
é alterado para um ícone de mão  .

Meta-alça de escalaMeta-alça de rotaçãoMeta-alça de movimentação

Ao usar as meta-alças, é possível ajustar o snap para controlar a precisão das

operações (clique no botão do aplicativo de página  ➤ Options ➤ nó
Interface ➤ Snapping.
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Trabalhar com
arquivos

Você pode combinar estes arquivos e criar um arquivo único do Autodesk Navisworks
com a vista de todo o projeto de seu modelo. Este arquivo traz junto a geometria e
os dados criados por equipes multidisciplinares e permite explorar e rever modelos
complexos em tempo real.

Formatos de arquivo nativo
O Autodesk Navisworks tem três formatos de arquivo nativo: NWD, NWF e
NWC.

Formato do arquivo NWD

Um arquivo NWD contém todas as geometrias dos modelos juntamente com
os dados específicos do Autodesk Navisworks, tais como notas de revisão. Você
pode considerar que um arquivo NWD é um instantâneo do estado atual do
modelo.

Os arquivos NWD são bem pequenos, já que eles comprimem os dados de CAD
em até 80% de seu tamanho original.

Formato de arquivo NWF

Um arquivo NWF contém vínculos com os arquivos nativos originais (como
listados na Selection Tree) juntamente com os dados específicos do Autodesk
Navisworks, tais como notas de revisão. Nenhuma geometria do modelo é salva
com este formato de arquivo; isto faz com que um NWF seja consideravelmente
menor em tamanho do que um NWD.

4
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Formato do arquivo NWC (Arquivos em cache)

Por padrão, ao abrir ou anexar um arquivo nativo CAD ou um arquivo gerado
por scanner a laser no Autodesk Navisworks, um arquivo de cache é criado no
mesmo diretório e com o mesmo nome do arquivo original, mas com uma
extensão .nwc.

Os arquivos NWC são menores do que os arquivos originais e aceleram o acesso
aos arquivos de uso comum. Na próxima vez que você abrir ou anexar o arquivo
no Autodesk Navisworks, os dados são lidos do arquivo de cache
correspondente se for mais novo do que o arquivo original. Se o arquivo de
cache for mais antigo, o que significa que o arquivo foi modificado, o Autodesk
Navisworks converte o arquivo atualizado e cria um novo arquivo de cache
para ele.

Consulte também:

Opções do arquivo NWC  na página 837

Opções do arquivo NWD  na página 836

Aplicativos de CAD compatíveis
A tabela abaixo é fornecida somente com um referência rápida, e não contém
uma lista exaustiva de aplicativos de CAD compatíveis. Para obter informações
adicionais, consulte a seção Features em nosso website
http://www.autodesk.com.br/navisworks.

Formatos de arquivoAplicativo

DWG, DXF, 3DSAutodesk AutoCAD

DWG, DXF, 3DSAutodesk ADT/AutoCAD Architecture

DWG, DXF, 3DSAutodesk Building Systems/AutoCAD MEP

IPT, IAM, IPJ, IGES, STEPAutodesk Inventor

DWG, DXF, 3DSAutodesk AutoCAD Civil 3D

DWG, DXF, 3DS, VRMLAutodesk MDT
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Formatos de arquivoAplicativo

DWG, DXF, DGNAutodesk Revit

DWG, DXF, DGNAutodesk Revit Building/Revit Architecture

DWG, DXF, DGN, CIS/2Autodesk Revit Structure

DWG, DXF, DGNAutodesk Revit Systems/Revit MEP

DWG, DXF, 3DS, IGESAutodesk 3DS MAX

DWG, DXF, 3DSAutodesk VIZ

DXF, IGES, VRMLAutodesk Maya

DGN, DWG, DXFBentley AutoPLANT

DGN, DWG, DXF, IGES, VRMLBentley MicroStation SE

DGN, DWG, DXF, IGES, STEP, VRMLBentley MicroStation J

DGN, DWG, DXF, IGES, STEP, VRMLBentley MicroStation

DGN, DWG, DXF, IGES, STEP, VRMLBentley Triforma J

DGN, DWG, DXF, IGES, STEP, VRMLBentley Triforma

DWG, DXF, DGN, IFCGraphisoft ArchiCAD

DWG, DXF, DGNGraphisoft Constructor

DXFAceCad StruCad

DWG, DXF, 3DS, IGES, STL, VRMLauto.des.sys form.z
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Formatos de arquivoAplicativo

DWG, DXF, 3DSAEC CADPIPE

RVMAVEVA PDMS

DWG, DXFCADopia IntelliCAD

DWG, DGNCEA Technology Plant-4D

DWG, DXF, 3DSCOADE CADWorx Plant

DWG, DXF, 3DSCOADE CADWorx Pipe

DWG, DXF, 3DSCOADE CADWorx Steel

DWG, DXF, 3DSCOINS BSLink

DWG, DXF, 3DSCOINS Framing

DWGCSC 3D+

DXF, IGES, STEPDassault Systemes CATIA

SKP, DWG, 3DSGoogle SketchUp

DWG, DXF, 3DSHannappel Software GmbH elcoCAD R4

DRI, DRV, DWG, DXF, DGN, IGES,
STEP

Integraph PDS

MANInformatix MicroGDS

DWG, DXF, 3DSITandFactory CADISON

VRMLITandFactory TRICAD MS
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Formatos de arquivoAplicativo

DWG, DXF, 3DSKiwi Software GmbH ProSteel 3D

DWG, DXF, IGES, STEPKubotek USA CADKEY

DWG, DXF, 3DSM.A.P. CAD-Duct

DWG, DXF, 3DS, IGES, STEPMcNeel North America Rhino

DWG, DXF, 3DSMensch und Maschine RoCAD

DWG, DXF, 3DSMultiSUITE MultiSTEEL

DWG, DXF, DGN, IFCNemetschek Allplan

DWG, DXF, 3DSPROCAD 3DSMART

IGES, STEP, VRMLPTC Pro/ENGINEER

IGES, STEPPTC CADDS 5

DWG, DXF, 3DSQuickPen PipeDesigner 3D

DWG, DXF, 3DSQuickPen DuctDesigner 3D

DWG, DXF, 3DSRAM International CADstudio

DWG, DXF, IGES, STEP, VRMLSolidWorks

DGN, VRML, CIS/2Tekla Structures

DGNTekla Xsteel

DWG, DXF, IGES, STEPthink3 thinkdesign
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Formatos de arquivoAplicativo

DXF, IGES, STEPUGS I-deas

IGES, STEPUGS Solid Edge

DXF, IGES, STEPNX

DWG, DXF, 3DSUGS Factory CAD

DWG, DXF, 3DSUHP Process Piping FabPro Pipe

DWG, DXF, 3DSUHP Process Piping x-plant

Formatos de arquivo CAD suportados

Consulte a tabela a seguir para verificar quais formatos de arquivo de CAD
podem ser abertos no Autodesk Navisworks sem ter que ter os aplicativos de
CAD instalados em sua máquina.

ExtensãoFormato

.nwd, .nwf, .nwcAutodesk Navisworks

.fbxAutodesk

.dwg, .dxfAutoCAD

.satACIS SAT

.stp, .stepCIS/2

.dwfDWF

.ifcIFC
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ExtensãoFormato

.igs, .igesIGES

.man, .cv7Informatix MicroGDS

.ipt, .iam,. ipjInventor

.jtJTOpen

.dgn, .prp, .prwMicroStation (SE, J, V8, XM)

.x_bParasolid

.driPDS Design Review

.rvmRVM

.skpSketchUp

.stp, .stepSTEP

.stlSTL

.wrl, .wrzVRML

.3ds, .prjv3D Studio
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Formatos de arquivo de varredura de laser
suportados

Consulte a tabela a seguir para verificar quais formatos de arquivo de varredura
de laser podem ser abertos no Autodesk Navisworks.

ExtensãoFormato

.asc, .txtArquivo ASCII Laser

.fls, .fws, .iQscan, .iQmod, .iQwspFaro

.pts, .ptxLeica

.3ddRiegl

.zfc, .zfsZ+F

OBSERVAÇÃO O formato de arquivo Native Trimble não é suportado. Para abrir
seu arquivo no Autodesk Navisworks, primeiro converta para o formato de arquivo
ASCII laser.

Utilizar leitores de arquivos
O Autodesk Navisworks fornece leitores de arquivos para suportar uma
variedade de formatos de arquivos CAD e formatos de arquivo de varredura
de laser.

Quando você abre um arquivo de CAD no Autodesk Navisworks, um leitor de
arquivo apropriado é automaticamente utilizado. Se necessário, é possível
ajustar as configurações do leitor padrão de arquivos para aprimorar a qualidade
da conversão.

Leitor de arquivos 3DS

O 3DS é um formato de arquivo comum suportados por diversos aplicativos
de CAD.
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O leitor de arquivos do Autodesk Navisworks lê toda a geometria 2D e 3D,
assim como os mapas de textura. A hierarquia definida pelos dados do
quadro-chave 0 é preservada, incluindo as instâncias. As entidades são
posicionadas com base no quadro-chave 0.

Entidades suportadas

■ Toda a geometria 2D e 3D

■ Câmeras

■ Groups

■ Os mapas de texturas em formatos: 8-bit color-mapped, 16-bit e 24-bit true
color, uncompressed ou Run Length Encoded TGA, BMP, JPEG, e LWI
(LightWork Image).

OBSERVAÇÃO A texturas de arquivos 3DS vêm como materiais do Presenter,
apesar de que você deve estar ciente de que os arquivos 3DS somente contêm
nomes de arquivos no formato 8.3 DOS, e que somente diversos formatos
ainda não são suportados no Presenter.

■ Cores (da cor do material, não cores da estrutura de arame - ambiente,
difusa, brilho, transparência e auto-iluminação).

Entidades não suportadas

■ Quadros-chave (os objetos no momento são obtidos do quadro-chave 0).

■ Os mapas de texturas em formatos: gray-scale TGA, TIF, GIF, e PNG.

■ Outros mapas (por exemplo, mapas de opacidade, reflexões e assim por
diante.)

■ Malhas de estrutura de arame

■ Linhas, splines

■ Pontos

■ Imagens do segundo plano

Consulte também:

Opções do leitor de arquivos 3DS  na página 838
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Leitor de arquivos ASCII Laser Scan

A maioria de softwares de scanner suportam a exportação de dados de pontos
para um arquivo de texto ASCII. Desde que os dados sejam salvos no formato
correto, eles podem ser lidos pelo Autodesk Navisworks.

Os formatos de arquivos de varredura de laser ASCII estão abaixo listados. Os
dados precisam ser separados utilizando um dos seguintes caracteres: vírgula,
tab ou espaço. O caractere utilizado para definir um decimal precisa ser um
ponto (.).
■ X, Y, Z

■ X, Y, Z, Intensity

■ X, Y, Z, Red, Green, Blue

■ X, Y, Z, Intensity, Red, Green, Blue

Os valores Intensity, Red, Green e Blue são inteiros na faixa de 0-255. As
intensidades não têm correção de gama.

Entidades suportadas

■ Pontos

Entidades não suportadas

■ Nenhuma outra entidade é suportada.

Consulte também:

Opções do leitor de arquivos ASCII Laser Scan  na página 839

Leitor do arquivo Bentley AutoPLANT

O Bentley AutoPLANT tem base no AutoCAD e como tal utiliza o formato de
arquivo DWG para armazenar a geometria do modelo. Quaisquer configurações
relativas ao formato de arquivo DWG também afetam os arquivos do
AutoPLANT.

As propriedades do objeto AutoPLANT podem ser armazenadas em arquivos
de banco de dados externo MDB. Por padrão, o Autodesk Navisworks também
suporta esses arquivos através da funcionalidade DataTools e procura os links
de ferramentas de dados Equipment, Nozzle e Piping.
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Consulte também:

Opções do leitor de arquivos DWG/DXF  na página 844

Leitor de arquivo CIS/2

O leitor de arquivo CIS/2 suporta o CIMSteel Integration Standards (CIS/2),
adotado pelo American Institute of Steel Construction (AISC) como seu formato
para dados de troca entre software do CAD relacionado ao aço.

Entidades suportadas

■ Assembly_design

■ Assembly_design_child

■ Assembly_manufacturing

■ Analysis_model_3d

■ Part_derived

■ Part_prismatic_simple

■ Part_sheet_bounded_complex

■ Part_sheet_bounded_simple

■ Section_profile_compound

■ Section_profile_derived

■ Section_profile_edge_defined

■ Section_profile_angle

■ Section_profile_channel

■ Section_profile_circle

■ Section_profile_circle_hollow

■ Section_profile_i_type

■ Section_profile_i_type_asymmetric

■ Section_profile_i_type_rail

■ Section_profile_rectangle

■ Section_profile_rectangle_hollow

■ Section_profile_t_type

■ feature_volume_prismatic_chamfer
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■ feature_volume_prismatic_flange_notch

■ feature_volume_prismatic_flange_chamfer

■ feature_volume_prismatic_notch

■ feature_volume_prismatic_skewed_end

■ Element_curve_simple

■ Element_node_connectivity

■ Element_eccentricity

■ Located_joint_system

■ Design_joint_system

■ Joint_system_mechanical

■ Fastener_mechanism

■ Fastener_simple_bolt

■ Fastener_simple_shear_connector

Entidades não suportadas

■ Part_complex

■ Part_prismatic_complex

■ Part_sheet_profiled

■ Section_profile_centreline

■ feature_cutting_plane

■ feature_edge_chamfer

■ feature_surface

■ feature_thread

■ feature_volume_complex

■ feature_volume_curved

■ feature_volume_hole

■ Element_volume

■ Element_surface

■ Element_point

■ Element_curve_complex

■ Element_with_material

■ Joint_system_amorphous
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■ Joint_system_chemical

■ Joint_system_welded

■ Weld_mechanism

■ Joint_system_complex

■ Fastener_simple_nut

■ Fastener_simple_washer

■ Fastener_simple_stud

■ Fastener_simple_pin

■ Fastener_simple_nail

■ Fastener_simple_screw

■ Fastener_simple_countersunk

■ Fastener_simple_curve

■ Fastener_simple_complex

Tipos de perfis de corte básico suportados

O leitor de arquivo suporta os seguinte tipos básico de perfil de corte:

■ Viga_I

■ Tê

■ Ângulo

■ Canal

■ Círculo

■ Retângulo

■ Ângulo duplo

■ Caibro

Tipos de perfis de corte AICS suportados

O leitor der arquivos suporta todos os tipos de perfis de corte definidos pelo
AISC e os mapeia para os tipos de perfis de corte básicos:

■ Viga-I: HP, M, S, W

■ Tê: MT, ST, WT

■ Ângulo: L, LP
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■ Canal: C, MC

■ Círculo: HSRO, P, PX, PXX, RB

■ Retângulo: HSRE, HSSQ, SB, TS

■ Ângulo duplo: DL, DLL, DLS

Consulte também:

Opções do leitor de arquivos CIS2  na página 839

Leitor de arquivos DWG/DXF

O leitor de arquivos DWG/DXF utiliza a tecnologia ObjectDBX™ da Autodesk
e, portanto, garante a leitura de toda a geometria de objetos e informações
para os aplicativos de terceiros que utilizam o ObjectDBX Framework.

A estrutura do desenho é preservada, incluindo refexs, blocos, inserções, índice
de cores AutoCAD, camadas, vistas e ponto de vista ativo. As entidades são
coloridas utilizando o AutoCAD Color Index (ACI), para que coincidam com
as entidades na vista 'sombreada' do AutoCAD.

OBSERVAÇÃO O leitor de arquivos suporta arquivos de todos os produtos com
base no AutoCAD 2012 e anteriores.

Entidades suportadas

■ Toda a geometria 2D e 3D, incluindo arcos, linhas, polilinhas com espessura
não-zero, objetos ACIS (regiões e sólidos), malhas poligonais e polifacetadas,
faces e superfícies 3D.

■ Pontos e pontos de snap.

■ Linhas, polilinhas, círculos, arcos com espessura zero.

■ Vistas nomeadas

■ Layers

■ Colors

■ Blocos, inserções e múltiplas inserções

■ Groups

■ Referências externas (refexs)

■ Hyperlinks
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■ Texto ou texto de múltiplas linhas

■ Manipuladores de entidade

■ Attributes

■ Texturas

■ Propriedades do arquivo

Entidades não suportadas

■ Luzes

■ Splines

■ Múltiplas linhas

■ Linetypes

■ Cotas e chamadas de detalhe

■ Bitmaps raster

■ Linhas de construção (xlinhas e raios)

■ Hatching

Consulte também:

Opções do leitor de arquivos DWG/DXF  na página 844

Visão geral dos ativadores de objetos

Os ativadores de objetos (OEs) podem ser considerados como um 'tradutor'
para objetos personalizados. Aplicativos com base na plataforma AutoCAD®

(incluindo produtos da Autodesk como o AutoCAD® Architecture, e produtos
não da Autodesk como o Bentley AutoPlant) geram objetos personalizados
que são salvos no formato de arquivo DWG file. Estes objetos personalizados
são normalmente encontrados em bibliotecas de conteúdo que fazem parte
destes aplicativos.

Muitos aplicativos têm a habilidade de ler arquivos DWG, no entanto, fora
do aplicativo de autoria qualquer objeto personalizado não pode ser
interpretado. Com resultado, os leitores de arquivos DWG, exibem tais objetos
personalizados de forma incorreta, como gráficos proxy (geometria de estrutura
de arame), a não ser que o OE requeridos esteja instalado na máquina que está
lendo o arquivo DWG.
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OBSERVAÇÃO  O Autodesk Navisworks contém versões do RealDWG™ para 2005,
2006, 2007, 2008, 2009, 2010 e 2012. Isso significa que você pode utilizar o OE
entre 2005 e 2012 com o Autodesk Navisworks. Você não pode utilizar nenhum
OE mais antigo do que o 2005. No entanto, os OEs são retro-compatíveis e um
OE posterior pode ser instalado para suportar a leitura de versões mais antigas dos
arquivos DWG.

Para verificar se um OE é requerido

1 Em Autodesk Navisworks, abra um arquivo DWG.

2 Se só puder ver a geometria de estrutura de arame, clique na guia Home,
deslize o painel Project, e clique em Scene Statistics. A caixa de
diálogo Scene Statistics contém o relatório que lista quaisquer OEs
que estão faltando ou que tiverem falha de carga. Você precisa instalar
todos os OEs faltantes para abrir corretamente o arquivo no Autodesk
Navisworks.

OBSERVAÇÃO Ocasionalmente, um OE já está instalado, mas não suporta
aplicativos que não têm base no AutoCAD, como o Autodesk Navisworks.
Em tais casos, o OE é reportado como faltando na caixa de diálogo Scene
Statistics.

Para instalar e utilizar um OE com o Autodesk Navisworks

1 Obtenha o ambiente operacional necessário e execute o instalador.

2 Na página OE Setup, selecione a caixa de seleção dos produtos Autodesk
Navisworks relevantes da Autodesk.

OBSERVAÇÃO Alguns OEs têm dependências sobre outros OEs e, portanto,
precisam ser instalados em uma ordem específica. Por exemplo, o OE do
AutoCAD MEP 2009 tem dependência sobre o OE do AutoCAD Architecture
2009. Como resultado, o OE do AutoCAD MEP 2009 precisa ser instalado
após o OE do AutoCAD Architecture.

3 Clique em Install. Quando o OE tiver sido instalado, clique em Finish.

4 Execute o Autodesk Navisworks.

5 Clique no botão do aplicativo  ➤ Options.

6 No Options Editor, expanda o nó File Readers, e clique em
DWG/DXF.

7 Assegure que o valor no campo DWG Loader Version seja o mesmo
da versão do OE instalado e feche a caixa de diálogo. Por exemplo, se
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você instalou o OE para o AutoCAD Architecture 2007, é preciso definir
o DWG Loader Version como ‘2007’.

Quando você abre um arquivo DWG no Autodesk Navisworks, o leitor
de arquivos utiliza o ambiente operacional configurado.

Como posso saber se é preciso utilizar um ativador de objetos com o
Autodesk Navisworks2012?

Quando um arquivo DWG é aberto no Autodesk Navisworks2012 e os objetos
são exibidos como uma geometria de estrutura de arame, normalmente significa
que um ativador de objetos está faltando.

Adicionalmente, a caixa de diálogo Scene Statistics reportar quaisquer OEs
que estejam faltando ou que tiveram falha de carga.

De onde obtenho os Object Enablers?

A forma recomendada para obter OEs é a de solicitá-los a pessoa autora do
arquivo DWG. Isto assegura que aversão correta do OE seja utilizada.

DICA Também é possível efetuar o download de diversos OEs dos websites do
fornecedor dos aplicativos de autoria. Por exemplo, você pode efetuar o download
do Autodesk OEs de http://www.autodesk.com/oe.

O que faço quando os Object Enablers não são reportados como
faltando, mas somente consigo visualizar a geometria de estrutura de
arame?

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó File Readers, e clique em
DWG/DXF.

3 Selecione Shaded na lista suspensa Render Type.

4 Assegure que a caixa de seleção Use ADT Standard Configuration
esteja selecionada.

5 Clique em OK para salvar as alterações e fechar a caixa de diálogo.

6 Clique em New  na barra de ferramentas Quick Access e, em seguida,
abra o arquivo DWG novamente.
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Leitor de arquivos DWF/DWFx

O DWF da Autodesk foi especificamente desenvolvido pela Autodesk como
um formato de arquivo para arquitetos, engenheiros e profissionais GIS, para
compartilhar dados de projeto 2D e 3D. Os arquivos DWF são altamente
compactados e retêm informações detalhadas de projeto e de escala. A versão
mais nova do formato de arquivo DWF, o DWFX, tem base na XML Paper
Specification (XPS) da Microsoft. Os arquivos DWFx podem ser abertos e
impressos instantaneamente com o uso do Microsoft XPS Viewer grátis, que
vem pré-instalado nos computadores que usam o sistema operacional Microsoft
Windows Vista®. (Para o sistema operacional Windows XP, o Microsoft XPS
Viewer pode ser baixado diretamente da Microsoft). Diferente dos arquivos
DWF, os arquivos DWFx incluem informações adicionais para exibir dados
do projeto no Microsoft XPS Viewer. Como tal, os arquivos DWFx são maiores
do que os arquivos DWF correspondentes.

Entidades suportadas

■ Toda a geometria 3D

■ Mapas de textura

■ Coordenadas de textura

■ Cores (por vértice, por face)

■ Campos de propriedades

■ Categories

■ Linhas 2D/cortes de plotagem

■ Miniaturas (para arquivos de 2012 ou posteriores)

■ Propriedade da folha (para arquivos de 2012 ou posteriores)

■ Mais de um corte 3D por arquivo (suporte a arquivo de múltiplas folhas)

Entidades não suportadas

■ Croquis com revisões

■ Superfícies NURBS

■ Câmeras

Consulte também:

Opções do leitor de arquivos DWF  na página 843
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Leitor de arquivos DGN

Autodesk Navisworks pode ler arquivos 3D DGN e PRP do MicroSation da
Bentley, mas não suporta arquivos CEL ou 2D DGN. Arquivos referenciados
e instâncias de células são respeitados e a Selection Tree reflete a estrutura
do arquivo.

OBSERVAÇÃO O leitor de arquivos suporta arquivos MicroStation 95, SE e /J. Não
suporta MicroStation Modeler e qualquer versão MicroStation antes da 95.

Entidades suportadas

■ Toda a geometria 2D e 3D, incluindo formas, formas complexas, malhas,
cones, superfícies, limites de B-spline, sólidos, SmartSolids e Feature Solids,
linhas, arcos e elipses.

■ Splines e curvas B-spline

■ Luzes

■ Levels

■ Células, células compartilhadas e suas instâncias

■ As propriedades cor e ambiente, difuso e brilho dos materiais das paletas
PAL e MAT e arquivos de materiais

■ Mapas de textura

■ Arquivos referenciados incluindo acrônimos

■ Desenho dinâmico de modelos paramétricos ao carregar/exportar arquivos
DGN e PRP

■ O texto 3D utilizado para notas e legendas agora é convertido e exibido
por padrão

■ Família, peças e informações de textura de TriForma e informações de
objetos PDS de arquivos DRV.

■ Família, peças e informações de textura de TriForma e informações de
objetos PDS de arquivos DRV.

Entidades não suportadas

■ Bitmaps raster

■ Cotas e chamadas de detalhe
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Consulte também:

Opções do leitor de arquivos DGN  na página 840

Leitor de arquivos Faro Scan

O leitor de arquivos suporta arquivos de todos os scanners Faro™. Arquivos
iQscan combinados, precisam estar localizados em uma pasta denominada
‘Scans’ no mesmo diretório que os arquivos de espaço de trabalho associados
iQmod e iQwsp.

Consulte também:

Opções do leitor de arquivos Faro Scan  na página 849

Leitor de arquivos FBX

O leitor de arquivos suporta arquivos FBX da Autodesk.

O formato Autodesk FBX é uma plataforma do formato de criação e intercâmbio
3D grátis e independente, que fornece o acesso ao conteúdo 3D para maioria
dos fornecedores de 3D. O formato de arquivo FBX oferece interoperabilidade
aprimorada entre o Autodesk Navisworks e uma variedade de produtos da
Autodesk, incluindo Maya, 3DS MAX e SoftImage.

O leitor de arquivos FBX do Autodesk Navisworks lê toda a geometria 2D e
3D, assim como os mapas de textura e mapas de materiais. No entanto, no
momento ele não suporta animações.

Entidades suportadas

■ Todas a geometria 2D e 3D (malha, NURBS, amostra, NURBS aparadas,
curva de NURBS)

■ Mapas de textura

■ Mapas de material

■ Câmera e luz

■ Esqueleto

■ Normais, cores (ambos do vértice)
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Entidades não suportadas

■ Restrição (restrição de cluster, restrição de forma e restrição de mira)

■ Pose

■ Quadro da animação

■ Marcador

■ Nulos

■ Geometria de nuvem de ponto

Consulte também:

Opções do leitor de arquivos FBX  na página 849

Leitor de arquivos IFC

O leitor de arquivos suporta arquivos IFC independentes.

Entidades suportadas

■ BReps facetadas

■ Sólidos de área com extrusão

■ Conjuntos geométricos

■ Modelos com base na face e com base na superfície

■ Curvas simples, aparadas e compostas

■ Superfícies planas

■ Perfis paramétricos simples, arbitrários e derivados

■ Resultados de recorte booleano e operações anuladas de nível de elemento
e projeção CSG

■ Itens com estilo básico e mapeados

■ Conjuntos de propriedades, incluindo propriedades simples e complexas

Entidades não suportadas

■ BReps anuladas

■ Sólidos com meio-espaço delimitado

■ Perfis paramétricos complexos
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■ Curvas BSpline

■ Estilos de curva

■ Superfícies varridas

■ Textura e iluminação complexa

■ Carga de modelos IFC com base no servidor

Consulte também:

Opções do leitor de arquivos IFC  na página 850

Leitor de arquivos IGES

O leitor de arquivos utiliza o servidor do Inventor para carregar arquivos IGS
e IGES. Todas as versões de arquivo são suportadas.

Não mais é possível personalizar o leitor de arquivos IGES no Editor de
opções.

Leitor de arquivos do Inventor

O leitor de arquivos suporta os formatos de arquivo IPT (peça), IAM
(montagem) e IPJ (projeto). O formato de arquivo IDW (desenho) não pode
ser lido.

O leitor suporta arquivos do Autodesk® Inventor® 2012 e anteriores.

Consulte também:

Opções do leitor de arquivos do Inventor  na página 852

Leitor de arquivos JTOpen

O leitor de arquivos suporta os dados 3D JT desenvolvido pela Siemens PLM
Software (anteriormente UGS Corp.).

Entidades suportadas

■ Forma definida como Tri-strip
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■ Forma definida como polilinha

■ Forma de primitivo de caixa

■ Forma de primitivo de cilindro

■ Forma de primitivo de esfera

■ Modelos com cor e normal com base no vértice

■ JT B-Rep geral

■ Atributo de transformação geométrica

■ Atributo de material

■ Segmento XT B-Rep

■ Propriedades

Entidades não suportadas

■ Forma definida como ponto

■ Forma definida como polígono

■ Forma definida como amarração de fiação

■ Forma de primitivo de pirâmide

■ Forma definida como Tri-prism

■ Meta-dados do gerenciador PMI

■ Modelos cor e normal com base na face ou com base no primitivo

■ Textura

■ Modelo de cor HSL

■ Identificador B-Rep CAD

■ Atributo de estilo de linha

■ Atributo de estilo de ponto

■ Atributo de efeitos de sombreamento

■ Atributo de sombreamento de vértice

■ Atributo de sombreamento de fragmento

■ Atributo de luz infinita

■ Atributo de luz puntiforme

■ Segmento de estrutura de arame

■ LOD
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Consulte também:

Opções do leitor de arquivos JTOpen  na página 853

Leitor de arquivos Leica Scan

O leitor de arquivos suporta os arquivos de todos os scanners Leica™ HDS.

Entidades suportadas

■ Pontos

Entidades não suportadas

■ Nenhuma outra entidade é suportada

Consulte também:

Opções do leitor de arquivos Leica Scan  na página 852

Leitor de arquivos MAN

O leitor de arquivos suporta arquivos MAN do MicroGDS™ versão 6.0 ou
superior da Infomatix. Os projetos do MicroGDS™ não são suportados. A
solução é exportar a janela de projeto desejado com uma extensão de arquivo
.man.

No Autodesk Navisworks, as renderizações de material do MicroGDS são
mostradas em suas cores sombreadas planas no modo sombreado. No modo
de renderização completa ou com a renderização do Presenter , sombras
completas são utilizadas. Somente as sombras padrão do LightWorks estão
disponíveis. Os sombreamentos que são únicos ao MicroGDS não estão
disponíveis dentro do Autodesk Navisworks e são convertidos como segue:
■ O sombreamento de cor de banda de altura é tratado como cinza simples

■ O sombreamento de cor aleatória envolvida é tratado como uma cor simples
utilizando a cor sombreada plana do MicroGDS

■ A transparência de lápis envolvido é ignorada

■ Os sombreamentos ondulados, tijolo envolvido, eixo envolvido e
sombreadores deslocados ondulados, são ignorados
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■ O espaço de textura do eixo do objeto é equivalente ao espaço da textura
da caixa do Autodesk Navisworks

■ O eixo automático e o espaço de textura do eixo XY do objeto são tratados
como o espaço de textura da caixa do Autodesk Navisworks

■ O segundo plano do eixo é tratado como um segundo plano simples
utilizando a cor do segundo plano, ou seja, as linhas de eixo não são
mostradas

■ Os sombreamentos de primeiro plano e de ambiente são ignorados

OBSERVAÇÃO Todos os outros sombreamentos, a partir do MicroGDS 7.2, são
corretamente importados no Autodesk Navisworks.

Os materiais do MicroGDS são especificados em milímetros e são convertidos
em metros para criar materiais do Autodesk Navisworks, dividindo os
parâmetros de distância por 1.000.

Janelas com vistas em perspectiva são convertidas como pontos de vista.

Entidades suportadas

■ Primitivos agrupados

■ Primitivos de linha

OBSERVAÇÃO A cor dos primitivos de linha é determinada pela primeira fase
na qual eles aparecem na janela Inicial do arquivo MAN. Se eles não estão
incluídos na janela Inicial, a cor é determinada por seu estilo.

■ Estilos de luz

OBSERVAÇÃO Luzes do projetos são tratadas como luz de spot sem a imagem
transparente.

■ Estilos de material, materiais simples e na maioria do LightWorks Renderer.

OBSERVAÇÃO Para materiais usando imagens envolvidas, é preciso especificar
os caminhos da textura.

■ Camadas

OBSERVAÇÃO Todas as camadas são lidas e tornadas visíveis de acordo com
seu status na janela Inicial do arquivo MAN.

■ Instâncias

■ Estrutura de dados do objeto
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Entidades não suportadas

■ Primitivos de texto

■ Primitivos de foto

Consulte também:

Opções do leitor de arquivos MAN  na página 854

Leitor de arquivos Parasolid

O leitor de arquivo suporta os arquivos X_B Parasolid.

Consulte também:

Opções do leitor de arquivos Parasolid  na página 854

Leitor de arquivos PDS

O leitor de arquivos suporta arquivos DRI do pacote PDS Design Review.

Consulte também:

Opções do leitor de arquivos PDS  na página 855

Leitor de arquivos Pro/ENGINEER

O leitor de arquivos Pro/ENGINEER usa o Servidor do Inventor para carregar
os seguintes tipos de arquivos do Pro/ENGINEER:
■ *.prt* (peça) - até a versão Wildfire 5.0

■ *.asm* (montagem) - até a versão Wildfire 5.0

■ *.g (Granito) - até a versão 6.0

■ *.neu* (Neutro)

O leitor de arquivos usa o servidor do Inventor para converter arquivos de
montagem e peças, sólidos, multi-sólidos, superfícies e mais. Não é possível
personalizar o leitor de arquivos Pro/ENGINEER no Editor de opções.
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Leitor de arquivos Riegl

O leitor de arquivos suporta os arquivos de todos os scanners Riegl™ LMS.

Entidades suportadas

■ Pontos

■ Triângulos

Entidades não suportadas

■ Nenhuma outra entidade é suportada

Consulte também:

Opções do leitor de arquivos de verificação Riegl  na página 856

Leitor de arquivos RVM

O leitor de arquivos suporta os seguintes formatos de arquivo:
■ Arquivos binários e ASCII RVM exportados do produto AVEVA’s PDMS™

■ Arquivos de atributos Dump Attributes e Data (também chamado
“OUTPUT”), com as extensões de arquivo .att, .attrib, and .txt.

■ Arquivos RVS

Entidades suportadas

■ Toda a geometria

■ Atributos armazenados em grupos

■ Texturas (através do arquivo RVS)

■ Câmeras e acompanhamento da câmera (através do arquivo RVS)

■ Planos de recorte (através do arquivo RVS)

■ Sinais (através do arquivo RVS)

■ Identificadores (através do arquivo RVS)

■ Legendas (através do arquivo RVS)

■ Translucidez (através do arquivo RVS)
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■ Pontos de origem PDMS

Entidades não suportadas

■ Atributos armazenados em primitivos

■ Luzes

■ Animação de objeto

■ Animação suave

■ Groups

■ Identificadores automáticos

Consulte também:

Opções do leitor de arquivos RVM  na página 856

Leitor de arquivos SAT

O leitor de arquivos suporta arquivos ACIS SAT.

Consulte também:

Opções do leitor de arquivos SAT  na página 858

Leitor de arquivos do SketchUp SKP

O leitor de arquivos suporta o formato de arquivo SKP nativo.

Entidades suportadas

■ Geometry

■ Materiais (somente material de face frontal)

■ Transparency

■ Groups

■ Componentes

■ Layers

■ Imagens importadas
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■ Transparency

Entidades não suportadas

■ Texto

■ Cotas

■ Planos de corte

Consulte também:

Opções do leitor de arquivos Sketchup SKP  na página 859

Leitor de arquivos STEP

O leitor de arquivos utiliza o servidor do Inventor para carregar arquivos STP
e STEP incluindo até o AP214 CC2 e AP203.

Não mais é possível personalizar o leitor de arquivos STEP no Editor de
opções.

Leitor de arquivos STL

O leitor de arquivos somente suporta arquivos STL binários. Versões ASCII
não são suportadas.

Entidades suportadas

■ Triângulos

Entidades não suportadas

■ Nenhuma outra entidade é suportada

Consulte também:

Opções do leitor de arquivos STL  na página 860
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Leitor de arquivos VRML

O leitor de arquivos suporta os formatos de arquivo VRML1 e VRML2.

Entidades suportadas

■ Toda a geometria 3D incluindo cubóides, cilindros, cones, esferas, eixos
de elevação, extrusões, conjuntos de faces e linhas e pontos.

■ Todos os nós de agrupamento, mas com as seguintes limitações:
■ Nós VRML2 Billboard - os secundários são carregados mas nenhum

'billboard' ocorre.

■ Nós VRML2 Collision - os secundários são carregados mas não corre
nenhuma especificação de detecção de colisão.

■ Nós VRML1 WWWAnchor e VRML2 Anchor - os secundários são
carregados mas clicar em objetos não carrega nenhum universo VRML.

■ Nós VRML1 e VRML2 LOD - o secundário mais detalhado é sempre
carregado.

Entidades não suportadas

■ Todas as definições ROUTE

■ Todos os nós do sensor

■ Todos os nós do interpolador

■ Texturas especificadas dentro do arquivo VRML (nós VRML2 PixelTexture
e o componente de imagem do nó VRML1 Texture2).

■ Nós VRML2 Script

■ Nós VRML2 MovieTexture

■ Nós VRML2 Fog

■ Nós VRML2 AudioClip and Sound

■ Todos os nós relativos ao texto (nós VRML1 ASCII Text, VRML2 Text e
FontStyle).

Consulte também:

Opções do leitor de arquivos VRML  na página 860
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Leitor de arquivos Z+F Scan

O leitor de arquivos suporta os arquivos de todos os scanners Z+F™ IMAGER.

Entidades suportadas

■ Pontos

Entidades não suportadas

■ Nenhuma outra entidade é suportada

Consulte também:

Opções do leitor de arquivos Z+F  na página 862

Utilizar exportadores de arquivos
O Autodesk Navisworks fornece exportadores de arquivos para criar arquivos
nativos do Autodesk Navisworks diretamente em aplicativos de CAD.

No momento, você pode exportar arquivos NWC dos aplicativos AutoCAD,
MicroStation, Revit, ArchiCAD e Viz/Max.

Você pode utilizar exportadores de arquivos:
■ Se o Autodesk Navisworks não puder ler o formato nativo do arquivo de

CAD. No momento, os seguintes formatos de arquivos nativos não são
suportados: VIZ, MAX, ArchiCAD, Revit.

■ Se o Autodesk Navisworks converteu o arquivo nativo de CAD, mas alguma
geometria está faltando, por exemplo, e você deseja aprimorar a qualidade
do arquivo.

Exportador do arquivo do AutoCAD

O Autodesk Navisworks é fornecido com plugins ARX para quaisquer produtos
com base no AutoCAD™, como o Architectural Desktop™, e permite exportar
arquivos no formato de arquivo NWC.

O exportador de arquivos está disponível para qualquer produto baseado em
AutoCAD entre as versões AutoCAD 2004 e 2012.
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OBSERVAÇÃO Se você instalou o software Autodesk Navisworks com plugins do
exportador, e instala qualquer software com base no AutoCAD após o Autodesk
Navisworks ter sido instalado, será necessário atualizar seus plugins do exportador
com os plugins ARX apropriados antes de poder utilizá-los.

Consulte também:

Opções do exportador de arquivo DWG na página 863

Adicionar o plugin ARX

Você pode adicionar o plugin ARX na instalação dos plugins do exportador,
ou pode carregá-lo manualmente no software com base no AutoCAD.

Para adicionar o plugin ARX na instalação dos plugins do exportador

1 No Painel de controle, clique duas vezes em Adicionar ou Remover
programas.

2 Na caixa de diálogo Adicionar ou remover programas, clique em
Autodesk Navisworks Manage 2012 Exporter Plugins e, a seguir, clique
em Alterar/Remover no Windows XP ou em Desinstalar/Alterar
no Vista/Windows 7.

3 No assistente de instalação clique em Add or Remove Features.

4 Na página Select Exporters to Install , no nó Export From Other
Applications, selecione a caixa de seleção junto ao plugin requerido.

5 Clique em Next.

6 No Autodesk Navisworks Manage 2012página Update Exporter
Plugins (Atualizar plugins do exportador), clique em Next (Avançar).

7 Na página Atualização completada , você é informado que as
atualizações foram executadas. Clique em Concluir.

Para carregar o plugin ARX no aplicativo com base no AutoCAD

1 Digite ARX na linha de comando.

2 Pressione Return.

3 Digite a letra L (para ‘Load’) na linha de comando.

4 Pressione Return.

5 Na caixa de diálogo Select ARX/DBX File , procure pelo plugin ARX.
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OBSERVAÇÃO Para aplicativos com base no AutoCAD 20xx, o plugin está
localizado em C:\Program Files\Common Files\Autodesk Shared\Autodesk
Navisworks\2012\NWExport20xx\nwexport20xx.arx. Portanto, por exemplo,
para aplicativos com base no AutoCAD 2004, o plugin está localizado em
C:\Program Files\Common Files\Autodesk Shared\Autodesk
Navisworks\2012\NWExport2004\nwexport2004.arx, e assim por diante.

6 Clique em OK para carregar o plugin ARX.

Utilizar o plugin ARX

Você pode exportar arquivos de aplicativos com base no AutoCAD a partir da
linha de comando ou ao utilizar o menu do Autodesk Navisworks.

Antes de poder utilizar o menu do Autodesk Navisworks, primeiro é preciso
carregá-lo. Por padrão, o menu do Autodesk Navisworks é adicionado ao
navegador de menus. Em alguns programas ele também pode ser adicionado
na barra de menus.

Para utilizar a linha de comando para exportar arquivos

1 Para exportar um arquivo NWC, digite NWCOUT na linha de comando.

2 Pressione Return.

3 Na caixa de diálogo Save As , insira um novo nome para o arquivo do
Autodesk Navisworks e procure pela localização de armazenamento
desejada.

4 Clique em OK para exportar o arquivo ou em Cancel para retornar para
o aplicativo sem exportar.

Para carregar o menu de exportação do Autodesk Navisworks

1 Na linha de comando, digite MENULOAD.

2 Pressione Return.

3 Na caixa de diálogo Load/Unload Customizations , clique em
Browse.

4 Na caixa de diálogo Select Customization File , altere Files of Type
para Legacy Menu Template (*.mnu), e procure pelo arquivo de
menu do Autodesk Navisworks.
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OBSERVAÇÃO Para aplicativos com base no AutoCAD 20xx, o arquivo está
localizado em C:\Program Files\Common Files\Autodesk Shared\Autodesk
Navisworks\2012\NWExport20xx\lwnw_export.mnu. Portanto, por exemplo,
para aplicativos com base no AutoCAD 2004, este arquivo está localizado
em C:\Program Files\Common Files\Autodesk Shared\Autodesk
Navisworks\2012\NWExport2004\lwnw_export.mnu, e assim por diante.

5 Clique em Open.

6 Na caixa de diálogo Load/Unload Customizations clique em Load.

O menu carregado é mostrado em Loaded Customization Groups.

7 Clique em Close.

Para utilizar o menu do Autodesk Navisworks para exportar arquivos

1 Clique no botão do navegador de menus, localizado no canto superior
esquerdo da janela do aplicativo.

2 Para exportar um arquivo NWC, clique em Autodesk Navisworks
Cache no menu do Autodesk Navisworks.

3 Na caixa de diálogo Save As (Salvar como), insira o nome do arquivo
do Autodesk Navisworks e procure o local de armazenamento desejado.

4 Clique em OK para exportar o arquivo ou em Cancel para retornar para
o aplicativo sem exportar.

Para ajustar as opções para o exportador de arquivo DWG

1 Clique no botão do navegador de menus, localizado no canto superior
esquerdo da janela do aplicativo.

2 Clique em Autodesk Navisworks Export Option (Exportar opção)
no menu do Autodesk Navisworks.

3 Expanda o nó File Exporters no Options Editor, e clique na página
DWG. Utilize as opções neste página para ajustar as configurações para
futuras exportações de arquivos NWC de aplicativos com base no
AutoCAD.

4 Clique em OK para salvar as alterações.

Entrada do comando: NWOPT
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Visualização de CAD

O plugin ARX também permite navegar através de seu modelo em tempo real
dentro de uma janela Navigator encaixável diretamente na interface do
AutoCAD.

Também é fácil importar e exportar pontos de vista entre o Navigator e o
AutoCAD, e explorar os modelos que está desenvolvendo.

OBSERVAÇÃO O Navegador do Autodesk Navisworks é fornecido para produtos
com base no AutoCAD 2004™ e posterior.

Para navegar em modelos do AutoCAD em tempo real

1 Digite NWNAVIGATOR na linha de comando.

2 Utilize a janela Navigator para explorar seu modelo.

Botões

A barra de ferramentas Navigator contém os seguintes botões:

DescriçãoBotão

Sincroniza o modelo na janela Navigator
com o modelo do AutoCAD. A janela
Navigator não é automaticamente
atualizada. Clique neste botão sempre que
desejar navegar em torno do modelo mais
recente.

Altera a vista atual do AutoCAD para a vista
na janela Navigator.

Altera a vista na janela Navigator para a
vista atual do AutoCAD.

Seleciona o modo de navegação e permite
navegar através do modelo em um plano
horizontal.
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DescriçãoBotão

Seleciona o modo de olhar em torno e
permite olhar em torno do modelo a partir
da posição atual da câmera.

Seleciona o modo de zoom. Arrastando o
botão esquerdo do mouse para cima ou
para baixo ou utilizando as teclas Seta para
cima e Seta para baixo, aproxima e afasta
o zoom, respectivamente.

Seleciona o modo de zoom para uma caixa.
Arrastar a caixa com o botão esquerdo do
mouse sobre o modelo preenche a vista
com o conteúdo da caixa. Manter
pressionadas as teclas SHIFT ou CTRL ou
girando a roda do mouse, ativa
temporariamente o modo de zoom.

Seleciona o modo de pan. Arrastar o botão
esquerdo do mouse para efetua o pan do
modelo acima, abaixo, esquerda e direita.
Manter pressionadas as teclas SHIFT ou
CTRL ou girando a roda do mouse, ativa
temporariamente o modo de zoom.

Seleciona o modo de órbita. Arrastar o
botão esquerdo do mouse utilizando as
teclas para cima, para baixo, seta a
esquerda e seta a direita, rotaciona a câmera
em torno do modelo. Manter pressionada
a tecla SHIFT ou girando a roda do mouse,
ativa temporariamente alterna este modo
para o modo de zoom. Manter pressionada
a tecla CTRL ativa temporariamente o pan
da câmera.

Seleciona o modo de examinar. Arrastar o
botão esquerdo do mouse utilizando as
teclas para cima, para baixo, seta a
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DescriçãoBotão

esquerda e seta a direita, rotaciona o
modelo em torno. Manter pressionada a
tecla SHIFT ou girando a roda do mouse,
ativa temporariamente alterna este modo
para o modo de zoom. Manter pressionada
a tecla CTRL, ativa temporariamente alterna
este modo para o modo de pan.

Seleciona o modo de vôo. Manter
pressionado o botão esquerdo do mouse
move a câmera adiante. Com em um
simulador de vôo, o botão esquerdo do
mouse vira na esquerda/direita quando
arrastado para a esquerda ou direita e
inclina acima/abaixo quando arrastado para
cima ou para baixo. Utilize as teclas do
cursor acima e baixo para aproximar ou
afastar o zoom respectivamente; utilize as
teclas do cursor esquerda e direita para girar
a câmera na esquerda e direita
respectivamente. Manter pressionada a tecla
SHIFT acelera este movimento. Manter
pressionada a tecla CTRL rotaciona a câmera
em torno de seu eixo de visualização,
enquanto ainda move adiante.

Seleciona o modo de mesa giratória.
Arrastar o botão esquerdo do mouse para
a esquerda e para a direita ou utilizar as
teclas do cursor para a esquerda e para a
direita gira a mesa giratória para a esquerda
e para a direita respectivamente. Manter
pressionada a tecla SHIFT ou girando a roda
do mouse, ativa temporariamente alterna
este modo para o modo de zoom. Manter
pressionada a tecla CTRL, ativa
temporariamente alterna este modo para o
modo de pan.
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DescriçãoBotão

Mostra todo o modelo. Clicar neste botão
efetua a elevação e pan da câmera para que
todo o modelo seja exibido.

Seleciona a vista da câmera em perspectiva.

Seleciona a vista da câmera ortogonal.

Abre o sistema de ajuda.

O menu de atalho

Clicar com o botão direito do mouse na janela Navigator abre um menu de
atalho.

Focus on Item Foca a câmera no item selecionado. Este ponto se torna o ponto
focal para os modos de navegação examinar, orbitar e mesa giratória.

Speed

Frame Rate Especifica o número de quadros por segundo (FPS) que são
renderizados na janela Navigator.

A configuração padrão é 6. Você pode definir a frequência de quadro de 1 a
20 quadros por segundo. A redução do valor reduz o descarte, mas pode causar
um movimento com sobre-saltos durante a navegação. Aumentar o valor
assegura uma navegação mais suave, mas aumenta o descarte.

Hardware Acceleration Selecione esta opção para utilizar qualquer aceleração
por hardware OpenGL disponível em sua placa de vídeo.

OBSERVAÇÃO Se sua placa de vídeo não suporta a aceleração por hardware
OpenGL, esta opção não está disponível.

Viewpoint

Rendering Seleciona o modo de renderização para seu modelo. Escolha entre:
■ Shaded - renderiza o modelo com sombreamento suave e sem texturas.

Esta é a opção padrão.
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■ Wireframe - renderiza o modelo em estrutura de arame; todas as arestas
triangulares são visíveis neste modo.

■ Hidden Line - renderiza o modelo nas linhas ocultas; isso é equivalente
a renderizar o modelo como sombreado e como estrutura de arame ao
mesmo tempo. A saída tem baixa qualidade e todas as arestas facetadas no
modelo são visíveis.

Lighting Seleciona o modo de iluminação para seu modelo. Escolha entre:
■ No Lights - desativa a iluminação. O modelo é sombreado com uma

renderização plana.

■ Head Light - utiliza uma única luz direcional localizada na câmera que
sempre aponta na mesma direção da câmera. Esta é a opção padrão.

■ Scene Lights - utiliza quaisquer luzes definidas no modelo, ou duas luzes
padrão opostas, caso nenhuma esteja disponível.

Navigation Mode Seleciona o modo de navegação. As opções aqui disponíveis
são as mesmas da barra de ferramentas Navigator, com uma exceção. A opção
Select permite selecionar itens em seu modelo. Múltiplas itens podem ser
selecionados ao manter pressionada a tecla CTRL ao selecionar itens.

Ferramentas de navegação Selecione View All para exibir todo o modelo.

Perspective Camera Seleciona a vista da câmera em perspectiva.

Orthographic Camera Seleciona a vista da câmera ortogonal.

Options

Culling Options Abre a caixa de diálogo Culling Options.

Close Files on Open Indica se o arquivo NWC criado para o modelo é fechado
após ser carregado na memória.

A seleção desta opção desbloqueia os arquivos NWC para edição por outros
usuários.

Max Image Texture Size Especifica o tamanho máximo para imagens de
textura em pixels.

Quanto maior o valor, maior a carga em sua placa gráfica, já que mais MB de
memória é necessário para renderizar texturas.

Utilizar exportadores de arquivos | 213



Exportador de arquivos Revit

O Autodesk Navisworks não pode ler diretamente arquivos nativos do Revit.
Utilize o exportador de arquivos para salvar seus arquivos no formato NWC,
que pode ser aberto no Autodesk Navisworks.

O exportador de arquivos está disponível para o Revit, versões 9.0 até 2012.

Consulte também:

Opções do exportador de arquivos Revit na página 867

Para exportar arquivos NWC do Revit

1 No Revit, clique em Tools ➤ External Tools ➤ Autodesk
Navisworks2012.

OBSERVAÇÃO Esta opção não está disponível no modo Demo/Visualizador.
Se você não estiver no modo de demonstração, mas não tiver acesso ao
menu do Autodesk Navisworks, verifique se a vista de edição está definida
como normal e se a ferramenta de modificação está selecionada ( ➤ Modify).

2 Na caixa de diálogo Export Scene As, insira o nome para o arquivo do
Autodesk Navisworks e procure pela localização de armazenamento
desejada.

3 Clique em Save para exportar o arquivo ou em Cancel para retornar
para o aplicativo sem exportar.

Para ajustar as opções para o exportador de arquivo Revit

1 No Revit, clique em Tools  ➤  External Tools  ➤ Autodesk
Navisworks2012.

2 Na caixa de diálogo Export Scene As, clique no botão do Autodesk
Navisworks Settings.

3 Expanda o nó File Exporters no Options Editor, e clique na página
Revit. Utilize as opções nesta página para ajustar as configurações para
futuras exportações de arquivos NWC do Revit.

4 Clique em OK para salvar alterações e retornar para caixa de diálogo
Export Scene As .

5 Clique em Cancel para fechar a caixa de diálogo.
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Exportador do arquivo do MicroStation

O Autodesk Navisworks é fornecido com plug-ins MDL para o MicroStation™

J, v8 e v8.9, bem como permite exportar arquivos para o formato NWC.

OBSERVAÇÃO Se você instalou o software Autodesk Navisworks com os plug-ins
do exportador e instalou o software MicroStation após instalar o Autodesk
Navisworks, será necessário atualizar os plug-ins do exportador com os plug-ins
ARX apropriados para que possa utilizá-los.

Consulte também:

Opções do exportador de arquivos DGN na página 869

Para adicionar o plugin MDL à instalação dos plugins do exportador do
Autodesk Navisworks

1 No Painel de controle, clique duas vezes em Adicionar ou Remover
programas.

2 Na caixa de diálogo Adicionar ou remover programas, clique em
Autodesk Navisworks Manage 2012 Exporter Plugins e, a seguir, clique
em Alterar/Remover no Windows XP ou em Desinstalar/Alterar
no Vista/Windows 7.

3 No assistente de instalação clique em Add or Remove Features.

4 Na página Select Exporters to Install , no nó Export From Other
Applications, selecione a caixa de seleção junto ao plugin requerido.

5 Clique em Next.

6 No Autodesk Navisworks Manage 2012página Update Exporter
Plugins (Atualizar plugins do exportador), clique em Next (Avançar).

7 Na página Atualização completada , você é informado que as
atualizações foram executadas. Clique em Concluir.

Carregar o plugin MDL

Antes de poder utilizar plugin MDL, primeiro é preciso carregá-lo.

Você pode carregá-lo somente para a sessão atual ou pode adicionar o plugin
em sua configuração padrão, em cujo caso ele é carregado para sessões futuras.
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Para carregar o plugin MDL somente para a sessão atual

1 Clique em Utilities ➤ Key-In.

2 Na caixa de diálogo Key-In, digite mdl load nwexport8.

3 Pressione Return.

Para carregar o plugin MDL para todas as sessões futuras

1 Clique em Workspace ➤ Configuration.

2 Na caixa de diálogo Configuration , campo Category , clique em
Design Applications.

3 Clique em NWEXPORT8 no campo Available Applications
(Dispositivos disponíveis).

4 Clique no botão Add.

5 Clique em OK, e confirme que deseja adicionar o plugin NWEXPORT
MDL em sua configuração padrão.

Exportar arquivos na linha de comando de
digitação

Você pode exportar arquivos individualmente ou em lotes na linha de comando
de digitação.

Também é possível adicionar os comandos no menu Key-In para acelerar o
processo.

Para utilizar a linha de comando de digitação para exportar arquivos

1 Clique em Utilities ➤ Key-In para abrir a caixa de diálogo Key-In.

2 Para exportar um arquivo NWC, digite nwcout.

OBSERVAÇÃO Para exportar rapidamente o arquivo de projeto atual, utilize
o comando batchnwcout. O explorer substitui a extensão do arquivo de
projeto (normalmente .dgn) por .nwc ao exportar o arquivo. Quando você
utiliza este comando, não é instruído a sobrescrever quaisquer arquivos
existentes, e nenhuma caixa de diálogo de exportação é exibida.

3 Na caixa de diálogo Export File do Autodesk Navisworks, procure pela
localização de armazenamento desejada.
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O exportador fornece automaticamente um nome de arquivo, um número
de vista, que podem ser modificados se necessário. O número da vista
escolhido determina a vista de modelo inicial no Autodesk Navisworks.

4 Clique em OK para exportar o arquivo.

Para adicionar comandos de exportação do Autodesk Navisworks no menu
Key-In

1 Clique em Workspace ➤ Customize.

2 Na caixa de diálogo Customize , na guia Menu Bar , expanda a opção
Utilities no campo Edit Menu Bar.

3 Clique na opção Key-In e clique no botão Insert.

4 Na caixa de diálogo Insert Menu Item, insira Label, por exemplo,
“Export Autodesk Navisworks Cache File”.

5 No campo Key-In, insira o comando apropriado, por exemplo, “nwcout”.

6 Clique em OK.

7 Adicione quantos itens de menu for necessário e clique em Save.

As opções adicionadas estão agora disponíveis no menu
Utilities ➤ Key-In.

Exportar arquivos a partir da linha de comando

Você também pode exportar arquivos a partir da linha de comando ao utilizar
arquivo msbatch.bat. Isto é útil quando você deseja definir um script
automatizado para a exportação de arquivo.

OBSERVAÇÃO Para exportar um arquivo a partir da linha de comando, primeiro
é preciso adicionar o diretório do programa MicroStation na variável de ambiente
Path.

O formato da linha de comando do exportador é

msbatch nwexport9 [-f] FILE [OUTPUT]

FILE é o nome do arquivo MicroStation que você deseja exportar. Esta é a
única opção requerida. O argumento OUTPUT permite especificar o nome
do arquivo de saída.

Por padrão, o exportador somente converte arquivos que foram modificados
desde a última vez em que forma exportados. Isto é útil para acelerar a
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exportação de um grande número de arquivos. Se você deseja forçar que o
exportador converta todos os arquivos, utilize a opção -f .

OBSERVAÇÃO Se o exportador encontrar quaisquer problemas, ele produz um
arquivo de registro de erros denominado nwdout.err.

Para modificar a variável de ambiente Path

1 No Control Panel, clique duas vezes em System.

2 Na caixa de diálogo System Properties , guia Advanced , clique no
botão Environment Variables.

3 Na caixa de diálogo Environment Variables , clique duas vezes em
Path sob System Variables.

4 Na caixa de diálogo Edit System Variable , adicione o aplicativo
MicroStation ano campo Variable Value.

OBSERVAÇÃO Os caminhos precisam ser separados por um ponto e vírgula
(;).

5 Clique em OK para salvar as alterações e fechar as caixas de diálogo.

Para utilizar a linha de comando para exportar arquivos

1 No menu Iniciar, clique em Executar no Windows XP ou pressione
Windows + R no teclado no Vista e no Windows 7.

2 Insira o comando de exportação de arquivos com os argumentos
apropriados, por exemplo, msbatch nwexport8 file.

3 Pressione Enter.

4 Na caixa de diálogo MicroStation Manager selecione os arquivos que
deseja exportar, a extensão de arquivo (NWC) e o local de
armazenamento.

5 Clique em OK.

Personalizar as opções do exportador de arquivos
DGN

O exportador de arquivos somente exporta de arquivos DGN 3D - arquivos
2D não são suportados.
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As cores do Autodesk Navisworks são derivadas de cores de células do
MicroStation ou de materiais do MicroStation, dependendo das opções de
exportação escolhidas. A aparência de objetos no Publisher coincidem com
as aparências de uma renderização sombreada do MicroStation.

Para ajustar as opções para o exportador de arquivos DGN

1 Clique em Utilities ➤ Key-In para abrir a caixa de diálogo Key-In.

2 Digite nwopt, e pressione Enter.

3 Expanda o nó File Exporters no Options Editor, e clique na página
DGN. Utilize as opções nesta página para ajustar as configurações para
futuras exportações de arquivos NWC do MicroStation.

4 Clique em OK para salvar as alterações.

Exportador de arquivos Viz e Max

O Autodesk Navisworks não pode ler diretamente arquivos nativos do Viz/Max.
Utilize o exportador de arquivos para salvar seus arquivos no formato NWC,
que pode ser aberto no Autodesk Navisworks.

O exportador de arquivos está disponível para o Viz, versões 2007 e 2008, e
para o Max, versões 8 a 2012.

OBSERVAÇÃO Se você instalou o software Autodesk Navisworks com plugins do
exportador, e instala software Viz ou Max após o Autodesk Navisworks ter sido
instalado, será necessário atualizar seus plugins do exportador com os plugins ARX
apropriados antes de poder utilizá-los.

Consulte também:

Opções do exportador de arquivos Viz e Max na página 872

Para exportar arquivos NWC do Viz ou Max

1 Clique em File ➤ Export.

2 Na caixa de diálogo Select File to Export, selecione Autodesk
Navisworks2012 Cache (*.nwc) no campo Save as Type.

3 Insira um nome para o arquivo do Autodesk Navisworks e procure pela
localização de armazenamento desejada.

4 Clique em Save para exportar o arquivo ou em Cancel para retornar
para o aplicativo sem exportar.
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OBSERVAÇÃO Quaisquer texturas aplicadas no modelo Viz ou Max são
salvas em um diretório com o mesmo nome do arquivo exportados, mas
com um sufixo _presenter_maps. Todas as texturas são convertidas em
arquivos BMP e salvas neste diretório para serem usadas com o Autodesk
Navisworks.

Para adicionar o menu de utilitário do Autodesk Navisworks

1 Clique no botão More no painel Utilities.

2 Na caixa de diálogo Utilities, selecione a opção Autodesk
Navisworks2012 e clique em OK.

Para personalizar as opções do exportador de arquivos 3DS

1 Clique no botão Options Editor no menu do Autodesk Navisworks no
painel Utilities.

2 Expanda o nó File Exporters no Options Editor, e clique na página
VIz/Max. Utilize as opções nesta página para ajustar as configurações
para futuras exportações de arquivos NWC dos aplicativos Viz e Max.

Exportador do arquivo do ArchiCAD

O Autodesk Navisworks não pode ler diretamente arquivos nativos do
ArchiCAD. Utilize o exportador de arquivos para salvar seus arquivos no
formato NWC, que pode ser aberto no Autodesk Navisworks.

O exportador de arquivos está disponível para o ArchiCAD, versão v9 a v13.

A exportação do add-on para o ArchiCAD está disponível nas janelas 2D e 3D.
Todos os elementos padrão e partes da biblioteca do ArchiCAD podem ser
exportados, desde que tenham uma representação 3D, e quaisquer outras são
ignoradas. O exportador de arquivos salva materiais padrão e materiais de
script GDL padrão.

OBSERVAÇÃO Somente as camadas visíveis são exportadas.

As configurações do plano de corte do ArchiCAD não definem o plano de
corte do Autodesk Navisworks. Elas são utilizadas para exportar itens que são
fisicamente reduzidos pelo plano.
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Entidades suportadas

■ Global Unique Identifiers (GUIDs)

■ Parâmetros personalizados para partes da biblioteca definidas por scripts
GDL

■ Storeys

■ Instâncias de partes da biblioteca

■ Câmeras

■ Hotlinks

■ Atributos do sol

■ Materials

Entidades não suportadas

■ Planos de corte

■ Pontos

■ Linhas

■ Texturas

Para exportar da janela 2D

1 Clique em File ➤ Save As.

2 Na caixa de diálogo Save As, selecione Autodesk Navisworks2012
(*.nwc) no campo Save As Type.

3 Insira um nome para o arquivo do Autodesk Navisworks e procure pela
localização de armazenamento desejada.

4 Clique em Save para iniciar o processo de exportação.

5 Na caixa de diálogo Exportar , ajuste as opções do exportador de
arquivos.
■ Export GUIDs - selecione esta caixa de seleção para anexar um

Globally Unique IDentifier como uma propriedade para cada item
do modelo. No Autodesk Navisworks, os GUIDs são utilizados pelo
Clash Detective para rastrear interferências.

■ Enable Library Part Instancing - selecione esta caixa de seleção
para criar instâncias da partes da biblioteca ao invés de criar novos
itens. Isto somente é possível quando múltiplos elementos de partes
da biblioteca dentro do modelo ArchiCAD têm exatamente as mesmas
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propriedades. Colocar estas partes em instâncias significa um arquivo
NWC menor e tempos mais curtos de exportação.

OBSERVAÇÃO Em modelos cortados, quando esta caixa de seleção for
selecionada, todas as instâncias mostram o mesmo corte que o item
original (normalmente, a primeira parte da biblioteca no arquivo). Se
você obtiver alguns efeitos inesperados, desmarque esta caixa de seleção.

■ Export Library Part Parameters - selecione esta caixa de seleção
para salvar os parâmetros de partes da biblioteca (incluindo os
parâmetros personalizados definidos pelo usuário) com propriedades
de item no Autodesk Navisworks.

■ Export Current Story Only - selecione esta caixa de seleção para
somente exportar o "story" atual.

Desmarque esta caixa de seleção para exportar todo o modelo. A
vista-padrão do modelo é determinada da caixa de delimitação do
modelo.

6 Clique em OK.

Para exportar da janela 3D

1 Clique em File ➤ Save As.

2 Na caixa de diálogo Save As, selecione Autodesk Navisworks2012
(*.nwc) no campo Save As Type.

3 Insira um nome para o arquivo do Autodesk Navisworks e procure pela
localização de armazenamento desejada.

4 Clique em Save para iniciar o processo de exportação.

5 Na caixa de diálogo Exportar , ajuste as opções do exportador de
arquivos.
■ Export GUIDs - selecione esta caixa de seleção para anexar um

Globally Unique IDentifier como uma propriedade para cada item
do modelo. No Autodesk Navisworks, os GUIDs são utilizados pelo
Clash Detective para rastrear interferências.

■ Enable Library Part Instancing - selecione esta caixa de seleção
para criar instâncias da partes da biblioteca ao invés de criar novos
itens. Isto somente é possível quando múltiplos elementos de partes
da biblioteca dentro do modelo ArchiCAD têm exatamente as mesmas
propriedades. Colocar estas partes em instâncias significa um arquivo
NWC menor e tempos mais curtos de exportação.
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OBSERVAÇÃO Em modelos cortados, quando esta caixa de seleção for
selecionada, todas as instâncias mostram o mesmo corte que o item
original (normalmente, a primeira parte da biblioteca no arquivo). Se
você obtiver alguns efeitos inesperados, desmarque esta caixa de seleção.

■ Export Library Part Parameters - selecione esta caixa de seleção
para salvar os parâmetros de partes da biblioteca (incluindo os
parâmetros personalizados definidos pelo usuário) com propriedades
de item no Autodesk Navisworks.

■ Export Current Story Only - esta opção não é utilizada; tudo
contido na vista é exportado.

Ao salvar da janela 3D, a vista se torna a vista padrão do Autodesk
Navisworks (incluindo as configurações da janela, como os planos
de corte).

6 Clique em OK.

Gerenciar arquivos

Abrir arquivos

Para abrir arquivos no Autodesk Navisworks, você pode utilizar uma caixa de
diálogo padrão Open ou arrastar e soltar os arquivos diretamente na janela
Selection Tree.

OBSERVAÇÃO Se o arquivo escolhido for um arquivo CAD ou de digitalização a
laser, o Autodesk Navisworks utilizará automaticamente um leitor de arquivo
apropriado para abrir o arquivo, desde que este formato de arquivo seja suportado.

O Autodesk Navisworks mantém uma lista dos arquivos abertos recentemente
(por padrão, até 4 arquivos são mostrados). É possível abrir qualquer um destes

arquivos clicando no botão do aplicativo  . Se deseja alterar o tamanho
desta lista, utilize Options Editor (nó General ➤ , página Environment).

Você pode utilizar as teclas Shift e Ctrl para abrir diversos arquivos ao mesmo
tempo. Isso cria automaticamente um novo arquivo “Untitled” do Autodesk
Navisworks com os arquivos anexados selecionados juntos.

Para arquivos NWD, é possível publicá-los em um servidor da Web, e a seguir
abrir os arquivos diretamente do Autodesk Navisworks. Você pode começar a
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navegar no modelo, mesmo antes de todo o arquivo ter sido baixado. Para tal,
10 - 50% costuma ser suficiente. Quanto maior a hierarquia do modelo, mais
perto de 50% de download é necessário. De forma similar, quanto menor a
estrutura de hierarquia do modelo, mais cedo é possível iniciar a navegação.

OBSERVAÇÃO Arquivos criptografados DWF, como arquivos com senha e arquivos
protegidos contra impressão/medição não são suportados.

Para abrir um arquivo

1 Clique no botão do aplicativo  ➤  Open  ➤ Open  .

2 Na caixa de diálogo Open , utilize a caixa Files of Type , para selecionar
o tipo de arquivo apropriado, e navegue para a pasta onde está localizado
seu arquivo.

3 Selecione o arquivo e clique em Open.

Barra de ferramentas: Classic user interface: Standard ➤ Open
Entrada do comando: Ctrl+O

Para abrir arquivos NWD localizados em um servidor da web

1 Clique no botão do aplicativo  ➤ Open ➤ Open URL  .

2 Insira o endereço do arquivo e clique em OK.

Criar arquivos

Ao iniciar o Autodesk Navisworks, um novo arquivo “Untitled” do Autodesk
Navisworks é criado automaticamente. O novo arquivo utiliza as configurações
padrão definidas no Options Editor, e na caixa de diálogo File Options.
Você pode personalizar estas configurações, se necessário.

Se um arquivo do Autodesk Navisworks já estiver aberto e desejar fechá-lo
para criar outro arquivo, clique em New  na barra de ferramentas Quick
Access.

Barra de ferramentas: Classic user interface: Standard ➤ New
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Salvar e renomear arquivos

Quando você salva um arquivo do Autodesk Navisworks, pode escolher entre
os formatos de arquivo NWD e NWF.

Como regra geral, utilize o formato de arquivo NWF para salvar a cena criada
ao juntar todos os arquivos de modelo, e o formato de arquivo NWD quando
simplesmente deseja ter um instantâneo de seu trabalho atual.

Ambos os formatos armazenam as marcações de revisão, mas o arquivo NWD
armazena a geometria do arquivo, enquanto o arquivo NWF armazena os
vínculos para os arquivos originais. Isto torna os arquivos NWF
consideravelmente menores em tamanho. Também, quando você abre um
arquivo NWF, o Autodesk Navisworks recarrega automaticamente todos os
arquivos referenciados modificados, o que significa que a geometria está sempre
atualizada, até mesmo para os modelos mais complexos.

De outra forma, quando você precisa compartilhar sua cena e marcações de
revisão com outras pessoas, é melhor distribuir um arquivo NWD publicado,
que inclui recursos adicionais como a proteção por senha e a data de expiração
do arquivo. Os arquivos publicados podem ser visualizados no Autodesk
Navisworks Manage 2012 e no Autodesk Navisworks Freedom 2012 (um
visualizador gratuito).

IMPORTANTE Quando você publica um arquivo NWD, não poderá incluir
quaisquer RPCs adicionados em sua cena.

Para salvar um arquivo

1 Clique em Save  na barra de ferramentas Quick Access. Se seu arquivo
foi anteriormente salvo, o Autodesk Navisworks sobrescreve o arquivo
com os novos dados.

2 Se seu arquivo não foi anteriormente salvo, a caixa de diálogo Save As
é aberta.
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Insira o nome do arquivo, utilize a caixa de diálogo Files of Type para
selecionar um dos formatos nativos do Autodesk Navisworks (NWF ou
NWD), selecione a localização para o arquivo, e clique em Save.

DICA Caso necessite abrir seu arquivo com uma versão anterior do Autodesk
Navisworks, salve-o como aquele tipo de versão.

Barra de ferramentas: Classic user interface: Standard ➤ Save
Entrada do comando: Ctrl+S

Para renomear um arquivo

1 Clique no botão do aplicativo  ➤ Save As  .

2 Na caixa de diálogo Save As, insira o novo nome para seu arquivo.
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3 Clique em Save.

Para publicar um arquivo NWD

1 Abra o arquivo que deseja publicar (NWD ou NWF).

2 Clique no botão do aplicativo  ➤ Publish  .

3 Utilize a caixa de diálogo Publish para inserir as informações do
documento, e para especificar a proteção de documento requerida. As
caixas de textos nesta caixa de diálogo guardam um histórico de até cinco
das últimas entradas. Clicar na seta para baixo no lado mais à direita da
caixa de texto permite selecionar uma entrada ao invés de redigitá-la.
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4 Clique em OK.

5 Na caixa de diálogo Save As , insira o nome do arquivo e especifique a
localização.

6 Clique em Save. Seu arquivo agora está publicado.

Faixa de opções:  Guia Output painel  ➤ Publish ➤ NWD

Barra de ferramentas: Classic user interface: Standard ➤ Publish

Arquivos de múltiplas folhas e 2D

Agora é possível trabalhar com arquivos 2D e arquivos contendo múltiplos
modelos ou folhas.

Enquanto modelos multidisciplinares fornecem uma aparência real de como
um projeto acabado ficaria, diversos interessados no projeto e profissionais
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de campo estão mais familiarizados com plantas e elevações 2D. O Autodesk
Navisworks Manage 2012 suporta arquivos de múltiplas folhas e 2D que podem
ser revisados ou combinados com modelos para fornecer múltiplas
representações de dados do projeto.

Os formatos de arquivo de múltiplas folhas e 2D suportados são: DWF, DWF(x)
e formatos de arquivo nativos (NWD ou NWF).

Quando você abre um arquivo suportado, que contém múltiplas
folhas/modelos, a folha/modelo padrão é exibida em Scene View e todas as
folhas/modelos do arquivo são listadas na janela Project Browser. Se o
arquivo contém modelos 3D e folhas 2D, o modelo 3D é carregado e exibido
em Scene View por padrão. Se não precisar de recursos 2D, apenas feche a
janela Project Browser e continue trabalhando em um espaço de trabalho
3D.

Adicionar folhas/modelos ao arquivo aberto
atualmente

É possível adicionar folhas 2D e modelos 3D de arquivos DWF, DWF(x), NWD
ou NWF ao arquivo aberto no momento no Autodesk Navisworks.

É possível selecionar um arquivo de origem em formato DWF, DWF(x), NWD
ou NWF, adicionar todos os seus modelos/folhas ao arquivo que está aberto
atualmente, excluir na página 232 todos os modelos/folhas não desejados e, a
seguir, salvar a coleção de múltiplas folhas em um formato de arquivo NWD
ou NWF nativo.

Para adicionar folhas/modelos ao arquivo aberto atualmente

1 Clique no botão do aplicativo  ➤ Import ➤ Sheets and Models

 .

2 Na caixa de diálogo Insert From File, utilize a caixa Files of Type
para selecionar o tipo de arquivo apropriado e navegue para a pasta onde
está localizado seu arquivo.

3 Selecione o arquivo e clique em Open. Todos os modelos/as folhas nos
arquivos selecionados são adicionados à lista na janela Project Browser,
na ordem em que foram listados no arquivo original.
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Janela do navegador de projeto

O Project Browser é uma janela encaixável que lista todos os modelos/folhas
no arquivo aberto atualmente.

A paleta Sheets/Models lista todas as folhas e os modelos no arquivo de
múltiplas folhas. A legenda na parte superior da paleta indica o arquivo aberto
no momento no Autodesk Navisworks. As folhas ou os modelos podem ser
representados como uma visualização de lista ou uma visualização de
miniaturas. Por padrão, a ordem de exibição é a mesma do arquivo original.
O modelo/folha selecionado no momento é indicado com um plano de fundo
sombreado e o modelo/folha aberto atualmente na Scene View é indicado
em preto com uma borda gráfica preta. Quando você abre um arquivo de
múltiplas folhas, nem todos os modelos/folhas podem ter sido preparados
para serem utilizados no Autodesk Navisworks. Os modelos/folhas que
requerem preparação são indicados com o ícone Prepare  .

É possível selecionar vários modelos/folhas ao mesmo tempo com as teclas
SHIFT e CTRL, mas não é possível abrir mais de um modelo/folha na Scene
View.

A paleta Properties é utilizada para examinar as propriedades do modelo/folha
selecionado na paleta Sheets/Models. Você também pode visualizar as
propriedades do arquivo aberto atualmente ao clicar em seu nome. As
propriedades são agrupadas por categoria, são de somente leitura e podem ser
expandidas/retraídas.
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OBSERVAÇÃO  Se mais de uma folha ou um modelo estiver selecionado, a paleta
Properties somente mostra o número de itens selecionados e não mostra
nenhuma informação da propriedade.

Para alternar a janela do navegador de projeto

■ Clique na guia View painel  ➤ Workspace menu suspenso  ➤ Windows
e selecione ou desmarque a caixa de seleção Project Browser.

Dispositivo apontador: Barra de status  ➤ Project Browser

Para visualizar folhas/modelos como uma lista

■ Clique no botão List View  situado no canto superior direito da janela
Project Browser.

Para visualizar modelos/folhas como miniaturas

■ Clique no botão Thumbnail View  no canto superior direito da janela
Project Browser.

Para examinar propriedades da falha/do modelo

1 Abra um arquivo de múltiplas folhas.

2 Clique na folha 2D ou no modelo 3D no Project Browser. A paleta
Properties mostra as informações disponíveis.

OBSERVAÇÃO Se mais de uma folha/um modelo for selecionado, a paleta
Properties somente mostra o número de folhas/modelos selecionados e
não mostra nenhuma informação da propriedade.

Para abrir uma folha ou um modelo na Scene View

1 Abra a janela Project Browser.

2 Clique duas vezes na folha ou no modelo que deseja abrir.

DICA Você também pode usar os controles de navegação de múltiplas folhas na
barra de status para abrir as folhas/os modelos rapidamente.

Para renomear um modelo/uma folha

1 Abra a janela Project Browser.
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2 Clique com o botão direito do mouse na folha ou no modelo desejado
e clique em Rename.

3 Insira um novo nome para seu modelo ou sua folha e pressione ENTER.

Entrada do comando: F2

Para excluir um modelo/folha

1 Abra a janela Project Browser.

2 Clique com o botão direito do mouse no modelo ou na folha que deseja
remover e clique em Delete. Se você cometer um erro, é possível usar o
comando Undo.

Para preparar uma folha/um modelo para uso

1 Abra a janela Project Browser.

2 Clique com o botão direito do mouse na folha ou no modelo que deseja
preparar e clique em Prepare Sheet/Model no menu de atalho.

Para preparar todos os modelos/folhas para uso

1 Abra a janela Project Browser.

2 Clique com o botão direito do mouse na folha ou no modelo que deseja
preparar e clique em Prepare All Sheets/Models no menu de atalho.

Para imprimir uma folha ou um modelo

OBSERVAÇÃO Somente é possível imprimir o ponto de vista atual.

1 Abra a janela Project Browser.

2 Clique duas vezes na folha ou no modelo que deseja imprimir para
torná-lo atual (isto é, aberto na Scene View).

3 Clique na guia Output painel  ➤ Print ➤ Print  .

4 Verifique as configurações necessárias da impressora e clique em OK.

OBSERVAÇÃO O tamanho máximo da imagem é de 2048x2048 pixels.

O botão Properties controla as configurações de tinta e papel específicas
da impressora.
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Menu de atalho da paleta de folhas/modelos

Abrir Abre a folha/o modelo selecionado na Scene View.

Delete Exclui a folha ou o modelo selecionado na lista. Não é possível excluir
a folha ou o modelo aberto no momento.

Merge into Current Sheet Mescla a folha 2D selecionada na lista com a folha
aberta no momento na Scene View. É possível mesclar uma folha com ela
mesma.

Merge into Current Model Mescla o modelo 3D selecionado na lista com o
modelo aberto no momento na Scene View.. É possível mesclar o modelo
com ele mesmo.

Append to Current Sheet Anexa a folha 2D selecionada na lista à folha no
aberta momento na Scene View. É possível anexar a folha a ela mesma.

Append to Current Model Anexa o modelo 3D selecionado na lista ao modelo
aberto no momento na Scene View. É possível anexar o modelo a ele mesmo.

Prepare Sheet/Model Prepara todos os modelos/folhas selecionados na lista
para uso no Autodesk Navisworks. Para selecionar múltiplos modelos/folhas,
utilize as teclas SHIFT e CTRL. Se os modelos/folhas estiverem prontos, esta
opção não estará disponível.

Prepare All Sheets/Models Prepara todoa os modelos/folhas selecionados no
arquivo de múltiplas folhas para uso no Autodesk Navisworks. Se os
modelos/folhas estiverem prontos para uso, esta opção não estará disponível.

Imprimir Imprime a folha ou o modelo aberto atualmente na Scene View.

Rename Renomeia a folha ou o modelo selecionado na lista. Por padrão, os
nomes de folhas/modelos são os mesmos do arquivo de origem.

Botões

Thumbnail View Exibe folhas/modelos como imagens em miniatura na
paleta Sheets/Models.

List View Exibe folhas/modelos como itens da lista na paleta Sheets/Models.

Import Sheets & Models Adiciona folhas/modelos de arquivos externos
ao arquivo aberto atualmente no Autodesk Navisworks. Todos os
modelos/folhas nos arquivos selecionados são adicionados à lista na paleta
Sheets/Models, na ordem em que foram listados no arquivo original.
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Trabalhar com arquivos de múltiplas folhas e 2D

Cada folha e modelo no Project Browser tem sua própria representação
integrada dentro do Autodesk Navisworks, que permite revisar e trabalhar com
cada folha/modelo como se fosse um arquivo separado.

Cada folha e modelo tem sua própria hierarquia de conteúdo, representada
na Selection Tree, que é automaticamente atualizada para refletir a
folha/modelo atualmente aberto na Scene View.

Ao rever as folhas/modelos do Project Browser, é possível:
■ Pesquisar na página 374 e selecionar na página 365 objetos dentro da vista

de cena atual.

Itens em uma folha 2D permanecem como objetos inteligentes, permitindo
que você os selecione para revisão ou manipulação.

■ Revise as propriedades na página 392 do objeto.

Os itens em um arquivo DWF 2D exportados do software Autodesk Revit,
por exemplo, conterão propriedades similares ao modelo 3D
correspondente. Isso permite pesquisar itens com base nas propriedades e
também é essencial para a associação 2D-3D e a vinculação de itens entre
essas representações. Consulte Localizar todas as folhas e os modelos que
contêm o objeto selecionado na página 381.

■ Aplicar transformações e substituir aparências do objeto na página 409.

Os objetos selecionados podem ser manipulados, por exemplo, é possível
alterar sua cor ou posição.

■ Adicionar links na página 456

É possível adicionar links que apontam para diversas origens de dados,
como os detalhes do fabricante, manuais do equipamento ou especificações.

■ Salvar pontos de vista na página 472

É possível criar e gerenciar diferentes vistas de suas folhas (ou modelos)
para que seja possível pular para pontos de vista predefinidos sem ter que
navegar a cada vez para alcançar um item.

■ Adicionar marcações de revisão na página 431.

É possível marcar pontos de vista com linhas de marcação ou adicionar
comentários.

■ Tome medidas na página 418 e capture-as como cotas interativas na página
427.

As medidas podem ser obtidas entre pontos em uma folha/modelo. O snap
ao objeto também é ativado, tornando mais fácil efetuar medições precisas.
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Adicionar geometria e metadados ao modelo/folha
atual

É possível anexar e mesclar folhas/modelos individuais dentro do mesmo
arquivo de múltiplas folhas. Qualquer geometria ou nota de revisão duplicada
é removida quando as folhas ou os modelos são mesclados.

Para arquivos de múltiplas folhas, é possível colocar a geometria e os dados
das origens internas do projeto, isto é, as folhas 2D ou os modelos 3D listados
no Project Browser, na folha ou no modelo que está aberto no momento.
No entanto, os modelos 3D só podem ser mesclados/anexados a outros modelos
3D, e modelos 2D só podem ser mesclados/anexados a outras folhas 2D.

Para anexar folhas 2D em um arquivo de múltiplas folhas

1 Abra um arquivo de múltiplas folhas.

2 Se a janela Project Browser não for exibida, clique em  na barra de
status.

3 Clique duas vezes em uma folha 2D do Project Browser para abri-la
na Scene View.

4 Utilize o Project Browser para selecionar todas as folhas 2D que você
deseja anexar à folha no momento.

DICA Para selecionar múltiplas folhas, utilize as teclas SHIFT e CTRL.

5 Clique com o botão direito do mouse na seleção e, a seguir, clique em
Append to Current Sheet.

OBSERVAÇÃO O comando Undo não está disponível.

Para anexar modelos 3D a um arquivo de múltiplas folhas

1 Abra um arquivo de múltiplas folhas.

2 Se a janela Project Browser não for exibida, clique em  na barra de
status.

3 Clique duas vezes no modelo 3D do Project Browser para abri-lo na
Scene View.

4 Utilize o Project Browser para selecionar todos os modelos 3D que
deseja anexar ao modelo aberto no momento.

DICA Para selecionar múltiplos modelos, utilize as teclas SHIFT e CTRL.
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5 Clique com o botão direito do mouse na seleção e, a seguir, clique em
Append to Current Model.

OBSERVAÇÃO O comando Undo não está disponível.

Para mesclar folhas 2D em um arquivo de múltiplas folhas

1 Abra um arquivo de múltiplas folhas.

2 Se a janela Project Browser não for exibida, clique em  na barra de
status.

3 Clique duas vezes em uma folha 2D do Project Browser para abri-la
na Scene View.

4 Utilize o Project Browser para selecionar todas as folhas 2D que deseja
mesclar à folha aberta atualmente.

DICA Para selecionar múltiplas folhas, utilize as teclas SHIFT e CTRL.

5 Clique com o botão direito do mouse na seleção e, a seguir, clique em
Merge to Current Sheet. Qualquer geometria duplicada e nota de
revisão é removida automaticamente.

OBSERVAÇÃO O comando Undo não está disponível.

Para mesclar modelos 3D em um arquivo de múltiplas folhas

1 Abra um arquivo de múltiplas folhas.

2 Se a janela Project Browser não for exibida, clique em  na barra de
status.

3 Clique duas vezes no modelo 3D do Project Browser para abri-lo na
Scene View.

4 Utilize o Project Browser para selecionar todos os modelos 3D que
deseja mesclar ao modelo aberto no momento.

DICA Para selecionar múltiplos modelos, utilize as teclas SHIFT e CTRL.

5 Clique com o botão direito do mouse na seleção e, a seguir, clique em
Merge to Current Model.

OBSERVAÇÃO O comando Undo não está disponível.
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Conjuntos de dados complexos

É possível utilizar o Autodesk Navisworks para combinar arquivos de projeto
juntos em conjuntos de dados complexos.

O Autodesk Navisworks permite combinar arquivos de projeto juntos utilizando
geometria e metadados de arquivos externos suportados na cena atual. O
Autodesk Navisworks alinha automaticamente a rotação e a origem dos
modelos e redimensiona as unidades em cada arquivo anexado para coincidir
com as unidades de exibição  na página 169. Se a rotação, origem ou unidades
do arquivo estão incorretas para a cena, é possível ajustá-las manualmente
para cada um dos arquivos incorporados.

Para arquivos de múltiplas folhas, é possível também utilizar a geometria e os
dados das origens internas do projeto, isto é, as folhas 2D ou os modelos 3D
listados no Project Browser, na folha ou no modelo que está aberto no
momento. Consulte Adicionar geometria e metadados ao modelo/folha atual
na página 235.

Anexar geometria e metadados à cena atual

É possível adicionar a geometria e os dados dos arquivos selecionados ao
modelo 3D ou à folha 2D atual.

OBSERVAÇÃO Caso tente arrastar e soltar arquivos diretamente na janela
Selection Tree ou utilizar a caixa de diálogo Open, você irá criar um novo arquivo
do Autodesk Navisworks, em vez disso.

Para anexar arquivos

1 Clique na guia Home ➤ painel Project ➤ Append  .

2 Na caixa de diálogo Append , utilize a caixa Files of Type , para
selecionar o tipo de arquivo apropriado, e navegue para a pasta onde os
arquivos que deseja adicionar estão localizados.

3 Selecione os arquivos requeridos e clique em Open.

DICA Para selecionar múltiplos arquivos utilize as teclas Shift e Ctrl.

Entrada do comando: Ctrl+A

Barra de ferramentas: Classic user interface: Standard ➤ Append
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Excluir arquivos

Você pode excluir arquivos anexados a seu arquivo do Autodesk Navisworks.

OBSERVAÇÃO Você não pode excluir quaisquer arquivos de um arquivo NWD
publicado ou salvo. Para excluir arquivos, use o formato de arquivo NWF.

Em arquivos de múltiplas folhas, é possível excluir na página 232 todos os
modelos/folhas indesejados.

Para excluir um arquivo

1 Abra um arquivo do Autodesk Navisworks.

2 Clique com o botão direito do mouse no arquivo que deseja excluir da
Selection Tree.

3 Clique em Delete.

4 Clique em Yes para confirma seu comando.

OBSERVAÇÃO O comando Undo não está disponível, portanto, caso cometa
um erro, será necessário anexar de volta manualmente seu arquivo.

Menu: Classic user interface: File ➤ Delete

Ajustar as unidades e a transformação

É possível alterar as unidades e modificar a rotação, a origem e a escala de cada
modelo 3D ou folha 2D anexados.

Recomenda-se ajustar primeiro as unidades, antes de tentar corrigir os
problemas com o alinhamento do modelo ou da folha.

Para alterar unidades em um arquivo 3D carregado

1 Clique com o botão direito no arquivo 3D desejado na Selection Tree
e clique em Units and Transform no menu de atalho.

2 Na caixa de diálogo Units and Transform, selecione o formato
requerido na lista suspensa Units.
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3 Clique em OK.

Para alterar unidades em uma folha 2D carregada

1 Clique com o botão direito do mouse na folha 2D desejada na Scene
View, e clique em Units and Transform no menu de atalho.

2 Na caixa de diálogo Units and Transform, selecione o formato
requerido na lista suspensa Units.

3 Clique em OK.

Para alterar uma transformação em um arquivo 3D carregado

1 Clique com o botão direito no arquivo 3D desejado na Selection Tree
e clique em Units and Transform no menu de atalho.

2 Para mover a localização do modelo, na caixa de diálogo Units and
Transform, na área Origin, insira valores para os eixos X, Y e Z.

Caso você utiliza uma escala negativa, selecione a caixa de seleção
Reflected Transform.

3 Para alterar a rotação do modelo, na caixa de diálogo Units and
Transform, na área Rotation, insira um ângulo de rotação e selecione
o eixo em torno do qual deseja rotacionar (digitando um valor maior do
que 0). Isto irá rotacionar o modelo em torno de seu ponto de origem.
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4 Para alterar a escala do modelo, na caixa de diálogo Units and
Transform, na área Scale, insira valores para os eixos X, Y e Z. Para
alterar a escala proporcionalmente de um objeto, assegure que os valores
de X, Y e Z sejam iguais.

A inserção de uma valor negativo vira o modelo de dentro para fora.

5 Clique em OK.

Para alterar uma transformação em uma folha 2D carregada

1 Clique com o botão direito do mouse na folha 2D desejada na Scene
View, e clique em Units and Transform no menu de atalho.

2 Para mover a localização da folha, na caixa de diálogo Units and
Transform, na área Origin, insira os valores para os eixos X e Y.

3 Para alterar a rotação da folha, na caixa de diálogo Units and
Transform, na área Rotation, insira um ângulo de rotação. Isso irá
rotacionar a folha em torno de seu ponto de origem.

4 Para alterar a escala da folha, na caixa de diálogo Units and Transform,
na área Scale, insira os valores para os eixos X e Y. Para alterar
proporcionalmente a escala de uma folha, assegure-se de que os valores
de X e Y são iguais.

5 Clique em OK.
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Atualizar arquivos

Ao trabalhar no Autodesk Navisworks, é possível que outras pessoas estejam
trabalhando nos arquivos de CAD que você está revisando no momento. Por
exemplo, se você estiver coordenando diversas disciplinas em um projeto,
então poderá ter um arquivo NWF referenciando diversos arquivos de projeto.
Durante os estágios interativos do projeto, qualquer membro da equipe de
projeto poderia potencialmente estar modificando seus arquivos de CAD.

Para assegurar que os dados que você está revisando sejam atuais, o Autodesk
Navisworks fornece uma função de atualização para reabrir os arquivos que
foram modificados no disco desde o início da sessão de revisão.

Para atualizar arquivos no momento abertos

1 Clique em Refresh  na barra de ferramentas Quick Access.

Barra de ferramentas: Interface de usuário Classic:

Standard ➤ Refresh

Mesclar arquivos

O Autodesk Navisworks é uma solução de colaboração e, embora os usuários
possam estar revendo o modelo de diversas formas, os seus arquivos resultantes
podem ser mesclados em um único arquivo do Autodesk Navisworks, com
qualquer geometria e marcação duplicada automaticamente removida.

Ao mesclar múltiplos arquivos NWF, cada um compreendendo os mesmos
arquivos referenciados, o Autodesk Navisworks somente carrega um único
conjunto de modelos combinados, junto com todas as marcações de revisão
(como identificadores, pontos de vista ou comentários) de cada arquivo NWF.
Qualquer geometria ou marcação duplicada é removida ao mesclar.

Para arquivos de múltiplas folhas, é possível também mesclar a geometria e
os dados de origens internas do projeto, isto é, as folhas 2D ou os modelos 3D
listados no Project Browser, na folha ou no modelo que está aberto no
momento. Consulte Adicionar geometria e metadados ao modelo/folha atual
na página 235.
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Mesclar dados do TimeLiner

Para arquivos que contêm dados do TimeLiner, a mescla é feita com segue:

■ se dois conjuntos de dados do TimeLiner são idênticos, todos os dados
duplicados são removidos.

■ se dois conjuntos de dados do TimeLiner contêm o mesmo link Primary,
então o conjunto de dados com o link mais recente (ou seja, a data de
arquivo mais recente) é escolhido em detrimento do outro. se os links
Primary são diferentes, então o conjunto de dados com o maior número
de tarefas será utilizado, e os links são reanexados sempre que for possível.

■ se dois conjuntos de dados do TimeLiner são completamente não
relacionados, nenhuma mescla de dados é executada.

Para mesclar arquivos

1 Clique emNew  na barra de ferramentas Quick Access.

2 Abra o primeiro dos arquivos com a marcação de revisão.

3 Clique na guia Home painel  ➤ Project ➤ Merge  .

4 Na caixa de diálogo Merge , utilize a caixa Files of Type , para
selecionar o tipo de arquivo apropriado (NWD ou NWF), e navegue para
a pasta onde seus arquivos que deseja mesclar estão localizados.

5 Selecione os arquivos requeridos e clique em Open.

DICA Para selecionar múltiplos arquivos utilize as teclas Shift e Ctrl.

Entrada do comando: Ctrl+M

Barra de ferramentas: Classic user interface: Standard ➤ Merge

Enviar arquivos por e-mail

Você pode enviar e receber por e-mail arquivos do Autodesk Navisworks.

Para enviar um arquivo aberto do Autodesk Navisworks, clique no botão do

aplicativo  ➤ Send by Email  .

O Autodesk Navisworks primeiro salva seu arquivo, a seguir, abre o software
de e-mail disponível e anexa seu arquivo em uma mensagem de e-mail em
branco.
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É possível enviar arquivos NWD e NWF, embota o tamanho de um arquivo
NWD será consideravelmente maior.

Faixa de opções:  Guia Output ➤ painel Send ➤ Send by Email

Barra de ferramentas: Standard ➤ Send by Email

Receber arquivos

Para abrir um arquivo recebido, salve o anexo em seu disco, e a seguir clique
duas vezes no mesmo.

Se for um arquivo NWF, o Autodesk Navisworks pesquisa primeiro pelos
arquivos referenciados utilizando o caminho absoluto com o qual o remetente
originalmente salvou o arquivo. Isto é útil se a equipe está em uma rede de
área local e os arquivos podem ser encontrados utilizando a Universal Naming
Convention (UNC).

DICA Uma equipe que não estiver compartilhando um servidor pode organizar
o projeto utilizando a mesma hierarquia de arquivos e a mesma letra da unidade,
e o Autodesk Navisworks poderá encontrar os arquivos dessa forma.

Se o Autodesk Navisworks for incapaz de encontrar os arquivos referenciados,
então será necessário salvar o arquivo NWF anexado em um diretório onde
todos os arquivos referenciados estão localizados. O Autodesk Navisworks
pode, então, pesquisar os arquivos relativos à localização do NWF mestre.

DICA Você pode utilizar o mesmo método para mover todo um subdiretório de
seu diretório de projetos para uma localização completamente nova. Salve o
arquivo NWF mestre nesse novo lugar e o Autodesk Navisworks será capaz de
procurar os arquivos referenciados nesse lugar.

Batch Utility

Você agora pode usar o Batch Utility para automatizar processos comuns de
importação/conversão de arquivo.

O Batch Utility é integrado com o Windows Task Scheduler para permitir
definir tarefas a serem automaticamente executadas em hora e intervalos
definidos.
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Usar o Batch Utility

Você agora pode usar o Batch Utility para executar e agendar os seguintes
comandos:
■ Criar uma lista de todos os arquivos do projeto no arquivo do Autodesk

Navisworks no momento aberto.

■ Anexar múltiplos arquivos de projeto em um único arquivo NWD ou NWF.

■ Converter múltiplos arquivos de projeto em arquivos NWD individuais.

IMPORTANTE Você pode usar qualquer um dos formatos de arquivo no momento
suportados, ao anexar ou converter arquivos com o Batch Utility. No entanto, se
você usa qualquer arquivo NWD publicado como entrada, ele precisa ter sido
criado com a opção Pode ser novamente salvo selecionada, caso contrário,
ao executar o Batch Utility, nenhum arquivo de saída NWD será salvo. Ainda é
possível criar um arquivo de saída NWF.

Todos os eventos serão gravados em um arquivo de registro.

Para gerar uma lista de todos os arquivos do projeto usados no modelo atual

1 No aplicativo Autodesk Navisworks, abra o arquivo do Autodesk
Navisworks desejado e clique na guia Home ➤ painel Tools ➤ Batch
Utility  .

2 A caixa de diálogo Autodesk Navisworksdo Autodesk Navisworks é
exibida, e o caminho para o modelo atual é automaticamente adicionado
à área Input da caixa de diálogo.

3 Na área Output , na guia As Single File , clique no botão Browse .

4 Na caixa de diálogo Save Output As, procure pela pasta desejada e
insira um nome para o arquivo de texto.

5 Na lista suspensa Save as Type, selecione a opção File List (*.txt) , e
clique em Save.
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6 Na caixa de diálogo Autodesk NavisworksAutodesk Navisworks, clique
no botão Run Command.

DICA Se você deseja abrir automaticamente o arquivo assim que for criado,
selecione a caixa de seleção View File on Output , antes de clicar no botão
Run Command.

Para anexar múltiplos arquivos de projeto a um único arquivo do Autodesk
Navisworks

1 No aplicativo Autodesk Navisworks, clique na guia Home ➤ painel
Tools ➤ Batch Utility  .
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2 No Autodesk Navisworks, na caixa de diálogo Batch Utility, use a
área Input para criar uma lista de arquivos de projeto para conversão:
■ Selecione a unidade e a pasta onde estão localizados os arquivos de

projeto. Uma vez selecionada a localização desejada, use o menu File
Type abaixo, para filtrar os arquivos de projeto que são exibidos na
direita. O menu contém uma lista de todos os formatos de arquivo
no momento suportados.

■ Há dois métodos que podem ser usados para escolher arquivos para
conversão. Você pode clicar duas vezes para adicioná-los à lista de
conversão.

Alternativamente, clique no botão Add File Spec . Isso fará com
que o Autodesk Navisworks converta os arquivos localizados na pasta
selecionada. A opção escolhida no menu File Type, determina quais
arquivos são convertidos.

3 Na área Output , na guia As Single File , clique no botão Browse .

4 Na caixa de diálogo Save Output As, procure pela pasta desejada e
insira um nome para o novo arquivo.

5 Na lista suspensa Save as Type, selecione o formato de arquivo exigido
(NWD ou NWF) e clique em Save.

6 Se você deseja abrir automaticamente o arquivo assim que for criado,
selecione a caixa de seleção View File on Output.

7 Selecione o botão Increment Output File Names se desejar anexar
um número de quatro dígitos no fim do nome do arquivo. Por padrão,
os arquivos de saída antigos são sobrescritos.
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8 Clique no botão Run Command.

Para converter múltiplos arquivos de projeto em arquivos NWD individuais

1 No aplicativo Autodesk Navisworks, clique na guia Home ➤ painel
Tools ➤ Batch Utility  .

2 No Autodesk Navisworks, na caixa de diálogo Batch Utility, use a
área Input para criar uma lista de arquivos de projeto para conversão:
■ Selecione a unidade e a pasta onde estão localizados os arquivos de

projeto. Uma vez selecionada a localização desejada, use o menu File
Type abaixo, para filtrar os arquivos de projeto que são exibidos na
direita. O menu contém uma lista de todos os formatos de arquivo
no momento suportados.
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■ Há dois métodos que podem ser usados para escolher arquivos para
conversão. Você pode clicar duas vezes para adicioná-los à lista de
conversão.

Alternativamente, clique no botão Add File Spec . Isso fará com
que o Autodesk Navisworks converta os arquivos localizados na pasta
selecionada. A opção escolhida no menu File Type, determina quais
arquivos são convertidos.

3 Na área Output , na guia As Multiple Files , escolha a localização para
os arquivos convertidos. Por padrão, os arquivos são criados na mesma
localização dos arquivos de origem.

Caso deseje alterar a localização de saída, selecione o botão Output to
Directory e clique no botão Browse . Use a caixa de diálogo Browse
for Folder para selecionar a pasta desejada.

4 Selecione o botão Increment Output File Names se desejar anexar
um número de quatro dígitos no fim do nome do arquivo. Por padrão,
os arquivos de saída antigos são sobrescritos.
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5 Clique no botão Run Command.

Para agendar a anexação de múltiplos arquivos de projeto em um único
arquivo do Autodesk Navisworks

1 No aplicativo Autodesk Navisworks, clique na guia Home ➤ painel
Tools ➤ Batch Utility  .

2 No Autodesk Navisworks, na caixa de diálogo Batch Utility, use a
área Input para criar uma lista de arquivos de projeto para conversão:
■ Selecione a unidade e a pasta onde estão localizados os arquivos de

projeto. Uma vez selecionada a localização desejada, use o menu File
Type abaixo, para filtrar os arquivos de projeto que são exibidos na
direita. O menu contém uma lista de todos os formatos de arquivo
no momento suportados.
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■ Há dois métodos que podem ser usados para escolher arquivos para
conversão. Você pode clicar duas vezes para adicioná-los à lista de
conversão.

Alternativamente, clique no botão Add File Spec . Isso fará com
que o Autodesk Navisworks converta os arquivos localizados na pasta
selecionada. A opção escolhida no menu File Type, determina quais
arquivos são convertidos.

3 Na área Output , na guia As Single File , clique no botão Browse .

4 Na caixa de diálogo Save Output As, procure pela pasta desejada e
insira um nome para o novo arquivo.

5 Na lista suspensa Save as Type, selecione o formato de arquivo exigido
(NWD ou NWF) e clique em Save.

6 Selecione o botão Increment Output File Names se desejar anexar
um número de quatro dígitos no fim do nome do arquivo. Por padrão,
os arquivos de saída antigos são sobrescritos.

7 Clique no botão Schedule Command.

8 Na caixa de diálogo Save Task File As procure pela localização desejada,
e clique no botão Save .

9 Na caixa de diálogo Schedule Task , altere o nome da tarefa, se
desejado, e insira seu nome de usuário e senha. Clique em OK.

OBSERVAÇÃO O agendamento de tarefa não funciona com para usuários
do Windows XP/2000 executando contas locais (ou seja, não em um
domínio) sem senhas.

10 No Windows Task Scheduler, na guia Schedule , clique no botão
New, e especifique quando e com que frequência a tarefa deve ser
executada. É possível adicionar quantos agendamentos forme necessários.

11 Clique em OK.
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Para agendar a conversão de múltiplos arquivos de projeto em arquivos NWD
individuais

1 No aplicativo Autodesk Navisworks, clique na guia Home ➤ painel
Tools ➤ Batch Utility  .

2 No Autodesk Navisworks, na caixa de diálogo Batch Utility, use a
área Input para criar uma lista de arquivos de projeto para conversão:
■ Selecione a unidade e a pasta onde estão localizados os arquivos de

projeto. Uma vez selecionada a localização desejada, use o menu File
Type abaixo, para filtrar os arquivos de projeto que são exibidos na
direita. O menu contém uma lista de todos os formatos de arquivo
no momento suportados.

■ Há dois métodos que podem ser usados para escolher arquivos para
conversão. Você pode clicar duas vezes para adicioná-los à lista de
conversão.

Alternativamente, clique no botão Add File Spec . Isso fará com
que o Autodesk Navisworks converta os arquivos localizados na pasta
selecionada. A opção escolhida no menu File Type, determina quais
arquivos são convertidos.

3 Na área Output , na guia As Multiple Files , escolha a localização para
os arquivos convertidos. Por padrão, os arquivos são criados na mesma
localização dos arquivos de origem.

Caso deseje alterar a localização de saída, selecione o botão Output to
Directory e clique no botão Browse . Use a caixa de diálogo Browse
for Folder para selecionar a pasta desejada.

4 Selecione o botão Increment Output File Names se desejar anexar
um número de quatro dígitos no fim do nome do arquivo. Por padrão,
os arquivos de saída antigos são sobrescritos.

5 Clique no botão Schedule Command.

6 Na caixa de diálogo Save Task File As procure pela localização desejada,
e clique no botão Save .

7 Na caixa de diálogo Schedule Task , altere o nome da tarefa, se
desejado, e insira seu nome de usuário e senha. Clique em OK.
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OBSERVAÇÃO O agendamento de tarefa não funciona com para usuários
do Windows XP/2000 executando contas locais (ou seja, não em um
domínio) sem senhas.

8 No Windows Task Scheduler, na guia Schedule , clique no botão
New, e especifique quando e com que frequência a tarefa deve ser
executada. É possível adicionar quantos agendamentos forme necessários.

9 Clique em OK.
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Para criar um arquivo de registro

1 No aplicativo Autodesk Navisworks, clique na guia Home ➤ painel
Tools ➤ Batch Utility  .

2 Na área Log , selecione a caixa de seleção Log Events To .

3 Clique no botão Browse .

4 Na caixa de diálogo Save Log As, procure pela pasta desejada e insira
um nome para seu arquivo de registro, e clique em Save..

5 Limpe a caixa de seleção Overwrite Existing Log File se desejar
manter os ventos novos e antigos no mesmo arquivo de registro. As
novas informações são anexadas ao fim do arquivo de registro.

Opções da linha de comando para o Batch Utility

É possível usar chaves da linha de comando para converter arquivos com o
Batch Utility. Para fazer isso, é preciso criar uma lista de arquivos que deseja
processar. Este arquivo precisa ser um arquivo de texto com codificação UTF-8,
contendo caminhos de arquivo ou especificações de arquivo, um em cada
linha, e sem nenhuma aspa. Por exemplo:

DescriçãoChave da linha de comando

Indica que o próximo argumento é o
arquivo de entrada. É preciso fornecer o
nome e o caminho do arquivo entre aspas.

/i

Saída para um único arquivo do Naviswork
(NWD ou NWF). É preciso fornecer o nome

/of

e o caminho do arquivo entre aspas. Por
exemplo, “C:\temp\a.nwd” ou
“C:\temp\a.nwf”.

Envia arquivos NWD múltiplos a uma pasta
específica. É preciso fornecer o nome e o

/od

caminho do arquivo entre aspas. Por
exemplo, “C:\temp”.

Saída de múltiplos arquivos NWD para a
mesma pasta que os arquivos de entrada.

/osd
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DescriçãoChave da linha de comando

Abre automaticamente o arquivo logo após
sua criação.

/view

Sobrescreve os arquivos de saída. Esse é o
comportamento padrão.

/over

Incrementa os nomes dos arquivos de saída./inc

Efetua a saída do eventos para um arquivo
de registro. É preciso fornecer o nome e o

/log

caminho do arquivo entre aspas. Por
exemplo, “C:\temp\log.log”.

Grava eventos novos e antigos no mesmo
arquivo de registro. As novas informações
são anexadas ao fim do arquivo de registro.

/appndlog

Especifica o idioma a ser usado ao efetuar
o login. Você pode usar os seguintes

/lang

argumentos: en-US = Inglês, de-DE =
Alemão, es-ES = Espanhol, fr-FR = Francês,
it-IT = Italiano, ja-JP = Japonês, ko-KR =
Coreano, pt-BR = Português do Brasil, ru-
RU = Russo, zh-CN = Chinês (PRC) .

A sintaxe para utilizar as chaves da linha de comando é:

FileToolsTaskRunner.exe /i <input file> [/of <output file>|/od <folder>|/osd] [/view]

[/over|/inc] [/log <log file>] [/append] [/lang <language>]

Por exemplo, a entrada a seguir processa a lista de arquivos de projeto no
arquivo filetools.txt , os anexa em um único arquivo conference.nwd , e cria um
arquivo de registro events.log no idioma Francês.

"C:\Program Files\Autodesk\Navisworks Manage

2012\FileToolsTaskRunner.exe" /i "C:\Conference Center\filetools.txt"

/of "C:\Conference Center\conference.nwd" /log "C:\Conference

Center\events.log" /lang fr-fr
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Visualizar estatísticas da cena
As estatísticas da cena exibem informações sobre a cena atual.

As estatísticas da cena lista todas os arquivo que contribuem para a cena, e os
diferentes elementos gráficos que compõem a cena, e também quais destes
elementos forma processados ou ignorados quando carregados.

Outras estatísticas úteis são a caixa de delimitação de toda a cena e o número
total de primitivos (triângulos, linhas, pontos) na cena.

Para visualizar as estatísticas da cena

1 Clique na guia Home e deslize o painel Project.

2 Clique em Scene Statistics  .
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Explorar seu modelo

Navegar em uma cena
No Autodesk Navisworks, você tem um variedade de opções para navegar na
cena.

Você pode manipular sua posição diretamente na Scene View com as
ferramentas de navegação da barra de navegação, como o Pan e o Zoom. Também
é possível usar os StreeringWheels® que acompanham o cursor e economizar
tempo ao combinar muitas das ferramentas de navegação comuns em uma única
interface.

É possível usar o ViewCube®, uma ferramenta de navegação 3D que permite
reorientar a vista de um modelo ao clicar em áreas predefinidas no cubo. Por
exemplo, ao clicar na frente do ViewCube gira a vista até que a câmera esteja
faceando a frente da cena. Você também pode clicar no ViewCube e arrastá-lo
para rotacionar livremente a vista. O ViewCube não está disponível em um
espaço de trabalho 2D.

DICA Utilize um mouse 3D 3Dconnexion como alternativa ao mouse para navegar
e alterar a orientação de seu modelo em um espaço de trabalho 3D. Há um modo
2D que você pode usar para navegar em um espaço de trabalho 2D.

Quando você navega em um modelo 3D, é possível utilizar as ferramentas de
realismo na guia Viewpoint painel  ➤ Navigate para controlar a velocidade
e o realismo de sua navegação. Portanto, por exemplo, você pode descer as
escadas ou seguir o terreno, agachar sob os objetos, utilizar um avatar para
representar a si próprio no modelo 3D. As ferramentas de realismo não estão
disponíveis em uma área de trabalho 2D.
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Efetuar a animação da navegação

Quando você navega no Autodesk Navisworks, poderá gravar animações de
pontos de vista e a seguir reproduzi-las. Para mais informações, consulte Play
Back Animations na página 503.

orientação no espaço de trabalho 3D

Embora o Autodesk Navisworks utilize o sistema de coordenadas X, Y, Z, não
há nenhuma regra direta e rápida mostrando para qual direção esses eixos
estão realmente “apontando”.

O Autodesk Navisworks lê os dados necessários para mapear qual a direção é
"para cima" e qual é "norte", diretamente dos arquivos carregados na cena.
Caso isto não seja possível, por padrão, Z é entendido como "para cima" e Y
como "norte".

É possível alterar as direções "para cima" e "norte" no modelo inteiro (orientação
mundial), e a direção "para cima" para o ponto de vista atual (vetor para cima
do ponto de vista).

OBSERVAÇÃO A alteração do vetor para cima do ponto de visão afeta os modos
de navegação que dependem da direção "para cima" do ponto de visão atual, tais
como Walk, Constrained Orbit e Orbit. Isto também tem impacto nas vistas
de corte.

Para alinhar o vetor acima do ponto de vista na vista atual

■ Em Scene View, pressione com o botão direito do mouse e clique em
Viewpoint ➤ Set Viewpoint Up ➤ Set Up no menu de atalho.

Para alinhar o vetor acima do ponto de vista para um dos eixos predefinidos

1 EmScene View, pressione com o botão direito do mouse e clique em
Viewpoint ➤  Set Viewpoint Up.

2 Clique em um dos eixos predefinidos. Escolha entre:
■ Set Up + X

■ Set Up - X

■ Set Up + Y

■ Set Up - Y

■ Set Up + Z
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■ Set Up -Z

Para alterar a orientação universal

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Orientation , insira os valores
necessários para ajustar a orientação do modelo.

3 Clique em OK.

Ferramentas de navegação específicas do
produto

A barra de navegação e os·SteeringWheels fornecem acesso a um conjunto de
ferramentas de navegação específicas do produto em espaços de trabalho 2D
e 3D.
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No Autodesk Navisworks Manage 2012, algumas ferramentas de navegação
clássicas foram substituídas por novas ferramentas de navegação. Consulte a
tabela abaixo para obter mais detalhes.

Pode ser
substituída de
volta para a
clássica?

2D?Substituída porFerramenta clássica

NãoSimPanPan

NãoSimZoomZoom

NãoSimZoom AllView All

NãoSimZoom SelectedView Selected

NãoSimZoom WindowZoom Box

SimNãoOrbitOrbit

SimNãoFree OrbitExamine

SimNãoConstrained OrbitTurntable

NãoNãoLookLook Around

---Focus

SimNãoWalkWalk

-Não-Fly

Personalizando o comportamento das ferramentas

Para a barra de navegação, pode-se usar Options Editor para alternar entre
os modos padrão e clássico para as ferramentas Órbita e Navegar.
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Controlar o realismo da navegação

É possível utilizar Collision na página 336, Gravity na página 335, Crouch na
página 336 e Third Person View na página 338 para aprimorar sua experiência
de navegação em um espaço de trabalho 3D.

DICA Use a combinação de Collision, Gravity, e Crouch com a ferramenta
Navegar. Isto permite, por exemplo, subir e descer escadas e andar sob objetos
baixos.

Ferramentas da barra de navegação

A barra de navegação contém um conjunto de ferramentas de navegação
específicas do produto.

Ferramenta Pan

A ferramenta de panorâmica move a vista paralela à tela.

A ferramenta é ativada ao clicar em Pan  na barra de navegação. A
ferramenta Pan se comporta da mesma forma que a ferramenta pan disponível
nos SteeringWheels.

Ferramentas de Zoom

Conjunto de ferramentas de navegação para aumentar ou diminuir a ampliação
da vista atual do modelo.

As seguintes ferramentas de zoom estão disponíveis:

■ Janela de Zoom  . Permite desenhar uma caixa e ampliar o zoom
para aquela área.

■ Zoom  . Zoom de clicar/arrastar padrão.

■ Zoom Selected  . Amplia/afasta o zoom para mostrar a geometria
selecionada.

■ Zoom All  . Afasta o zoom para mostrar toda a cena.
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Zoom Window

A ferramenta é ativada ao clicar na opção Janela de zoom no menu suspenso
Zoom na barra de navegação. Esta se comporta da mesma forma que o modo
clássico Zoom Box.

Zoom

A ferramenta é ativada ao clicar em Zoom no menu suspenso Zoom na barra
de navegação. Esta se comporta da mesma forma que a ferramenta Zoom
disponível nos SteeringWheels.

Zoom Selected

A ferramenta é ativada ao clicar em Zoom Selected no menu suspenso Zoom
na barra de navegação. Outra alternativa é clicar na guia Item Tools ➤ painel

Look At ➤ Zoom  na faixa de opções. Esta se comporta da mesma forma
que a ferramenta clássica View Selected.

Zoom All

A ferramenta é ativada ao clicar em Zoom All no menu suspenso Zoom na
barra de navegação. Esta se comporta da mesma forma que a ferramenta clássica
View All.

Ferramentas Orbit

Conjunto de ferramentas de navegação para rotacionar o modelo em torno
de um ponto de giro enquanto a vista permanece fixa. Essas ferramentas não
estão disponíveis em um espaço de trabalho 2D.

As seguintes ferramentas de órbita estão disponíveis:

■ Órbita  . Move a câmera ao redor do ponto focal do modelo. A direção
em pé é sempre mantida, e nenhuma rolagem de câmera é possível.

■ Órbita livre  . Rotaciona o modelo ao redor do ponto focal em
qualquer direção.

■ Órbita restringida  . Gira o modelo ao redor do vetor vertical, como
se o modelo estivesse em um prato giratório. A direção vertical é sempre
mantida.
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Orbit

A ferramenta é ativada ao clicar em Órbita no menu suspenso Órbita na
barra de navegação. Esta se comporta da mesma forma que a ferramenta Órbita
disponível nos SteeringWheels. É possível usar o comando Options Editor
para voltar ao modo clássico Órbita.

Free Orbit

A ferramenta é ativada ao clicar em Órbita livre no menu suspenso Órbita
na barra de navegação. Esta se comporta de forma similar ao modo clássico
Examine. É possível usar o comando Options Editor para voltar ao modo
clássico Examine.

Constrained Orbit

A ferramenta é ativada ao clicar em Órbita restringida no menu suspenso
Órbita na barra de navegação. Esta se comporta de maneira similar ao modo
clássico Turntable. É possível usar o comando Options Editor para voltar
ao modo clássico Turntable.

Para usar a ferramenta clássica Órbita com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.

2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Orbit na área Orbit Tools.

3 Clique em OK.

Para usar a ferramenta clássica Examine com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.

2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Free Orbit (Examine) na área
Orbit Tools.

3 Clique em OK.

Para usar a ferramenta clássica Turntable com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.
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2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Constrained Orbit
(Turntable) na área the Orbit Tools.

3 Clique em OK.

Ferramentas Look

Conjunto de ferramentas para rotacionar a vista atual verticalmente e
horizontalmente. Essas ferramentas não estão disponíveis em uma área de
trabalho 2D.

As seguintes ferramentas de olhar estão disponíveis:

■ Look Around  . Olha ao redor da cena da localização atual da câmera.

■ Look At  . Olha para um ponto em particular na cena. A câmera move
para se alinha com aquele ponto.

■ Focus  . Olha para um ponto em particular na cena. A câmera
permanece onde está.

Look Around

A ferramenta é ativada ao clicar em Vista panorâmica no menu suspenso
Olhar na barra de navegação. Esta se comporta da mesma forma que a
ferramenta Olhar disponível nos SteeringWheels.

Examinar em

A ferramenta é ativada ao clicar em Examinar no menu suspenso Olhar na
barra de navegação. Esta se comporta da mesma forma que a ferramenta do
SteeringWheels Olhar ao manter pressionada a tecla SHIFT.

Focus

A ferramenta é ativada ao clicar em Focus no menu suspenso Look na barra
de navegação. Consulte Foco na página 334 para obter mais detalhes.
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Ferramentas Walk e Fly

Conjunto de ferramentas de navegação para mover ao redor do modelo e
controlar as configurações de realismo. Essas ferramentas não estão disponíveis
em uma área de trabalho 2D.

As seguintes ferramentas estão disponíveis:

■ Navegar  . Move através de um modelo como se você estivesse andando
por ele.

■ Fly  . Move através de um modelo como em um simulador de vôo.

Walk

A ferramenta é ativada ao clicar em Navegar no menu suspenso Olhar/Fly
na barra de navegação. Por padrão, a ferramenta se comporta como a
ferramenta Navegar no SteeringWheels. É possível personalizar as opções de
ferramentas no Options Editor. Também é possível voltar para o modo
clássico Walk.

Fly

A ferramenta é ativada ao clicar em Fly no menu suspenso Navegar/Fly na
barra de navegação. Esta se comporta da mesma forma que o modo clássico
Fly.

Consulte também:

Controlar o realismo de sua navegação na página 335

Para usar a ferramenta Walk clássica com a barra de navegação

1 Na barra de navegação, clique em Customize  ➤ Navigation Bar
Options.

2 No Options Editor, página Navigation Bar sob o nó Interface,
selecione a caixa de seleção Use Classic Walk na área Walk Tool.

3 Clique em OK.
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Ferramentas SteeringWheels

Cada círculo é dividido em diferentes seções. Cada setor contém uma
ferramenta de navegação que pode ser usada para reorientar a vista atual de
um modelo. Quais ferramentas de navegação que estão disponíveis depende
de qual círculo está ativo.

Ferramenta Centro

Com a ferramenta Centro é possível definir o centro da vista atual de um
modelo. Para definir o centro, arraste o cursor sobre seu modelo. Uma esfera
(ponto de giro) é exibida além do cursor. A esfera indica que o ponto abaixo
do cursor no modelo será o centro da vista atual quando você soltar o botão
do mouse. O modelo é centralizado na esfera.

OBSERVAÇÃO Se o cursor não está sobre o modelo, o centro não pode ser definido
e um cursor de proibição é exibido.

O ponto definido pela ferramenta Centro fornece um ponto focal para a
ferramenta Zoom e um ponto de giro para a ferramenta Órbita

OBSERVAÇÃO Se você deseja efetuar o zoom a partir dos círculos de navegação
completa de seu ponto central definido, mantenha pressionado Ctrl antes de
efetuar o zoom.

Para especificar um ponto em um modelo como o centro de uma vista

1 Exiba um dos círculos Navegação completa ou o círculo grande
Visualização de objetos.

2 Clique e arraste para baixo o setor Centro.
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3 Arraste o cursor para a localização desejada do modelo.

4 Solte o botão no seu dispositivo apontador quando a esfera for exibida.

É efetuada a panorâmica no modelo até que a esfera esteja centralizada.

Para especificar o ponto alvo para as ferramentas Zoom e Órbita.

1 Exiba um dos círculos Navegação completa ou o círculo grande
Visualização de objetos.

2 Clique e arraste para baixo o setor Centro.

3 Arraste o cursor sobre a localização desejada do modelo.

4 Solte o botão no seu dispositivo apontador quando a esfera for exibida.

É efetuada a panorâmica no modelo até que a esfera esteja centralizada.

5 Utilize as ferramentas Zoom ou Órbita para reorientar a vista do modelo.

Se estiver utilizando um dos círculos Navegação completa, pressione a
tecla Ctrl antes de utilizar a ferramenta Zoom.

Ferramenta Avançar

A ferramenta Avançar é utilizada para alterar a ampliação do modelo ao
aumentar ou diminuir a distância entre o ponto atual da vista e o ponto de
giro. A distância na qual é possível mover adiante ou para atrás é limitada pela
posição do ponto de giro.

OBSERVAÇÃO Em vistas ortogonais, a ferramenta Adiante está limitada à distância
entre a posição atual e o ponto de giro. Em vistas em perspectiva, ela não está
limitada. Sendo assim, é possível mover o cursor através do ponto de giro.
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Para ajustar a distância entre o ponto atual da vista e o ponto de giro, utilize
o indicador Distância de arraste. O indicador Distância de arraste possui duas
marcas que mostram a distância inicial e de destino do ponto atual da vista.
A distância percorrida atual é exibida pelo indicador de posição laranja. Deslize
o indicador para frente ou para trás para diminuir ou aumentar a distância do
ponto de giro.

Para reorientar uma vista ao avançar ou retroceder de um modelo

1 Exiba o círculo grande Tour do edifício.

2 Clique e arraste para baixo o setor Avançar.

O indicador Distância de arraste é exibido.

OBSERVAÇÃO Se clicar um vez no setor Avançar, o modelo move adiante
50% da distância entre a localização atual e o ponto de giro.

3 Arraste o cursor para cima ou para baixo para alterar a distância da qual
se observa o modelo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Olhar

Com a ferramenta Olhar, é possível rotacionar a vista atual na vertical e na
horizontal. Ao rotacionar a vista, a sua linha de visão gira em torno da posição
atual do olho, como se virasse a sua cabeça. A ferramenta Olhar pode ser
comparada a você parado em uma posição fixa, olhando para cima ou para
baixo enquanto vira a sua cabeça para esquerda ou direita.

Ao usar a ferramenta Olhar, a vista do modelo é ajustada ao se arrastar o cursor.
Quando você arrasta, o cursor muda para o cursor Olhar e o modelo gira em
torno da localização da vista atual.
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Além de usar a ferramenta Olhar para olhar ao redor de um modelo, também
é possível utilizar a ferramenta para fazer a panorâmica na vista atual para
uma face especifica no modelo. Mantenha pressionada a tecla Shift antes de
selecionar a ferramenta Olhar em um dos círculos Navegação completa.

Navegar através de um modelo

Ao usar a ferramenta Olhara partir do grande círculoNavegação completa,
é possível andar pelo modelo usando as teclas de setas no teclado. Para ajustar
a velocidade de navegação, utilize o Options Editor.

Inverter eixo vertical

Quando se arrasta o cursor para cima, o ponto alvo da vista se eleva; arrastando
o cursor para baixo abaixa o ponto alvo da vista. Para inverter o eixo vertical
para a ferramenta Olhar use o Options Editor.

Para olhar ao redor de uma vista com a ferramenta Olhar

1 Exiba um dos círculos de navegação completa ou o minicírculo de tour
do edifício.

2 Clique e arraste para baixo o setor Olhar.

O cursor muda para o cursor Olhar.

3 Arraste o dispositivo apontador para alterar a direção na qual você está
olhando.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para olhar para uma face no modelo com a ferramenta Olhar

1 Exiba um dos círculos Navegação completa.

2 Pressione segure a tecla Shift.

3 Clique e arraste para baixo o setor Olhar.

O cursor muda para o cursor Olhar para.

4 Arraste sobre os objetos no modelo até que a face realçada seja a que
você deseja olhar.

5 Solte o botão do dispositivo apontador para retornar para o círculo.

Para olhar ao redor e navegar através de um modelo com a ferramenta Olhar.

1 Exiba a círculo grande Navegação completa.

2 Clique e arraste para baixo o setor Olhar.
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O cursor muda para o cursor Olhar.

3 Arraste para alterar a direção na qual você está olhando.

4 Mantendo pressionado o botão no dispositivo apontador, pressione as
teclas de seta para navegar no modelo.

5 Solte o botão do dispositivo apontador para retornar para o círculo.

6 Clique em Fechar para sair do círculo.

Para inverter o eixo vertical para a ferramenta Look

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Invert Vertical Axis na área Look Tool.

Arrastando para baixo ou para cima, abaixa ou aumenta o ponto alvo
da vista atual.

4 Clique em OK.

Ferramenta Órbita

É possível usar a ferramenta Órbita para alterar a orientação de um modelo.
O cursor muda para o cursor Órbita. Quando o cursor é arrastado, o modelo
rotaciona em torno do ponto de pivô enquanto a vista permanece fixa.
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Especificar o ponto de pivô

O ponto de pivô é o ponto base usado ao rotacionar o modelo com a
ferramenta Órbita. É possível especificar o ponto de pivô nas seguintes formas:

■ Ponto de pivô padrão. Ao abrir o modelo pela primeira vez, o ponto
alvo da vista atual é usado como o ponto de pivô para orbitar no modelo.

■ Selecionar objetos. É possível selecionar objetos antes da ferramenta
Órbita ser utilizada para calcular o ponto de giro. O ponto de pivô é
calculado com base no centro das extensões dos objetos selecionados.

■ Ferramenta Centralizar. É possível especificar um ponto no modelo
para ser usado como o ponto de pivô ao orbitar com a ferramenta
Centralizar na página 266.

■ CTRL+Clique e arraste. Mantenha pressionada a tecla Ctrl antes de
clicar no setor Órbita ou enquanto a ferramenta Órbita está ativa, e arraste
para o ponto do modelo que você deseja como o ponto de giro. Esta opção
somente está disponível ao utilizar os círculos de navegação completa
grande e mini ou o minicírculo de visualização de objeto.

OBSERVAÇÃO Enquanto a ferramenta Órbita está ativa, é possível manter
pressionada a tecla Ctrl a qualquer momento para mover o ponto de giro
utilizado pela ferramenta Órbita. Este ponto de giro é usado para a navegação
subsequente até ele ser movido.

Manter a direção para cima

Pode-se controlar como o modelo orbita em torno do ponto de giro ao escolher
manter a direção do modelo para cima. Quando a direção para cima é mantida,
a órbita é restrita ao longo dos eixos XY e na direção Z. Se você arrastar na
horizontal, a câmera se moverá em paralelo ao plano XY. Se arrastar na vertical,
a câmera se moverá ao longo do eixo Z.

Se a direção para cima não for mantida, é possível rolar o modelo utilizando
a anel de rolagem que está centralizado em torno do ponto de giro. Utilize a
caixa de diálogo Propriedades dos SteeringWheels para controlar se a direção
para cima é mantida ou não para a ferramenta Órbita.
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Para orbitar um modelo com a ferramenta Órbita

1 Exiba um dos círculos Visualização de objetos ou Navegação completa.

2 Clique e pressione o setor Órbita.

O cursor muda para o cursor Órbita.

3 Arraste para girar o modelo.

OBSERVAÇÃO Utilize a ferramenta Centro para recentralizar o modelo na
vista atual, se você está utilizando um dos círculos Navegação completa ou
Visualização de objetos.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para orbitar em volta de um objeto com a ferramenta Órbita.

1 Pressione Esc para assegurar-se de que nenhum comando esteja ativo e
para limpar quaisquer objetos previamente selecionados.

2 Selecione os objetos no modelo para os quais deseja definir o ponto de
giro.

3 Exiba um dos círculos Visualização de objetos ou Navegação completa.

4 Clique e pressione o setor Órbita.

O cursor muda para o cursor Órbita.

5 Arraste para girar o modelo.

6 Solte o botão do dispositivo apontador para retornar para o círculo.
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Para ativar a sensibilidade da ferramenta Orbit

1 Mostre um dos círculos Visualizar objeto ou Navegação completa.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Center Pivot on Selection na seção Orbit
Tool.

4 Clique em OK.

As extensões de quaisquer objetos que estão selecionados antes do círculo
ser exibido são usados para definir o ponto de giro para a ferramenta
Orbit. Se nenhum objeto está selecionado, o ponto de giro usado pela
ferramenta Orbit é o definido pela ferramenta Center.

Para manter a direção acima para a ferramenta Orbit

1 Mostre o mini círculo Visualizar objeto ou um dos círculos Navegação
completa.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Keep Scene Upright na área Orbit Tool.

4 Clique em OK.

A órbita no modelo é restrita ao longo do plano XY e a direção Z.

Para rolar o modelo ao redor do ponto de giro com a ferramenta Orbit.

1 Mostre o mini círculo Visualizar objeto ou um dos círculos Navegação
completa.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, na página SteeringWheels sob o nó Interface
, desmarque a caixa de seleção Keep Scene Upright.

4 Clique em OK.

5 Clique e pressione o setor Órbita.

O cursor muda para o cursor Órbita.

6 Mantenha pressionada a tecla Shift para exibir o anel de rolagem.
Arraste para rolar o modelo.

7 Solte o botão do dispositivo apontador para retornar para o círculo.
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Para iniciar a ferramenta Órbita com o botão do meio do mouse

1 Exiba um dos círculos diferente do círculos grandes Visualização de
objetos ou Tour do edifício.

2 Mantenha pressionada a tecla Shift.

3 Mantenha pressionada a roda de rolagem ou o botão do meio em seu
dispositivo apontador a arraste para orbitar o modelo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Pan

Quando a ferramenta Pan está ativa, o cursor Pan (uma seta com quatro pontas)
é exibido. Arrastar o dispositivo apontador move o modelo na mesma direção.
Por exemplo, arrastar para acima move o modelo para cima, enquanto arrastar
para baixo move o modelo para baixo.

DICA Se o cursor alcançar a borda da tela, pode-se continuar a efetuar a
panorâmica ao arrastar o cursor para forçá-lo a envolver a tela.

Para efetuar uma panorâmica na vista com a ferramenta Pan

1 Mostre um dos círculos Navegação completa, ou o mini círculo
Visualizar objeto.

2 Mantenha pressionado o setor Pan.

O cursor é alterado para o cursor Pan.

3 Arraste para reposicionar o modelo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.
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Para iniciar a ferramenta Pan com o botão do meio do mouse

1 Mostre um dos círculos Navegação completa, ou o mini círculo
Visualizar objeto.

2 Mantenha pressionada a roda de rolagem ou o botão do meio do mouse.

O cursor é alterado para o cursor Pan.

3 Arraste para reposicionar o modelo.

4 Libere a roda ou botão no dispositivo apontador para retornar para o
círculo.

Ferramenta Rebobinar

Conforme as ferramentas de navegação são utilizadas para reorientar a vista
de um modelo, a vista anterior é salva para o histórico de navegação. O
histórico de navegação armazena uma representação das vistas anteriores do
modelo junto com uma miniatura. Um histórico de navegação separado é
mantido para cada janela, mas não é mantido após a janela ser fechada. O
histórico de navegação de Rebobinar é específico da vista.

Com a ferramenta Rebobinar, é possível recuperar as vistas anteriores do
histórico de navegação. A partir do histórico de navegação é possível restaurar
uma vista anterior ou navegar através de todas as vistas salvas.

OBSERVAÇÃO  Quando você rebobina e grava um novo histórico de navegação,
as vistas rebobinadas são substituídas por novas vistas. O histórico de navegação
não é salvo entre sessões.
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Para restaurar a vista anterior

1 Exiba um círculo.

2 Clique no setor Rebobinar.

Para restaurar uma vista anterior com o painel Rebobinar histórico

1 Exiba um círculo.

2 Clique e pressione o setor Rebobinar.

O painel Rebobinar histórico é exibido.

3 Mantendo pressionado o botão do dispositivo apontador, arraste para a
esquerda ou para a direita para restaurar uma vista anterior.

Arrastando para a esquerda restaura-se uma vista anterior mais antiga.
Arrastando para a direita restaura a vista que seja mais nova do que a
que você está no momento visualizando É preciso ter utilizado
anteriormente a ferramenta Rebobinar para visualizar as vistas que estão
disponíveis na direita. A posição atual do histórico de navegação é
indicada pela caixa laranja que é arrastada ao longo do painel Histórico
rebobinar.

Ferramenta Para cima/Para baixo

Diferente da ferramenta Pan, a ferramenta Acima/Abaixo é usada para ajustar
a altura do ponto de vista atual ao longo do eixo Z do modelo. Para ajustar a
elevação vertical da vista atual, arraste para cima ou para baixo. Quando se
arrasta, a elevação atual e a faixa permitida do movimento são exibidas em
um elemento gráfico de indicador denominado como Distância vertical.

O indicador Distância vertical tem duas marcas que mostram a elevação mais
alta (Superior) e mais baixa (Inferior) que a vista pode ter. Ao alterar a elevação
com o indicador Distância vertical, a elevação atual é mostrada pelo indicador
laranja brilhante, enquanto a elevação anterior é mostrada pelo indicador
laranja esmaecido.
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Para alterar a elevação de uma vista

1 Exiba um dos círculos Navegação completa ou Tour do edifício.

2 Clique e pressione o setor Acima/Abaixo.

O indicador Distância vertical é exibido.

3 Arraste para cima ou para baixo para alterar a elevação da vista.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Navegar

Com a ferramenta Navegar é possível navegar através de um modelo como se
estivesse andando nele. Iniciada a ferramenta Navegar, o ícone Círculo central
é exibido perto da base da vista e o cursor muda para exibir uma série de setas.
Para navegar através do modelo, arraste na direção que deseja mover.
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Constrain the Walk Angle

Ao navegar através de uma modelo, pode-se restringir o ângulo do movimento
para o vetor acima. Se a opção Constrain Walk Angle estiver ativada, é
possível navegar livremente, enquanto mantém uma elevação de ponto de
vista da câmera constante. Se o ângulo de navegação não for restrito, você irá
"voar" na direção em que está olhando. Use o Options Editorpara restringir
o ângulo de movimento ao vetor mundial para cima para a ferramenta
Navegar.

Usar velocidade linear do ponto de visão

Por padrão, a velocidade de navegação linear nos pontos de visão está
diretamente relacionada ao tamanho do seu modelo. Você pode definir uma
velocidade de movimento específica para todos os pontos de vista (Options
Editor ➤ Interface ➤ Viewpoint Defaults) ou para o ponto de vista atual
(guia Viewpoint ➤ painel Save, Load & Playback ➤ Edit Current
Viewpoint). Use oOptions Editor para fazer as configurações Usar
velocidade linear do ponto de visão da ferramentaNavegar.

Velocidade do movimento

Quando você "voa" através de um modelo pode controlar a velocidade do
movimento. A velocidade do movimento é controlada pela distância na qual
o cursor é movido do ícone Center Circle e pela configuração de velocidade
de movimento atual. É possível ajustar a velocidade do movimento definindo-a
como permanente ou temporária, conforme for utilizando a ferramenta
Navegar. Para ajustar permanentemente a velocidade do movimento, use o
Options Editor ou as teclas < e > quando a ferramenta Navegar estiver
ativa. Para aumentar permanentemente a velocidade do movimento, mantenha
pressionada a tecla + (mais) enquanto estiver usando a ferramenta Navegar.

Alterar a elevação

Quando a ferramenta Navegar é usada, pode-se ajustar a elevação da vista ao
manter pressionada a tecla Shift . Isto ativa temporariamente a ferramenta
Acima/Abaixo. Com a ferramenta Acima/Abaixo ativa, arraste para cima ou
para baixo para ajustar a elevação da câmera. Também é possível utilizar as
teclas Para cima e Para baixo enquanto se navega para ajustar a altura da
vista.
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Para usar a ferramenta Navegar para mover através do modelo

1 Exiba um dos círculos Navegação completa ou o minicírculo Tour do
edifício.

2 Clique e pressione o setor (Rebobinar).

O cursor é alterado para o cursor Navegar e o ícone Círculo central é
exibido.

3 Arraste na direção que deseja navegar.

OBSERVAÇÃO Enquanto navega, pressione e segure a tecla + (mais) para
aumentar temporariamente a sua velocidade de movimento.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para alterar a velocidade do movimento para a ferramenta Walk

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface, use
o deslizador Walk Speed na área Walk Tool.

Arrastar o deslizador para a esquerda diminui a velocidade da navegação.
arrastar para a direita aumenta a velocidade de navegação.

4 Clique em OK.

Para restringir a ferramenta Walk para o vetor acima

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Constrain Walk Angle na área Walk
Tool.

4 Clique em OK.

O movimento ao navegar é feito em paralelo ao universo acima do
modelo.

Para fazer com que a ferramenta Walk use a velocidade linear do ponto de
vista

1 Exiba um círculo.
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2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Usar velocidade linear para o ponto
de visão na área ferramenta Navegar.

4 Clique em OK.

Para ajustar a altura da vista atual da ferramenta Navegar

1 Exiba um dos círculos Navegação completa ou o minicírculo Tour do
edifício.

2 Clique e pressione o setor (Rebobinar).

O cursor é alterado para o cursor Navegar e o ícone Círculo central é
exibido.

3 Efetue um dos seguintes procedimentos:
■ Mantenha pressionada a tecla Shift para ativar a ferramenta Para

cima/Para baixo e arraste para cima ou para baixo.

■ Mantenha pressionada a tecla Para cima ou Para baixo.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Ferramenta Zoom

É possível utilizar a ferramenta Zoom para alterar a ampliação do zoom de
um modelo.

OBSERVAÇÃO Ao iniciar a ferramenta Zoom do círculo Navegação completa,
o aumento incremental do zoom deve estar ativado no Options Editor para que
seja possível usar o comandoCTRL + clique e SHIFT + clique.
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Restrições do zoom

Ao alterar a ampliação de um modelo com a ferramenta Zoom, não é possível
aumentar o zoom além do ponto de foco ou além das extensões do modelo.
A direção na qual se poderá aproximar ou afastar o zoom é controlada pelo
ponto central definido pela ferramenta Centro.

OBSERVAÇÃO Diferente da ferramenta Zoom no círculo grande Visualização de
objetos, a ferramenta Zoom no minicírculo Visualização de objetos e nos círculos
Navegação completa não é restrita.

Para efetuar o zoom na vista com um único clique

Observação: É necessário que o aumento incremental do zoom esteja ativado
ao usar os círculos Full Navigation ou um minicírculo View Object. Para
o grande círculo Visualizar objeto, o aumento incremental do zoom está
sempre ativado.

1 Faça o seguinte para assegurar que a opção Enable Single-Click
Incremental Zoom-In seja selecionada:

1 Mostre o círculo Navegação completa.

2 Clique com o botão direito do mouse no círculo e clique em Opções
do SteeringWheel.

3 No Options Editor, página SteeringWheelssob o nó Interface,
selecione a caixa de seleção Enable Single-Click Incremental
Zoom-In na área Zoom Tool.

4 Clique em OK.

2 Mostre um círculo que tenha a ferramenta Zoom.

3 Clique no círculo Zoom.

A ampliação do modelo é aumentada quando se aproxima o zoom do
modelo. Se você mantiver pressionada a tecla Shift enquanto clica o setor
Zoom, o modelo terá o zoom diminuído; também é possível manter
pressionada a tecla Ctrl para aumentar o zoom.

Para aproximar e afastar o zoom ao arrastar

1 Mostre um dos círculos Navegação completa, ou um dos círculos
Visualizar objeto.

2 Clique e pressione o setor Zoom.

O cursor muda para o cursor Zoom.
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3 Arraste na vertical para aproximar ou afastar o zoom.

4 Solte o botão do dispositivo apontador para retornar para o círculo.

Para ampliar o zoom em uma área do modelo ao especificar uma janela

1 Exiba um dos círculos de navegação completa ou o minicírculo de
visualização de objeto.

2 Mantenha pressionada a tecla Shift.

3 Clique e pressione o setor Zoom.

O cursor muda para o cursor Zoom.

4 Arraste o dispositivo apontador para definir o canto oposto da janela
que define a área na qual deseja aplicar o zoom.

OBSERVAÇÃO Ao manter pressionada a tecla Ctrl enquanto define o
segundo ponto da janela, determina se o primeiro ponto da janela é usado
como o canto ou centro da janela sendo arrastada. Quando a tecla Ctrl é
mantida pressionada, o primeiro ponto define o centro da janela.

5 Solte o botão do dispositivo apontador para retornar para o círculo.

Para aumentar ou diminuir o zoom ao rolar a roda do mouse quando os
SteeringWheels são exibidos

1 Exiba um dos círculos que não seja o círculo Tour do edifício.

2 Mova a roda do mouse para aproximar e afastar o zoom.

3 Solte o botão do dispositivo apontador para retornar para o círculo.

É possível usar a ferramenta Zoom para alterar a ampliação de um modelo. As
seguintes combinações de clique e tecla estão disponíveis para controlar como
a ferramenta Zoom se comporta:
■ Clique. Se clicar na ferramenta Zoom no círculo, a vista atual é ampliada

por um fator de 25 por cento. Se estiver usando o círculo Navegação
completa, o aumento incremental do zoom deve estar ativado no Options
Editor.

■ SHIFT+clique. Se mantiver pressionada a tecla SHIFT antes de clicar na
ferramenta Zoom em um círculo, a vista atual tem o zoom reduzido por
um fator de 25%. O zoom é aplicado na localização do cursor, e não do
ponto de giro atual.

■ Ctrl + clique. Se a tecla Ctrl for mantida pressionada antes de clicar na
ferramenta Zoom em um círculo, a vista atual tem o zoom aumentado por
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um fator de 25 por cento. O zoom é aplicado na localização do cursor, e
não do ponto de giro atual.

■ Clique e arraste. Se você clicar na ferramenta Zoom e manter pressionado
o botão no seu dispositivo apontador, é possível ajustar a ampliação do
modelo ao arrastar para cima ou para baixo.

■ Ctrl+ clique e arraste.  Ao utilizar os círculos Navegação completa ou
o minicírculo Visualização de objetos, é possível controlar o ponto alvo
utilizado pela ferramenta Zoom. Ao manter pressionada a tecla Ctrl, a
ferramenta Zoom irá utilizar a localização do ponto de giro anterior definido
pela ferramenta Zoom, Órbita ou Centro.

■ Shift+ clique e arraste Ao utilizar os círculos Navegação completa ou
o minicírculo Visualização de objetos, é possível aumentar o zoom em uma
área do modelo ao arrastar uma janela retangular em volta da área que
deseja ajustar a tela. Mantenha pressionada a tecla Shift e a seguir clique
e arraste uma janela ao redor da área na qual deseja aplicar zoom.

OBSERVAÇÃO Se a tecla Ctrl for mantida pressionada junto com a tecla
Shift, é possível aproximar o zoom em uma área do modelo utilizando uma
janela com base no centro, em vez de definida por cantos opostos.

■ Roda do mouse. Quando um círculo é exibido, role a roda do mouse
para cima ou para baixo para aumentar ou diminuir o zoom na vista do
modelo.

OBSERVAÇÃO Quando a ferramenta Zoom é utilizada a partir dos círculos de
navegação completa ou visualização de objetos, o ponto na vista no qual se clica
para aplicar o zoom se torna o ponto central para operações futuras de órbita, até
que se utilize a ferramenta Zoom novamente ou a ferramenta Centro. Se pressionar
CTRL antes de clicar na seção Zoom, o ponto Central não mudará.

Modos e ferramentas de navegação clássicos

Na interface do usuário Classic, há nove modos de navegação disponíveis na
barra de ferramentas Navigation Mode para controlar o movimento pela
Scene View: seis modos de câmera cêntrica e três modos de modelos cêntricos.
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DICA É possível usar alguns dos modos de navegação clássicos com a interface
de usuário clássica (faixa de opções). O Options Editor permite selecionar entre
os modos novos e antigos.

Em um modo centralizado na câmera, a câmera move na cena, e no modo
centralizado no modelo, o modelo move na cena. Por exemplo, os modos de
examinar e órbita essencialmente fazem a mesma coisa, exceto que o modo
de órbita move a câmera em torno do ponto focal e o modo examinar move
o modelo em torno do ponto focal.

OBSERVAÇÃO Os modos de navegação e SteeringWheels na página 309 são
mutuamente exclusivos, portanto, a ativação do modo de navegação desativa o
menu atual do SteeringWheel.

O movimento em cada modo tem base nas teclas de seta do teclado, as teclas
SHIFT e CTRL e no arraste do mouse. A roda do mouse também é suportada,
permitindo o rápido e fácil zoom ou lado-a-lado, dependendo do modo de
navegação atual.

DICA Arrastar com o mouse esquerdo enquanto mantém pressionado a tecla
CTRL executa a mesma ação que arrastar com o botão do meio do mouse, o qual
é útil caso só possua um mouse de dois botões.

As teclas SHIFT e CONTROL modificam o movimento, por exemplo, pressionar
a tecla SHIFT no modo navegar, acelera o movimento, e pressionar a tecla
CTRL também neste modo, desliza a câmera para a esquerda/direita e para
cima/para baixo.

OBSERVAÇÃO O movimento da câmera é o oposto de efetuar o pan no modelo.
O movimento da câmera é um movimento centralizado na câmera e o pan é um
movimento centralizado no modelo.

DescriçãoModo

Navegar. Permite navegar através do
modelo em um plano horizontal
assegurando que 'acima' sempre seja
'acima'.

Look Around . Permite olhar em torno do
modelo da posição atual da câmera e
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DescriçãoModo

fornece o efeito de estar movendo sua
cabeça em torno.

Zoom. Permite aproximar e afastar o zoom
do modelo. O curso para cima aproxima o
zoom e o cursor para baixo afasta o zoom.

Zoom to a Box. Permite arrastar uma
caixa para que o conteúdo da caixa
preencha a vista.

Pan. Permite efetuar o pan no modelo ao
invés da câmera.

Órbita. Permite orbitar a câmera em torno
do modelo assegurando que 'acima' seja
sempre 'acima'. A câmera sempre efetua a
órbita em torno de um ponto focal do
modelo.

Examine Permite rotacionar o modelo.

Fly. Permite voar em torno do modelo
como em um simulador de vôo.

Turntable. Permite girar o modelo em
trono do vetor acima. Este modo de
navegação se comporta como se o modelo
estivesse sentado em uma mesa giratória
assegurando que 'acima' seja sempre
'acima'.

Modo Walk

No modo Walk, é possível navegar por um modelo como se estivesse andando
por ele. Neste modo, a direção acima é sempre mantida.

Navegar em uma cena | 285



Após você iniciar o modo de navegação, o cursor muda para o cursor de
navegação. Para navegar através do modelo, você arrasta na direção na qual
deseja mover para.

Para utilizar o modo de navegação para mover através do modelo

1 Clique em Walk  na barra de ferramentas Navigation Mode.

2 Para mover, mantenha pressionado o botão esquerdo do mouse ao
arrastar na direção em que deseja navegar ou utilize as teclas de cursor.
A câmera gira para a esquerda e para a direita e move adiante e para atrás,

OBSERVAÇÃO Manter pressionada a tecla SHIFT acelera este movimento.

3 Para movimentar, mantenha pressionada tecla CTRL ao arrastar o mouse.
A câmera se movimenta para a esquerda e para a direita e para cima e
para baixo.

Quando o modo de navegação é centralizado na câmera, este modo difere
do modo normal de pan, pelo fato de que a câmera é movida e não o
modelo.

4 Para inclinar a câmera para cima e para baixo, gire a roda do mouse.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Walk

Entrada do comando: Ctrl+2

Modo Look Around

No modo Look Around, é possível girar a vista atual verticalmente e
horizontalmente. Ao rotacionar a vista, sua linha de visão rotaciona em torno
da posição do olho, como se estivesse virando sua cabeça.
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Para olhar em torno de uma vista

1 Clique em Look Around  na barra de ferramentas Navigation
Mode.

2 Para olhar em torno, arraste o botão esquerdo do mouse ou utilize as
teclas do cursor. A câmera olha para a esquerda, para a direita, para cima
ou para baixo.

OBSERVAÇÃO Manter pressionada a tecla SHIFT acelera este movimento.

3 Para rotacionar a câmera em torno de seu eixo de visualização, mantenha
pressionada a tecla CTRL.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Look Around

Entrada do comando: Ctrl+3

Modo Zoom

No modo Zoom, é possível efetuar o zoom dentro e fora do modelo.

Para efetuar o zoom na vista

1 Clique em Zoom  na barra de ferramentas Navigation Mode.
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2 Arraste o botão esquerdo do mouse para cima e para baixo ou utilize as
teclas do cursor para cima e para baixo para aproximar e afastar o zoom
respectivamente.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Zoom

Entrada do comando: Ctrl+4

Modo Zoom Box

No modo Zoom Box, é possível efetuar o zoom dentro de uma área de um
modelo ao arrastar uma caixa retangular pela área que deseja enquadrar na
Vista da cena.

Para aproximar o zoom em uma área do modelo ao especificar uma caixa

1 Clique em Zoom Box  na barra de ferramentas Navigation Mode.

2 Arraste uma caixa com o botão esquerdo do mouse sobre a Vista da
cena para preencher a vista com o conteúdo da caixa.

OBSERVAÇÃO Manter pressionada as teclas SHIFT ou CTRL, ou girar a roda
do mouse, ativa temporariamente o modo Zoom.

Menu:  Interface de usuárioClassic: Viewpoint ➤ Navigation
Mode ➤ Zoom Window

Entrada do comando: CTRL + 5
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Modo Pan

No modo Pan, é possível mover o modelo, em vez da câmera. Por exemplo,
arrastar para cima move o modelo acima e arrastar para baixo move o modelo
abaixo.

Para efetuar o pan de um modelo

1 Clique em Pan  na barra de ferramentas Navigation Mode.

2 Arraste o botão esquerdo do mouse para efetuar o pan do modelo acima,
abaixo, esquerda e direita.

OBSERVAÇÃO Manter pressionada as teclas SHIFT ou CTRL, ou girar a roda
do mouse, ativa temporariamente o modo Zoom.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Pan

Entrada do comando: Ctrl+6

Modo Orbit

No modo Orbit, a câmera é movida pelo ponto focal do modelo. Neste modo,
a direção acima é sempre mantida.

Navegar em uma cena | 289



Para efetuar a órbita de um modelo

1 Clique em Orbit  na barra de ferramentas Navigation Mode.

2 Para rotacionar a câmera em torno do modelo, arraste o botão esquerdo
do mouse ou as teclas do cursor.

OBSERVAÇÃO Pressionar a tecla SHIFT, ou girar a roda do mouse, ativa
temporariamente o modo normalZoom.

3 Para movimentar a câmera, mantenha pressionada a tecla CTRL ao
arrastar o mouse. A câmera se movimenta para a esquerda e para a direita
e para cima e para baixo.

Como o modo de órbita é centralizado na câmera, este modo difere do
modo normal de pan pelo fato de que a câmera é movida ao invés do
modelo.

Menu:  Interface de usuárioClassic: Viewpoint ➤ Navigation
Mode ➤ Orbit

Entrada do comando: Ctrl+7

Modo Examine

No modoFree Orbit, é possível girar o modelo pelo ponto focal.
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Para examinar o modelo

1 Clique em Examine  na barra de ferramentas Navigation Mode.

2 Para rotacionar o modelo em torno do ponto focal, arraste o botão
esquerdo do mouse ou as teclas do cursor. Se mouse estiver se movendo
quando você solta o botão, o modelo continua a girar. Clicando no
modelo para o giro.

OBSERVAÇÃO Pressionar a tecla SHIFT, ou girar a roda do mouse, ativa
temporariamente o modo normalZoom. Mantendo pressionada a tecla
CTRL, habilita temporariamente o modo normal Pan.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Examine

Entrada do comando: Ctrl+8

Modo Fly

No modo Fly, é possível mover pelo modelo como se estivesse num simulador
de vôo.

Para usar o modo Fly para mover pelo modelo

1 Clique em Fly  na barra de ferramentas Navigation Mode.

2 Mantenha pressionado o botão esquerdo do mouse para mover a câmera
adiante. Com em um simulador de vôo, o botão esquerdo do mouse vira
na esquerda/direita quando arrastado para a esquerda ou direita e inclina
acima/abaixo quando arrastado para cima ou para baixo.

OBSERVAÇÃO Manter pressionada a tecla SHIFT acelera este movimento.
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3 Utilize as teclas do cursor acima e baixo para aproximar ou afastar o
zoom da câmera respectivamente; utilize as teclas do cursor esquerda e
direita para girar a câmera na esquerda e direita respectivamente.

OBSERVAÇÃO Manter pressionada a tecla CTRL rotaciona a câmera em
torno de seu eixo de visualização, enquanto ainda move adiante.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Fly

Entrada do comando: Ctrl+9

Modo Turntable

No modo Turntable, é possível girar o modelo pelo vetor para cima como
se o modelo estivesse em uma mesa giratória. Neste modo, a direção acima é
sempre mantida.

Para girar o modelo em uma mesa giratória

1 Na barra de navegação, clique em Turntable  na barra de ferramentas
Navigation Mode.

2 Arraste o botão esquerdo do mouse para a esquerda e para a direita ou
utilize as teclas do cursor para a esquerda e para a direita para girar a
mesa giratória para a esquerda e para a direita respectivamente.

OBSERVAÇÃO Pressionar a tecla SHIFT, ou girar a roda do mouse, ativa
temporariamente o modo normalZoom. Mantendo pressionada a tecla
CTRL, habilita temporariamente o modo normal Pan.

3 Para inclinar a mesa giratória para cima e para baixo, gire a roda do
mouse, ou use as teclas do cursor para cima e para baixo.
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Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Mode ➤ Turntable

Entrada do comando: Ctrl+0

Ferramenta View All

Faz com que o modelo completo caiba na Vista da cena.

A utilização desta função efetua a elevação e pan da câmera para que todo o
modelo seja mostrado na vista atual, o que é muito útil caso você se perca
dentro de um modelo ou o perde por completo.

Ocasionalmente, você pode obter uma vista em branco. Isto normalmente se
dá porque há itens que são muito pequenos em comparação ao modelo
principal ou itens que estão localizados longe do modelo principal. Nestes
casos, clique com o botão direito num item na Árvore de seleção e clique
em Zoom Selected para voltar ao modelo antes de tentar descobrir quais os
itens "perdidos".

Para visualizar tudo

1 Clique em View All  na barra de ferramentas Navigation Tools.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ View All
Menu de atalho: Scene ➤ View All

Ferramenta Zoom selecionado

Amplia o zoom da câmera para que os itens selecionados preencham a Vista
da cena.

Para visualizar itens selecionados

1 Clique em Zoom Selected  na barra de ferramentas Navigation
Tools.

Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Zoom Selected
Menu de atalho: Scene ➤ Zoom Selected
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ViewCube

A ferramenta de navegação ® ViewCube® da Autodesk fornece o feedback
visual sobre a orientação atual de um modelo. É possível utilizar a ferramenta
ViewCube para ajustar o ponto de vista de seu modelo. O ViewCube não está
disponível em um espaço de trabalho 2D.

Visão geral do ViewCube

A ferramenta ViewCube é uma interface persistente e clicável, que pode ser
arrastada e permite alternar entre vistas de seu modelo.

Ao exibir a ferramenta ViewCube, por padrão, esta é mostrada no canto superior
direito da Vista da cena sobre o modelo em uma estado inativo. A ferramenta
ViewCube fornece feedback visual sobre o ponto de vista atual do modelo
quando ocorrem alterações na vista. Quando o cursor é posicionado sobre a
ferramenta ViewCube, ela se torna ativa. É possível arrastar ou clicar no
ViewCube, alternar para uma das vistas predefinidas disponíveis, rolar a vista
atual ou alterar para a vista Inicial do modelo.

DICA Quando a barra de navegação está vinculada à ViewCube, ambas podem
ser movidas pela Vista da cena. Consulte  Reposicionando e reorientando a barra
de navegação na página 306 para obter mais informações.

Controlar a aparência do ViewCube

A ferramenta ViewCube é exibida em um dos dois estados: inativo ou ativo.
Quando a ferramenta ViewCube está inativa, ela aparece parcialmente
transparente por padrão, para que não obscureça a vista do modelo. Quando
está ativa, ela aparece opaca e pode obscurecer a vista dos objetos na vista
atual do modelo.

Além de controlar o nível de opacidade do ViewCube quando ele está inativo,
também é possível controlar seu tamanho e exibição da bússola. As

294 | Capítulo 5   Explorar seu modelo



configurações usadas para controlar a aparência do ViewCube estão localizadas
no Options Editor.

Utilizar a bússola

A bússola é exibida abaixo da ferramenta ViewCube e indica em qual direção
o Norte está definido para o modelo. É possível clicar em uma letra de direção
cardeal na bússola para rotacionar o modelo, ou arrastar uma das letras de
direção cardeal ou o anel da bússola para rotacionar interativamente o modelo
ao redor do ponto de giro.

Arraste ou clique no ViewCube

Quando você arrasta ou clica na ferramenta ViewCube, a vista do modelo é
reorientada em torno de um ponto de giro. O ponto de giro é exibido no
centro do objeto que foi por último selecionado antes de usar a ferramenta
ViewCube.

Para exibir ou ocultar o ViewCube

■ Clique na guia View painel  ➤ Navigation Aids ➤ ViewCube  .

Para controlar o tamanho do ViewCube

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione uma opção na lista suspensa Size.
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3 Clique em OK.

Para controlar a opacidade de inatividade do ViewCube

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione uma opção na lista suspensa Inactive Opacity.

3 Clique em OK.
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Para exibir a bússola para o ViewCube

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione Show Compass Below the ViewCube.

3 Clique em OK.

A bússola é exibida abaixo da ferramenta ViewCube e indica a direção
norte para o modelo.

Menu do ViewCube

Utilize o menu do ViewCube para restaurar e definir a vista Inicial de um
modelo, alternar entre os modos de projeção, e alterar o comportamento
interativo e a aparência da ferramenta ViewCube.

Para exibir o menu do ViewCube

Para exibir o menu do ViewCube, siga uma das seguintes opções:
■ Clique com o botão direito na bússola, ícone Início, ou na área principal

da ferramenta ViewCube.

■ Clique no botão do menu de contexto localizado abaixo da ferramenta
ViewCube.

O menu do ViewCube possui as seguintes opções:
■ Início. Restaura a vista Início salva com o modelo. Esta vista está

sincronizada com a opção Ir para a vista inicial no menu do SteeringWheels.

■ Perspectiva.Alterna a vista atual para a projeção em perspectiva.

■ Ortogonal. Alterna a vista atual para a projeção ortogonal.

■ Bloquear na seleção. Utiliza os objetos selecionados para definir o centro
da vista quando uma alteração de orientação de vista ocorre com a
ferramenta ViewCube.

OBSERVAÇÃO Se clicar em Início na ferramenta ViewCube, a vista retornará
para a vista Início, mesmo se Bloquear na seleção estiver selecionada.

■ Definir a vista atual como a principal. Define a vista Principal do
modelo com base na vista atual.

■ Definir a vista atual como a frontal. Define a vista "Front" (Frontal)
do modelo.
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■ Reinicializar frontal. Reinicializa a vista Frontal do modelo para sua
orientação-padrão.

■ ViewCube Options.Exibe o Options Editor onde é possível ajustar a
aparência e o comportamento da ferramenta ViewCube.

■ Help. Inicia o sistema de ajuda on-line e exibe o tópico para a ferramenta
ViewCube.

Reorientar a vista de um modelo com o ViewCube

O ViewCube é utilizado para reorientar a vista atual de um modelo. É possível
reorientar a vista de um modelo com a ferramenta ViewCube ao clicar em
áreas predefinidas para definir um pré-ajuste da vista atual, clicar e arrastar
para modificar livremente o ângulo da vista do modelo, e definir e restaurar
a vista Início.

Reorientar a vista atual

A ferramenta ViewCube fornece 26 áreas definidas, onde é possível clicar para
alterar a vista atual de um modelo. As 26 áreas definidas são categorizadas em
três grupos: canto, aresta e face. Das 26 áreas definidas, 6 áreas representam
vistas ortogonais-padrão de um modelo: superior, inferior, frontal, posterior,
esquerda e direita. As vistas ortogonais são definidas ao clicar em uma das
faces na ferramenta ViewCube.

OBSERVAÇÃO Quando o cursor está sobre um das áreas clicáveis da ferramenta
ViewCube, o cursor muda para uma seta com um pequeno cubo para indicar que
ele está sobre a ferramenta ViewCube. Uma dica de ferramenta também é exibida.
A dica de ferramenta descreve a ação que pode ser executada com base na
localização do cursor sobre a ferramenta ViewCube.

As outras 20 áreas definidas são usadas para acessar vistas angulares de um
modelo. Clicar em um dos cantos da ferramenta ViewCube reorienta a vista
atual do modelo para vista de 3/4, com base em um ponto de vista definido
por três lados do modelo. Clicar em uma das extremidades reorienta a vista
do modelo para uma 1/2 vista com base em dois lados do modelo.
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Também é possível clicar e arrastar a ferramenta ViewCube para reorientar a
vista de um modelo para um ponto de vista personalizado diferente dos outros
26 pontos de vista predefinidos. Conforme você arrasta, o cursor é alterado
para indicar que você está reorientando a vista atual do modelo. Se você arrastar
a ferramenta ViewCube perto das orientações predefinidas e ele estiver definido
para alinhar à vista mais próxima, a ferramenta ViewCube vai rotacionar para
a orientação predefinida mais próxima.

O contorno da ferramenta ViewCube auxilia a identificar a forma da orientação
na qual ela se encontra: padrão ou fixa. Quando a ferramenta ViewCube está
na orientação padrão, não orientada para uma das 26 vistas predefinidas, o
seu contorno é exibido como tracejado. A ferramenta ViewCube tem o
contorno em um linha contínua sólida quando é restrita a uma das vistas
predefinidas.

Rotacionar uma face da vista

Quando você exibe um modelo a partir de uma das vistas de face, dois botões
de seta de rolagem são exibidos próximos a ferramenta ViewCube. Utilize as
setas de rolagem para rotacionar a vista atual 90º graus no sentido horário ou
anti-horário em volta do centro da vista.
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Alternar para uma face adjacente

Quando a ferramenta ViewCube está ativa durante a exibição de um modelo
a partir de uma das vistas de face, quatro triângulos ortogonais são exibidos
perto do ViewCube. Utilize estes triângulos para alternar para uma das vistas
de face adjacentes.

Vista frontal

É possível definir a vista Frontal de um modelo para definir a direção das vistas
de face na ferramenta ViewCube. Junto com a vista Frontal, a direção para
cima de um modelo também é usada para definir a direção das vistas de face
na ferramenta ViewCube.

OBSERVAÇÃO A vista frontal é uma configuração global e sempre será mesma
para pontos de visão .

Para reorientar a vista atual para uma orientação predefinida

■ Clique em uma das faces, arestas ou cantos na ferramenta ViewCube.

Para visualizar uma face adjacente

Observação: Assegure-se de que uma vista de face é atual.
■ Clique em um dos triângulos exibidos próximos da extremidade da

ferramenta ViewCube.
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Para reorientar de forma interativa a vista

■ Clique na ferramenta ViewCube, mantenha pressionado o botão esquerdo
do mouse, e arraste na direção em que deseja orbitar o modelo.

Para utilizar transições animadas ao reorientar a vista para uma orientação
predefinida

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione Use Animated Transitions When Switching Views.

Quando marcado, as transições de uma vista para outra aparecem
animadas ao clicar em uma área predefinida na ferramenta ViewCube.

3 Clique em OK.
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Para ajustar automaticamente o modelo após uma reorientação da vista

1 Clique com o botão direito do mouse na ferramenta ViewCube e clique
em ViewCube Options.

2 No Options Editor, na página ViewCube sob o nó Interface ,
selecione Fit-to-View on Change.

3 Clique em OK.

Para rolar uma vista de face

Observação: Assegure-se de que uma vista de face é exibida.
■ Clique em uma da setas de rotação exibidas acima e à direita da ferramenta

ViewCube.

A seta de rotação esquerda rotaciona a vista em 90 graus no sentido
anti-horário e a seta de rotação direita rotaciona a vista 90 graus no sentido
horário.

Para definir a vista frontal

■ Clique com o botão direito na ferramenta ViewCube e clique em Definir
a vista atual como frontal.

Para restaurar a vista frontal

■ Clique com o botão direito na ferramenta ViewCube e clique em Redefinir
o lado frontal.

Definir o modo de projeção da vista

A ferramenta ViewCube possui dois modos de projeção de vista (Perspectiva
e Ortogonal). A projeção Ortogonal é também referida como projeção
paralela. As vistas projetadas em Perspectiva são calculadas com base na
distância da câmera teórica e o ponto alvo. Quanto menor a distância entre
a câmera e o ponto alvo, mais distorcido aparece o efeito de perspectiva; a
distância maior produz menos efeitos distorcidos que afetam o modelo. As
vistas projetadas Ortogonais exibem todos os pontos de um modelo sendo
projetado paralelamente à tela.

O modo de projeção ortogonal torna mais fácil trabalhar com um modelo, já
que todas as arestas do modelo aparecem com o mesmo tamanho,
independentemente da distância da câmera. No entanto, o modo de projeção
ortogonal não é como normalmente você visualiza os objetos no mundo real.

302 | Capítulo 5   Explorar seu modelo



Os objetos no mundo real são visualizados na projeção em perspectiva.
Portanto, quando você deseja gerar uma renderização ou uma vista de linha
oculta de um modelo, a utilização da projeção em perspectiva dará ao modelo
uma aparência mais realista.

A ilustração a seguir mostra o mesmo modelo visto da mesma direção de
visualização, mas com diferentes projeções da vista.

PerspectiveOrthographic

Para alterar o modo de projeção da vista

■ Clique com o botão direito na ferramenta ViewCube e clique em uma
das opções a seguir:
■ Ortogonal

■ Perspectiva

Vista inicial

A vista Início é uma vista especial armazenada com um modelo que torna fácil
para retornar para uma vista conhecida e familiar. É possível definir qualquer
vista do modelo como a vista Início. A vista Início salva pode ser aplicada à
vista atual ao clicar no botão Início acima da ferramenta ViewCube ou no
menu ViewCube.

Para definir a vista Home

■ Clique com o botão direito do mouse na ferramenta ViewCube e clique
em Set Current View as Home.

Entrada do comando: CTRL+SHIFT+Home
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Para reorientar o modelo para a vista Início

■ Clique no botão Home (  ) localizado próximo à ferramenta ViewCube.

■ Clique com o botão direito na ferramenta ViewCube e clique em Início.

Examinar objetos individuais com o ViewCube

É possível bloquear a ferramenta ViewCube para um conjunto de objetos
selecionados. Bloquear uma seleção de objetos para a ferramenta ViewCube
define o centro da vista atual e a distância da vista com base nos objetos
selecionados. Para desativar Lock to Selection, é possível clicar no botão
Lock to Selection  ao lado do botão de visualização Home.

A seleção e o cancelamento da seleção de objetos após a ativação de Bloquear
para a seleção não afeta o centro ou a distância da vista quando ocorre uma
alteração da orientação da vista. Não é possível aplicar o zoom nas extensões
para visualizar um modelo quando Bloquear na seleção estiver ativada, mesmo
que a ferramenta ViewCube seja definida para aplicar zoom nas extensões
após cada alteração de orientação de vista.

Para bloquear a seleção atual

■ Clique com o botão direito na ferramenta ViewCube e clique Bloquear
para a seleção.

Se a opção Bloquear para a seleção estiver marcada quando ocorrer uma
alteração de orientação de vista, os objetos selecionados serão utilizados
para calcular o centro da vista e será efetuado zoom nas extensões dos
objetos selecionados. Quando desmarcada, os objetos selecionados são
utilizados para calcular o centro da vista e o zoom nas extensões do modelo.

Para examinar um objeto individual com o ViewCube

1 No modelo, selecione um ou mais objetos para definir o ponto central
da vista.

2 Clique em uma das localizações predefinidas na ferramenta ViewCube
ou clique e arraste a ferramenta ViewCube para reorientar a vista do
modelo.

A ferramenta ViewCube reorienta a vista do modelo com base no ponto
central dos objetos selecionados.
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Barra de navegação

Ferramentas de navegação unificadas e especificas do produto podem ser
acessadas da barra de navegação.

Visão geral da Barra de navegação

A barra de navegação é um elemento da interface do usuário que permite
acessar ferramentas de navegação unificadas e especificas do produto.

As ferramentas de navegação unificadas (como ® ViewCube ®, 3Dconnexion®

e SteeringWheels®da Autodesk) são as que podem ser encontradas em muitos
produtos da Autodesk. As ferramentas de navegação especificas do produto
são exclusivas daquele produto. A barra de navegação flutua sobre e por um
dos lados da Vista da cena.

As ferramentas de navegação são iniciadas ao clicar em um dos botões na barra
de navegação ou ao selecionar uma das ferramentas de uma lista que é exibida
quando a menor porção de um botão de divisão é clicada.

5. Ferramentas Orbit na página 262.
Conjunto de ferramentas de navegação para

1. ViewCube na página 294 Indica a
orientação atual de um modelo e é utilizada

rotacionar o modelo ao redor de um ponto
de giro enquanto a vista permanece fixa.

para reorientar a vista atual de um modelo.
Clicar neste botão exibe o ViewCube na
Vista da cena quando ele não está visível.

6. Ferramentas Look na página 264.
Conjunto de ferramentas para rotacionar a
vista atual verticalmente e horizontalmente.

2. SteeringWheels na página 309 Coleção
de círculos que oferece a rápida alternância
entre as ferramentas de navegação
especializadas.

7. Ferramentas Walk e Fly na página 265.
Conjunto de ferramentas de navegação para

3. ferramenta Pan na página 261. Ativa a
ferramenta pan e move a vista
paralelamente à tela.
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mover ao redor do modelo e controlar as
configurações de realismo.

3Dconnexion na página 321 Conjunto de
ferramentas de navegação usado para

4. Ferramentas de Zoom na página 261.
Conjunto de ferramentas de navegação para

reorientar a vista atual de um modelo com
um mouse 3D 3Dconnexion.

aumentar ou diminuir a ampliação da vista
atual do modelo.

OBSERVAÇÃO Em uma área de trabalho 2D, somente as ferramentas de navegação
2D (como o SteeringWheels 2D, Pan, Zoom e 3Dconnexion Modo 2D) estão
disponíveis.

Para exibir ou ocultar a barra de navegação

■ Clique na guia View ➤ painel Navigation Aids ➤ Navigation Bar

 .

Reposicionando e reorientando a barra de
navegação

A posição e orientação da barra de navegação podem ser ajustadas ao vinculá-la
à ferramenta ViewCube, encaixá-la quando a ferramenta ViewCube não é
exibida ou posicionando-a livremente em uma das extremidades da janela
atual.

Quando vinculada à ferramenta ViewCube, a barra de navegação é posicionada
abaixo da ferramenta ViewCube em uma orientação vertical. Quando não está
vinculada ou encaixada, a barra de navegação pode ser alinhada livremente
por uma das arestas da Vista da cena.

É possível especificar como a barra de navegação pode ser reposicionada no
menu Personalizar. Quando a barra de navegação não está vinculada com
à ferramenta ViewCube ou encaixada, uma alça de manipulação é exibida.
Arraste o manipulador de controle na barra de navegação para reposicioná-lo
ao longo de um dos lados da Vista da cena.

Caso o lado da Vista da cena no qual a barra de navegação estiver alinhada
não for longo o suficiente para mostrar toda a barra de navegação, esta será
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cortada para caber no mesmo. Quando truncada, o botão More Controls
é exibido e substitui o botão Customize  . Ao clicar no botão Mais
controles, é exibido um menu que contém as ferramentas de navegação que
não estão sendo exibidas no momento.

Para reposicionar a barra de navegação e o ViewCube

1 Na barra de navegação, clique em Personalizar.

2 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  e selecione
Vincular ao ViewCube.

Quando Vincular ao ViewCube está marcado, a barra de navegação e o
ViewCube são reposicionados juntos na tela atual. Quando o ViewCube
não é exibido, a barra de navegação é encaixada na mesma localização
na qual o ViewCube estaria.

3 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  , e a seguir em
uma posição de encaixe disponível.

A barra de navegação e o ViewCube são reposicionados.

Para vincular a posição da barra de navegação ao ViewCube

1 Na barra de navegação, clique em Personalizar.

2 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  e selecione
Vincular ao ViewCube.

Quando Vincular ao ViewCube está marcado, a barra de navegação e o
ViewCube são reposicionados juntos na tela atual.

Para reposicionar livremente a barra de navegação ao longo da extremidade
da janela atual

DICA Em uma área de trabalho 2D, clique na alça de manipulação e arraste a
barra de navegação para reposicioná-la.

1 Na barra de navegação, clique em Personalizar.

2 Clique no menu Personalizar  ➤  Posições de encaixe  ➤  e desmarque
Vincular ao ViewCube.

A alça de manipulação para a barra de navegação é exibida no topo da
barra de navegação.

3 Clique na alça de manipulação e arraste a barra de navegação ao longo
da aresta da janela na qual ele deve ser exibida. Solte o botão no
dispositivo apontador para orientar a barra de navegação ao longo da
borda da janela.
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4 Arraste a barra de navegação ao longo da borda da janela para ajustar
sua posição ao longo da borda da janela.

Controlar a exibição das ferramentas de navegação
na barra de navegação

É possível controlar quais ferramentas de navegação unificadas e específicas
do produto são exibidas na barra de navegação com o menu Customize
(Personalizar).

O menu Personalizar é exibido ao clicar no botão Personalizar no canto inferior
esquerdo da barra de navegação. No menu Personalizar clique nas ferramentas
de navegação que deseja exibir na barra de navegação. A posição das
ferramentas de navegação na barra de navegação é predefinida e não pode ser
alterada.

OBSERVAÇÃO Em um espaço de trabalho 3D, o botão ViewCube será exibido
na barra de navegação somente quando a ferramenta ViewCube estiver oculta na
Scene View. Em uma área de trabalho 2D, o botão ViewCube não está disponível.

Para personalizar a barra de navegação

1 Na barra de navegação, clique em Personalizar.

2 No menu Personalizar clique na ferramenta de navegação que deseja
exibir na barra de navegação.

Uma marca de seleção próxima ao nome da ferramenta de navegação
indica que ela já está exibida na barra de navegação. Desmarque a
ferramenta de navegação para removê-la da barra de navegação.

É possível exibir um menu de atalho para ferramentas na barra de navegação
ao clicar com o botão direito nelas. Os seguintes comandos estão disponíveis
no menu de atalho sempre que forem aplicáveis.

FinalidadeComando

Remove a ferramenta da barra de
navegação. Este é o equivalente à desmarcar

Remover da Barra de navegação

a caixa de seleção relevante no menu
Customize.

Oculta a barra de navegação.Fechar a Barra de navegação
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SteeringWheels

Os SteeringWheels™ são menus de rastreamento que seguem seu cursor, dos
quais é possível acessar diferentes ferramentas de navegação 2D e 3D a partir
de uma única ferramenta.

Visão geral dos SteeringWheels

Os SteeringWheels, também conhecido como círculos, podem economizar
tempo ao combinar muitas das ferramentas de navegação em uma única
interface. Os círculos são específicos ao contexto que um modelo está sendo
visualizado.
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As ilustrações a seguir mostram os diferentes círculos disponíveis:

Círculo de navegação 2D

Círculo de tour do edifício (Círculo
básico)

Círculo de visualização de objetos
(Círculo básico)

Círculo de navegação completa

Minicírculo de tour da construçãoMinicírculo de objeto de vistaMinicírculo de navegação completa

OBSERVAÇÃO SteeringWheels e classic navigation modes na página 283 são
mutuamente exclusivos, de maneira que ao ativar um SteeringWheel desativa o
modo de navegação Classic selecionado.

Exibir e usar os círculos

Pressionar e arrastar em um setor de um círculo é o modo principal de
interação. Após um círculo ser exibido, clique em um dos setores e pressione
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o botão no dispositivo apontador para ativar a ferramenta de navegação.
Arraste para reorientar a vista atual. Ao liberar o botão, retorna-se ao círculo.

Controlar a aparência dos círculos

É possível controlar a aparência dos círculos ao alternar entre os diferentes
estilos de círculos disponíveis, ou ao ajustar o tamanho e opacidade. Os círculos
estão disponíveis em dois tamanhos: grande e mini. O círculo grande é maior
do que o cursor e legendas são exibidas nos setores do círculo. O mini círculo
tem um tamanho similar ao cursor e legendas não são exibidas nos setores do
círculo.

Minicírculo Full Navigation

Círculo grande Full Navigation

O tamanho de um círculo controla o tamanho das seções e das legendas que
aparecem no círculo; o nível de opacidade controla a visibilidade dos objetos
no modelo atrás do círculo.

Controlar dicas de ferramentas para os círculos e as mensagens para
as ferramentas

São exibidas dicas de ferramenta para cada botão do círculo conforme o cursor
passa sobre eles. As dicas de ferramentas aparecem abaixo do círculo e
identificam qual ação será executada se o setor ou botão for clicado.

Similar às dicas de ferramentas, as mensagens de ferramenta e texto do cursor
são exibidos quando se utiliza uma das ferramentas de navegação de um
círculo. As mensagens da ferramenta são exibidas quando uma ferramenta de
navegação está ativa. Elas fornecem instruções básicas sobre como utilizar a
ferramenta. O texto do cursor da ferramenta exibe o nome da ferramenta de
navegação ativa próximo ao cursor. Desativar as mensagens de ferramenta e
texto do cursor somente afeta as mensagens que são exibidas ao utilizar os
minicírculos ou o círculo de navegação grande completo.

Para exibir um círculo

1 Na barra de navegação, clique na seta abaixo do botão SteeringWheels.
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2 Clique no círculo que deseja exibir, por exemplo Full Navigation
Wheel.

Faixa de opções: Guia Viewpoint ➤ painel

Navigate ➤ SteeringWheels
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  SteeringWheels 

Para fechar um círculo

■ Pressione SHIFT+W

Para alterar o tamanho de um círculo

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, na página SteeringWheels sob o nó Interface,
selecione uma opção na lista suspensa Size na área Big Wheels ou Mini
Wheels.

4 Clique em OK.

Para alterar a opacidade de um círculo

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, na página SteeringWheels sob o nó Interface,
selecione uma opção na lista suspensa Opacity na área Big Wheels ou
Mini Wheels.

4 Clique em OK.

Para ativar dicas de ferramentas para círculos

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Show Tooltips na área On-Screen
Messages.
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As dicas de ferramentas são exibidas para os setores e botões em um
círculo quando o cursor passa sobre o círculo.

4 Clique em OK.

Para ativar mensagens de ferramentas para círculos

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Show Tool Messages na área On-Screen
Messages.

As mensagens são exibidas quando ferramentas de navegação são usadas.

4 Clique em OK.

Para ativar o texto do cursor da ferramenta para círculos

1 Exiba um círculo.

2 Clique com o botão direito do mouse no círculo e clique em
SteeringWheels Options.

3 No Options Editor, página SteeringWheels sob o nó Interface,
selecione a caixa de seleção Show Tool Cursor Text na área On-Screen
Messages.

O nome da ferramenta ativa é exibido próximo ao cursor quando a
ferramenta está em uso.

4 Clique em OK.

Menu Wheel

No menu Wheel, é possível alternar entre diferentes círculos e alterar o
comportamento de algumas ferramentas de navegação no círculo atual.

Utilize o menu Círculo para alternar entre os círculos grande e mini que estão
disponíveis, ir para a vista Início, alterar as preferências do círculo atual e
controlar o comportamento das ferramentas de navegação Órbita 3D, Olhar
e Navegar. Os itens do menu disponíveis no menu Círculo são dependentes
do círculo atual e do programa.
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Para exibir o menu Círculo

■ Clique na seta para baixo, no canto inferior direito do círculo, ou clique
com o botão direito do mouse no círculo.

O menu Círculo tem as seguintes opções:
■ Basic View Object Wheel. Exibe o círculo grande View Object.

■ Basic Tour Building Wheel. Exibe o círculo grande Tour Building.

■ Círculo de navegação completa. Exibe o círculo grande Navegação
completa.

■ Advanced Wheels. Exibe o minicírculo View Object, Tour Building ou
Full Navigation wheel.

■ Início. Vai para a vista Inicial salva com o modelo.

OBSERVAÇÃO Esta é a vista Inicial definida utilizando o ViewCube.

■ Fit to Window. Redimensiona e centraliza a vista atual para exibir todos

os objetos na Vista da cena. Isso é o mesmo que clicar em View All
na barra de ferramentas Navigation Tools na interface de usuário Classic.

■ Restaurar o centro original.Restaura o ponto central da vista para as
extensões do modelo.

■ Level Camera. Rotaciona a vista atual para que seja relativa ao plano de
chão XY.

■ SteeringWheels Options. Exibe o Options Editor onde é possível
ajustar a aparência de o comportamento do SteeringWheels.

■ Help. Inicia o sistema de ajuda on-line e exibe o tópico para o
SteeringWheels.

■ Close Wheel. Fecha o círculo.

Círculos Visualização de objetos

Com os círculos (mini e grande) Visualização de objetos, é possível visualizar
objetos individuais ou recursos em um modelo. O círculo grande Visualização
de objetos é otimizado para novos usuários 3D, enquanto que o minicírculo
Visualização de objetos é otimizado para usuários 3D experientes.
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Círculo grande Visualização de objetos

Os setores do círculo grande de visualização de objeto têm as seguintes opções:

■ Centro na página 266. Especifica um ponto no modelo para ajustar o
centro da vista atual, ou para alterar o ponto alvo usado por algumas
ferramentas de navegação.

■ Zoom na página 280. Ajusta a ampliação da vista atual.

■ Rebobinar na página 275. Restaura a orientação mais recente da vista.
É possível mover para trás ou para frente ao clicar e arrastar para esquerda
ou direita.

■ Órbita na página 270. Rotaciona a vista atual em torno de um ponto de
giro fixo.

Minicírculo de visualização de objetos

Os setores do minicírculo de visualização de objeto têm as seguintes opções:

■ Zoom (Círculo superior) na página 280. Ajusta a ampliação da vista
atual.

■ Rebobinar (Círculo direito) na página 275. Restaura a vista mais
recente. É possível mover para trás ou para frente ao clicar e arrastar para
esquerda ou direita.

■ Pan (Círculo inferior) na página 261. Reposiciona a vista atual ao
efetuar o pan.

■ Órbita (Círculo esquerdo) na página 270. Rotaciona a vista atual em
torno de um ponto de pivô fixo.
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OBSERVAÇÃO Quando o minicírculo é exibido, é possível pressionar e segurar o
botão do meio do mouse para efetuar a panorâmica, rolar o botão de rolagem
para aumentar ou diminuir o zoom, e manter pressionada a tecla Shift enquanto
pressiona e segura o botão do meio do mouse para orbitar o modelo.

Para alternar para o minicírculo View Object

■ Clique com o botão direito do mouse no círculo, e clique em Advanced
Wheels ➤ Mini View Object Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Mini View
Object Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsMini View Object
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Mini

View Object Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Mini View Object Wheel 

Para alternar para o círculo grande View Object

■ Clique com o botão direito no círculo, e clique em Basic View Object
Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Basic View
Object Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsBasic View Object
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  View

Object Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  View Object Wheel 

Círculos Tour do edifício

Com os círculos (grande e mini) Tour o edifício, é possível mover através de
um modelo, como um edifício, uma linha de montagem, navio ou plataforma
de petróleo. Você pode também andar e navegar em torno de um modelo. O
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círculo grande Tour do edifício é otimizado para novos usuários 3D, enquanto
que o minicírculo Tour do edifício é otimizado para usuários 3D experientes.

Círculo grande Tour do edifício

Os setores do círculo grande de tour do edifício têm as seguintes opções:

■ Adiante na página 267. Ajusta a distância entre o ponto atual da vista e
o ponto de pivô definido do modelo. Clicar uma vez move para frente a
meia distância do objeto clicado.

■ Olhar.  Gira a vista atual.

■ Rebobinar. Restaura a vista mais recente. É possível mover para trás ou
para frente ao clicar e arrastar para esquerda ou direita.

■ Ferramenta para cima/para baixo. Desliza a vista atual de um modelo
ao longo do eixo Z de um modelo.

Minicírculo Tour do edifício

Os setores do minicírculo de tour do edifício têm as seguintes opções:

■ Navegar (Círculo superior). Simula a navegação no modelo.

■ Rebobinar (Círculo direito). Restaura a vista mais recente. É possível
mover para trás ou para frente ao clicar e arrastar para esquerda ou direita.

■ Acima/Acima (Círculo inferior). Desliza a vista atual de um modelo
ao longo do eixo Z de um modelo.

■ Olhar (Círculo esquerdo).  Gira a vista atual.

OBSERVAÇÃO Quando o minicírculo é exibido, é possível pressionar e segurar o
botão do meio do mouse para efetuar a panorâmica, rolar o botão de rolagem
para aumentar ou diminuir o zoom, e segurar a tecla Shift enquanto pressiona e
segura o botão do meio do mouse para orbitar o modelo.
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Para alternar para o minicírculo Tour do edifício

■ Clique com o botão direito do mouse no círculo e clique em Advanced
Wheels  ➤ Mini Tour Building Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Mini Tour
Building Wheel
Faixa de opções: Guia Viewpoint painel

Navigate ➤  ➤ SteeringWheelsMini Tour Building
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Mini

Tour Building Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Mini Tour Building Wheel 

Para alternar para o círculo grande Tour Building

■ Clique com o botão direito no círculo, e clique em Basic Tour Building
Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Basic Tour
Building Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsBasic Tour Building
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Tour

Building Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Tour Building Wheel 

Círculos Navegação completa

Os círculos Navegação completa (grande e mini) combinam as ferramentas de
navegação 3D comuns encontradas nos círculos Visualização de objetos e Tour
do edifício. Os círculos Navegação completa grande e mini são otimizados
para usuários 3D experientes.
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OBSERVAÇÃO Quando um dos círculos Navegação completa é exibido, é possível
pressionar e segurar o botão do meio do mouse para efetuar pan, rolar o botão
de rolagem para aumentar ou diminuir o zoom, e segurar a tecla Shift enquanto
segura o botão do meio do mouse para orbitar o modelo.

Círculo grande Navegação completa

Os setores do círculo grande de navegação completa têm as seguintes opções:

■ Zoom. Ajusta a ampliação da vista atual.

■ Rebobinar. Restaura a vista mais recente. É possível mover para trás ou
para frente ao clicar e arrastar para esquerda ou direita.

■ Pan. Reposiciona a vista atual ao efetuar o pan.

■ Órbita. Rotaciona a vista atual em torno de um ponto de pivô fixo.

■ Centro. Especifica um ponto no modelo para ajustar o centro da vista
atual, ou para alterar o ponto alvo usado por algumas ferramentas de
navegação.

■ Navegar. Simula a navegação no modelo.

■ Olhar.  Gira a vista atual.

■ Acima/Abaixo. Desliza a vista atual de um modelo ao longo do eixo Z
do modelo.

Minicírculo Navegação completa

Os setores do minicírculo de navegação completa têm as seguintes opções:

■ Zoom (Círculo superior). Ajusta a ampliação da vista atual.

■ Navegar (Círculo superior direito). Simula a navegação no modelo.

■ Rebobinar (Círculo direito). Restaura a vista mais recente. É possível
mover para trás ou para frente ao clicar e arrastar para esquerda ou direita.
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■ Acima/Abaixo (Círculo inferior direito). Desliza a vista atual de um
modelo ao longo do eixo Z do modelo.

■ Pan (Círculo inferior). Reposiciona a vista atual ao efetuar o pan.

■ Olhar (Círculo inferior esquerdo).  Gira a vista atual.

■ Órbita (Círculo esquerdo). Rotaciona a vista atual em torno de um
ponto de pivô fixo.

■ Centro (Circulo superior esquerdo). Especifica um ponto no modelo
para ajustar o centro da vista atual, ou para alterar o ponto alvo usado por
algumas ferramentas de navegação.

Para alternar para o minicírculo Navegação completa

■ Clique com o botão direito do mouse no círculo e clique em Advanced
Wheels ➤ Mini Full Navigation Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Mini Full
Navigation Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsMini Full Navigation
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Mini Full

Navigation Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Mini Full Navigation Wheel 

Para alternar para o círculo grande Full Navigation

■ Clique com o botão direito do mouse no círculo e clique no círculo Full
Navigation Wheel.

Barra de ferramentas: Navigation bar  ➤  SteeringWheels  ➤  Full
Navigation Wheel
Faixa de opções: Guia Viewpoint ➤ painel Navigate ➤ Steering

WheelsFull Navigation
Menu:  Interface de usuárioClassic: View  ➤  SteeringWheels  ➤  Full

Navigation Wheel
Barra de ferramentas:  Interface de usuário Classic: Navigation Mode

 ➤  Full Navigation Wheel 
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Círculo de navegação 2D

Com este círculo é possível acessar ferramentas de navegação 2D básicas. É
particularmente útil quando você não tem um dispositivo apontador com um
roda de rolagem.

Os setores do círculo de navegação 2D têm as seguintes opções:
■ Pan. Reposiciona a vista atual ao efetuar o pan.

■ Zoom. Ajusta a ampliação da vista atual.

■ Rebobinar. Restaura a orientação mais recente da vista. É possível mover
para trás ou para frente ao clicar e arrastar para esquerda ou direita.

Mouse 3D 3Dconnexion

Um mouse 3D 3Dconnexion pode ser usado como uma alternativa ao mouse
para mover ao redor da Scene View.

O dispositivo tem uma cápsula de controle sensível à pressão projetada para
flexionar em todas as direções. Puxe, empurre, gire ou incline a cápsula para
efetuar o pan, zoom e rotacionar a vista atual. A velocidade de navegação é
sensível ao montante de força aplicada no dispositivo 3Dconnexion. É possível
ajustar as configurações do dispositivo ao utilizar o Painel de controle para o
dispositivo que é fornecido pelo fabricante com a instalação.
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Quando ocorre uma alteração na vista com o mouse 3D 3Dconnexion, a
ferramenta ViewCube é reorientada para refletir a vista atual. Você pode alterar
o comportamento do mouse 3D 3Dconnexion a partir da barra de navegação.

Opções do 3Dconnexion na barra de navegação

ExemploDescriçãoOpção

Mova a cápsula de controle para a direita
para efetuar o pan da vista para a direita.

Navega e reorienta a vista na
direção da cápsula de
controle.

Modo de
objeto

Mova a cápsula de controle adiante para
navegar em direção do modelo.

Simula a navegação através
do modelo. A vista do modelo
é movida na direção oposta

Modo de
navegação

da cápsula de controle. A
orientação e a altura da vista
atual são mantidas.

Mova a cápsula de controle para elevar
a vista. Isso faz parecer que o modelo
está se movendo para baixo.

Simula o voo através do
modelo. A vista do modelo é
movida na direção oposta da
cápsula de controle. A

Modo de voo

orientação e altura da vista
atual não é mantida.
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Opções do 3Dconnexion na barra de navegação

ExemploDescriçãoOpção

Mova a cápsula de controle para efetuar
o pan e zoom na vista.

Navega na vista usando
somente as opções de
navegação 2D. A vista move

Modo 2D

na direção da cápsula de
controle.

Clique no modelo. A vista é centralizada
no modelo com base no ponto
especificado.

Especifica um ponto para
definir o ponto de giro e o
centraliza o modelo naquele
ponto. Este ponto de giro é

Ferramenta
Centro

usado por ferramentas
subsequentes de navegação
até ser movida.

Ajuste a velocidade de translação e
rotação.

Controla o modo de
navegação padrão e a
velocidade de conversão e

Configurações
3Dconnexion

rotação do mouse 3D
3Dconnexion no Options
Editor na página 828

Se você estiver usando a interface do usuário Classic, o comportamento do
dispositivo 3Dconnexion corresponde à ferramenta da barra de navegação na
página 261 ou ao modo de navegação na página 283. Isso permite navegar com
o dispositivo 3Dconnexion enquanto executa outras operações com o mouse.
Se nenhuma ferramenta ou modo de navegação for selecionado ou se a
ferramenta ou modo selecionado não for um modo válido para o dispositivo
3Dconnexion, então o modo de navegação padrão será usado.

Usar Chaves de gerenciamento da vista no mouse 3D 3Dconnexion

Você pode acessar as diferentes vistas (como Superior, Frontal, Esquerda, Direita
ou Inicial) com os botões disponíveis em alguns modelos de mouse 3D
3Dconnexion. Use o Editor de configuração de botão para personalizar as
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operações destes botões. Quando você clica em qualquer destes botões no
dispositivo, poderá
■ Ajustar a vista nas extensões do modelo. Rotaciona a vista do objeto

em torno do centro da cena e afasta o zoom para que a cena caiba na
viewport.

■ Reorientar a vista atual para uma orientação predefinida. Retorna
a vista do objeto para uma vista predeterminada.

■ Manter a sensibilidade da seleção. Reorienta o modelo em torno de
um ponto de giro definido com base na seleção atual.

■ Manter bloqueado na seleção. Quando a opção Bloquear na seleção
estiver ativada na ferramenta ViewCube, a vista do objeto é reorientada
em torno do centro predefinido do objeto selecionado.

Câmera

O Autodesk Navisworks oferece diversas opções prefixadas para controlar a
projeção, posição e orientação da câmera durante a navegação.

Definir a projeção da câmera

Você pode utilizar uma câmera em perspectiva ou uma câmera ortogonal
durante a navegação, somente em um espaço de trabalho 3D. Em um espaço
de trabalho 2D, a câmera ortogonal sempre é utilizada.

OBSERVAÇÃO Câmaras ortogonais não estão disponíveis com as ferramentas de
navegação Walk e Fly.

Para utilizar uma câmera em perspectiva

■ Clique na guia Viewpoint ➤ painel Camera ➤ Perspective  .

Menu:  Interface do usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Perspective

Para utilizar uma câmera ortogonal

■ Clique na guia Viewpoint ➤ painel Camera ➤ Orthographic  .
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Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Orthographic

Controlar o campo de visão

É possível definir a área da cena que pode ser visualizada através da câmera
somente em um espaço de trabalho 3D.

Para o ponto de vista atual, é possível mover o deslizador FOV na faixa de
opções para ajustar o Horizontal Field of View. Para pontos de visão
anteriormente salvos, você pode usar a caixa de diálogo Editar ponto de visão
na página 796 para ajustar os valores dos ângulos de visão vertical e horizontal.

OBSERVAÇÃO Quando você modifica o Horizontal Field of View, o Vertical Field
of View é automaticamente ajustado, e vice-versa, para coincidir com a relação
de aspecto no Autodesk Navisworks.

Para controlar o campo de visão horizontal

■ Clique na guia Viewpoint painel  ➤ Camera e mova o controle deslizante
FOV para controlar o ângulo de vista da câmera.

Mover o deslizador para a direita produz um ângulo de visão mais amplo,
e mover o deslizador para a esquerda produz um ângulo de visão mais
estreito, ou mais focado.

Posição e foco da câmera

É possível ajustar a posição e a orientação da câmera na cena.

Mover a câmera

Para o ponto de vista atual, você pode usar as caixas de entrada Position na
faixa de opções para mover a posição da câmera. Para pontos de visão salvos
anteriormente, você pode usar a caixa de diálogo Editar ponto de visão na
página 796 para ajustar os valores da câmera.

OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.
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Para mover a câmera numericamente

1 Clique na guia Ponto de visão, e deslize o painel Câmera.

2 Digite os valores numéricos nas caixas de entrada Position para mover
a câmera pelo valor inserido.

Rotacionar a câmera

É possível ajustar o ângulo da câmera durante a navegação somente em um
espaço de trabalho 3D.

Para o ponto de visão atual, use a janela Inclinar para rotacionar a câmera
acima e abaixo e caixa de entrada Roll na faixa de opções para rotacionar a
câmera para a direita/esquerda. Para pontos de visão salvos, você pode usar a
caixa de diálogo Editar ponto de visão na página 796 para ajustar os valores da
câmera.

janela Inclinar

O ângulo de inclinação nas unidades da cena abaixo (negativo) ou acima
(positivo) de horizontal (0) na base da janela.

É possível usar a janela Inclinarcom a ferramenta Navegarna barra de
navegação, para olhar para cima e para baixo. Se houver uma roda de rolagem
no mouse, você poderá utilizá-la para ajustar o ângulo de inclinação.
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Para alternar a janela Inclinar

■ Clique na guia Viewpoint ➤ painel Camera ➤ Show Tilt Bar  .

Entrada do comando: CTRL + F7

Para rolar a câmera para cima/para baixo

■ Arraste o controle deslizante acima e abaixo na janela Inclinar para rolar
a câmera.

Também é possível digitar valores diretamente na caixa de entrada na base
da janela Inclinar. Um valor positivo rotaciona a câmera no sentido para
cima, e um valor negativo rotaciona para baixo. Digitar 0 nivela a câmera.

Para rolar a câmera para esquerda/direita

■ Clique na guia Ponto de visão, e deslize o painel Camera.

■ Digite um valor na caixa de entrada Roll para rotacionar a câmera ao redor
do eixo frontal-traseiro.

Um valor positivo rotaciona a câmera no sentido anti-horário e um valor
negativo rotaciona no sentido horário.

OBSERVAÇÃO Este valor não é editável quando o vetor superior do ponto de
vista permanece em pé (isto é, quando você usa as ferramentas de navegação
Walk, Orbit e Constrained Orbit).

Mover o ponto focal

É possível alterar o ponto focal da câmera. Para o ponto de vista atual, use as
caixas de entrada Look At na faixa de opções. Para pontos de visão salvos,
você pode usar a caixa de diálogo Editar ponto de visão na página 796 para
ajustar os valores da câmera.

OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.

Em um espaço de trabalho 3D, também é possível colocar a Scene View no
modo de foco, o qual gira eficazmente a câmera, de maneira que o ponto
clicado esteja no centro da vista. Consulte Foco na página 334.
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Para mover o ponto focal da câmera

1 Clique na guia Ponto de visão, e deslize o painel Camera.

2 Digite os valores numéricos nas caixas de entrada Look At para mover
o ponto focal da câmera pela quantidade inserida.

Colocar a câmera reta

É possível colocar a câmera reta para alinhar com o vetor acima do ponto de
vista, somente em um espaço de trabalho 3D.

Quando a câmera está próxima do vetor acima do ponto de vista (dentro de
13 graus), você pode utilizar esta função para efetuar o snap da câmera no
eixo apropriado.

DICA O mesmo efeito pode ser alcançado ao digitar 0 na base da janela Inclinar.

Para colocar a câmera reta

■ Clique na guia Viewpoint ➤ painel Camera ➤ menu suspenso Align
Camera ➤ Straighten  .

Vistas de câmera predefinidas

No Autodesk Navisworks, é possível alinhar a câmera a um dos eixos ou
selecionar uma das seis vistas de face predefinidas para alterar instantaneamente
a posição da câmera e a orientação da cena. Esta função está disponível somente
em um espaço de trabalho 3D.

Quando você alinha a posição da câmera ao longo de um dos eixos:
■ Alinhar com o eixo X alterna entre as vistas de face frontais e traseiras.

■ Alinhar com o eixo Y alterna entre as vistas de face esquerda e direita.

■ Alinhar com o eixo Z alterna entre as vistas de face superiores e inferiores.

OBSERVAÇÃO É possível personalizar a localização da face frontal usando a
ferramenta ViewCube. Esta alteração é global e afeta todos os pontos de visão .
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Para alinhar com o eixo X

■ Clique na guia Viewpoint ➤ painel Camera ➤ menu suspenso Align
Camera ➤ Align X  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Align X

Para alinhar com o eixo Y

■ Clique na guia Viewpoint painel  ➤ Camera ➤  menu suspenso Align
Camera ➤ Align Y  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Align Y

Para alinhar com o eixo Z

■ Clique na guia Viewpoint ➤ painel Camera ➤ menu suspenso Align
Camera ➤ Align Z  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Align Z

Para olhar de uma vista de face predefinida

■ Clique com o botão direito do mouse em Scene View e clique em
Viewpoint ➤ Look From.

■ Clique em uma das vistas de face. Escolha entre:
■ Top

■ Bottom

■ Front

■ Back

■ Left

■ Right
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Auxílios de navegação

Head-Up Display

Os elementos de exibição instantânea (HUD)são exibições na tela que fornecem
informações sobre sua localização e orientação no espaço de trabalho 3D. Essa
função não está disponível em um espaço de trabalho 2D.

No Autodesk Navisworks, é possível utilizar os seguintes elementos de exibição
instantânea (HUD):
■ Eixos X Y Z. Mostra a orientação X, Y, Z da câmera (ou o olho de avatar

se o avatar estiver visível). O indicador dos Eixos XYZ está localizado na
parte inferior esquerda da Vista da cena.

■ Position Readout Mostra a posição absoluta X, Y, Z da câmera (ou a
posição do olho de avatar se o avatar estiver visível). O indicador Position
Readout está localizado na parte inferior esquerda da Vista da cena.

Para alternar os eixos XYZ

1 Clique na guia View painel  ➤ Navigation Aids menu suspenso
 ➤ HUD.

2 Selecione ou desmarque a caixa de seleção XYZ Axes.

Para alternar a leitura da posição

1 Clique na guia View painel  ➤ Navigation Aids menu suspenso
 ➤ HUD.

2 Selecione ou desmarque a caixa de seleção Position Readout.
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Vistas de referência

As vistas de referência são úteis para obter uma visão geral de onde você está
em toda a cena e para mover com rapidez a câmera para uma localização em
um modelo grande. Esta função está disponível em um espaço de trabalho
3D.

Há dois tipos de vistas de referência disponíveis no Autodesk Navisworks:
■ Section View

■ Plan View

As vistas de referência mostram uma vista fixa do modelo. Por padrão, a vista
de corte mostra a vista de frente do modelo e a vista de planta mostra uma
vista superior do modelo.

As vistas de referências são exibidas dentro das janelas encaixáveis. Um
marcador triangular representa seu ponto de vista atual. Este marcador move
quando você navega, mostrando a direção de sua vista. O marcador também
pode ser arrastado ao manter pressionado o botão esquerdo do mouse sobre
ele e arrastando para mover a câmera na Vista da cena.

OBSERVAÇÃO O marcador muda para um ponto pequeno quando a vista de
referência está no mesmo plano da vista da câmera.

Para usar a Plan View

1 Clique na guia View ➤ painel Navigation Aids ➤ menu suspenso
Reference Views ➤ caixa de seleção Plan View.

A janela Plan View é aberta com a vista de referência do modelo.
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2 Arraste o marcador triangular na vista de referência para uma nova
localização. A câmera na Vista da cena muda sua posição para coincidir
com a posição do marcador na vista.

Alternativamente, navegue para um localização diferente na Vista da
cena. O marcador triangular na vista de referência muda sua posição
para coincidir com a posição da câmera na Vista da cena.

3 Para manipular uma vista de referência, clique com o botão direito do
mouse em qualquer lugar da janela Plan View. Utilize o menu de atalho
para ajustar a vista como desejado.

Entrada do comando: CTRL + F9

Para usar a Section View

1 Clique na guia View ➤ painel Navigation Aids ➤ menu suspenso
Reference Views ➤ caixa de seleção Section View.

A janela Section View é aberta com a vista de referência do modelo.

2 Arraste o marcador triangular na vista de referência para uma nova
localização. A câmera na Vista da cena muda sua posição para coincidir
com a posição do marcador na vista.

Alternativamente, navegue para um localização diferente na Vista da
cena. O marcador triangular na vista de referência muda sua posição
para coincidir com a posição da câmera na Vista da cena.

3 Para manipular uma vista de referência, clique com o botão direito em
qualquer lugar da janela Section View. Utilize o menu de atalho para
ajustar a vista como desejado.

Entrada do comando: CTRL + F10
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Clicar com o botão direita na janela Section View ou  Plan View abre o
menu de atalho com as seguintes opções.

DescriçãoOpção

Permite definir a vista de referência para um
dos pontos de visão predefinidos. Escolha

Look From

a partir de: Superior, Inferior, Frontal,
Posterior, Esquerda, Direita, ou Ponto
de visão atual. Selecionar a opção Ponto
de visão atual define a vista de referência
à vista no ponto de visão da navegação
ativa.

Define o ponto de vista de navegação ativo
para a vista na vista de referência.

Atualizar o ponto de visão atual

Abre a caixa de diálogo Editar ponto de
visão e permite modificar as configurações
para a vista de referência correspondente.

Editar o ponto de visão

Instrui o Autodesk Navisworks a coincidir a
proporção da vista de referência com aquela

Lock Aspect Ratio

do ponto de vista atual na Scene View. A
coincidência é feita mesmo quando você
redimensiona a janela com a vista de
referência. Isto em geral irá colocar listras
cinzas no topo ou na parte inferior ou em
qualquer lado da vista de referência.

Redesenha a vista de referência com base
na configuração atual. O desenho da vista

Atualizar

de referência utiliza o software OpenGL e,
portanto, pode levar alguns segundos para
modelos grandes.

Abre a ajuda sensível ao contexto.Help
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Foco

É possível colocar a Vista da cena no modo de foco até o próximo clique.

Quando você estiver no modo de foco, clicar em um item gira a câmera para
que o ponto clicado esteja no centro da vista. Esse ponto se torna o ponto
focal para as ferramentas Órbita (SteeringWheels e barra de navegação) somente
em um espaço de trabalho 3D.

Na interface de usuário Classic, espaço de trabalho 3D, esse ponto se torna
o ponto focal para os modos de navegação clássicos na página 283 examinar,
órbita e mesa giratória.

Em uma área de trabalho 2D, a câmera é movida para o centro da caixa do
item em foco enquanto o valor de Z permanece o mesmo.

Para focar em um item

■ Clique na guia Item Tools ➤ painel Look At ➤ Focus on Item 
.

Barra de ferramentas: Navigation bar  ➤  ferramentas Look  ➤  Focus
Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Focus
Menu de atalho: Scene  ➤  Focus

Armazenar

Ao navegar por um modelo no Autodesk Navisworks, é possível "pegar" ou
segurar itens selecionados e movimentar com eles pelo modelo.

Por exemplo, você pode estar visualizando uma planta para uma fábrica e
gostaria de ver diferentes configurações de layouts de máquina.

Para armazenar e liberar objetos

1 Selecione os objetos que você deseja armazenar na Vista da cena ou
na Selection Tree.

2 Clique na guia Item Tools painel  ➤ Hold ➤ Hold  .
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Os objetos selecionados agora estão seguros e serão movidos com você
pelo modelo quando usar as ferramentas de navegação, tais como
Navegar, Pan e assim por diante.

3 Para liberar objetos armazenados, clique novamente em Hold  na
faixa de opções.

4 Se desejar redefinir os objetos às suas posições originais, clique na guia

Item Tools ➤ painel Transform ➤ Reset Transform  .

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Hold

Controlar o realismo de sua navegação
Quando você navega em um modelo 3D, é possível utilizar as ferramentas de
realismo na guia Viewpoint painel  ➤ Navigate para controlar a velocidade
e o realismo de sua navegação. As ferramentas de realismo não estão disponíveis
em uma área de trabalho 2D.

Gravity

OBSERVAÇÃO Esta função somente funciona em conexão a uma colisão.

A colisão lhe fornece massa e a gravidade lhe fornece peso. Com tal, você
(como o volume de colisão) será puxado para baixo ao navegar através da
cena.

OBSERVAÇÃO A gravidade só pode ser usada com a ferramenta de navegação
Walk.

Isto permite descer as escadas, por exemplo, ou seguir o terreno.

Para alternar a gravidade

■ Ao usar a ferramenta Walk, clique na guia Viewpoint ➤ painel

Navigate ➤ menu suspenso Realism  ➤ caixa de seleção
Gravity.
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Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Gravity
Entrada do comando: Ctrl+G

Crouching

OBSERVAÇÃO Esta função somente funciona em conexão a uma colisão.

Ao navegar ou voar em torno de um modelo com a colisão ativada, você pode
encontrar objetos que estão muito baixos para navegar abaixo dos mesmos,
uma tubulação baixa por exemplo. Esta função permite agachar sob quaisquer
destes tipos de objetos.

Com agachar ativado, você irá automaticamente se agachar sob qualquer
objeto que não pode ser navegado sob o mesmo com sua altura especificada,
portanto, não impedindo sua navegação em torno do modelo.

DICA Para se agachar temporariamente sob um objeto baixo, mantenha
pressionada a barra de espaço para permitir que a navegação prossiga.

Para alternar agachar-se

1 Ao usar a ferramenta Walk ou Fly, clique na guia Viewpoint ➤ painel

Navigate ➤ menu suspenso Realism  ➤ caixa de seleção
Crouch.

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Crouch

Collision

Esta função lhe define como um volume de colisão - um objeto 3D que pode
navegar e interagir com o modelo, obedecendo determinadas regras físicas
que lhe confinam dentro do próprio modelo. Em outras palavras, você tem
uma massa e como tal não pode passar através de outros objetos, pontos ou
linhas na cena.

Você pode navegar por cima ou subir nos objetos na cena que estejam a meia
altura do volume de colisão, portanto, permitindo subir escadas, por exemplo.
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O volume de colisão, em sua forma básica, é uma esfera (com um raio = r),
que pode receber a extrusão para lhe fornecer altura (com altura = h >= 2r).
Veja o diagrama abaixo:

As cotas do volume de colisão podem ser personalizadas para o ponto de vista
atual ou como uma opção global.

OBSERVAÇÃO A colisão somente pode ser usada com as ferramentas de navegação
Walk e Fly.

Quando a colisão está ativada, a priorização da renderização é mudada, para
que os objetos em torno da câmera ou avatar sejam exibidos com muito mais
detalhes do que o normal. O tamanho da região de alto detalhe tem base no
raio do volume de colisão e na velocidade do movimento (sendo necessário
ver para o que se deve navegar).

Para alternar a colisão

1 Ao usar a ferramenta Walk ou Fly, clique na guia Viewpoint painel

 ➤ Navigate menu suspenso  ➤ Realism caixa de seleção 
 ➤ Collision.

Menu:  Interface de usuário Classic: Viewpoint  ➤  Navigation Tools  ➤ 

Collision
Entrada do comando: Ctrl+D
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Third Person View

Esta função permite navegar na cena de uma perspectiva de uma terceira
pessoa.

Quando a terceira pessoa está ativada, você será capaz de ver um avatar que
é uma representação de si próprio dentro do modelo 3D. Ao navegar você
estará controlando a interação do avatar com a cena atual.

Utilizar a terceira pessoa em conexão com a colisão e gravidade torna esta uma
poderosa função, permitindo-lhe visualizar exatamente como uma pessoa iria
interagir com o projeto intencionado.

Você pode personalizar as configurações, como a seleção do avatar, cota e
posicionamento, para o ponto de vista atual ou como uma opção global.

Quando a vista de terceira pessoa está ativada, a priorização da renderização
muda, para que os objetos em torno da câmera ou do avatar, sejam exibidos
com muito mais detalhes do que o normal. O tamanho da região de alto
detalhe tem base no raio do volume de colisão e na velocidade do movimento
(sendo necessário ver para o que se deve navegar), e a distância da câmera
atrás do avatar (para poder ver como que o avatar está interagindo).

Para alternar a vista da terceira pessoa

1 Clique na guia Viewpoint ➤ painel Navigate ➤ menu suspenso

Realism  ➤ caixa de seleção Third Person.
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Menu:  Interface de usuário Classic: Viewpoint ➤ Navigation
Tools ➤ Third Person

Entrada do comando: Ctrl+T

Para adicionar e utilizar um avatar personalizado

ATENÇÃO: A Autodesk não recomenda ou suporta a utilização de avatars
personalizados.

1 Abra o arquivo que deseja usar como avatar (DWG, SKP e assim por
diante) no Autodesk Navisworks.

2 Clique no botão do aplicativo  ➤ Save As.

3 Na caixa de diálogo Save As selecione .nwd na caixa Save as Type.

4 Navegue para o diretório de instalação do Autodesk Navisworks, por
exemplo: C:\Program Files\Autodesk\Navisworks Manage

2012\avatars\my_new_folder_name.

5 Digite o novo nome para seu arquivo de avatar e clique em Save.

6 Reinicie o Autodesk Navisworks e abra qualquer arquivo.

7 Clique no botão do aplicativo  ➤ Options.

8 No Options Editor, expanda o nó Interface, e clique na opção Ponto
de visão Defaults.

9 Clique no botão Settings na área Collision.

10 Na caixa de diálogo Default Collision, selecione a caixa de verificação
Ativar na área Third Person.

11 Selecione seu avatar na lista suspensa Avatar.

12 Clique em OK para retornar ao Options Editor.

13 Você também pode alterar o tamanho do avatar ao alterar os valores
Height e Radius na área Viewer.

14 Clique em OK.

15 Reinicie o Autodesk Navisworks.

Para alterar o avatar padrão

1 No Autodesk Navisworks, clique no botão do aplicativo  ➤ Options.
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2 No Options Editor, expanda o nó Interface e clique na opção
Viewpoint Defaults.

3 Clique no botão Configurações na área Colisão.

4 Na caixa de diálogo Colisão padrão, selecione a caixa de seleção Ativar
na área Terceira pessoa.

5 Clique em OK para retornar ao Editor de opções.

6 Clique em OK.

7 Reinicie o Autodesk Navisworks.

Para ativar ou desativar um avatar para o ponto de vista atual

1 No Autodesk Navisworks, clique na guia Viewpoint ➤ painel Save,

Load & Playback ➤ Edit Current Viewpoint  na faixa de opções.

2 Na caixa de diálogo Editar ponto de vista , clique no botão
Configurações na área Colisão.

3 Na caixa de diálogo Colisão, selecione a caixa de seleção Ativar na área
Terceira pessoa.

4 Selecione seu novo avatar na lista suspensa Avatar.

5 Clique em OK para retornar para a caixa de diálogo Editar ponto de
vista .

6 Clique em OK.
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Controlar a aparência
do modelo e a
qualidade de
renderização

Controlar a aparência do modelo
Você pode usar as ferramentas no painel Render Style na guia Viewpoint
para controlar como o seu modelo é exibido na Scene View.

As opções de iluminação interativa a seguir podem ser selecionadas (Full Lights,
Scene Lights, Head Light, ou No Lights), quatro modos de renderização
(Full Render, Shaded, Wireframe, or Hidden Line) e é possível ativar ou
desativar cada um dos cinco tipos primitivos (Surfaces, Lines, Points, Snap
Points e Text).

OBSERVAÇÃO Os modos Render (Renderização) e Lighting (Iluminação) não estão
disponíveis em uma área de trabalho 2D.

Selecionar o modo de renderização

A renderização atribui sombras à geometria da cena utilizando a iluminação
que foi definida e as configurações dos materiais e do ambiente selecionadas
(como o fundo).

No Autodesk Navisworks, é possível utilizar quatro modos de renderização para
controlar como os itens são renderizados na Scene View. As esferas abaixo
demonstram o efeito que os modos de renderização têm na aparência do modelo.
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A partir da esquerda, a ordem é Full Render, Shaded, Wireframe e Hidden
Line.

Renderização completa

No modo Full Render o modelo é renderizado com um sombreado suave,
incluindo materiais aplicados utilizando a ferramenta Presenter, ou que
foram convertidos pelo arquivo CAD nativo.

OBSERVAÇÃO  O Autodesk Navisworks não converte todas as texturas dos arquivos
CAD nativos. Para obter mais detalhes, consulte Utilizar leitores de arquivos na
página 182 e Utilizar exportadores de arquivos na página 205.

Para selecionar o modo Full Render

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Mode e clique em Full Render  .

Menu: Interface de usuário Classic: Viewpoint ➤ Rendering ➤ Full
Render

Sombreado

No modo Shaded, o modelo é renderizado com um sombreado suave sem
texturas.

Para selecionar o modo Shaded

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Mode e clique em Shaded  .

Menu: Interface de usuário Classic: Viewpoint ➤ Rendering ➤ Shaded
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Estrutura de arame

No modo Wireframe o modelo é renderizado numa estrutura de arame.
Como o Autodesk Navisworks utiliza triângulos para representar superfícies e
sólidos, todas as arestas triangulares são visíveis neste modo.

Para selecionar o modo Wireframe

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Mode e clique em Wireframe  .

Menu: Classic user interface: Viewpoint ➤ Rendering ➤ Wireframe

Linha oculta

No modo Hidden Line, o modelo é renderizado na estrutura de arame, mas
apenas o contorno e as arestas da faceta das superfícies visíveis para a câmera
são exibidas.

OBSERVAÇÃO Diferente do modo de estrutura de arame, onde as superfícies são
renderizadas como transparentes, o modo de linha oculta renderiza as superfícies
como opacas.

Para selecionar o modo Hidden Line

■ Clique na guia Viewpoint painel  ➤ Render Style lista suspensa

 ➤ Mode e clique em Hidden Line  .

Menu: Interface de usuário clássica: Viewpoint ➤ Rendering ➤ Hidden
Line

Adicionar iluminação

No Autodesk Navisworks, é possível utilizar quatro modos de iluminação para
controlar como a cena 3D será iluminada.

As esferas abaixo demonstram o efeito que os estilos de iluminação têm nelas.
Da esquerda para a direita, a ordem é: Full Lights, Scene Lights, Head
Light e No Lights.
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Luzes completas

Este modo utiliza luzes que foram definidas com a ferramenta Presenter.

Para utilizar luzes definidas pela ferramenta Presenter

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Lighting e clique em Full Lights  .

Menu: Classic user interface: Viewpoint ➤ Lighting ➤ Full Lights

Luzes de cena

Este modo utiliza as luzes que foram trazidas através do arquivo CAD nativo.
Se nenhuma luz estiver disponível, serão utilizadas duas luzes padrão opostas.

Você pode personalizar a intensidade das luzes de cena na caixa de diálogo
File Options.

Para utilizar as luzes definidas com o modelo

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Lighting e clique em Scene Lights  .

Menu: Classic user interface: Viewpoint ➤ Lighting ➤ Scene Lights

Para ajustar a intensidades das luzes da cena

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Scene Lights.

3 Mova o deslizador Ambient para ajustar o brilho da cena.
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DICA Ativar o modo de luzes de cena antes de seguir este procedimento
permite ver instantaneamente o efeito que suas alterações têm sobre a
renderização da cena.

4 Clique em OK.

Luz frontal

Este modo utiliza uma única luz direcional localizada na câmera que sempre
aponta na mesma direção da câmera.

É possível personalizar as propriedades de Head Light (Luz frontal) na caixa
de diálogo File Options, (guia Home painel  ➤ Project).

Para utilizar o modo Head Light

■ Clique na guia Viewpoint ➤ painel Render Style ➤ lista suspensa

Lighting e clique em Head Light  .

Menu: Interface de usuário Classic: Viewpoint ➤ Lighting ➤ Head
Light

Para ajustar a intensidade da Head Light

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Headlight.
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3 Mova o deslizador Ambient para ajustar o brilho da cena, e o deslizador
Headlight para ajustar o brilho da luz direcional.

DICA Ativar o modo Head Light antes de seguir este procedimento permite
ver instantaneamente o efeito que suas alterações têm sobre a renderização
da cena.

4 Clique em OK.

Nenhuma luz

Este modo desliga todas as luzes. A cena é renderizada com uma renderização
plana.

Para desligar todas as luzes

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Lighting e clique em No Lights  .

Menu: Interface de usuário Classic: Viewpoint ➤ Lighting ➤ No Lights
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Selecionar o efeito do segundo plano

No Autodesk Navisworks, você pode escolher um efeito de segundo plano para
usar na Scene View.

No momento, as seguintes opções estão disponíveis:
■ Plain - o segundo plano da cena 3D é preenchido com a cor selecionada.

Este é o estilo padrão de segundo plano. Ele pode ser usado para modelos
3D e folhas 2D.

Segundo plano simples

■ Graduated - o segundo plano da cena é preenchido com um gradiente
suave entre as duas cores selecionadas. Este segundo plano pode ser utilizado
para modelos 3D e folhas 2D.

Segundo plano graduado

■ Horizon - o segundo plano da cena 3D é dividido no plano horizontal
dando o efeito de céu e terra. O horizonte artificial resultante lhe fornece
uma indicação de sua orientação no universo 3D. Por padrão, o
horizonte artificial respeita o vetor para cima, como definido
em File Options  ➤  Orientation.. Este segundo plano não é suportado
para folhas 2D.
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OBSERVAÇÃO O horizonte artificial é um efeito no segundo plano e não inclui
um plano de chão físico. Por exemplo, se navegar "abaixo do solo" e olhar
para cima, não irá visualizar o fundo de um plano de chão, ao invés disso terá
uma vista de baixo do modelo, preenchida com a cor do céu.

Segundo plano de horizonte

Para definir um segundo plano simples

1 Clique na guia View  ➤  Scene View  ➤  Background  .

2 Na caixa de diálogo Background Settings , selecione Plain na lista
suspensa Mode.

3 Selecione a cor requerida na paleta Color.

4 Reveja o novo efeito de fundo na caixa anterior e clique em OK.

Para definir um segundo plano graduado

1 Clique na guia View ➤ Scene View ➤ Background  .

2 Na caixa de diálogo Background Settings , selecione Graduated na
lista suspensa Mode.

3 Selecione a primeira cor na paleta Top Color.

4 Selecione a segunda cor na paleta Bottom Color.

5 Reveja o novo efeito de fundo na caixa anterior e clique em OK.

Para definir um segundo plano de horizonte artificial para um modelo 3D

1 Clique na guia View ➤ Scene View ➤ Background  .

2 Na caixa de diálogo Background Settings , selecione Horizon na
lista suspensa Mode.
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3 Para definir uma cor de céu graduada, utilize as paletas Sky Color e
Horizon Sky Color.

4 Para definir uma cor de chão graduada utilize as paletas Horizon
Ground Color e Ground Color.

5 Reveja o novo efeito de fundo na caixa anterior e clique em OK.

Ajustar a exibição de primitivos

É possível habilitar ou desabilitar o desenho de Surfaces, Lines, Points,
Snap Pointse 3D Text na Scene View.

Points são pontos reais no modelo, enquanto Snap Points marcam
localizações em outros primitivos, por exemplo o centro de um círculo, e são
úteis para o snap durante a medição.

Superfícies

Superfícies são os triângulos que compõem os itens 2D e 3D na cena. Você
pode alternar a renderização de superfícies no modelo.

Para alternar a renderização de superfícies

■ Clique na guia Viewpoint ➤ painel Render Style ➤ menu suspenso

Mode e clique em Surfaces  .

Menu: Interface de usuário Classic: Viewpoint ➤ Display ➤ Surfaces

Linhas

Você pode alterar a renderização de linhas no modelo. Você também pode
alterar a largura de linhas desenhadas utilizando o Options Editor.

Para alternar a renderização de linhas

■ Clique na guia Viewpoint ➤ painel Render Style ➤ Lines  .

Menu: Classic user interface: Viewpoint ➤ Display ➤ Lines
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Para alterar a largura da linha

1 Clique no botão do aplicativo  ➤  Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display.

3 Na página Display , área Primitives , insira um número entre 1 e 9
na caixa Line Size.

Isto define a largura em pixels para linhas desenhadas na Scene View.

4 Clique em OK.

Pontos

Pontos são pontos reais no modelo como, por exemplo, os pontos em uma
nuvem de pontos em um arquivo de digitalização a laser. Você pode alternar
a renderização de pontos no modelo. Você também pode alterar o tamanho
de pontos desenhados utilizando o Options Editor.

Para alternar a renderização de pontos

■ Clique na guia Viewpoint ➤ painel Render Style ➤ Points  .

Menu: Interface de usuário Classic: Viewpoint ➤ Display ➤ Points

Para alterar o tamanho dos pontos

1 Clique no botão do aplicativo  ➤  Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Primitives , insira um número entre 1 e 9
na caixa Point Size.

Isto define o tamanho em pixels para pontos desenhados na Scene
View.

4 Clique em OK.
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Pontos de snap

Os pontos de snap são pontos implícitos no modelo, por exemplo, o ponto
central de uma esfera ou pontos finais de um tubo. Você pode alternar a
renderização do ponto de snap no modelo 3D. Você também pode alterar o
tamanho dos pontos de snap desenhados utilizando o Options Editor.

OBSERVAÇÃO Você pode alternar a renderização de pontos de snap para folhas
2D.

Para alternar a renderização de pontos de snap

■ Clique na guia Viewpoint painel  ➤ Render Style ➤ Snap Points
.

Para alterar o tamanho dos pontos de snap

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Primitives , insira um número entre 1 e 9
na caixa Snap Size.

Isto define o tamanho em pixels de pontos de snap desenhados na Scene
View.

4 Clique em OK.

Texto

Você pode alternar a renderização de texto em modelos 3D. Esta função não
é suportada para folhas 2D.

Para alternar a renderização de texto 3D

■ Clique na guia Viewpoint ➤ painel Render Style ➤ Text  .

Menu: Classic user interface: Viewpoint ➤ Display ➤ Text
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Controlar a qualidade da renderização

Utilizar a seleção

A seleção permite navegar e manipular cenas grandes e complexas em taxas
interativas ao ocultar de forma inteligente objetos menos importantes enquanto
você trabalha.

No Autodesk Navisworks, você pode utilizar os seguintes métodos para
selecionar objetos:
■ Area - o tamanho do objeto em pixels determina se os objetos são ou não

renderizados. Por padrão, quaisquer objetos menores do que 1x1 pixels de
tamanho são descartados.

■ Backface - por padrão, somente a face frontal de cada polígono é
desenhada no Autodesk Navisworks. Algumas vezes, durante o processo
de conversão, a face frontal e traseira de polígonos se misturam, em cujo
caso é necessário ajustar a opção Backface.

■ Near and Far Clipping Planes (seleção de tronco) - objetos mais perto
da câmera do que o plano de recorte próximo ao além do plano de recorte
afastado, não são desenhados. Você pode deixar que o Autodesk Navisworks
restrinja automaticamente a localização dos planos de recorte ou pode
restringir manualmente sua localização.

OBSERVAÇÃO As opções Backface e Clipping Planes não são utilizadas em
um espaço de trabalho 2D.

Para definir a seleção da área

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione a caixa de
seleção Enable na seção Area.

3 Insira uma valor para a área de tela em pixels abaixo do qual os objetos
de geometria são selecionados. Por exemplo, definir este valor como 100
pixels significa que qualquer objeto dentro do modelo que seria
desenhado com um tamanho menor do que 10x10 pixels será descartado.

4 Clique em OK.
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Para ativar a seleção da face traseira para todos os objetos em uma área de
trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione On na área
Backface.

3 Clique em OK.

Para desativar a seleção da face traseira para todos os objetos em um espaço
de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione Off na área
Backface.

3 Clique em OK.

Para ativar a seleção da face traseira somente para os objetos sólidos em uma
área de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Culling , selecione Solid na
área Backface.

3 Clique em OK.

Para restringir automaticamente a posição dos planos de recorte em um
espaço de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Culling.

3 Selecione Automatic para o plano de recorte Near.

4 Selecione Automatic para o plano de recorte Far.

5 Clique em OK.

O Autodesk Navisworks controla automaticamente a posição dos planos
de recorte próximos e afastados para oferecer a melhor vista do modelo.

Para restringir manualmente a posição dos planos de recorte em um espaço
de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Culling.
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3 Selecione Constrained para o plano de recorte Near , e insira o valor
desejado na caixa Distance.

4 Selecione Constrained para o plano de recorte Far , e insira o valor
desejado na caixa Distance.

5 Clique em OK.

O Autodesk Navisworks utiliza os valores fornecidos, a não ser que isto
afete o desempenho do sistema (por exemplo, torna todo o modelo
invisível), em qual caso ele ajusta a posição dos planos de recorte como
necessário.

Para fixar a posição dos planos de recorte em um espaço de trabalho 3D

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia Culling.

3 Selecione Fixed para o plano de recorte  Near , e insira o valor desejado
na caixa Distance.

4 Selecione Fixed para o plano de recorte Far , e insira o valor desejado
na caixa Distance.

5 Clique em OK.

IMPORTANTE O Autodesk Navisworks utiliza os valores fornecidos, a não
ser que isto afete o desempenho do sistema (por exemplo, torne todo o
modelo invisível).

Tornar objetos como necessários

Embora o Autodesk Navisworks prioriza de forma inteligente os objetos para
a seleção na cena, algumas vezes ele descarta geometria que precisa permanecer
visível ao navegar.

Você pode assegurar que os objetos sempre são renderizados durante a
navegação interativa tornando-os necessários.

Para tornar os objetos como necessários

1 Selecione os itens de geometria que deseja que permaneçam visíveis
durante a navegação na Selection Tree.

2 Clique na guia Home painel  ➤ Visibility ➤ Require  .
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Na Selection Tree, o objeto aparece em vermelho quando ele for
necessário.

DICA Clicar novamente em Require  torna os objetos selecionados não
necessários.

Menu: Classic user interface: Edit ➤ Required
Entrada do comando: Ctrl+R

Faixa de opções:  Guia Item Tools ➤ painel Visibility ➤ Require

Para tornar todos os objetos desnecessários

■ Clique na guia Home ➤ painel Visibility ➤ lista suspensa Unhide
All ➤ Unrequire All  .

Menu de atalho: Scene ➤ Reset All ➤ Unrequire All

Controlar a renderização de objetos

Ajustar a renderização da cena durante a
navegação

Seus modelos podem variar de tamanho, de pequenos modelos a supermodelos
complexos. Quando você navega em tempo real na cena, o Autodesk
Navisworks automaticamente calcula quais itens renderizar primeiro, com
base no tamanho dos itens, distância da câmera e a frequência de quadro
especificada. Esta frequência de quadro personalizável é garantida por padrão,
mas pode ser desativada, se necessário. Itens para os quais o Autodesk
Navisworks não tiver tempo para renderizar serão descartados. Estes itens
descartados são renderizados quando a navegação pára.

A quantidade de descarte depende de diversos fatores, como o desempenho
do seu hardware (placa gráfica e driver), o tamanho da Scene View, e o
tamanho do modelo. Ao trabalhar com supermodelos realmente grandes no
Autodesk Navisworks, será necessário tem um montante suficiente de RAM
para carregar e rever os dados.

O Autodesk Navisworks emprega a tecnologia JetStream que otimiza a utilização
da RAM disponível. Antes de ficar sem memória, o Autodesk Navisworks pagina
dados desnecessários para o disco rígido, liberando espaço para que o
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carregamento continue. A tecnologia JetStream também permite iniciar a
navegar no supermodelo, antes que ele seja completamente carregado na
memória. O Autodesk Navisworks está ciente de endereços grandes, e utiliza
qualquer atribuição de memória adicional segundo a chave 3GB disponível
nos sistemas Windows XP.

DICA Você pode reduzir o montante de descarte durante a navegação ao reduzir
a frequência de quadro, ou desativando a opção Guarantee Frame Rate.

Para definir a frequência de quadro alvo

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia Speed , selecione o número de
quadros por segundo a ser aplicado na exibição renderizada do modelo.

3 Clique em OK.

Para definir o nível de detalhe

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Detail , selecione a caixa de seleção
Guarantee Frame Rate para manter a frequência de quadro alvo
durante a navegação. Se esta caixa de seleção estiver desmarcada, o
modelo completo é renderizado durante a navegação, não importando
quanto tempo levar.

4 Selecione a caixa de seleção Fill in Detail para renderizar um modelo
completo quando a navegação pára. Se esta caixa de seleção estiver
desmarcada, os itens descartados durante a navegação não são
preenchidos quando a navegação pára.

5 Clique em OK.

Para renderizar itens transparentes

Observação: Se a sua placa de vídeo suporta o OpenGL acelerado por
hardware, você pode ativar a renderização de itens transparentes durante a
navegação interativa. Por padrão, os itens transparentes somente são
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desenhados quando a interação parou de prevenir problemas com o
desempenho de exibição.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Transparency , selecione a caixa de seleção
Interactive Transparency.

4 Clique em OK.

Para renderizar primitivos paramétricos

Observação: a modificação desta opção requer a reinicialização do Autodesk
Navisworks para que tenha efeito.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Primitives , selecione a caixa de seleção
Enable Parametric Primitives. O nível de detalhe muda durante a
navegação dependendo da distância da câmera.

Se você deseja utilizar as representações padrão de primitivos, desmarque
esta caixa de seleção. O nível de detalhe permanece o mesmo durante a
navegação.

Clique em OK.

Acelerar o desempenho de exibição

Se sua placa de vídeo suporta o OpenGL, você pode aprimorar o desempenho
gráfico ao ativar a aceleração por hardware e a seleção de obstrução.

A utilização da aceleração do hardware normalmente fornece um renderização
melhor e mais rápida. No entanto, alguma placas gráficas podem não funcionar
bem neste modo, em qual caso se recomenda desativar esta opção.

A seleção de obstrução pode aprimorar significativamente o desempenho em
situações onde a maior parte do modelo não está visível. Por exemplo, quando
você anda em um corredor em um edifício, as paredes obstruem a maioria da
geometria fora do corredor. Outros ambientes somente são visíveis através de
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aberturas de portas ou janelas. Desativar a seleção de obstrução reduz muito
a carga de renderização nestes casos.

Para utilizar a aceleração por hardware

OBSERVAÇÃO: se sua placa de vídeo não suporta a aceleração por hardware
OpenGL, esta opção não está disponível.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Acceleration , selecione a caixa de seleção
Hardware Acceleration. Isto permite que o Autodesk Navisworks
utilize qualquer aceleração por hardware OpenGL disponível em sua
placa de vídeo.

OBSERVAÇÃO Se os drivers de sua placa de vídeo não funcionam bem com
o Autodesk Navisworks, desmarque esta caixa de seleção.

4 Clique em OK.

Para utilizar a seleção de obstrução

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Display..

3 Na página Display , área Acceleration , selecione a caixa de seleção
Occlusion Culling.

4 Clique em OK.

OBSERVAÇÃO A seleção de obstrução somente pode ser utilizada em uma
máquina com uma placa gráfica compatível com o OpenGL. Além disso, a seleção
da oclusão não é utilizada em uma área de trabalho 2D.

Ajustar materiais no Presenter

É possível ajustar a aparência dos materiais do Presenter na Scene View
para melhorar o desempenho da placa de vídeo ao navegar em cenas com
muita textura.
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Consulte também:

Página Presenter  na página 875

Renderização em estéreo

A visualização estereoscópica no Autodesk Navisworks permite a visualização
do modelo 3D através de hardware estéreo, incluindo lentes de visualização
estéreo ativas e passivas em conjunto com telas CRT e projetores dedicados.

IMPORTANTE A utilização da renderização em estéreo requer que o computador
host tenha uma placa gráfica OpenGL com suporte de estéreo. Adicionalmente,
alguns drivers requerem que o estéreo seja explicitamente ativado no driver e
pode requerer menor configuração de cor ou resolução antes que a renderização
em estéreo esteja disponível.

Quando a saída de vídeo estiver no modo estéreo, a vista parece distorcida
sem as lentes corretas sendo utilizadas. Se a câmera estiver no modo ortogonal,
ela precisa ser definida com em perspectiva para que o efeito funcione
corretamente.

OBSERVAÇÃO Com a visão para cada olho precisa ser renderizada separadamente,
não é possível suportar o preenchimento incremental de detalhe no modo estéreo.
O detalhe aparece quando a renderização for completada. O andamento pode
ser visto utilizando a barra na área de status, e é possível interromper e iniciar
novamente a interação a qualquer momento.

Nos modos de navegação com base no ponto focal (como órbita, órbita livre
e órbita restrita), o modelo é posicionado para que as partes mais perto do que
o ponto focal apareçam na frente da tela com o resto atrás. Em outros modo
de navegação (como navegar e voar), o ponto focal é definido para que
qualquer avatar estará nivelado com a tela. Os objetos entre você o avatar irão
aparecer na frente da tela. Você pode ajustar o efeito fora da tela na caixa de
diálogo Stereo Options.

Para ativar a renderização em estéreo

■ Clique na guia View ➤ painel Stereo ➤ Enable Stereo  .

OBSERVAÇÃO Esta opção somente está disponível se você tiver o hardware
requerido e as configurações corretas do driver e de exibição.
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Para ajustar os efeitos de estéreo

1 Clique na guia View ➤ painel Stereo ➤ iniciador de ferramentas
Stereo Options  .

2 Na caixa de diálogo Stereo Options , mova o deslizador Magnitude
para variar a intensidade do efeito.

3 Para ajustar o efeito fora da tela, selecione a caixa de seleção Enable , e
a seguir mova o deslizador para controlar quanto da cena aparece fora
da tela durante a navegação.

4 Se precisar intercambiar os olhos esquerdo e direito, selecione a caixa de
seleção Swap Eyes. Isto pode ser útil ao mover do CRT para um projeto
de tela grande e de volta.

5 Clique em OK.
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Revisar seu modelo

Selecionar objetos
Em modelos grandes, a seleção de itens de interesse é um processo que
potencialmente pode consumir muito tempo. O Autodesk Navisworks torna
bem mais simples essa tarefa ao fornecer uma gama de funções para a seleção
rápida da geometria, de forma interativa e ao pesquisar no modelo de forma
manual e automática.

Seleção interativa da geometria

No Autodesk Navisworks, há um conceito de um conjunto de seleção ativo (os
itens atualmente selecionados ou a seleção atual) e de conjuntos de seleção
salvos. A seleção e procura de itens os torna parte da seleção atual, portanto, é
possível ocultá-los ou sobrepor suas cores. A qualquer momento, a seleção atual
pode ser salva e nomeada para recuperação em sessões posteriores.

A seleção de itens os torna parte da seleção atual, portanto, é possível ocultá-los
ou sobrepor suas cores.

É possível utilizar diversos métodos para selecionar itens interativamente na
seleção atual. É possível usar as guias na Árvore de seleção, selecione os itens
diretamente na Vista da cena com as ferramentas Selecionar e Selecionar
caixa e pode selecionar itens com propriedades similares à seleções existentes
usando os comandos de seleção.

OBSERVAÇÃO Clicar com o botão direito em qualquer item na Selection Tree
ou Vista da cena abre um menu de atalho.

7
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Também é possível personalizar o nível no qual você seleciona os itens
(resolução de seleção) na página 369, e modificar o método de realce para os
itens selecionados na Vista da cena.

Janela Selection Tree

A Selection Tree é uma janela encaixável que exibe uma variedade de vistas
hierárquicas da estrutura do modelo, como definido pelo aplicativo de CAD
no qual o modelo foi criado.

O Autodesk Navisworks utiliza esta estrutura hierárquica para identificar
caminhos específicos de objeto (do nome do arquivo até um determinado
objeto).

Por padrão há quatro guias:
■ Standard. Exibe a hierarquia da árvore padrão, incluindo todas as

instâncias. O conteúdo desta guia pode ser classificado alfabeticamente.

■ Compact. Exibe uma versão simplificada da hierarquia na guia Standard
omitindo vários itens; É possível personalizar o nível de complexidade
desta árvore no Options Editor.

■ Propriedades Exibe a hierarquia com base nas propriedades dos itens.
Isto permite uma pesquisa manual simples no modelo por propriedade de
item.

■ Sets Exibe a lista de conjuntos de seleção e de pesquisa. Caso nenhum
conjunto de seleção e pesquisa tiver sido criado, esta guia não é exibida.
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OBSERVAÇÃO A lista de itens na guia Sets é exatamente a mesma que a lista
na janela encaixável Sets.

Guias adicionais personalizadas Selection Tree podem ser adicionadas usando
a API do Autodesk Navisworks.

O nome dos itens reflete os nomes do aplicativo de CAD original, sempre que
for possível. É possível copiar e colar nomes da Selection Tree. Para fazer
isto, clique com o botão direito na Selection Tree, e clique em Copy Name
no menu de contexto. Alternativamente, é possível clicar em um item na
Selection Tree, e pressionar CTRL + C. O nome agora foi copiado para a área
de transferência.

Há diferentes ícones de árvore representando os tipos de geometria que
compõem a estrutura do modelo. Cada um destes itens podem ser marcados
como ocultos (cinza), não oculto (azul escuro) ou requerido (vermelho).

OBSERVAÇÃO Se um grupo estiver marcado como oculto ou requerido, então
todas as instâncias daquele grupo são marcadas como oculto ou requerido. Caso
deseje operar em uma única ocorrência de um item, então você deverá marcar o
grupo em instâncias (o nível acima ou o 'principal' na hierarquia) como oculto ou
requerido.

Para alternar a Selection Tree

■ Clique em: guia Home painel  ➤ Select & Search ➤ Selection Tree
.

Menu: Classic user interface: View ➤ Control Bars ➤ Selection Tree
Entrada do comando: CTRL + F12

Para usar a opção Árvore de seleção para selecionar objetos

1 Abra a Selection Tree, e clique na guia Standard.

2 Clique em um objeto na Selection tree para selecionar a geometria
correspondente na Vista da cena.

OBSERVAÇÃO Quando você seleciona um item na árvore, a geometria
individual ou um grupo de geometrias é selecionado na Vista da cena
dependendo da resolução de seleção escolhida.

3 Para selecionar múltiplos itens ao mesmo tempo, utilize as teclas SHIFT
e CTRL. CTRL permite a múltipla seleção de item por item e SHIFT
permite a múltipla seleção entre o primeiro e último item selecionado.
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4 Para remover a seleção de um objeto na Selection Tree pressione Esc.

Para alterar a ordem de classificação na guia Standard

1 Abra a Selection Tree, e clique na guia Standard.

2 Clique com o botão direito do mouse em qualquer item na árvore e
clique em Scene ➤ Sort. O conteúdo da guia agora está classificado na
ordem alfabética.

OBSERVAÇÃO  Não é possível usar a opção Undo  na barra de ferramentas
Quick Access para reverter esta ação.

Para personalizar o conteúdo da guia Compact

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.

3 Na página Selection , selecione o nível de detalhe requerido na caixa
Compact Tree. Escolha entre as seguintes opções:
■ Models - a árvore é restrita para somente exibir arquivos de modelo.

■ Layers - a árvore pode ser expandida para o nível de camada.

■ Objects - pode ser expandida para o nível de objetos, mas sem os
níveis de instâncias mostrados na guia Standard.

4 Clique em OK.

DescriçãoÍcone

Um modelo, como um arquivo de desenho
ou um arquivo de projeto.

Uma camada ou nível.

Um grupo, como uma definição de bloco
do AutoCAD ou uma definição de célula do
MicroStation.

Um grupo em instâncias, como um bloco
inserido do AutoCAD ou de uma célula do
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DescriçãoÍcone

MicroStation. Se no arquivo importado a
instância não estava nomeada, o Autodesk
Navisworks nomeia a instância para
coincidir com o nome de seu secundário.

Um item de geometria, como um polígono.

Um item em instância da geometria, como
uma instância do 3D Studio.

Um objeto composto. Um único objeto de
CAD que é representado no Autodesk
Navisworks por um grupo de itens de
geometria.

O conjunto de seleção salvo.

O conjunto de pesquisa salvo.

Ferramentas de seleção

Existem duas ferramentas de seleção (Select  e Select Box  ) disponíveis
na guia Home ➤ painel Select & Search para controlar o modo de seleção
de geometria.

Normalmente, o uso de ferramentas de seleção é mutuamente exclusivo à
utilização das ferramentas de navegação (consulte Ferramentas de navegação
específicas do produto na página 259; portanto, quando você estiver
selecionando não poderá navegar e vice-versa.

OBSERVAÇÃO Ao utilizar um mouse 3D 3Dconnexion em conjunto com o controle
padrão do mouse, o 3Dconnexion pode ser configurado para a navegação e o
mouse para a seleção. Consulte Mouse 3D 3Dconnexion na página 321 para obter
mais informações.

Selecionar geometria na Vista da cena automaticamente seleciona os objetos
correspondentes na Selection Tree.
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Manter pressionada a tecla SHIFT ao selecionar itens na Vista da cena efetua
o ciclo através da resolução de seleção, lhe permitindo ser mais específico com
suas seleções.

É possível utilizar o Options Editor para personalizar a distância que existe
de um item para que ele seja selecionado (raio de seleção). Isto é útil quando
você seleciona linhas e pontos.

Ferramenta Select

A ferramenta Select lhe permite selecionar itens na Vista da cena com um
clique do mouse. A ferramenta é ativada ao clicar na guia Home ➤ painel

Select & Search ➤ menu suspenso Select ➤ Select  . Após um item
único ter sido selecionado, suas propriedades são exibidas na janela
Properties.

Ferramenta Select Box

No modo de caixa de seleção, você pode selecionar múltiplos itens no modelo
ao arrastar a caixa retangular em torno da área que deseja que seja tornada
sua seleção atual.

Para selecionar geometria com a ferramenta Select

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

Select ➤ Select  .

2 Clique em um item na Vista da cena para selecioná-lo.

3 Para selecionar múltiplas geometrias, mantenha pressionada a tecla CTRL
ao clicar nos itens na cena.

4 Para remover itens da seleção atual, mantenha pressionada a tecla CTRL
ao clicar neles novamente. Outra alternativa é pressionar a tecla ESC
para remover todos os itens da seleção atual.

Menu: Classic user interface: Edit ➤ Select ➤ Select
Entrada do comando: Ctrl+1

Para selecionar geometria com a ferramenta Select Box

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

Select ➤ Select Box  .
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2 Arraste a caixa com o botão esquerdo do mouse sobre a Vista da cena
para selecionar todos os itens na caixa.

DICA Manter pressionada a tecla SHIFT ao arrastar a caixa, seleciona todos
os itens dentro e que efetua a intersecção com a caixa.

3 Para selecionar múltiplas geometrias, mantenha pressionada a tecla CTRL
ao arrastar a caixa na cena.

4 Para remover itens da seleção atual, pressione a tecla Esc.

Para definir o raio de seleção

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção
Selection.

3 Na página Selection , insira o raio em pixels no qual o tem de estar para
poder ser selecionado. Os valores válidos são entre 1 e 9.

4 Clique em OK.

Comandos de seleção

Os comandos de seleção permitem alterar com rapidez a seleção atual utilizando
a lógica. É possível selecionar vários itens com base nas propriedades dos itens
selecionados atuais, ou inverter rapidamente o conjunto, selecionar tudo ou
nada.

Para selecionar todos os itens no modelo

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

 ➤ Select All  .

Para anular a seleção de todos os itens

■ Clique na guia Home painel  ➤ Select & Search ➤ menu suspenso

Select All ➤ Select None  .
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Para inverter a sua seleção atual

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso

Select All ➤ Invert Selection  .

Itens atualmente selecionados são deselecionados, e os itens atualmente
deselecionados são selecionados.

Para selecionar todas as instâncias do grupo de geometria selecionado

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Select Same ➤ Select Multiple Instances  .

Para selecionar todos os itens com o mesmo nome que o item selecionado
atualmente

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Select Same ➤ Same Name  .

Para selecionar todos os itens com o mesmo tipo que o item selecionado
atualmente

■ Clique na guia Home painel  ➤ Select & Search menu suspenso
 ➤ Select Same ➤  Same Type.

Para selecionar todos os itens com a mesma propriedade que o item
selecionado atualmente

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Select Same ➤ Same <Property>.

Para usar um conjunto de seleção ou pesquisa salvo

■ Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Sets e clique no conjunto que deseja chamar novamente.

Os comandos de seleção são os seguintes:
■ Select All. Seleciona todos os itens contidos dentro do modelo.

■ Select None. Anula a seleção de tudo dentro do modelo.

■ Inverter seleção. A seleção dos itens atualmente selecionados é anulada
e vice versa.

■ Sets Fornece opções para salvar e chamar de volta as seleções e conjuntos
de pesquisa.
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■ Select Multiple Instances. Seleciona todas as instâncias (algumas
chamadas inserções do grupo da geometria selecionada atual que ocorre
no modelo.

■ Select Same Name. Seleciona todos os itens no modelo que têm o mesmo
nome que o item atualmente selecionado.

■ Select Same Type. Seleciona todos os itens no modelo que têm o mesmo
tipo que o item atualmente selecionado.

■ <Property>. Select Same. Seleciona todos os itens com a mesma
propriedade que o item selecionado atualmente. Esta propriedade pode ser
qualquer propriedade pesquisável atualmente anexada ao item, por exemplo
material ou link.

OBSERVAÇÃO O uso do comando <Property> Select Same funciona através
da comparação das propriedades dos itens. Caso você tenha múltiplos itens
selecionados ao executar um comando de seleção do mesmo nome e tipo e
assim por diante, todos os tipos, nomes e propriedades dos itens na seleção
atual são comparados com as propriedades de todos os itens na cena. Os itens
com propriedades coincidentes com quaisquer propriedades dos itens no
momento selecionados são selecionados.

Definir a resolução de seleção

Ao clicar em um item na Scene View, o Autodesk Navisworks não sabe que
nível tem o item para iniciar a seleção. Quer dizer todo o modelo ou a camada,
a instância, o grupo, ou somente a geometria? A resolução de seleção padrão
especifica um ponto inicial para o caminho do objeto na Selection Tree para
que o Autodesk Navisworks possa localizar e selecionar o item.

É possível personalizar a resolução da seleção padrão na guia Home painel
 ➤ Select & Search. Alternativamente, você pode usar o Options Editor.
Ou também é possível usar um caminho mais rápido, clicando com o botão
direito do mouse em qualquer item na opção Árvore de seleção e clicando
no X em Set Selection Resolution to, onde "X" é uma das resoluções de
seleção disponível.

Se achar que selecionou o nível errado do item, poderá circular interativamente
pela resolução da seleção, sem tem que ir ao Options Editor ou à guia Início.
Isso pode ser feito ao manter pressionada a tecla SHIFT ao clicar em um item.
Isto seleciona um item em um nível mais específico cada vez que clicar no
item até que a resolução se torne "geometria", ponto no qual, é revertida de
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volta ao "modelo". Clicar em um item diferentes reverte a resolução de seleção
de volta para seu padrão (como definida no Options Editor).

Para alterar a resolução de seleção padrão no Options Editor

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.

3 Na página Selection , selecione o ponto inicial requerido para o caminho
do objeto na caixa Resolution.

4 Clique em OK.

Para alterar a resolução de seleção padrão com as ferramentas da faixa de
opções

1 Clique na guia Início e amplie o painel Select & Search.

2 Clique no menu suspenso Resolução da seleção e selecione a opção
necessária.

As opções disponíveis para a resolução de seleção são as seguintes:
■ Arquivo. Faz com que o caminho do objeto inicie no nível do arquivo e,

como resultado, todos os objetos no nível de arquivo atual são selecionados.

■ Layer. Faz com que o caminho do objeto inicie no nó da camada e, como
resultado, todos os objetos em uma camada são selecionados.

■ First Object. Faz com que o caminho do objeto inicie no maior nível de
objetos abaixo do nó da camada, se aplicável.

■ Last Object. Faz com que o caminho do objeto inicie no menor nível de
objetos na Selection Tree. O Autodesk Navisworks procura primeiro por
objetos compostos e se nenhum for encontrado, o nível de geometria é
utilizado. Esta é a opção padrão.

■ Last Unique. Faz com que o caminho do objeto inicie no primeiro nível
único de objetos (não de múltipas instâncias) na Selection Tree.

■ Geometry. Faz com que o caminho do objeto inicie no nível de geometria
na Selection Tree.
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Definir o método de realce

É possível usar o Options Editor para personalizar a cor e método do realce
de geometria selecionado na Vista da cena.

Há três tipos de realces:
■ Shaded

■ Wireframe

■ Tinted
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Para alternar o realce de objetos selecionados

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.

3 Na página Seleção, área Highlight, selecione a caixa de verificação
Habilitar se quiser que os itens selecionados sejam ressaltados na Vista
da cena. Desmarque esta caixa de seleção se não desejar nenhum realce.

4 Clique em OK.

Para personalizar a forma com que os objetos são realçados

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Selection.

3 Assegure que a caixa de seleção Enabled esteja selecionada.

4 Use a lista suspensa Method para selecionar o tipo de realce desejado
(Shaded, Wireframe ou Tinted).

5 Clique na paleta Color para selecionar a cor realçada.

6 Se você selecionou Tinted na caixa Method , utilize o deslizador para
ajustar o Tint Level.

7 Clique em OK.

Ocultar objetos

O Autodesk Navisworks fornece ferramentas que podem ser utilizadas para
ocultar e exibir objetos ou grupos de objetos. Objetos ocultos não são
desenhados na Vista da cena.

Ocultar objetos selecionados

Você pode ocultar objetos na seleção atual para que não sejam desenhados na
Vista da cena. Isso é útil quando você deseja remover partes específicas do
modelo. Por exemplo, ao navegar pelo corredor do edifício, pode desejar ocultar
uma parede que esteja obstruindo a vista do cômodo ao lado.
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Ocultar objetos não selecionados

Você pode ocultar todos os itens com exceção dos atualmente selecionados,
para que eles não sejam desenhados na Vista da cena. Isso é útil quando
você somente deseja ver partes específicas do modelo.

OBSERVAÇÃO Na Selection Tree, os itens aparecem em cinza quando marcados
como ocultos.

Para ocultar objetos selecionados

1 Na Vista da cena, selecione todos os itens que deseja ocultar.

2 Clique na guia Home ➤ painel Visibility ➤ Hide  .

Os objetos selecionados agora estão invisíveis.

DICA Clicando novamente em Hide  são exibidos os objetos invisíveis.

Menu: Classic user interface: Edit ➤ Hidden
Entrada do comando: CTRL+H

Menu de atalho: Hide

Para tornar objetos não selecionados ocultos

1 Na Vista da cena, selecione todos os itens que deseja revisar.

2 Clique na guia Home ➤ painel Visibility ➤ Hide Unselected  .

Somente a geometria selecionada permanece visível.

DICA Clicando novamente em Hide Unselected  são exibidos os objetos
invisíveis.

Menu: Classic user interface: Edit ➤ Hide Unselected
Menu de atalho:  Hide Unselected

Para revelar todos os objetos ocultos

■ Clique na guia Home painel  ➤ Visibility menu suspenso  ➤ Unhide
All ➤ Unhide All  .

Menu de atalho: Scene ➤ Reset All ➤ Unhide All
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Encontrar objetos
Localizar é um jeito rápido e avançado de selecionar itens na seleção atual
com base nas propriedades dos itens.

É possível utilizar a janelaFind Items para definir e executar uma pesquisa,
que pode então ser salva e reexecutada em sessões posteriores ou compartilhada
com outros usuários.

Também é possível utilizar Quick Find, que é uma forma mais rápida de
pesquisar. Ela simplesmente procura pela sequência especificada em todos os
nomes e valores de propriedades anexados aos itens na cena.

Janela Find Items

A janela Find Items é uma janela encaixável que permite pesquisar por itens
que tenham uma propriedade em comum ou uma combinação de propriedades.

O painel esquerdo contém a Find Selection Tree com diversas guias na
parte inferior, e permite selecionar o nível do item no qual iniciar a pesquisa.
Este pode ser um arquivo, uma camada, uma instância, um conjunto de seleção,
e assim por diante.

As guias são as mesmas da janela Selection Tree:
■ Standard. Exibe a hierarquia da árvore padrão, incluindo todas as

instâncias.

■ Compact. Exibe uma versão simplificada da hierarquia da árvore.
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■ Propriedades Exibe a hierarquia com base nas propriedades dos itens.

■ Sets Exibe a lista de conjuntos de seleção e de pesquisa. Caso nenhum
conjunto de seleção e pesquisa tiver sido criado, esta guia não é exibida.

OBSERVAÇÃO A lista dos itens na guia Sets é exatamente a mesma que a lista
na janelaSets.

O painel direito permite adicionar as declarações (ou condições) de pesquisa.
E os botões permitem encontrar o itens qualificados em sua cena.

Definindo declarações de pesquisa

Uma declaração de pesquisa contém uma propriedade (uma combinação de
nome de categoria e nome de propriedade), um operador de condição, e um
valor a ser testado contra a propriedade selecionada. Por exemplo, você pode
procurar MaterialContains Chrome (material que contenha cromo).

Por padrão, todos os itens que coincidam com seu critério de declaração são
encontrados (por exemplo, todos os objetos que utilizam material de cromo).
Você também pode negar uma declaração, em qual caso, todos os itens que
não coincidem com seu critério de declaração são então encontrados (por
exemplo, todos os objetos que não utilizam material de cromo).

Cada nome de categoria e propriedade tem duas partes: uma sequência do
usuário que é exibida na interface do Autodesk Navisworks e uma sequência
interna que não é exibida e que é principalmente utilizada pela API. Por padrão,
os itens têm correspondências com ambas as partes, mas é possível instruir o
Autodesk Navisworks a fazer correspondência com somente uma parte, se for
necessário. Por exemplo, você pode ignorar nomes em pesquisas e coincidir
os itens somente com seus nomes internos. Isto é útil quando você planeja
compartilhar suas pesquisas salvas com outros usuários que podem estar
executando versões localizadas do Autodesk Navisworks.

As declarações que não utilizam configurações padrão são identificadas por
este ícone:  . Por exemplo, ele parece quando você nega uma declaração, ou
escolhe ignorar palavras maiúsculas e minúsculas nos valores da propriedade.

Combinando declarações de pesquisa

As declarações de pesquisa são lidas da esquerda para a direita. Por padrão,
todas as declarações têm operador AND. Por exemplo,“A e B”, “A e B e C”.

Você pode organizar sua declarações em grupos. Por exemplo, “(A e B) OU (C
e D)”. Declarações com o operador OR são identificadas por um ícone de mais:
 . Todas as declarações que precedem as declarações com o operador OR e
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AND, e todas as declarações seguindo a declaração com o operador OR e AND.
Portanto, para criar os dois grupos do exemplo anterior, precisa marcar a
declaração C com o operador OR.

Não há parênteses para mostrar visualmente a forma com que a s declarações
são lidas. Declarações simples tais como "A ou B" não serão mal interpretadas.
Para pesquisas complexas, a ordem e agrupamentos de declarações são mais
importantes, especialmente se você decidir negar algumas declarações. Por
exemplo, “(A e B) OU (C e não D)”. Quando as condições de pesquisa são
avaliadas, NOT é aplicado antes de AND, e AND é aplicado antes de OR.

Para alternar a janela Find Items

■ Clique na guia Home ➤ painel Select & Search ➤ Find Items  .

Menu: Classic user interface: View ➤ Control Bars ➤ Find Items
Entrada do comando: Shift + F3

Para encontrar objetos

1 Abra a janela Find Items.

2 Na Find Selection Tree, clique nos itens nos quais deseja começar a
pesquisar. Por exemplo, se você deseja pesquisar em todo o modelo,
clique na guia Standard , mantenha pressionado CTRL, e clique em
todos os arquivos que compreendem o modelo. Se você deseja limitar
sua pesquisa para um conjunto de seleção, clique na guia Sets , e clique
no conjunto requerido.

3 Definir uma declaração de pesquisa:

a Clique na coluna Category , e selecione o nome da categoria de
propriedades na lista suspensa, por exemplo, 'Item'.

b Na coluna Property , selecione o nome da propriedade na lista
suspensa, por exemplo, ‘Material’.

c Na coluna Condition, selecione o operador de condição, por
exemplo, "Contém".

d Na coluna Value, insira o valor da propriedade a ser procurada,
por exemplo, "Chrome".

e Caso deseja que sua declaração de pesquisa não seja sensível a
maiúsculas e minúsculas, clique com o botão direito do mouse na
declaração, e clique em Ignore String Value Case,

4 Defina mais declarações de pesquisa, se necessário.
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Por padrão, todas as declarações têm operador AND. Isto significa que
todas precisam ser verdadeiras para que um item seja selecionado. Você
pode fazer com que a declaração utilize a lógica OR, ao clicar com o botão
direito do mouse na declaração, e clicar em Or Condition. Se você
estiver utilizando duas declarações, e marcou a segunda com o operador
OR, isso significa que um item será selecionado de uma destas declarações
for verdadeira.

5 Clique no botão Find All. Os resultados da pesquisa são realçados na
Vista da cena e Selection Tree.

Para salvar a pesquisa atual

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Sets ➤ Manage Sets.

Isto abre a janela Sets e a torna a janela ativa.

2 Clique com o botão direito em qualquer lugar da janela Sets, e clique
em Add Current Search.

3 Insira um nome para seu conjunto de pesquisa e pressione ENTER.

Menu: Classic user interface: Edit ➤ Select ➤ Selection Sets ➤ Add
Current Search

Para exportar a pesquisa atual

1 Clique na guia Output painel  ➤ Export Data ➤ Current Search

 .

2 Na caixa de diálogo Export , procure pela pasta desejada.

3 Insira um nome de arquivo e clique em Save.

Para importar uma pesquisa salva

1 Clique no botão do aplicativo  ➤ Import ➤ Search XML.

2 Na caixa de diálogo Import, procure pela pasta contendo o arquivo
com o critério de pesquisa de salvamento e a selecione.

3 Clique em Open.
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Opções de pesquisa

Category Seleciona o nome da categoria. Somente as categorias que estão
contidas na cena estão disponíveis na lista suspensa.

Property Seleciona o nome da propriedade. Somente as propriedades na cena
com a categoria escolhida estão disponíveis na lista suspensa.

Condition Seleciona o operador de condição para sua pesquisa. Você pode
utilizar os seguintes operadores dependendo da propriedade pela qual está
pesquisando:
■ =. Equals; pode ser utilizado para avaliar qualquer tipo de propriedade.

Para qualificar para a pesquisa, a propriedade precisa coincidir exatamente
com o valor especificado.

■ Not Equals . Pode ser utilizado para avaliar qualquer tipo de propriedade.

■ > -. Maior que: somente pode ser usado para avaliar os tipos de propriedades
numéricas.

■ >=. Maior que ou igual: somente pode ser usado para avaliar os tipos de
propriedades numéricas.

■ < -. Menor que: somente pode ser usado para avaliar os tipos de
propriedades numéricas.

■ <=. Menor que ou igual: somente pode ser usado para avaliar os tipos de
propriedades numéricas.

■ Contains. Para qualificar para a pesquisa, uma propriedade precisa conter
o valor especificado (por exemplo, uma série de letras em uma sequência).

■ Wildcard. Permite utilizar coringas no campo Value  para permitir
coincidir contra qualquer caractere (?) ou uma sequência arbitrária de
caracteres (*).

■ Defined. Para qualificar para a pesquisa, uma propriedade precisa ter
algum valor definido.

■ Undefined. Para qualificar para a pesquisa, uma propriedade não pode
ter algum valor definido.

Value Você pode digitar livremente um valor nesta caixa, ou escolher um
valor predefinido na lista suspensa, que mostra todas os valores disponíveis
na cena dentro da categoria e propriedade anteriormente definidas. Caso tenha
utilizado Wildcard como o operador de condição, poderá digitar um valor
com coringas. Para coincidir um caractere único não especificado use o símbolo
"?" (ponto de interrogação). Para coincidir qualquer número de caracteres não
especificados, utilize o símbolo * (asterisco). Por exemplo, "b??k" irá coincidir
com "brick" e "block"; “b*k” irá coincidir com “bench kiosk”, “brick”, e “block”;
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e “*b*k*” irá coincidir com “bench kiosk”, “brick” e “block” assim como
“Coarse bricks” e “block 2”.

Esta caixa não está disponível caso você tenha utilizado Defined ou
Undefined como o operador de condição.

Match Case Selecione esta caixa de seleção para respeitar as letras maiúsculas
e minúsculas dos valores testados durante a pesquisa. Isso afeta todas as
declarações em sua pesquisa. Também é possível definir a sensibilidade de
maiúsculas e minúsculas para cada declaração individual de pesquisa ao utilizar
o menu de atalho Search Conditions.

Prune Below Result Selecione esta caixa de verificação se desejar parar a
pesquisa de uma ramificação de Find Selection Tree tão logo o primeiro
objeto qualificativo seja encontrado.

Search Especifica o tipo de pesquisa a ser executada. Escolha entre:
■ Default. Pesquisa por todos os itens selecionados na Find Selection

Tree, junto com os caminhos abaixo deste itens, para objetos qualificados.

■ Below Selected Paths. Somente pesquisa abaixo dos itens selecionados
na Find Selection Tree para objetos qualificados.

■ Selected Paths Only. Somente pesquisa nos itens selecionados na Find
Selection Tree para itens qualificados.

Menu de atalho Find Selection Tree

Select Altera a seleção feita por você na Vista da cena para a seleção atual
na Find Selection Tree.

Importe Current Selection Altera a seleção na Find Selection Tree para a
sua seleção atual na Vista da cena.

Menu de atalho Search Conditions

Ignore String Value Case Torna a declaração de pesquisa selecionada insensível
a maiúsculas e minúsculas (por exemplo, os materiais ‘Chrome’ e ‘chrome’
são testados quanto a sua qualificação).

Ignore Category User Name Instrui o Autodesk Navisworks a utilizar nomes
de categorias internas e ignorar os nomes de categorias do usuário para a
declaração de pesquisa selecionada.

Ignore Category Internal Name Instrui o Autodesk Navisworks a utilizar
nomes de categorias do usuário e ignorar os nomes de categorias internas para
a declaração de pesquisa selecionada.
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Ignore Property User Name Instrui o Autodesk Navisworks a utilizar nomes
de propriedades internas e ignorar os nomes de propriedades do usuário para
a declaração de pesquisa selecionada.

Ignore Property Internal Name Instrui o Autodesk Navisworks a utilizar
nomes de propriedades do usuário e ignorar os nomes de categorias internas
para a declaração de pesquisa selecionada.

Ou Condição Escolhe a condição OR para a declaração de pesquisa selecionada.

Negate Condition Nega a declaração de pesquisa selecionada, para que todos
os itens que não coincidam com o critério da declaração sejam encontrados.

Delete Condition Exclui a declaração de pesquisa selecionada.

Delete All Conditions Exclui todas as declarações de pesquisa.

Botões

Find First Encontra o primeiro item qualificado, e o seleciona na Vista da
cena e Selection Tree.

Find Next Encontra o próximo item qualificado, e o seleciona na Vista da
cena e Selection Tree.

Find All Encontra todos os itens qualificados, e os realça na Vista da cena
e Selection Tree.

DICA Clique na guia Home ➤ Visibility ➤ Hide Unselected  para exibir
somente os resultados da pesquisa na Scene View.

Quick Find

Para localizar e selecionar rapidamente os objetos, utilize o recurso Quick
Find.

Para encontrar itens rapidamente

1 Clique na guia Home ➤ painel Select & Search.

2 Na caixa de texto Quick Find, digite a sequência de caracteres para
pesquisar por nas propriedades de todos os itens. Esta pode ser uma
palavra ou algumas palavras. A pesquisa não faz distinção entre letras
maiúsculas e minúsculas.
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3 Clique em Quick Find  . O Autodesk Navisworks encontra e seleciona
o primeiro item na Selection Tree que coincide com o texto inserido,
seleciona-o na Vista da cena, e para a pesquisa.

4 Para localizar mais itens, clique novamente em Quick Find  . Se houver
quaisquer outros itens que coincidam com o texto inserido, o Autodesk
Navisworks seleciona o próximo na Selection Tree, seleciona-o na
Vista da cena, e para a pesquisa. Cliques subsequentes encontram as
próximas instâncias.

Entrada do comando: Para abrir a caixa de diálogo Quick Find: CTRL
+ F. Para a caixa de diálogo Find Next: F3.

Localizar todas as folhas e os modelos que
contêm o objeto selecionado

É possível pesquisar um objeto em todos os modelos e folhas preparados no
Project Browser.

Os modelos exportados para o Autodesk Navisworks podem ser integrados às
folhas 2D exportadas do mesmo aplicativo de projeto para formar um arquivo
de múltiplas folhas. Por exemplo, os modelos exportados do Autodesk Revit
para o formato de arquivo NWC, DWF ou DWF(x) podem ser integrados a
qualquer folha 2D exportada para os arquivos DWF/DWF(x) do mesmo projeto
do Revit. Isso permite selecionar um componente do modelo no ambiente 3D
e, a seguir, localizar e revisar o mesmo componente em uma representação
2D (como uma planta baixa ou um corte). De forma similar, é possível
selecionar um item na folha 2D e localizá-lo no modelo 3D e em outras folhas
2D. Isso pode permitir que você, por exemplo, revise rapidamente um item
com interferência na planta baixa do sistema relevante.

Preparação de folhas/modelos a pesquisar

Quando você abre um arquivo de múltiplas folhas, nem todos os
modelos/folhas podem ter sido preparados para serem utilizados no Autodesk
Navisworks. Todos os modelos/folhas que requerem preparação são indicados
com o ícone Prepare  na janela Project Browser. Você pode usar o menu
de atalho Project Browser para preparar uma ou mais folhas ou modelos
(consulte Janela do navegador de projeto na página 230 ou é possível preparar
todos os modelos/folhas diretamente na janela Find Items in Other Sheets
and Models. O Autodesk Navisworks somente pesquisa modelos/folhas
preparados. Portanto, se alguma folha ou modelo em seu arquivo não tiver
sido preparado, ele não será incluído na pesquisa.
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Janela Localizar itens em outras folhas e
modelos

A janela Find Items in Other Sheets and Models (Localizar itens em
outras folhas e modelos) é uma janela encaixável que permite pesquisar um
objeto em todas as folhas ou modelos preparados no Project Browser.

A legenda no topo da janela indica o objeto selecionado no momento na
Scene View. O tipo de geometria é representado por um ícone na página 364
junto ao nome do objeto. Os ícones são os mesmos daqueles utilizados na
janela Selection Tree. Os resultados da pesquisa são exibidos na lista
Sheets/Models e contêm todas as folhas/modelos do arquivo que está aberto
atualmente no qual o objeto selecionado foi encontrado. Você pode classificar
os resultados clicando no cabeçalho da coluna desejada. Isso alterna a ordem
de classificação entre ascendente e descendente.

Para ativar a janela Find Item in Other Sheets and Models

■ Clique na guia View painel  ➤ Workspace menu suspenso  ➤ Windows
e selecione ou desmarque a caixa de seleção Find Item in Other Sheets
and Models.

Para localizar todas as folhas e modelos que contêm o objeto selecionado

1 Clique em  na barra de status para abrir a janela Project Browser.

2 Clique duas vezes na folha ou no modelo com o objeto que deseja
localizar em outras folhas e modelos e selecione a folha ou o modelo na
Scene View.
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3 Clique com o botão direito do mouse no objeto e clique em Find Item
in Other Sheets and Models no menu de atalho.

4 Se você visualizar um ícone de status do aviso  na janela Find Item
in Other Sheets and Models, clique no botão Prepare All. Uma vez
que todos os modelos/folhas tiverem sido preparados, você verá uma
lista de todos os modelos/folhas que contêm o objeto.

5 Selecione o modelo ou a folha na lista e clique em View para abrir. O
Autodesk Navisworks aplica o zoom no objeto selecionado.
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Botões

Prepare All Prepara todas as folhas e os modelos não preparados no arquivo
de múltiplas folhas aberto atualmente.

View Abre a folha ou o modelo selecionado no momento na Scene View.

Ícones de status

Nem todos os modelos/folhas podem ser pesquisados no arquivo de
múltiplas folhas aberto atualmente; ao menos uma folha ou um modelo ainda
não foi preparado.

Todos os modelos/folhas do arquivo de múltiplas folhas abertos
atualmente foram pesquisados e os resultados estão atualizados.
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Criar e utilizar conjuntos de objetos
No Autodesk Navisworks, é possível criar e utilizar conjuntos de objetos
semelhantes. Isso facilita a revisão e análise de seu modelo.

Conjuntos de seleção

Conjuntos de seleção são grupos estáticos de itens, e são úteis para salvar um
grupo de objetos nos quais você deseja executar algum tipo de ação, como
ocultá-los, alterar sua transparência, e assim por diante. Eles apenas armazenam
um grupo de itens para posterior recuperação. Não há nenhum inteligência
por detrás deste conjunto - se o modelo é modificado, os mesmos itens são
selecionados (assumindo que ainda estejam disponíveis no modelo) ao chamar
novamente o conjunto de seleção.

Conjuntos de pesquisa

Conjuntos de pesquisa são grupos dinâmicos, e funcionam de forma similar
aos conjuntos de seleção exceto pelo fato de terem um critério de pesquisa ao
invés de resultados de uma seleção, para que você possa reexecutar a pesquisa
em uma data posterior da data de alteração do modelo. Os conjuntos de
pesquisa são muito mais poderosos e podem economizar tempo, especialmente
se seus arquivos de CAD continuam a ser atualizados e revisados. Também é
possível exportar conjuntos de pesquisa e compartilhá-los com outros usuários.

Janela Sets

A janela Sets é uma janela encaixável, que exibe os conjuntos de seleção e
conjuntos de pesquisa disponíveis no seu arquivo do Autodesk Navisworks.
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Os conjuntos de seleção são indicados por este ícone:  , e os conjuntos de

pesquisa são identificados por este ícone:  .

OBSERVAÇÃO A lista dos itens na janela Sets é exatamente a mesma que a lista
na guia Sets da Selection Tree.

Você pode personalizar os nomes dos conjuntos de seleção e de pesquisa e
adicionar comentários. É possível copiar e colar nomes da janela Sets. Para
fazer isto, clique com o botão direito em um item na janela Sets, e clique em
Copy Name no menu de contexto. Alternativamente, é possível clicar em
um item na janela Sets, e pressionar CTRL + C. O nome agora foi copiado
para a área de transferência.

Você também pode exibir os conjuntos de seleção e de pesquisa como links
na página 450 na Vista da cena. Esses links são automaticamente criados pelo
Autodesk Navisworks. Clicar em um link restaura a geometria no conjunto de
seleção ou pesquisa correspondente para a seleção ativa, e a realça na Vista
da cena e Selection Tree.

Você pode utilizar o menu de atalho Sets para criar e gerenciar conjuntos de
seleção e pesquisa no arquivo do Autodesk Navisworks.

Para alternar a janela Sets

■ Clique na guia View  ➤  painel Espaço de trabalho  ➤  menu suspenso
Windows, e selecione ou desmarque a caixa de verificação Sets.

Menu: Classic user interface: View  ➤  Control Bars  ➤  Selection Sets
Entrada do comando: Shift + F2

Para usar a janela Sets para selecionar objetos

1 Abra a janela Sets.

2 Clique no conjunto desejado na lista. A geometria neste conjunto é
selecionada na Vista da cena e Selection Tree.

OBSERVAÇÃO Se você clicou em um conjunto de pesquisa, a pesquisa é
executada no modelo atual, pesquisando por toda a geometria que atenda
o critério de pesquisa, incluindo qualquer geometria adicional que poderia
ter sido adicionada no arquivo.

Menu: Classic user interface: Edit ➤ Select ➤ Sets ➤  <Saved Set>
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Para alterar a ordem de classificação na janela Sets

1 Abra a janela Sets.

2 Clique com o botão direito do mouse na lista, e clique em Sort. O
conteúdo da guia agora está classificado na ordem alfabética.

O menu de atalho Sets possui as seguintes opções:
■ New Folder. Cria uma pasta acima do item selecionado.

■ Add Current Selection. Salva a seleção atual como um novo conjunto
de seleção na lista. Este conjunto contém toda a geometria atualmente
selecionada.

■ Add Current Search. Salva a pesquisa atual com um conjunto de pesquisa
na lista. Este conjunto contém o critério de pesquisa atual.

■ Make Visible. Se a geometria na pesquisa selecionada ou no conjunto
de seleção estiver oculta, é possível utilizar esta opção para torná-la visível.

■ Add Copy. Cria uma cópia do conjunto de pesquisa ou de seleção realçado
na lista. A cópia tem o mesmo nome que o conjunto original, mas com
um sufixo "X", onde "X" é o próximo número disponível.

■ Add Comment. Abre a caixa de diálogo Add Comment para o item
selecionado.

■ Edit Comment. Abre a caixa de diálogo Edit Comment para o item
selecionado.

■ Update. Atualiza o conjunto de pesquisa selecionado com o critério de
pesquisa atual ou atualiza o conjunto de seleção selecionado com a
geometria atualmente selecionada.

■ Delete. Exclui o conjunto de pesquisa ou de seleção selecionado.

■ Rename. Renomeia o conjunto de pesquisa ou de seleção selecionado.
Por padrão, novos conjuntos de seleção são chamados deConjunto de
seleção X e os conjuntos de pesquisa são chamados de “Search SetX”,
onde "X" é o próximo número disponível para ser adicionado à lista.

■ Copy Name. Copia o nome do conjunto de pesquisa para a área de
transferência.

■ Sort. Ordena o conteúdo da janela Sets em ordem alfabética.

■ Help. Inicia o sistema de ajuda on-line e exibe o tópico para os conjuntos
de seleção e de pesquisa.
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Criar e gerenciar conjuntos de seleção e de
pesquisa

Você pode adicionar, mover e excluir conjuntos de seleção e de pesquisa e
organizá-los em pastas.

Os conjuntos de pesquisa e de seleção podem ser atualizados. É possível
modificar a sua seleção atual na Vista da cena, ou o critério de pesquisa
atual, e alterar o conteúdo do seu conjunto para refletir isto.

Você também pode exportar conjuntos de pesquisa e reutilizá-los Por exemplo,
se o modelo contém os mesmos componentes, como uma estrutura de aço,
dutos de ventilação, e assim por diante, poderá definir conjuntos de pesquisa
genéricos, exportá-los como um arquivo XML, e compartilhar com outros
usuários.

Para salvar um conjunto de seleção

1 Selecione todos os itens que deseja salvar na Vista da cena ou na
Selection Tree.

2 Clique na guia Home painel  ➤ Select & Search ➤ Save Selection

 .

3 Insira um nome para seu conjunto de seleção na janela Sets e pressione
ENTER.

Menu: Classic user interface: Edit  ➤  Select  ➤  Sets  ➤  Add Current
Selection

Para salvar um conjunto de pesquisa

1 Abra a janela Find Items e defina o critério de pesquisa desejado.

2 Clique no botão Find All para executa a pesquisa. Todos os itens que
satisfazem o seu critério agora estão selecionados na Vista da cena e
Selection Tree.

3 Abra a janela Sets, clique com o botão direito, e clique em Add Current
Search.

4 Insira um nome para seu conjunto de pesquisa e pressione ENTER.

Menu: Classic user interface: Edit  ➤  Select  ➤  Sets  ➤  Add Current Search
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Para renomear um conjunto de pesquisa ou de seleção

1 Abra a janela Sets.

2 Clique com o botão direito do mouse no conjunto de pesquisa ou de
seleção, e clique em Rename.

3 Insira um novo nome para seu conjunto e pressione ENTER.

Entrada do comando: F2

Para excluir um conjunto de pesquisa ou de seleção

1 Abra a janela Sets.

2 Clique com o botão direito do mouse no conjunto de pesquisa ou de
seleção que deseja remover, e clique em Remove.

Para organizar conjuntos de seleção e de pesquisa em pastas

1 Abra a janela Sets.

2 Clique com o botão direito do mouse, e clique em New Folder no menu
de atalho. A pasta é adicionada na lista.

Se, ao clicar com o botão direito do mouse, o item selecionado for uma
pasta, então a nova pasta é criada dentro dela, caso contrário, ela é
adicionada acima do item selecionado. Você pode ter quantas pastas
desejar.

3 Insira um nome para sua pasta e pressione ENTER.

DICA Utilize nomes que possam ajudá-lo a identificar seus conjuntos no
futuro.

4 Selecione o conjunto que deseja adicionar em sua nova pasta. Mantenha
pressionado o botão esquerdo do mouse e arraste o mouse para o nome
da pasta. Solte o botão do mouse para soltar o conjunto na pasta.

DICA Você também pode arrastar as próprias pastas junto com seu conteúdo.

Para atualizar um conjunto de seleção

1 Selecione a geometria desejada na Vista da cena ou na Selection Tree.

2 Abra a janela Sets.

3 Clique com o botão direito do mouse no conjunto que deseja modificar
e clique em Update.
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Para atualizar um conjunto de pesquisa

1 Abra a janela Find Items e excute uma nova pesquisa.

2 Abra a janela Sets.

3 Clique com o botão direito no conjunto de pesquisa que deseja modificar
e clique em Update.

Para exportar conjuntos de pesquisa

1 Clique na guia Output painel  ➤ Export Data ➤ Search Sets  .

2 Na caixa de diálogo Export , procure pela pasta desejada.

3 Insira um nome de arquivo e clique em Save.

Para importar conjuntos de pesquisa

1 Clique no botão do aplicativo  ➤ Options.

2 Na caixa de diálogo Import, procure pela pasta contendo o arquivo
com o conjunto de pesquisa e a selecione.

3 Clique em Open.

Comparar objetos
Você pode pesquisar por diferenças entre quaisquer dois itens selecionados
na cena. Estes itens podem ser arquivos, camadas, grupos ou apenas a
geometria.

Você também pode utilizar este recurso para investigar as diferenças entre
duas versões do mesmo modelo.

Durante a comparação , o Autodesk Navisworks inicia ao nível de cada item,
e recursivamente desce por cada caminho na Selection Tree. A comparação
de cada item, vem através dos termos de critério necessários.

Quando a comparação tiver terminado, os resultados podem ser realçados na
Vista da cena. A seguinte codificação de cores é utilizada por padrão:
■ White. Itens coincidentes.

■ Red. Itens com diferenças.

■ Yellow. O primeiro item contém coisas não encontradas no segundo item.
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■ Cyan. O segundo item contém coisas não encontradas no primeiro item.

Você pode salvar os resultados da comparação como conjuntos de seleção com
comentários automáticos descrevendo as diferenças encontradas em mais
detalhes.

Para comparar duas versões do modelo

1 Abra no Autodesk Navisworks o primeiro arquivo que deseja comparar.

2 Clique na guia Home ➤ painel Project ➤ menu suspenso

Append ➤ Append  , localize o segundo arquivo, e clique em Open.

3 Mantenha pressionada a tecla CTRL e selecione ambos os arquivos.

4 Clique na guia Home painel  ➤ Tools ➤ Compare  .

5 Na caixa de diálogo Compare , na área Find Differences In , selecione
as caixas de seleção para todas as opções requeridas.

OBSERVAÇÃO As caixas de seleção Overridden Material e Overridden
Transform se referem a alterações na cor e na transparência no Autodesk
Navisworks, e a alteração da origem, escala ou rotação de um arquivo desde
seu carregamento no Autodesk Navisworks, respectivamente. Estas caixas
de seleção são desmarcadas por padrão. Todos os outros critérios se referem
as propriedades dos itens do modelo de CAD original.

6 Na área Results , selecione as caixas de seleção para controlar como os
resultados da comparação são exibidos:
■ Save as Selection Sets. Salva os itens que você está comparando

como um conjunto de seleção. Você pode utilizar este conjunto para
comparações posteriores entre os mesmos itens.

■ Save Each Difference As Set. Salva as diferenças resultantes
encontradas na comparação entre os dois itens como um conjunto
de seleção para posterior análise. O conjunto de seleção também terá
um comentário anexado, detalhando as diferenças em maior
profundidade.

■ Remove Old Results. Remove quaisquer conjuntos de seleção
resultantes de uma comparação anterior, para reduzir a confusão ao
visualizar os resultados.

■ Hide Matches. Oculta todos os itens que estão na mesma
comparação quando esta termina.

■ Highlight Results. Realça cada diferença resultante com uma
sobreposição de cor quando a comparação termina. É possível redefinir
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as cores à configuração anterior ao clicar na guiaHome ➤ painel

Project ➤ menu suspenso Reset All ➤ Appearances  .

7 Clique em OK.

Para comparar dois itens no modelo

1 Selecione exatamente dois itens na cena.

2 Clique na guia Home painel  ➤  Tools ➤  Compare  .

3 Utilize a caixa de diálogo Compare para definir a pesquisa de
comparação.

4 Clique em OK.

Propriedades do objeto
O Autodesk Navisworks suporta a conversão das propriedades do objeto para
muitos formatos de arquivos. Para obter mais detalhes relativos as entidades
suportadas/não-suportadas, consulte Utilizar leitores de arquivos na página
182.

Janela Properties

Uma vez trazidas para o Autodesk Navisworks, as propriedades do objeto
podem ser examinadas na janela Properties.
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A janela Properties é uma janela encaixável, que possui uma guia dedicada
para categoria de propriedade associada com o objeto selecionado atualmente.

Propriedades internas do arquivo, como as propriedades de transformação e
geometria, não são exibidas por padrão. O Options Editor permite ativar
isso.

É possível utilizar o menu de atalho Properties para criar e gerenciar
propriedades personalizadas de objeto e links na página 450.

Também é possível trazer mais propriedades do objeto para o Autodesk
Navisworks de bancos de dados externos, e mostrar nas guias específicas do
banco de dados na janela Properties.

Para alternar a janela Properties

■ Clique na guia View ➤ painel Workspace ➤ menu suspenso
Windows, e selecione ou desmarque a caixa de seleção Properties.

Menu: Classic user interface: View ➤ Control Bars ➤ Properties
Entrada do comando: Shift + F7

Para analisar as propriedades dos objetos

1 Selecione o objeto de interesse na Selection Tree, ou na Vista da
cena.

2 Abra a janela Properties , e utilize as guias para navegar entre as
categorias de propriedades disponíveis.

OBSERVAÇÃO Se mais de um objeto estiver selecionado, a janela
Propertiessomente mostra o número de itens selecionados e não mostra
nenhuma informações da propriedade.
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Para adicionar guias com propriedades internas na janela Properties

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Developer.

3 Na página Developer , selecione a caixa de seleção Show Internal
Properties.

4 Clique em OK.

O menu de atalho Properties tem as seguintes opções:
■ Copy Value Copia o valor selecionado.

■ Copy Row Copia a linha selecionada.

■ Copy All Copia tudo na guia.

■ Edit Links. Abre a caixa de diálogo Edit Links.

■ Add New User Data Tab. Adiciona uma guia de propriedade
personalizada na janela Properties.

■ Delete New User Data Tab. Exclui a guia de propriedade personalizada
no momento selecionada da janela Properties.

■ Insert New Property. Adiciona uma propriedade personalizada.

■ Delete Property. Exclui a propriedade personalizada no momento
selecionada.

■ Edit Property Value. Permite editar o valor para todos os tipos de
propriedades, exceto Boolean.

■ Set Value. Permite editar o valor para o tipo de propriedade Boolean.

■ Rename Property. Renomeia a propriedade personalizada no momento
selecionada.

■ Rename Tab. Renomeia a guia de propriedade personalizada no momento
selecionada na janela Properties.

Propriedades personalizadas

As informações da propriedade trazida para o Autodesk Navisworks de um
aplicativo de CAD não podem ser editadas, com exceção de cor, transparência
e links. No entanto, é possível adicionar sua própria informação personalizada
em qualquer item na cena do modelo.
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Para adicionar uma guia de propriedade personalizada

1 Abra a janela Properties.

2 Selecione o objeto de interesse na Vista da cena ou na Selection Tree.

3 Clique com o botão direito do mouse na janela Properties , e clique
em Add New User Data Tab. A nova categoria de propriedade é
adicionada para o objeto no momento selecionado. Por padrão, a guia
é denominada como User Data.

Para renomear uma guia de propriedade personalizada

1 Abra a janela Properties.

2 Clique na guia personalizada que deseja renomear.

3 Clique com o botão direito do mouse na área Properties e clique em
Rename Tab.

4 Insira um novo nome para a guia na caixa fornecida.

5 Clique em OK.

Para excluir uma guia de propriedade personalizada

1 Abra a janela Properties.

2 Clique na guia personalizada que deseja excluir.

3 Clique com o botão direito do mouse na área Properties, e clique em
Delete User Data Tab.

Para adicionar uma propriedade personalizada

1 Abra a janela Properties.

2 Clique na guia personalizada onde deseja adicionar uma propriedade.

3 Clique com o botão direito do mouse na área Properties, clique em Insert
New Property, e clique no tipo de propriedade que deseja adicionar.
Escolha:
■ String - se o valor da propriedade for uma sequência

■ Boolean - se o valor da propriedade for Yes ou No

■ Float - se o valor da propriedade for um valor decimal, por exemplo:
1,234

■ Integer - se o valor da propriedade for um número inteiro positivo
(1, 2, 3,...), um número inteiro negativo (-1, -2, -3,...), ou zero (0)

4 Insira o nome da propriedade na caixa Property e pressione ENTER.
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5 Clique duas vezes na caixa Value, insira o valor associado à sua
propriedade na caixa fornecida, e clique em OK.

OBSERVAÇÃO Para a propriedade Boolean, clicar duas vezes na caixa Value
, alterna entre os valores Yes e No.

Para editar uma propriedade personalizada

1 Abra a janela Properties.

2 Clique na guia personalizada onde está localizada a propriedade que
deseja editar.

3 Para renomear a propriedade, clique com o botão direito do mouse nela,
clique em Rename Property, e insira o novo nome na caixa fornecida.
Clique em OK.

4 Para editar o valor da propriedade, clique com o botão direito do mouse
nela, clique em Edit Property Value, e insira o novo valor na caixa
fornecida. Clique em OK.

OBSERVAÇÃO Para a propriedade Boolean, clique em Set Value no menu
de atalho, e escolha Yes ou No.

Para excluir uma propriedade personalizada

1 Abra a janela Properties.

2 Clique na guia personalizada onde está localizada a propriedade que
deseja excluir.

3 Clique com o botão direito do mouse na propriedade, e clique em Delete
Property.

Links de bancos de dados externos

Os bancos de dados são normalmente utilizados para armazenar grandes
quantidades de dados, como especificações de equipamentos, dados de catálogo
e manuais de manutenção.

Você pode conectar-se aos bancos de dados externos diretamente dos arquivos
do Autodesk Navisworks, além de criar links entre objetos na cena e nos campos
nas tabelas do banco de dados para restaurar propriedades extras.

Qualquer banco de dados com um driver de ODBC adequado é suportado,
mas as propriedades para os objetos no modelo precisam incluir identificadores
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únicos aos dados no banco de dados. Por exemplo, para arquivos com base
no AutoCAD, manipuladores de entidade podem ser utilizados.

Você pode ter quantos bancos de dados e links que desejar, mas todos eles
precisam ter nomes únicos. Para utilizar um link de banco de dados, primeiro
é preciso ativá-lo.

Os links do banco de dados podem ser salvos dentro do arquivos do Autodesk
Navisworks (NFW e NWD). Você também pode salvar globalmente os links
do banco de dados, tornando-os persistentes em todas as sessões do Autodesk
Navisworks. As informações de conexão global são salvas na maquina local.
Se o banco de dados associado estiver disponível ao carregar o arquivo
NWF/NWD, o link é automaticamente estabelecido quando um objeto é
selecionado. Na seleção de um objeto, se o banco de dados estiver disponível,
e houver dados associados ao objeto, o Autodesk Navisworks adiciona uma
guia apropriada do banco de dados à janela Properties e exibe os dados
apropriados.

OBSERVAÇÃO  Para ser capaz de exibir os dados, é preciso configurar os detalhes
de conexão. Talvez precise de um gerenciador do banco de dados para fazer isto,
já que é necessário um conhecimento sobre a conexão do banco de dados. Você
pode utilizar os identificadores do Autodesk Navisworks em sequências de conexão
e declarações SQL.

Dados vinculados de uma conexão de banco de dados podem ser extraídos e
embutidos como dados estáticos dentro do arquivo NWD publicado. Estes
também podem ser incluídos nas pesquisas de objetos e podem ser usados
com a ferramenta Clash Detective como parte do critério de interferência.

É possível exportar links de banco de dados e compartilhá-los com outros
usuários.

Para adicionar um link de banco de dados

1 Se você deseja adicionar um link de banco de dados no arquivo do
Autodesk Navisworks:

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , na guia DataTools , clique no
botão New.
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2 Se você deseja adicionar globalmente um link de banco de dados:

a Clique na guia Home painel  ➤ Tools ➤ DataTools  .

b Na caixa de diálogo DataTools , clique no botão New.
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3 Na caixa de diálogo New Link , insira um Nome para o novo link, por
exemplo 'Informações de serviços'. Este é o nome da guia que irá aparecer
na janela Properties.

Você agora está pronto para configurar o link do banco de dados.

4 Clique em OK para salvar o link e retornar à caixa de diálogo anterior.
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Para configurar um link de banco de dados

1 Para configurar um link de banco de dados com base em um arquivo:

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia DataTools , clique no
link que deseja configurar na área DataTools Links , e clique no
botão Edit.

OBSERVAÇÃO Se você ainda não adicionou quaisquer links, clique
no botão New , e siga o procedimento para primeiro adicionar links
do banco de dados.

2 Para configurar um link global de banco de dados:

A Clique na guia Home painel  ➤ Tools ➤ DataTools  .

B Na caixa de diálogo DataTools , clique no link que deseja
configurar na área DataTools Links , e clique no botão Edit.
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OBSERVAÇÃO Se você ainda não adicionou quaisquer links, clique
no botão New , e siga o procedimento para primeiro adicionar links
do banco de dados.

3 Configurar o driver ODBC:

a Na caixa de diálogo Edit Link, selecione o Driver OBDC apropriado
para definir o tipo de banco de dados a ser vinculado, por exemplo,
Microsoft Access Driver (*.mdb).

b Clique no botão Setup. O assistente do driver é aberto e o guia
através das opções de configuração. Caso tenha dificuldades para
configurar seus detalhes de conexão, contate seu administrador do
banco de dados. Quando terminar, a caixa abaixo irá mostrar a
sequência de conexão. Esta sequência pode ser modificada se
necessário.

Por exemplo, se você deseja selecionar um banco de dados com um
determinado nome (digamos, test.mdb) que sempre está perto do
arquivo de modelo (como no NWD/NWF resultante e não no
original), digite:
DBQ=%pushpath(%poppath(%currentpath),"test.mdb");

DRIVER={Microsoft Access Driver (*.mdb)};

Se você deseja selecionar um banco de dados com o mesmo nome
do arquivo de modelo original (digamos, AutoPlant), digite:
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DBQ=%join(%removeext(%removepath(%sourcepath)),".mdb");

DRIVER={Microsoft Access Driver (*.mdb)};

4 Selecione a caixa de seleção Hold Open for Application Lifetime
se desejar manter aberto o link do banco de dados até você sair do
Autodesk Navisworks.

5 Especifique qual tabela do banco de dados a ser consultada:

No campo SQL String , clique após SELECT, e insira a declaração de
seleção, por exemplo: SELECT * FROM tblBoilerData WHERE

"NWUniqueID" = %prop("Entity Handle", "Value");

Esta declaração instrui o Autodesk Navisworks a selecionar todas as
colunas na tabela tblBoilerData, exigindo que a coluna denominada
NWUniqueID coincida com um par categoria/propriedades denominado
Entity Handle/Value.

6 Selecione quais colunas que deseja exibir como categorias de link na
janela Properties:

a Clique duas vezes em Fields Name , e digite o nome exato da
coluna do banco de dados, por exemplo: “Temporário”.

b Pressione ENTER.

Display Name é automaticamente completado por você, e é
possível clicar nele, e inserir outro nome se desejado. O texto aqui
inserido é o nome da categoria mostrado na guia Link da janela
Properties.

c Repita o processo acima para listar todas as categorias requeridas
na área Fields da caixa de diálogo.
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7 Clique em OK.

IMPORTANTE O modelo não é vinculado aos dados externos de origem até você
ter ativado o link do banco de dados.

Para excluir um link de banco de dados

1 Para excluir um link de banco de dados com base no arquivo:

a Clique na guia Home painel  ➤ Project ➤ File Options  .

b Na caixa de diálogo File Options , na guia, DataTools , clique
no link que deseja remover na área DataTools Links , e clique
no botão Delete.

2 Para excluir um link global de banco de dados:

a Clique na guia Home painel  ➤  Tools ➤  DataTools  .

3 Na caixa de diálogo DataTools , clique no link que deseja remover na
área DataTools Links e, clique no botão Delete.

4 Clique em OK.
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Para ativar o link do banco de dados

1 Para ativar um link do banco de dados com base no arquivo:

a Clique na guia Home painel  ➤ Project ➤ File Options  .

b Na caixa de diálogo File Options , guia DataTools , selecione as
caixas de seleção para todos os links que deseja ativar na área
DataTools Links.

2 Para ativar um link global de banco de dados:

a Clique na guia Home painel  ➤ Tools ➤ DataTools  .

b Na caixa de diálogo DataTools , selecione as caixas de seleção para
todos os links que deseja ativar na área DataTools Links.

3 Clique em OK.

IMPORTANTE Você não pode ativar links com informações insuficientes ou
inválidos de configuração.

Para exportar um link de banco de dados

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , guia DataTools , clique no link que
deseja exportar na área DataTools Links , e clique no botão Export.
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3 Na caixa de diálogo Save As, procure pela pasta desejada e insira um
nome para o arquivo datatools. Você também pode selecionar o nome
de um arquivo datatools existente para sobrepô-lo com sua configuração
modificada.
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4 Clique em Save.

5 Clique em OK para fechar a caixa de diálogo File Options.

Para importar um link de banco de dados

1 Clique na guia Home painel  ➤ Project ➤ File Options  .

2 Na caixa de diálogo File Options , clique na guia DataTools, e clique
no botão Import.

3 Na caixa de diálogo Open , procure pela pasta que contenha o arquivo
datatools requerido, selecione-o, e clique em Open.
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4 Clique em OK para fechar a caixa de diálogo File Options.

Você pode utilizar os seguintes identificadores do Autodesk Navisworks com
consultas SQL:

Identificador de propriedade

%prop("category","property") Propriedade do objeto no momento
selecionado. Categoria é o nome da guia na janela Properties (por exemplo,
Item ou Entity Handle) e propriedade é o nome naquela guia (por exemplo,
Value ou Layer).

%intprop("category","property") Propriedade do objeto no momento
selecionado. Este é igual ao identificador anterior, com exceção de utilizar a
categoria publicamente visível e o nome da propriedade, ele utiliza os nomes
internos do Autodesk Navisworks. O benefício de utilizar nomes internos é
que eles não são dependentes do idioma. Este é um identificador avançado
adequado para usuários familiarizados com a API do Autodesk Navisworks.

Identificadores de arquivo e caminho

%sourcepath Este identificador representa o caminho completo e o nome do
arquivo do qual o objeto no momento selecionado vem. Mesmo quando uma
coleção de modelos tiverem sido combinados em um arquivo NWD único,
este identificador ainda lembra do caminho e do nome do arquivo do arquivo
do modelo original.
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%currentpath Este identificador representa o caminho completo e o nome
do arquivo do modelo no momento carregado. Caso no momento você tenha
um NWF ou NWD carregado que contém muitos outros modelos, ele irá apenas
retornar o caminho e o nome do arquivo do nível NWF/NWD superior.

Identificadores de manipulação de arquivo e caminho

%removeext("text") Se o texto fornecido inclui um nome de arquivo com
uma extensão, este identificador remove a extensão.

%removepath("text") Se o texto fornecido inclui um caminho e nome de
arquivo, este identificador remove os caminhos e retorna o nome do arquivo.

%poppath("text") Se o texto fornecido inclui um caminho, este identificador
remove o nível superior. Se o texto também inclui um nome de arquivo, ele
conta como o nível superior e é removido. Por exemplo, %poppath(“c:\temp”)
se torna c:\ e %popath(c:\temp\readme.txt”) se torna c:\temp.

%pushpath("text1","text2") Se text1 é um caminho e text2 é um nome de
arquivo ou pasta, então text2 é adicionado no caminho em text1. Por
exemplo, %pushpath(“c:\test”,”model.nwd”) se torna c:\test\model.nwd.

Identificadores de manipulação de sequência

%join("text","text") Este identificador apenas juntas as duas partes do texto.
Por exemplo, %join(“c:\”,”model.nwd”) retorna c:\model.nwd.

Exemplos de consulta

Os exemplos abaixo ilustram como os identificadores devem ser utilizados
com consultas SQL.

■ Selecionando todas as colunas da tabela Test, enquanto requer que a coluna
denominada Entity Handles coincida com um par de categoria/propriedade
denominado como Entity Handle/Value e a coluna denominada como
File Name coincida com o nome do arquivo original do desenho:

SELECT * FROM Test WHERE "Entity Handle" = %prop("Entity

Handle","Value") AND “File Name” =

$removeext(%removepath(%sourcepath));

Aqui o caminho e a extensão do nome do caminho estão sendo recortados,
portanto, um arquivo como c:\model\3rdFloorDucts.dwg seria
3rdFloorDucts.
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■ Selecionando duas colunas da tabela Test, enquanto requer que a coluna
denominada como Entity Handle coincida com par de
categoria/propriedade denominado como Entity Handle/Value:

SELECT Name,Part FROM Test WHERE "Entity Handle" = %prop("Entity

Handle","Value");

■ Selecionando todas as colunas da tabela Test, enquanto requer que a coluna
denominada como Value esteja dentro de uma determinada faixa fornecidas
por dois pares de categoria/propriedade:

SELECT * FROM Test WHERE Value BETWEEN %prop("Pressure","Minimum")

AND %prop("Pressure","Maximum");

OBSERVAÇÃO Os identificadores não podem conter espaços em branco entre os
colchetes (a não ser que estejam circundados por aspas), portanto
%prop("EntityHandle","Value") funciona, mas %prop("EntityHandle",
"Value") não funciona.

Manipular atributos de objeto
No Navisworks Manage, você pode manipular a transformação de objetos
(translação, rotação e dimensão) e também alterar a aparência (cor e
transparência) de objetos. Toda a manipulação de objeto é executada na Vista
da cena.

Quaisquer alterações feitas nos atributos do objeto são consideradas como
globais (como se tivessem sido efetuadas no modelo de CAD original) e podem
ser salvas com os arquivos do Autodesk Navisworks. Você tem a opção de
redefinir os atributos do objeto de volta ao estado que tinham quando foram
importados dos arquivos de CAD originais.

Manipulando atributos do objeto durante a animação do objeto

É possível modificar a posição, rotação, tamanho e aparência de objetos de
geometria temporariamente para propósitos de animação. Estas alterações não
são globais e somente podem ser salvas (ou capturadas) como quadros-chave
da animação.
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Transformar objetos

Pata transformar objetos, você pode usar três ferramentas de manipulação
visual, ou meta-alças, disponíveis na guia Item Tools  ➤  painel Transform.
Também é possível transformar numericamente os objetos.

Para obter uma visualização mais clara de um objeto ao efetuar sua
manipulação, você poderá utilizar o Options Editor para ajustar a forma na
qual a seleção atual é realçada. Para obter mais informações, consulte Definir
o método de realce na página 371.

Utilizando ferramentas de medição para transformar objetos

É possível utilizar a funcionalidade Ferramentas de medição na página 418 para
mover e rotacionar os objetos selecionados no momento.

Para mover um objeto com a meta-alça

1 Selecione o objeto que deseja mover na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Transform  ➤  Move  .

3 Utilize a meta-alça de movimentação para ajustar a posição do objeto
no momento selecionado:
■ Para mover os objetos selecionados no momento, coloque o mouse

sobre a seta na extremidade do eixo desejado. Quando o cursor mudar
para  , arraste a seta na tela para aumentar/diminuir a conversão
ao longo daquele eixo.

■ Para mover os objetos ao longo de diversos eixos ao mesmo tempo,
arraste a moldura quadrada entre os eixos desejados.

Arrastar a bola no meio do gizmo de movimentação permite efetuar
o snap deste ponto central para outras geometrias no modelo.

■ Para mover o próprio gizmo em vez dos objetos selecionados,
mantenha pressionada a tecla CTRL ao arrastar a bola no meio do
gizmo. O gizmo de movimentação irá se alinhar aos outros objetos
enquanto você executa essa ação.

Para mover um objeto numericamente

1 Selecione o objeto que deseja mover na Vista da cena.

2 Clique na guia Item Tools, e deslize o painel Transform.
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3 Digite os valores numéricos nas caixas de entrada manual para mover o
objeto pelo valor inserido:
■ Position X, Y, Z representa a distância de tradução na unidade do

modelo atual.

■ Transform Center X, Y, Z representa o ponto central de tradução.

Para mover um objeto sobrepondo sua transformação (interface de usuário
clássica somente)

1 Selecione o objeto que deseja mover na Vista da cena.

2 Clique em Edit  ➤  Override Item  ➤  Override Transform.

3 Na caixa de diálogo Override Transform, insira os valores XYZ da
transformação a ser aplicada ao objeto atualmente selecionado. Por
exemplo, uma transformação de (0, 0, 1) reposiciona um objeto por uma
unidade na direção Z.

4 Clique em OK.

Para mover um objeto com uma ferramenta de medição

1 Selecione o objeto que você deseja mover.

2 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point Line  .

3 Clique no objeto selecionado para criar o primeiro ponto. Este é o ponto
inicial do qual o reposicionamento será calculado.

4 Clique no segundo ponto na cena. Este é o ponto para onde o objeto
será movido. Agora há uma linha conectando o ponto inicial e o ponto
final na Vista da cena.

5 Se você deseja ser capaz de mover o objeto diversas vezes, crie mais pontos
na cena.
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OBSERVAÇÃO Você somente pode selecionar um ponto em outro objeto
na cena. Selecionar um ponto no 'espaço' não é uma opção válida. Para
reposicionar um objeto no 'espaço', é possível utilizar uma meta-alça de
tradução, ou se conhece a distância pela qual o objeto será movido, ao
sobrepor sua transformação.

6 Deslize o painel Measure, e clique em Transform Selected Items
para mover o objeto para o segundo ponto. Caso tenha múltiplos pontos
na cena, cada vez que clicar em Transform Objects, o objeto
selecionado é movido para o próximo ponto.

Para rotacionar um objeto com a meta-alça

1 Selecione o objeto que deseja rotacionar na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Transform  ➤  Rotate  .

3 Use a meta-alça para rotacionar o objeto atualmente selecionado:
■ Antes de poder rotacionar os objetos no momento selecionados, é

preciso posicionar a origem (ponto central) da rotação. Para fazer
isso, coloque o mouse sobre a seta na extremidade do eixo desejado.
Quando o cursor mudar para  , arraste a seta na tela para
aumentar/diminuir a conversão ao longo daquele eixo. Isto irá mover
a meta-alça por conta própria.

Arrastar a bola no meio do gizmo de rotação permite movê-la ao redor
do eixo e efetuar o snap para pontos em outros objetos da geometria.
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■ Uma vez que a meta-alça de rotação esteja corretamente posicionada,
coloque o mouse sobre uma das curvas no meio, e arraste-a na tela
para rotacionar os objetos selecionados. As curvas são codificadas por
cores e a coincidência da cor do eixo é utilizada para rotacionar o
objeto em torno. Portanto, por exemplo, arrastar a curva azul entre
os eixos X e Y, rotaciona os objetos em torno do eixo Z azul.

■ Para rotacionar a orientação da meta-alça para uma posição arbitrária,
mantenha pressionada a tecla CTRL ao arrastar uma das três curvas
no meio.

■ Para efetuar o snap do gizmo em outros objetos, mantenha
pressionada a tecla CTRL ao arrastar a bola no meio do gizmo.

Para rotacionar um objeto numericamente

1 Selecione o objeto que deseja rotacionar na Vista da cena.

2 Clique na guia Item Tools, e deslize o painel Transform.

3 Digite os valores numéricos nas caixas de entrada manual para mover o
objeto pelo valor inserido:
■ Rotation X, Y, Z representa os graus de rotação da unida do modelo

atual.

■ Transform Center X, Y, Z representa o ponto central de rotação.

Para rotacionar um objeto com uma ferramenta de medição

1 Selecione o objeto que você deseja mover.

2 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Measure Angle  .

3 Para rotacionar o objeto, clique nos três pontos no objeto selecionado
para determinar como o objeto deve ser rotacionado (consulte o diagrama
abaixo).

Manipular atributos de objeto  | 413



Este diagrama ilustra como o objeto selecionado (posição) é rotacionado.
Linhas do primeiro ao segundo ponto (1 a 2) e do segundo ao terceiro
ponto (2 a 3) definem o ângulo pelo qual o objeto é rotacionado (por
exemplo, 90 graus). O segundo ponto (2) é utilizado como o ponto central
da rotação.

4 Deslize o painel Measure e clique em Transform Selected Items
. Isto gira o objeto da posição A à posição B (como mostrado no diagrama
anterior). Clicar novamente neste botão, rotaciona o objeto da posição
B para a posição C.

Para redimensionar um objeto com a meta-alça

1 Selecione o objeto que deseja redimensionar na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Transform  ➤  Rotate  .

3 Utilize a meta-alça de escala para redimensionar o objeto no momento
selecionado:
■ Para redimensionar os objetos ao longo de um único eixo, utilize

setas coloridas na extremidade dos eixos. Para redimensionar os
objetos ao longo de dois eixos ao mesmo tempo, use triângulos
coloridos no meio dos eixos. Finalmente, para redimensionar os
objetos ao longo dos três eixos ao mesmo tempo, utilize o círculo no
centro do gizmo.

■ É possível modificar o centro da escala. Para fazer isso, coloque o
mouse sobre o círculo no meio do gizmo e mantenha pressionada a
tecla CTRL enquanto arrasta o círculo na tela.
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Para redimensionar um objeto numericamente

1 Selecione o objeto que deseja redimensionar na Vista da cena.

2 Clique na guia Item Tools, e deslize o painel Transform.

3 Digite os valores numéricos nas caixas de entrada manual para mover o
objeto pelo valor inserido:
■ Scale X, Y, Z representa o fator de escala (1 sendo o tamanho atual,

0.5 metade, 2 sendo o dobro, e assim por diante).

■ Transform Center X, Y, Z representa o ponto central da escala.

Alterar a aparência do objeto

Você pode aplicar cores e transparências personalizadas na geometria na cena.

Por exemplo, quanto estiver tratando com modelos com materiais e texturas
não suportados, toda a geometria é exibida em sua cor de estrutura de arame.
Você pode alterar (ou sobrepor) a aparência dos objetos na cena para obter
uma apresentação mais realística.

Você também pode utilizar a ferramenta Presenter para aplicar materiais de
textura em objetos na cena para obter resultados ainda melhores.

OBSERVAÇÃO Quaisquer materiais aplicados com a ferramenta Presenter
sobrepõe quaisquer alterações de cor e transparência.

Para alterar a cor

1 Selecione o objeto que deseja modificar na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Appearance  ➤  menu suspenso
Color, e selecione a cor desejada.

Menu: Classic user interface: Edit  ➤  Override Item  ➤  Override Color

Para alterar a transparência

1 Selecione o objeto que deseja modificar na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Appearance.

3 Mova o deslizador Transparency para ajustar o quão transparente ou
opaco o objeto selecionado é.
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Menu: Classic user interface: Edit  ➤  Override Item  ➤  Override
Transparency

Snap

O snap oferece o controle ao medir, mover, rotacionar e dimensionar objetos
do Autodesk Navisworks.

Pontos e pontos de snap tem o snap automaticamente efetuado neles. Você
pode definir o cursor para efetuar o snap para o vértice, aresta ou linha mais
próximo ao selecionar a geometria. Você também pode ajustar o ângulo do
snap e a tolerância de snap que são utilizados ao rotacionar a geometria.

Diferentes cursores fornecem o feedback do que está recebendo o snap:

DescriçãoCursor

Nenhum snap, mas um ponto em uma
superfície é encontrado.

Um vértice, ponto, ponto de snap ou
extremidade da linha é encontrado no qual
efetuar o snap.

Também é encontrada uma arestas na qual
efetuar o snap.

A geometria no Autodesk Navisworks tem a suavização de serrilhado em
triângulos e, portanto, o cursor efetua o snap nas arestas que podem perecer
estar no meio de uma face. Considere exibir o modelo no modo de linha oculta
(Guia Ponto de visão  ➤  painel Render Style  ➤  menu suspenso Mode  ➤ 

Hidden Line  ) para clarificar para qual vértice ou extremidade o cursor
está efetuando o snap.

Para alternar o snap

■ Clique na guia Item Tools, deslize o painel Transform, e clique em Snap
Item  .
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Para personalizar as configurações de snap

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Snapping.

3 Na página Snapping , área Picking , selecione as caixas de seleção para
todos os snaps necessários, e insira a Tolerance de snap. Quanto menor
o valor, mais perto o cursor precisa estar para aparecer no modelo antes
de efetuar o snap.

4 Na área Rotation , insira o multiplicador para o ângulo de snap na caixa
Angles , e a tolerância de snap na caixa Angle Sensitivity. Quanto
menor o valor, mais perto o cursor precisa estar do ângulo de snap para
que o snap tenha efeito.

5 Clique em OK.

Redefinir para os valores originais

No Autodesk Navisworks, é possível redefinir os atributos do objeto de volta
para os valores nos arquivos de CAD originais.

Para restaurar a aparência original de um objeto ou grupo de objetos na sua
cena

Observação: Não é possível restaurar cores separadamente de transparências.

1 Selecione os objetos requeridos na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Appearance  ➤  Reset Appearance

 .

Para redefinir a aparência de todos os objetos na sua cena

Observação: Não é possível restaurar cores separadamente de transparências.
■ Clique na guia Início painel do  ➤  Project,  ➤  suspenso Reset All,  ➤ 

Appearances  .
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Para redefinir a transformação para um objeto ou grupo de objetos em sua
cena

1 Selecione os objetos requeridos na Vista da cena.

2 Clique na guia Item Tools  ➤  painel Transform  ➤  Reset Transform 
.

Para redefinir a transformação para todos os objetos em sua cena

■ Clique na guia Início painel do  ➤  Project,  ➤  suspenso Reset All,  ➤ 

Transforms  .

Ferramentas de medição
As ferramentas de medição permitem medir entre pontos em itens no modelo.
Todas as medições são feitas em unidades de exibição na página 169.

A utilização de ferramentas de medição é mutuamente exclusiva à utilização
das ferramentas de navegação (consulte Ferramentas de navegação específicas
do produto na página 259), portanto, quando você estiver medindo não poderá
navegar e vice-versa.

Janela Measure Tools

A janela Measure Tools é uma janela encaixável, que contém diversos botões
no topo, que permitem selecionar o tipo de medição que deseja efetuar.
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Para todas as medições, as coordenadas X, Y e Z do ponto Inicial e do ponto
Final são exibidas nas caixas de texto abaixo dos botões, junto com a
Diferença e a Distância absoluta. Se você utiliza a medição cumulativa,
como Point Line ou Accumulate, Distance mostra a distância acumulada
para todos os pontos registrados na medição.

OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis para as folhas
2D.

Para alternar a janela Measure Tools

■ Clique na guia Review  ➤  painel Measure  ➤  inicializador de ferramenta
Measure Options  .

Menu: Classic user interface: Tools  ➤  Measure

DescriçãoBotão

Mede a distância entre dois pontos.

Mede a distância entre um ponto base e
diversos outros pontos.

Mede a distância total entre múltiplos
pontos ao longo de uma rota.
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DescriçãoBotão

Calcula a soma total de diversas medições
ponto-a-ponto.

Calcula um ângulo entre duas linhas.

Calcula uma área em um plano.

Mede a distância mais curta entre dois
objetos selecionados.

Limpa todas as linhas de medição na Vista
da cena.

Permite mover ou rotacionar um objeto.

Converte os marcadores dos pontos finais
e quaisquer valores de medição em linhas
de marcação.

Medição

Você pode utilizar as ferramentas de medição para efetuar medições lineares,
angulares e de área, e para medir automaticamente a distância mais curta entre
dois objetos selecionados.

OBSERVAÇÃO Quando você mede, é preciso clicar em um ponto em um item
para registrar um ponto. Clicar no segundo plano não registra nada. É possível
reiniciar um comando de medição a qualquer momento ao clicar com o botão
direito, ao invés de clicar com o botão esquerdo, na Vista da cena. Isso inicia
novamente o comando de medição sem nenhum ponto registrado, como se você
tivesse escolhido um novo tipo de medição.
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Os pontos finais de linhas de medição padrão são representados como pequenos
símbolos de cruz na Vista da cena, e todas as linhas sendo medidas como
uma linha simples entre pontos registrados.

Os pontos finais de linhas de medição que recebem o snap as linhas centrais,
são representados como símbolos de cruz com marcadores CL adicionais.

É possível alterar a cor e espessura das linhas de medição, e alternar a exibição
de legendas de cota na Vista da cena.

Legendas de cota

Para medições com base na distância, a legenda da cota é desenhada para cada
segmento de linha. Para medições cumulativas, a legenda da cota mostra os
totais e é desenhada para o último segmento de linha. O texto é posicionado
relativo ao ponto central da linha.

Para medições angulares, um indicador de arco é exibido dentro dos ângulos,
com o centro do texto posicionado na linha invisível de bifurcação do ângulo.
Se um ângulo for muito agudo, a legenda será desenhada fora dele. Esta legenda
é fixa e não é redimensionada quando você aproxima ou afasta o zoom, a não
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ser que as linhas de medição se tornem muito curtas na tela para acomodar o
arco, em cujo caso será ajustada.

O Options Editor permite alternar a ativação e a desativação das legendas
de cota.

Para medições de área, a legenda de cota é posicionada no centro da área sendo
medida.

Convertendo medições para linhas de marcação

É possível converter medições para linhas de marcação. A própria medição é
limpa quando for convertida para uma linha de marcação, e a linha de
marcação pega a cor e espessura da linha no momento definidas para a linha
de marcação.

OBSERVAÇÃO Quando você converte medições para linhas de marcação, as linhas
e texto são armazenadas no ponto de vista atual.

Para alterar a espessura e cor das linhas de medição

1 Abra a janelaMeasure Tools e clique em Options .

2 No Options Editor, na página Measure sob o nó Interface , insira
o número desejado na caixaLine Thickness.

3 Selecione a cor requerida na paleta Color. Por padrão, as linhas de
medição são brancas.

4 Clique em OK.

Para alternar as legendas de cota

1 Abra a janelaMeasure Tools e clique em Options .

2 No Options Editor, na página Measure sob o nó Interface , selecione
a caixa de seleção Show Measurement values in Vista da cena.

3 Clique em OK.

Para medir a distância entre dois pontos

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point to Point  .

2 Clique nos pontos inicial e final da distância a ser medida na Vista da
cena.

A legenda de cota opcional exibe a distância medida.
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Menu: Classic user interface: Review  ➤  Measure  ➤  Point to Point

Para manter o mesmo ponto inicial ao medir a distância entre dois pontos

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point to Multiple Points  .

2 Clique no ponto inicial e no primeiro ponto final a ser medido. Uma
linha de medição é exibida entre dois pontos.

3 Clique para registrar o próximo ponto final a ser medido.

4 Repita para medir pontos finais adicionais se necessário. A legenda de
cota opcional sempre exibe a última distância medida. Seus pontos iniciais
permanecem os mesmos durante a medição.

DICA Se deseja alterar o ponto inicial, clique com o botão direito na Vista
da cena, e selecione um novo ponto inicial.

Menu: Classic user interface: Review  ➤  Measure  ➤  Point to Multiple
Points

Para medir a distância total ao longo de uma rota

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Point Line  .

2 Clique no ponto inicial e no segundo ponto a ser medido.

3 Clique no próximo ponto ao longo da rota.

4 Repita para medir toda a rota. A legenda de cota opcional exibe a distância
total ao longo da rota selecionada.
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DICA Se deseja alterar o ponto inicial, clique com o botão direito na Vista
da cena, e selecione um novo ponto inicial.

Menu: Classic user interface: Review  ➤  Measure  ➤  Point Line

Para calcular um ângulo entre duas linhas

1 Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure

 ➤  Angle  .

2 Clique em um ponto na primeira linha.

3 Clique na primeira linha no ponto onde ele efetua a intersecção com a
segunda linha.

4 Clique em um ponto na segunda linha. A legenda de cota opcional exibe
o ângulo calculado entre as duas linhas.

Menu: Classic user interface: Review  ➤  Measure  ➤  Measure Angle

Para calcular a soma total de diversas medições ponto-a-ponto

1 Clique na guia Review painel  ➤ Measure menu suspenso

 ➤ Measure ➤ Accumulate  .

2 Clique no ponto inicial e final da primeira distância a ser medida.
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3 Clique no ponto inicial e final da próxima distância a ser medida.

4 Repita para medir mais distâncias se necessário. A legenda de cota
opcional exibe a soma de todas as pedidas de ponto-a-ponto.

Menu: Classic user interface: Review ➤ Measure ➤ Accumulate

Para calcular uma área em um plano

1 Clique na guia Review ➤ painel Measure ➤ menu suspenso

Measure ➤ Area  .

2 Clique para registrar uma série de pontos para descrever o perímetro da
área que deseja calcular. A legenda de cota opcional exibe a área do
perímetro descrito desde o primeiro ponto, como projetado no plano do
ponto de vista.

OBSERVAÇÃO Para que seu cálculo seja mais preciso, todos os pontos
adicionados precisam estar no mesmo plano.

Menu: Interface de usuário Classic: Review ➤ Measure ➤ Measure Area

Para medir a distância mais curta entre dois objetos

1 Mantenha pressionada a tecla CTRL e selecione dois objetos na Scene

View com a ferramenta de seleção  .

Ferramentas de medição | 425



2 Clique na guia Review  ➤  painel Measure  ➤  Measure Shortest Distance

 .

A legenda de cota opcional exibe a distância mais curta entre os objetos
selecionados.

Menu: Classic user interface: Review  ➤  Measure  ➤  Measure Shortest
Distance

Para medir a distância mais curta entre dois objetos paramétricos

1 Mantenha pressionada a tecla CTRL e selecione dois objetos paramétricos

na Vista da cena com a ferramenta Select  .

2 Abra a janelaMeasure Tools e clique em Options .

3 No Options Editor, na página Measure sob o nó Interface , selecione
a caixa de seleção Use Center Lines, e clique em OK.

4 Clique na guia Review  ➤  painel Measure  ➤  Measure Shortest Distance

 .

A caixa Distance e a legenda opcional de cota exibem a distância mais
curta entre as linhas centrais dos objetos paramétricos selecionados.

Menu: Classic user interface: Review  ➤  Measure  ➤  Measure Shortest
Distance

Para limpar linhas de medição

■ Clique na guia Review  ➤  painel Measure  ➤  menu suspenso Measure  ➤ 

Clear  .
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Menu: Classic user interface: Review ➤ Measure ➤ Clear

Para converter medições em linhas de marcação

1 Clique na guia Review  ➤  painel Measure, e tira as medidas desejadas,
por exemplo, a distância entre dois pontos.

2 Clique na guia Review  ➤  painel Measure  ➤  Convert to Redline  .

Os marcadores finais, linhas e legenda de cota (se houver) de sua medição
atual são agora convertidos em uma linha de marcação e armazenados
no ponto de vista atual.

Comentários, linhas de marcação e
identificadores

Usar comentários, linhas de marcação e
identificadores

É possível adicionar comentários aos pontos de visão, às animações dos pontos
de visão, aos conjuntos de seleção e de pesquisa, aos resultados de interferências
e às tarefas do TimeLiner.

As ferramentas de revisão (linhas de marcação e identificadores) permitem
adicionar anotações nos pontos de visão e resultados de detecção de
interferência.

O uso de ferramentas de revisão é mutuamente exclusivo à utilização das
ferramentas de navegação (consulte Ferramentas de navegação específicas do
produto na página 259); portanto, quando você adiciona linhas de marcação
ou identificadores não é possível navegar e vice-versa.
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Janela Comments

A janela Comments é uma janela encaixável que permite visualizar e gerenciar
comentários.

A janela Comments mostra o nome, hora e data, autor, ID, status e assunto
(ou primeira linha) para cada comentário. Há diferentes ícones que ajudam a
identificar a origem de cada comentário em uma rápida olhada.

O menu de atalho Comment tem as seguintes opções:
■ Add Comment.Abre a caixa de diálogo Add Comment

■ Edit Comment. Abre a caixa de diálogo Edit Comment para o item
selecionado.

■ Delete Comment. Exclui o comentário selecionado.

■ Help. Inicia o sistema de ajuda on-line e exibe o tópico para comentários.

Você pode adicionar quantos comentários desejar para uma origem, na janela
Comments ou na própria origem.

DICA Para adicionar um comentário para um objeto específico na Vista da cena,
use identificadores.

Para alternar a janela Comments

■ Clique na guia Review ➤ painel Comments ➤ View Comments
.

Menu: Classic user interface: View  ➤  Control Bars  ➤  Comments
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Para adicionar um comentário para um ponto de vista

1 Clique na guia Viewpoint ➤ painel Save, Load &
Playback ➤ iniciador de ferramentas Saved Viewpoints  para
abrir a janela Saved Viewpoints.

2 Clique com o botão direto no ponto de vista desejado na janela Pontos
de visão salvos, e clique em Add Comment.

3 Na janela Comments digite seu comentário. Por padrão ele recebe o
status de 'New'.

4 Clique em OK.

Para adicionar um comentário para uma animação de ponto de vista

1 Clique na guia Viewpoint ➤ painel Save, Load &
Playback ➤ iniciador de ferramentas Saved Viewpoints  para
abrir a janela Saved Viewpoints.

2 Clique com o botão direito na animação de ponto de vista desejada na
janela Pontos de visão salvos, e clique em Add Comment.

3 Na janela Comments digite seu comentário. Por padrão ele recebe o
status de 'New'.

4 Clique em OK.

Para adicionar um comentário para um conjunto de seleção ou de pesquisa

1 Clique na guia Home ➤ painel Select & Search ➤ menu suspenso
Sets ➤ Manage Sets para abrir a janela Sets.

2 Clique com o botão direito do mouse no conjunto de pesquisa ou de
seleção desejado, e clique em Add Comment.

3 Na janela Comments digite seu comentário. Por padrão ele recebe o
status de 'New'.

4 Clique em OK.

Para adicionar um comentário para um resultado de interferência

1 Clique na guia Home ➤ painel Tools ➤ Clash Detective  para
abrir a janela Clash Detective, e clique na guia Results.

2 Na área Results , clique com o botão direito do mouse no resultado de
interferência desejado, e clique em Add Comment.
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3 Na janela Comments digite seu comentário. Por padrão ele recebe o
status de 'New'.

4 Clique em OK.

OBSERVAÇÃO Os comentários também podem ser atribuídos a um resultado de
interferência ao atribuir uma interferência utilizando a caixa de diálogo Assign
Clash na página 785, e são automaticamente inseridos quando você cancela a
atribuição de uma interferência, consulte Cancelar atribuição de uma interferência
na página 752.

Para adicionar um comentário à uma tarefa TimeLiner

1 Clique na guia Home painel  ➤ Tools ➤ TimeLiner  para abrir a
janela TimeLiner.

2 Clique na guia Tasks.

3 Clique com o botão direito do mouse na tarefa desejada e clique em Add
Comment.

4 Na janela Comments digite seu comentário. Por padrão ele recebe o
status de 'New'.

5 Clique em OK.

Para visualizar comentários

1 Abra a janela Comments.

2 Siga para a origem de seus comentários. Por exemplo, abra a janela
Pontos de visão salvos.

3 Quando você clica nos pontos de origem, por exemplo, pontos de visão
, os comentários associados são exibidos na janela Comments.

DescriçãoÍcone

Selection set

Search set

Clash result (new)

Clash result (approved)
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DescriçãoÍcone

Clash result (reviewed)

Clash result (resolved)

Clash result (active)

Ponto de visão (orthographic camera)

Ponto de visão (perspective camera)

Animação do ponto de visão

Corte da animação do ponto de visão

Tag

Tarefa TimeLiner (nenhum item anexado)

Tarefa TimeLiner (com itens anexados)

Tarefa TimeLiner (link sincronizado)

Tarefa TimeLiner ( link antigo ou interrompido)

Painel Redline Tools

O painel Redline Tools na guia Review permite marcar pontos de visão e
resultados de interferência com anotações de linha de marcação.
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Na interface de usuário clássica, você pode usar a janela encaixável Redline
Tools para adicionar linhas de marcação e identificadores.

Os controles Thickness e Color permitem modificar as configurações de
linha de marcação. Essas alterações não afetam as linhas de marcação
desenhadas. Também, a espessura somente se aplica as linhas; não afeta o
texto da linha de marcação, que tem um tamanho e espessura padrão e não
podem ser modificado.

Todas as linhas de marcação somente podem ser adicionadas a um ponto de
vista salvo ou para um resultado de interferência que possui um ponto de vista
salvo. Caso não tenha nenhum ponto de vista salvo, adicionar um identificador
irá criar e salvar automaticamente um ponto de vista para você.

Também é possível converter medições para linhas de marcação. Para obter
mais informações, consulte Medição na página 420.

Para adicionar texto

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints e selecione o ponto de vista que deseja
revisar.

2 Clique na guia Review painel  ➤ Redline ➤ Text  .
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3 Na Vista da cena, clique na localização onde deseja colocar o texto.

4 Insira sua anotação na caixa fornecida e clique em OK. A linha de
marcação é adicionado no ponto de vista selecionado.

OBSERVAÇÃO O texto somente pode ser adicionado em uma única linha
com esta ferramenta de linha de marcação. Para exibir o texto em múltiplas
linhas, escreva cada linha individualmente.

5 Se você deseja mover a anotação, clique com o botão direito do mouse
na linha de marcação e clique em Move. Clicar em uma localização
diferente na Vista da cena move o texto para lá.

6 Caso você deseje editar a anotação, clique com o botão direito do mouse
na linha de marcação, e clique em Edit.

Menu: Classic user interface: Review  ➤  Redline ➤  Text

Para desenhar à mão livre

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints e selecione o ponto de vista que deseja
revisar.

2 Clique na guia Review ➤ painel Redline ➤ menu suspenso Draw

e clique em Freehand  .
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3 Arraste o mouse para desenhar o ponto de vista.

Menu: Classic user interface: Review  ➤  Redline  ➤  Freehand

Para desenhar uma linha

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints e selecione o ponto de vista que deseja
revisar.

2 Clique na guia Review ➤ painel Redline ➤ menu suspenso Draw

e clique em Line  .

3 Clique no ponto de vista nos pontos inicial e final da linha.
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Menu: Classic user interface: Review  ➤  Redline  ➤  Line

Para desenhar uma sequência de linhas

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints e selecione o ponto de vista que deseja
revisar.

2 Clique na guia Review painel  ➤ Redline menu suspenso  ➤ Draw e

clique em Line String  .

3 Clique no ponto de vista para iniciar. Cada vez que você clica, um novo
ponto é adicionado na sequência de linhas. Cada a sequência estiver
completada, clique com o botão direito do mouse para finalizar a linha,
e você pode começar uma nova sequência de linhas.
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Menu: Classic user interface: Review ➤ Redline ➤ Line String

Para desenhar uma elipse

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints e selecione o ponto de vista que deseja
revisar.

2 Clique na guia Review ➤ painel Redline ➤ menu suspenso Draw

e clique em Ellipse  .

3 Clique e arraste uma caixa no ponto de vista para efetuar o contorno da
elipse.

4 Solte o botão do mouse para colocar a elipse no ponto de vista.
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Menu: Classic user interface: Review ➤ Redline ➤ Ellipse

Para desenhar uma nuvem

1 Clique na guia Viewpoint ➤  painel Save, Load & Playback menu
suspendo  ➤  Saved Viewpoints, e selecione o ponto de vista que
deseja revisar.

2 Clique na guia Review ➤ painel Redline ➤ menu suspenso Draw

e clique em Cloud  .

3 Clique no ponto de vista para iniciar o desenho de arcos da nuvem. Cada
vez que você clica, um novo ponto é adicionado. Clicar no sentido
horário desenha arcos regulares, clicar no sentido anti-horário desenha
arcos invertidos.

4 Para fechar automaticamente a nuvem, clique com o botão direito do
mouse.
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Menu: Interface de usuário Classic: Review ➤ Redline ➤ Cloud

DescriçãoFerramenta

Adiciona texto em um ponto de vista.

Permite desenhar à mão livre em um ponto
de vista.

Desenha uma linha em um ponto de vista.

Desenha uma sequência de linhas em um
ponto de vista.

Desenha uma elipse em um ponto de vista.

Desenha uma nuvem em um ponto de
vista.

Apaga linhas de marcação.
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Exibir linhas de marcação e Identificadores

Para exibir linhas de marcação e identificadores, é preciso chamar o ponto de
vista no qual eles estão contidos.

Para visualizar linhas de marcação

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback
inicializador de ferramenta  ➤ Saved Viewpoints  .

2 Clique no ponto de vista desejado na janela Pontos de visão salvos.
Todas as linhas de marcação anexadas (se houverem) são exibidas na
Vista da cena.

Painel Tags

O painel Tags na guia Review permite adicionar e gerenciar identificadores.

Os identificadores combinam recursos de linha de marcação, pontos de visão
e comentários em uma única ferramenta de revisão fácil de usar. Isso permite
identificar qualquer coisa que você deseja identificar na cena do modelo. Um
ponto de vista é automaticamente criado para você, e é possível adicionar um
comentários e status no identificador.

Por exemplo, durante uma sessão de revisão, você pode localizar um item na
cena que esteja incorretamente dimensionado ou posicionado. Você pode
identificar este item, declarando o problema, salvara seus resultados de revisão
como um arquivo NWF e passar o arquivo para a equipe de projeto. A equipe
de projeto pode pesquisar no arquivo por quaisquer identificadores com o
status de 'novo' e localizar seus comentários de revisão. Após quaisquer
modificações necessárias terem sido feitas nos arquivos de desenho, estes
podem ser recarregados no arquivo *.nfw, o status do identificador pode ser
alterado de acordo. Você pode rever esta versão ais recente do arquivo NWF
para assegura que todos os identificadores forma selecionados e finalmente
'aprová-los'.
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Para adicionar um identificador

1 Clique na guia Review ➤ painel Tags ➤ Add Tag  .

2 Na Vista da cena, clique no objeto que deseja identificar.

3 Clique na área onde deseja que a legenda do identificador esteja
localizada. O identificador agora é adicionado, e ambos os pontos são
unidos por uma linha de chamada.

Se o ponto de visão atual ainda não tiver sido salvo, será salvo
automaticamente e chamado de "Identificador da Vista X", onde "X" é a
identidade do identificador.

4 Na caixa de diálogo Add Comments , insira o texto a ser associado com
o identificador, defina o Status o identificador a partir da lista suspensa,
e clique em OK.

Menu: Interface de usuário Classic: Review ➤ Redline ➤ Tag

Para exibir identificadores

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback
inicializador de ferramenta  ➤ Saved Viewpoints  .

2 Clique no ponto de vista desejado na janela Pontos de visão salvos.
Todos os identificadores anexados (se houverem) são exibidos na Vista
da cena.

Editar Comentários e Identificadores

Após um comentário ter sido salvo, você pode editá-lo na janela Comments
ou da própria origem. Editar identificadores é o mesmo que editar comentários.
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Você pode editar conteúdo, alterar o status atribuído aos comentários e
identificadores, e excluir comentários e identificadores. Você também pode
renumerar IDs de identificadores e comentários, se necessário (consulte
Gerenciar IDs de comentário e identificador na página 449).

É possível usar os controles Thickness e Color na guia Review ➤  painel
Redline para modificar a forma como os identificadores serão desenhados
na Scene View. Essas alterações não afetam os identificadores já desenhados.

Para alterar o conteúdo e status de um comentário ou identificador

1 Visualize o comentário ou identificador que deseja editar na janela
Comments.

2 Clique com o botão direito do mouse no comentário ou identificador e
clique em Edit Comment.

3 Modifique o texto do comentário, como necessário.

4 Utilize a caixa Status para alterar o status.

5 Clique em OK.

Menu: Classic user interface: Review ➤ Comments ➤ Edit Comment

Para excluir um comentário ou identificador

1 Visualize o comentário ou identificador que deseja excluir na janela
Comments.

2 Clique com o botão direito do mouse no comentário ou identificador e
clique em Delete Comment.

Menu: Classic user interface: Review ➤ Comments ➤ Delete Comment

Editar linhas de marcação

Linhas de marcação adicionadas não podem ser editadas com a exceção do
texto, que pode ser movido e alterado como necessário.

Para mover texto

■ Clique com o botão direito na anotação na Vista da cena, e clique em
Move no menu de atalho.
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Para editar texto

1 Clique com o botão direito na anotação na Vista da cena, e clique em
Edit no menu de atalho.

2 Insira uma nova anotação na caixa fornecida, e clique em OK.

Para excluir texto

■ Clique com o botão direito no texto que deseja excluir, e clique em Delete
Redline no menu de atalho.

Para apagar linhas de marcação

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Saved Viewpoints e selecione o ponto de vista que deseja
revisar.

2 Clique na guia Review ➤ painel Redline ➤ menu suspenso Draw

e clique em Erase  .

3 Arraste uma caixa sobre a linha de marcação que deseja apagar e solte o
mouse.
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Menu: Classic user interface: Review ➤ Redline ➤ Erase

Localizar Comentários e Identificadores

Você pode usar a janela Find Comments para definir e executar uma pesquisa
por identificadores e comentários. Também é possível usar os controles no
painel Tags para navegar através de identificadores.

Janela Find Comments

A janela Find Comments é uma janela encaixável que permite pesquisar por
comentários e identificadores com base nos dados do comentário (texto, autor,
ID do comentário, status), data de modificação do comentário, e a origem do
comentário.
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Três guias no topo permitem definir o critério de pesquisa. Pressionar o
botãoFind executa a pesquisa. Quaisquer resultados encontrados são exibidos
em uma coluna com múltiplas colunas na parte inferior da janela. Com as
barras de rolagem na parte direita e inferior da janela, é possível mover através
dos comentários. Há diferentes ícones que ajudam a identificar a origem de
cada comentário em uma rápida olhada. Estes ícones são as mesmos que são
usados na janela Comments.

A seleção de um comentário na lista também seleciona a origem do comentário.
Por exemplo, a seleção de uma comentário que originou de uma ponto de
vista salvo, seleciona aquele ponto de vista.

Você pode alterar a ordem de classificação dos itens na lista ao clicar em um
cabeçalho de coluna.

Se novos comentários são adicionados ou se quaisquer dos comentários
existentes são modificados, a lista de resultados é limpa.

Para alternar a janela Find Comments

■ Clique na guia Review ➤ painel Comments ➤ Find Comments  .

Menu: Classic user interface: Edit  ➤  Find Comments or Review  ➤ 

Comments  ➤  Find Comments
Entrada do comando: Shift + F4
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Para encontrar comentários

1 Abra a janela Find Comments.

2 Defina o critério de pesquisa:
■ Use a guia Comments se desejar pesquisar por um texto, autor, ID

de comentário ou status específico.

■ Utilize a guia Date Modified para somente pesquisar por
comentários criados dentro da faixa de tempo especificada.

■ Utilize a guia Source para somente pesquisar por comentários
anexados às origens selecionadas.

3 Clique em Find.

Para localizar identificadores usando a janela Find Comments

1 Abra a janela Find Comments.

2 Clique na Source , selecione a caixa de seleção Redline Tags , e limpe
o resto das caixas de seleção.

3 Utilize as guias Comments e Date Modified para restringir mais sua
pesquisa, se necessário.

4 Clique em Find.

Guia Comments

Utilize esta guia para restringir sua pesquisa com base nos dados do comentário.
Se as caixas nesta guia forem deixadas vazias, a pesquisa retorna todos os
comentários dentro da definição do critério nas guias Date Modified e
Source.

Texto O texto exato a ser pesquisado em todos os comentários. Esta pode ser
uma palavra ou algumas palavras. Portanto, por exemplo, digitar a palavra
redline, e executar a pesquisa, somente retorna os comentários que contenham
um única palavra “redline”.

Caso você não conheça o conteúdo exato do comentário, poderá utilizar
coringas. Para coincidir um caractere único não especificado use o símbolo
"?" (ponto de interrogação). Para coincidir qualquer número de caracteres não
especificados, antes ou depois do texto, utilize o símbolo * (asterisco). Por
exemplo, se você deseja encontrar todos os comentários que contenham algum
texto antes ou depois da palavra redline, digite *redline* na caixa Text.

Author O nome exato do autor a ser pesquisado em todos os comentários.
Utilize coringas se não souber o nome exato do autor.
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ID A ID de comentário exata a ser pesquisada. Você somente pode utilizar
números aqui.

Status Selecione o status do comentário a ser pesquisado.

Match Case Selecione esta caixa de seleção se desejar pesquisar respeitando
os caracteres maiúsculos e minúsculos na pesquisa.

Guia Date Modified

Utilize esta guia para especificar uma faixa de datas nas quais os comentários
precisam ter sido feitos.

All Comments A pesquisa retorna todos os comentários. Esta é a opção padrão.

Between Selecione este botão se desejar pesquisar por todos os comentários
modificados entre as datas especificadas.

During the Previous Months Selecione este botão para localizar todos os
comentários modificados nos últimos X número de meses.

During the Previous Days Selecione este botão para localizar todos os
comentários modificados nos últimos X número de dias.

Guia Source

Utilize esta guia para restringir a pesquisa pela origem a qual os comentários
estão anexados. Por padrão, todas as caixa de seleção são selecionadas.

Clash Detective Marque esta caixa de seleção se você deseja encontrar
comentários anexados ao resultados do Clash Detector. Limpar esta caixa de
seleção exclui os comentários relacionados as interferências dos resultados de
pesquisa.

TimeLiner Selecione esta caixa de verificação se desejar encontrar os
comentários anexados às tarefas TimeLiner. Apagar esta caixa de verificação
exclui os comentários relacionados ao TimeLiner provenientes dos resultados
da pesquisa.

Viewpoints Selecione esta caixa de seleção se você deseja encontrar os
comentários anexados a pontos de visão . Limpar esta caixa de seleção exclui
todos os comentários relacionados aos pontos de visão dos resultados de
pesquisa.

Redline Tags Selecione esta caixa de seleção se desejar localizar comentários
anexados aos identificadores. Desmarcar esta caixa de seleção exclui os
comentários relacionados aos identificadores dos resultados de pesquisa.
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Conjuntos Selecione esta caixa de seleção se você deseja encontrar comentários
anexados aos conjuntos de seleção e de pesquisa. Limpar esta caixa de seleção
exclui todos os comentários relacionados aos conjuntos de seleção e pesquisa
dos resultados de pesquisa.

Quick Find Comments

Para localizar comentários que coincidam com um termo de pesquisa
especificado rapidamente, use o recurso Quick Find Comments.

Para localizar comentários rapidamente

1 Clique na guia Review painel  ➤ Comments.

2 Na caixa de texto Quick Find Comments, digite a sequência de texto
a ser pesquisa em todos os comentários. Esta pode ser uma palavra ou
algumas palavras.

3 Clique em Quick Find Comments  .

A janela Find Comments é aberta com uma lista de todos os
comentários que coincidem com o texto inserido.
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Clicar no comentário na lista o direciona para o ponto de vista
apropriado.

Localizar identificadores

É possível pesquisar por identificadores da mesma forma que pesquisa por
comentários. Também é possível localizar identificadores por seus números
de ID, e navegar através dos identificadores usando os controles no painel
Tags.

Para localizar identificadores por ID de identificador

1 Clique na guia Review painel  ➤ Tags.

2 Insira a ID do identificador na caixa de texto e clique em Go to Tag
.
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Você levado automaticamente para o ponto de vista apropriado.

Para navegar através de identificadores

1 Clique na guia Review ➤ painel Comments ➤ View Comments

 para abrir a janela Comments.

2 Clique na guia Review ➤ painel Tags ➤ First Tag  . O comentário
do identificador é mostrado na janela Comments, e a Vista da cena
exibe o ponto de vista com o primeiro identificador.

3 Para navegar entre os identificadores em sua cena:
■ Clique na guia Review ➤ painel Tags ➤ Next Tag  para localizar

o identificador que se segue ao atual.

■ Clique na guia Review ➤ painel Tags ➤ Previous Tag  para
localizar o identificador que precede o atual.

■ Clique na guia Review ➤ painel Tags ➤ Last Tag  para localizar
o último identificador na cena.

Gerenciar IDs de comentário e identificador

Quando você adiciona um identificador ou comentário à cena, uma ID única
é atribuída a ele. Se, no entanto, você estiver anexando ou mesclando múltiplos
arquivos do Autodesk Navisworks, haverá a possibilidade que a mesma ID seja
usada mais de uma vez. Observe o exemplo a seguir. Três usuário revisaram e
adicionaram comentários e linhas de marcação no mesmo arquivo de modelo,
cada um deles salvando seu trabalho como um arquivo NFW. Se fundir os
arquivos NWF resultantes, somente uma cópia da geometria seria carregada e
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quaisquer pontos de visão de identificador de mesmo nome, receberiam um
sufixo com o nome do arquivo NWF entre parênteses. No entanto, todas as
identidades dos identificadores, seriam mantidas. Em tais casos, você pode
renumerar todas as IDs, tornando-as únicas novamente para a cena.

OBSERVAÇÃO Pode haver uma situação onde duas sessão são mescladas que
contêm identificadores identicamente numerados e pontos de visão
correspondentes (Tag Views). Nesta situação, quando você renumerar IDs de
identificadores, o Autodesk Navisworks também tentará, sempre que possível,
renomear as Tag Views associadas em linha com os números dos novos
identificadores.

Para renumerar IDs de comentários

1 Clique na guia Review, deslize o painel Comments.

2 Clique em Renumber Comment IDs  .

Para renumerar IDs de identificadores

1 Clique na guia Review, e deslize o painel Tags.

2 Clique em Renumber Tag IDs  .

Links
Há várias fontes de links no Autodesk Navisworks: links originais que foram
convertidos dos arquivos nativos do CAD, links que foram adicionados pelos
usuários do Autodesk Navisworks e links que foram gerados automaticamente
pelo programa (por exemplo, links de conjunto de seleção, links de pontos de
visão, links de tarefa TimeLiner e assim por diante).

Os links convertidos de arquivos nativos de CAD e os links adicionados por
usuários do Autodesk Navisworks, são tratados como propriedades do objeto.
Isto significa que você pode examiná-los na janela Properties.

Você também pode utilizar a janela Find Items para pesquisar por eles.

Todos os links são salvos com arquivos do Autodesk Navisworks, portanto,
quando o modelo é modificado, os links permanecem aqui para que você e
outros o visualizem.
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Categorias de links

Há dois tipos de links: padrão e definidos pelo usuário.

Links padrões são divididos nas seguintes categorias:
■ Hyperlink

■ Label

■ Pontos de visão

■ Clash Detective

■ TimeLiner

■ Sets

■ Redline tags

Por padrão, todos os links exceto legendas, são desenhados como ícones na
Vista da cena. Legendas são desenhadas como texto.

Os links definidos pelos usuário permitem personalizar as categorias dos links
para se ajustarem ao fluxo de trabalho. Por padrão, links definidos pelo usuário
são desenhados como ícones na Vista da cena.

Você pode utilizar o Options Editor para alternar a exibição de cada uma
das categorias de links e também para controlar sua aparência.

Quando você adiciona um link, é possível atribuir uma categoria definida por
usuário, categoria de hyperlink ou categoria de legenda a ele. O restante das
categorias são automaticamente atribuídas pelo Autodesk Navisworks quando
este gera links correspondentes.

Exibir links

Você também ativar e desativar links na Vista da cena. Também é possível
alternar a exibição de cada categoria de links. Autodesk Navisworks lembra da
configuração de visibilidade selecionada entre as sessões.

Quando links são ativados, é possível reduzir a ocupação da tela ao restringir
o número de links que podem ser exibidos na Vista da cena, ocultando
ícones que colidem, e usando seleção. Finalmente, como algumas categorias
de link padrão podem ter comentários associados com eles, e você pode decidir
desenhar comente os links com comentários anexados.
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Para alternar a exibição dos links

■ Clique na guia Home painel  ➤ Display ➤ Links  .

Menu: Classic user interface: Tools ➤ Links

Para controlar a exibição de links padrão

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção Standard Categories.

3 Na página Standard Categories , selecione a caixa de verificação
Visible para exibir a categoria de link correspondente. Desmarcar a caixa
de verificação oculta a categoria de link correspondente na Vista da
cena.

Por padrão, todas as categorias de link padrão são visíveis.

4 Clique em OK.

Para controlar a exibição de links definidos pelo usuário

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção User-Defined Categories.

3 Na página User-Defined Categories , selecione a caixa de seleção
Visible para exibir a categoria de link correspondente. Desmarcar a caixa
de verificação oculta a categoria de link correspondente na Vista da
cena.

Por padrão, todas as categorias de links definidas pelo usuário são visíveis.

OBSERVAÇÃO Caso nenhuma categoria definida pelo usuário foi adicionada,
esta página estará vazia.

4 Clique em OK.

Para reduzir a ocupação da tela

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção Links.
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3 Na página Links, insira o número de links na caixa Max Icons. Por
padrão, 25 links podem estar visíveis.

4 Para ocultar links que aparecem sobrepostos na Vista da cena, selecione
a caixa de verificação Hide Colliding Icons.

5 Na caixa Cull Radius insira o valor desejado. Somente os links
localizados dentro da distância especificada da câmera são desenhados
na Vista da cena. O valor padrão de 0 significa que todos os links são
desenhados.

6 Clique em OK.

Para ocultar links sem comentários

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção Standard Categories.

3 Na página Standard Categories , selecione a caixa de seleção Hide
Icons Without Comments para todas as categorias de link necessárias.

Por padrão, os links sem comentários também são exibidos.

4 Clique em OK.

Personalizar links

Você pode personalizar a aparência padrão de links no Autodesk Navisworks.
Em particular, você pode desenhá-los em 3D e pode adicionar linhas de
chamada de detalhe (setas) apontando para o ponto de anexação nos itens.
Você pode escolher como representar cada categoria de link (como um ícone
ou como um texto).

Pontos de anexação

Por padrão, os links são anexados ao centro padrão da caixa de delimitação
do item.

Você pode sobrepor isso com pontos de anexação mais convenientes. Se você
adiciona mais de um ponto de anexação, o link é exibido anexado ao ponto
de anexação mais próximo a câmera durante a navegação. Isso permite definir
links que sempre estejam disponíveis para serem seguidos quando desenhados
mo modo 3D durante a navegação, e para não desaparecerem atrás de objetos.
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Para desenhar links no modo 3D

Observação: No modo 3D os links podem ser ocultos por outros objetos na
cena quando você estiver navegando.

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção Links.

3 Na página Links, selecione a caixa de verificação In 3D.

Os links agora flutuam no espaço 3D justo em frente de seus pontos de
anexação aos itens.

4 Clique em OK.

Para exibir linhas de chamada de detalhe

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, e clique na opção Links.

3 Na página Links, insira as distâncias X- e Y- na Leader Offset para o
número de pixels à direita e acima que estas linhas de chamada irão usar.
O ângulo-padrão é 0. O ângulo recomendado é de 45.

Os links na Vista da cena agora têm linhas de chamada apontando
para o ponto de anexação nos itens.

4 Clique em OK.

Para personalizar a aparência de links padrão

1 Clique no botão do aplicativo  ➤ Options.
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2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção Standard Categories.

3 Na página Standard Categories , utilize a caixa Icon Type para
especificar como deseja que um link seja desenhado para cada uma das
categorias disponíveis. É possível escolher entre um ícone e texto.

Por padrão, links de legenda são exibidos como texto, e o resto das
categorias de links são exibidas como ícones.

4 Clique em OK.

Para personalizar a aparência de links definidos pelo usuário

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface, expanda o nó Links, e
clique na opção User-Defined Categories.

3 Na página User-Defined Categories , utilize a caixa Icon Type para
especificar como deseja que um link seja desenhado para cada uma das
categorias disponíveis. É possível escolher entre um ícone e texto. Por
padrão, os links com categorias definidas pelo usuário são mostrados
como ícones.

OBSERVAÇÃO Caso nenhuma categoria definida pelo usuário foi adicionada,
esta página estará vazia.

4 Clique em OK.

A tabela abaixo mostra os ícones que podem ser usados para representar
diferentes categorias de link na Vista da cena.

DescriçãoÍcone

Representa links que possuem hyperlink, legenda, ou qualquer outra categoria
definida por usuário (e aponta para um endereço da web).

Representa links que tenham hyperlink, legenda, ou qualquer categoria definida
pelo usuário (e aponta para um arquivo externo).

Representa links com a categoria Clash Detective (novas interferências).

Representa links com a categoria Clash Detective (interferências ativas).
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DescriçãoÍcone

Links representados na categoria Detetor de interferências (choques revistos).

Representa links com a categoria Clash Detective (interferências solucionadas).

Representa links com a categoria Clash Detective (interferências aprovadas).

Represente links com a categoria TimeLiner (tarefas com itens anexados).

Represente links com a categoria TimeLiner (tarefas com links válidos).

Represente links com a categoria TimeLiner (tarefas com links interrompidos).

Representa links com a categoria de ponto de vista (modo de câmera em
perspectiva).

Representa links com a categoria de ponto de vista (modo de câmera ortogonal).

Representa links com a categoria de identificador.

Representa links com a categoria de conjuntos (conjuntos de seleção).

Representa links com a categoria de conjuntos (conjuntos de pesquisa).

Adicionar links

Você pode adicionar links que apontam para diversas origens de dados, como
planilhas, páginas da web, scripts, gráficos, arquivos de áudio e vídeo, e assim
por diante. Um objeto pode ter vários links anexados a eles, contudo, somente
um link, chamado padrão, é mostrado na Vista da cena. O link padrão é o
link que você adiciona primeiro, mas é possível marcar outro link como padrão,
se necessário.
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Para adicionar um link em um objeto

1 Na Vista da cena, selecione o item de geometria desejado.

2 Clique na guia Item Tools painel  ➤  Links ➤ Add Link  .

3 Na caixa de diálogo Add Link, insira o nome para o link na caixa Name.

4 Na caixa Link to File or URL , digite o caminho completo para a
origem de dados requerida ou o endereço URL. Você também pode

pesquisar  pela pasta que contém o arquivo externo desejado.

5 Escolha a categoria para seu link na lista suspensa Category. Por padrão,
seu link tem uma categoria de hyperlink.

DICA Para criar um tipo de categoria personalizada, digite seu nome
diretamente na caixa Category. quando você salva o seu link, a categoria
definida pelo usuário correspondente é automaticamente criada.

6 Opcionalmente, por padrão, o link é anexado ao centro padrão da caixa
delimitadora do item. Se você deseja anexar seu link em um ponto
específico do item selecionado, clique no botão Add. Um cursor de alvo
de mira aparece na Vista da cena, permitindo selecionar o ponto no
item ao qual o link será anexado.

OBSERVAÇÃO Caso cometa um erro, clicar no botão Clear All exclui todos
os pontos de anexação associados com este link e reverte o link para ser
anexado ao centro da caixa de delimitação do item.

7 Clique em OK.

Para adicionar diversos links ao mesmo objeto

1 Na Vista da cena, selecione o item de geometria desejado.
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2 Clique com o botão direito e clique em Links ➤ Add Link.

3 Use a caixa de diálogo Add Link para adicionar o primeiro link. Este é
o link padrão e é o único link que estará visível na Vista da cena. É
possível escolher outro link padrão mais tarde, se necessário.

4 Clique com o botão direito do mouse novamente no objeto e repita as
etapas anteriores para adicionar todos os links necessários.

Encontrar e seguir links

Os links são uma ferramenta de revisão extremamente útil para permitir acessar
informações não gráficas através da interface gráfica do Autodesk Navisworks.

Os links convertidos de arquivos nativos de CAD e os links adicionados por
usuários do Autodesk Navisworks são tratados como propriedades do objeto.
Isto significa que você pode examiná-los na janela Properties.

Você também pode utilizar a janela Find Items para pesquisar por eles.

Para seguir um link padrão

1 Assegure que os links estejam ativados. Clique na guia Home painel

 ➤ Display ➤ Links  .

2 Clique no link desejado na Vista da cena para abrir a origem de dados
anexada.

Menu de atalho: Seguir link

Para seguir um dos links não-padrão

1 Assegure que os links estejam ativados. Clique na guia Home painel

 ➤ Display ➤ Links  .

2 Clique com o botão direito no link padrão, e clique na opção Select
Item Containing Link. Esta opção somente está disponível para
múltiplos links anexados ao mesmo item.

3 Clique com o botão direito no item selecionado e, a seguir, clique em
Links ➤  o link que deseja seguir.
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Para seguir um link padrão na janela Properties

Nota: é possível utilizar esse procedimento para seguir links de arquivos CAD
originais ou links que você mesmo adicionou.

1 Na Vista da cena, selecione o objeto com um link.

2 Abra a janela Properties , clique com o botão direito em qualquer guia,
e clique em Follow Default Link.

Para encontrar links

1 Clique na guia Home painel  ➤ Select & Search ➤ Find Items  .

2 Na janela Find Items , clique na guia Standard , e mantenha
pressionado CTRL, e clique em todos os arquivos que compreendem o
modelo.

3 Clique na coluna Category , e selecione Hyperlinks na lista suspensa.

4 Na coluna Propriedade, selecione o nome da propriedade na lista
suspensa, por exemplo, "Nome".

5 Na coluna Condition , selecione o operador da condição, por exemplo
‘=’.

6 Na coluna Value insira o valor da propriedade a ser procurado, por
exemplo, "Meu Link".

7 Clique no botão Find All. Os resultados da pesquisa são realçados na
Vista da cena e Selection Tree.

Manage Links

Você pode editar links originais que foram convertidos de arquivo nativos de
CAD. Se fizer isso, salve imediatamente as alterações no arquivo NWF e, a
seguir, altere o link no arquivo original do CAD e reabra o arquivo NWF no
Autodesk Navisworks, assim as "substituições" de edição irão permanecer. No
entanto, caso não tenha editado os links no Autodesk Navisworks, os links
atualizados do arquivo CAD aparecerão.

Você pode definir todos os links em um objeto para os links que foram
originalmente convertidos do arquivo CAD. Você também pode redefinir todos
os links em todos os objetos na cena para seu estado original.
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OBSERVAÇÃO Não é possível editar links gerados automaticamente, tais como
os links que apontam para os resultados de interferências, tarefas TimeLiner e
assim por diante.

Você pode excluir quaisquer links que foram adicionados ao seu arquivo por
usuários do Autodesk Navisworks e os links que foram convertidos dos arquivos
CAD originais. Não é possível excluir links gerados automaticamente, mas
pode desativá-los, para que não ocupem a Vista da cena.

Para editar um link

1 Na Vista da cena, clique com o botão direito no link que deseja editar,
e clique em Edit Link.

2 Na caixa de diálogo Edit Links, clique no link que deseja alterar, e
clique no botão Edit.

3 Use a caixa de diálogo Editar link para modificar os detalhes dos links,
e clique em OK.

4 Clique em OK para fechar a caixa de diálogo Edit Links.
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Faixa de opções:  Guia Item Tools guia  ➤ Links ➤ Edit Links

Para alterar o link padrão

1 Na Vista da cena, clique com o botão direito no link padrão, e clique
em Edit Link.

2 Na caixa de diálogo Edit Link, selecione o link que deseja que seja
exibido na Vista da cena, e clique no botão Make Default.

OBSERVAÇÃO Também é possível mover links para cima e para baixo na
lista utilizando os botões Move Up e Move Down , ou ao arrastá-los para
sua nova posição na lista. O link no topo da lista é o link padrão.

3 Clique em OK.

Para excluir um link

1 Na Vista da cena, clique com o botão direito no link padrão, e clique
em Edit Link.

2 Na caixa de diálogo Edit Links, clique no link que deseja excluir, e
clique no botão Delete.

3 Clique em OK.

Menu: Interface de usuário clássica: Review ➤ Links ➤ Edit Links

Para redefinir todos os links para um objeto

Atenção: a redefinição de links para um objeto também remove quaisquer
links manualmente adicionados a ele por usuários doAutodesk Navisworks.
Se tiver cometido um erro, use o botão Undo  na barra de ferramentas
Acesso rápido.

1 Na Vista da cena, selecione o objeto com os links que deseja redefinir
para seu estado original.

2 Clique na guia Item Tools ➤ painel Links ➤ Reset Links  .

Para redefinir todos os links em uma cena

Atenção: A redefinição de links em uma cena também remove quaisquer
links manualmente adicionados a ela por usuários do Autodesk Navisworks.
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Se tiver cometido um erro, use o botão Undo  na barra de ferramentas
Acesso rápido.
■ Clique na guia Home ➤ painel Project ➤ menu suspenso Reset

All ➤ Links  .

Propriedades rápidas
É possível ativar e desativar as propriedades rápidas na Vista da cena. O
Autodesk Navisworks lembra da configuração de visibilidade selecionada entre
as sessões.

Quando as Propriedades rápidas estão ativadas, é possível visualizar
informações sobre elas numa janela de estilo de dica de ferramentas ao mover
o cursor sobre os objetos na Vista da cena. Não é preciso primeiro selecionar
os objetos. A dica de ferramenta sobre as propriedades rápidas desaparecem
após alguns segundos.

Por padrão, as propriedades rápidas mostram o nome e o tipo do objeto, mas
é possível utilizar o Options Editor para definir quais propriedades são
mostradas. Cada definição configurada permite exibir uma combinação de
categoria/propriedade adicional nas propriedades rápidas. Você pode decidir
ocultar ou não os nomes de categorias nas propriedades rápidas.

OBSERVAÇÃO Ao mover o mouse sobre um objeto que não possua as
propriedades necessárias, o Autodesk Navisworks procura na árvore de seleção
um objeto pai que contenha essas informações e o exibe em seu lugar,
maximizando dessa maneira as informações úteis para o usuário.
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Para alternar a exibição das propriedades rápidas

■ Clique na guia Home ➤ painel Display ➤ Quick Properties  .

Menu: Interface de usuário Classic: Tools ➤ Quick Properties

Para adicionar definições de propriedades rápidas

1 Clique no botão do aplicativo  ➤ Options.

2 No comando Options Editor, amplie o nó Interface , amplie o nó
Propriedades rápidas e clique na opção Definições.

3 Na página Definitions, clique em Grid View  para exibir as
definições de propriedades rápidas como linhas de tabela.

4 Clique em Add Element  . Um nova linha é adicionada no topo
da tabela.

5 Clique na coluna Category e selecione a categoria de propriedade na
lista suspensa, por exemplo ‘Item’. As opções disponíveis dependem das
categorias de propriedades em seu modelo.

6 Clique na coluna Property , e selecione o nome da propriedade na lista
suspensa, por exemplo, ‘Material’. As opções disponíveis dependem da
categoria de propriedade selecionada.

7 Clique em OK.

OBSERVAÇÃO É possível adicionar tantas definições as suas propriedades rápidas
quanto quiser.

Para excluir definições de propriedades rápidas

1 Clique no botão do aplicativo  ➤ Options.

2 No comando Options Editor, amplie o nó Interface , amplie o nó
Propriedades rápidas e clique na opção Definições.

3 Na página Definitions, clique em Grid View  para exibir as
definições de propriedades rápidas como linhas de tabela.

4 Clique em Category ou Property para a definição que deseja excluir.
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5 Clique em Remove Element  .

6 Clique em OK.

Para ocultar nomes de categorias

1 Clique no botão do aplicativo  ➤ Options.

2 No comando Options Editor, amplie o nó Interface e clique na opção
Propriedades rápidas .

3 Selecione a caixa de seleção Hide Category.

4 Clique em OK.

SwitchBack
O SwitchBack permite selecionar um objeto no Autodesk Navisworks e, a
seguir, localizar e aproximar o zoom no mesmo objeto em um pacote de CAD
nativo. É possível utilizar a funcionalidade SwitchBack com o AutoCAD
(versão 2004 ou posterior), o Revit (versão 2012 ou posterior) e com produtos
de CAD baseados no MicroStation (/J e v8).

IMPORTANTE O pacote de CAD nativo precisa estar instalado na mesma máquina
que o Autodesk Navisworks para que o SwitchBack funcione.

Para utilizar o SwitchBack com o AutoCAD

1 Para o AutoCAD (versão 2004 ou posterior) ou para produtos nele
baseados, abre primeiro o produto na forma usual, e digite: nwload na
linha de comando para carregar o plugin nwexport.

OBSERVAÇÃO Se SwitchBack precisa estar disponível cada vez que o
AutoCAD é executado, o nwexport pode ser adicionado ao conjunto de
aplicativos de inicialização no AutoCAD.

2 Quando o pacote de CAD estiver sendo executado, e o nwexport tiver
sido iniciado, volte ao Autodesk Navisworks.

3 Clique no botão do aplicativo  ➤ Options.

4 No Options Editor, expanda o nó File Readers, e clique na opção
DWG/DXF.
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5 Na página DWG/DXF, verifique se a opção Convert Entity Handles
está selecionada.

6 Selecione um objeto na Scene View, e clique na guia Item Tools painel

 ➤ SwitchBack ➤ SwitchBack  .

A vista atual da câmera do Autodesk Navisworks é devolvida ao pacote
de CAD, e o mesmo objeto é selecionado. A seleção de objetos é feita
pelo manipulador de entidade.

DICA Alternativamente, na janela Clash Detective, na guia Results, é
possível clicar no botão SwitchBack.

7 Faça as alterações no AutoCAD e então salve as alterações.

8 Retorne para o Autodesk Navisworks, e clique em Refresh  na barra
de ferramentas Quick Access para exibir o objeto modificado.

OBSERVAÇÃO Alguns objetos não podem ser selecionados no AutoCAD (por
exemplo, blocos), o que pode significar que a execução do SwitchBack pode não
ter êxito com um determinado objeto selecionado. Se este for o caso, tente
selecionar mais acima na árvore de objetos e tente novamente.

Menu de atalho: Retornar

Para utilizar o SwitchBack com o MicroStation

1 Para os produtos com base no MicroStation (/J e v8), abra o produto na
forma usual e digite:

2 Clique em Utilities ➤ Key In.

3 Na caixa de diálogo Key-In, digite mdl load nwexport9 para carregar o
plug-in nwexport.

DICA Se SwitchBack necessita estar disponível cada vez que o MicroStation
é executado, nwexport9 pode ser adicionado à lista dos plug-ins MDL no
MicroStation.

4 Quando o pacote do MicroStation estiver sendo executado, e o nwexport
tiver sido iniciado, volte ao Autodesk Navisworks.

5 Selecione um objeto na Scene View, e clique na guia Item Tools painel

 ➤ SwitchBack ➤ SwitchBack  .

A vista atual da câmera do Autodesk Navisworks é redefinida para a
primeira vista visível no MicroStation, e o mesmo objeto é selecionado.
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A seleção de objetos é feita pela ID de elemento (MicroStation v8) ou
valor DMRS (MicroStation /J).

DICA Alternativamente, na janela Clash Detective, na guia Results, é
possível clicar no botão SwitchBack.

6 Se você deseja sobrepor a vista utilizada pelo SwitchBack, utilize nwview
<número da vista> key-in onde número da vista é janela visível no
MicroStation. Esta configuração e vista não é salva entre sessões.

7 Faça as alterações no MicroStation e então salve as alterações.

8 Retorne para o Autodesk Navisworks, e clique em Refresh  na barra
de ferramentas Quick Access para exibir o objeto modificado.

Menu de atalho: Retornar

Para utilizar o SwitchBack com o Revit

1 Para os produtos do Revit 2012 ou com base nele, abra o produto da
forma usual e inicialize o complemento Navisworks SwitchBack:

1 Abra um projeto existente ou crie um novo.

2 Clique na guia Add-Ins ➤ External Tools ➤  Navisworks
SwitchBack para ativá-lo. Agora é possível fechar o projeto, mas
não feche o Revit.

2 Volte para o Autodesk Navisworks e abra o arquivo desejado. Enquanto
você estiver trabalhando com um arquivo NWC exportado do Revit ou
com um arquivo NWF ou NWD salvo, é possível retornar para o Revit.

3 Selecione um objeto na Scene View e clique na guia Item Tools painel

 ➤ SwitchBack ➤ SwitchBack  .

O Revit irá carregar o projeto relevante, localizar e selecionar o item e
aplicar zoom sobre ele. Se SwitchBack não foi realizado corretamente
com o objeto selecionado e foi exibida uma mensagem de erro, tente
selecionar mais acima na Selection Tree no Autodesk Navisworks.

DICA Alternativamente, na janela Clash Detective, na guia Results, é
possível clicar no botão SwitchBack.

OBSERVAÇÃO Se você tentar usar SwitchBack e o arquivo RVT não estiver na
mesma localização de quando ele foi salvo, uma caixa de diálogo será exibida
perguntando se você deseja procurar o arquivo RVT.
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Menu de atalho: Retornar

Appearance Profiler
O Appearance Profiler permite definir perfis personalizados de aparência com
base em conjuntos (pesquisa e seleção) e valores de propriedade, e usá-los para
codificar em cores os objetos no modelo para diferenciar os tipos de sistemas
e identificar visualmente seu status. Os perfis de aparência podem ser salvos
como arquivos DAT e compartilhados entre outros usuários do Autodesk
Navisworks.

Os seletores de perfil de aparência definem o critério de seleção de objeto e as
configurações de aparência. A seleção do objeto pode ter base em valores de
propriedade ou em conjuntos de pesquisa e seleção disponíveis em seu arquivo
do Autodesk Navisworks.

O uso de valores de propriedade é mais flexível, porque os conjuntos de
pesquisa e seleção precisam ser adicionados primeiro em seu modelo, e são
com frequência projetados para cobrir uma área específica do modelo (nível,
piso, zona, e assim por diante). Por exemplo, se seu modelo tem cinco andares,
para localizar todos os objetos de "Água Fria" com conjuntos, é preciso definir
cinco seletores de "Água Fria", um por andar. Se você usar o método com base
na propriedade, um seletor de 'Água Fria' é suficiente, já que a pesquisa
compreende todo o modelo, incluindo as propriedades extras vindas de bancos
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de dados externos se disponível (consulte Vínculos com bancos de dados
externos na página 396)

Não há restrição no número de seletores que um perfil de aparência possa ter.
No entanto, a ordem dos seletores em um perfil é importante. Os seletores de
aparência são aplicados ao modelo em ordem sequencial, de cima para baixo.
Se um objeto pertence a mais de um seletor, a aparência do objeto será
sobreposta cada vez que ele é processado por um novo seletor na lista. No
momento não é possível alterara a ordem dos seletores após estes terem sido
adicionados na lista.

Consulte também:

Caixa de diálogo Appearance Profiler  na página 783

Para abrir o Appearance Profiler

■ Clique na guia Home painel  ➤ Tools ➤ Appearance Profiler

Para salvar um perfil de aparência

1 Abra a caixa de diálogo Appearance Profile e defina todos os seletores
necessários.

2 Clique no botão Save.

3 Na caixa de diálogo Salvar como , insira o nome e a localização do
arquivo.

4 Clique em Salvar.

Para abrir um perfil de aparência existente

1 Abra a caixa de diálogo Perfil de aparência.

2 Clique em Carregar.

3 Na caixa de diálogo Abrir localize o arquivo DAT do perfil de aparência
desejado

4 Clique em Abrir.

Para codificar em cores o modelo por valores da propriedade

1 Abra a caixa de diálogo Perfil de aparência.

2 Clique na guia By Property na área Selector.

3 Use os campos fornecidos para configurar o critério de seleção de objeto
para seu seletor.
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4 Clique em Seleção de teste. Todos os objetos que satisfazem os critérios
são selecionados na Scene View.

5 Se você estiver satisfeito com os resultados, use a área Aparência para
configurar as sobreposições de cor e transparência para seu seletor.

6 Clique em Adicionar. O seletor é agora adicionado à lista Selector.

7 Repita as etapas 3 a 6 até ter adicionado todos os seletores necessários.
Lembre-se, a ordem dos seletores na lista é importante.

DICA Se você usa seu primeiro seletor para sobrepor a cor de todo o modelo
para cinza com 80% de transparência, outras sobreposições de cor terão
mais destaque.

8 Clique em Executar. Os objetos em seu modelo agora estão codificados
por cores.

Para codificar em cores o modelo por conjuntos de pesquisa e seleção

1 Abra a caixa de diálogo Perfil de aparência.

2 Clique na guia By Set na área Selector.

3 Selecione na lista o conjunto que deseja usar e clique em Seleção de
teste. Todos os objetos que satisfazem os critérios são selecionados na
Scene View.

4 Se você estiver satisfeito com os resultados, use a área Aparência para
configurar as sobreposições de cor e transparência para seu seletor.

5 Clique em Adicionar. O seletor é agora adicionado à lista Selector.

6 Repita as etapas 3 a 5 até ter adicionado todos os seletores necessários.
Lembre-se, a ordem dos seletores na lista é importante.

7 Clique em Executar. Os objetos em seu modelo agora estão codificados
por cores.
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Para redefinir as sobreposições de cores de volta para os valores originais

■ Clique em guia Home painel  ➤  Project ➤ menu suspenso Reset
All ➤ Appearances
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Utilizar pontos de vista
e modos de corte

Os pontos de vista são um recurso importante do Autodesk Navisworks. Eles permitem
salvar e chamar de volta diferentes configurações relacionadas à vista do modelo e
configurações para navegação. Você também tem a opção de salvar as sobreposições
de visibilidade e aparência do item nos pontos de vista.

Criar e modificar pontos de vista

Visão geral de pontos de vista

Os pontos de vista são instantâneos tirados do modelo da forma como ele é
exibido na Scene View. Importante, os pontos de vista podem ser usados para
mais do que apenas salvar informações sobre a vista do modelo. Por exemplo,
eles podem ser complementados com linhas de marcação e comentários,
permitindo usar os pontos de vista como uma trilha de auditoria de revisão de
projeto. Os pontos de vista também podem ser usados como links na Scene
View, para que quando você clicar e ampliar o zoom em um ponto de vista, o
Autodesk Navisworks também exiba as linhas de marcação e comentários
associados a ele.

Os pontos de vista, linhas de marcação e comentários são salvos em um arquivo
NWF do Autodesk Navisworks e independem da geometria do modelo. Portanto,
se os arquivos de CAD estão mudando, os pontos de vista salvos permanecem
os mesmos, aparecendo como uma sobreposição em cima da camada base da
geometria do modelo. Isso permite visualizar como o projeto está se
desenvolvendo. Consulte Revisar seu modelo na página 361 para obter mais
informações sobre links, comentários e linhas de marcação e Formatos de arquivo
nativo na página 175 para obter mais informações sobre o formato de arquivo
NWF.
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Os pontos de vista englobam uma faixa de diferentes informações sobre a vista
do modelo, configurações de navegação, e anotações na forma de linhas de
marcação e comentários. Consulte Opções padrão de ponto de vista na página
482 para obter mais informações.

Vista do modelo

■ Posição da câmera, modo de projeção, campo de visão e orientação

■ Modo de iluminação, modo de renderização e alternação para a exibição
de diferentes tipos de geometria (superfícies, linhas e pontos).

■ Configuração de corte

Adicionalmente, as seguintes sobreposições de itens podem ser salvas com o
ponto de vista (isto é opcional):

■ Visibilidade (oculto / requerido)

■ Aparência (cor e transparência)

Navegação

■ Velocidades de movimento linear e angular

■ Configurações de realismo (colisão, gravidade, terceira pessoa, agachar)

■ A ferramenta de navegação atualmente selecionada

Anotações

■ Linhas de marcação

■ Comentários

Janela Saved Viewpoints

A janela Saved Viewpoints é uma janela encaixável que permite criar e
gerenciar diferentes vistas de seu modelo, para que seja possível pular para
pontos de vista predefinidos sem ter que navegar a cada vez para alcançá-los.
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As animações do ponto de vista também são salvas com os pontos de vista, já
que simplesmente uma lista de pontos de vista tratados como quadros-chave.
De fato, as animações do ponto de vista podem ser criadas bastando arrastar
pontos de vista predefinidos para uma animação vazia de ponto de vista. Você
pode organizar seus pontos de vista e animações do ponto de vista utilizando
pastas.

Ícones são utilizados para representar diferentes elementos:

 representa uma pasta que pode conter todos os outros elementos (incluindo
outras pastas).

 representa um ponto de vista salvo no modo ortogonal.

 representa um ponto de vista salvo no modo de perspectiva.

 representa um clip de animação do ponto de vista.

 representa um corte inserido em um clip de animação do ponto de vista.

É possível selecionar mais de um ponto de vista mantendo pressionada a tecla
Ctrl e clicando com o botão esquerdo do mouse ou clicando com o botão
esquerdo no primeiro elemento e então clicando no último elemento enquanto
mantém pressionada a tecla Shift.

Você pode arrastar pontos de vista em torno da janela Saved Viewpoints e
reorganizá-los em pastas ou animações.

Existem botões nesta janela e comandos são invocados através de menus de
atalho.
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Através destes menus, é possível salvar e atualizar pontos de vista, criar e
gerenciar animações do ponto de vista, e criar pastas para organizar estes
pontos de vista e animações do ponto de vista. Você também pode arrastar e
soltar pontos de vista ou animações do ponto de vista em animações do ponto
de vista ou pastas. Manter pressionada a tecla Ctrl durante esta operação irá
copiar o elemento sendo arrastado. Isto permite hierarquias bem complexas
de animações de ponto de vista e pastas que podem ser facilmente copiadas.

Pontos de vista, pastas e animações de pontos de vista podem ser renomeados
clicando lentamente (clicando e pausando sem mover o mouse) no elemento
ou clicando no elemento e pressionando F2.

Para alternar a janela Saved Viewpoints

■ Clique na guia Viewpoint painel  ➤ Save, Load & Playback
inicializador de ferramenta  ➤ Saved Viewpoints  .

Menu: Interface de usuário Classic: View ➤ Control Bars ➤ Saved
Viewpoints

Entrada do comando: Ctrl + F11

Você obtém um menu de atalho diferente, dependendo de qual elemento foi
clicado com o botão direito do mouse na janela Saved Viewpoints. Todos
os menus de atalho compartilham a opção Sort, que classifica o conteúdo da
janela na ordem alfabética, incluindo pastas e seus conteúdos.

Blank Space

Salvar ponto de vista Salva o ponto de vista atual, e a seguir o adiciona na
janela Saved Viewpoints.

New Folder Adiciona a pasta na janela Saved Viewpoints.

Add Animation Adiciona uma nova animação vazia do ponto de vista, pronta
para receber pontos de vista.

Add Cut Adiciona um corte na animação. Os cortes são utilizados como pausas
nas animações do ponto de vista e têm um segundo de duração por padrão.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.

Saved Viewpoint

Salvar ponto de vista Cria uma cópia do ponto de vista selecionado na janela
Saved Viewpoints.
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New Folder Adiciona uma pasta acima do ponto de vista selecionado.

Add Animation Adiciona uma nova animação vazia de ponto de vista acima
do ponto de vista selecionado.

Add Cut Adiciona um corte de animação acima do ponto de vista selecionado.
Os cortes são utilizados como pausas nas animações do ponto de vista e têm
um segundo de duração por padrão.

Add Copy Cria uma cópia do ponto de vista selecionado na janela Saved
Viewpoints. A cópia é nomeada com o mesmo nome do ponto de vista
selecionado, mas inclui o número da versão entre colchetes. Por exemplo,
View1(1), View1(2), e assim por diante.

Add Comment Adiciona um comentário em relação ao ponto de vista
selecionado. Consulte Comentários, linhas de marcação e identificadores na
página 427 para obter mais informações sobre comentários.

Edit Comment Quando disponível, abre a caixa de diálogo Edit Comment.

Edit Abre a caixa de diálogo Edit Viewpoint , e permite editar manualmente
os atributos do ponto de vista.

Update Torna o ponto de vista selecionado igual ao ponto de vista atual na
Scene View.

Transform Abre a caixa de diálogo Transform. Permite transformar a posição
da câmera. Essa opção não está disponível em um espaço de trabalho 2D.

Delete Exclui o ponto de vista da janela Saved Viewpoints.

Rename Permite renomear o ponto de vista selecionado.

Copy Name Copia o nome do ponto de vista selecionado para a Área de
transferência.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.

Animação do ponto de vista

Salvar ponto de vista Salva o ponto de vista atual e o adiciona como o último
quadro-chave na animação de ponto de vista selecionada.

New Folder Adiciona uma pasta como o último quadro-chave na animação
do ponto de vista selecionada.

Add Animation Adiciona uma nova animação vazia de ponto de vista como
o último quadro chave na animação do ponto de vista selecionada.

Criar e modificar pontos de vista  | 475



Add Cut Adiciona um corte de animação no fim da animação do ponto de
vista. Os cortes são utilizados como pausas nas animações do ponto de vista
e têm um segundo de duração por padrão. Você pode arrastar o corte criado
para uma posição diferente.

Add Copy Cria uma cópia da animação do ponto de vista selecionada na
janela Saved Viewpoints. A cópia é nomeada com o mesmo nome da
animação de ponto de vista selecionada, mas inclui o número da versão entre
colchetes. Por exemplo, View1(1), View1(2), e assim por diante.

Add Comment Adiciona uma comentário relativo a animação do ponto de
vista selecionada. Consulte Comentários, linhas de marcação e identificadores
na página 427 para obter mais informações sobre comentários.

Edit Comment Quando disponível, abre a caixa de diálogo Edit Comment.

Edit Abre a caixa de diálogo Edit Animation , e permite definir a duração
da animação do ponto de vista selecionada, o tipo de suavização e se efetua
ou não o ciclo.

OBSERVAÇÃO Clicar em Edit sobre um quadro-chave da animação, abre a caixa
de diálogo Edit Viewpoint; e clicar em Edit sobre um corte da animação, abre
a caixa de diálogo Edit Animation Cut.

Update Atualiza todos os quadros-chave na animação de ponto de vista com
o estilo de renderização, iluminação e modo ou ferramenta de navegação
atuais.

OBSERVAÇÃO Clicar em Update sobre um quadro-chave único somente irá
atualizar aquele quadro com os modos atuais.

Transform Abre a caixa de diálogo Transform. Permite transformar a posição
da câmera. Essa opção não está disponível em um espaço de trabalho 2D.

Delete Exclui a animação do ponto de vista selecionada da janela Saved
Viewpoints.

OBSERVAÇÃO Clicar em Delete sobre um quadro-chave ou corte, remove o
quadro-chave ou corte da animação do ponto de vista.

Rename Permite renomear a animação de ponto de vista selecionada,
quadro-chave ou corte.

Copy Name Copia o nome da animação de ponto de vista selecionada,
quadro-chave ou corte para a Área de transferência.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.
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Folder

Salvar ponto de vista Salva o ponto de vista atual e o adiciona na pasta
selecionada.

New Folder Adiciona uma subpasta na pasta selecionada.

Add Animation Adiciona uma animação vazia de ponto de vista na pasta
selecionada.

Add Cut Adiciona um corte de animação na pasta selecionada. Os cortes são
utilizados como pausas nas animações do ponto de vista e têm um segundo
de duração por padrão. Você pode arrastar o corte criado para uma posição
diferente.

Add Copy Cria uma cópia da pasta selecionada na janela Saved Viewpoints.
A cópia é nomeada com o mesmo nome da pasta selecionada, mas inclui o
número da versão entre colchetes. Por exemplo, Folder1(1), Folder1(2) e assim
por diante.

Add Comment Adiciona um comentário relativo a pasta selecionada. Consulte
Comentários, linhas de marcação e identificadores na página 427 para obter
mais informações sobre comentários.

Edit Comment Quando disponível, abre a caixa de diálogo Edit Comment.

Update Atualiza todos os pontos de vista na pasta com o estilo de renderização,
iluminação e modo ou ferramenta de navegação atuais. Escolher Update para
um ponto de vista único, somente irá atualizar aquele ponto de vista com os
modos atuais.

Transform Abre a caixa de diálogo Transform. Permite transformar a posição
da câmera. Essa opção não está disponível em um espaço de trabalho 2D.

Delete Remove a pasta selecionada e todo seu conteúdo da janela Saved
Viewpoints.

Rename Permite renomear a pasta selecionada.

Copy Name Copia o nome da pasta selecionada para a Área de transferência.

Sort Classifica o conteúdo da janela Saved Viewpoints na ordem alfabética.

Help Abre o sistema de ajuda.
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Save Viewpoints

Novos pontos de vista são denominados “ViewX” onde “X” é o próximo
número disponível adicionado à lista. Este novo ponto de vista pega todos os
atributos do ponto de vista atual na Scene View.

Para salvar um ponto de vista

1 Clique na guia Viewpoint ➤ painel Save, Load & Playback ➤ lista

suspensa Save Viewpoint ➤ Save Viewpoint  .

A janela Saved Viewpoints agora está em foco, e um novo ponto de
vista é adicionado.

2 Digite um novo nome para o seu ponto de vista na janela Saved
Viewpoints, e pressione Enter.

Menu: Classic user interface: Viewpoint ➤ Saved Viewpoints ➤ Save
Viewpoint

Chamar pontos de vista

Você pode retornar para qualquer um dos pontos de vista anteriormente salvos.
Ao chamar pontos de vista no modo de navegação que estava ativo quando
o ponto de vista foi criado, será novamente selecionado. Quaisquer linhas de
marcação e comentários associadas com ponto de vista também serão
restaurados.

Para chamar um ponto de vista a partir da faixa de opções

■ Clique na guia Viewpoint painel  ➤ Save, Load & Playback menu
suspenso  ➤ Current Viewpoint e selecione o ponto de vista salvo na
lista.

478 | Capítulo 8    Utilizar pontos de vista e modos de corte



Ele agora é exibido na Scene View.

Para chamar um ponto de vista a partir da janela Saved Viewpoints

1 Se a janela Saved Viewpoints não for exibida, clique na guia
Viewpoint ➤ painel Save, Load & Playback ➤ iniciador de
ferramentas Saved Viewpoints  .

2 Clique no ponto de vista desejado na lista. Ele agora é exibido na Scene
View.

Organizar pontos de vista

Os pontos de vista podem ser organizados em pastas, como necessário.

Para organizar pontos de vista em pastas

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback lista
suspensa  ➤ Current Viewpoint ➤ Manage Saved Viewpoint.
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Isto abre a janela Saved Viewpoints, e a torna a janela ativa.

2 Clique com o botão direito do mouse em um espaço vazio na Saved
Viewpoints e clique em New Folder.

3 Digite um novo nome e pressione Enter.

DICA Utilize nomes que possam ajudá-lo a identificar seus pontos de vista
no futuro.

4 Arraste os pontos de vista requeridos para sua nova pasta.

Editar pontos de vista

Dependendo se você trabalha em um espaço de trabalho 2D ou 3D, é possível
editar todos ou alguns dos seguintes atributos dos pontos de vista, incluindo
a posição da câmera, o campo de visão, a velocidade do movimento e os
atributos salvos. Todas as entradas são medidas em Unidades de exibição na
página 169.

DICA Clique na guia Viewpoint e deslize o painel Navigate para ajustar
rapidamente a velocidade linear e a angular do movimento para o seu ponto de
vista atual em um espaço de trabalho 3D.

Para editar o ponto de vista atual

1 Clique na guia Viewpoint ➤  painel Save, Load & Playback  ➤ Edit

Current Viewpoint  .
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2 Utilize a caixa de diálogo Edit Viewpoint na página 796 para ajustar os
atributos do ponto de vista.

3 Clique em OK.

Para editar um ponto de vista

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback lista
suspensa  ➤ Current Viewpoint ➤ Manage Saved Viewpoint.

2 Na janela Saved Viewpoints, clique com o botão direito no ponto de
vista que você deseja modificar, e clique em Edit.

3 Utilize a caixa de diálogo Edit Viewpoint na página 796 para ajustar os
atributos do ponto de vista.
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4 Clique em OK.

Para excluir um ponto de vista

1 Clique na guia Viewpoint painel  ➤ Save, Load & Playback lista
suspensa  ➤ Current Viewpoint ➤ Manage Saved Viewpoint.

2 Na janela Saved Viewpoints, clique com o botão direito no ponto de
vista que deseja remover e clique em Delete.

Opções padrão de ponto de vista

Dois atributos de vista podem ser salvos com um ponto de vista:
■ Hide/Required - se os itens são ocultos ou requeridos.

■ Override Materials - a cor e transparência do itens.

Você pode definir que um ponto de vista salve seus atributos ao editar na
página 480 o ponto de vista. Para atualizar as alterações de materiais sobrepostos
ou ocultos/requeridos, utilize a opção Update no menu de atalho do ponto
de vista. Mas tenha cuidado, pois isso também atualiza o ponto de vista, que
pode causar distúrbio sobre quaisquer informações de linhas de marcação
armazenadas com o ponto de vista.
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Por padrão, estes atributos não são armazenados com os novos pontos de vista
salvos. Caso deseje salvá-los por padrão, então isso pode ser definido no
Options Editor.

As configurações padrão de colisão também podem ser salvas com um ponto
de vista, incluindo se a colisão, gravidade, agachar-se e vista da terceira pessoa
estão ativados. Essas configurações somente são utilizadas em um espaço de
trabalho 3D.

Você pode definir que um ponto de vista salve qualquer uma destas
configurações ao editar o ponto de vista, da mesma forma que os atributos da
vista.

Por padrão, todas as configurações da colisão são desativadas. Se você deseja
salvar suas configurações padrão de colisão predefinidas, utilize o Options
Editor.

OBSERVAÇÃO Quando você modifica as configurações padrão do ponto de vista,
suas alterações não afetam o arquivo do Autodesk Navisworks aberto no momento.
Elas são utilizadas assim que abrir um novo arquivo do Autodesk Navisworks ou
iniciar uma nova sessão do Autodesk Navisworks.

Para definir os atributos padrão da vista

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Viewpoint Defaults.
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3 Selecione a caixa de seleção Save Hide/Required Attributes se deseja
salvar os itens ocultos e requeridos com o ponto de vista salvo. Isso
significa que ao retornar para estes pontos de vista, os itens que estavam
ocultos quando o ponto de vista foi salvo, serão novamente ocultos e os
que foram desenhados são novamente desenhados. Por padrão, esta caixa
de seleção está desmarcada, já que ela requer uma grande quantidade de
memória para salvar estas informações de estado com cada ponto de
vista.

Consulte Ocultar objetos na página 372 para obter mais informações sobre
os itens ocultos e Tornar objetos como necessários na página 354 para
obter mais informações sobre a criação de itens requeridos.

4 Selecione a caixa de seleção Override Material se deseja salvar as
sobreposições de material com o ponto de vista salvo. Isso significa que
ao retornar para estes pontos de vista, as sobreposições de material
definidas quando o ponto de vista foi salvo, serão restauradas. Por padrão,
esta caixa de seleção está desmarcada, já que ela requer uma grande
quantidade de memória para salvar estas informações de estado com
cada ponto de vista.

Consulte  Manipular atributos de objeto  na página 409 para obter mais
informações sobre a sobreposição de materiais.

5 Selecione a caixa de seleção Override Model Linear Speed para poder
definir um velocidade específica para navegar em um modelo carregado.
Sem estar selecionada, a velocidade de navegação linear é diretamente
relacionada ao tamanho do modelo carregado.
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6 A Default Angular Speed pode ser definida para qualquer número
de graus por segundo. Isso afeta a velocidade de giro da câmera.

7 Clique em OK.

Para definir opções padrão de colisão

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Interface , e clique na opção
Viewpoint Defaults.

3 Na página Viewpoint Defaults clique no botão Settings.

4 Na caixa de diálogo Default Collision na página 791, selecione as opções
padrão com as quais deseja que o Autodesk Navisworks seja inicializado.

5 Clique em OK para retornar para Options Editor.

6 Clique em OK para salvar as alterações.

Compartilhar pontos de vista

É possível exportar pontos de vista salvos do Autodesk Navisworks para um
arquivo XML e os compartilhar com outros usuários.

Para obter mais informações, consulte Exportar pontos de vista na página 533
e Importar pontos de vista na página 522.
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Corte
O Autodesk Navisworks permite ativar o corte do ponto de vista atual e criar
cortes transversais do seu modelo em um espaço de trabalho 3D. A
funcionalidade de corte não está disponível para as folhas 2D.

Um corte transversal é uma vista cortada de um objeto 3D que permite ver
dentro dele. É possível ativar ou desativar o seccionamento para o ponto de
vista clicando na guia Viewpoint ➤ painel Sectioning ➤ Enable

Sectioning  . Quando o seccionamento está ativado, a guia contextual
Sectioning Tools é automaticamente exibida na faixa de opções.

Existem dois modos de seccionamento disponíveis a partir da guia Sectioning
Tools ➤ painel Mode: Planes e Box.

O modo Plano  permite criar até sis cortes em qualquer plano, enquanto
ainda é capaz de navegar em torno da cena, permitindo ver dentro dos modelos
sem ocultar qualquer item. Por padrão dos planos de corte são criados através
do centro da área visível do modelo.

Os planos de corte são armazenados dentro dos pontos de vista, e também
podem ser utilizados dentro de animações do ponto de vista e de animações
de objeto, para mostrar um modelo dinamicamente cortado. Consulte Janela
Saved Viewpoints na página 472 para obter mais informações sobre pontos de
vista e  Gravar e reproduzir animações  na página 503 para obter mais
informações sobre animações.
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O modo Box  permite que você concentre a revisão em áreas específicas
e limitadas do modelo. Conforme você move a caixa em torno, somente a
geometria dentro da caixa de corte definida é exibida na Scene View.

Para ativar ou desativar o seccionamento para o ponto de vista atual

■ Clique na guia Viewpoint painel  ➤ Sectioning ➤ Enable Sectioning

 .

Barra de ferramentas: Interface de usuário Classic:

Workspace ➤ Enable Sectioning

Ativar e usar planos de corte

Para visualizar cortes transversais de seu modelo, você pode ativar até seis
planos de corte. Quando um plano é "ativado" isto significa que ele afeta (corta
através) a cena. O plano atual é aquele visível na Scene View. Selecionar um
plano como o atual automaticamente ativa aquele plano se ele não tiver sido
ativado anteriormente.

Quando um plano de corte é ativado pela primeira vez, ele é criado com o
alinhamento e posição padrão. Mais tarde, ativar um plano de corte restaura
o alinhamento, posição e rotação salvos se estiverem disponíveis para o ponto
de vista atual.
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OBSERVAÇÃO Para salvar as configurações para os planos de corte ativados
(alinhamento, posição e rotação), é preciso salvar o ponto de vista atual com o
corte ativado e no modo de seccionamento.

Por padrão, um plano de corte é criado na vista, o mais próximo do centro da
vista possível. Visualmente, um plano de corte é representado por uma estrutura
de arame azul claro. É possível ocultar a representação visual do plano ao
alternar o botão da meta-alça correspondente.

Para usar um plano para cortar através de um modelo 3D pela primeira vez

1 Clique na guia Viewpoint painel  ➤ Sectioning ➤ Enable Sectioning

 .

O Autodesk Navisworks abre a guia Sectioning Tools na faixa de opções
e desenha um plano de corte através do modelo na Scene View. O
alinhamento padrão para o Plane 1 é Top. A posição padrão é através do
centro da área visível do modelo. Move é a meta-alça padrão.

2 Arraste a meta-alça para posicionar o plano atual, como necessário.

3 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.
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Para alterar o plano de corte atual

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja tornar o atual, por exemplo, Plane 2.

O plano selecionado agora está visível (estrutura de arame azul claro), e
pode ser manipulado. O outro plano de seção não está visível mas ainda
atravessa o modelo Scene View pelo tempo que o plano estiver ativado.

DICA Para ver quais planos estão ativados, expanda o menu suspenso
Current Plane no painel Planes Settings. O plano ativado tem um ícone

de lâmpada  próximo do seu nome.

Para ativar ou desativar planos de corte adicionais

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e clique nos ícones de lâmpada próximos de todos os planos requeridos.

Quando uma lâmpada está acesa, o plano de corte correspondente está
ativado e corta através do modelo na Scene View.
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OBSERVAÇÃO Se você deseja remover todos os planos juntos, é possível
vinculá-los. De outra forma, você somente pode mover um plano (o atual)
por vez.

Personalizar o alinhamento do plano de corte

Por padrão, os planos de corte são mapeados para uma das seis direções
principais, como segue:

Default AlignmentPlane NamePlane No

TopPlane 11

BottomPlane 22

FrontPlane 33

BackPlane 44

LeftPlane 55

RightPlane 66

É possível selecionar um alinhamento diferente para o plano de corte atual.
Existem 6 alinhamentos fixos e 3 alinhamentos personalizados a serem
escolhidos:
■ Top  - alinha o plano atual com a parte superior do modelo.

■ Bottom  - alinha o plano atual com a parte inferior do modelo.
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■ Front  - alinha o plano atual com a parte frontal do modelo.

■ Back  - alinha o plano atual com a parte posterior do modelo.

■ Left  - alinha o plano atual à esquerda do modelo.

■ Right  - alinha o plano atual à direita do modelo.

■ Align To View  - alinha o plano atual à câmera do ponto de vista atual.

■ Align To Surface  - permite selecionar uma superfície e colocar o plano
atual "naquela" superfície, com a sua normal alinhada com a normal do
triângulo selecionado.

■ Align To Line  - permite selecionar uma linha, e colocar o plano atual
"naquela" linha, no ponto onde você clicou, e alinhar para que o seu normal
esteja na própria linha, de frente para a câmera.

Para alinhar um plano de corte com uma das direções pré-fixadas

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja personalizar, por exemplo, Plane 1.

Este plano se torna o plano atual.

3 Clique no menu suspenso Alignment no painel Planes Settings, e
selecione uma das seis direções pré-fixadas, por exemplo, Top 

O Autodesk Navisworks atualiza a posição e o alinhamento do plano de
corte.

4 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

Para alinhar um plano de corte com uma linha

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja personalizar, por exemplo, Plane 1.

Este plano se torna o plano atual.

3 Clique no menu suspenso Alignment no painel Planes Settings e
clique em Align To Line  .

O cursor muda para um  alvo.
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4 Na Scene View, clique em algum lugar na linha para a qual deseja
alinhar.

O Autodesk Navisworks atualiza a posição e o alinhamento do plano de
corte, para que ele seja colocado no ponto clicado.

5 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

Para alinhar um plano de corte com uma superfície

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja personalizar, por exemplo, Plane 1.

Este plano se torna o plano atual.

3 Clique no menu suspenso Alignment no painel Planes Settings e
clique em Align To Surface  .

O cursor muda para um  de alvo de mira.

4 Na Scene View, clique em algum lugar em um objeto para o qual você
deseja alinhar.

O Autodesk Navisworks atualiza a posição e o alinhamento do plano de
corte, para que ele seja colocado 'na' superfície do objeto selecionado.

5 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

Para alinhar um plano de corte com uma vista

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja personalizar, por exemplo, Plane 1.

Este plano se torna o plano atual.

3 Clique no menu suspenso Alignment no painel Planes Settings, e
clique em Align to View  .

4 Opcional: Clique em Sectioning Tools ➤  painel Save ➤ Save

Viewpoint  para salvar o atual ponto de vista cortado.
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Mover e rotacionar planos de corte

Os planos de corte podem ser manipulados com as meta-alças de
seccionamento, disponíveis na guia Sectioning Tools ➤ painel Transform.
Também é possível manipular a caixa de seleção numericamente. Os planos
de corte podem ser movidos e rotacionados, mas não redimensionados.

Por padrão, quando um plano de corte é tornado o atual, a meta-alça de
movimentação é usada, ao menos que você já tenha selecionado a meta-alça
de rotação antes de ativar o plano de corte. Todas as meta-alças compartilham
a mesma localização/rotação. Isto significa que mover uma meta-alça afeta a
posição das outras.

Você só pode manipular um plano por vez (o plano atual), mas é possível
vincular os planos de corte para formar fatias.

A tabela a seguir ilustra como as meta-alças de seccionamento funcionam com
os planos de corte.

ComportamentoMeta-alça

Braços e faces perpendiculares movem o
plano atual e a meta-alça. Braços e faces
paralelos movem somente a meta-alça.

Move

A posição da meta-alça significa o centro
da rotação. Arcos perpendiculares

Rotate

rotacionam o plano atual e a meta-alça.
Arcos paralelos rotacionam somente a meta-
alça. Os braços movem somente a meta-
alça.

Não é usada com planos de corte.Scale

Para mover um plano de corte com a meta-alça

1 Clique na guia Sectioning Tools painel  ➤  Mode ➤  Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja usar, por exemplo, Plane 3.

Este plano se torna o plano atual.
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3 Se a meta-alça não estiver visível na Scene View, clique no painel

Transform ➤  Move  .

4 Arraste a meta-alça para mover o plano atual, como necessário.

DICA Braços e faces perpendiculares movem o plano atual e a meta-alça.
Braços e faces paralelos movem somente a meta-alça.

Para mover um plano de corte numericamente

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja usar, por exemplo, Plane 3.

Este plano se torna o plano atual.

3 Deslize o painel Transform, e digite os valores numéricos nas caixas
de entrada manual Position para mover o plano atual pela quantidade
inserida.

Para rotacionar um plano de corte com a meta-alça

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja usar, por exemplo, Plane 3.

Este plano se torna o plano atual.

3 Clique na guia Sectioning Tools ➤ Clique no painel

Transform ➤ Rotate  .

4 Arraste a meta-alça para rotacionar o plano atual, como necessário.

DICA Arcos perpendiculares rotacionam o plano atual e a meta-alça. Arcos
paralelos rotacionam somente a meta-alça. Os braços movem somente a
meta-alça.
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Para rotacionar um plano de corte numericamente

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Clique no menu suspenso Current Plane no painel Planes Settings,
e selecione o plano que deseja usar, por exemplo, Plane 3.

Este plano se torna o plano atual.

3 Deslize o painel Transform, e digite os valores numéricos nas caixas
de entrada manual Rotation para rotacionar o plano atual pela
quantidade inserida.

Vincular planos de corte

No Autodesk Navisworks, é possível ativar até 6 planos para cortar através do
modelo, mas somente o plano atual pode ser manipulado com as meta-alças
de corte.

Vincular planos de corte faz com que eles se movam como se fossem um, e
permite rapidamente fatiar o seu modelo em tempo real. As fatias podem ser
utilizadas em pontos de vista, animações do ponto de vista e animações de
objeto.
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Para vincular os planos

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Planes  .

2 Ative os planos requeridos ao clicar no menu suspenso Current Plane
no painel Planes Settings, e clique nos ícones de lâmpada próximos
de todos os planos requeridos.

Quando uma lâmpada está acesa, o plano de corte correspondente está
ativado e corta através do modelo na Scene View.

3 Clique em Link Section Planes no painel Planes Settings. Todos
os planos ativados são vinculados em uma fatia.

4 Se a meta-alça de movimento não estiver visível em Scene View, no

painel Transform, clique em Move  .

5 Arraste a meta-alça para mover o plano de corte atual. Todos os planos
de corte agora movem juntos, efetivamente criando uma fatia através
do modelo.
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6 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

OBSERVAÇÃO É possível clicar na guia Animation ➤ painel Create ➤ Record

 e criar uma animação de ponto de vista mostrando o modelo à medida que
ele é fatiado.

Ativar e usar a caixa de corte

É possível usar uma caixa de corte para focar a sua revisão em áreas específicas
e limitadas do modelo. A caixa de corte pode ser movida, rotacionada e
redimensionada com os gizmos de corte, disponíveis na guia Sectioning
Tools ➤ painel Transform. Também é possível manipular a caixa de seleção
numericamente.

Por padrão, quando uma caixa de corte é ativada, a meta-alça de movimentação
é usada, ao menos que você tenha selecionado uma meta-alça diferente antes
de ativar a caixa de corte. Todas as meta-alças compartilham a mesma
localização/rotação. Isto significa que mover uma meta-alça afeta a posição
das outras.

Quando a caixa de corte á criada pela primeira vez, o tamanho padrão da caixa
tem base nos limites do ponto de vista atual. A caixa é criada para preencher
a vista, de tal forma que nenhuma parte da caixa seja desenhada fora da tela.
Mais tarde, ativar uma caixa de corte restaura as informações de posição,
rotação e escala salvas usadas se estiverem disponíveis para o ponto de vista
atual.

OBSERVAÇÃO Para salvar configurações da caixa de corte (posição, rotação e
escala), é preciso salvar o ponto de vista atual com o seccionamento ativado e no
modo de caixa.

A tabela a seguir ilustra como as meta-alças de seccionamento funcionam com
as caixas de corte.

ComportamentoMeta-alça

É possível usar os braços e faces para mover
a caixa e a própria meta-alça no eixo
relativo.

Move
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ComportamentoMeta-alça

A posição da meta-alça significa o centro
da rotação. Os arcos rotacionam a caixa.
Os braços movem somente a meta-alça.

Rotate

É possível mover o centro de transformação.
Puxar qualquer um dos pontos de escala
redimensiona a caixa.

Scale

Para usar uma caixa para cortar através de um modelo 3D pela primeira vez

1 Clique na guia Viewpoint painel  ➤ Sectioning ➤ Enable Sectioning

 .

O Autodesk Navisworks abre a guia Sectioning Tools na faixa de opções
e desenha um plano de corte através do modelo em Scene View.

2 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Box  .

A caixa agora está visualmente presente na tela, com a meta-alça de
movimentação ativa por padrão.

3 Arraste a meta-alça para cortar o modelo com a caixa ao longo dos eixos.
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4 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

Para mover a caixa de corte com a meta-alça

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Box  .

2 No painel Transform, clique em Move  .

3 Arraste os braços ou faces da meta-alça para mover a caixa, como
necessário.

Para mover a caixa de corte numericamente

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Box  .

2 Deslize o painel Transform, e digite os valores numéricos nas caixas
de entrada manual Position para mover a caixa pela quantidade inserida.

Para rotacionar a caixa de corte com a meta-alça

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Box  .

2 No painel Transform, clique em Rotate  .

3 Arraste a meta-alça para rotacionar a caixa, como necessário.
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4 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

Para rotacionar a caixa de corte numericamente

1 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Box  .

2 Deslize o painel Transform, e digite os valores numéricos nas caixas
de entrada manual Rotation para rotacionar a caixa pela quantidade
inserida.

Para redimensionar a caixa de corte com a meta-alça

1 Clique na guia Sectioning Tools ➤  painel Mode ➤  Box  .

2 No painel Transform, clique em Scale  .

3 Puxe os pontos de escala na meta-alça para redimensionar a caixa, como
necessário.
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4 Opcionalmente: Clique na guia Sectioning Tools painel

 ➤ Save ➤ Save Viewpoint  para salvar o ponto de vista cortado
atual.

Para redimensionar a caixa de corte numericamente

1 Clique na guia Sectioning Tools ➤  painel Mode ➤  Box  .

2 Deslize o painel Transform, e digite os valores numéricos nas caixas d
entrada manual Size para redimensionar a caixa pela quantidade inserida.
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Gravar e reproduzir
animações

No Autodesk Navisworks há dois tipos de animação: animação de ponto de vista e
animação de objeto.

Animação do ponto de vista

A animação do ponto de vista é uma forma rápida e eficaz de gravar seu movimento através
do modelo e das vistas do modelo. Há duas maneiras de produzir uma animação de ponto de
vista no Autodesk Navisworks:

■ Ao gravar uma navegação interativa

■ Ao criar transições com animação entre vistas salvas

Você também pode criar animações de slide show, que são essencialmente, transições de
pontos de vista com diversos cortes (pausas) adicionados entre os pontos de vista.

Animação de objeto

Além da animação do ponto de vista, você também pode criar uma animação e interagir com
a geometria 3D em seu modelo. Embora a habilidade de gravar animações e produzir scripts
necessários para interagir com objetos com animação, esta está limitada aos usuários com
acesso as funcionalidades do Animator e do Scripter, e qualquer usuário pode de fato
reproduzi-las após terem sido gravadas.

Consulte Animar objetos na página 537 para obter instruções passo-a-passo sobre como gravar
animações e scripts.
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Criar e editar animações de ponto de vista
Há duas maneiras de criar animações de ponto de vista no Autodesk
Navisworks. Você pode simplesmente gravar seu percurso virtual em tempo
real, ou pode montar pontos de vista específicos para que o Autodesk
Navisworks possa interpolar em outro momento com uma animação de ponto
de vista.

As animações de ponto de vista são controladas através da guia Animation
e da janela Saved Viewpoints.

É válido lembrar que você pode ocultar itens nos pontos de vista, sobrepor
cores e transparências, e definir múltiplos planos de corte, e estes serão
respeitados por uma animação do ponto de vista. Desta forma você pode com
facilidade criar poderosas animações do ponto de vista.

Após uma animação do ponto de vista ter sido criada, você pode editá-la para
definir a duração, o tipo de suavização e se ela fará ciclos ou não.

Também não há nada que o impeça de copiar animações de pontos de vista
(mantenha pressionada a tecla CTRL ao arrastar uma animação na janela
Saved Viewpoints), arrastar quadros para fora da animação para um espaço
em branco na janela Saved Viewpoints para removê-los da animação do
ponto de vista, editar atributos de quadros individuais, inserir cortes ou arrastar
outros pontos de vista ou animações de ponto de vista para um existente, para
continuar desenvolvendo suas animações.

Cortes (pausas) da animação

Os cortes em uma animação de ponto de vista, são simplesmente pontos onde
a câmera pausa por alguns momentos. Eles são automaticamente inseridos
quando você clica em Pause durante a gravação interativa de uma animação
de ponto de vista, ou quando os insere manualmente em uma animação
existente de ponto de vista.

Para criar uma animação de ponto de vista em tempo real

1 Clique na guia Animation painel  ➤ Create ➤ Record  .

Na parte mais a direita da guia Animation, observe que o painel
Recording é exibido.

2 Navegue pela Scene View enquanto o Autodesk Navisworks grava seus
movimentos. Você pode até mover os planos de corte através do modelo
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durante sua navegação, e isso também será gravado na animação do
ponto de vista.

3 A qualquer momento durante a navegação, clique na guia

Animation ➤ painel Recording ➤ Pause  .

Isso irá pausar a gravação enquanto você manobra para uma nova
posição. Para continuar a gravar a animação do ponto de vista, clique
em Pause novamente.

A animação resultante do ponto de vista irá conter um corte na página
504 para a duração da pausa.

4 Quando concluída, clique na guia Animation ➤ painel

Recording ➤ Stop  .

A animação é salva automaticamente na janela Saved Viewpoints
(clique na guia View ➤ painel Workspace ➤ menu suspenso
Windows ➤ Saved Viewpoints). A sua nova animação de ponto de
vista é denominada "AnimationX", onde "X" é o próximo número
disponível. O nome será editável neste ponto, caso você mesmo deseja
nomeá-la. Esta animação de ponto de vista também irá se tornar a
animação ativa atual na lista suspensa Available Animations no painel
Playback da guia Animation.

Embora o método acima seja útil para criar rápidas animações de ponto de
vista no instante, algumas vezes é preciso ter um maior controle sobre a câmera
do ponto de vista. Para fazer isso no Autodesk Navisworks, é preciso definir
diversos pontos de vista e adicioná-los a uma animação sem pontos de vista.
Ao reproduzir a animação, o Autodesk Navisworks irá, então, interpolar entre
estes pontos de vista.

Para criar uma animação quadro-a-quadro

1 Se necessário, exiba a janela Saved Viewpoints (clique na guia
View ➤ painel Workspace ➤ menu suspenso Windows ➤ Saved
Viewpoints).

2 Clique com o botão direito na janela Saved Viewpoints e selecione
Add Animation.

Uma nova animação de ponto de vista é criada, denominada
"AnimationX", onde "X" é o próximo número disponível. O nome será
editável neste ponto, caso você mesmo deseja nomeá-la. Não haverá
nenhum sinal de mais próximo da nova animação de ponto de vista
porque ela está vazia.
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3 Navegue para uma posição no modelo que você gostaria de adicionar a
sua animação e salve a nova localização como um ponto de vista. (Clique
com o botão direito na janela Saved Viewpoints e selecione Save
Viewpoint.) Repita esta etapa como desejado. Cada ponto de vista irá
se tornar um quadro para a animação. Quanto mais quadros você tiver,
mais suave e mais previsível será a animação do ponto de vista. Consulte
Save Viewpoints na página 478 para obter mais informações sobre como
criar pontos de vista.

4 Quando você tiver todos os pontos de vista necessários, arraste-os para
a animação de ponto de vista vazia que acabou de criar. Você pode
arrastá-los um a um ou pode selecionar múltiplos pontos de vista
utilizando as teclas Ctrl e Shift do teclado e arrastar diversos de uma só
vez.

Caso você os solte no próprio ícone da animação de ponto de vista, então
os pontos de vista se tornam quadros no fim da animação, mas é possível
soltar os pontos de vista em qualquer lugar da animação expandida, para
colocá-los onde desejar.

5 Neste ponto, é possível usar o deslizador Playback Position no painel
Playback da guia Animation para mover adiante ou para trás através
da animação de ponto de vista para ver como ela se parece.

6 É possível editar qualquer um dos pontos de vista dentro da animação
de ponto de vista (consulte Editar pontos de vista na página 480 para
obter mais detalhes sobre isso), ou você pode adicionar mais pontos de
vista, excluí-los, movê-los aleatoriamente, adicionar cortes e editar a
animação na página 506 até que esteja satisfeito com a animação do ponto
de vista.

7 Após ter diversas animações do ponto de vista, você pode arrastá-las e
soltá-las em um animação mestre de ponto de vista, para compor
combinações mais complexas de animações, da mesma forma que arrasta
e solta pontos de vista em uma animação como um quadro.

Para editar uma animação de ponto de vista

1 Se necessário, exiba a janela Saved Viewpoints (clique na guia View ➤ 

painel Workspace ➤  menu suspenso Windows ➤  Saved
Viewpoints).

2 Na janela Saved Viewpoints, clique com o botão direito na animação
de ponto de vista que deseja modificar e selecione Edit.

3 Na caixa de diálogo Edit Animation, na caixa de texto Duration,
digite a duração desejada em segundos.
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4 Se desejar que a animação de ponto de vista se reproduzida
continuamente, selecione a caixa de seleção Loop Playback.

5 Na lista suspensa Smoothing, selecione o tipo de suavização que deseja
que a animação do ponto de vista utilize.

None significa que a câmera irá mover de um quadro para o próximo
sem tentar suavizar os cantos.

Synchronize Angular/Linear Speeds irá suavizar as diferenças entre
velocidades de cada quadro na animação, resultando em uma animação
menos brusca.

6 Clique em OK.

Para inserir cortes (pausas) em uma animação de ponto de vista

1 Se necessário, exiba a janela Saved Viewpoints (clique na guia View ➤ 

painel Workspace ➤  menu suspenso Windows ➤  Saved
Viewpoints).

2 Abaixo do quadro da animação onde você deseja inserir o corte, clique
com o botão direito e selecione Add Cut.

3 Digite o nome do corte, ou pressione Enter para aceitar o nome padrão,
que será "CutX", onde "X" é o próximo número disponível.

4 A duração padrão do corte é de 1 segundo. Para alterar a duração desta
pausa, clique com o botão direito no corte e selecione Edit.

5 Na caixa de diálogo Edit Animation, na caixa de texto Delay, digite
a duração desejada da pausa em segundos.

6 Clique em OK.
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Reproduzir animações e scripts
Você pode reproduzir animações de objetos e de ponto de vista pré-gravadas
na Scene View.

As animações do ponto de vista são reproduzidas em tempo real. Isso significa
que o mecanismo do Autodesk Navisworks ainda está tentando manter a
frequência de quadros garantida, portanto, algum descarte ainda pode ocorrer,
da mesma forma que na navegação em tempo real.

FinalidadeControle

Rebobina a animação atual de volta ao início.

Volta um quadro ou um quadro-chave da
animação.

Reproduz a animação atual no sentido inverso.

Grava a animação do ponto de vista.

Pára a reprodução ou gravação de uma animação.

Pausa a reprodução ou gravação de uma
animação.

Reproduz a animação no momento selecionada.

Avança adiante um quadro ou quadro-chave na
animação.

Move adiante em direção ao fim da animação.

O deslizador de tempo de reprodução.

O girador de tempo de reprodução.
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Para reproduzir uma animação

1 Clique na guia Animation painel  ➤ Playback lista suspensa
 ➤ Available Animations e selecione a animação que deseja reproduzir.

2 No painel Playback, clique em Play  .

Use os botões VCR no painel Playback para controlar a animação. O
deslizador Playback Position permite rapidamente mover adiante e
para trás através da animação. Todo a esquerda é o início e todo a direita
é o final.

A direito do deslizador Playback Position, existem dois indicadores
de andamento da animação: porcentagem e tempo (em segundos). É
possível digitar um número em cada caixa para definir a câmera em um
determinado ponto.

3 Nas animações do ponto de visão, pode-se notar que a estrutura na
animação na janela Saved Viewpoints (clique na guia View painel
 ➤ Workspace menu suspenso  ➤ Windows ➤ Saved Viewpoints)
é ressaltada quando a animação está sendo executada. Clique em qualquer
quadro para definir a câmera para aquele ponto no tempo na animação
de ponto de vista e continuar a reproduzir dali em diante.

Para ativar scripts de animação

■ Clique na guia Animation painel  ➤ Scripts ➤ Enable Scripts  .

Você agora pode interagir com seu modelo. Por exemplo, se houver um
script para abrir uma porta ao pressionar uma tecla específica no teclado,
pressionar esta tecla irá abrir a porta.

Compartilhar animações
É possível exportar as animações aos arquivos AVI para serem reproduzidas
com o Windows Media Player.

Para obter mais informações, consulte Exportar imagens e anotações na página
529.
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Trabalhar em equipe

O Autodesk Navisworks Manage 2012 permite que múltiplos usuários participem
em uma única sessão de revisão de projeto através de uma rede de Área Local (LAN).

A ferramenta Collaborate tem duas limitações dignas de atenção.
■ Colaboração entre diferentes versões do Autodesk Navisworks não é suportada.

■ Este recurso está disponível somente para os usuários do Windows XP, uma vez que este
utiliza as operações de programas compartilhados do Windows NetMeeting, o qual não
está disponível nos sistemas operacionais Vista e Windows 7.

Painel Collaborate
As ferramentas de colaboração necessárias para executar sessões de colaboração
estão localizadas na guia Review ➤ painel Collaborate.

Por padrão, o painel Collaborate não é exibido. Para exibi-lo, clique com o
botão direito na guia Review e clique em Show Panels ➤ Collaborate no
menu de atalho.

Sessão de colaboração
Todos os participantes de reuniões requerem acesso aos arquivos NWF e NWD
do Autodesk Navisworks, numa localização compartilhada. Um dos participantes
será o hospedeiro da reunião e fará uma chamada convidando os outros para a
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mesma. Qualquer um dos participantes que se juntou à reunião pode exercer
o controle e conduzir a sessão. Toda navegação executada pelo condutor será
exibida na Scene View de cada uma das máquinas dos participantes. Qualquer
pontos de visão ou linhas de marcação, por exemplo, adicionadas durante a
sessão, podem ser atualizadas em todos os equipamentos participantes com
apenas um clique num botão.

OBSERVAÇÃO Se uma sessão de revisão colaborativa, como aqui descrita, não
for conduzida em uma mesma sala, então podem ser necessárias provisões
adicionais de teleconferência. Isso pode ser através da utilização do NetMeeting
Whiteboard ou através de seu próprio sistema de telefonia.

Para iniciar uma sessão de colaboração

1 Abra o arquivo do Autodesk Navisworks no qual deseja colaborar a partir
de um diretório compartilhado.

2 Clique na guia Review ➤ painel Collaborate ➤ Collaborate  .

Isso inicializa o Windows® NetMeeting®.
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OBSERVAÇÃO Na primeira vez que o Windows NetMeeting é inicializado,
um assistente de configuração irá levá-lo através do processo de configuração.
Será necessário inserir seu nome e endereço de e-mail. Quando estiver
utilizando o NetMeeting em uma LAN, não será necessário se conectar a
um servidor de diretórios, uma vez que estes não lhe estarão disponíveis.

Para fazer uma chamada para convidar que os participantes se unam à sessão

1 Tendo inicializado o Windows NetMeeting, clique no botão Call
na caixa de diálogo NetMeeting.

2 Na caixa de diálogo Place a Call , insira o nome da máquina ou o
endereço IP da máquina com a qual deseja se juntar à reunião, na caixa
To.
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3 Clique no botão Call para enviar o convite.

Após a pessoa que recebe o convite o aceita, o nome dela e o seu serão
listados na caixa de diálogo NetMeeting.

4 Repita este procedimento para convidar todos os participantes necessários.

Para aceitar um convite

1 Quando você é convidado a se juntar à uma reunião, a caixa de diálogo
Incoming Call será exibida.

2 Clique no botão Accept para se juntar á reunião ou em Ignore para
declinar do convite.

OBSERVAÇÃO Após ter aceitado uma chamada, será preciso clicar na guia

Review ➤ painel Collaborate ➤ Collaborate  para iniciar a sua própria
sessão de colaboração.

Para se tornar o condutor

Durante a reunião, qualquer um participante da chamada pode assumir o
controle da sessão e se tornar o condutor. O condutor irá controlar a navegação
do modelo compartilhado em todas as máquinas na chamada.

1 Clique na guia Review ➤ painel Collaborate ➤ Drive  .

2 Após clicar no botão do condutor, todos os outros usuários na chamada
irão receber uma mensagem avisando que você está solicitando o
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controle. Eles terão que responder Yes para esta mensagem para que
você possa conduzir o Autodesk Navisworks na máquina deles.

Para atualizar todas as máquinas dos participantes

Embora a navegação em tempo real no Autodesk Navisworks possa ser
executada em todas as máquinas em uma chamada por um usuário, não é
possível rever dados salvos, como pontos de vista, comentários e linhas de
marcação, para que sejam automaticamente atualizados em todas as máquinas
do usuários. Essa informação, no entanto, pode ser atualizada em suas
máquinas ao atualizar o modelo. Este processo de atualização pode ser
executado em uma máquina de usuário e ser atualizado em todas as máquinas
na chamada.
■ Clique na guia Review ➤ painel Collaborate ➤ Refresh  .
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Compartilhar dados

Print
Você pode imprimir uma cópia impressa do ponto de vista atual em qualquer
impressora ou plotadora.

Print Preview

Antes de imprimir uma cópia do modelo ou da folha em que estiver trabalhando,
você pode desejar verificar sua aparência.

Para visualizar um modelo/uma folha antes de imprimir

1 Clique na guia Output ➤ painel Print ➤ Print Preview  .

2 Utilize os botões Zoom In e Zoom Out para fazer o mesmo que a imagem
de visualização.

3 Clique em Print.

4 Na caixa de diálogo Print clique em OK.

Print Setup

Esta opção permite definir o tamanho do papel e as opções de orientação.
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Para alterar a configuração de impressão

1 Clique na guia Output ➤ painel Print ➤ Print Settings  .

2 Na caixa de diálogo Print Setup faça as modificações necessárias para
o tamanho de papel e orientação.

3 Clique no botão Properties se desejar alterar configurações específicas
da impressora.

4 Retorne à caixa de diálogo Print e clique em OK.

Imprimir o ponto de vista atual

Quando a opção de impressão é selecionada, o Autodesk Navisworks imprime
o ponto de vista atual, dimensionado para caber e centralizado na página.

OBSERVAÇÃO Caso prefira exportar uma imagem para impressão, consulte
Exportar uma imagem na página 529 para obter mais informações.

Para imprimir o ponto de vista atual

1 Clique na guia Output ➤ painel Print ➤ Print  .

2 Verifique as configurações necessárias da impressora e clique em OK.

OBSERVAÇÃO O tamanho máximo da imagem é de 2048x2048 pixels.

O botão Properties controla as configurações de tinta e papel específicas
da impressora.

Barra de ferramentas: Classic user interface: Standard ➤ Print

Importar arquivos
A opção de importação integra dados de revisão PDS da Intergraph, incluindo:
PDS Tags (.tag) e PDS Display Sets (.dst).

Também é possível importar diversos dados que foram exportados de sessões
anteriores do Autodesk Navisworks. É possível importar folhas 2D e modelos
3D de arquivos DWF, DWF(x), NWD ou NWF ao arquivo aberto no momento
no Autodesk Navisworks. Consulte Adicionar folhas/modelos ao arquivo aberto
atualmente na página 229
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Arquivos de critério de pesquisa

Os critérios de pesquisa podem ser importados no Autodesk Navisworks. Estes
irão preencher a janela Find Items. A pesquisa pode então ser executada no
modelo atual, para encontrar quaisquer itens que coincidem com o critério
específico. Consulte Janela Find Items na página 374 para obter mais
informações sobre como pesquisar no modelo para encontrar itens com base
em suas propriedades.

Para importar critério de pesquisa salvo

1 Clique no botão do aplicativo  ➤ Import ➤ Search  .

2 Na caixa de diálogo Import, localize o arquivo XML de pesquisa
desejado.

3 Clique em Open.

Importar arquivos | 519



Arquivos de conjunto de pesquisa

Os conjuntos de pesquisa podem ser importados no Autodesk Navisworks.
Isto irá preencher a janela Sets com conjuntos de pesquisa predefinidos
(consulte Janela Sets na página 385). A seleção de um Conjunto de pesquisa
importado, irá definir o critério atual de Encontrar itens e irá pesquisar o
modelo atual de acordo. Consulte Janela Find Items na página 374 para obter
mais informações sobre como pesquisar no modelo para encontrar itens com
base em suas propriedades.

Para importar conjuntos de pesquisa salvos

1 Clique no botão do aplicativo  ➤ Import ➤ Search Sets  .

2 Na caixa de diálogo Import, localize o arquivo XML dos conjuntos
desejado.

3 Clique em Open.

520 | Capítulo 11   Compartilhar dados



Arquivos do conjunto de exibição PDS

Conjuntos de exibição do PDS da Intergraph, contêm critérios detalhados que
definem as seleções do item. Ao importar para o Autodesk Navisworks os
arquivos DST criam Search Sets na janela Selection Sets.

Consulte também:

Janela Sets na página 385

Para importar conjuntos de exibição PDS

1 Clique no botão do aplicativo  ➤ Import ➤ PDS Display Sets

 .

2 Use a caixa de diálogo Import para localizar o arquivo DST desejado.

3 Clique em Open para importar os conjuntos de exibição PDS.
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Arquivos PDS Tag

As informações de identificadores do PDS da Intergraph PDS contêm uma ID
única, o ponto de vista salvo e os comentários correspondentes. As informações
de identificadores criados no Autodesk Navisworks também podem ser
exportados para serem utilizados no PDS da Intergraph. Consulte Arquivos
PDS Tag na página 535.

Para importar um arquivo de identificador PDS

1 Clique no botão do aplicativo  ➤ Import ➤ PDS Tags  .

2 Use a caixa de diálogo Import para localizar o arquivo TAG desejado.

3 Clique em Open para importar os dados PDS.

Arquivos de pontos de vista

Os pontos de visão pode ser importados para o Autodesk Navisworks através
de um arquivo XML, permitindo trazer pontos de visão à cena atual
provenientes de outro arquivo modelo. Por exemplo, se você estiver
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trabalhando em diferentes verões do mesmo modelo, poderá salvar pontos de
vista em uma versão do arquivo, exportá-lo, e a seguir importá-lo na outra
versão. Consulte Save Viewpoints na página 478 para mais informações sobre
salvar pontos de visão, e Export Viewpoints Files na página 533 para mais
informações sobre a exportação dos pontos de visão a um arquivo XML.

Para importar pontos de vista e dados associados

1 Clique no botão do aplicativo  ➤ Import ➤ Viewpoints  .

2 Na caixa de diálogo Import, localize o arquivo dos pontos de visão
desejado.

3 Clique em Open.

Arquivos de teste de interferência

Os testes de interferência podem ser importados na ferramenta Clash
Detective para definir testes de interferência predefinidos e genéricos. Para
obter mais informações, consulte Importar testes de interferência na página
731.
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Exportar arquivos

Formato DWFx/DWF 3D

É possível exportar o modelo 3D atual como um arquivo DWF ou DWFx.

Os arquivos DWF são altamente compactados e retêm informações detalhadas
de projeto e de escala. Os arquivos DWFx incluem informações adicionais para
exibir dados do projeto no Microsoft XPS Viewer. Como tal, os arquivos DWFx
são maiores do que os arquivos DWF correspondentes.

A exportação de arquivos DWFx/DWF 3D suporta:
■ Toda a geometria

■ Todos os materiais

■ Cores por vértice

■ Propriedades (quando disponível)

OBSERVAÇÃO A exportação de arquivos DWFx/DWF 2D não é suportada no
momento.

Para exportar um arquivo DWFx/DWF 3D

1 Clique na guia Output ➤ painel Export Scene ➤ 3D DWF/DWFx

 .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.

Formato Google Earth KML

Os arquivos Google Earth KML podem ser exportados do Autodesk Navisworks.
O exportador cria um arquivo KML compresso com a extensão .kmz e suporta
a exportação de:
■ Triângulos

■ Linhas

■ Materiais (somente cor e transparência plana)
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■ Pontos de vista ( podem ocorrer ajustes devido as limitações do Google
Earth)

■ Hierarquia do modelo

■ Hiperlinks (no momento somente os URLs funcionam corretamente com
o Google Earth)

Para exportar arquivos Google Earth KML

1 Clique na guia Output ➤ painel Export Scene ➤ Google Earth

KML  .

2 Na caixa de diálogoKML Options selecione a caixa de seleção Export
Model Relative to Terrain Height para colocar o Google Earth
em um modo onde as alturas são medidas a partir da superfície do chão.
Quando esta caixa de seleção está desmarcada, todas as alturas serão
medidas a partir do nível do oceano.
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OBSERVAÇÃO Ao posicionar um modelo relativo ao nível do oceano, a
altura dos pontos de referência do Google Earth também precisam ser
medidos relativas aos ao nível do oceano. Ao posicionar um modelo relativo
ao nível do chão, a altura dos pontos de referência do Google Earth
também precisam ser medidos relativas ao nível do chão.

O Google Earth coloca novos marcadores de lugar em um altitude de
zero, sem relação se é relativa ou absoluta.

3 A lista suspensa Collapse on Export  permite diferentes níveis de partes
retraíveis da hierarquia do modelo no arquivo exportado. Escolha entre:
■ None - assegura que toda a hierarquia seja exportada

■ All Objects - retrai tudo em um nó

■ Files - retrai cada arquivo em um nó

■ Layers - retrai cada camada em um nó

4 Selecione a caixa de seleção Enable na área Limit Number of
Polygons para restringir a quantidade de geometria exportada para o
arquivo de saída. A geometria é selecionada com base na obtenção dos
objetos mais óbvios em preferência ao detalhe fino. Se o arquivo
exportado for muito grande para que o Google Earth exiba, tente ativar
isso e reduzir o número de polígonos. Clicar na guia Home, deslizar a

guia Project, e clicar em Scene Statistics  no Autodesk Navisworks
mostra o número de triângulos e/ou linhas no projeto atual. Ao definir
um limite de polígonos, você está decidindo somente exportar alguns
destes itens.

5 Os valores da posição Origin no primeiro para de pontos de referência
na superfície do Google Earth , e sempre precisam ser definidos. O
ponto de referência do Autodesk Navisworks será sempre posicionado
para sobrepor exatamente o ponto de referência do Google Earth.

Os pontos de referência Second e Third podem ser utilizados, e se
ativados, então a posição e orientação do modelo podem ser definidas
com maior precisão.

6 Utilize os botões Import para ler localizações de marcas de lugar salvas
de arquivos KML exportados do Google Earth.

O botão Origin Import difere um pouco dos outros dois; se o arquivo
KML contém múltiplos marcadores de lugar, este botão irá oferecer ao
usuário de escolha de importar o segundo e terceiro ponto de referência,
se disponível. Os outros dois botões somente irão importar um ponto
de referência único.
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7 Os botões Pick permitem que as localizações de pontos de referência
sejam selecionadas na Scene View.

Estes pontos precisam estar visíveis na Scene View antes de serem
exportados, já quando a caixa de diálogo KML Options for aberta, não
será possível navegar antes de selecionar.

DICA É possível clicar na guia View ➤ painel Scene View ➤ menu

suspenso Split View e selecionar Split Vertical  ou Split Horizontal

 para dividir a Scene View em vistas separadas de cada ponto de
referência.

8 Clique em OK.

9 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

10 Clique em Save.

Formato FBX da Autodesk

Os arquivos FBX podem ser exportados do Autodesk Navisworks. O exportador
cria um arquivo FBX com a extensão .fbx e suporta a exportação de:
■ Triângulos

■ Linhas

■ Materiais (somente cor, transparência plana e textura da imagem virada)

■ Pontos de vista

■ Luzes

■ Hierarquia do modelo

OBSERVAÇÃO O FBX não suporta a geometria de nuvem de ponto.

Para exportar um arquivo FBX

1 No aplicativo Autodesk Navisworks, clique na guia Output ➤ painel

Export Scene ➤ FBX  .

2 Na caixa de seleção Opções do FBX , selecione a caixa de seleção Ativar
na área Limitação de polígono , para restringir a geometria exportada
para o arquivo de saída.
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A geometria é selecionada com base na obtenção dos objetos mais óbvios
em preferência ao detalhe fino. Se o arquivo exportado for muito grande,
tente ativar este recurso e reduzir o número de polígonos. Clicar na guia

Home, deslizar o painel Project e clicar em Scene Statistics  no
Autodesk Navisworks mostra o número de triângulos e linhas no projeto
atual. Ao definir um limite de polígonos, você está decidindo somente
exportar alguns destes itens.

3 Selecione as opções desejadas na área Include .
■ Textures.Selecione esta caixa de seleção para incluir as texturas no

arquivo FBX.

■ Lights.Selecione esta caixa de seleção para incluir as luzes no arquivo
FBX.

■ Cameras.Selecione esta caixa de seleção para incluir câmeras no
arquivo FBX.

4 Selecione as Advanced Options desejadas para o arquivo FBX.
■ Convert Units To. Especifica as unidades que são usadas no arquivo

FBX exportado.

■ FBX File Format Ajusta o formato do arquivo FBX exportado (por
exemplo, ASCII).

■ FBX File Version. Seleciona a versão do arquivo FBX exportado
(por exemplo, FBX201100).
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5 Clique em OK.

6 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

7 Clique em Save.

Exportar imagens e anotações

Exportar uma imagem

Para exportar uma imagem como um arquivo bitmap, PNG, ou JPEG

1 Exiba a vista que deseja exportar na Scene View e clique na guia

Output ➤ painel Visuals ➤ Image  .

2 Na caixa de diálogo Image Export selecione o Format da imagem que
deseja exportar.

3 Utilize a área Size e Options para definir o tamanho da imagem.
Consulte Caixa de diálogo Image Export  na página 805.

Para arquivos PNG, clique no botão Options e use a caixa de diálogo
PNG Options para especificar as configurações deInterlacing e de
Compression.
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Para arquivos JPEG, clique no botão Options e use a caixa de diálogo
JPEG Options para especificar as configurações de Compression e de
Smoothing.

4 Clique em OK.

5 Na caixa de diálogo Save As , insira um novo nome de arquivo e
localização, se deseja alterar dos sugeridos.

6 Clique em Save.

Exportar uma imagem renderizada

As cenas renderizadas no Presenter podem ser exportadas como imagens,
portanto, podem ser utilizadas em apresentações, websites, impressas, e assim
por diante. Para obter mais informações, consulte Renderização fotorrealista
da cena na página 591.

OBSERVAÇÃO Esta opção somente está disponível para os modelos 3D.
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Exportar uma animação

Para exportar uma animação para um arquivo AVI, ou uma sequência de
arquivos de imagens

1 Clique na guia Output painel  ➤ Visuals ➤ Animation  .

A caixa de diálogo Animation Export é aberta.

2 Para exportar a animação do ponto de vista no momento selecionada,
selecione Current Animation na caixa Source.

Para exportar a animação do objeto no momento selecionada, selecione
Current Animator Scene na caixa Source.

Para exportar uma sequência do TimeLiner , selecione TimeLiner
Simulation na caixa Source.

3 Defina o resto das caixas na caixa de diálogo Animation Export, e
clique em OK. Para obter mais informações, consulte Caixa de diálogo
Animation Export na página 781.

4 Na caixa de diálogo Save As , insira um novo nome de arquivo e
localização, se deseja alterar dos sugeridos.

5 Clique em Save.
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Formato Piranesi EPix

Esta opção somente está disponível para os modelos 3D.

Para exportar um arquivo EPX para renderização em Informatix’s Piranesi

1 Clique na guia Output ➤ painel Visuals ➤ Piranesi EPix  .

2 Na caixa de diálogo Piranesi EPix clique no botão Browse , para
localizar um destino, e insira um novo nome de arquivo para exportação,
caso deseje alterar do nome de arquivo e localização existente.

3 Selecione as opções de dimensionamento para o arquivo a ser exportado:
■ Type - definir o tamanho da imagem exportada, como segue:

Explicit. Fornece o controle completo sobre a largura e altura (as
dimensões são em pixels).

Use Aspect Ratio. Permite especificar a altura. A largura é
automaticamente calculada a partir da relação de aspecto de sua vista
atual.

Use View. Utiliza a largura e altura de sua vista atual.

■ Width - permite inserir a largura em pixels, quando disponível.

■ Height - permite inserir a altura em pixels, quando disponível.

4 Selecione o valor desejado na caixa Anti-Aliasing. Esta opção somente
se aplica para a renderização OpenGL. A suavização de serrilhado é
utilizada para suavizar as arestas das imagens exportadas. Quando maior
o número, mais suave a imagem, mas leva mais tempo para ser exportada.
4x é adequado para a maioria das situações.

5 Clique em Save.

Critério de pesquisa atual

O critério de pesquisa especificado na janela Find Items pode ser exportado
a um arquivo XML. Isso pode então ser importado para outras sessões do
Autodesk Navisworks. Por exemplo, se você especificou um critério de pesquisa
complicados, contendo diversas declarações lógicas, que se referem a todos os
projetos em que trabalha, então este recursos permite especificar tudo de um
só vez e utilizá-los em todos os projetos.

Para obter mais informações, consulte Janela Find Items na página 374.
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Para exportar o critério de pesquisa atual

1 Clique na guia Output ➤ painel Export Data ➤ Current Search

 .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.

Arquivos de conjunto de pesquisa

Conjuntos de pesquisa salvos podem ser exportados do Autodesk Navisworks
como um arquivo XML. Eles podem ser importados em outras sessões do
Autodesk Navisworks e reutilizados. Por exemplo, se você tem diversas
pesquisas genéricas que executa em todos seus projetos, este recurso permite
especificar as pesquisas de um só vez e utilizá-las em todos os projetos.

Para obter mais informações, consulte, Criar e gerenciar conjuntos de seleção
e de pesquisa na página 388.

Para exportar conjuntos de pesquisa

1 Clique na guia Output painel  ➤ Export Data ➤ Search Sets  .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.

Arquivos de pontos de vista

Os pontos de vista podem ser exportados do Autodesk Navisworks para um
arquivo XML.

Estes pontos de vista contêm todos os dados associados, incluindo as posições
da câmera, cortes, itens ocultos e sobreposições de material, linhas de marcação,
comentários, identificadores e configurações de detecção de colisão.

Após os dados do ponto de vista terem sido exportados para este formato de
arquivo com base em texto, eles podem ser importados para outras sessões do
Autodesk Navisworks, ou podem ser acessados e utilizados em outros
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aplicativos. Por exemplo, você pode desejar definir os mesmos pontos de vista
em seu aplicativo de CAD.

Para exportar pontos de vista

1 Clique na guia Output ➤ painel Export Data ➤ Viewpoints  .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.

Relatório de pontos de vista

Um arquivo HTML pode ser exportado contendo um JPEG de todos os pontos
de visão salvos e dados associados, incluindo posição da câmera e comentários.

OBSERVAÇÃO Para personalizar a aparência ou o layout do arquivo HTML, será
necessário editar o arquivo viewpoints_report.xsl. O arquivo instalado está
localizado no subdiretório de folhas de estilo do diretório de instalação do Autodesk
Navisworks. Você pode copiar o arquivo editado no subdiretório de folhas de estilo
de qualquer diretório de pesquisa do Autodesk Navisworks. Para obter mais
informações, consulte Pesquisar diretórios na página 171.

Para exportar relatórios de pontos de vista

1 Clique na guia Output painel  ➤ Export Data ➤ Viewpoints Report

 .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.

TimeLiner CSV

Você pode exportar dados CSV do TimeLiner. Os dados são exportados na
ordem padrão, sem considerar a ordem ou a seleção de colunas do TimeLiner.
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OBSERVAÇÃO Ao exportar um CSV do TimeLiner, a hierarquia das tarefas não
é representada. Todas as tarefas disponíveis são exportadas sem nenhuma estrutura
hierárquica. Isso significa que a retração;expansão dos nós das tarefas na grade
do TimeLiner não afeta se as tarefas são ou não exportadas para o CSV.

Para exportar dados CSV do TimeLiner

1 Clique na guia Output ➤ painel Export Data ➤ TimeLiner CSV

 .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.

OBSERVAÇÃO Os arquivos CSV exportados sempre têm cabeçalhos na linha 1,
que contém os nomes das colunas do TimeLiner.

Arquivos de teste de interferência

Os testes de interferência podem ser exportados da ferramenta Clash
Detective para utilização por outros usuários do Autodesk Navisworks. Para
obter mais informações, consulte Exportar testes de interferência na página
732.

Arquivos PDS Tag

Para exportar identificadores PDS

1 Clique na guia Output ➤ painel Export Data ➤ PDS Tags  .

2 Na caixa de diálogo Export insira um novo nome de arquivo e
localização, caso deseje alterar dos sugeridos.

3 Clique em Save.
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Animar objetos

No Autodesk Navisworks Manage 2012 criar um modelo animado e interagir com
ele. Por exemplo, você pode efetuar a animação da movimentação do guindaste em
torno de um terreno, ou como um carro é montado ou desmontado, e assim por
diante. Com alguns poucos cliques do mouse, também é possível criar scripts de
interação, que vinculam as suas animações com eventos específicos, como "Ao
pressionar tecla" ou "Na colisão". Portanto, por exemplo, uma esteira rolante irá
mover-se quando você pressiona um botão em seu teclado, as portas serão abertas
ao aproximar-se das mesmas em seu modelo.

Escopo

O Autodesk Navisworks Manage 2012 suporta a animação e a interação de objetos, da seguinte
maneira:

■ Animação especificada por quadros-chave com interpolação linear entre quadros-chave
(similar a animação de pontos de vista).

■ Câmera, plano de corte, animação do objeto.

■ Múltiplos objetos movendo-se independentemente e independentemente iniciados.

■ Múltiplas animações do mesmo objeto na mesma cena (por exemplo, movendo um
guindaste e a seguir elevando seu braço).

■ Scripts simples (por exemplo, para abrir e fechar uma porta especificada).

■ Vincular ao TimeLiner desencadeia animações independentes como um início de tarefa.

■ Vincular ao TimeLiner com diferentes tarefas TimeLiner executa pontos específicos
em uma animação (por exemplo, ter uma animação que mova um guindaste entre todos
os pontos num site, qualquer tarefa pode desencadear um movimento da animação do
ponto atual para o ponto desejado).

■ Vincular ao Clash Detective para executar testes de interferência em intervalos específicos
através de uma animação, para verificar interferências de objetos animados contra animados
ou animados contra estáticos.
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Os seguintes recursos não são suportados pelo Autodesk Navisworks Manage 2012 no
momento:

■ Animação especificada por qualquer outra coisa que não seja um objeto, por exemplo,
spline ou caminho.

■ Animação de luzes.

■ Mover todo um objeto e em seguida criar um acionador independente para mover parte
do objeto (por exemplo, mover todo o guindaste e ter um botão que aciona o movimento
do braço em qualquer ponto).

■ Abertura/fechamento de múltiplas portas sem ter que criar um script separado e uma
animação para cada porta. No momento não há recursos para copiar e colar no script.

■ Vincular ao TimeLiner para ter tarefas diferentes do TimeLiner desencadeia animações
dependentes umas das outras (por exemplo, uma tarefa que mova o guindaste a um
ponto específico, outra tarefa que mova o braço do guindaste).

■ A verificação da colisão em tempo real quando você a ativa, reproduz uma animação e
para a animação quando ao mover o objeto este bate em algo.

Visão geral da ferramenta Animator
As janelas Animator e Scripter são duas janelas encaixáveis, que são
utilizadas para criar e editar a animação do objeto no Autodesk Navisworks
Manage 2012.

Janela Animator

Utilize a janela Animator para criar objetos animados em seu modelo.

Faixa de opções:  Guia Animation ➤  painel Create ➤ Animator
Menu: Classic user interface: Tools  ➤  Animator
Barra de ferramentas: Classic user interface: Workspace  ➤  Animator

A barra de ferramentas Animator

A barra de ferramentas Animator está localizada no topo da janela Animator.
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Utilize esta barra de ferramentas para criar, editar e executar animações.

FinalidadeControle

Coloca o Animator no modo de tradução.
A meta-alça Translation é exibida na
Scene View, e permite modificar a posição
dos objetos de geometria. Este modo
permanece ativo até você selecionar um
modo diferente de manipulação de objeto
na barra de ferramentas.

Coloca o Animator no modo de rotação.
A meta-alça Rotation é exibida na Scene
View, e permite modificar a rotação dos
objetos de geometria. Este modo
permanece ativo até você selecionar um
modo diferente de manipulação de objeto
na barra de ferramentas.

Coloca o Animator no modo de escala. A
meta-alça Scaling é exibida na Scene
View, e permite modificar o tamanho dos
objetos de geometria. Este modo
permanece ativo até você selecionar um
modo diferente de manipulação de objeto
na barra de ferramentas.

Coloca o Animator no modo de cor. Uma
paleta de cor é exibida na barra Manual
Entry, e permite modificar a cor dos
objetos de geometria.

Coloca o Animator no modo de
transparência. Um deslizador de
transparência é exibido na barra Manual
Entry, e permite modificar a transparência
dos objetos de geometria.
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FinalidadeControle

Cria um instantâneo da alteração atual do
modelo como um novo quadro-chave em
uma vista de linha de tempo.

Ativa/desativa o snap. O snap somente tem
efeito ao mover objetos arrastando as meta-
alças na Scene View, e não tem efeito em
entradas numéricas ou controle do teclado.

Seleciona a vista ativa.

Controla a posição atual do deslizador de
tempo na vista de linha de tempo.

Rebobina a animação de volta ao início.

Rebobina um segundo.

Reproduz a animação detrás para frente do
ponto final para o inicial e a seguir pára.
Isto não afeta a direção da face de
elementos com animação.

Pausa a animação. Para continuar
reproduzindo, clique em Play novamente.

Para e rebobina a animação para o início.

Reproduz a animação adiante do ponto
inicial para o final.

Reproduz a animação adiante um segundo.

Avança rápido a animação para o fim.
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Consulte também:

Meta-alça na página 172

A visualização em árvore do Animator

A visualização em árvore Animator lista todas as cenas e componentes de
cena em uma visualização de lista hierárquica.

Utilize-a para criar e gerenciar cenas com animação.

Lista hierárquica

É possível usar a visualização em árvore Animator para criar e gerenciar suas
cenas de animação. As árvores da cena exibem os componentes da cena, como
conjuntos de animações, câmera e planos de corte em uma estrutura
hierárquica.

Para trabalhar em um item na visualização em árvore, primeiro é preciso
selecioná-lo.

Selecionar um componente de cena na visualização em árvore seleciona todos
os elementos contidos naquele componente na Scene View. Por exemplo, a
seleção de um conjunto de animação em uma visualização em árvore,
automaticamente seleciona todos os objetos de geometria contidos naquele
conjunto de animação.

Você pode copiar e mover rapidamente os itens na visualização em árvore ao
arrastá-los. Para fazer isso, clique no item que deseja copiar ou mover,
mantenha pressionado o botão direito do mouse, e arraste o item para a
localização desejada. Quando o ponteiro do mouse muda para uma seta, libere
o botão direito para exibir um menu de atalho. Clique em Copy Here ou
Move Here, como apropriado.

Menu de atalho

É possível exibir um menu de atalho para qualquer item na árvore ao clicar
com o botão direito nele. Os seguintes comandos estão disponíveis no menu
de atalho sempre que forem aplicáveis.

FinalidadeComando

Adiciona uma nova cena na visualização em
árvore.

Add Scene
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FinalidadeComando

Adiciona uma nova câmera na visualização
em árvore

Add Camera

Adiciona um conjunto de animações na
visualização em árvore.

Add Animation Set

Atualiza o conjunto de animações
selecionado.

Update Animation Set

Adiciona um novo plano de corte na
visualização em árvore.

Add Section Plane

Adiciona uma pasta na visualização em
árvore As pastas podem armazenar
componentes da cena e outras pastas.

Add Folder

Adiciona uma pasta de cena na visualização
em árvore Pasta de cenas pode armazenar

Add Scene Folder

cenas e outras pastas de cenas. Quando
você adiciona uma pasta de cena e o faz ao
ter uma pasta de cena vazia selecionada, o
Autodesk Navisworks cria a nova pasta de
cena bem no topo da árvore, caso contrário
ele a cria abaixo da seleção atual.

Ativa ou desativa um componente de cena.Active

Seleciona o modo de ciclo para cenas e
animações de cena. A animação é

Loop

reproduzida adiante até o fim e a seguir
reinicia no início, reproduzindo
indefinidamente.

Seleciona o modo ping-pong para cenas e
animações de cena. A animação é

Ping-Pong

reproduzida adiante até o fim. e a seguir
reproduz de trás para a frente até o início.
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FinalidadeComando

A não ser que o modo de ciclo também
esteja selecionado, isso somente acontece
uma vez.

Seleciona o modo infinito; somente se
aplica às cenas e fará com que a cena seja

Infinite

reproduzida infinitamente (ou seja, até que

o botão Stop  seja pressionado).

Corta o item selecionado na árvore para a
área de transferência.

Cut

Copia o item selecionado na árvore para a
área de transferência.

Copy

Cola o item da área de transferência em
uma nova localização.

Paste

Exclui o item selecionado da árvore.Delete

Ícones

FinalidadeÍcone

Abre um menu de atalho que permite
adicionar novos itens na visualização em
árvore, como Add Scene, Add Camera,
e assim por diante.

Exclui o item no momento selecionado da
visualização em árvore.

OBSERVAÇÃO Se você excluir
acidentalmente um item, clique em
Undo  na barra de ferramentas
Acesso rápido para restaurá-lo.
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FinalidadeÍcone

Move a cena atualmente selecionada para
cima na visualização em árvore.

Move a cena atualmente selecionada para
baixo na visualização em árvore.

Amplia o zoom na barra de escala de
tempo. O valor atual é exibido na caixa
Zoom à direita.

Diminui o zoom na barra de escala de
tempo. O valor atual é exibido na caixa
Zoom à direita.

Caixas de seleção

Utilize as caixas de seleção na vista da cena para controlar se o item
correspondente está ativo, se efetua o ciclo, ping-pong e se deve ser
infinitamente executado.

Active Esta caixa de seleção somente está disponível para animações de cena.
Selecione esta caixa de seleção para tornar a animação ativa na cena. Somente
animações ativas serão reproduzidas.

OBSERVAÇÃO Para tornar uma cena ativa, é preciso selecioná-la no Scene Picker
na barra de ferramentas Animator.

Loop Esta caixa de seleção está ativa para cenas e animações de cena. Permite
controlar o modo de reprodução. Selecione esta caixa de seleção para usar o
modo de loop. Quando a animação chegar ao fim, ela será reinicializada para
o início e começará a ser novamente reproduzida.

P.P. Esta caixa de seleção está ativa para cenas e animações de cena. Permite
controlar o modo de reprodução. Selecione esta caixa de seleção para usar o
modo de ping-pong. Quando a animação chegar ao fim, ela será reproduzida
no sentido inverso até alcançar o início. A não ser que o modo de ciclo também
esteja selecionado, isso somente acontece uma vez.

Infinite Esta caixa de seleção somente está disponível para cenas. Selecione
esta caixa de seleção para reproduzir a cena indefinidamente (ou seja, até que
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o botão Stop  seja pressionado). Se esta caixa de seleção estiver desmarcada,
a cena será reproduzida até que seu ponto final seja alcançado.

OBSERVAÇÃO Quando uma cena é definida para Infinite, ele não pode ser
atribuída para os modos de loop ou ping-pong; portanto, se você marcar esta
caixa de seleção, as caixas de seleção Loop e P.P. não estarão disponível para a
sua cena.

Vista em linha do tempo do Animator

A vista em linha do tempo mostra as linhas de tempo e quadros-chave para
conjuntos de animações, câmeras e planos de corte em suas cenas.

Utilize-a para visualizar e editar as animações.

Barra Timescale

No topo da vista de linha de tempo há uma barra de escala de tempo em
segundos. Todas as linhas de tempo começam em 0. Clicar com o botão direito
do mouse na escala de tempo abre um menu de atalho.

Use os ícones  e  na parte inferior da visualização em árvore Animator
para ampliar ou reduzir o zoom na barra de escala de tempo.

A escala de tempo padrão mostra cerca de 10 segundos da animação em uma
resolução de tela padrão, e aproximando e afastando o zoom tem um efeito
de dobrar ou dividir por dois a área visível. Portanto, por exemplo, aproximar
o zoom mostra cerca de 5 segundos da animação e afastar o zoom mostra de
20 segundos.

DICA Você também pode aproximar e afastar o zoom com a roda do mouse ao
passar o cursor sobre a linha de tempo.

Outra forma de alterar a escala de tempo é a de utilizar a caixa Zoom. Por
exemplo, digite "1/4", e pressione Enter para dividir por quatro a área visível.
O valor aqui inserido é dividido por dois quando você aproxima o zoom e
dobrado quando afasta o zoom. Você pode retornar para a escala de tempo
padrão ao excluir o valor na caixa Zoom, e pressionando Enter.

Quadros-chave

Os quadros-chave são mostrados como diamantes pretos em linhas de tempo.
Você pode alterar o tempo em que um quadro-chave ocorre ao arrastar o
diamante preto para a esquerda ou direita na visualização de linha de tempo.
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Quando você arrasta um quadro-chave, ele muda da cor preta para um cinza
claro.

Clicar com o botão esquerdo do mouse em um quadro-chave move o deslizador
de tempo para aquela posição. Clicar com o botão direito do mouse em um
quadro-chave abre um menu de atalho.

Barras de animação

As barras de animação coloridas são utilizadas para visualizar os quadros-chave
em uma linha de tempo e não podem ser editadas. Cada tipo de animação é
mostrada com uma cor diferente e as barras de animação para cenas têm a cor
cinza. Normalmente, a barra de animação termina com o último quadro-chave.
Se uma barra de animação tem uma cor esmaecida após o último quadro-chave,
isto indica que a animação será reproduzida infinitamente (por exemplo,
animação em ciclo).

Deslizadores

É possível utilizar dois deslizadores na visualização de linha de tempo:
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Time Slider A linha vertical preta é o deslizador de tempo, representando a
posição atual da reprodução. Isto pode ser ajustado usando os controles VCR
na barra de ferramentas Animator, ao arrastar o deslizador de tempo para a
esquerda ou direita na visualização de linha de tempo, ou ao selecionar o
deslizador de tempo na visualização de linha de tempo e usando as teclas de
seta para esquerda e direita. Conforme o deslizador de tempo é movido, o
modelo na Scene View é atualizado para refletir os movimentos causados
pelos quadros-chave na cena atual como se a animação estivesse sendo
reproduzida.

End Slider A linha vertical vermelha é o deslizador final, representando o
ponto final da cena ativa atual. Ela é oculta se você selecionou a caixa de
seleção Infinite para a cena atual na visualização em árvore. Por padrão, o
deslizador final é definido para o último quadro-chave na cena e não pode ser
movido. Você pode ativar o controle manual no deslizador final em uma cena
ao clicar com o botão direito do mouse nele, e selecionando a opção Manually
Position Endbar no menu de atalho. Em seguida, ajuste manualmente o
deslizador final, ao arrastá-lo para a esquerda ou direita. Este marcador final
será utilizado como o ponto final da animação quando as cenas são definidas
com o modo de ciclo ou ping-pong.

Menu de atalho

Clicar com o botão direito do mouse na escala de tempo abre um menu de
atalho que permite ajustar os deslizadores.

■ Move Time Here - move o deslizador de tempo para a posição atual do
cursor do mouse.

■ Move Scene End Here - move o deslizador final para a posição atual do
cursor do mouse.

OBSERVAÇÃO Esta opção não está disponível até você selecionar a opção
Manually Position Endbar.

■ Reset Endbar to the Scene End - move o deslizador final para sua
posição original.

■ Manually Position Endbar - ativa o controle manual do deslizador
final em uma cena.

Clicar com o botão direito do mouse em um quadro-chave abre um menu de
atalho com as seguintes opções:

■ Edit - permite editar o quadro-chave selecionado.
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■ Go to Keyframe - move o deslizador preto de tempo para este
quadro-chave.

■ Cut, Copy, Paste - comandos padrão de cortar, copiar e colar. Eles somente
funcionam dentro da linha de tempo selecionada.

■ Delete - exclui o quadro-chave selecionado.

■ Interpolate - determina se o Autodesk Navisworks é interpolado
automaticamente entre o quadro-chave atual e o último quasdro-chave.
Esta é a opção padrão. Quando desativada, não haverá uma transição
gradual entre os dois quadros-chave. Ao invés disso, a animação irá
instantaneamente pular para a posição/visualização do segundo
quadro-chave quando for alcançado. Também, não haverá uma barra de
animação colorida entre os quadros-chave.

OBSERVAÇÃO Se você clica com o botão direito em uma área na barra de
animação sem um quadro-chave nela, o menu de atalho irá conter somente a
opção Paste. Para usá-la, é preciso ter os dados do quadro-chave na área de
transferência.

Consulte também:

Trabalhar com quadros-chave na página 575

A barra Manual Entry

A barra opcional Manual Entry está localizada na parte inferior da janela
Animator, e permite manipular objetos de geometria ao digitar valores
numéricos, ao invés de usar meta-alças na Scene View.

O conteúdo da barra Manual Entry muda dependendo do botão selecionado
por último na barra de ferramentas Animator.

Você pode ativar ou desativar a barra de ferramentas Manual Entry ao usar
o Options Editor na página 878.

Translate

X, Y, Z Insira os valores de coordenada X, Y, e Z para posicionar os objetos
selecionados.
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Rotate

X, Y, Z Insira os graus de rotação ao redor dos eixos X, Y e Z para mover os
objetos selecionados na posição.

cX, cY, cZ Insira os valores das coordenadas X, Y e Z para mover a origem (ou
o ponto central) da rotação à esta posição.

oX, oY, oZ Insira os graus de rotação ao redor dos eixos X, Y e Z para modificar
a orientação da rotação.

OBSERVAÇÃO 0,0,0 representa universo acima.

Scale

X, Y, Z Insira o fator de escala em torno dos eixos X, Y, Z para a geometria; 1
sendo o tamanho atual, 0.5 metade, 2 o dobro, e assim por diante.

cX, cY, cZ Insira os valores das coordenadas X, Y e Z para mover a origem (ou
o ponto central) da escala à esta posição.

Color

Color Esta caixa de seleção indica se clicar ou não em Capture Keyframe

 irá gravar a alteração de cor no quadro-chave.

Desmarcar esta caixa de seleção redefine a cor de volta para seu estado original.

Por padrão, o Autodesk Navisworks desmarca esta caixa de seleção cada vez
que você cria um conjunto de animações. Em um e no mesmo conjunto de
animações, quando esta caixa de seleção é selecionada, ela permanece
selecionada, até que você a desmarque manualmente.

R, G, B Insira os valores Red, Green e Blue para a nova cor.

Se não deseja inserir os valores Red, Green e Blue manualmente, clique
neste botão, e selecione a cor desejada.

Transparency

Transparency Esta caixa de seleção indica se clicar ou não em Capture

Keyframe  irá registrar a alteração de transparência no quadro-chave.

Desmarcar esta caixa de seleção redefine a transparência de volta para seu
estado original.

Por padrão, o Autodesk Navisworks desmarca esta caixa de seleção cada vez
que você cria um conjunto de animações. Em um e no mesmo conjunto de
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animações, quando esta caixa de seleção é selecionada, ela permanece
selecionada, até que você a desmarque manualmente.

% Insira o valor para ajustar o nível de transparência (o a 100%). Um valor
mais alto torna o elemento mais transparente. Um valor mais baixo torna o
elemento mais opaco.

Caso não deseje inserir manualmente os valores de transparência, utilize
este deslizador para ajustar o nível de transparência.

Consulte também:

Meta-alça na página 172

Janela Scripter

Use a janela Scripter para adicionar interatividade aos objetos animados no
seu modelo.

Faixa de opções:  Guia Animation ➤  painel Script ➤ Scripter
Menu: Classic user interface: Tools  ➤  Scripter

Barra de ferramentas: Classic user interface: Workspace  ➤  Scripter 

A visualização em árvore do Scripter

A visualização em árvore do Scripter contém todos os scripts disponíveis no
seu arquivo do Autodesk Navisworks em uma visualização de lista hierárquica.

Utilize-a para criar e gerenciar scripts de animação.

OBSERVAÇÃO Embora seja possível organizar os scripts em pastas, isso não tem
efeito na forma com que os scripts são executados no Autodesk Navisworks.

Lista hierárquica

Você pode usar a visualização em árvore do Scripter para criar e gerenciar
seus scripts.

Para trabalhar em um item na visualização em árvore, primeiro é preciso
selecioná-lo.
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A seleção de um script na visualização em árvore exibe os eventos, ações e
propriedades associados.

Você pode copiar e mover rapidamente os itens na visualização em árvore ao
arrastá-los. Para fazer isso, clique no item que deseja copiar ou mover,
mantenha pressionado o botão direito do mouse, e arraste o item para a
localização desejada. Quando o cursor do mouse mudar para uma seta, libere
o botão direito para exibir um menu de atalho. Clique em Copy Here ou
Move Here, como apropriado.

Menu de atalho

É possível exibir um menu de atalho para qualquer item na árvore ao clicar
com o botão direito nele. Os seguintes comandos estão disponíveis no menu
de atalho sempre que forem aplicáveis.

FinalidadeComando

Adiciona um novo script na visualização em
árvore

Add New Script

Adiciona uma pasta na visualização em
árvore As pastas podem armazenar scripts
e outras pastas.

Add New Folder

Permite renomear o item no momento
selecionado da visualização em árvore.

Rename Item

Exclui o item no momento selecionado da
visualização em árvore.

Delete Item

Seleciona a caixa de seleção Active para o
item no momento selecionado na

Activate

visualização em árvore. Somente scripts
ativos serão executados.

Desmarca a caixa de seleção Active para
o item atualmente selecionado na

Deactivate

visualização em árvore. Somente scripts
ativos serão executados.
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Ícones

FinalidadeÍcone

Adiciona novos scripts na visualização em
árvore

Adiciona novas pastas na visualização em
árvore

Exclui o item no momento selecionado da
visualização em árvore.

OBSERVAÇÃO Se você acidentalmente

excluir um item, clique em Undo  na
barra de ferramentas Acesso rápido para
restaurá-lo.

Caixas de seleção

Active Utilize esta caixa de seleção para especificar quais scripts deseja utilizar.
Somente scripts ativos serão executados.

Se você organizou seus scripts em pastas, poderá rapidamente ativar e desativar
os scripts ao utilizar a caixa de seleção Active junto a pasta de nível superior.

A visualização Events

A visualização Events mostra todos os eventos associados com o script
atualmente selecionado.

Use a visualização Events para definir, gerenciar e testar eventos.

Ícones

FinalidadeÍcone

Adiciona eventos de inicialização.

Adiciona eventos do temporizador.
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FinalidadeÍcone

Adiciona eventos de pressionar uma tecla.

Adiciona eventos de colisão.

Adiciona eventos de ponto principal.

Adiciona eventos variáveis.

Adiciona eventos de animação.

Move o evento atualmente selecionado para
cima na visualização Events.

Move o evento atualmente selecionado para
baixo na visualização Events.

Exclui o evento atualmente selecionado na
visualização Events.

Menu de atalho

Clique com o botão direito na visualização Events para exibir um menu de
atalho. Os seguintes comandos estão disponíveis no menu de atalho sempre
que forem aplicáveis.

FinalidadeComando

Permite selecionar um evento a ser
adicionado.

Add Event

Exclui o evento no momento selecionado.Delete Event

Move acima o evento no momento
selecionado.

Move Up
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FinalidadeComando

Move abaixo o evento no momento
selecionado.

Move Down

Permite selecionar colchetes. Escolha entre
(, ) e None.

Brackets

Permite selecionar operadores lógicos.
Escolha entre AND e OR.

Logic

Testa a validade de sua condição de evento.Test Logic

A visualização Actions

A visualização Actions mostra as ações associadas com o script atualmente
selecionado.

Use a visualização Actions para definir, gerenciar e testar ações.

Ícones

FinalidadeÍcone

Adiciona ações de reprodução de animação.

Adiciona ações para parar animações.

Adiciona ações de ponto de vista.

Adiciona ações de pausa.

Adiciona ações de envio de mensagem.

Adiciona ações para definir variável.
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FinalidadeÍcone

Adiciona ações para armazenar propriedade.

Adiciona ações de carga de modelo.

Move a ação atualmente selecionada para
cima na visualização Actions.

Move a ação no momento selecionada para
baixo na visualização Actions.

Exclui a ação no momento selecionada.

Menu de atalho

Clique com o botão direito na visualização Actions para exibir um menu de
atalho. Os seguintes comandos estão disponíveis no menu de atalho sempre
que forem aplicáveis.

FinalidadeComando

Permite selecionar uma ação a ser
adicionada.

Add Action

Exclui a ação no momento selecionada.Delete Action

Executa a ação no momento selecionada.Test Action

Interrompe a execução da ação atualmente
selecionada (quando você testa a ação).

Stop Action

Move a ação atualmente selecionada para
cima na visualização Actions.

Move Up

Move a ação no momento selecionada para
baixo na visualização Actions.

Move Down
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A visualização Properties

A visualização Properties mostra as propriedades para o evento ou ação
atualmente selecionados.

Use a visualização Properties para configurar o comportamento dos eventos
e ações em seus scripts.

Propriedades de eventos

No momento há sete tipos de eventos no Autodesk Navisworks. Quando o
evento é adicionado, a visualização Properties exibe as propriedades para
aquele tipo de evento. As propriedades do evento podem ser configuradas
imediatamente, ou em outro momento.

On Start

Não é necessário configurar quaisquer propriedades para este tipo de evento.

On Timer

Interval (Seconds) Define a duração de tempo em segundos entre o
acionamento do temporizador.

Regularity Especifica a frequência do evento. Escolha entre:
■ Once After - um evento somente acontece uma vez. Utilize esta opção

para criar um vento que começa após uma determinada duração de tempo.

■ Continuous - um evento é continuamente repetido em intervalos
específicos de tempo. Por exemplo, isso pode ser utilizado para simular
trabalho cíclico de um máquina de uma fábrica.

On Key Press

Key Clique nesta caixa e pressione a tecla no teclado para vincular ao seu
evento.

Trigger On Define como o evento é acionado. Escolha entre:
■ Key Up - um evento é acionado após você pressionar e liberar a tecla.

■ Key Down - um evento é acionado assim que você pressiona a tecla.

■ Key Pressed - um evento é acionado enquanto a tecla é pressionada. Esta
opção permite utilizar um evento de pressionar uma tecla junto com
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operadores Booleanos. Por exemplo, você pode AND este evento com um
evento do temporizador.

On Collision

Selection to Collide With Clique no botão Set e utilize o menu de atalho
para definir os objetos de colisão:
■ Clear - desmarca seus objetos de colisão no momento selecionados.

■ Set From Current Selection - define os objetos de colisão para a sua
seleção de objetos atual na Scene View.

OBSERVAÇÃO Esta opção não está disponível até que faça uma seleção na
Scene View.

■ Set From Current Selection Set - define os objetos de colisão para o
seu conjunto de pesquisa ou conjunto de seleção atuais.

Show Esta é uma caixa de somente leitura, mostrando o número de objetos
de geometria selecionados como objetos de colisão.

Include the Effects of Gravity Selecione esta caixa de seleção se deseja incluir
gravidade na colisão. Se esta opção é utilizada, por exemplo, ao bater no chão
ao andar nele, irá acionar seu evento.

On Hotspot

Hotspot Define o tipo de ponto principal. Escolha entre:
■ Sphere - uma simples esfera para um determinado ponto no espaço.

■ Sphere on Selection - uma esfera ao redor de uma seleção. Esta opção
não requer a definição do determinado ponto no espaço. Este ponto
principal irá mover quando o objeto selecionado move no modelo.

Trigger When Define como o evento é acionado. Escolha entre:
■ Entering - um evento é acionado quando você entra no ponto principal.

Por exemplo, isso é útil para abrir portas.

■ Leaving - um evento é acionado quando você deixa o ponto principal.
Por exemplo, isso é útil para fechar portas.

■ In Range - um evento é acionado quando você está dentro do ponto
principal. Esta opção permite utilizar um evento de ponto principal junto
com operadores Booleanos. Por exemplo, você pode AND este evento com
um evento do temporizador.

Visão geral da ferramenta Animator | 557



Hotspot Type
Position A posição do ponto de ponto principal. Se o ponto principal escolhido
for Sphere on Selection, esta propriedade não estará disponível.

Pick Permite selecionar a posição do ponto de ponto principal. Se o ponto
principal escolhido for Sphere on Selection, este botão não está disponível.
Clique no botão Pick, e em seguida, clique em um ponto para o ponto
principal na Scene View.

Seleção Clique no botão Set , e utilize o menu de atalho para definir os objetos
de ponto principal:

OBSERVAÇÃO Se o ponto principal escolhido for Sphere, este botão não está
disponível.

■ Clear - desmarca a seleção atual.

■ Set From Current Selection - o ponto principal é definido para a sua
seleção de objeto atual na Scene View.

OBSERVAÇÃO Esta opção não está disponível até que faça uma seleção na
Scene View.

■ Set From Current Selection Set - o ponto principal é definido para seu
conjunto atual de pesquisa ou de seleção.

Show Esta é uma caixa de somente leitura, que exibe o número de objetos de
geometria vinculados ao ponto principal. Se o ponto principal escolhido for
Sphere, esta propriedade não estará disponível.

Radius (m) Raio do ponto principal.

On Variable

Variable O nome alfanumérico da variável a ser avaliada.

Value Um operador a ser utilizado. Insira um valor para ser testado contra sua
variável. Alternativamente, insira o nome de outra variável. Este valore será
testado contra o valor em sua variável.

As seguintes regras se aplicam:

■ Se você insere um número (por exemplo 0, 400, 5.3), o valor é tratado
como uma valor numérico. Se ele possuir uma casa decimal, a formatação
do ponto flutuante é preservada para as casa decimais definidas pelo
usuário.

■ Se você insere uma seqüência alfanumérica entre aspas simples ou dupla,
como 'testing' ou "hello", o valor é tratado como uma seqüência.
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■ Se você insere uma seqüência alfanumérica sem aspas simples ou dupla,
como counter1 ou testing, o valor é tratado como outra variável. Caso esta
variável nunca tenha sido utilizada, um valor numérico de 0 é atribuído à
mesma.

■ Se você inserir as palavras true ou false sem aspas, o valor é tratado como
Booleano (true = 1, false = 0).

Evaluation Operadores utilizados para a comparação de variáveis. É possível
usar qualquer um dos operadores a seguir com números e valores booleanos.
No entanto, as seqüências de comparação são limitadas somente aos operadores
"Equal To" e "Not Equal To".
■ Equal To

■ Not Equal To

■ Greater Than

■ Less Than

■ Greater Than or Equal To

■ Less Than or Equal To

On Animation

Animation Seleciona a animação que aciona o evento. Se você não tiver
nenhuma animação de objeto no seu arquivo do Autodesk Navisworks, esta
propriedade ficará indisponível.

Trigger On Define como o evento é acionado. Escolha entre:
■ Starting - um evento é acionado quando a animação começa.

■ Ending - um evento é acionado quando a animação termina. Isso é útil
para fechar encadear animações.

Consulte também:

Tipos de eventos na página 581

Propriedades de ação

No momento há oito tipos de ações no Autodesk Navisworks. Quando a ação
é adicionada, a visualização Properties exibe as propriedades para aquele
tipo de ação. As propriedades da ação pode ser imediatamente configuradas
ou em outro momento.
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Play Animation

Animation Seleciona a animação a ser reproduzida. Se você não tiver nenhuma
animação de objeto no seu arquivo do Autodesk Navisworks, esta propriedade
ficará indisponível.

Pause at End Selecione esta caixa de seleção se deseja que a animação pare
no término. Quando esta caixa de seleção está desmarcada, a animação volta
para o ponto inicial quando termina.

Starting At Define a posição inicial da reprodução da animação. Escolha entre:
■ Start - a animação é reproduzida para frente desde o início.

■ End - a animação é reproduzida de trás para a frente do término.

■ Current Position - a animação é reproduzida de sua posição atual, se a
reprodução já tiver sido iniciada. De outra forma, a animação é reproduzida
desde o início.

■ Specified Time - a animação é reproduzida a partir do segmento definido
na propriedade Specific Start Time (Seconds).

Ending At Define a posição de término da reprodução da animação. Escolha
entre:
■ Start - a reprodução termina no início da animação.

■ End - a reprodução termina no término da animação.

■ Specified Time - a reprodução termina no segmento definido na
propriedade Specific End Time (Seconds).

Specific Start Time (Seconds) A posição inicial de um segmento de
reprodução.

Specific End Time (Seconds) A posição de término de um segmento de
reprodução.

Stop Animation

Animation Seleciona a animação para parar. Se você não tiver nenhuma
animação de objeto no seu arquivo do Autodesk Navisworks, esta propriedade
ficará indisponível.

Reset To Define a posição de reprodução da animação parada. Escolha entre:
■ Default Position - a animação é redefinida para seu ponto inicial.

■ Current Position - a animação permanece na posição em que foi parada.
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Show Viewpoint

Viewpoint Seleciona o ponto de vista ou uma animação de ponto de vista a
ser mostrada. Se você não tiver nenhum ponto de vista no seu arquivo do
Autodesk Navisworks, esta propriedade ficará indisponível.

Pause

Delay (Seconds) Define o tempo de atraso antes que a próxima ação no script
seja executada.

Send Message

Message Define a mensagem a ser enviada para um arquivo texto definido no
Options Editor.

Você pode efetuar a saída das variáveis do Scripter em sua mensagem. Para
fazer isso utilize o estilo %variable_name%.

Set Variable

Variable Name O nome alfanumérico para a variável.

Value Um operador a ser atribuído. As seguintes regras se aplicam:
■ Se você insere um número (por exemplo 0, 400, 5.3), o valor é tratado

como uma valor numérico. Se ele possuir uma casa decimal, a formatação
do ponto flutuante é preservada para as casa decimais definidas pelo
usuário.

■ Se você insere uma seqüência alfanumérica entre aspas simples ou dupla,
como 'testing' ou "hello", o valor é tratado como uma seqüência.

■ Se você inserir as palavras true ou false sem aspas, o valor é tratado como
Booleano (true = 1, false = 0).

Modifier Operadores de atribuição para sua variável. É possível usar qualquer
um dos operadores a seguir com números e valores booleanos. No entanto, a
utilização de sequência é limitada para o operador Set Equal To somente.
■ Set Equal To

■ Increment By

■ Decrement By
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Store Property

Selection to Get Property From Clique no botão Set , e utilize o menu de
atalho para definir os objetos que são utilizados dos quais obter a propriedade:
■ Clear - desmarca a seleção atual.

■ Set From Current Selection - os objetos são definidos para sua seleção
de objetos atual na Scene View.

OBSERVAÇÃO Esta opção não está disponível até que faça uma seleção na
Scene View.

■ Set From Current Selection Set - os objetos são definido para seu
conjunto atual de pesquisa ou de seleção.

IMPORTANTE Se a sua seleção contém uma hierarquia de objetos, a propriedade
superior do objeto é automaticamente usada. Portanto, por exemplo, se você
selecionou um grupo denominado "Wheel", que inclui dois subgrupos denominados
"Rim" e "Tire", somente as propriedades relativas a "Wheel" podem ser armazenadas.

Variable to Set O nome da variável para receber a propriedade.

Property to Store
Category A categoria da propriedade. Os valores nesta lista suspensa dependem
dos objetos selecionados.

Property O tipo da propriedade. Os valores nesta lista suspensa dependem da
Category da propriedade escolhida.

Load Model

File to Load O caminho para o arquivo do Autodesk Navisworks que será
carregado para substituir o atual.

Você pode considerar isto útil quando apresenta uma seleção de cenas com
animação contida em uma faixa de diferentes arquivos de modelo.

Consulte também:

Tipos de ações na página 583
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Criar animações de objeto
Uma animação é uma sequência preparada de alterações no modelo. As
alterações que você pode efetuar no Autodesk Navisworks Manage 2012, são:
■ Manipular objetos de geometria modificando sua posição, rotação, tamanho

e aparência (cor e transparência). Este tipo de alteração é referida como
um conjunto de animações.

■ Manipular pontos de vista usando diferentes ferramentas de navegação
(como órbita e vôo), ou usando as animações de ponto de vista existentes.
Este tipo de alteração é referida como uma câmera.

■ Manipular cortes transversais do seu modelo ao mover os planos de corte
ou uma caixa de corte. Este tipo de alteração é referida como um conjunto
de planos de corte.

A janela Animator é uma janela flutuante que permite adicionar animações
no seu modelo.

Faixa de opções:  Guia Animation ➤  painel Create ➤ Animator
Menu: Classic user interface: Tools  ➤  Animator
Barra de ferramentas: Classic user interface: Workspace  ➤  Animator

A janela Animator contém os seguintes componentes: a barra de ferramentas
na página 538, a visualização em árvore na página 541, a visualização da linha
de tempo na página 545, e a barra de entrada manual na página 548.
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Trabalhar com cenas com animação

As cenas agem como containeres para suas animações de objeto.

Cada cena contém os seguintes componentes:
■ Um ou mais conjuntos de animações

■ Uma animação única de câmera

■ Uma animação única do conjunto de planos de corte

As cenas e os componentes da cena pode ser agrupadas em pastas. Isto não
tem efeito na reprodução, exceto que o conteúdo de uma pasta pode ser
facilmente ativado ou desativa para economizar tempo.

Há dois tipos de pastas:
■ Pasta de cenas - para armazenar cenas e outras pastas de cenas.

■ Pastas - para armazenar componentes da cena e outras pastas.

Para adicionar um cena com animação

1 Se a janela Animator já não estiver aberta, clique na guia Animation

painel  ➤ Create ➤  Animator  .

2 Clique com o botão direito na visualização em árvore do Animator, e
clique em Add Scene no menu de atalho.

3 Clique no nome padrão da cena e digite um novo nome.

DICA Utilize nomes que possam ajudá-lo a identificar suas cenas no futuro.

Dispositivo apontador: Clique em  , e clique em Add Scene no menu
de atalho.

Para excluir uma cena com animação

1 Se a janela Animator já não estiver aberta, clique na guia Animation

painel  ➤ Create ➤  Animator  .

2 Selecione a cena que deseja excluir e clique em  .

OBSERVAÇÃO A exclusão de uma cena também exclui todos os sues
componentes. Se você acidentalmente excluir um item, clique em Undo
na barra de ferramentas Acesso rápido para restaurá-lo.
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Para organizar as cenas em pastas de cenas

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .

2 Clique com o botão direito na visualização em árvore do Animator, e
clique em Add Scene Folder no menu de atalho.

3 Clique no nome padrão da pasta e digite um novo nome.

DICA Utilize nomes que possam ajudá-lo a identificar suas cenas no futuro.

4 Selecione a cena que deseja adicionar em sua nova pasta. Mantenha
pressionado o botão esquerdo do mouse e arraste o mouse para o nome
da pasta. Quando o cursor mudar para uma seta, libere o botão do mouse
para soltar a cena na pasta.

Para organizar os componentes da cena em pastas

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Create ➤ Animator  .

2 Para adicionar uma subpasta para uma cena, clique com o botão direito
do mouse na mesma, e clique em Add Folder  no menu de atalho.

Para adicionar uma subpasta para um componente da cena, clique com
o botão direito do mouse na mesma, e clique em Add Folder no menu
de atalho.
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3 Para mover uma subpasta, clique com o botão direito do mouse na
mesma, e clique em Cut no menu de talho. Clique com o botão direito
do mouse na nova localização, e clique em Paste no menu de atalho.

4 Para renomear uma pasta, clique nela, e digite um novo nome.

DICA Utilize nomes que possam ajudá-lo a identificar seus componentes da
cena no futuro.

Trabalhar com conjunto de animações

Um conjunto de animações contém uma lista de objetos de geometria a
receberem uma animação, e uma lista de quadros-chave que descrevem como
receberá a animação.

Sua cena pode ter quantos conjuntos de animações que desejar, e também é
possível ter os mesmos objetos de geometria em diferentes conjuntos de
animações dentro da mesma cena. A ordem dos conjuntos de animação em
uma cena é importante, e pode ser utilizada para controlar a posição final do
objeto quando o mesmo objeto é utilizado em múltiplos conjuntos de
animações.

Adicionar conjuntos de animações

Um conjunto de animação pode ter base na seleção atual na Scene View, ou
no conjunto de seleção ou conjunto de pesquisa atuais.
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Quando você adiciona uma animação com base em um conjunto de seleção,
o conteúdo do conjunto de animações é automaticamente atualizado se o
conteúdo da seleção de origem for modificado.

Quando você adiciona uma animação com base em um conjunto de pesquisa,
o conteúdo do conjunto de animações é automaticamente atualizado cada
vez em que o modelo é modificado para incluir tudo no conjunto de pesquisa.

OBSERVAÇÃO Quaisquer alterações nos conjuntos de pesquisa/seleção durante
a reprodução da animação são ignorados.

Se um modelo muda e aqueles objetos em uma determinada animação estão
faltando, eles são automaticamente removidos do conjunto de animações
quando o arquivo NWD ou NWF correspondente é novamente salvo.

Finalmente, se os conjuntos de seleção ou pesquisa são excluídos ao invés de
serem perdidos, o conjunto de animações correspondente se torna uma seleção
estática de objetos com base no seu último conteúdo.

Para adicionar um conjunto de animações com base na seleção atual

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Create ➤ Animator  .

2 Selecione os objetos de geometria desejados na Scene View, ou na
Selection Tree.

3 Clique com o botão direito do mouse no nome da cena, e clique em Add
Animation Set ➤ From Current Selection no menu de atalho.

4 Se desejar, insira um nome para o novo conjunto de animação e pressione
Enter.

Para adicionar um conjunto de animações com base no conjunto atual de
pesquisa ou seleção

1 Se a janela Animator já não estiver aberta, clique na guia Animation

painel  ➤ Create ➤  Animator  .

2 Selecione o conjunto de pesquisa ou conjunto de seleção desejados na
janela Sets.

3 Clique com o botão direito no nome da cena e clique em Add
Animation Set ➤ From Current Search/Selection Set no menu
de atalho.
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4 Se desejar, insira um nome para o novo conjunto de animação e pressione
Enter.

Atualizar conjuntos de animações

Um conjunto de animações pode ser atualizado manualmente.

É possível modificar a sua seleção atual na Scene View, ou o conjunto de
seleção ou conjunto de pesquisa atuais, e alterar o conteúdo do seu conjunto
de animação para refletir isto.

OBSERVAÇÃO Os quadros-chave não são afetados por esta operação.

Para atualizar um conjunto de animações com base na seleção atual

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .

2 Selecione os objetos de geometria desejados na Scene View, ou na
Selection Tree.

3 Clique com o botão direito no nome da cena e clique em Update
Animation Set ➤ From Current Selection no menu de atalho.

Para atualizar um conjunto de animações com base no conjunto de seleção
ou de pesquisa atual

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .

2 Selecione o conjunto de pesquisa ou conjunto de seleção desejados na
janela Sets.

3 Clique com o botão direito no nome da cena e clique em Update
Animation Set ➤ From Current Search/Selection Set no menu
de atalho.

Manipular objetos de geometria

Você pode modificar a posição, rotação, tamanho, cor e transparência de
objetos de geometria em conjuntos de animações, e capturar estas alterações
em quadros-chave.
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Toda a manipulação de objetos é executada na Scene View.

Quando você manipula objetos de geometria ao alterar sua posição, rotação
ou tamanho, poderá utilizar o snap para controlar a precisão de suas operações
na Scene View.

Quando você seleciona conjuntos de animações na visualização em árvore do
Animator, eles também são realçados na Scene View. Para obter uma
visualização mais clara de um objeto ao efetuar sua animação, você poderá
utilizar o Options Editor para ajustar a forma na qual a seleção atual é
realçada.

Consulte também:

A barra Manual Entry na página 548

Meta-alça na página 172

Para capturar o movimento do objeto

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .

2 Selecione o conjunto de animação desejado na visualização em árvore
do Animator.

Os objetos de geometria correspondentes são realçados na Scene View.

DICA Para obter uma melhor visualização, altera a forma pela qual os objetos
são realçados.

3 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com o estado inicial do objeto.

4 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

5 Clique em Translate Animation Set  na barra de ferramentas
Animator.

6 Use a meta-alça Translation para alterar a posição dos objetos
selecionados.

7 Para capturar as alterações no objeto atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.
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Para capturar a rotação do objeto

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Create ➤ Animator  .

2 Selecione o conjunto de animação desejado na visualização em árvore
do Animator.

Os objetos de geometria correspondentes são realçados na Scene View.

DICA Para obter uma melhor visualização, altera a forma pela qual os objetos
são realçados.

3 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com o estado inicial do objeto.

4 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

5 Clique em Rotate Animation Set  na barra de ferramentas
Animator.

6 Use a meta-alça Rotation para rotacionar os objetos selecionados.

7 Para capturar as alterações no objeto atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.

Para capturar as alterações de escala

1 Se a janela Animatorainda não tiver sido aberta, clique na guia

Animation ➤  painel Create ➤  Animator  .

2 Selecione o conjunto de animação desejado na visualização em árvore
do Animator.

Os objetos de geometria correspondentes são realçados na Scene View.

DICA Para obter uma melhor visualização, altera a forma pela qual os objetos
são realçados.

3 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com o estado inicial do objeto.

4 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

5 Clique em Scale Animation Set  na barra de ferramentas Animator.

6 Use a meta-alça Scale para redimensionar os objetos selecionados.
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7 Para capturar as alterações no objeto atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.

Para capturar as alterações de cor

1 Se a janela Animatorainda não tiver sido aberta, clique na guia

Animation ➤  painel Create ➤  Animator  .

2 Selecione o conjunto de animação desejado na visualização em árvore
do Animator.

Os objetos de geometria correspondentes são realçados na Scene View.

DICA Para obter uma melhor visualização, altera a forma pela qual os objetos
são realçados.

3 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com o estado inicial do objeto.

4 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

5 Clique em Change Color of Animation Set  na barra de ferramentas
Animator.

6 Clique no botão Color na barra Manual Entry, e selecione a cor
desejada.

7 Para capturar as alterações no objeto atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.

Para capturar as alterações de transparência

1 Se a janela Animatorainda não tiver sido aberta, clique na guia

Animation ➤  painel Create ➤  Animator  .

2 Selecione o conjunto de animação desejado na visualização em árvore
do Animator.

Os objetos de geometria correspondentes são realçados na Scene View.

DICA Para obter uma melhor visualização, altera a forma pela qual os objetos
são realçados.

3 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com o estado inicial do objeto.
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4 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

5 Clique em Change Transparency of Animation Set  na barra de
ferramentas Animator.

6 Use o deslizador Transparency na barra Manual Entry para ajustar
o quão transparentes ou opacos os objetos selecionados devem ser.

7 Para capturar as alterações no objeto atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.

Trabalhar com câmeras

Uma câmera contém uma lista de pontos de vista e uma lista opcional de
quadros-chave para descrever como os pontos de vista se movem.

Se nenhum quadro-chave de câmera for definido, então a cena usa as vistas
atuais na Scene View. Se um quadro-chave único for definido, a câmera move
para aquele ponto de vista, e a seguir permanece estática através da cena.
Finalmente, se múltiplos quadros-chave forem definidos, a câmera recebe a
animação de acordo.

Você pode adicionar uma câmera em branco, e a seguir manipular os pontos
de vista, ou pode copiar um animação de ponto de vista existente direto em
sua câmera.

OBSERVAÇÃO Cada cena somente por ter uma câmera nela.

Para adicionar uma câmera em branco

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Create ➤ Animator  .

2 Clique com o botão direito no nome da cena desejada, e clique em Add
Camera ➤ Blank Camera no menu de atalho.

Você agora está pronto para capturas pontos de vista da câmera.

Para adicionar uma câmera com uma animação de ponto de vista existente

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .
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2 Selecione a animação de ponto de vista existente na barra de controle
Viewpoints.

3 Clique com o botão direito no nome da cena desejada e clique em Add
Camera  ➤  From Current Viewpoint Animation no menu de
atalho.

O Autodesk Navisworks adiciona automaticamente todos os
quadros-chave necessários para a vista de linha de tempo.

Para capturar pontos de vista da câmera

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Create ➤ Animator  .

2 Selecione a câmera desejada na visualização em árvore do Animator.

3 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com o ponto de vista atual.

4 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

5 Use os botões na barra de navegação para alterar o seu ponto de vista
atual.

Alternativamente, selecione um dos pontos de vista salvos na barra de
controle Viewpoints.

6 Para capturar as alterações no objeto atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.

Trabalhar com conjuntos de planos de corte

Um plano de corte contém uma lista de cortes transversais do seu modelo, e
uma lista de quadros-chave para descrever como eles se movem.

OBSERVAÇÃO Cada cena somente pode ter um conjunto de planos de corte
nela.

Consulte também:

Meta-alça na página 172

Corte na página 486
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Para adicionar um conjunto de planos de corte

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .

2 Clique com o botão direito do mouse no nome da cena desejada, e clique
em Add Section Plane no menu de atalho.

Você agora está pronto para capturar cortes transversais.

Para capturar cortes transversais ao mover um plano de corte

1 Se a janela Animator já não estiver aberta, clique na guia Animation

painel  ➤ Create ➤  Animator  .

2 Selecione o conjunto de planos de corte desejado na visualização em
árvore do Animator.

3 Clique na guia Viewpoint painel  ➤ Sectioning ➤ Enable Sectioning

 .

O Autodesk Navisworks abre a guia Sectioning Tools na faixa de opções
e desenha um plano de corte através do modelo em Scene View.

4 Clique na guia Sectioning Tools painel  ➤ Planes Settings menu
suspenso  ➤ Current Plane e selecione o plano que você deseja
manipular.

5 Clique na guia Sectioning Tools painel  ➤ Transform e clique na

meta-alça de corte que você deseja usar (mover  ou rotacionar  ).
Por padrão, a meta-alça de movimentação é usada.

Arraste a meta-alça para ajustar a posição inicial do plano na Scene
View.

6 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar um quadro-chave com a posição inicial do plano de corte.

7 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

8 Use a meta-alça novamente para ajustar a profundidade do seu corte
transversal.

9 Para capturar as alterações do plano atual em um quadro-chave, clique

em Capture Keyframe  na barra de ferramentas Animator.
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Para capturar cortes transversais ao mover uma caixa de corte

1 Se a janela Animator já não estiver aberta, clique na guia Animation

painel  ➤ Create ➤  Animator  .

2 Selecione o conjunto de planos de corte desejado na visualização em
árvore do Animator.

3 Clique na guia Viewpoint painel  ➤ Sectioning ➤ Enable Sectioning

 .

O Autodesk Navisworks abre a guia Sectioning Tools na faixa de opções
e desenha um plano de corte através do modelo em Scene View.

4 Clique na guia Sectioning Tools painel  ➤ Mode ➤ Box  .

5 Clique na guia Sectioning Tools ➤ painel Transform e clique no

gizmo de corte que você deseja usar (mover  , rotacionar  ou

dimensionar  ). Por padrão, a meta-alça de movimentação é usada.

Arraste a meta-alça para ajustar a posição inicial da caixa de corte na
Scene View.

6 Clique em Capture Keyframe  na barra de ferramentas Animator
para criar uma captura de quadro-chave com a posição inicial da caixa
de corte.

7 Na visualização da linha de tempo, mova o deslizador preto de tempo
para a direita para definir o tempo desejado.

8 Use a meta-alça novamente para ajustar a profundidade do seu corte
transversal.

9 Para capturar as alterações atuais da caixa de corte em um quadro-chave,

clique em Capture Keyframe  na barra de ferramentas Animator.

Trabalhar com quadros-chave

Os quadros-chave são utilizados para definir a posição e as propriedades das
alterações feitas no modelo.

Consulte também:

Caixa de diálogo Edit Key Frame na página 793
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Capturar quadros-chave

Novos quadros-chave são criados ao clicar em Capture Keyframe  na
barra de ferramentas Animator. Sempre que você clica neste botão, o Autodesk
Navisworks adiciona um quadro-chave do conjunto de animações no momento
selecionado, câmera, ou conjunto de planos de corte na posição atual do
deslizador preto de tempo.

Conceitualmente, os quadros-chave representam operações de traduções
relativas, rotações e dimensionamento de um quadro-chave anterior, no ou
caso do primeiro quadro-chave, a posição inicial do modelo.

Os quadros-chave são relativos um ao outro e a posição inicial do modelo.
Isto significa que, se um objeto é movido na cena (quando, por exemplo, uma
nova versão do modelo é aberta, ou se ferramentas de movimento são utilizadas
no Autodesk Navisworks), a animação é feita relativa à nova localização inicial
em vez da posição inicial original da animação.

As operações de tradução, dimensionamento e rotação são cumulativas. Isto
significa que se um determinado objeto está em dois conjuntos de animações
ao mesmo tempo, ambos os conjuntos de operações pode ser executado.
Portanto, se ambas são traduções através do eixo X, por exemplo, o objeto irá
mover duas vezes.

Se não houver um quadro-chave no início da linha do tempo para um conjunto
de animações, câmera ou plano de corte, então o real início da linha do tempo
age com um quadro-chave oculto. Portanto, por exemplo, se você tem um
quadro chave com poucos segundos adiante, e o quadro tem a opção
Interpolate ativada, então ao longo destes poucos segundos os objetos irão
interpolar entre sua posição inicial padrão e as definidas no primeiro
quadro-chave.

Editar quadros-chave

Você pode editar quadros-chave capturados para conjuntos de animações,
câmeras e conjuntos de planos de corte.

Para editar um quadro-chave

1 Se a janela Animator ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Create ➤ Animator  .
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2 Clique com o botão direito do mouse no quadro-chave desejado na
visualização da linha do tempo, e selecione Edit no menu de atalho.

3 Utilize a caixa de diálogo Edit Key Frame para ajustar a animação.

4 Clique em OK para salvar suas alterações ou em Cancel para sair da
caixa de diálogo.

Reproduzir cenas com animação

As animações criadas no Autodesk Navisworks Manage 2012 podem ser
executadas em todos os produtos Autodesk Navisworks2012, incluindo o
Freedom.

Para reproduzir uma cena na janela Animator

1 Se a janela Animation ainda não tiver sido aberta, clique na guia

Animation ➤ painel Create ➤ Animator  .

2 Na lista suspensa Scene Picker, selecione a cena que deseja reproduzir
na visualização em árvore do Animator.

3 Clique em Play  na barra de ferramentas Animator.

Para reproduzir uma cena a partir da guia Animation

1 Clique na guia Animation ➤ painel Playback.

2 Na lista suspensa Available Animations, selecione a cena que deseja
reproduzir.

3 Clique em Play  na barra de ferramentas Animation no painel
Playback.

Para ajustar a reprodução da cena

1 Se a janela Animatorainda não tiver sido aberta, clique na guia

Animation ➤  painel Create ➤  Animator  .

2 Selecione a cena desejada na visualização em árvore do Animator.

3 Utilize as caixas de seleção Loop, P.P. e Infinite para ajustar a forma
de reprodução da cena:
■ Se você deseja que a cena seja continuamente reproduzida, selecione

a caixa de seleção Loop. Quando a animação chegar ao fim, ela será
reinicializada para o início e começará a ser novamente reproduzida.
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■ Se você deseja que a cena seja reproduzida no modo ping-pong,
selecione a caixa de seleção P.P. . Quando a animação chegar ao fim,
ela será reproduzida no sentido inverso até alcançar o início. Isto
somente irá acontecer uma vez, a não ser que você selecione a caixa
de seleção Loop.

■ Se quiser que a cena seja reproduzida indefinidamente (isto é, até que

Stop  seja clicado), selecione a caixa de seleção Infinite. Se esta
caixa de seleção estiver desmarcada, a cena será reproduzida até que
seu ponto final seja alcançado.

OBSERVAÇÃO Selecionar Infinite desativa Loop e P.P.

4 Se necessário, utilize as caixas de seleção Active, Loop e P.P., para
ajustar a reprodução dos componentes individuais da cena.

OBSERVAÇÃO Somente animações com a caixa de seleção Active
selecionada serão reproduzidas.

Adicionar interatividade
A janela Scripter é uma janela flutuante que permite adicionar interatividade
nas animações de objetos em seu modelo.

Faixa de opções:  Guia Animation ➤  painel Script ➤ Scripter
Menu: Classic user interface: Tools  ➤  Scripter

Barra de ferramentas: Classic user interface: Workspace  ➤  Scripter 
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A janela Scripter contém os seguintes componentes: a visualização em árvore
na página 550, a visualização Events na página 552, a visualização Actions na
página 554, e a visualização Properties na página 556.

OBSERVAÇÃO Caso não consiga utilizar qualquer um dos controles na janela
Scripter, significa que você está no modo de interação. Para sair do modo, clique

na guia Animation ➤ painel Script ➤  Enable Scripts  .

Trabalhar com scripts de animação

Um script é uma coleção de ações que você deseja que aconteçam quando
determinadas condições de evento são atendidas.

Para adicionar a interatividade em seu modelo, é preciso criar ao menos um
script de animação.

Cada script pode conter os seguintes componentes:
■ Um ou mais eventos

■ Uma ou mais ações

Seu modelo pode ter quanto scripts você desejar, mas somente os scripts ativos
são executados.

Você pode agrupar os scripts em pastas. Isto não tem efeito em sua execução,
exceto pelo fato de que o conteúdo de uma pasta pode ser facilmente
ativado/desativado para economizar tempo.

Para adicionar um script

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Script ➤ Scripter  .

2 Clique com o botão direito do mouse na visualização do script, e clique
em Add New Script no menu de atalho.

3 Clique no nome padrão do script e digite um novo nome.

DICA Utilize nomes que possam ajudá-lo a identificar seus scripts no futuro.

Dispositivo apontador: Clique em  na parte inferior da visualização em
árvore.
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Para excluir um script

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation ➤ painel Script ➤ Scripter  .

2 Clique com o botão direito no script que você deseja excluir na
visualização em árvore, e clique em Delete Item no menu de atalho.

Dispositivo apontador: Clique em  na parte inferior da visualização em
árvore.

OBSERVAÇÃO Se você acidentalmente excluir um item, clique em Undo  na
barra de ferramentas Acesso rápido para restaurá-lo.

Menu de atalho: Clique com o botão direito do mouse, e clique em Delete
Item.

Para organizar scripts em pastas

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation ➤ painel Script ➤ Scripter  .

2 Clique com o botão direito do mouse na visualização em árvore, e clique
em Add New Folder no menu de atalho.

3 Clique no nome padrão da pasta e digite um novo nome.

DICA Utilize nomes que possam ajudá-lo a identificar seus scripts no futuro.

4 Selecione o script que deseja adicionar em sua nova pasta. Mantenha
pressionado o botão esquerdo do mouse e arraste o mouse para o nome
da pasta. Quando o cursor mudar para uma seta, libere o botão do mouse
para soltar o script na pasta.

Alternativamente, selecione o script, e mantenha pressionado o botão
direito do mouse. Arraste o mouse para o nome da pasta. Quando o
cursor mudar para uma seta, solte o botão direito do mouse, e clique em
Move Here no menu de atalho.
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Trabalhar com eventos

Um evento é a ocorrência de um incidente ou uma situação, como um clique
do mouse, pressionar uma tecla, ou colisão, que determina se o seu script é
executado ou não.

Seu script pode conter mais de um evento. No entanto, a forma pela qual você
combina todas as condições de eventos no script se torna muito importante.
Ou seja, você precisa assegurar que a lógica Booleana faça sentido, que os
colchetes estejam apropriadamente fechados, e assim por diante.

OBSERVAÇÃO Até que a combinação de todas as condições de evento sejam
satisfeitas, seu script não será executado.

Tipos de eventos

Os seguintes tipos de eventos estão disponíveis no Autodesk Navisworks:

■ On Start - o evento aciona um script assim que o script seja ativado. Se
o script estiver ativado quando um arquivo é carregado, então quaisquer
eventos de inicialização no arquivo serão imediatamente acionados. Isto
é útil para definir as condições iniciais de seu script, como fornecer valores
iniciais para variáveis ou mover a câmera para um ponto inicial definido.

■ On Timer - o evento aciona um script em intervalos de tempo predefinidos

■ On Key Press - o evento aciona um script com um botão específico no
teclado.

■ On Collision - o evento aciona um script quando a câmera colide com
um objeto específico.
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■ On Hotspot - o evento aciona um script quando a câmera estiver em uma
fixa específica de um ponto principal.

■ On Variable - o evento aciona um script quando a variável atende um
critério predefinido.

■ On Animation - o evento aciona um script quando uma animação
específica começa ou para.

Condições de evento

Os eventos podem ser combinados com uma lógica Booleana simples: Para
criar uma condição de evento você pode utilizar uma combinação de colchetes
e os operadores AND/OR.

Os colchetes e os operadores lógicos podem ser adicionados ao clicar com o
botão direito do mouse em um evento e selecionado a opção no menu de
atalho. Alternativamente, é possível clicar no campo correspondente na
visualização Events, e usar a lista suspensa para selecionar a opção desejada.

OBSERVAÇÃO Se você tiver mais de um evento em seu script, por padrão o
operador AND será utilizado. Isto significa que o script somente será executado
se todos os eventos ocorreram.

Para adicionar um evento

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Script ➤ Scripter  .

2 Selecione o script desejado na visualização em árvore.

3 Clique no ícone do evento desejado na parte inferior da visualização

Events. Por exemplo, clique em  para criar um evento On Start.

4 Revise as propriedades do evento na visualização Properties, e ajuste-
as conforme for necessário na página 556.
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Para testar a lógica do evento

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Script ➤ Scripter  .

2 Selecione o script desejado na visualização em árvore.

3 Clique com o botão direito na visualização Events, e clique em Test
Logic no menu de atalho.

O Autodesk Navisworks verifica as condições do evento no script e reporta
quaisquer erros detectados.

Para excluir um evento

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Script ➤ Scripter  .

2 Selecione o script desejado na visualização em árvore.

3 Clique com o botão direito no evento que deseja excluir na visualização
Events, e clique em Delete Event.

Trabalhar com ações

Uma ação é uma atividade, como reproduzir ou parar uma animação, exibir
um ponto de vista, e assim por diante, que é executada quando um script é
acionado por um evento ou por uma combinação de eventos.

Seu script pode conter mais de uma ação. As ações são executadas uma após
a outra, portanto, é importante ter a sequência correta das ações.

OBSERVAÇÃO  O Autodesk Navisworks não espera pela conclusão da ação atual
antes de mover para a próxima ação.

Tipos de ações

Os seguintes tipos de ações estão disponíveis no Autodesk Navisworks:

■ Play Animation - a ação especifica qual animação deve ser reproduzida
quando um script é acionado.

■ Stop Animation - a ação especifica qual animação no momento sendo
reproduzida deve ser parada quando um script é acionado.
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■ Show Viewpoint - a ação especifica qual ponto de vista dever ser utilizado
quando um script é acionado.

■ Pause - permite parar o script por um período específico de tempo antes
que a próxima ação seja executada.

■ Send Message - a ação grava uma mensagem em um arquivo de texto
quando um script é acionado.

■ Set Variable - a ação atribui, aumenta ou diminui uma valor de variável
quando um script é acionado.

■ Store Property -a ação armazena um propriedade de objeto em uma
variável quando um script é acionado.

Isto pode ser útil se você precisa acionar eventos com base em propriedades
de objeto embutidas ou dados ao-vivo em um banco de dados vinculado.

■ Load Model - a ação abre um arquivo especificado quando um script é
acionado.

Você pode considerar ser útil quando deseja apresentar uma seleção de
cenas com animação contida em uma faixa de diferentes arquivos de
modelo.

Para adicionar uma ação

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation ➤  painel Script ➤  Scripter  .

2 Selecione o script desejado na visualização em árvore.

3 Clique no ícone de ação desejado na parte inferior da visualização

Actions. Por exemplo, clique em  para adicionar uma ação Play
Animation.

4 Revise as propriedades da ação na visualização Properties, e  ajuste-as
conforme for necessário na página 559.

Para testar uma ação

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Script ➤ Scripter  .

2 Selecione o script desejado na visualização em árvore.

3 Clique com o botão direito na visualização Actions, e clique em Test
Action no menu de atalho.

O Autodesk Navisworks executa a ação selecionada.
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Para excluir uma ação

1 Se a janela Scripter ainda não tiver sido aberta, clique na guia

Animation painel  ➤ Script ➤ Scripter  .

2 Selecione o script desejado na visualização em árvore.

3 Clique com o botão direito na ação que deseja excluir na visualização
Actions, e clique em Delete Action.

Ativar script

Para ativar scripts de animação no seu arquivo, é preciso clicar na guia

Animation painel  ➤ Script ➤ Enable Scripts  .

Você agora pode interagir com seu modelo.

OBSERVAÇÃO Quando os scripts são ativados, é possível criar ou editar scripts
na janela Scripter. Para desativar os scripts, clique na guia Animation ➤ painel

Script ➤ Enable Scripts  novamente.
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Criar visualizações
fotorrealistas

Você pode usar o Presenter para aplicar materiais de textura, iluminação, Rich
Photorealistic Content (RPC), e efeitos de plano fundo no seu modelo.

OBSERVAÇÃO Os materiais do Presenter estão disponíveis somente durante o uso do
sistema de gráficos do Presenter.

Visão geral da ferramenta Presenter

Janela Presenter

A janela encaixável Presenter é utilizada para definir materiais e iluminação
em sua cena para renderizar a cena com mais realismo e efeitos. Também é
possível usá-lo para editar materiais predefinidos e aplicá-los a itens na cena,
adicionar iluminação à cena, e definir regras para aplicar os materiais em outros
arquivos na mesmas configurações de projeto com os mesmos parâmetros. Você
pode definir e aplicar materiais e iluminação em um modelo e salvar as
configurações em um arquivo NFW, portanto, quando o modelo é atualizado,
os materiais e a iluminação permanecem os mesmos.

Os materiais também pode ser trazidos de aplicativos de CAD através dos
formatos de arquivo 3DS, DWG e DGN, ou ao exportar do 3D Studio Viz ou
Max. Consulte Trabalhar com arquivos na página 175 para obter mais detalhes
sobre isso.
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A janela Presenter contém as seguintes guias:
■ Materials. Inclui diversos materiais, que podem ser selecionados e

aplicados em itens individuais ou em grupos de itens do modelo. Você
também utiliza esta guia para criar novos materiais ou para personalizar
materiais existentes.

■ Lighting. Inclui diversas opções de iluminação, que podem ser
selecionadas e aplicadas no modelo. Também é possível personalizar as
opções de iluminação, se desejado.

■ RPC. Contém Rich Photorealistic Content (ou RPC), que pode ser acionado
de diversas origens, incluindo websites. RPCs podem incluir imagens de
pessoas, árvores, carros, e assim por diante.

■ Effects. Inclui diversos segundos planos e ambientes, que podem ser
selecionados e aplicados na cena do modelo. Alguns segundos planos pode
ser personalizados ou novos podem ser criados. Você também pode
adicionar segundos planos e ambientes de outras origens, como websites.

■ Rendering. Inclui diversos estilos de renderização, que podem ser
selecionados e aplicados no modelo. Um estilo de renderização afeta como
a cena é renderizada. Você também pode utilizar esta guia para criar novos
estilos de renderização ou para personalizar estilos de renderização
existentes.

■ Texture Space. Define como uma textura é aplicada em um item do
modelo, por exemplo, aplicar um espaço de textura cilíndrica em uma
tubulação que irá fornecer um efeito mais natural.

■ Rules. Aplica os materiais nos modelos de acordo com um critério definido
pelo usuário. As regras podem ser usadas, por exemplo, para acelerar a
aplicação de materiais para grupos de itens.
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As guias Materials, Lighting, Effects e Rendering são divididas em dois
painéis. O painel esquerdo contém os arquivos na página 590 e o painel direito
contém a paleta, que define quais materiais, iluminação, efeitos e estilos de
renderização são usados na cena. Os arquivos são mostrados em uma estrutura
de árvore e são definidos no formato LightWorks Archive (.lwa).

Aparência do modelo

O Presenter pode ser utilizado para renderizações fotorrealistas e também
pode ser utilizado para a renderização interativa OpenGL. Uma vez que você
tenha configurado a cena com o Presenter, é possível exibir os materiais e
iluminação no Autodesk Navisworks em tempo real.

Para obter mais informações, consulte Controlar a aparência do modelo na
página 341.

Para alternar a janela Presenter

■ Clique na guia Home ➤ painel Tools ➤ Presenter  .

Faixa de opções:  Guia Home ➤ painel Tools ➤ Presenter
Menu: Classic user interface: Tools ➤ Presenter

Utilizar os arquivos do Presenter

Esses são três do arquivos predefinidos que são instalados com o Presenter:
■ Os arquivos Recommended contém materiais, iluminação, efeitos e

estilos de renderização que são recomendados para a maioria dos usuários.
Eles incluem materiais, iluminação e efeitos que podem ser visualizados
durante a navegação interativa no Autodesk Navisworks e podem ser
completamente renderizados com o OpenGL. É claro que eles terão melhor
aparência quando renderizados com foto realismo.

■ Materiais adicionais, estúdios de iluminação, efeitos e estilos de renderização
estão disponíveis nos arquivos Standard. Estes incluem os materiais e
não podem ser completamente reproduzidos utilizando o OpenGL,
portanto, não serão apropriadamente visualizados no modo interativo ou
até que a renderização fotorrealista seja feita.

■ Qualquer material, iluminação, efeito e estilo de renderização de qualquer
arquivo podem ser usados como um inicializador de modelo para as suas
próprias definições, mas os arquivos Templates contêm instâncias de
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cada tipo de material, iluminação, efeito e estilo de renderização,
fornecendo acesso mais rápido.

DICA Arquivos LWA adicionais podem ser baixados de Lightworks-User, e
adicionados nas guias Materials, Lighting, Effects e Rendering.

Mesmo que materiais, iluminação, efeitos e estilos de renderização não possam
ser editados nos arquivos, uma vez arrastados para a paleta da cena, eles podem
ser editados e salvos com a cena em um arquivo NWF, ou publicados como
um arquivo NWD.

É possível salvar as suas próprias edições em materiais em um formato de
arquivo NWP. Consulte Organizar e gerenciar materiais na página 597 para
obter mais informações sobre como fazer isso.

Os arquivos do usuário

Os arquivos do usuário permitem salvar os seus próprios materiais,
iluminação, efeitos e estilos de renderização editados para uso em outras cenas.

Os arquivos do usuário estão acessíveis para cada uma das guias Materials,
Lighting, Effects, e Rendering. Em cada uma das guias, os arquivos são
nomeados My Materials, My Lighting, My Effects, e My Render Styles,
respectivamente.

Para gerenciar arquivos do usuário

■ Para salvar um material, iluminação, efeito ou estilo de renderização para
uso em outras cenas, no painel direito, arraste aquele item da paleta da
cena para o respectivo arquivo de usuário.

■ Para criar uma nova subpasta em um arquivo do usuário, clique com o
botão direito no arquivo, e clique em New Directory no menu de atalho.
Você pode renomear esta nova pasta ao clicar com o botão direito do mouse
na mesma, e clicar em Rename no menu de atalho. Você pode adicionar
tantas subpastas aninhadas quanto desejar.

■ Para salvar um arquivo do usuário no disco, clique com o botão direito do
mouse no mesmo, e clique em Save Archives no menu de atalho. Isso
salva quaisquer arquivos modificados.

OBSERVAÇÃO Você também será instruído a salvar quaisquer arquivos
modificados ao fechar o Autodesk Navisworks.
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■ Para remover um material, iluminação, efeito ou estilo de renderização do
respectivo arquivo do usuário, clique com o botão direito no item a ser
removido, e clique em Delete no menu de atalho.

■ Para remover uma subpasta criada no respectivo arquivo do usuário, clique
com o botão direito na pasta a ser removida, e clique em Delete no menu
de atalho.

OBSERVAÇÃO Você não pode excluir quaisquer pastas de arquivo padrão do
usuário.

Para adicionar arquivos

■ Para efetuar o download de um arquivamento do site do Lightworks-User,
no painel esquerdo, clique com o botão direito do mouse em qualquer
arquivamento, e clique em Download Archive no menu de atalho. A
seguir siga as instruções fornecidas no site.

■ Para importar um arquivo baixado no Presenter, no painel esquerdo,
clique com o botão direito em qualquer arquivo, e clique em Import
Archive no menu de atalho. Use a caixa de diálogo Open padrão para
selecionar o arquivo LWA para importar.

Para excluir um arquivo adicionado

1 Clique com o botão direito no arquivo, e clique em Delete Archive no
menu de atalho.

2 Clique em Yes.

Renderização fotorrealista da cena
É possível renderizar diretamente na Scene View ao clicar em Render na
parte inferior da janela Presenter a qualquer momento.

Você pode exportar cenas renderizadas como imagens e utilizá-las em
apresentações, em websites, um impressões, e assim por diante. Você também
pode exportar apresentações AVI com animações ou filmes instrucionais, nos
quais os objetos com animação se movem em cenas renderizadas com foto
realismo.
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OBSERVAÇÃO Quando maior o tamanho da animação exportada, maior a
resolução. No entanto, isto aumenta significantemente os tempos de renderização.
Se estiver criando imagens em alta resolução, é melhor usar uma máquina separada
para renderizar.

Após ter definido e renderizado uma cena, é possível adicionalmente criar a
animação na cena. A renderização que foi definida será aplicada em cada
quadro da animação.

Para definir e renderizar uma cena

1 Selecione a guia Home ➤ painel Tools ➤ Presenter  para abrir a
janela Presenter.

2 Configure a cena.
■ Utilize e guia Materials para arrastar e soltar materiais em itens no

modelo.

Você pode usar os materiais predefinidos, ou criar os seus próprios a
partir dos modelos na guia Materials (consulte Utilizar materiais do
Presenter na página 594 para obter mais detalhes).

Ou

Utilize a guia Rules para configurar regras que definem a aplicação
de materiais no âmbito do projeto (consulte Utilizar regras do
Presenter na página 640 para obter mais detalhes).

■ Utilize a guia Texture Space para mapear com mais precisão os
materiais em itens na cena (consulte Utilizar o espaço de textura do
Presenter na página 637 para obter mais detalhes sobre essa função).

■ Utilize a guia Lighting para configurar iluminação adicional
(consulte Utilizar luzes do Presenter na página 607 para obter mais
detalhes).

■ Utilize a guia Effects para adicionar efeitos de primeiro e segundo
plano na cena (consulte Utilizar efeitos de renderização do Presenter
na página 626 para obter mais detalhes).

■ Utilize a guia Rendering para selecionar um estilo para a
renderização (consulte Utilizar estilos de renderização do Presenter
na página 633 para obter mais detalhes).

3 A qualquer momento, você pode clicar em Render para iniciar o processo
de renderização na Scene View. O processo de renderização pode ser
interrompido a qualquer momento ao clicar no botão Stop.

4 Clique em Clear para limpar a renderização na Scene View, e voltar
para uma vista interativa OpenGL.
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Para imprimir uma imagem renderizada

1 Aplique materiais e efeitos de iluminação na cena requerida, e clique em
Render.

2 Quando a cena tiver sido renderizada, clique na guia Output painel
 ➤ Visuals ➤ Rendered Image.

3 Na caixa de diálogo Export Rendered Image , selecione Printer na
lista suspensa Type.

A opções Browse ficam acinzentadas.

4 Clique em OK.

5 Na caixa de diálogo Print, selecione a impressora desejada, insira as
configurações de impressão, e clique em OK.

Faixa de opções:  Guia Output painel  ➤ Visuals ➤ Rendered Image

Menu: Botão do aplicativo  ➤ Export ➤ Images &
Animations ➤ Rendered Image

Para salvar uma imagem renderizada

1 Aplique materiais e efeitos de iluminação na cena requerida, e clique em
Render.

2 Quando a cena tiver sido renderizada, clique na guia Output painel

 ➤ Visuals ➤ Rendered Image  .

3 Na caixa de diálogo Export Rendered Image , selecione o tipo de
arquivo desejado na lista suspensa Type. Para obter mais informações,
consulte Caixa de diálogo Export Rendered Image na página 797

4 Procure por uma localização e insira o nome do arquivo para o qual
deseja renderizar.

5 Defina o tamanho do arquivo renderizado.

OBSERVAÇÃO Se você selecionar Use View como o Size do arquivo de
imagem, então o Autodesk Navisworks irá salvar qualquer renderização
existente na Scene View, sem ter que renderizar novamente do início.

6 Clique em OK.

Faixa de opções:  Guia Output painel  ➤ Visuals ➤ Rendered Image
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Menu: Botão do aplicativo  ➤ Export ➤ Images &
Animations ➤ Rendered Image

Para exportar animações renderizadas

1 Aplique materiais e efeitos de iluminação na cena requerida, e, na janela
Presenter, clique em Render.

2 Quando a cena tiver sido renderizada, clique na guia Output painel

 ➤ Visuals ➤ Animation  .

A caixa de diálogo Animation Export é aberta.

3 Na lista suspensa Source, selecione o tipo de animação que você deseja
exportar.
■ Para exportar uma animação de objeto, selecione Current Animator

Scene.

■ Para exportar uma sequência do TimeLiner, selecione TimeLiner
Simulation.

■ Para exportar uma animação de ponto de vista, selecione Current
Animation.

4 Defina as opções restantes na caixa de diálogo Animation Export, e
clique em OK. Para obter mais informações, consulte Caixa de diálogo
Animation Export na página 781.

5 Na caixa de diálogo Save As, insira um novo nome e localização de
arquivo, se deseja alterar o que foi sugerido.

6 Clique em Save.

Faixa de opções:  Guia Output painel  ➤ Visuals ➤ Animation
Menu: Botão do aplicativo  ➤ Export ➤ Images &

Animations ➤ Animation

Utilizar materiais do Presenter

Guia Materials

Com as guias Lighting na página 607, Effects na página 626 e Rendering na
página 633 , a guia Materials é dividida em dois painéis. O painel esquerdo
descreve os arquivos na página 590 de materiais predefinidos que estão
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instalados e o painel direito mostra a paleta de materiais atual que foi definida
e está sendo usada na cena. A paleta também mostra uma pequena miniatura
de cada material como será exibido quando for renderizado.

Aplicar e remover materiais do Presenter

Materiais podem ser aplicados em itens na cena ao arrastar e soltar o material
em:
■ Um item na Scene View

■ Um item na Selection Tree

■ Um conjunto de seleção ou de pesquisa

Se você arrastar o material de um arquivo, ele irá aparecer na paleta onde pode
ser editado e salvo com a cena, se necessário.

O Presenter usa a resolução de seleção do Autodesk Navisworks para decidir
a quais itens aplicar o material ao arrastar de um arquivo ou paleta para vista
principal. Ao passar o mouse sobre qualquer item na vista principal, a seleção
proposta irá mudar para a cor de seleção (azul por padrão). Quando você solta
o material na seleção atual, ele será aplicado em todos os itens selecionados.
Se você solta o material em um item que não está no momento selecionado,
ele será aplicado em somente aquele item. Consulte Definir a resolução de
seleção na página 369 para obter mais informações sobre resolução de seleção.

Você também pode aplicar materiais nos itens ao selecioná-los na Selection
Tree ou na Scene View, clicar com o botão direito do mouse no material na
paleta e clicar em Apply to Selected Items.
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Regras também podem ser utilizadas para aplicar materiais em itens
automaticamente com base em sua camada ou cor ou nomes de conjuntos de
seleção, por exemplo. Consulte Utilizar regras do Presenter na página 640 para
obter mais detalhes sobre isso.

É possível remover materiais atribuídos a itens de geometria, na janela
Presenter, ou diretamente na Scene View ou Selection Tree.

Herança

As camadas assim como com geometria podem ter cores. Se a camada tem
material, todas suas secundárias na Selection Tree herdam este material, até
que uma das secundárias tenha seu próprio material atribuído, em cujo ponto
todas suas secundárias na Selection Tree herdam este material, e assim por
diante.

É possível arrastar e soltar materiais em camadas. Somente a camada recebe o
material, e mesmo que seus objetos secundários herdem o material, eles não
o tem explicitamente atribuído.

Portanto, clicar com o botão direito do mouse em uma secundária não irá
permitir remover o material porque um não foi explicitamente atribuído em
primeiro lugar.

No entanto, se você utiliza uma regra para atribuir um material para uma
determinada cor, então todos os objetos na cena irão receber este material
explicitamente atribuído aos objetos, incluindo as camadas principais e os
objetos secundários. Se, como uma resolução de seleção de algo como
Geometry (que é mais específico do que uma resolução de Layer), clique
com o botão direito em um objeto secundário, e clique em Remove Materials
no menu de atalho, então o material será removido do objeto secundário, mas
não da camada principal e não haverá diferença aparente.

Para remover o material, é necessário, portanto, remover o material do objeto
principal; na situação acima isso seria a camada.

Para aplicar materiais na geometria do modelo

1 Selecione os itens de geometria diretamente na Scene View ou na
Selection Tree.

2 Abra a janela Presenter e clique na guia Materials.

3 Selecione o seu material de um arquivo ou paleta, clique com o botão
direito neste material, e clique em Apply to Selected Items no menu
de atalho para atribuir o material para a seleção de geometria atual.
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OBSERVAÇÃO O material selecionado somente será aplicado no item de
geometria selecionado e não para cada instância do item. Para atribuir o
material para todas as instâncias da geometria selecionada na cena, clique
em Apply to All Instances of Selection no menu de atalho.

DICA Você pode arrastar e soltar um material de um arquivo ou paleta nos itens
na Selection Tree ou Scene View para atribuir esse material aos itens. A resolução
de seleção determina quais itens irão receber os materiais.

Para usar a Scene View ou a Selection Tree para remover materiais da
geometria do modelo

■ Clique com o botão direito do mouse na Scene View ou na Selection
Tree, e clique em Presenter ➤ Remove Material no menu de atalho.

OBSERVAÇÃO Remove Material somente estará disponível se o item que
foi clicado com o botão direito possuir um material atribuído na resolução de
seleção na Selection Tree.

Para usar a janela Presenter para remover materiais da geometria do modelo

1 Abra a janela Presenter e clique na guia Materials.

2 Na paleta de materiais, clique com o botão direito no material que você
deseja remover dos itens na cena, e clique em Remove From All Items
no menu de atalho.

OBSERVAÇÃO Excluir o material da paleta irá automaticamente remover
aquele material de qualquer item na Scene View ao qual foi aplicado.

Organizar e gerenciar materiais

Pastas personalizadas

Você pode organizar os materiais em pastas personalizadas para uma fácil
referência e gerenciamento. Ao fazer isso, você está de fato personalizando
um arquivo de usuário. Para obter mais informações, consulte Utilizar os
arquivos do Presenter na página 589.
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A paleta Material

Na guia Materials, painel direito, ou paleta de materiais, é onde você edita
e gerencia seus materiais para sua cena. Os materiais são tirados do arquivo e
colocados na paleta onde eles são editados. Você pode então salvar a paleta
em um arquivo de paleta (NWP) do Autodesk Navisworks para utilização
também em outras cenas.

Para adicionar uma pasta personalizada

1 Abra a janela Presenter e clique na guia Materials.

2 Clique com o botão direto na pasta My Materials no painel esquerdo,
e clique em New Directory no menu de atalho.

3 Expanda a pasta My Materials, e clique com o botão direito do mouse
na nova pasta, e clique em Rename no menu de atalho.

4 Digite o novo nome, por exemplo “GGK Project”.

Para excluir uma pasta personalizada

1 Na janela Presenter, guia Materials, expanda a pasta My Materials
no painel esquerdo, e clique com o botão direito na pasta que deseja
excluir.

2 Clique em Delete no menu de atalho.

Para copiar materiais em uma pasta personalizada

1 Na janela Presenter, guia Materials, clique em um material no painel
direito, e arraste-o para a localização desejada na pasta My Materials
no painel esquerdo até que um cursor do mouse apresente um pequeno
sinal de mais.

2 Solte o botão esquerdo do mouse para soltar o material na pasta.
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OBSERVAÇÃO Também é possível copiar materiais entre pastas no painel
esquerdo ao arrastar e soltá-los, ou usando as opções Copy e Paste no
menu de atalho.

Para gerenciar os materiais na paleta

1 Clique com o botão direito em um material no painel direito da guia
Materials (a paleta).
■ Clique em Copy para copiar o material para a área de transferência.

Clique com o botão direito do mouse em um espaço vazio na paleta
e clique em Paste para colar uma cópia do material com o mesmo
nome com sufixo do próximo número na lista. Este processo é útil
se você deseja testar pequenos ajustes em um material.

■ Clique em Delete no menu de talho para excluir o material da paleta.
Isso também irá remover o material de todos os itens na cena.

■ Clique em Regenerate Image para gerar novamente a miniatura
do material na paleta com os atributos atuais.

■ Clique em Rename para renomear o material. Você também pode
selecionar o material e pressionar F2 para renomeá-lo.

■ Clique em Edit, ou clique duas vezes em um material para abrir a
caixa de diálogo Material Editor, permitindo editar seus parâmetros.
Consulte Editar materiais do Presenter na página 600 para obter mais
informações.

■ Dependendo se os itens são selecionados na cena e se o material foi
atribuído para quaisquer itens, também deverá haver alguns itens de
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Apply e Remove no menu de atalho. Consulte Aplicar e remover
materiais do Presenter na página 595 para obter mais detalhes.

■ Clique em Select All Instances para selecionar os itens na cena
que tem possuem este material em particular atribuído aos mesmos.

■ Clique em Load Palette para carregar uma paleta de materiais
anteriormente salva na cena atual. Isso irá excluir quaisquer materiais
existentes no momento na paleta. A caixa de diálogo padrão File
Open é aberta, permitindo procurar por um arquivo NWP.

■ Clique em Append Palette para carregar uma paleta de um arquivo
NWP, mantendo todos os materiais existentes na paleta atual.
Quaisquer materiais que estejam duplicados serão renomeados com
o arquivo NWP como uma extensão.

■ Clique em Merge Palette para mesclar uma paleta de um arquivo
NWP na cena atual. Isso é como anexar, mas ao invés de adicionar e
renomear quaisquer materiais duplicados, irá mesclar ao sobrescrever
com materiais existentes do mesmo nome.

■ Clique em Save Palette As para salvar sua paleta atual de materiais
em um arquivo de paleta NWP no Autodesk Navisworks. Se você
salvar a cena atual usando o método Save usual em um arquivo NWF
ou NWD, a paleta também será salva, mas o arquivo NWP
independente é útil se deseja transferir materiais que tenha criado
em uma cena para outras cenas.

OBSERVAÇÃO Se você publicar um arquivo NWD usando a guia
Output ➤ painel Publish ➤ NWD, uma pasta _Presenter_Maps
será criada junto com o arquivo NWD. Esta pasta conterá quaisquer
materiais que não estão contidos no Presenter Runtime, que é utilizado
pelo Autodesk Navisworks Manage 2012 e Autodesk Navisworks Freedom
2012, para visualizar materiais.

■ Clique em Clear Palette para excluir todos os materiais da paleta
e também de todos os itens na cena.

Editar materiais do Presenter

Materiais de arquivo instalados não podem ser editados enquanto estiverem
nos arquivos, mas você pode editar materiais na paleta da cena. Os materiais
editados serão salvos com o modelo do Autodesk Navisworks em um arquivo
NWD ou NWF, ou em um arquivo de paleta NWP, ou eles podem ser
adicionados em seu arquivo do usuário, denominado My Materials.
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Para editar um material, clique duas vezes na paleta ou clique com o botão
direito do mouse nela e clique em Edit no menu de atalho. A caixa de diálogo
Material Editor é aberta, a qual irá variar para diferentes tipos de material.
Não é possível adicionar ou remover parâmetros em um material. Somente é
possível editar aqueles existentes. Portanto, é importante usar o tipo correto
de modelo de material para o material que você deseja editar. A caixa de diálogo
para textura procedural Breeze Block é mostrada abaixo e será utilizada
como um exemplo de como editar um material.

OBSERVAÇÃO Se o Presenterprofile no Options Editor (consulte Presenter
Page na página 875 para obter mais informações) estiver definido para Advanced,
existem mais guias e parâmetros para editar nesta caixa de diálogo. Em particular,
há as guias Reflectance, Transparency, Displacement e 2D Texture Space
, e no topo de cada guia há um tipo Shader , que permite alterar completamente
o tipo de material e todos os outros parâmetros.

Para editar a textura Breeze Block

1 Abra a janela Presenter e clique na guia Materials.

2 Expando o arquivo de materiais Recommended\Bricks, e clique duas
vezes em Breeze Block na paleta para abrir o Material Editor.
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3 Os três botões no topo determinam que tipo de visualização de material
você recebe:

■ Clique em Standard Preview  para obter uma visualização
fotorrealista gerada por software do material na bola padrão contra
um plano de fundo xadrez. Apesar de não ser interativa, a visualização
irá mostrar como o material irá se parecer quando renderizado
fotorrealisticamente.

■ Clique em Active Preview  para obter uma visualização OpenGL
interativa do material na bola padrão contra um plano de fundo
xadrez. Esta é atualizada interativamente enquanto você altera os
parâmetros. A visualização irá refletir a qualidade do material exibido
no Autodesk Navisworks durante a navegação, mas a qualidade não
será tão alta quanto uma renderização fotorrealista.

■ Clique em Main Window Preview  para fechar a janela de
visualização no Material Editor e, em vez disso, visualizar o material
no item da Scene View. Esta é atualizada interativamente enquanto
você altera os parâmetros. A visualização irá representar o material
mostrado no Autodesk Navisworks durante a navegação, mas a
qualidade não será tão alta quanto uma renderização fotorrealista.

4 Para um material simples, somente há uma guia Material no Material
Editor, enquanto para um material de textura, seja procedural (gerada
de um algoritmo) ou de bitmap (gerada de uma imagem), há uma guia
extra denominada Texture.
■ A guia Material contém parâmetros simples que afetam a cor, escala

e brilho do material, e assim por diante. No caso do Breeze Block,
existem parâmetros para a escala geral do material, assim como a
largura e altura de um bloco, a cor do bloco e da argamassa, sua dureza
e reflexão. Para texturas de bitmap, é preciso definir a localização da
imagem na caixa Image File Name. Um material envidraçado,
outros fatores podem afetar as propriedades de transparência e refração
do vidro. Alguns desses fatores não ficarão aparentes na janela
OpenGL interativa e terão que ser renderizados com o Render para
serem visualizados.

■ A guia Texture contém parâmetros que afetam especificamente as
propriedades de mapeamento de textura de um material de textura,
como sua rotação, deslocamento (origem) e escalas S- e T- (algumas
vezes chamadas U- e V-). Esses valores de parâmetro são aplicados
em relação a um ponto de origem (consulte Advanced Materials na
página 604 para obter mais informações). Há as caixas de seleção S- e
T- Reflect, que mostram a reflexão da imagem em um destes eixos
(ou ambos). Finalmente, há uma caixa de seleção Offset Center,
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que reposiciona a origem no centro da imagem (novamente, consulte
Advanced Materials na página 604 para obter mais informações). Ao
utilizar a Main Window Preview, as alterações de textura efetuadas
podem ser imediatamente feitas permitindo o posicionamento
interativo de materiais em um objeto.

5 A qualquer momento, clique em Apply para aplicar as edições de
parâmetro para o material na cena.

6 Clique em OK para manter as alterações ou em Cancel para descartar
quaisquer alterações efetuadas (desde a última vez que você clicou em
Apply ao menos).

Para criar uma textura utilizando a sua própria imagem

1 Expanda o arquivo de materiais Templates, e clique duas vezes no
material Plain Texture para adicioná-lo a paleta da cena, e para abrir
o Material Editor.

2 Na guia Material(ou guia Color, se estiver em um perfil Developer)
clique no botão Browse (...) próximo da caixa de texto Image File
Name. A caixa de diálogo Open Image File é aberta.
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3 Procure e selecione o seu arquivo de imagem, e clique em Open.

4 Você pode então precisar ajustar alguns dos parâmetros de textura do
novo material, por exemplo, sua escala, rotação, deslocamento ou reflexão
(se estiver de trás para frente). Estes podem ser editados na guia Texture.
Consulte Editar materiais do Presenter na página 600 para obter mais
informações.

Materiais avançados

Internamente, um material é definido por quadro sombreador de diferentes
classes: Color, Transparency, Reflectance e Displacement. Cada classe
de sombreador controla um aspecto diferente do comportamento do material.
Há muitos tipos de sombreadores em cada classe, cada tipo sendo definido
por seu conjunto próprio de parâmetros.
■ Um sombreador Color é utilizado para definir a cor de uma superfície em

qualquer ponto no espaço. Ela pode ser tão simples como uma cor comum
que especifica todas as partes da superfície para que tenham uma cor
uniforme, ou pode definir padrões de superfície complexa como mármore
ou madeira. Cada material precisa ter um sombreador de cor.
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■ O comportamento de uma superfície na presença da luz é representado
por um sombreador de reflexão , que define quanta luz é refletida pela
superfície em direção ao visualizador. Os sombreadores desta classe podem
ser conhecidos como definindo o "acabamento" de uma superfície, e são
usados para propriedades de modelo como opaco, metal e plástico.

■ Um sombreador de transparência é utilizado para definir quão
transparente ou opaca é uma superfície e, portanto, quanto de luz pode
passar através dela. Os sombreadores de transparência variam de uma
simples transparência uniforme para padrões regulares complexos ou
irregulares com erosão, que seriam mais difíceis de serem representados
utilizando técnicas de modelagem. Um material sem um sombreador de
transparência é completamente opaco.

■ Pequenos distúrbios da superfície podem ser suportados por meio de
sombreadores de deslocamento. Normalmente, um sombreador de
deslocamento irá fornecer uma superfície suave e uma aparência irregular
ou indentada. Os sombreadores de transparência são utilizados para
representar recursos que seriem difíceis, impossíveis ou ineficientes, se as
técnicas convencionais de modelagem fossem utilizadas. Por exemplo, a
fundição de metal duro e as indentações irregulares produzidas por folha
de metal prensada podem ser simuladas.

Normalmente, o Material Editor exibe uma seleção dos parâmetros mais
importantes de todos os sombreadores na guia Materials. Se o perfil do
usuário está definido como Developer na interface  nó no Options Editor
(consulte a Página do Presenter na página 875), então todos os quatro
sombreadores podem ser editados e alterados individualmente.

Alguns sombreadores são descritos como "embalados". Estes definem um
material de duas dimensões plano, como um papel de parede. Os materiais
abaulados precisam de um sombreador de espaço de textura para definir
como deveriam ser aplicados (embalados em torno) em um objeto
tridimensional. Os materiais que incluem um sombreador embalado também
podem incluir um sombreador de espaço de textura. Um tipo especial de
sombreador de espaço de textura, denominado um sombreador de layout,
pode ser utilizado para transformar (rotacionar, esticar, deslocar) o material
bidimensional antes de ele ser aplicado ao objeto tridimensional. As
transformações tem base em torno de um ponto de origem, o qual por padrão,
é o canto superior esquerdo da imagem (consulte o diagrama abaixo, onde a
imagem está inscrita no quadrado vermelho, o que é então repetido. A origem
padrão é o Point 1). A seleção da caixa de seleção Offset Center irá
reposicionar a origem do centro da imagem (Point 2). Finalmente, no perfil
Developer , é possível editar o Decal Mode, escolhendo entre Default ou
Normalized. Selecionar Normalized irá mover a origem para o canto inferior
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esquerdo da imagem (Point 3, com a opção Offset Center desmarcada).
Com Normalized e Offset Center selecionadas, a origem será reposicionada
no centro da imagem repetida, diretamente abaixo do (Point 4).

Na janela Presenter, materiais que incluem um sombreador embalado também
têm um sombreador de espaço de textura de layout associado com eles. Os
sombreadores de espaço de textura normal são associados com objetos.

OBSERVAÇÃO Um completo manual de referência para todos os tipos de
renderização é incluído com a API do Autodesk Navisworks (consulte
\API\COM\documentation\shaders.chm). A API do Autodesk Navisworks é incluída
com o Autodesk Navisworks Manage 2012; é um recurso opcional no instalador,
e é instalada por padrão na subpasta API na pasta de instalação do Autodesk
Navisworks.

606 | Capítulo 13   Criar visualizações fotorrealistas



Utilizar luzes do Presenter

Guia Lighting

Como as guias Materials na página 594, Effects na página 626 e Rendering na
página 633, a guia Lighting é dividida em dois painéis, com os arquivos à
esquerda e a paleta à direita. O arquivo contém luzes individuais, assim como
estúdio de luz. Um estúdio de luz é uma combinação de luzes que funcionam
bem juntas. A paleta contém todas as luzes que estão ativas na cena.

Para aplicar uma luz na cena, arraste-a de um arquivo para a paleta, em qual
ponto é possível editar seus parâmetros, se necessário. A luz é adicionada as
já existentes na cena.

Para aplicar um estúdio de luz na cena, arraste-o de um arquivo para a paleta.
Todas as luzes no estúdio de luz substituem as luzes já existentes na cena. Os
estúdios de luz são aplicados de forma inteligente na cena. O estúdio de luz é
orientado e dimensionado para coincidir com a cena no qual está sendo
aplicado. Você também pode expandir um estúdio de luz no arquivo e arrastar
as luzes individualmente para a paleta. Caso você faça isso, as luzes não são
orientadas ou dimensionadas para coincidir com a cena.

Cada luz tem uma caixa de seleção na cena para acender ou apagá-la.

Utilizar luzes do Presenter | 607



Adicionar e posicionar luzes

As luzes e estúdios de luz podem ser tirados diretamente dos arquivos e
aplicados no modelo ao soltá-los na paleta. Estes então podem ser
reposicionados como necessário.

O arquivo Recommended contém cinco luzes (Ambient, Distant, Eye,
Point e Spot), um Standard Light Studio, um Environment Light
Studio, uma pasta Environment contendo duas luzes Environment
utilizando origens de luz com base em HDRI (consulte Iluminação com base
na imagem na página 619 para obter mais informações), e uma pasta Exterior
com diferentes localizações de cidades ao redor do mundo, cada uma contendo
três estúdios de luz (Clear Sky, Overcast Sky e Sun Study).

Se você estiver criando uma renderização externa de um edifício, por exemplo,
então poderá verificar que um dos estúdios de luz Environment pode fornecer
um efeito bastante realista, utilizando a iluminação com base na imagem para
iluminar o modelo. Os estúdios de luz Exterior também podem fornecer o
efeito que precisa. No entanto, estes utilizam luzes fisicamente precisas, o que
geralmente toma mais tempo para renderizar a cena.

Alternativamente, você pode preferir utilizar o Standard Light Studio como
um ponto de partida e desenvolver sua própria iluminação dali, adicionando
combinações da luzes básicas recomendadas para criar o efeito desejado.

O arquivo Standard contém um estúdio Default Eye Light (o que de fato
está renderizando uma luz direcional); uma pasta Environmental; uma pasta
de estúdios de luz Exterior, que predominantemente consistem de estúdios
de luz que usam um número de luzes para replicar o efeito de uma luz Sky.
Não usar luzes fisicamente precisas significa que não é necessário ativar Auto
Exposure (consulte Auto Exposure na página 637) , o que pode impactar
negativamente nas configurações básicas de luz recomendadas; um pasta de
estúdios de luz Interior para utilização em cenas internas; uma pasta de
estúdios de luz Object que são melhor adequados para iluminar modelos
menores, como um veículo ou uma peça de maquinário, por exemplo; e um
pasta de estúdios de luz Projector, que podem ser utilizados para projetar
uma imagem em um objeto na cena; e uma pasta Simple Sky .

O arquivo Templates contém todos os sombreadores de luz básica que estão
disponíveis. Estes podem então ser editados (como podem ser editadas todas
as luzes) para criar a iluminação exata que você requer (consulte Editar luzes
na página 612 para obter mais informações).
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Para adicionar luzes no modelo

1 Abra a janela Presenter e clique na guia Lighthing.

2 No painel esquerdo, selecione a luz que deseja adicionar à cena.

3 Arraste a luz e solte-a na paleta (painel direito da guia Lighting). Esta
será automaticamente adicionada na cena.

OBSERVAÇÃO Se você arrasta um estúdio de luz para a paleta, este irá
substituir quaisquer luzes existentes pelas luzes que compõem o estúdio de
luz.

Com uma regra geral, quanto mais luzes houverem na cena, mas tempo
levará para renderizá-la como foto realismo. Para cenas renderizadas
externamente, você pode considerar utilizar o Standard Light Studio
do arquivo Recommended como um ponto de partida, e a seguir
adicionar estrategicamente algumas luzes Point e Spot em torno da
cena. As luzes Point são boas para iluminar uma área escura da cena,
enquanto as luzes Spot podem adicionar um elemento de drama e
aprimorar o realismo.

Para posicionar ou reposicionar luzes no modelo

1 Abra a janela Presenter e clique na guia Lighthing.

2 Na paleta (painel direito da guia Lighting), clique com o botão direito
na luz que deseja reposicionar, e clique em Edit no menu de atalho.

3 Utilize o Light Editor para posicionar a luz, como necessário.

As luzes Point, Distant, Spot e Projector possuem um parâmetro
Location. As luzes Distant e Spot adicionalmente possuem um
parâmetro To. Você pode digitar as coordenadas X, Y e Z para estas, ou
alternativamente utilizar o botão Pick para selecionar interativamente
um ponto na cena onde a luz e/ou alvo está localizada. A luz é
representada por um ícone de sol de estrutura de arame 3D na cena e o
alvo por uma esfera de estrutura de arame. A luz selecionada no momento
é desenhada na cor de seleção (consulte Página Selection na página 813
para obter mais informações).

OBSERVAÇÃO O Autodesk Navisworks não permite selecionar um ponto
no espaço vazio; portanto, é preciso selecionar um ponto no modelo.

4 As luzes podem ser posicionadas interativamente. O ícone de sol de
estrutura de arame 3D, representando a luz, tem seis barras se estendendo
ao longo dos eixos X, Y e Z. Passe o cursor do mouse sobre uma das
barras. O cursor irá mudar para uma mão e as barras irão se estender mais
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ao longo daquele eixo. Mantenha pressionado o botão esquerdo do
mouse para segurar a luz e para movê-la em qualquer direção ao longo
da barra estendida. Solte o botão esquerdo do mouse para soltar a luz
em sua nova posição. Isso pode ser executado para todos os três eixos.

5 As luzes também podem ser posicionadas na localização atual da câmera,
que pode ser em qualquer lugar na cena. Navegue para a localização onde
deseja que a luz seja posicionada. Clique com o botão direito na paleta
(painel direito da guia Lighting) , e clique em Position as Camera
no menu de atalho.

OBSERVAÇÃO Isso não somente irá posicionar a luz na mesma localização
da câmera, se a luz tem um parâmetro To , mas também será definida para
o ponto focal (ou Look At) da câmera.

Organizar e gerenciar luzes

Gerenciar pastas

Você pode organizar as luzes em pastas personalizadas para a fácil referência
e gerenciamento. Ao fazer isso, você está de fato personalizando um arquivo
de usuário. Para obter mais informações, consulte Utilizar os arquivos do
Presenter na página 589.

A paleta Lighting

Na guia Lighting, painel direito, ou paleta de iluminação, é onde você edita
e gerencia suas luzes para sua cena. As luzes são tiradas do arquivo e colocados
na paleta onde elas são editadas.

Para adicionar uma pasta personalizada

1 Abra a janela Presenter e clique na guia Lighthing.

2 Clique com o botão direto na pasta My Lighting no painel esquerdo,
e clique em New Directory no menu de atalho.

3 Expanda a pasta My Lighthing, e clique com o botão direito do mouse
na nova pasta, e clique em Rename no menu de atalho.

4 Digite o novo nome, por exemplo “GGK Project”.
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Para excluir uma pasta personalizada

1 Na janela Presenter, guia Lighthing, expanda a pasta My Lighthing
no painel esquerdo, e clique com o botão direito na pasta que deseja
excluir.

2 Clique em Delete no menu de atalho.

Para copiar efeitos de iluminação em uma pasta personalizada

1 Na janela Presenter, guia Lighting, clique em um efeito de iluminação
no painel direito, e arraste-o para a localização desejada na pasta My
Lighting no painel esquerdo até que um cursor do mouse apresente
um pequeno sinal de mais.

2 Solte o botão esquerdo do mouse para soltar o efeito de iluminação na
pasta.

OBSERVAÇÃO Você também pode copiar os efeitos de iluminação entre as
pastas no painel esquerdo ao arrastar e soltá-los, ou utilizando as opções
Copy e Paste no menu de atalho.

Para gerenciar as luzes na paleta

1 Clique com o botão direito do mouse no painel no lado direito da guia
Lighthing (a paleta).
■ Clique em Copy para copiar a luz para a área de transferência. Clique

com o botão direito do mouse em um espaço vazio na paleta e clique
em Paste para colar uma cópia da luz com o mesmo nome com
sufixo do próximo número na lista.
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■ Clique em Delete para excluir a luz da paleta. Isso também irá
remover a luz da cena.

■ Clique em Rename para renomear a luz. Você também pode
selecionar a luz e pressionar F2 para renomeá-la.

■ Clique em Edit, ou clique duas vezes em uma luz para abrir a caixa
de diálogo Light Editor, permitindo editar seus parâmetros.
Consulte Editar luzes na página 612 para obter mais informações.

■ Clique em Clear Palette para excluir todos as luzes da paleta e,
portanto, da cena.

Editar luzes

Você pode editar a luz na paleta ao clicar duas vezes nela, ou ao clicar com o
botão direito do mouse e escolher Edit no menu de atalho.

Há seis tipos de luzes visíveis nas renderizações OpenGL interativas e nas
renderizações fotorrealistas.
■ As luzes Ambient fornecem uma luz geral de segundo plano para a cena

e, portanto, somente têm os parâmetros Intensity e Color.

■ Luzes Distant são direcionais e, portanto, têm uma localização e um alvo.
No entanto, a localização e alvo meramente definem um eixo no qual a
luz brilha, como estes tipos de luzes são infinitamente distantes e seus
feixes são paralelos. Assim como os parâmetros Intensity e Color, elas
também podem projetar sombras em uma renderização fotorrealista.

■ As luzes Eye estão localizadas no ponto de vista e também somente têm
os parâmetros Intensity e Color.

■ Luzes Point têm uma localização mas brilham em todas as direções. Elas
também têm Intensity e Color e adicionalmente podem projetar
Shadows (somente disponível em uma renderização fotorrealista
completa).

■ As luzes Spot também são direcionais e, portanto, têm uma localização e
um alvo, assim como os parâmetros Intensity e Color, e parâmetros de
sombra. Além disso, elas também têm parâmetros para afetar o Fall Off
e Cone Angle da luz, já que estes tipos de luz não estão infinitivamente
distantes, portanto, elas espalham sua luz sobre um cone e a intensidade
diminui quando longe da luz.

■ Sun simula a luz do sol. A orientação de seu modelo é definida pelas
direções North e Up. A posição do sol é especificada como Azimuth e
Altitude. Se o Mode do sol inclui Position, é possível inserir a sua
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localização na terra, o Time (usando o fuso horário local), data e o
Presenter irão calcular o azimute e altitude do sol para você. Se o Mode
do sol inclui Intensity, o Presenter também irá calcular uma intensidade
precisa para o sol com base na posição, hora do ano e condições
atmosféricas.

Há três tipos adicionais de luzes visíveis somente em renderizações
fotorrealistas.
■ Luzes Projector são utilizadas para projetar uma imagem em superfícies.

Você pode definir o arquivo da imagem a ser projetada.

■ Sky simula a iluminação do céu (mas não a contribuição direta devida ao
próprio sol). A orientação de seu modelo é definida pelas direções North
e Up. A posição do sol é especificada como Sun Altitude e Sun Azimuth.
Embora a contribuição direta do sol não esteja incluída, sua localização irá
determinar a aparência do hemisfério do céu. Se Intensity for deixada
em 0, o Presenter irá calcular uma intensidade precisa para você com
base na posição do sol.

■ Luzes Goniometric podem emitir quantidades bem variadas de energia
de luz em diferentes direções. Uma origem goniométrica iria se comportar
exatamente como uma luz puntiforme, outra poderia se comportar
exatamente como uma luz de spot, uma terceira poderia parecer com
nenhuma destas. Uma luz goniométrica obtém sua função de distribuição
de intensidade (quanto de luz vai em qualquer uma direção) de um arquivo
padrão da indústria. O Presenter suporta arquivos CIE, IES, CIB, e LDT.

OBSERVAÇÃO  Um manual de referência completo para todos os tipos de luzes
é incluído com a API do Autodesk Navisworks (consulte
\API\COM\documentation\shaders.chm). A API do Autodesk Navisworks é incluída
com o Autodesk Navisworks Manage 2012; é um recurso opcional no instalador,
e é instalada por padrão na subpasta API na pasta de instalação do Autodesk
Navisworks.

Cada tipo de luz tem seus próprios parâmetros, e o editor para Point Light
é aqui mostrado:
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As luzes puntiformes, de spot e de projetor têm um parâmetro Location.
Luzes distantes e de spot adicionalmente têm um parâmetro To. Consulte
Adicionar e posicionar luzes na página 608 para obter mais informações.

OBSERVAÇÃO Se o perfil do Presenter noOptions Editor (consulte Página
Presenter na página 875 para obter mais informações) estiver definido como
Advanced, a caixa de diálogo irá incluir uma lista completa dos parâmetros
disponíveis e irá permitir alterar o tipo de luz.
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As luzes puntiformes, distantes, spot, sol, projetor e goniométrica têm o
parâmetro Shadows. Consulte Projetar sombras na página 615 para obter mais
informações.

Editar parâmetros na caixa de diálogo irá alterar interativamente a cena com
estas alterações.

A qualquer momento, clique em Apply para aplicar as edições de parâmetro
para a luz na cena.

Você pode salvar uma luz editada para ser utilizada em outras cenas, ao
arrastá-la para o arquivo do usuário My Lighting.

Projetar sombras

Selecionar a caixa de seleção Shadows no Light Editor de uma luz que
suporta sombras (puntiforme, distante, spot, céu, sol, projetor e goniométrica)
resulta na luz selecionada projetando sombras na cena. As sombras somente
serão visíveis em renderizações fotorrealistas, a não ser que você esteja
utilizando uma placa gráfica em conformidade com o OpenGL 1.5 com
aceleração por hardware, em cujo caso, é possível visualizar as sombras
interativas. Consulte Página Presenter na página 875 para obter detalhes sobre
como exibir sombras e iluminação interativas.

OBSERVAÇÃO Ativar sombras em luzes deve ser levada na devida consideração.
Se você ativar sombras em todas as luzes, então poderá achar o efeito muito
confuso e de certa forma não natural, especialmente se houverem muitas luzes
em uma cena pequena. Isto também afetará o desempenho, durante a navegação
e atualização em geral da Scene View. Você pode desejar considerar somente
ativar sombras para algumas poucas luzes estrategicamente posicionadas, para
criar o efeito que precisa.

Além de escolher quais luzes em seu modelo irão projetar sombras, você
também pode selecionar quais itens da geometria no modelo devem projetar
uma sombra. Cada item na cena tem sua própria opção para projetar sombra.

Para definir a projeção de sombra da Scene View

■ Clique com o botão direito em um item na Scene View, clique no
Presenter no menu de atalho, clique em Shadows, e clique na opção de
projetar sombra que desejar.
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As opções disponíveis de projetar sombra para um item de geometria são:

■ On. Escolha essa opção para ativar sombras. O item selecionado irá
projetar uma sombra de qualquer origem de luz que tenha Shadows
ativado.

■ Off. Escolha essa opção para desativar sombras. O item selecionado
não irá projetar uma sombra de qualquer origem de luz.

■ Inherit. Escolha essa opção para herdar a opção de projetar sombra
do item principal. Ou seja, o item selecionado irá utilizar a mesma
opção do item diretamente acima dele no caminho da Selection Tree
(consulte Janela Selection Tree na página 362 para obter mais
informações). Por exemplo, se você selecionar On para projeção de
sombras para um grupo, e a geometria contida naquela camada é
definida para Inherit, então a geometria também irá projetar sombras,
já que ela herda a opção On do principal (o grupo).

OBSERVAÇÃO Se todos os itens na cena estão definidos como Inherit ,
então a configuração padrão é On.

OBSERVAÇÃO O item selecionado irá depender de sua configuração de
Selection Resolution. Consulte Definir a resolução de seleção na página 369
para obter mais informações.

Para definir a projeção de sombra da Selection Tree

■ Clique com o botão direito em um item na Selection Tree, clique no
Presenter no menu de atalho, clique em Shadows, e clique na opção de
projetar sombra que desejar.

As opções disponíveis de projetar sombra para um item de geometria são:

■ Off. Escolha essa opção para desativar sombras. O item selecionado
não irá projetar uma sombra de qualquer origem de luz.

■ On. Escolha essa opção para ativar sombras. O item selecionado irá
projetar uma sombra de qualquer origem de luz que tenha Shadows
ativado.

■ Inherit. Escolha essa opção para herdar a opção de projetar sombra
do item principal. Ou seja, o item selecionado irá utilizar a mesma
opção do item diretamente acima dele no caminho da Selection Tree
(consulte Janela Selection Tree na página 362 para obter mais
informações). Por exemplo, se você selecionar On para projeção de
sombras para um grupo, e a geometria contida naquela camada é
definida para Inherit, então a geometria também irá projetar sombras,
já que ela herda a opção On do principal (o grupo).
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OBSERVAÇÃO Se todos os itens na cena estão definidos como Inherit ,
então a configuração padrão é On.

Iluminação avançada

Você pode utilizar o Presenter para aplicar efeitos de iluminação avançada.

Sombras suaves

O Presenter incluir sombras geradas a partir de mapas de sombras
pré-calculados para cada origem de luz que projeta sombras. A utilização do
mapa de sombra permite a rápida renderização de sombras com arestas suaves
ou graduadas. A resolução da sombra pode ser controlada para balancear o
desempenho e a qualidade da imagem.

As sombras suaves somente são adequadas para utilização com modelos
pequenos e são desativadas por padrão. Para modelos grandes, a geração dos
mapas de sombra pode utilizar quantidades excessivas de tempo e memória.
As sombras suaves geradas para modelos grandes são com frequência muito
vagas e dispersas sem a utilização de uma resolução excessivamente alta, que
utiliza ainda mais memória e tempo.

Luzes fisicamente precisas

Por padrão, o Presenter utiliza luzes sem unidades ou intensidades empíricas.
Estas são fisicamente insignificantes e são apenas escolhidas para fornecer um
resultado visual agradável. O Presenter também pode utilizar intensidades
fisicamente precisas. Estas são definidas em unidades reais, como Candela,
Lúmen ou Lux. No entanto, uma vez que você começa a utilizar luzes com
intensidades reais, começa a produzir imagens com uma variação real nos
valores de luminosidade.

Por padrão, o Presenter utiliza luzes cujas intensidades permanecem
constantes quando você se afasta mais da luz. No universo real, a intensidade
é reduzida proporcionalmente ao quadrado inverso da distância da luz. Alterar
o parâmetro Fall Off de uma luz para Inverse Square Law irá modelar com
mais precisão a dispersão de uma luz em intensidade. No entanto, uma vez
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que você começa a utilizar luzes com dispersão real, começa a produzir imagens
com uma variação real nos valores de luminosidade.

O mundo real, o olho humano é capaz de solucionar imagens com variações
extremas de condições de iluminação, variando do brilho solar intenso
refletindo da neve para uma ambiente iluminado somente por uma vela. Na
computação gráfica, entretanto, é preciso produzir uma imagem em um
dispositivo de exibição que tem uma faixa bem limitada de valores de
luminosidade. Portanto, é necessário comprimir a faixa de valores de
luminosidade encontradas em uma cena do mundo real para a faixa de exibição
que pode ser exibida, de uma forma que produza uma imagem que pareça
realista.

A fotografia, é claro, tem exatamente o mesmo problema. Se um fotógrafo (ou
câmera) não leva em contar os níveis de luz em uma cena antes de calcular a
exposição da foto, o resultado provável será uma imagem que está sobre-exposta
(tudo tem muito brilho) ou sob-exposta (tudo está muito escuro). Um fotógrafo
profissional também irá utilizar diferentes velocidades de filme para diferentes
condições e iluminação. O objetivo é o de produzir um imagem em filme de
como a cena seria se vista por um observador humano.

O Presenter inclui a opção Auto Exposure (consulte Auto Exposure na
página 637). Quando ativada, o Presenter irá renderizar a imagem duas vezes.
Uma para obter a amostra da faixa de valores de luminosidade na imagem de
saída, e na segunda vez para renderizar a imagem real com os valores de
luminosidade ajustados para coincidir com o comportamento do olho humano.

Em geral, ao utilizar luzes fisicamente precisas, a opção Auto Exposure
deveria estar ativada.

Luzes volumétricas

A iluminação volumétrica permite efeitos como a dispersão da luz, por névoa
ou fumaça, em uma cena. Para utilizar este efeito, selecione a caixa de seleção
Scattering em cada luz. Um efeito de Scattering Medium no primeiro
plano também precisa estar em uso (consulte Efeitos de primeiro plano na
página 632 para obter mais informações).

OBSERVAÇÃO Pode ser necessário ajustar os parâmetros Medium Density e
Medium Ambient do efeito Scattering Medium no primeiro plano para
adequar seu modelo. Caso nenhum efeito volumétrico esteja visível, a Medium
Density está muito baixa. Se a imagem renderizada está totalmente branca, a
Medium Density está muito alta.
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O médio padrão e branco puro. Opcionalmente, um sombreador de densidade
pode ser definido para qualquer sombreador sólido (não embalado), para criar
o efeito de um meio não-uniforme (não-homogêneo). Exemplos de
sombreadores que podem ser utilizados são o Blue Marble e Solid Clouds.
Um sombreador que tenha sido desenvolvido especificamente para este
propósito é o sombreador Turbulent.

Os pontos-chave ao utilizar a iluminação volumétrica, são:
■ Lembre-se de desativar o parâmetro Scattering de origens de luz se desejar

ver os seus efeitos volumétricos,

■ Utilize Medium Density e Medium Color para definir o brilho e cor
do meio iluminado.

■ Utilize um sombreador de cor sólida definido como o sombreador de
densidade para a simulação de variações de densidade no meio.

■ Diminua o parâmetro Error Bound , se a imagem parecer pontuada fora
das áreas de sombra.

■ Aumente o parâmetro Min LOD , se as áreas com sombras volumétricas
aparecem pontuadas.

■ Para visualizações rápidas, defina alto o parâmetro Error Bound e baixo
o parâmetro Min LOD.

■ Para melhores resultados, defina a opção Fall Off como Inverse Square
Law, e desative Auto Exposure.

Iluminação com base na imagem

A iluminação com base na imagem é onde uma imagem é utilizada para
iluminar uma cena. No mundo real, cada objeto é iluminado não somente
por origens de luz como o sol, lâmpadas, e assim por diante, mas também por
tudo em volta. Estando em pé no meio de uma rua, uma pessoa será iluminada
pelo sol, pelo céu azul, pelos edifícios marrons e pelo chão cinza. A emulação
desta forma de iluminação, claramente tem o potencial de criar imagem
incrivelmente realistas.

As imagens utilizadas neste método de iluminação dão um tipo especial de
imagem, denominado High Dynamic Range Image ou HDRI. Este tipo de
imagem tem a capacidade de iluminar uma cena com incrível precisão. Na
janela Presenter, uma HDRI é embalada em torno da cena como uma esfera,
e a cor e brilho da HDRI são projetadas no modelo 3D para iluminá-lo.
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Um modelo iluminado com luzes normais
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O mesmo modelo iluminado com iluminação com base na imagem

Você pode ver a diferença que esta forma de iluminação pode fazer em imagens
renderizadas. E a enorme vantagem disto, é que é muito mais fácil defini-la
do que a iluminação tradicional.

Para definir uma iluminação com base na imagem

1 Abra a janela Presenter e clique na guia Lighthing.

2 Expanda o arquivo Recommended no painel esquerdo da guia
Lighting.

3 Arraste o Environment Light Studio para a paleta na direita.

Isso substitui todas as luzes que estão na paleta por uma luz Ambient
e uma luz Environment contendo uma High Dynamic Range
Image.

4 Clique em Render para renderizar a cena utilizando a imagem padrão
contida nesta luz Environment. Este tipo de renderização pode levar
um pouco mais de tempo do que com métodos tradicionais de
iluminação, mas os resultados valem o tempo extra investido.

5 Para utilizar uma imagem de amostra alternativa, expanda a pasta
Environment no painel esquerdo para ver dois outros exemplos de
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luzes de ambiente; Sky e City. Arraste a luz City para o painel à direita
para substituir a luz Environment na paleta.

OBSERVAÇÃO Antes de renderizar, exclua a luz Environment da paleta
ou desmarque a caixa de seleção.

Para inserir manualmente uma nova HDRI

1 Abra a janela Presenter e clique na guia Lighthing.

2 Clique com o botão direito na luz Environment na paleta à direita, e
clique em Edit no menu de atalho.

3 No Light Editor, clique em Edit no campo Environment.

4 No Shader Editor, clique no botão Browse (...) no campo File Name,
e procure pelo arquivo HDR requerido.

OBSERVAÇÃO Para que isso funcione corretamente, esta HDRI precisa ser
uma HDRI Light Probe. HDRI Light Probe adicionais estão disponíveis em
diversos lugares na Internet, incluindo Dosch Design.

Clique em OK em ambas as caixas de diálogo para definir que a nova
imagem seja a origem da luz.

5 Na janela Presenter, clique em Render para produzir um cena
renderizada com nova iluminação.

Utilizar RCP's do Presenter

Guia RPC

O suporte ao RPC (Rich Photorealistic Content) na janela Presenter permite
adicionar uma cenário fotográfico em qualquer projeto 3D. Os arquivos RPC
podem ser comprados diretamente da ArchVision e, normalmente, vêm em
bibliotecas de conteúdo, variando de árvores e vegetação a pessoas. Eles também
vêm em diversos tipos.
■ RPCs 2D são fotografias 2D de direção única que sempre faceiam a câmera

e estão em um quadro único, parecendo a mesma de qualquer ângulo e
que não contém animação.

■ RPCs 3D são objetos que um alto número de quadros, permitindo que
câmera mova em torno do objeto para que este seja visto de todos os
ângulos.
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■ 2.5D RPCs são fotografias 2D animadas com uma única direção. Os RPCs
com animação somente podem ser visualmente animadas quando
exportados como uma animação renderizada.

■ RPcs 3.5D incluem animações e vistas de tudo em torno do objeto.

■ RPCs 3D+ , com frequência denominados de Smart Content, no momento
não são suportados.

Um exemplo de pessoa RPC em e ao redor de uma construção.

O benefício chave de utilizar o conteúdo RPC, é o de que somente leva um
pequeno período de tempo para preencher a cena com conteúdo realista, e
ele adiciona muito pouco no tempo de renderização.

OBSERVAÇÃO Enquanto navega pela cena, os RPCs sempre irão virar para a
câmera. Se um RPC for 3D ou 3.5D, clicar com o botão direito na Scene View,
e clicar em Refresh no menu de atalho, irá defini-lo para o quadro correto com
base na posição atual da câmera. Renderizar a cena sempre irá atualizar todos os
RPCs.
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IMPORTANTE Ao publicar uma cena utilizando a caixa de diálogo Publisher,
qualquer RPC incluído naquela cena não é publicado para o diretório
_Presenter_Maps ou embutidos no arquivo NWD. O tamanho dos arquivos, e
o fato de que a maioria dos RPCs são licenciados, no momento proíbe isso.

Como as guias Materials na página 594, Lighting na página 607, e Rendering na
página 633, a guia RPC é dividia em dois painéis, com os arquivos à esquerda
e a paleta à direita. Esta guia é onde você configura os RPCs.

Para adicionar um RPC em uma paleta

1 Abra a janela Presenter e clique na guia RPC.

2 No painel esquerdo, expanda o arquivo Templates, e arraste o ícone
RPC para a paleta na direita.

3 Clique duas vezes no ícone RPC na paleta.

4 No RPC Editor, clique no botão Browse (...) no campo File Name.
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5 Na caixa de diálogo Open RPC File , localize o arquivo RPC desejado,
e clique em Open. O Autodesk Navisworks tem uma pequena seleção
de arquivos de exemplo de RPC grátis na área de recursos do DVD do
produto. Você pode utilizá-los para criar uma cena simples com algumas
pessoas, vegetação e árvores.

6 Ajuste as configurações no RPC Editor como necessário, e clique em
OK.

Para adicionar um RPC no modelo

1 Abra a janela Presenter e clique na guia RPC.

2 Para adicionar um RPC no modelo, clique com o botão direito no ícone
RPC desejado na paleta e selecione Add Instance , que fornece um
cursor alvo com o qual então se pode clicar em uma localização na Scene
View, ou clique com o botão esquerdo e arraste o ícone RPC da paleta
para a posição desejada Scene View.

3 Clique em Render para ver como o efeito RPC se parece na cena.
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Para mover um RPC

■ Clique com o botão direito do mouse no RPC que deseja mover na Scene
View, e clique em Pick Position no menu de atalho. Isto altera o cursor
para um alvo para a seleção de uma localização alternativa.

Para editar um RPC

1 Abra a janela Presenter e clique na guia RPC.

2 Clique duas vezes no RPC requerido na paleta.

3 Utilize o RPC Editor  para ajustar as configurações, como necessário.
Por exemplo, você pode utilizar Rotation para definir a direção na qual
as pessoas estão faceando, ou pode alterar o tamanho de Scale.

4 Clique em OK.

Para excluir um RPC

■ Clique com o botão direito do mouse no RPC que deseja excluir na Scene
View, e clique em Delete no menu de atalho.

Utilizar efeitos de renderização do Presenter

Guia Effects

Como as guias Materials na página 594, Lighting na página 607, e Rendering na
página 633, a guia Effects é dividia em dois painéis, com os arquivos à esquerda
e a paleta à direita. Esta guia é onde você define diferentes efeitos para o
segundo plano e o primeiro plano.
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Você somente pode ter um efeito de segundo plano e um de primeiro plano
de cada vez na paleta.

OBSERVAÇÃO Um completo manual de referência para todos os tipos segundo
plano, primeiro plano e estilos de renderização é incluído com a API do Autodesk
Navisworks (consulte \API\COM\documentation\shaders.chm). A API do Autodesk
Navisworks API é incluída com o Autodesk Navisworks Manage 2012 é um recurso
opcional no instalador, e é instalada por padrão na subpasta API na pasta de
instalação do Autodesk Navisworks.

Efeitos de segundo plano

Os efeitos de segundo plano alteram o segundo plano da imagem quando
renderizada, e incluem cores normais, cores graduadas, nuvens procedurais e
arquivos de imagem (lado-a-lado ou dimensionados).

A maioria dos segundos planos podem ser renderizados interativamente no
OpenGL, portanto, você terá uma boa visualização de como o segundo plano
será completamente renderizado.

Clique duas vezes em um efeito na paleta para abrir o Background Editor.
Cada editor será diferente para cada tipo de segundo plano. O editor Scaled
Image é aqui mostrado:
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OBSERVAÇÃO Se o perfil Presenter no Options Editor (consulte Página
Presenter na página 875 para obter mais informações) estiver definido como
Advanced, a caixa de diálogo incluirá uma lista completa de parâmetros
disponíveis e permitirá alterar o tipo de plano de fundo.

No Background Editor, você pode mudar de segundo plano ao clicar no
botão Browse (...) próximo do campo File Name e abrir uma nova imagem
como o segundo plano.

A edição de parâmetros no Background Editor irá alterar interativamente
a cena com estas alterações. A qualquer momento, clique em Apply para
aplicar as edições do parâmetro na cena.

Você pode salvar um segundo plano editado para ser utilizado em outras cenas,
ao arrastá-lo para a pasta Backgrounds dentro do arquivo do usuário My
Effects.

Segundo plano e reflexões de ambiente

O segundo plano de ambiente é um tipo especial de segundo plano que se
move com o modelo e permite reflexões de partes refletivas do modelo.

O segundo plano de ambiente não somente torna mais realista a aparência da
cena para imagens estáticas do modelo, mas transforma completamente o
efeito de realismo nas animações. Isso porque na vida real, ao mover um objeto
em torno do segundo plano, o ambiente também muda. Por exemplo, ao olhar
para o topo de um edifício, o segundo plano será o céu, mas em uma vista
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aérea do edifício teremos os edifícios circundantes ou paisagismo como o
segundo plano.

Outro benefício de utilizar um segundo plano de ambiente é o de que as
propriedades de reflexão de materiais no modelo, podem refletir o ambiente
(por exemplo, ao olhar para cima, em direção ao topo do edifício com fachada
envidraçada, o céu é refletido no vidro).
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O segundo plano de ambiente é uma imagem embalada em trono do modelo.
As imagens recomendadas para utilização são mapas cruzados verticais. Estas
imagens são automaticamente colocadas no lado de dentro de um cubo e a
seguir circunda a cena. Devido a natureza do recurso, as arestas e cantos se
tornam não distinguíveis.circunda Uma ampla variedade de mapas de ambiente
estão disponíveis para compra na Internet.

A definição de um segundo plano de ambiente consiste em dois componentes:
a imagem do segundo plano, como o céu sobre o deserto, e o ambiente que
armazena a imagem de segundo plano.

Para adicionar um efeito de segundo plano

1 Abra a janela Presenter e clique na guia Effects.
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2 No painel esquerdo, expanda o arquivo Recommended, e escolha o
efeito de segundo plano desejado.

3 Arraste o segundo plano escolhido para a paleta no lado direito.

A maioria dos segundos planos podem ser renderizados interativamente
no OpenGL, portanto, você terá uma boa visualização de como o segundo
plano será completamente renderizado.

4 Clique em Render para aplicar o segundo plano no modelo.

Para editar um efeito de segundo plano

1 Abra a janela Presenter e clique na guia Effects.

2 Clique duas vezes no segundo plano requerido na paleta.

3 Use o Background Editor para ajustar as configurações, como
necessário.

Cada editor será diferente para cada tipo de segundo plano.

4 Clique em OK.

Para adicionar um segundo plano de ambiente

1 Abra a janela Presenter e clique na guia Effects.

2 No painel esquerdo, expanda o arquivo Recommended, abra a subpasta
Environments, e a seguir abra a pasta Panorama.

3 Arraste o efeito Sky para a paleta na direita.

O segundo plano ainda não está visível na Scene View.

4 Retorne para o arquivo Recommended, abra a subpasta Backgrounds,
e arraste o efeito Environment para a paleta.

O segundo plano agora está visível. Isso se dá porque este tipo de segundo
plano é feito de duas partes, a imagem Sky e o sombreador de segundo
plano Environment que aponta na imagem. Os dois elementos são
automaticamente vinculados.
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Após isso ser completado, ao mover em torno do modelo você verá o segundo
plano de movendo apropriadamente em tempo real. Com uma placa gráfica
moderna, se houver superfícies reflexivas na cena, a definição do
PresenterHardware Shading no Options Editor como Lighting , irá
mostrar o novo segundo plano definido refletido em tais superfícies (consulte
Página Presenter na página 875).

DICA Clique em Render para exibir este segundo plano na saída fotorrealística.

Efeitos de primeiro plano

Os efeitos de primeiro plano alteram o primeiro plano da imagem quando
renderizada, e incluem os efeitos de névoa e neve. Nenhum deste efeitos estão
disponíveis como uma visualização interativa e somente podem ser vistos
quando uma renderização completa é feita.

Adicionar efeitos de primeiro plano é similar à adicionar efeitos de segundo
plano. Clique duas vezes em um efeito na paleta para abrir o Foreground
Editor. Cada editor será diferente para cada tipo de primeiro plano. O editor
Fog é aqui mostrado:
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OBSERVAÇÃO Se o perfil Presenter no Options Editor (consulte Página
Presenter na página 875 para obter mais informações) estiver definido como
Advanced, a caixa de diálogo irá incluir uma lista completa dos parâmetros
disponíveis e irá permitir alterar o tipo de primeiro plano.

A qualquer momento, clique em Apply para aplicar as edições do parâmetro
na cena.

Você pode salvar um primeiro plano editado para ser utilizado em outras cenas,
ao arrastá-lo para a pasta Foregrounds dentro do arquivo do usuário My
Effects.

Utilizar estilos de renderização do Presenter

Guia Rendering

Como as guias Materials na página 594, Lighting na página 607, e Effects na
página 626, a guia Rendering é dividia em dois painéis, com os arquivos à
esquerda e a paleta à direita. Esta guia está onde você seleciona em qual estilo
e como deseja que a cena seja renderizada. Cada arquivo tem um número de
diferentes estilos de renderização entre os quais escolher um.
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OBSERVAÇÃO Um completo manual de referência para todos os tipos de
renderização é incluído com a API do Autodesk Navisworks (consulte
\API\COM\documentation\shaders.chm). A API do Autodesk Navisworks API é
incluída com o Autodesk Navisworks Manage 2012 é um recurso opcional no
instalador, e é instalada por padrão na subpasta API na pasta de instalação do
Autodesk Navisworks.

Estilos de renderização

Os estilos de renderização afetam a forma com a qual a cena é renderizada
quando um renderização fotorrealista completa é feita (ao clicar em Render).
Nenhum destes efeitos estão disponíveis em uma visualização interativa.

Para definir um estilo de renderização, arraste o seu estilo escolhido para a
paleta no lado direito da guia.

Para editar seu estilo de renderização escolhido, clique duas vezes no estilo na
paleta. A caixa de diálogo Render Editor é aberta. Cada editor será diferente
para cada tipo de estilo de renderização. O editor High Quality é aqui
mostrado:
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OBSERVAÇÃO Se o perfil Presenter no Options Editor (consulte Página
Presenter na página 875 para obter mais informações) estiver definido como
Advanced, a caixa de diálogo irá incluir uma lista completa dos parâmetros
disponíveis e irá permitir alterar o tipo de primeiro plano.

A qualquer momento, clique em Apply para aplicar as edições do parâmetro
na cena.

Você pode salvar um estilo de renderização editado para ser utilizado em outras
cenas, ao arrastá-lo para o arquivo do usuário My Render Styles.

Estilos de renderização predefinidos

O arquivo Recommended contém três estilos de renderização predefinidos:
■ High Quality. Escolha este estilo de renderização para a saída renderizada

da mais alta qualidade. Isto inclui todas as reflexões e transparências e
suavização de serrilhado nas arestas, reflexões e sombras. Dos três estilos
de renderização recomendados, este é o que levará mais tempo para ser
renderizado. Este também é o estilo de renderização utilizado se nenhum
outro for escolhido. Utilize este estilo para a exportação final de sua saída
renderizada.
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■ Low Quality. Escolha este estilo de renderização para uma renderização
rápida e de baixa qualidade. Isto não inclui reflexões ou suavização de
serrilhado. Utilize este estilo se deseja ver com rapidez o efeito dos materiais
e iluminação que você aplicou na cena.

■ Medium Quality. Escolha este estilo de renderização para uma
renderização de qualidade média. Isto inclui todas as reflexões e
transparências e suavização de serrilhado somente nas sombras. Você pode
utilizar este estilo para uma visualização final da cena, antes de exportar
sua saída final renderizada.

O arquivo Standard contém muitos estilos de renderização que simulam
desenho a mão e outros estilos não fotorrealistas. Estes estilos utilizam uma
mistura de técnicas de renderização com base em sombras, vetores e imagens.
Eles são normalmente melhor adequados para modelos pequenos e imagens
de saída pequenas.

OBSERVAÇÃO Os estilos de renderização Standard requerem múltipos estágios
para renderizar a cena. Portanto, estes estilos podem tomar um tempo considerável
para renderizar.

O arquivo Templates contém cinco tipos principais de estilos de renderização,
que podem ser utilizados para definir seus próprios estilos de renderização:
■ Photorealistic (Raytrace). Este arquivo contém estilos de renderização

fotorrealistas, incluindo High Quality, Low Quality e Medium Quality
como o arquivo Recommended. Estes estilos de renderização são os mais
rápidos e utilizam menos memória onde partes grandes do modelo estão
obscurecidas de qualquer ponto de vista em particular. Por exemplo, quando
dentro de um ambiente em um edifício, as paredes do ambiente irão
obscurecer o resto do edifício da vista.

■ Photorealistic (Scanline). Este arquivo contém estilos de renderização
fotorrealistas, incluindo High Quality, Low Quality e Medium Quality
como o arquivo Recommended. Estes estilos de renderização são os mais
rápidos e utilizam menos memória onde a maioria do modelo está visível
de qualquer ponto de vista em particular. Por exemplo, ao renderizar uma
visão geral de um modelo de fábrica e processo, a maioria do modelo pode
ser visto, já que há menos paredes, ou similares, que possam obscurecer
sua vista.

■ Simple Shaded. Este modelo é um estilo de renderização sombreado
simples, onde recursos avançados como texturas e transparência não são
necessários.

■ Sketch. Este arquivo contém diversos estilos básicos de renderização de
croqui.
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OBSERVAÇÃO Os estilos de renderização Sketch requerem múltiplos estágios
para renderizar uma cena. Portanto, estes estilos podem tomar um tempo
considerável para renderizar.

■ Vector. Este modelo é um estilo de renderização de vetor, que irá renderizar
a cena em estrutura de arame.

Auto Exposure

Selecione a caixa de seleção Auto Exposure para renderizar a cena com brilho
e contraste balanceados. Isso é essencial ao utilizar a iluminação fisicamente
precisa, como a luz Sky ou Sun. Caso esteja adicionando uma destas luzes
em sua cena, você será solicitado a ativar Auto Exposure , caso já não esteja
ativada.

Utilizar o espaço de textura do Presenter
O espaço de textura descreve a forma pela qual uma textura é aplicado em um
item. Por exemplo, a aplicação de um espaço de textura cilíndrica em uma
tubulação, irá causar a renderização mais natural das texturas na tubulação.
Um espaço de textura de um item pode ter sido atribuído do aplicativo de
CAD original e armazenado no arquivo de CAD nativo, ou definido na janela
Presenter com as opções de Box, Plane, Cylinder ou Sphere. A opção
Explicit permite que um espaço de textura definido pelo usuário seja aplicado,
e estará disponível de um item tiver tido um espaço de textura aplicado ao
mesmo no aplicativo de CAD original. Cada opção do espaço de textura aplica
alguma geometria delimitante imaginária em torno do item e "embala" a
textura da melhor forma que conseguir à geometria sob esta geometria
delimitante.
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Se você aplicou um textura em um item, a janela Presenter irá tentar
estabelecer o melhor ajuste entre os quatro espaços de textura disponíveis.
Caso não seja esta sua intenção, então é possível editar o espaço de textura.

Para editar um espaço de textura

1 Selecione o item (consulte Seleção interativa da geometria na página 361
para obter mais informações) e siga para a guia Texture Space na janela
Presenter para escolher outro espaço de textura.

Alternativamente, clique com o botão direito em um item que possui
uma textura aplicada e clique em um novo espaço de textura no menu
de atalho Presenter ➤ Texture Space.

2 Você pode efetuar o ajuste fino do espaço de textura de um time ao clicar
em Edit na guia Texture Space da janela Presenter. O Texture
Space Editor relevante é aberto.

O editor de espaço de textura plana:
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Ou o editor de espaço de textura cilíndrica:

Ou o editor de espaço de textura esférica:
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3 Edite cada um dos parâmetros individuais e clique em Apply para
visualizar os resultados da edição. Clicar em Pick permite selecionar
interativamente um ponto no modelo ao invés de digitar individualmente
as coordenadas X-, Y- e Z-.

4 Clique em OK.

5 Após editado, você sempre pode redefinir um espaço de textura para a
versão definida pelo Autodesk Navisworks ao clicar em Reset na guia
Texture Space.

6 Clique em Ortho se você deseja que o Autodesk Navisworks alinhe o
espaço de textura com o eixo mais próximo.

7 Clique em Fit se você deseja que o Autodesk Navisworks ajuste uma
única repetição da textura para o item. Isso é de utilização particular
quando você estiver mapeando uma imagem para o tamanho exato do
item ao qual ela está sendo aplicada.

Utilizar regras do Presenter

Guia Rules

A guia Rules da janela Presenter permite aplicar materiais em modelos, de
acordo com determinados critérios definidos pelo usuário, ao invés de arrastar
e soltar os materiais em camadas, grupos ou componentes individuais. Por
exemplo, todas as camadas que sejam pisos podem ter uma material aplicado
denominado "floorboards", sem ter que manualmente arrastar e soltar o
material para cada piso de madeira. Cada vez que o modelo é atualizado, as
regras então só precisam ser reaplicadas, ao invés de manualmente reaplicar
os materiais a todos os itens.
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Todos os materiais podem ser salvos em um arquivo NWP "pallette" do
Autodesk Navisworks, que permite definir uma paleta de materiais uma vez
para um projeto, e reaplicá-la em um modelo na medida que este evolui, ou
para outro modelo no mesmo projeto que tenha sido definido com os mesmos
nomes de camadas, cores, conjuntos de seleção e/ou propriedades.

Consulte Organizar e gerenciar materiais na página 597 para obter mais
informações.

Regras predefinidas

Você pode aplicar quantas regras que desejar, já que todas as regras dependem
de nomes do material. As regras podem ser definidas usando a API do Autodesk
Navisworks, mas as regras predefinidas são:
■ Layers by Name permite aplicar um material em camadas nomeadas.

Por exemplo, se uma camada é denominada "Doors" e você renomeia um
material como "Doors" (a ortografia e caixa precisam ser exatamente as
mesmas do nome da camada), então todas as camadas denominadas "Doors"
irão exibir as propriedades daquele material, quando você seleciona a regra
Layers by Name, e clica em Apply.

Você pode fornecer o nome de diferentes camadas para múltiplos materiais
e aplicar esta regra em todas as camadas.

■ Autodesk Navisworks Materials by Name permite aplicar um material
para materiais nomeados do Autodesk Navisworks. Os materiais do Autodesk
Navisworksnão são como os materiais do Autodesk NavisworksPresenter.
Os materiais do Autodesk Navisworks meramente se referem a cor e
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transparência do item como foi salvo no arquivo de CAD original, já os
materiais do Presenter são aqueles aplicados usando a ferramenta
Presenter, ou são materiais mais complexos, como bitmaps convertidos
do arquivo de CAD original.

Se um material do Presenter tiver o mesmo nome que um material do
Autodesk Navisworks no modelo (por exemplo, "AutoCAD Color Index
7"), então todos os itens com este nome original de material do Autodesk
Navisworks na cena recebem esse material do Presenter a partir da paleta
quando você seleciona a regra Autodesk Navisworks Materials by Name,
e clica em Apply.

■ Selection Sets by Name permite aplicar um material em conjuntos de
seleção. Consulte  Criar e utilizar conjuntos de objetos  na página 385 para
obter mais informações sobre como definir conjuntos de seleção.

Se um material tem o mesmo nome de um conjunto de seleção no modelo,
então todos os itens neste conjunto de seleção recebem este material da
paleta, quando você seleciona a regra Selection Sets by Name, e clica
em Apply.

Para aplicar regras do Presenter predefinidas

1 Abra a janela Presenter e clique na guia Rules.

2 Selecione todas as regras que deseja aplicar. Você pode aplicar quantas
regras que desejar, já que as regras dependem de nomes do material.

3 Use as caixas de seleção no lado direito da janela Presenter, guia Rules,
para controlar como as regras selecionas se aplicam à cena:

Selecione Override Any Current Exact Mappings se deseja sobrepor
quaisquer mapeamentos existentes dos materiais do Presenter para
itens na árvore de seleção.

Selecione Apply to Current Selection Only se desejar aplicar esta
regra somente para os itens no momento selecionados na cena. Esteja
ciente de que esta é a configuração padrão, portanto, se parecer que suas
regras não funcionaram, verifique se não tem esta opção marcada com
nada selecionado na cena.

Selecione Apply to All Instances se deseja aplicar esta regra em todas
as instâncias de quaisquer itens de múltiplas instâncias afetados pela
regra.

4 Clique em Apply.
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Regras personalizadas

Novas regras personalizadas podem ser adicionadas e definidas utilizando o
Rules Editor.

Para adicionar regras personalizadas do Presenter

1 Na guia Rules da janela Presenter , clique em New.

A caixa de diálogo Rules Editor é aberta.

2 Insira um novo nome para sua regra na caixa Rule name.

OBSERVAÇÃO Se você decidir não inserir um nome, ao selecionar um
modelo de regra, o nome daquele modelo será utilizado.

3 Na lista Rule templates , escolha um modelo do qual sua regra terá
base.

OBSERVAÇÃO Os modelos Layers by Name, Materials by Name e
Selection Sets by Name são os modelos utilizados para as regras
predefinidas do Presenter.

O modelo Materials by Porperty permite especificar uma propriedade
dentro da cena do modelo. Se um material tem o mesmo nome do valor
de propriedade especificado no modelo, então todos os itens que tenham
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esta propriedade recebem este material da paleta, quando você seleciona
a regra Materials by Property, e clica em Apply.

4 Na caixa Rule description , clique em cada dos valores sublinhados para
definir sua regra personalizada. Os valores personalizáveis disponíveis
nos modelos inclusos, são:
■ Name. Utilize o nome da categoria ou propriedade como estiver

exibido na interface (recomendado). Você também pode escolher
Internal Name, que é acessado através da API (somente para uso
avançado).

■ '<category>'. Escolha na lista disponível, em qual categoria a
propriedade que deseja definir se encontra. Somente as categorias
que estão contidas na cena estão disponíveis na lista suspensa.

■ '<property>'. Escolha a propriedade que deseja definir na lista
disponível. Somente as propriedades na cena dentro da categoria
escolhida estão disponíveis.

5 Clique em OK.

Exemplo de regras do Presenter

Para seguir este procedimento, abra o arquivo denominado gatehouse_pub.nwd
localizado na pasta Examples\Gatehouse no diretório de instalação do Autodesk
Navisworks.

Vamos assumir que você deseja aplicar um material de vidro de janela para
todos os itens do 'gatehouse' com a propriedade de material doAutoCAD
Color Index 9, e o material de tijolo vermelho para todos os itens do
'gatehouse' com a propriedade de material do AutoCAD Color Index 32. O
procedimento a seguir descreve as etapas necessárias para obter isso, utilizando
as regras do Presenter.

Para aplicar materiais com as regras personalizadas do Presenter

1 Abra a janela Presenter e clique na guia Rules.

2 Crie um regra denominada "Color Index 9", com base nos materiais por
modelo de propriedade:

a Na guia Rules da janela Presenter , clique em New.

b Insira o nome da regra "Color Index 9".

c Escolha o modelo Materials by property.
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d Clique em '<category>' e selecione Material na lista suspensa e
clique em OK.

e Clique em '<property>' e selecione Name na lista suspensa e
clique em OK.

f Clique em OK para salvar a regra personalizada.

3 Crie outra regra denominada "Color Index 32" utilizando as mesmas
configurações como antes.

4 Defina os materiais necessários:

1 No arquivo Recommended\Glass na guia Materials, arraste o
material Window Glass para a paleta, pressione F2, e renomeie-o
como “AutoCAD Color Index 9”. Pressione Enter para salvar o
novo nome.

OBSERVAÇÃO O nome do material do Presenter precisa coincidir
com o nome do material salvo no arquivo de CAD original. Você pode
visualizar as propriedades do material na janela Properties ou na guia
Properties da Selection Tree.

2 No arquivo Recommended\Bricks na guia Materials, arraste
o material Red Brick para a paleta, pressione F2, e renomei-o
como “AutoCAD Color Index 32”. Pressione Enter para salvar o
novo nome.
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5 Clique na guia Rules e selecione as regras Color Index 9 e Color Index
32.

6 Assegure que somente Override any current exact mappings esteja
selecionado e clique em Apply, para aplicar as regras.

Todos os itens na cena do modelo que possuem as propriedades AutoCAD
Color Index 9 e AutoCAD Color Index 32 devem ter os materiais
correspondentes do Presenter aplicados.
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Simular o
planejamento de
construção

A ferramenta TimeLiner permite vincular seu modelo 3D com um planejamento
de construção externa para o planejamento visual 4D.

Visão geral da ferramenta TimeLiner
A ferramenta TimeLiner adiciona a simulação de planejamento 4D ao Autodesk
Navisworks Manage 2012. TimeLiner importa planejamento de uma variedade
de fontes. É possível então conectar tarefas em planejamento com objetos no
modelo para criar uma simulação 4D. Isto permite ver o efeito do planejamento
no modelo e comparar as datas planejadas com as datas atuais. O TimeLiner
também permite exportar as imagens e animações com base nos resultados da
simulação. O TimeLiner irá atualizar automaticamente a simulação se o modelo
ou o planejamento é modificado.

Você pode combinar a funcionalidade do TimeLiner com outras ferramentas
do Autodesk Navisworks:
■ A vinculação do TimeLiner com um Object Animation permite acionar e

planejar o movimento de um objeto com base em uma hora inicial e a
duração das tarefas do projeto, e pode ajudar com o planejamento de espaço
de trabalho e de processo. Por exemplo, uma sequência do TimeLiner pode
indicar quando um determinado guindaste no terreno move de seu ponto
inicial para seu ponto final no decorrer de uma determinada tarde, e que
um grupo de trabalho trabalhando nas proximidades causa uma obstrução
em sua rota. Este problema potencial de obstrução pode ser solucionado
antes de ir ao terreno (ou seja, o guindaste pode ser movido ao longo de uma
outra rota, o grupo de trabalho pode ser movido para outro lugar ou o
planejamento do projeto pode ser alterado). Consulte Adicionar uma
animação na página 705 para obter mais informações.
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■ A vinculação do TimeLiner com o Clash Detective permite as
verificações de interferência no projeto com base em horário. Consulte
Localizar e gerenciar interferências na página 711 para obter detalhes
adicionais sobre a interferência com base no horário.

■ A vinculação do TimeLiner, com o Object Animation e o Clash
Detective permite o teste de interferência de planejamentos do
TimeLiner com uma animação completa. Portanto, ao invés de
inspecionar visualmente uma sequência do TimeLiner para assegurar,
por exemplo, que o guindaste em movimento não colidiu com o grupo de
trabalho, é possível executar um teste do Clash Detective.

Janela TimeLiner

A janela encaixável do TimeLiner permite anexar itens do modelo às tarefas
do projeto e simular planejamentos do projeto.

Para alternar a janela TimeLiner

■ Clique na guia Home ➤ painel Tools ➤ TimeLiner  .

Menu: Interface de usuário clássica: Tools  ➤  TimeLiner

Para definir as opções do TimeLiner

1 Clique em  ➤  Options.

2 Expanda o nó Tools no Options Editor, e clique na opção TimeLiner.

3 Na página TimeLiner, selecione a caixa de seleção Auto Select
Attached Items se deseja que o TimeLiner selecione qualquer item
anexado na Scene View conforme você seleciona cada tarefa na janela
do TimeLiner.
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4 Selecione a hora que deseja que o dia útil comece a utilizar a opção
Beginning of Working Day (24h).

5 Selecione um formato de data do menu suspenso Date Format.

6 Selecione a caixa de seleção Enable Find se você deseja encontrar opção
para estar disponível ao clicar com o botão direito do mouse na guia
Tasks.

7 Selecione a hora que deseja que o dia útil conclua com a opção End of
Working Day (24h).

8 Selecione a caixa de seleção Report Data-Source Import Warnings
para ativar a exibição de mensagens de advertência, se um problema
ocorrer ao importar dados na janela TimeLiner, guia Data Sources.

9 Selecione a caixa de seleção Show Time para exibir a hora nas colunas
de data na guia Tasks.

OBSERVAÇÃO É possível selecionar o formato do arquivo de texto que será
utilizado para importar/exportar um arquivo CSV para TimeLiner na caixa de
diálogo TimeLiner CSV na página 874.

Guia Tasks

A guia Tasks permite criar e gerenciar as tarefas do projeto. Ela mostra todas
as tarefas em seu planejamento, listadas em formato de tabela. Você pode
utilizar as barras de rolagem a direita e na parte inferior da guia para mover
entre os registros de tarefas.
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A visualização da tarefa

As tarefas são mostradas em um tabela com múltiplas colunas, o que fornece
alguma flexibilidade sobre como os registros são exibidos. Você pode:

■ Mover ou redimensionar colunas

■ Classificar dados da coluna em ordem crescente ou decrescente

■ Adicionar novas colunas do usuário para o conjunto padrão de colunas

DICA Você pode mover entre entradas com o teclado. Basta selecionar uma tarefa
e utilizar as teclas Tab e SHIFT + Tab para mover adiante e para trás entre os
campos. O teclado pode então ser utilizado para editar e definir cada entrada
onde necessário.

A hierarquia da tarefa  O Autodesk NavisworksTimeLiner suporta uma
estrutura hierárquica de tarefas, como uma importada de uma fonte de dados
como o Microsoft Project ™ (consulte Guia Data Sources na página 653 para
obter mais informações. A hierarquia pode ser expandida ou retraída ao clicar
no sinal de mais ou de menos, respectivamente, no lado esquerdo da tarefa.

Os ícones de status Cada tarefa tem seu próprio status identificado por um
ícone. Duas barras separadas são desenhadas para cada tarefa, comparando as
relações planejadas com as atuais. A cor é usada para diferenciar as porções
mais cedo (azul), na hora (verde), atrasado (vermelho) e planejado (cinza), das
tarefas. Pontos marcam as datas de início e final do planejamento.

Ao parar o ponteiro do mouse sobre o ícone Status é exibida uma dica de
ferramenta explicando o status da tarefa.

Terminou antes do início planejado.

Início antecipado, conclusão antecipada.

Início antecipado, conclusão no prazo.

Início antecipado, conclusão atrasada.

Início no prazo, conclusão antecipada.

Início no prazo, conclusão no prazo.

Início no prazo, conclusão atrasada.

Início atrasado, conclusão antecipada.

Início atrasado, conclusão no prazo.

Início atrasado, conclusão atrasada.

Começou após o início planejado.

Sem comparação.
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A caixa de seleção Active A caixa de seleção na coluna Active permite ativar
e desativar uma tarefa. Se a tarefa estiver desativada, então ela não irá aparecer
na simulação na página 657. Para tarefas hierárquicas, a desativação da tarefa
principal irá automaticamente desativar todas as tarefas secundárias.

Os menus de atalho Clicar com o botão direito do mouse na área da tarefa
na guia, abre um menu de atalho que permite trabalhar com tarefas em seu
planejamento.
■ Copy Date/Time - copia os valores de data/hora no campo selecionado.

Esta opção somente está disponível quando você clica com o botão direito
do mouse em um dos campos de data (por exemplo, Planned Start).

OBSERVAÇÃO No momento, não é possível utilizar o atalho de teclado Ctrl
+ C para copiar valores de data/hora.

■ Paste Date/Time - cola os valores de data/hora. Para acessar esta opção
é preciso clicar com o botão direito do mouse nos campos de data. Também,
esta opção não está disponível a não ser que uma data/hora válida tenha
sido previamente copiada.

OBSERVAÇÃO No momento, não é possível utilizar o atalho de teclado Ctrl
+ V para colar valores de data/hora.

■ Enable Planned Dates - simula datas planejadas para a tarefa selecionada.
Esta opção está disponível ao clicar com o botão direito do mouse no campo
Planned Start ou Planned End.

■ Enable Actual Dates - simula as datas atuais para a tarefa selecionada.
Esta opção está disponível ao clicar com o botão direito do mouse no campo
Actual Start ou Actual End.

■ Dates - permite simular datas reais e planejadas para a tarefa selecionada.
Se nenhuma data estiver habilitada para a tarefa, não será exibido na
simulação na página 657.

■ Add Task - adiciona uma nova tarefa na tabela. Esta opção está disponível
ao clicar com o botão direito do mouse em uma área da vista de tarefas
abaixo de qualquer tarefa atual.

■ Attach Current Selection - anexa os itens no momento selecionados
na cena nas tarefas selecionadas.

■ Attach Current Search - anexa todos os itens selecionados pela
Pesquisa atual nas tarefas selecionadas. Consulte Encontrar objetos na
página 374 para obter mais informações sobre como pesquisar.

■ Attach Set - anexa todos os itens contidos dentro de um conjunto de
seleção, para as tarefas selecionadas. Quando você escolhe esta opção, uma
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lista de todos os conjuntos de seleção e de pesquisa salvos na cena atual
são exibidos. Escolha o conjunto de seleção ou de pesquisa que deseja
anexar nas tarefas. Consulte  Criar e utilizar conjuntos de objetos  na página
385 para obter mais informações sobre como utilizar conjuntos de seleção
e de pesquisa.

■ Append Current Selection - anexa os itens no momento selecionados
na cena nos itens já anexados nas tarefas selecionadas.

OBSERVAÇÃO Consulte Selecionar objetos na página 361 para obter mais
informações sobre como selecionar itens no Autodesk Navisworks.

■ Clear Attachment - remove o anexo desta tarefa.

■ Add Comment - adiciona um comentário na tarefa. Consulte  Usar
comentários, linhas de marcação e identificadores  na página 427 para obter
mais informações.

■ Fill Down - define o Task Type de todas as tarefas selecionadas na vista
de tarefas para coincidir com o da tarefa que está no momento "em foco".

■ Insert Task - insere uma nova tarefa acima da selecionada atualmente
na vista de tarefas.

■ Delete Task - exclui a tarefa selecionada atualmente na vista de tarefas.

■ Auto-Add Tasks - adiciona automaticamente uma tarefa para cada camada
superior, item superior ou para cada conjunto de seleção ou de pesquisa.

■ Find - encontra elementos em um agendamento com base nos critérios
de pesquisa selecionados no menu Find. Esta opção pode ser ativada ou
desativada no Options Editor (caixa de seleção
Tools ➤ TimeLiner ➤ Enable Find).

É possível usar a multi seleção (por exemplo, manter pressionada a tecla SHIFT
ou CTRL) para desempenhar a maioria dos comandos em várias tarefas de uma
só vez. Por exemplo, caso precise excluir todas as tarefas, selecione a primeira
tarefa, a seguir, mantenha pressionada a tecla SHIFT e selecione a última tarefa,
então, pressione Delete.

Tasks

Column Set O menu suspenso Column Set permite que você selecione um
dos três conjuntos de colunas predefinidos a serem exibidos na visualização
da tarefa; Basic, Standard ou Extended. Também é possível criar um conjunto
de colunas personalizado em Choose TimeLiner Columns na página 659
clicando em Choose Columns e, em seguida, selecionando Custom depois
de definir o conjunto de colunas preferido.
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Filter by Status O menu suspenso Filter by Status permite filtrar tarefas
com base em seu status. Filtrar uma tarefa a deixa temporariamente oculta nas
visualizações da tarefa e do gráfico Gantt, mas não efetua quaisquer alterações
na estrutura de dados subjacente.

Rules Clique para exibir a caixa de diálogo TimeLiner Rules na página 659.

Show Hierarchy Clicar na caixa de seleção Show Hierarchy torna "plana"
a estrutura hierárquica mostrada na vista de tarefas.

Gantt Chart

A Exibição das datas A opção suspensa Display Dates, permite alternar
entre os gráficos Gantt Actual, Planned e Planned vs Actual.

O Deslizador de zoom O deslizador de Zoom permite ajustar a resolução do
gráfico Gantt exibido. A posição mais à esquerda seleciona o menor incremento
disponível na linha do tempo (por exemplo, dias); a posição mais à direita
seleciona o maior incremento disponível na linha do tempo (por exemplo,
anos).

Mostrar Clique na caixa de seleção Show para exibir ou ocultar o gráfico
Gantt.

A vista do gráfico Gantt

O gráfico Gantt exibe um gráfico de barras coloridas ilustrando o status do
projeto. Cada tarefa ocupa uma linha. O eixo horizontal representa o intervalo
de tempo do projeto, dividido em incrementos (tais como dias, semanas, meses
e anos) e o eixo vertical representa as tarefas do projeto. As tarefas podem ser
executadas sequencialmente, em paralelo, ou sobrepostas.

É possível arrastar uma tarefa para diferentes datas ou clicar em qualquer
extremidade da tarefa e arrastá-la para estender ou encurtar sua duração. Todas
as alterações são atualizadas automaticamente na vista de tarefas.

Guia Data Sources

A guia Data Sources e importar tarefas de um software de planejamento de
terceiros, tais como Microsoft·Project, Asta e Primavera. Ela mostra todas as
origens de dados adicionadas, listadas em um formato de tabela.
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A visualização de origem de dados

As origens de dados são mostradas em uma tabela com múltiplas colunas. As
colunas mostram o nome, a origem (por exemplo, Microsoft Project™) e do
projeto (por exemplo, my_schedule.mpp). Quaisquer colunas adicionais
(pode·haver·nenhuma) identificam os campos do planejamento externo, que
especificam o tipo da tarefa, ID única, data inicial e data final para cada tarefa
importada.

Você pode mover e redimensionar as colunas, se necessário.

Os botões de origem de dados

Add Cria uma nova conexão para um arquivo de projeto externo. Clicar neste
botão exibirá um menu que lista todas as origens de projetos que podem estar
conectadas com a máquina atual. Consulte Software de planejamento
suportado na página 691 para obter mais informações sobre quais origens estão
disponíveis.

Excluir  Exclui a origem de dados atualmente selecionada. Se você tiver
atualizado a origem de dados antes de excluí-la, qualquer tarefa e leitura de
dados da origem de dados irá permanecer na guia Tasks.

Atualizar Exibe a caixa de diálogo Refresh from Data Source na página 664
onde é possível atualizar as origens de dados selecionados.
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Os menus de atalho

Clicar com o botão direito do mouse dentro da área de origem de dados na
guia, abre um menu de atalho que permite gerenciar origens de dados.

■ Rebuild Task Hierarchy - lê todas as tarefas e dados associados (na
caixa de diálogo Field Selector) das origens de dados selecionadas e adiciona
à guia Tasks. Escolha esta opção para também sincronizar com o arquivo
de projeto selecionado quando novas tarefas forma adicionadas no arquivo
do projeto. Isso irá reconstruir a hierarquia de tarefas no TimeLiner,
contendo todas as tarefas e dados mais recentes.

■ Syncronize - Atualiza todas as tarefas existentes na guia Tasks com os
últimos dados associados das origens de dados selecionadas (por exemplo,
datas iniciais e finais).

■ Delete - Exclui a origem de dados atualmente selecionados. Se você tiver
atualizado a origem de dados antes de excluí-la, qualquer tarefa e leitura
de dados da origem de dados irá permanecer na guia Tasks.

■ Edit - permite editar a origem de dados selecionada. Isso exibirá a caixa
de diálogo Field Selector na página 660 da qual é possível definir novos
campos ou redefinir os existentes.

■ Refresh - exibe a caixa de diálogo Refresh from Data Source na página
664 onde é possível atualizar a origem de dados selecionada.

■ Rename - permite renomear a origem de dados para algo mais apropriado.
Quando o campo do texto se torna ressaltado, insira o novo nome, a seguir,
pressione Enter para salvá-lo.

OBSERVAÇÃO Tarefas na origem de dados serão ignoradas se não incluírem
datas iniciais e finais, com a data inicial sendo anterior ou igual a data final.

Guia Configure

A guia Configure permite definir os parâmetros da tarefa, como os tipos de
tarefas, as definições de aparência para tarefas e a aparência padrão do modelo
no início da simulação.
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Tipos de tarefas

Os tipos de tarefas são mostrados em uma tabela com múltiplas colunas. Você
pode mover e redimensionar as colunas da tabela, se necessário.

OBSERVAÇÃO É possível clicar duas vezes na coluna Name para renomear um
tipo de tarefa ou clicar duas vezes em qualquer outra coluna para alterar a aparência
do tipo de tarefa.

O TimeLiner vem com três tipos predefinidos de tarefas:

■ Construct - para tarefas onde os itens anexados devem ser construídos.
Por padrão, durante a simulação, os objetos são realçados em verde no
início da tarefa e são redefinidos para Model Appearance na página 702 no
fim da tarefa.

■ Demolish - para tarefas que foram demolidas onde os itens anexados
devem ser demolidos. Por padrão, durante a simulação, os objetos são
realçados em vermelho no início da tarefa e são ocultos no fim da tarefa.

■ Temporary - para tarefas onde os itens anexados são somente temporários.
Por padrão, durante a simulação, os objetos são realçados em amarelo no
início da tarefa e são ocultos no final da tarefa.

Add

Adiciona um novo tipo de tarefa.

Excluir

Exclui o tipo de tarefa selecionado.
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Appearance Definitions

Abre a caixa de diálogo Appearance Definitions na página 672 onde é possível
configurar e alterar definições de aparência.

Guia Simulate

A guia Simulate permite simular sua sequência do TimeLiner através da
duração do planejamento do projeto.

Os controles de reprodução

Utilize os botões padrão de VCR para entrar e executar adiante e para atrás
através da simulação.

Rewind  irá rebobinar a simulação de volta para o início.

Step Back  irá voltar atrás um único tamanho de etapa. Consulte Caixa
de diálogo Simulation Settings na página 664 para obter mais informações.

Reverse Play  irá reproduzir a simulação de trás para a frente.

Pause  irá pausar a simulação no momento em que você a pressiona. Você
pode olhar em torno e interrogar o modelo, ou ir adiante ou para atrás através
da simulação. Para continuar a reproduzir do ponto da pausa, basta pressionar
Play novamente.

Stop  irar parar a reprodução da simulação e irá rebobinar de volta ao início.

Play  irá reproduzir a simulação da hora no momento selecionada.

Visão geral da ferramenta TimeLiner | 657



Step Forwards  irá adiantar um único tamanho de etapa.

Forward  irá adiantar rápido a simulação até o final.

Você pode utilizar o deslizador Simulation Position para mover rapidamente
para adiante e para atrás através da simulação. Todo a esquerda é o início e
todo a direita é o final.

A caixa Date/Time próxima dos botões VCR mostra o ponto no tempo através
da simulação. Você pode clicar no ícone suspenso no lado direito da data para
exibir um calendário, no qual é possível selecionar uma data para ir para a
mesma.

O botão Settings

O botão Settings abre a caixa de diálogo Simulation Settings na página 664,
que permite definir como o planejamento é simulado.

A visualização da tarefa

Todas as tarefas ativas são exibidas em uma tabela com múltiplas colunas.
Você pode mover e redimensionar as colunas da tabela, se necessário.

Você pode visualizar o tempo da simulação atual para cada uma das tarefas
ativas, e quão perto está de ser completada (o Andamento é exibido em
percentual). O Status de cada tarefa ativa também é exibido como um ícone.
Para as simulações onde as datas Planejado e Real estão disponíveis, o status
fornece uma representação visual sobre se há uma variação entre as datas de
planejado e real. Consulte Os ícones de status na página 649 para obter mais
informações.

A vista do gráfico Gantt

O gráfico Gantt exibe um gráfico de barras coloridas ilustrando o status do
projeto. Cada tarefa ocupa uma linha. O eixo horizontal representa o intervalo
de tempo do projeto, dividido em incrementos (tais como dias, semanas, meses
e anos) e o eixo vertical representa as tarefas do projeto. As tarefas podem ser
executadas sequencialmente, em paralelo, ou sobrepostas.

O nível da faixa visível (Zoom) é determinado pelas opções de Interval Size
na caixa de diálogo Simulation Settings na página 664.
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Caixa de diálogo Choose TimeLiner
Columns

Utilize esta caixa de diálogo para personalizar como as colunas são exibidas
na guia TimeLiner Tasks. Para acessá-la, clique no menu suspenso Column
Set botão  ➤ Choose Columns na guia Tasks.

Column List Exibe todas as colunas disponíveis. Clique na caixa de seleção
de uma coluna para que ela seja exibida na guia Tasks.

Move Up Move as colunas selecionadas para cima na lista por uma posição.

Move Down Move as colunas selecionadas para baixo na lista por uma posição.

Show All Seleciona todas as caixas de seleção na lista.

Hide All Desmarca todas as caixas de seleção da lista.

Caixa de diálogo TimeLiner Rules

Use a caixa de diálogo TimeLiner Rules para criar e gerenciar as regras do
TimeLiner.

Clique no botão Rules na guia Tasks para abrir esta caixa de diálogo. Ela
lista todas as regras no momento disponíveis. Estas podem ser utilizadas para
mapear tarefas para itens no modelo. Cada uma das regras padrão podem ser
editadas e novas regras podem ser adicionadas como necessário.
Novo Abre a caixa de diálogo Rules Editor, na qual é possível criar uma
nova regra.

Edit Abre a caixa de diálogo Rules Editor, na qual é possível editar a regra
selecionada no momento.

Delete Exclui a regra selecionada no momento.

Import/Export Attachment Rules Permite importar/exportar regras em
um arquivo XML.

OBSERVAÇÃO As regras importadas irão substituir quaisquer regras atuais com
o mesmo nome.

Caixa de seleção Override Current Selections  Se selecionada, quando as
regras forem aplicadas, elas substituirão quaisquer itens anexados. Se não for
selecionada, as regras anexarão itens nas tarefas relevantes sem itens anexados.
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Apply Rules Aplica as regras selecionadas.

Caixa de diálogo Field Selector

A caixa de diálogo Field Selector determina as diversas opções utilizadas ao
importar dados de um agendamento de projeto externo.

As opções disponíveis podem ser diferentes para cada tipo de origem de dados.

A caixa de diálogo Field Selector para importar dados de um software de planejamento
externo.
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A caixa de diálogo Field Selector para importar dados CSV.

Options

CSV Import Settings
Row 1 Contains Headings  Selecione a caixa de verificação Row 1 Contains
Headings se desejar que a primeira linha do arquivo CVS seja usada como
cabeçalhos das colunas. O TimeLiner irá utilizá-los para preencher as opções
do External Field Name na grade.

A primeira linha de dados no arquivo CVS não contém cabeçalhos de colunas,
apague esta caixa de verificação.

Automatically Detect Date/Time Format Selecione a opção Automatically
Detect Date/Time Format se deseja que o TimeLiner tente determinar
o formato data/hora usado no arquivo CVS. Primeiro, o TimeLiner aplica um
conjunto de regras para tentar estabelecer o formato de data/hora utilizado
no documento, e caso não seja possível, ele utiliza as configurações locais de
seu sistema.

Use Specific Date/Time Format Selecione a opção Use Specific Date/Time
Format se deseja especificar manualmente o formato de data/hora que deve
ser utilizado. Quando este botão é selecionado, é possível inserir o formato
requerido na caixa fornecida. Veja a lista abaixo, de códigos válidos de
data/hora.
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OBSERVAÇÃO Se for determinado que uma ou mais colunas com base em
data/hora contêm campos onde os dados não podem ser mapeados para um valor
válido de data/hora utilizando o formato manualmente especificado, o TimeLiner
irá 'retornar' e irá tentar utilizar o formato automático de data/hora.

A grade de mapeamento de campo
A grade de mapeamento de campo é uma grade contendo, na coluna esquerda,
todas as colunas na tabela atual do TimeLiner e, na coluna direita, diversos
menus suspensos que permitem mapear os campos de entrada com as colunas
do TimeLiner.

OBSERVAÇÃO Quando estiver importando dados de um arquivo CSV, a coluna
External Field Name da grade mostra os dados da primeira linha do arquivo
CSV, se Row 1 Contains Headings estiver selecionada. Caso contrário, ele
padroniza para a Coluna A, Coluna B, e assim por diante.

Task Name Este campo é exibido e requerido ao importar dados CSV. Se você
não mapear este campo, irá receber uma mensagem de erro.

External ID O campo é utilizado para identificar de forma única cada tarefa
importada. Isso permite que a sincronização funcione, mesmo quando grandes
alterações são efetuadas no planejamento externo no software de planejamento.
O comportamento padrão é o de utilizar o campo mais apropriado para cada
origem. Algumas origens não têm uma ID única bem definida, em cujo caso
pode ser preciso escolher manualmente um campo.

OBSERVAÇÃO É recomendável ter uma coluna no arquivo CSV contendo dados
únicos (por exemplo, um número incremental) e mapeá-la para este campo. Se
o campo não estiver mapeado, não será possível reconstruir ou sincronizar o link
de origem de dados.

Task Type Este campo é utilizado para atribuir automaticamente Task Types
na página 655 (Tipos de tarefa) para cada tarefa importada.

Display ID O campo é utilizado para quaisquer outros requisitos de usuário
e não precisa ser mapeado.

Planned Start Date O campo é utilizado para identificar a data de início
planejada. Isso permite que a comparação de planejado versus real possa ser
efetuada e simulada.

Planned End Date Este campo é utilizado para identificar uma data final
planejada. Isso permite que a comparação de planejado versus real possa ser
efetuada e simulada.

Actual Start Date Algumas origens de projeto suportam múltiplas datas iniciais
para diferentes propósitos. O comportamento padrão é o de utilizar data
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disponível mais apropriada para cada origem. Este campo pode ser utilizado
para definir uma data Inicial real , caso seja diferente daquela selecionada
por padrão.

Actual End Date Algumas origens de projeto suportam múltiplas datas finais
para diferentes propósitos. O comportamento padrão é o de utilizar data
disponível mais apropriada para cada origem. Este campo pode ser utilizado
para definir especificamente uma data Real final, caso seja diferente daquela
selecionada por padrão.

User 1 to 10 Dez campos de usuário estão disponíveis para vincular quaisquer
campos de dados personalizados da origem do projeto.

Botão Reset All Utilize estes botão para desmarcar todo o mapeamento de
coluna e também redefinir as configurações de importação de CSV para seus
padrões, caso apropriado.

Códigos válidos de data/hora

d, %d  O dia do mês. Dias de dígito único NÃO terão zeros a esquerda.

dd O dia do mês. Dias de dígito único terão zeros a esquerda.

ddd O nome abreviado do dia.

dddd O nome completo do dia.

M, %M O mês numérico. Meses de dígito único NÃO terão zeros a esquerda.

MM O mês numérico. Meses de dígito único terão zeros a esquerda.

MMM O nome abreviado do mês.

MMMM O nome completo do mês.

a, %a A ano sem o século. Se menor do que 10, NÃO terá zeros a esquerda.

aa A ano sem o século. Se menor do que 10, terá zeros a esquerda.

aaaa O ano em quatro dígitos, incluindo o século.

h, %h A hora no formato de relógio de 12 horas. Horas de dígito único NÃO
terão zeros a esquerda.

hh A hora no formato de relógio de 12 horas. Horas de dígito único terão
zeros a esquerda.

H A hora no formato de relógio de 24 horas. Horas de dígito único NÃO terão
zeros a esquerda.

HH A hora no formato de relógio de 24 horas. Horas de dígito único terão
zeros a esquerda.
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m, %m O minuto. Minutos de dígito único NÃO terão zeros a esquerda.

mm O minuto. Minutos de dígito único terão zeros a esquerda.

s, %s O segundo. Segundos de dígito único NÃO terão zeros a esquerda.

ss O segundo. Segundos de dígito único terão zeros a esquerda.

t, %t O primeiro caractere designado de AM/PM, se houver.

tt O designador AM/PM. se houver.

z  O deslocamento do fuso horário GMT ("+" ou "-" seguido somente da hora).
Horas de dígito único NÃO terão zeros a esquerda.

zz O deslocamento do fuso horário. Horas de dígito único terão zeros a
esquerda.

zzz O deslocamento completo do fuso horário em horas e minutos. Horas e
minutos de dígito único terão zeros a esquerda. Por exemplo, "-8:00".

Caixa de diálogo Refresh from Data Source

Utilize esta caixa de diálogo para escolher como os dados são atualizados.

Rebuild Lê todas as tarefas e dados associados (como definido na caixa de
diálogo Field Selector na página 660) dos agendamentos externos selecionados
e os adiciona à guia Tasks. Escolha esta opção para também sincronizar ao
agendamento externo selecionado quando novas tarefas forem adicionadas
ao arquivo de projeto. Isso irá reconstruir a hierarquia de tarefas no
TimeLiner, contendo todas as tarefas e dados mais recentes.

Synchronize Atualiza todas as tarefas existentes na guia Tasks com os dados
mais recentes associados dos agendamentos externos selecionados (por
exemplo, datas iniciais e finais).

Dispositivo apontador: Guia TimeLiner Data Sources ➤ Refresh

Caixa de diálogo Simulation Settings

O botão Settings na guia Simulate fornece o acesso à caixa de diálogo
Simulation Settings.
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É possível sobrepor as datas Inicial e Final entre as quais a simulação é
executada. A seleção da caixa de seleção Override Start/End Dates ativa
as caixas de datas e permite escolher as datas iniciais e finais. Ao fazer isso,
você pode simular uma pequena subseção de todo o projeto. As datas serão
exibidas na guia Simulate. Estas datas também serão utilizadas ao exportar
animações.

Você pode definir o Tamanho do intervalo para utilizar a passagem através
da simulação utilizando os controles de reprodução. O tamanho do intervalo
pode ser definido como um percentual da duração total da simulação ou como
um número absoluto de dias ou semanas, e assim por diante.

Utilize a lista suspensa para selecionar a unidade de intervalo, e a seguir utilize
os botões de seta Up e Down para aumentar ou diminuir o tamanho do
intervalo.
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Também é possível realçar todas as tarefas nas quais se está trabalhando durante
o intervalo. Ao selecionar a caixa de seleção Show All Tasks in Interval,
e, por exemplo, definindo Interval Size para 5 dias, todas as tarefas sendo
executadas durante estes 5 dias serão definidas para sua Start Appearance
na Scene View, incluindo aquelas que começam e terminam dentro dos
limites do intervalo. O deslizador Simulation irá mostrar isso ao desenhar
uma linha azul sob o deslizador. Se esta caixa de seleção for desmarcada, as
tarefas que começam e terminam dentro dos limitas do intervalo não serão
realçadas desta maneira, e terão que coincidir com a data atual para serem
realçadas na Scene View.

Você pode definir a Duração de reprodução geral, para toda a simulação
(o tempo necessário para reproduzi-la do início ao fim). Utilize os botões de
seta Up e Down para aumentar ou diminuir a duração (em segundos). Você
pode também pode inserir a duração diretamente neste campo.

Você pode definir se a data da simulação atual deveria ser sobreposta na Scene
View, e se deveria aparecer na parte superior ou inferior da tela. No menu
suspenso, escolha entre None (para não exibir texto de sobreposição), Top
(para exibir o texto no topo da janela), ou Bottom (para exibir o texto na
parte inferior da janela).

Você pode usar a opção Edit para editar as informações exibidas no texto
sobreposto utilizando o Caixa de diálogo Overlay Text na página 670. A caixa
de diálogo torna alterar a Fonte Tipo, Estilo e Tamanho ao clicar no botão
Font contido.

Você pode adicionar uma animação em um agendamento completo, para que
durante a reprodução da sequência do TimeLiner , o Autodesk Navisworks
também irá reproduzir a animação ou câmera do ponto de vista especificado.
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As seguintes opções podem ser selecionadas no campo Animation:
■ No Link - nenhuma animação ou câmera do ponto de vista será

reproduzida.

■ Saved Viewpoints Animation - vincula seu planejamento para o ponto
de vista ou a animação do ponto de vista no momento selecionado.

■ Scene X -  ➤ Camera - vincula o planejamento à animação da câmera na
cena de animação selecionada.

Você pode pré-gravar animações adequadas para serem utilizadas com a
simulação do TimeLiner (consulte  Gravar e reproduzir animações  na página
503). A utilização de animação também afeta a Animation Export na página
529.

Área View. Cada vista irá reproduzir o planejamento indicando os
relacionamentos de Planejado e Real:
■ Actual. Escolha esta vista para simular somente o planejamento Real (ou

seja, utiliza somente as datas de Início real e Final real).

■ Actual (Planned Differences). Escolha esta vista para simular o
planejamento Real contra o planejamento Planejado. Esta vista somente
realça os itens anexados na tarefa na faixa de datas Real ( ou seja entre
Inicial real e Final real. Veja o diagrama abaixo para uma representação
gráfica). Para períodos de tempo onde as datas de Real estão dentro das
datas de Planejado (no prazo), os itens anexados na tarefa serão exibidos
na Task Type Start Appearance. Para períodos de tempo onde as datas
de Actual estão antecipadas ou atrasadas em comparação às datas de
Planned (há uma variação), os itens anexados na tarefa serão exibidos
em Task TypeEarly ou Late Appearance, respectivamente.
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■ Planned. Escolha esta vista para simular somente o planejamento
Planejado (ou seja, somente utilizar as datas Inicial planejado e Final
planejado).

■ Planned (Actual Differences). Escolha esta vista para simular o
planejamento Real contra o planejamento Planejado. Esta vista somente
realçará os itens anexados à tarefa na faixa de datas Planned (ou seja,
entre PlannedStart and Planned End. Veja o diagrama abaixo para
uma representação gráfica). Para períodos de tempo onde as datas Actual
estão dentro das datas Planned (no prazo), os itens anexados à tarefa
serão exibidos em Task Type Start Appearance. Para períodos de tempo
onde as datas de Actual estão antecipadas ou atrasadas em comparação
às datas de Planned (há uma variação), os itens anexados na tarefa serão
exibidos em Task TypeEarly ou Late Appearance, respectivamente.
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■ Planned Against Actual. Escolha esta vista para simular o planejamento
Real contra o planejamento Planejado. Isso realçará os itens anexados
à tarefa em toda a faixa de datas Planned e Actual (ou seja, a primeira
data de Actual e PlannedStart e na última data de Actual e
PlannedEnd. Veja os diagramas abaixo para uma representação gráfica).
Para períodos de tempo onde as datas Actual estão dentro das datas
Planned (no prazo), os itens anexados à tarefa serão exibidos em Task
Type Start Appearance. Para períodos de tempo onde as datas de Actual
estão antecipadas ou atrasadas em comparação às datas de Planned (há
uma variação), os itens anexados na tarefa serão exibidos em Task
TypeEarly ou Late Appearance, respectivamente.
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Caixa de diálogo Overlay Text

Você tem a opção de definir o texto sobreposto na Scene View durante a
simulação ao clicar em Edit na Caixa de diálogo Simulation Settings na página
664.

Por padrão, a data e a hora são exibidas utilizando o formato especificado em
Painel de Controle ➤ Configurações Regionais. Você pode especificar
o formato exato a ser utilizado ao inserir texto na caixa de texto. A maioria
dos textos aparecem como foram inseridos, exceto que as palavras pré-fixadas
por um caractere "%" ou "$" agem como palavras-chave e são substituídas por
valores variados. Os botões Date/Time e Extras podem ser utilizados para
selecionar e inserir todas as palavras-chave possíveis. O botão Colors pode
ser utilizado para definir a cor to texto de sobreposição.

O botão Font traz a caixa de diálogo padrão de seleção de fontes do Microsoft
Windows. Após selecione a fonte, estilo da fonte e tamanho da fonte corretos,
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pressione OK para retornar para a caixa de diálogo Overlay Text. A seleção
da fonte atual é mostrada junto ao botão Font , e durante a simulação do
TimeLiner , todo o texto na sobreposição será mostrado utilizando esta fonte.

Palavras-chave de data/hora

%a  Nome abreviado do dia da semana.

%A Nome completo do dia da semana.

%b Nome abreviado do mês.

%B Nome completo do mês.

%c Representação apropriada de data e hora para o local.

%d Dia do mês como um número decimal (01 - 31).

%H Hora no formato de relógio de 24 horas (00 -23).

%I Hora no formato de relógio de 12 horas (01 -12).

%j Dia do ano como um número decimal (001 - 366).

%m Mês como um número decimal (01 - 12).

%M Minuto como um número decimal (00- 59).

%p Indicador atual de A.M/P.M local para o relógio de 12 horas.

%S Segundo como um número decimal (00- 59).

%U Semana de um ano como um número decimal, com Domingo sendo o
primeiro dia da semana (00 -53).

%w Dia da semana como um número decimal (0 - 6; Domingo é 0).

%W Semana de um ano como um número decimal, com Segunda-feira sendo
o primeiro dia da semana (00 -53).

%x Representação da data para o local atual.

%X Representação da hora para o local atual.

%y Ano sem o século, como um número decimal (00 - 99).

%Y Ano com o século, como um número decimal.

%z Abreviatura do fuso horário; nenhum caractere se o fuso horário for
desconhecido.

%Z Nome do fuso horário; nenhum caractere se o fuso horário for
desconhecido.
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Palavras-chave de cores

$COLOR_RED  Define a cor do texto sobreposto como vermelho.

$COLOR_BLUE Define a cor do texto sobreposto como azul.

$COLOR_GREEN Define a cor do texto sobreposto como verde.

$COLOR_WHITE Define a cor do texto sobreposto como branco.

$COLOR_BLACK Define a cor do texto sobreposto como preto.

$RGBr,g,b$RGB Define o texto exibido sobreposto como qualquer cor
especificada usando os valores RGB explícitos entre 0 e 255. Por exemplo,
“$RGB127,127,127$RGB” define a cor como cinza.

Palavras-chave extras

$TASKS  Adiciona o nome de cada tarefa no momento ativa para o texto de
exibição sobreposto. Cada tarefa é exibida em um nova linha.

$DAY Dias desde o início da primeira tarefa no projeto (iniciando em 1).

$WEEK Semanas desde o início da primeira tarefa no projeto (iniciando em
1).

CTRL + Enter Digite CTRL + Enter para inserir uma nova linha no texto exibido
sobreposto.

%% Sinal de percentual.

Caixa de diálogo Appearance Definitions

Utilize esta caixa de diálogo para personalizar os tipos de tarefas padrão ou
criar novas, como necessário. Para acessá-la, clique no botão Appearance
Definitions na guia Configure.

O TimeLiner vem com um conjunto de dez definições de aparência
predefinidas, que podem ser utilizadas para configurar os tipos de tarefas. As
aparências definem o nível de transparência e a cor.
Name Especifica o nome da definição de aparência. Clique no nome para
alterá-la conforme necessário.

Color Especifica a definição de aparência de cor. Clique na cor para alterá-la
conforme necessário.
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Transparency Especifica a definição de aparência de transparência. Utilize o
controle deslizante ou insira um valor para alterar a transparência conforme
necessário.

Add Clique para adicionar uma definição de aparência.

Delete Clique para excluir a definição de aparência selecionada atualmente.

Default Simulation Start Appearance Esta caixa suspensa especifica uma
aparência padrão a ser aplicada a todos os objetos no modelo no início da
simulação. O padrão é Hide, que é ideal para simular a maioria das sequências
de construção.

Para iniciar

Para iniciar

1 Carregue um modelo no Autodesk Navisworks da forma usual (consulte
Abrir arquivos na página 223 para obter mais informações) e clique na

guia Home ➤ painel Tools ➤ TimeLiner  .

OBSERVAÇÃO Embora a habilidade de criar simulações 4D está limitada
aos usuários com acesso à funcionalidade do TimeLiner , qualquer usuário
pode de fato reproduzir simulações 4D após terem sido configurados.

2 Crie algumas tarefas, cada uma com um nome, data inicial e final e um
tipo de tarefa. Você pode adicionar manualmente as tarefas na página
679. Alternativamente, clique com o botão direito do mouse dentro da
área da tarefa na guia Tasks para abrir o Guia Tasks na página 649 e criar
um conjunto inicial de tarefas com base em nomes de camadas, itens ou
conjuntos de seleção. O TimeLiner define alguns tipos de tarefas padrão
por você (Construct, Demolish e Temporary) ou você pode definir seus
próprios tipos de tarefas na Guia Configure na página 655. Você também
pode visualizar uma representação gráfica somente leitura do
planejamento do projeto, bem como alternar entre os gráficos Gantt
Planned, Actual e Planned vs Actual.

Visão geral da ferramenta TimeLiner | 673



É possível utilizar a funcionalidade Guia Data Sources na página 653 para
importar tarefas de uma origem externa, como o Microsoft Project ™.
Você pode escolher um campo de um planejamento externo para definir
os tipos de tarefas importadas ou pode definir à mão os tipos de tarefas.
É possível editar parâmetros da tarefa diretamente no TimeLiner. Você
também pode atualizar o planejamento externamente e atualizar as
tarefas no TimeLiner para alinhá-las às da origem externa. As alterações
feitas nas tarefas importadas dos arquivos de projetos externos serão
substituídas na próxima vez que você atualizar as origens de dados
correspondentes.

3 Anexe os objetos no modelo com tarefas.

Se você utilizou o menu de atalho na Guia Tasks na página 649 para criar
um conjunto inicial de tarefas com base nos nomes de camadas, itens e
conjuntos de seleção, então as camadas, os itens ou os conjuntos de
seleção correspondentes já estarão anexados.

Se você precisar manualmente Anexar tarefas na geometria na página
684, é possível utilizar o menu de atalho para anexar seleções, pesquisas
ou conjuntos de seleção.
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Alternativamente, você pode Utilizar regras para anexar tarefas na página
686 automaticamente.

4 Simular seu planejamento na página 701. Você pode visualizar seu modelo
em qualquer data em seu planejamento com as tarefas ativas no momento
realçadas. Passe por todo o planejamento utilizando os controles VCR.
É possível Adicionar uma animação na página 705 para seus planejamentos
de construção e aprimorar a qualidade das simulações.
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5 Ajustar a forma de reprodução da simulação na página 701. Você pode
utilizar a guia Configure para criar novos tipos de tarefas e editar as
antigas. O tipo da tarefa define o que acontece no início e no fim de cada
tarefa daquele tipo. Você pode ocultar objetos anexados, alterar sua
aparência ou redefini-los para a aparência especificada no modelo.

6 Criar arquivos de imagem e AVI. Exportar na página 704 a vista da
simulação atual como uma imagem ou toda a simulação como um AVI.

7 Mantenha-se atualizado com as alterações de seu projeto. Salve o projeto
como um arquivo NWF do Autodesk Navisworks. Abrir o NWF e
Sincronizar as tarefas com as alterações do projeto na página 700.
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Tarefas do TimeLiner
A guia Tasks pode ser utilizada para criar e editar tarefas, para anexar tarefas
em itens de geometria, e para validar seu planejamento do projeto.

Você pode ajustar a vista da tarefa.

Adicionar novas colunas do usuário para o conjunto padrão de colunas. Isso
é útil quando você importa dados de arquivos de projeto externos que contêm
mais campos do que o TimeLiner.

Para mover uma coluna

1 Abra a janela TimeLiner e clique na guia Tasks.

2 Posicione o mouse sobre o cabeçalho da coluna que você deseja mover
e pressione o botão esquerdo do mouse.

3 Arraste o cabeçalho da coluna para a localização desejada e solte o botão
esquerdo do mouse.

Para redimensionar uma coluna

1 Abra a janela TimeLiner e clique na guia Tasks.

2 Selecione a linha de grade na borda direita do cabeçalho da coluna a ser
redimensionada.

3 Arraste para a direita para aumentar a coluna ou para a esquerda, para
reduzi-la.
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Para especificar a ordem de classificação

1 Clique no cabeçalho da coluna que deseja utilizar e clique novamente
para alternar entre crescente/decrescente.

A ordem crescente classifica a coluna iniciando com o valor menor e
finalizando com o valor maior (por exemplo: a-z, 0-9, Segunda a
Sexta-feira). A ordem decrescente classifica a coluna iniciando com o
maior valor e finalizando com o menor valor.

OBSERVAÇÃO Se a classificação é selecionada na coluna Status , as
atividades serão classificadas da data inicial mais cedo a mais tarde como
ascendente e vice-versa para descendente. A hierarquia das tarefas é
preservada durante o processo de classificação, ou seja, as tarefas são
classificadas primeiro pelo contêiner e, a seguir, pelo conteúdo do contêiner.

OBSERVAÇÃO Somente é possível classificar uma coluna de cada vez. Ao invés
de utilizar o menu de atalho para alterar a ordem de classificação, você pode clicar
no cabeçalho da coluna desejada. Isso alterna a ordem de classificação entre
ascendente e descendente.

Para adicionar uma coluna do usuário

1 Na janela TimeLiner, guia Tasks, clique no menu suspenso Column
Set botão  ➤ Choose Columns.

2 Na caixa de diálogo Choose TimeLiner Columns, selecione a caixa
de seleção junto a uma das dez colunas de usuário disponíveis (por
exemplo, User 1) e clique em OK.

A coluna personalizada do usuário foi adicionada noTimeLiner. Por
padrão, ela tem o mesmo nome da opção selecionada na caixa de diálogo.

3 Clique com o botão direito do mouse na coluna adicionada, clique em
Rename User Column, e digite um nome, por exemplo 'Custo'.

OBSERVAÇÃO Para preencher essa coluna com dados, você precisa mapear o
campo do usuário (neste caso, User 1) para o campo de dados correspondente
das origens de dados. Para obter mais informações, consulte Caixa de diálogo
Field Selector na página 660.

Para excluir uma coluna do usuário

1 Na janela TimeLiner, guia Tasks, clique no menu suspenso Column
Set botão  ➤ Choose Columns.
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2 Na caixa de diálogo Choose TimeLiner columns, desmarque a caixa
de seleção ao lado da coluna do usuário que deseja remover e clique em
OK.

Criar tarefas

No TimeLiner as tarefas podem ser criadas das seguintes formas:
■ Manualmente, um de cada vez.

■ Automaticamente, com base nas estruturas dos objetos na Selection Tree,
ou nos conjuntos de seleção e de pesquisa.

■ Automaticamente, criadas a partir de origens de dados adicionadas ao
TimeLiner.

DICA Diferente de tarefas manuais, que precisam ser anexadas na geometria em
seu modelo, as tarefas automáticas serão anexadas na geometria correspondente
assim que são criadas.

Para adicionar uma tarefa manualmente

1 Carregue seu modelo no Autodesk Navisworks (consulte Abrir arquivos
na página 223 se precisar de ajuda).

2 Clique na guia Home ➤  Tools painel  ➤  TimeLiner  , e clique
na guia Tasks na janela TimeLiner.

3 Clique com o botão direito em qualquer lugar da vista, e clique em Add
Task no menu de atalho.

OBSERVAÇÃO Você pode clicar em uma tarefa existente e selecionar Insert
Task para inserir uma tarefa acima da tarefa selecionada.

4 Insira um nome para sua tarefa e pressione Enter. A tarefa é agora
adicionada em seu planejamento.

OBSERVAÇÃO Se você pressionar Enter quando a última tarefa na vista de
tarefas estiver selecionada, uma nova tarefa será criada abaixo dela.
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Para adicionar tarefas com base na estrutura da Selection Tree

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner , na guia Tasks , clique com o botão direito do
mouse em Task View, e clique em Auto-Add Tasks no menu de atalho.

3 Clique em For Every Topmost Layer se você deseja criar tarefas com
os mesmos nomes que da camada mais superior na Selection Tree.

Clique em For Every Topmost Item se você deseja criar as tarefas com
os mesmos nomes de cada item mais superior na Selection Tree. Este
pode ser uma camada, um grupo, bloco ou célula ou geometria,
dependendo de como o modelo está construído.

OBSERVAÇÃO  As datas PlannedStart e End serão automaticamente criadas,
começando da data atual do sistema e sendo incrementadas por um dia para cada
data inicial e final subsequente. O Task Type será definido como Construct.

Para adicionar tarefas com base nos conjuntos de seleção e de pesquisa

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner , na guia Tasks , clique com o botão direito do
mouse em Task View, e clique em Auto-Add Tasks no menu de atalho.

3 Clique em For Every Set para criar tarefas com os mesmos nomes de
cada seleção e conjunto de pesquisa na janela encaixável Sets.
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OBSERVAÇÃO  As datas PlannedStart e End serão automaticamente criadas,
começando da data atual do sistema e sendo incrementadas por um dia para cada
data inicial e final subsequente. O Task Type será definido como Construct.

Editar tarefas

É possível editar qualquer parâmetro da tarefa diretamente no TimeLiner.
No entanto, as alterações feitas nas tarefas importadas dos arquivos de projetos
externos serão substituídas na próxima vez que você atualizar as origens de
dados correspondentes.

Para alterar o nome da tarefa

1 Na janela TimeLiner, guia Tasks, selecione a linha com a tarefa que
deseja modificar e clique em seu nome.

2 Insira um nome para a tarefa e pressione Enter.

Entrada do comando: F2

Para alterar a data e hora da tarefa

OBSERVAÇÃO Por padrão, o horário não é exibido. Para exibir um horário para
tarefas, abra o Options Editor, clique em Tools ➤ TimeLiner e marque a caixa
de seleção Show Time.

1 Na janela TimeLiner na guia Tasks , clique com o botão direito do
mouse na tarefa que deseja modificar.

2 Modificar a data da tarefa:

Clicar no botão suspenso nos campos Actual Start e Actual End abre
o calendário e permite definir as datas ActualStart/End.

Clicar no botão suspenso nos campos Planned Start e Planned End
abre o calendário, e permite definir as datas PlannedStart / End.
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Utilize os botões de seta esquerda e direita no topo do calendário para
mover para atrás e adiante em um mês, respectivamente, e a seguir clique
no dia desejado.

3 Para alterar a hora inicial e final, clique na unidade de tempo que deseja
modificar (horas, minutos ou segundos), e a seguir insira o valor. Você
pode utilizar as teclas de seta esquerda e direita para mover entre as
unidades no campo de hora.

Para copiar e colar valores de data/hora

1 Na janela TimeLiner na guia Tasks, clique com o botão direito do
mouse no campo de data que deseja copiar, por exemplo Planned Start.

2 Clique em Copy Date/Time.

3 Clique com o botão direito do mouse em outro campo de data e clique
em Paste Date/Time.

OBSERVAÇÃO No momento, não é possível utilizar o atalho de teclado Ctrl +
Ce Ctrl + V para copiar e colar valores de data/hora.

Para definir ou modificar o tipo de tarefa

1 Na janela TimeLiner na guia Tasks , clique com o botão direito do
mouse na tarefa que deseja modificar.

2 Na lista suspensa Task Type , selecione o tipo de tarefa que deseja que
esta tarefa seja. Por padrão, você pode escolher entre:
■ Construct

■ Demolish

■ Temporary

O tipo de tarefa define como os itens anexados na tarefa serão exibidos
durante a simulação. Por exemplo, uma sequência padrão de construção
iria iniciar com todos os itens ocultos, e quando a tarefa inicia os itens
anexados serão exibidos em verde transparente, e quando a tarefa termina
os itens anexados serão exibidos na exibição normal do modelo (isso
pode ser com os materiais aplicados se tiverem sido anteriormente
definidos na ferramenta Presenter). Os próprios tipos de tarefas podem
ser definidos e novos tipos podem ser criados no Guia Configure na
página 655.
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OBSERVAÇÃO É possível alterar rapidamente o tipo de todas as tarefas
selecionadas. Para fazer isto, pressione a tecla SHIFT ou CTRL e selecione tarefas
desejadas, clique com o botão direito do mouse na seleção e, a seguir, clique em
Fill Down no menu de atalhos. O tipo especificado para a primeira tarefa
selecionada será utilizado para todas as tarefas no intervalo.

Para excluir uma tarefa

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner , na guia Tasks , clique com o botão direito do
mouse na tarefa que deseja excluir, e clique em Delete Task no menu
de atalho.

OBSERVAÇÃO A exclusão da tarefa no nível raiz exclui todas atarefas na
hierarquia. Caso tenha cometido algum erro, utilize o botão Undo  na
barra de ferramentas Quick Access para restaurar o elemento excluído.

Use Gráficos Gantt

A vista Gantt Chart na guia Tasks fornece uma representação visual de suas
tarefas. O eixo horizontal representa o intervalo de tempo do projeto, dividido
em incrementos (tais como dias, semanas, meses e anos) e o eixo vertical
representa as tarefas do projeto. As tarefas podem ser executadas
sequencialmente, em paralelo, ou sobrepostas.

É possível arrastar uma tarefa para diferentes datas ou clicar em qualquer
extremidade da tarefa e arrastá-la para estender ou encurtar sua duração. Todas
as alterações são atualizadas automaticamente na vista Task. Da mesma forma,
modificar um campo na vista Tasks modifica o campo correspondente na
vista Gantt Chart.

Para visualizar um gráfico Gantt para datas Atuais

1 Clique na guia Home ➤  Tools painel  ➤  TimeLiner  , e clique
na guia Tasks na janela TimeLiner.

2 Selecione Actual na opção suspensa Display Dates.
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Para visualizar um gráfico Gantt para datas Planejadas

1 Clique na guia Home ➤  Tools painel  ➤  TimeLiner  , e clique
na guia Tasks na janela TimeLiner.

2 Selecione Planned na opção suspensa Display Dates.

Para visualizar um gráfico Gantt para datas Planejada contra Atual

1 Clique na guia Home ➤  Tools painel  ➤  TimeLiner  , e clique
na guia Tasks na janela TimeLiner.

2 Selecione Planned vs Actual na opção suspensa Display Dates.

Para alterar a resolução de um gráfico Gantt

1 Clique na guia Tasks na janela TimeLiner.

2 Opcionalmente: use a opção suspensa Display Dates para personalizar
o gráfico Gantt exibido. Por padrão, as datas Planned são utilizadas.

3 Arraste o deslizador de Zoom para ajustar a resolução do gráfico. A
posição mais à esquerda seleciona o menor incremento disponível na
linha do tempo (por exemplo, dias); a posição mais à direita seleciona o
maior incremento disponível na linha do tempo (por exemplo, anos).

Anexar tarefas na geometria

Cada tarefa precisa ser anexada aos itens no modelo antes que a simulação
4D funcione. Você pode criar e anexar tarefas ao mesmo tempo ou pode
primeiro criar todas as tarefas, e a seguir anexá-las, separadamente ou em lotes
definidos por regra.

As tarefas podem ser anexadas na seleção atual na Scene View, ou em
qualquer conjunto de seleção ou de pesquisa. Você pode ver o tipo de anexos
na coluna Attached. Por padrão, esta coluna está localizada após Task Type,
mas é possível movê-la, por exemplo, na frente da coluna Start.
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Anexar manualmente as tarefas

Para anexar uma tarefa a uma seleção atual

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Selecione os objetos de geometria desejados na Scene View, ou na
Selection Tree.

3 Na janela TimeLiner, na guia Tasks, clique com o botão direito do
mouse na tarefa necessária, e clique em Attach Selection no menu de
atalho.

Para anexar uma tarefa a um conjunto de seleção ou a um conjunto de
pesquisa

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner, na guia Tasks, clique com o botão direito do
mouse na tarefa necessária, clique em Attach Selection Set e clique
no conjunto de seleção ou de pesquisa necessário.

Para anexar uma tarefa a uma pesquisa atual

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Execute a pesquisa desejada a partir da janela encaixável Find Items.
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3 Na janela TimeLiner, na guia Tasks, clique com o botão direito do
mouse na tarefa necessária, e clique em Attach Current Search.

Para adicionar múltiplas tarefas em um conjunto de seleção ou de pesquisa

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner na guia Tasks , mantenha pressionada a tecla
Ctrl ou Shift para selecionar todas as tarefas requeridas.

3 Clique com o botão direito do mouse na seleção de tarefa, clique em
Attach Set, e clique no conjunto de seleção ou de pesquisa necessário.

Para anexar múltiplas tarefas em uma seleção atual

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Selecione os objetos de geometria desejados na Scene View, ou na
Selection Tree.

3 Na janela TimeLiner na guia Tasks , mantenha pressionada a tecla
Ctrl ou Shift para selecionar todas as tarefas requeridas.

4 Clique com o botão direito do mouse na seleção de tarefas e clique em
Attach Current Selection no menu de atalho.

DICA Se você precisa adicionar itens adicionais a uma tarefa já anexada, clique
na opção Append Current Selection no menu de atalho; caso contrário,
quaisquer anexos anteriores da tarefa serão sobrepostos. Se você tiver cometido
um erro, clique com o botão direito do mouse na tarefa e clique em Clear
Attachment.

Utilizar regras para anexar tarefas

A anexação manual de tarefas poderia levar muito tempo. É uma boa prática
utilizar nomes de tarefas, que correspondem às camadas na Selection Tree,
ou criar conjuntos de seleção e de pesquisa que correspondam aos nomes das
tarefas. Se este for o caso, então você pode aplicar regras predefinidas ou
personalizadas para anexar instantaneamente tarefas nos objetos no modelo.
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Regras predefinidas

■ Items By Task Name. Escolha esta regra para anexar item de geometria
no modelo em cada tarefas com o mesmo nome na coluna especificada.
O padrão é utilizar a coluna Name.

■ Selection Sets By Task Name. Escolha esta regra para anexar cada
Conjunto de seleção e de Pesquisa no modelo para cada tarefa com o
mesmo nome na coluna especificada. O padrão é utilizar a coluna Name.

■ Layers By Task Name. Escolha esta regra para anexar cada camada no
modelo para cada tarefa com o mesmo nome na coluna especificada. O
padrão é utilizar a coluna Name.

■ Attach Items to Task by Category/Property. Escolha esta regra para
anexar cada item no modelo com a propriedade definida, para cada tarefa
com o mesmo nome na coluna especificada. O padrão é utilizar a coluna
Name;no entanto, você também precisará definir os valores <categoria>
e <propriedade>.

Para adicionar regras personalizadas do TimeLiner

1 Na guia Tasks da janela do TimeLiner, clique no botão Rules.

2 Na caixa de diálogo TimeLiner Rules, clique no botão New.

A caixa de diálogo Rules Editor é exibida.

3 Insira um novo nome para sua regra na caixa Rule Name.
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OBSERVAÇÃO Se optar por não inserir um nome, ao selecionar um modelo
de regra, o nome desse modelo será usado.

4 Na lista Rule templates , escolha um modelo do qual sua regra terá
base.

OBSERVAÇÃO O modelo Attach Items to Tasks é o utilizado para as três
primeiras regras do TimeLiner, ou seja, Items, Selection Sets e Layers
By Task Name.

O modelo Attach Items to Tasks by Category/Property permite
especificar uma propriedade dentro da cena do modelo. Se uma tarefa
tem o mesmo nome do valor da propriedade especificada no modelo,
então todos os itens que tenham aquela propriedade serão anexados
naquela tarefa, quando você seleciona a regra Attach Items to Tasks
by Category/Property, e clica em Apply Rules.

5 Na caixa Rule Description, clique em cada um dos valores
sublinhados para definir sua regra personalizada. Os valores
personalizáveis disponíveis nos modelos inclusos, são:
■ Column Name. Escolha qual coluna no Guia Tasks na página 649

deseja comparar os nomes de Item. O valor padrão é a coluna Name,
embora seja possível escolher outras colunas disponíveis, por exemplo,
uma das dez colunas User identificadas no Caixa de diálogo Field
Selector na página 660.

■ Items. Escolha com que você gostaria que o valor na coluna seja
comparado na cena do modelo. O padrão é o nome do Item , embora
você possa também escolher Selection Sets ou Layers.

■ Matching. Utilize a sensibilidade de maiúsculas e minúsculas
e , portanto, somente coincida os nomes coincidentes que sejam
exatamente os mesmos. Você também pode escolher Ignoring para
ignorar a sensibilidade de maiúsculas e minúsculas.

■ Category/Property Name. Utilize o nome da categoria ou propriedade
como estiver exibido na interface (recomendado). Você também pode
escolher Internal Name que é acessado através da API (somente
para usuários avançados).

■ “<category>”. Escolha na lista disponível, em qual a categoria a
propriedade que deseja definir se encontra. Somente as categorias
que estão contidas na cena estão disponíveis na lista suspensa.

■ “<property>”. Escolha na lista disponível, qual a propriedade que
deseja definir. Somente as propriedades na cena dentro da categoria
escolhida estão disponíveis.
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6 Clique em OK para adicionar uma nova regra do TimeLiner ou em
Cancel para retornar para a janela TimeLiner Rules.

Para aplicar regras do TimeLiner

1 Abra a janela TimeLiner e clique no botão Rules na guia Tasks.

2 Selecione as caixas de seleção para todas as regras que deseja aplicar. As
regras serão aplicadas na ordem.

OBSERVAÇÃO Você também pode clicar no botão Import/Export

Attachment Rules  que permite importar/exportar regras de/para um
arquivo XML. As regras importadas irão substituir quaisquer regras atuais
com o mesmo nome.

3 Se a caixa de seleção Override Current Selections estiver selecionada,
quando as regras forem aplicadas, elas irão substituir quaisquer itens
anexados. Caso contrário, as regras irão anexar itens nas tarefas relevantes
sem itens anexados.

4 Clique em Apply Rules.

OBSERVAÇÃO Para validar tarefas em seu planejamento, clique na guia Tasks,
clique com o botão direito do mouse em Task View e utilize o menu de atalho
Find. Esta opção pode ser ativada ou desativada no Options Editor (caixa de
seleção Tools ➤ TimeLiner ➤ Enable Find).

Validar o planejamento do projeto

Você pode verificar a validade de seu planejamento, ao identificar itens que
não foram incluídos em nenhuma tarefa, estão duplicados em múltiplas tarefas,
ou estão em tarefas sobrepostas. Isso é especialmente útil quando você utiliza
regras para anexar tarefas.

Qualquer item pode permanecer desanexado por diversos motivos. Por
exemplo, uma tarefa no arquivo de planejamento do projeto é omitida, ou o
item da geometria não foi incluído em um conjunto de seleção ou de pesquisa.

Para verificar um planejamento

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .
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2 Na janela TimeLiner, na guia Tasks, clique com o botão direito do
mouse na vista das tarefas e clique em Find. Se esta opção não estiver
disponível, abra o Options Editor e clique na caixa de seleção
Tools ➤ TimeLiner ➤ Enable Find.

3 Selecione uma das opções disponíveis:
■ Unattached/Uncontained Items (Itens desanexados/não

contidos). Escolha esta opção para selecionar quaisquer itens na cena
que não estão anexados em um tarefa, ou que não estejam contidos
dentro de qualquer outro item anexado na tarefa.

OBSERVAÇÃO Um item Contained é o secundário de outro item. Por
exemplo, se selecionar um Group, Block ou uma Cell que são
compostos de várias partes da geometria, então, essa geometria está
contida dentro do Group , Block ou Cell. Um Group, Block ou uma
Cell podem entretanto ser anexados a uma tarefa e embora a geometria
filha não esteja diretamente anexada à ela mesma, está contida dentro
do item ao qual está anexada.

■ Contained Items (Itens contidos). Escolha esta opção para selecionar
quaisquer itens na cena que estão anexados em um tarefa ou contidos
dentro que quaisquer outros itens anexados na tarefa.

■ Attached Items (Itens anexados). Escolha esta opção para selecionar
quaisquer itens na cena que estão diretamente anexados na tarefa.

■ Items Attached to Multiple Tasks (Itens anexados a múltiplas
tarefas). Escolha esta opção para selecionar quaisquer itens que estão
diretamente anexados em mais de uma tarefa.

■ Find items contained in multiple tasks (Localizar itens contidos
em múltiplas tarefas). Escolha esta opção para selecionar quaisquer
itens na cena que estão anexados ou contidos dentro de qualquer
item que está anexado em mais de uma tarefa.

■ Items Attached to Overlapping Tasks (Itens anexados a tarefas
sobrepostas). Escolha esta opção para selecionar quaisquer itens na
cena que estão anexados em mais de uma tarefa, ou quando as
durações das tarefas se sobrepõem.

■ Items Contained in Overlapping Tasks (Itens contidos em
tarefas sobrepostas). Escolha esta opção para selecionar quaisquer
itens na cena que estão ou contidos dentro de qualquer outro item
que está anexado em mais de uma tarefa quando as durações das
tarefas se sobrepõem.
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Os resultados da verificação são realçados na Selection Tree e na Scene
View.

Vincular com arquivos de projetos externos
Um dos mais poderosos recursos do TimeLiner é a sua integração com
software de planejamento de projeto. A lista de tarefas incluindo suas
datas/horas iniciais e finais podem ser importada de um arquivo de projeto
diretamente no TimeLiner.

OBSERVAÇÃO Ao abrir arquivos no Autodesk Navisworks 2012 que foram criados
no Autodesk Navisworks 2011 ou anterior, você pode perceber que as datas
Planned (Planejadas) e Actual (Reais) foram trocadas. Agora, o Autodesk
Navisworks utiliza as datas Planned por padrão em vez das datas Actual, como
é consistente com a maioria dos aplicativos de planejamento.

Para trocar os conjuntos de datas dos arquivos afetados, edite a origem de
dados (consulte Editar uma origem de dados na página 698), troque o
mapeamento das datas Planned e Actual na caixa de diálogo Field Selector
na página 660 e então reconstrua a hierarquia de tarefas (consulte Construir
tarefas a partir de origens de dados na página 699).

Software de planejamento suportado

O Autodesk Navisworks do Autodesk Navisworks suporta diversos softwares
de planejamento.

OBSERVAÇÃO Alguns destes podem somente funcionar se o software de
planejamento relevante estiver instalado.
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OBSERVAÇÃO  O Autodesk Navisworksdo Autodesk Navisworks suporta
múltiplas origens de planejamentos externos utilizando uma interface COM.
Qualquer um pode desenvolver o suporte para a nova origem de planejamento -
o tipo de biblioteca que define a interface está incluído no TimeLiner.

Microsoft Project 2003

Esta origem de dados exige que o Microsoft Project 2003™ seja instalado.

Microsoft Project 2007

Esta origem de dados exige que o Microsoft Project 2007™ seja instalado.

Microsoft Project MPX

TimeLiner pode ler diretamente os arquivos do Microsoft Project™ MPX,
sem ser necessário instalar uma cópia do Microsoft Project™ (ou qualquer
outro software de planejamento). O Primavera SureTrak™, o Primavera Project
Planner e o Asta Power Project™ podem todos exportar arquivos MPX.

OBSERVAÇÃO O Primavera SureTrak™ exporta sua identidade única no campo
de texto 10 do arquivo MPX, em vez de um único campo de identidade. Quando
você vincular um arquivo MPX exportado do SureTrak, certifique-se de especificar
o campo de texto 10 como o campo de identidade única na caixa de diálogo Field
Selector na página 660.
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Primavera Project Planner (P3)

Esta origem de dados requer que o Primavera Project Planner™ esteja instalado.
Uma vez que o link seja adicionado, seu status será exibido como " Status not
available" no TimeLiner.

OBSERVAÇÃO  O TimeLiner irá solicitar um nome de usuário e senha para
vincular com o Primavera Project Planner. Caso sejam desconhecidos, há a
possibilidade de que possam ser recuperados no atalho P3. Para localizar essa
informação, clique com o botão direito do mouse no atalho utilizado para executar
o P3, e selecione Properties. A caixa de diálogo Properties irá exibir a linha de
comando alvo que se parece com algo como

"C:\Program Files\P3\P3.exe /U:Bob"

Aqui, o nome do usuário é definido como "Bob" e para o propósito da
ferramenta TimeLiner, a senha será a mesma.

Primavera Project Management 4.1, 5.0, e 6.2

Esta origem de dados requer que diversos elementos sejam instalados junto
com o Autodesk Navisworks:

■ Produto Primavera Project Manager 4.1, ou 5.0, ou 6.2

■ ActiveX Data Objects 2.1

■ Primavera Software Development Kit (disponível nos CDs do Primavera)

PPM4 - 6 tem referência no banco de dados e como tal exige a instalação do
Software Development Kit, a fim de configurar o link de origem de dados
ODBC. Este pode ser instalado e definido a partir do CD do Project
Management CD, ao executar as seguintes etapas:

1 Insira o CD do Project Management, insira a Chave do Produto e aceite
o Contrato de Licença.

2 Assegure que Primavera Applications or Components esteja
selecionado, e clique em Next.

3 Selecione Other Components, e clique em Next.

4 Selecione Software Development Kit, e clique em Next.

5 Continue a clicar em Next até a instalação ser iniciada.

6 Quando a instalação tiver sido completada, clique em OK para iniciar o
assistente Database Configuration.
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7 Ajuste as configurações na caixa de diálogo Software Development
Kit Setup onde apropriado, e clique em OK.

8 Clique em Yes para um arquivo de registro, seguido por Finish para
completar.

Na conexão do PPM4 - ¨6 dentro do TimeLiner, uma caixa de diálogo de
logon permite que o link de origem seja selecionado (uma advertência ocorrerá
se nenhuma estiver presente). O nome do usuário e senha não serão
armazenados no arquivo do Autodesk Navisworks e serão solicitados para cada
vez.

Uma vez conectado, uma caixa de diálogo permite que o usuário selecione
qual projeto deve ser aberto. Uma caixa de seleção determina se todos os
subprojetos são abertos.

Por padrão, o, TimeLiner traz Start, End, Planned Start, e Planned End
como Start, Finish, BL Start and BL Finish respectivamente.

Outras datas do Primavera podem ser selecionadas através da caixa de diálogo
Field Selector na página 660 genérica, incluindo Project Activity Codes,
Global Activity Codes e User Defined Fields.

A hierarquia do TimeLiner suporta a estrutura WBS para a hierarquia de
Projeto / Atividade.

OBSERVAÇÃO Devido à natureza dos produtos Primavera Project Manager 4 - 6
que usam o SDK no acesso de dados, a importação de dados com o TimeLiner
pode demorar mais tempo que outros formatos.

Primavera P6 (Web Services)

Acessar ao Primavera P6 Web Services capability diminui de forma significativa
o tempo gasto para sincronizar o TimeLiner e as tabelas do Primavera.

Esta origem de dados requer a instalação de um Primavera Web Server. Consulte
o Primavera P6 Web Server Administrator Guide (disponível na documentação
do Primavera).

Asta Power Project 8 - 10

Esta origem de dados requer que a versão correspondente do Asta Power
Project™ seja instalada.
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Suporte CSV

A ferramenta TimeLiner apóia planejamentos de importação e exportação
nos formatos CSV/Excel.

É necessário usar vírgulas (",") ao salvar um arquivo CSV, ou do contrário terá
problemas ao importá-lo para o TimeLiner.

OBSERVAÇÃO Caso o produto do software use outros separadores ao invés de
vírgulas (","), tente ajustar as configurações do software. Você também pode
verificar as configurações de seu SO para o separador na lista regional.

É possível usar o Options Editor para alterar o formato do arquivo de texto
que será usado para importar/exportar um arquivo CSV para o TimeLiner.

Consulte também:

Importar dados de um planejamento de projeto externo na página 695

Export TimeLiner CSV na página 534

Adicionar e gerenciar origens de dados

Nesta seção, você aprenderá a criar, excluir e editar origens de dados.

Importar dados de um planejamento de projeto
externo

Para importar dados de um planejamento de projeto externo

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner, clique na guia Data Sources.

3 Clique no botão Add e escolha a opção requerida na lista de origens de
projetos que podem estar conectados no PC atual.

OBSERVAÇÃO Para obter mais informações sobre quais origens estão
normalmente disponíveis, consulte Software de planejamento suportado na
página 691.
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4 Utilize a caixa de diálogo padrão Open para procurar e abrir o arquivo
de projeto desejado.

O TimeLiner acessa o arquivo selecionado de acordo com os parâmetros
predefinidos configurados para a origem de dados correspondente
utilizando uma interface COM.

Dependendo da origem de dados, a caixa de diálogo Field Selector na
página 660 pode ser exibida. Você pode utilizá-lo para sobrepor algumas
das opções predefinidas de importação de dados.

5 Por padrão, a origem de dados é chamada de “New Link Source(x)”, em
que "x" é o último número disponível. Para tornar sua origem de dados
mais descritiva, clique nela com o botão direito do mouse, clique em
Rename no menu de atalho e insira um novo nome.

Para importar dados de um projeto do Primavera P6

OBSERVAÇÃO Siga o mesmo procedimento para importar dados de um projeto
do Primavera P6 V7, selecionando as opções do Primavera P6 V7 quando aplicável.

1 Se a janela TimeLiner já não estiver aberta, clique na guia

Home ➤ Tools painel  ➤ TimeLiner  .

2 Na janela TimeLiner, clique na guia Data Sources.

3 Clique no botão Add e clique em Primavera P6 (Web Services).

OBSERVAÇÃO Se a opção não estiver visível, é necessário configurar um
Primavera Web Server antes. Consulte o Primavera P6 Web Server
Administrator Guide (disponível na documentação do Primavera).

4 Quando a caixa de diálogo Primavera é exibida, insira o nome de usuário,
a senha e o endereço do servidor.

DICA O Server Address é o nome da máquina no domínio ou de um
endereço de IP para um servidor.
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5 Na caixa de diálogo Primavera P6 Database Instance Selection,
clique duas vezes no Instance ID desejado para selecioná-lo.

6 Na caixa de diálogo Primavera P6 Project Selection clique duas
vezes no arquivo de projeto desejado para abri-lo.

7 Utilize a caixa de diálogo Field Selector na página 660 para sobrepor
algumas das opções predefinidas de importação de dados.

O TimeLiner é conectado ao arquivo de projeto selecionado.

Para importar dados CSV

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner, clique na guia Data Sources.

3 Clique no botão Add e clique em CSV File.

4 Use a caixa de diálogo padrão Open para localizar o arquivo de projeto
desejado no formato CVS e clique em Open.

5 Na caixa de diálogo Field Selector na página 660, utilize a área CSV
Import Settings para especificar como seus dados devem ser importados
no TimeLiner.

OBSERVAÇÃO As configurações de importação CSV, incluindo mapeamentos
de campos, são lembradas pelo sistema e pré-preenchidos quando a caixa
de diálogo é aberta. Se você estiver vinculando um arquivo CSV diferente
do que estava sendo utilizado, o TimeLiner irá tentar mapear quaisquer
colunas para colunas de nome similar no arquivo CSV.

É recomendável ter uma coluna no arquivo CSV contendo dados únicos
(por exemplo, um número incremental) e mapeá-la para esta coluna
External ID. Isso permite que a sincronização dos os dados funcione,
mesmo se grandes alterações são feitas no arquivo CSV. Se o campo não
estiver mapeado, não será possível reconstruir ou sincronizar a origem
dos dados.

■ Selecione a caixa de verificação Row 1 Contains Headings se
desejar que a primeira linha do arquivo CVS seja usada como
cabeçalhos das colunas. O TimeLiner irá utilizá-los para preencher
as opções do External Field Name na grade.

A primeira linha de dados no arquivo CVS não contém cabeçalhos
de colunas, apague esta caixa de verificação.

■ Selecione a opção Automatically Detect Date and Time se
desejar que o TimeLiner tente determinar o formato de data/hora
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usado no arquivo CSV. Primeiro, o TimeLiner aplica um conjunto
de regras para tentar estabelecer o formato de data/hora utilizado no
documento e, caso não seja possível, ele utiliza as configurações locais
de seu sistema.

Selecione a opção Use Specific Date/Time Format se deseja
especificar manualmente o formato de data/hora que deve ser
utilizado. Quando este botão é selecionado, é possível inserir o
formato requerido na caixa fornecida. Para obter uma lista de códigos
válidos, consulte Caixa de diálogo Field Selector na página 660.

OBSERVAÇÃO Se for determinado que uma ou mais colunas com base
em data/hora contêm campos onde os dados não podem ser mapeados
para um valor válido de data/hora utilizando o formato manualmente
especificado, o TimeLiner irá 'retornar' e irá tentar utilizar o formato
automático de data/hora.

6 Por padrão, a origem de dados é chamada de “New Link Source(x)”, em
que "x" é o último número disponível. Para tornar sua origem de dados
mais descritiva, clique nela com o botão direito do mouse, clique em
Rename no menu de atalho e insira um novo nome.

Você agora está pronto para Construir tarefas a partir de origens de dados na
página 699.

Editar uma origem de dados

Para editar uma origem de dados

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia

Home ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner , na guia Data Sources, clique com o botão
direito do mouse no link que deseja modificar e clique em Edit no menu
de atalho.

A Caixa de diálogo Field Selector na página 660 é aberta.

Normalmente, esta caixa de diálogo é utilizada para personalizar o
mapeamento de colunas entre o TimeLiner e o arquivo de projeto
externo. Por exemplo, se o arquivo externo inclui as datas BaselineStart
e End, você pode desejar mapear estas datas com as colunas Start Date
e End Date no TimeLiner. Também, se você adicionou quaisquer
colunas do usuário  na página 677 no TimeLiner, para cada link, é preciso
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mapear os dados do arquivo externo com as colunas requeridas do usuário
no TimeLiner, caso contrário as colunas do usuário estarão vazias.

3 Clique em OK.

OBSERVAÇÃO Para cada origem de dados, é preciso reconstruir a hierarquia das
tarefas ou sincronizar as tarefas para aplicar as alterações.

Excluir uma origem de dados

Para excluir uma origem de dados

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner, na guia Data Sources, clique com o botão direito
do mouse na origem de dados que deseja excluir e clique em Delete no
menu de atalho.

Todas as tarefas e dados que foram lidos a partir da origem de dados irá
permanecer na guia Tasks.

OBSERVAÇÃO Caso tenha cometido algum erro, use o botão Undo na barra de
ferramentas Quick Access para restaurar o item excluído.

Construir tarefas a partir de origens de dados

Para construir tarefas a partir de uma origem de dados

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na janela TimeLiner, guia Data Sources, clique no botão Refresh,
selecione Selected Data Source ou All Data Sources e, a seguir,
selecione Rebuild Task Hierarchy na Caixa de diálogo Refresh from
Data Source na página 664 e clique em OK.

Isso irá importar todas as tarefas do arquivo de projeto no TimeLiner.

OBSERVAÇÃO Também é possível clicar com o botão direito do mouse na
guia Data Sources e selecionar a opção Rebuild Task Hierarchy.
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3 Clique na guia Tasks para visualizar as tarefas criadas. A tabela de tarefas
é preenchida de acordo com as configurações predefinidas para a origem
de dados. Você pode criar quaisquer substituições necessárias no Caixa
de diálogo Field Selector na página 660.

OBSERVAÇÃO Embora as tarefas agora tenham sido importadas para TimeLiner,
será necessário ainda Anexar tarefas na geometria na página 684 antes de executar
uma simulação 4D. A maneira mais rápida de anexar tarefas vinculadas é aplicando
regras (consulte Utilizar regras para anexar tarefas na página 686).

Sincronizar as tarefas com as alterações do
projeto

Quaisquer alterações feitas nas tarefas e nos dados das tarefas na origem de
dados externos podem ser facilmente atualizadas no TimeLiner.

Para atualizar as tarefas para refletir as alterações do projeto

1 Faça as alterações no projeto no software de planejamento e salve-o.

2 Carregue seu modelo no Autodesk Navisworks (consulte Abrir arquivos
na página 223 se precisar de ajuda).

3 Clique na guia Home ➤ painel Tools ➤ TimeLiner  e clique na
guia Data Sources na janela TimeLiner.

4 Clique no botão Refresh e selecione Selected Data Sources ou All
Data Sources.

5 Na caixa de diálogo Refresh from Data Source na página 664, selecione
uma das opções a seguir e clique em OK.
■ Rebuild Task Hierarchy. Escolha esta opção para reimportar todas

as tarefas e dados associados do(s) arquivo(s) de projeto selecionado(s)
e reconstruir a hierarquia de tarefas na guia Tasks.

■ Synchronize. Escolha esta opção para atualizar todas as tarefas
existentes na guia Tasks, com os dados associados mais recentes
do(s) arquivo(s) de projeto selecionado(s) (por exemplo, as datas
Start e End).

DICA Também é possível clicar com o botão direito do mouse na guia Data
Sources e selecionar a opção Synchronize ou Rebuild Task Hierarchy.
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Simulação 4D
Nesta seção, você irá aprender como reproduzir simulações 4D, e como
personalizar a reprodução e aparência da simulação.

Reproduzir simulações

Para reproduzir uma simulação

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na guia Tasks selecione a caixa de seleção Active para todas as tarefas
que deseja incluir na simulação.

3 Assegure que as tarefas ativas tenham Task Types na página 655 corretos
atribuídos.

4 Assegure que as tarefas ativas estão anexadas na página 684 com objetos
de geometria, e clique na guia Simulate.

5 Clique no botão Play  .

A janela TimeLiner exibe as tarefas da forma como são executadas, e
a Scene View mostra as seções do modelo que foram adicionadas ou
removidas ao longo do tempo, de acordo com os tipos de tarefas.

OBSERVAÇÃO Quando a guia Simulate está em uso, por padrão, a data de
simulação atual é sobreposta na Scene View. Você pode personalizar as
informações exibidas utilizando o Caixa de diálogo Overlay Text na página 670.

Configurar simulações

Você pode ajustar os parâmetros de reprodução da simulação a aparência da
simulação.

Reprodução da simulação

Por padrão, a duração de reprodução da simulação é definida em 20 segundos,
a despeito da duração das tarefas. Você pode ajustar a duração da simulação
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e diversas outras opções de reprodução para aumentar a eficácia de sua
simulação.

Para ajustar a reprodução da simulação

1 Se a janela TimeLiner ainda não tiver sido aberta, clique na guia

Home ➤ painel Tools ➤ TimeLiner  .

2 Clique na guia Simulation , e clique no botão Settings.

3 Quando a Caixa de diálogo Simulation Settings na página 664 for aberta,
modifique as configurações de reprodução e clique em OK.

Aparência da simulação

Cada tarefa tem um tipo de tarefa associado, que especifica como os itens são
anexados na tarefa e são tratados (e exibidos) no início e fim da tarefa durante
a simulação. As opções disponíveis são:
■ None - os itens anexados na tarefa não irão mudar.

■ Hide - Os itens anexados na tarefa serão ocultos.

■ Model Appearance - os itens anexados na tarefa serão exibidos com
forma definidos no modelo. Isto pode ser as cores de CAD originais, se
você aplicou sobreposições de cor e transparência no Autodesk Navisworks
ou materiais no Presenter, então estes serão exibidos.

■ Appearance Definitions - permite escolher na lista Appearance
Definitions, incluindo dez aparências predefinidas e diversas aparências
personalizadas que você possa ter adicionado.

Para adicionar uma definição de tipo de tarefa

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Clique na guia Configure e clique no botão Add.

3 Um novo tipo de tarefa é adicionado na parte inferior da lista e será
realçado, permitindo inserir um nome para o mesmo.

4 Selecione um dos campos Aparência e clique para abrir um menu
suspenso e atribuir o comportamento de objeto desejado.
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É possível personalizar as seguintes propriedades:

■ Start Appearance - qual a aparência dos itens no início da tarefa,
por exemplo, Verde transparente.

■ End Appearance - qual a aparência dos itens quando a tarefa é
completada, por exemplo, Oculto.

■ Early Appearance - qual a aparência dos itens se a tarefa for iniciada
antes da hora planejada, por exemplo, Amarelo transparente.

■ Late Appearance - qual a aparência dos itens se a tarefa for iniciada
após a hora planejada, por exemplo, Vermelho transparente.

■ Simulation Start Appearance - qual a aparência dos itens no
início de uma simulação.

OBSERVAÇÃO Como um mínimo, é necessário definir a Simulation Start
Appearance; isto atribui uma aparência inicial única ao tipo de tarefa. Se
você não configurar esse campo, a aparência inicial definida em Default
Simulation Start Appearance em Appearance Definitions Dialog Box na
página 672 será utilizada.

Para excluir uma definição de tipo de tarefa

1 Se a janela TimeLiner ainda não tiver sido aberta, clique na guia

Home ➤ painel Tools ➤ TimeLiner  .

2 Clique na guia Configure, clique na definição de tipo de tarefa e clique
no botão Delete.

Para adicionar uma definição de aparência

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Clique na guia Configure e clique em Appearance Definitions.

3 Clicar em Add

4 A nova definição de aparência é adicionada na parte inferior da lista e
será realçada, permitindo inserir um novo nome para a mesma.

5 No campo Transparency, utilize o controle deslizante para definir o
nível de transparência entre 0 e 100 (onde 0 é opaco e 100 é totalmente
transparente).
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6 No campo Color, clique duas vezes na cor para abrir o seletor de cores.
No seletor, selecione uma das cores básicas disponíveis, ou clique em
Define Custom Colors para definir sua própria escolha de cor.

7 Clique em OK.

Para excluir uma definição de aparência

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Clique na guia Configure e clique no botão Appearance Definition.

3 Na caixa de diálogo Appearance Definitions, selecione a definição
de aparência e clique em Delete.

4 Clique em OK.

Para alterar a aparência padrão do início da simulação

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  e clique na guia Configure.

2 Clique no botão Appearance Definitions. A caixa de diálogo
Appearance Definitions será aberta.

3 Na lista suspensa Default Simulation Start Appearance, selecione
a opção de aparência que você deseja utilizar para iniciar suas simulações.

4 Clique em OK.

Exportar
Você pode exportar uma imagem estática a qualquer momento durante uma
simulação ao utilizar uma das exportações padrão do Autodesk Navisworks
enquanto a guia Simulation estiver ativa. Consulte Exportar uma imagem
na página 529 para obter mais informações.

Você também tem a opção de exportar uma animação de toda uma simulação
do TimeLiner. Consulte Exportar uma animação  na página 531 para obter
mais informações.
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Adicionar uma animação
Nesta seção você aprende a como adicionar uma animação nas tabelas do
TimeLiner.

Visão geral

Você pode vincular animações do objeto e ponto de vista de seus planejamentos
de construção e pode aprimorar a qualidade das simulações. Por exemplo,
você pode iniciar sua simulação com uma câmera mostrando uma visão geral
de todo o projeto, e a seguir, como as tarefas são simuladas, aproximar o zoom
em áreas específicas para obter uma vista detalhada do modelo. Você também
pode reproduzir cenas de animações quando as tarefas são simuladas. Por
exemplo, você pode efetuar a animação da chegada e a arrumação das pilhas
de materiais junto com o movimento do veículo, e monitorar o acesso veicular
ao terreno.

Você pode adicionar a animação em todo o planejamento, para tarefas
individuais em um planejamento, ou combinar estes métodos para obter o
efeito desejado.

Para gravar uma animação, consulte Criar e editar animações de ponto de
vista na página 504 e Criar animações de objeto na página 563.

Também é possível adicionar scripts para as tarefas em seu planejamento. Ao
fazer isso, você obtém controle sobre as propriedades da animação. Por
exemplo, você pode ser capaz de reproduzir diferentes segmentos da animação
quando as tarefas são simuladas, ou reproduzir animações de trás para a frente,
e assim por diante.

Para gravar scripts, consulte Adicionar interatividade na página 578.

Adicionar uma animação em todo um
planejamento

A animação que pode ser adicionada em todo um planejamento está restrito
a pontos de vista, animações de ponto de vista e câmeras.

Uma animação adicionada de ponto de vista e câmera será automaticamente
dimensionada para coincidir com a duração da reprodução.
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Após ter adicionado uma animação para seu planejamento, você pode simulá-
la na página 701.

Para adicionar um ponto de vista atual ou uma animação do ponto de vista

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Selecione o ponto de visão exigido ou a animação do ponto de visão na
janela encaixável Saved Viewpoints.

3 Na janela TimeLiner, clique na guia Simulation , e clique no botão
Settings.

4 Na caixa de diálogo Simulation Settings , clique na seta suspensa do
campo Animation , e selecione Saved Viewpoints Animation.

5 Clique em OK.
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Para adicionar uma animação da câmera

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia

Home ➤ painel Tools ➤ TimeLiner  .

2 Clique na guia Simulation , e clique no botão Settings.

3 Na caixa de diálogo Simulation Settings , clique na seta suspensa no
campo Animation , e selecione a animação da câmera desejada, por
exemplo Scene1  ➤  Camera.

4 Clique em OK.

Adicionar animações em tarefas

A animação que pode ser adicionada em tarefas individuais no TimeLiner
são restritas a conjuntos de cenas e animações definidos de cenas.

Por padrão, quaisquer animações adicionadas são dimensionadas para se ajustar
a duração da tarefa. Você também tem a opção de reproduzir uma animação
em sua velocidade padrão (gravada), ao coincidir seu ponto inicial e final com
a tarefa.

OBSERVAÇÃO Quadros-chave de animação podem conter transparência e
substituição de cor. Durante a simulação do TimeLiner , os dados de sobreposição
de transparência e cores do Animator são ignorados.

Após ter adicionado a animação em suas tarefas, é possível simular na página
701 seu planejamento.

Para adicionar um cena com animação com um conjunto de animações

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na guia Tasks , clique na tarefa na qual deseja adicionar uma animação,
e utilize a barra de rolagem horizontal para localizar a coluna
Animation.

Se preferir, poderá mover as colunas de animação para antes da coluna
Start Date, como abaixo mostrado.
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3 Clique na seta suspensa no campo Animation , e selecione uma cena
ou um conjunto de animações de uma cena. Quando você seleciona a
cena, todos os conjuntos de animações gravados para esta cena serão
utilizados.

4 Clique na seta suspensa no campo Animation Behavior e selecione
como a animação será reproduzida durante esta tarefa:
■ Scale - a duração da animação é coincidida com a duração da tarefa.

Esta é a configuração padrão.

■ Match Start - a animação começa junto com a tarefa. Se a animação
passa do fim da simulação do TimeLiner , e o fim da animação será
recortado.

■ Match End - a animação inicia mais cedo para que termine justo
no fim da tarefa. Se a animação começa antes da simulação do
TimeLiner , o início da animação será recortado.

Adicionar scripts em tarefas

Quando você adiciona scripts em tarefas do TimeLiner , os eventos do script
são ignorados, e as ações do script são executas a despeito dos eventos.

A utilização de scripts permite controlar como a animação será reproduzida
(adiante, para atrás, um segmento de cada vez, e assim por diante). Você
também pode utilizar scripts para alterar os pontos de vista da câmera para
tarefas individuais, ou reproduzir diversas animações ao mesmo tempo.

OBSERVAÇÃO Antes de simular na página 701 o planejamento, certifique-se de
habilitar os scripts de animação no arquivo, clicando no botão Enable Scripts

 na guia Animation ➤ painel Scripts.
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Para adicionar um script

1 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

2 Na guia Tasks , clique na tarefa na qual deseja adicionar um script, e
utilize a barra de rolagem horizontal para localizar a coluna Script.

3 Clique na seta suspensa no campo Script , e selecione o script desejado
para ser executado com esta tarefa.

Adicionar uma animação | 709



710



Localizar e gerenciar
interferências

A ferramenta Clash Detective permite pesquisar todo o modelo de seu projeto,
identificando interferências interdisciplinares (interferências) no estágio inicial do
processo do projeto.

Visão geral da ferramenta Clash Detective
A ferramenta Clash Detective permite a eficaz identificação, inspeção e reporte
de interferências em um modelo de projeto 3D.

A utilização do Clash Detective pode ajudá-lo a reduzir o risco de erro humano
durante as inspeções do modelo.

Clash Detective pode ser usado como um “sanity check” para um trabalho
de projeto completo, ou pode ser usado como uma verificação de revisão do
projeto.

Você pode utilizar o Clash Detective para conduzir testes de interferência
entre a geometria 3D tradicional (triângulos) e nuvens de pontos digitalizados
a laser.

Você pode combinar a funcionalidade do Clash Detective com outras
ferramentas do Autodesk Navisworks:
■ A vinculação do Clash Detective com o Object Animation, fornece a

habilidade de verificar automaticamente as interferências entre objetos em
movimento. Por exemplo, a vinculação de um teste do Clash Detective
com uma cena com animação existente, iria realçar automaticamente as
interferências para objetos estáticos e em movimento durante a animação,
por exemplo, um guindaste girando através do topo do edifício, um caminhão
caçamba colidindo com um grupo de trabalho, e assim por diante.
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■ A vinculação do Clash Detective com oTimeLiner permite as verificações
de interferência com base no tempo no projeto. Consulte Selecionar itens
para serem testados na página 739 para obter detalhes adicionais sobre a
interferência com base no horário.

■ A vinculação do Clash Detective com o TimeLiner e o Object
Animation, permite o teste de interferência de planejamentos do
TimeLiner com completa animação.

Janela Clash Detective

A janela encaixável Clash Detective permite definir as regras e opções para
seus testes de interferência, visualizar os resultados, classificá-los e produzir
relatórios de interferência.

Informações de resumo de interferência

A guia Batch exibe as informações de resumo para cada um dos testes de
interferência exibidos. O número total de interferências em cada teste é exibido,
junto com o número de interferências em cada status de interferência
identificado.
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Um resumo do teste de interferência selecionado no momento é exibido no
topo das demais guias do Clash Detective. O número total de interferências
no teste é exibido com detalhes das interferências abertas (Nova, Ativa,
Revisada) e fechadas (Aprovada, Solucionada).

Para ativar a janela Clash Detective

■ Clique na guia Home ➤ painel Tools ➤ Clash Detective  .

Menu: Interface de usuário : Tools  ➤  Clash Detective

Para definir as opções do Clash Detective

1 Clique no botão do aplicativo  ➤ Options.

2 Expanda o nó Tools no Options Editor, e clique na opção Clash
Detective.
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3 Na página Clash Detective, utilize a caixa View in Context Zoom
Duration (seconds) para inserir o valor requerido. Quando você utiliza
a funcionalidade View in Context da guia Results da janela Clash
Detective, este valor especifica quanto tempo leva para afastar o zoom
da vista (utilizando uma transição com animação).

4 Utilize a caixa View in Context Pause (seconds) para inserir o valor
requerido. A executar um View in Context, o zoom permanece afastado
da vista, desde que você mantenha o botão pressionado. Se você clicar
rapidamente ao invés de manter o botão pressionado, este valor especifica
a duração de tempo em que o zoom permanece afastado da vista, para
que a transição não seja cortada no meio do fluxo.

5 Utilize caixa Animated Transition Duration (seconds) para inserir
o valor requerido. Quando você clica em uma interferência na grade de
resultados da janela Clash Detective, este valor é utilizado para suavizar
as transições da vista atual para a próxima.

OBSERVAÇÃO Esta opção somente é aplicável quando a caixa de seleção
Animate Transitions é selecionada na guia Results da janela Clash
Detective.

6 Utilize o deslizador Dimming Transparency para especificar o nível
de transparência de itens não envolvidos em interferências.

OBSERVAÇÃO Esta opção somente é aplicável quando as caixas de seleção
Dim Other e Transparent Dimming estão selecionadas na guia Results
da janela Clash Detective.

7 Selecione a caixa de seleção Use Wireframes for Transparent
Dimming para exibir os itens não envolvidos nas interferências como
estruturas de arame.

OBSERVAÇÃO Esta opção somente é aplicável quando as caixas de seleção
Dim Other e Transparent Dimming estão selecionadas na guia Results
da janela Clash Detective.

8 Clique em OK.

Guia Batch

A guia Batch permite gerenciar seus testes de resultados de interferências. Ela
mostra todos os testes de interferência definidos no momento, listados em
formato de tabela, e um resumo do status de todos os testes de interferência.
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Você pode utilizar a s barras de rolagem na parte inferior da guia para mover
entre os testes de interferência.

Você também pode alterar a ordem de classificação dos testes de interferência.
Para fazer isso, clique no cabeçalho da coluna desejada. Isso alterna a ordem
de classificação entre ascendente e descendente.

Botões

Utilize os botões na guia Batch para definir e gerenciar lotes de testes de
interferência.

Add - adiciona um novo teste de interferência no lote atual.

Delete - exclui o teste selecionado do lote atual.

Compact - exclui todas as interferências solucionadas no teste selecionado.

Clean - redefine o status de cada interferência no teste selecionado como
'New'.

Clear All - excluir todos os testes de interferência no lote e exibe um teste de
interferência simples e vazio.

Update - executa todos os testes de interferência no lote atual.
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Guia Rules

A guia Rules permite definir, personalizar e ignorar regras a serem aplicadas
nos testes de interferência. Ela lista todas as regras no momento disponíveis.
Estas podem ser utilizadas para que o Clash Detective ignore determinada
geometria do modelo durante um teste de interferência. Cada uma das regras
padrão podem ser editadas e novas regras podem ser adicionadas como
necessário.

OBSERVAÇÃO Um resumo do teste de interferência selecionado no momento é
exibido no topo da guia.

Guia Select

A guia Select permite definir o teste de interferência testando somente
conjuntos de itens de cada vez, em vez de testar o modelo inteiro. Utilize-a
para configurar os parâmetros para interferência no momento selecionada na
guia Batch.
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DICA Para executar todos os testas em seu lote, utilize o botão Update na guia
Batch.

OBSERVAÇÃO Itens ocultos não estão incluídos num teste de interferência. Um
resumo do teste de interferência selecionado no momento é exibido no topo da
guia.

Os painéis esquerdo e direito

Estes painéis contêm uma visualização em árvore de dois conjuntos de itens
que serão testados um contra o outro durante o teste de interferência e é preciso
selecionar os itens em cada painel.

Na parte inferior de cada painel, há diversas guias duplicando o estado atual
da janela Selection Tree. Você pode utilizar as guias para selecionar itens
para testes de interferência:

■ Standard - exibe a hierarquia da árvore padrão, incluindo todas as
instâncias.

■ Compact - uma versão simplificada da hierarquia da árvore.

■ Properties - a hierarquia com base nas propriedades do item.

■ Sets - mostra os mesmos itens como na barra de controle Selection Sets.
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O teste de interferência pode ser mais rápido, mais eficaz, e facilmente repetível,
caso você utilize conjuntos de seleção e de pesquisa. Considere com cuidado
quais conjuntos de objetos precisam de interferência uns com os outros e crie
conjuntos de seleção/pesquisa de acordo.

Botões Geometry Type

Os testes de interferência podem incluir a interferência de superfícies, linhas
e pontos dos itens selecionados.

 - interferências de superfícies do item. Esta é a opção padrão.

 - interferências de itens com linhas centrais, por exemplo, tubos.

 - interferência de pontos (laser).

A caixa de seleção Self Intersect

Selecione esta caixa de seleção caso deseje testar a seleção da geometria no
painel contra si própria, além de testá-la coma a seleção de geometria no outro
painel.

O botão Select Current

Você também pode selecionar geometria para teste de interferência diretamente
na Scene View e na janela encaixável Selection Tree.

Após ter selecionado os itens requeridos (mantenha pressionado Ctrl para
selecionar múltiplos objetos), clique no botão Select Current sob o painel
desejado para criar o conjunto de interferência correspondente.

O menu de atalho

Clicar com o botão direito do mouse no painel Esquerdo ou Direito abre
um menu de atalho:

Import Current Selection - tem o mesmo efeito de pressionar o botão
Select Current.

Select - seleciona os itens na Scene View.

Os controles de execução

Type Selecione um tipo de interferência. Há quatro tipos possíveis de
interferências:
■ Hard - dois objetos que de fato efetuam a intersecção.
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■ Hard (Conservative) - dois objetos são tratados como efetuando a
intersecção, mesmo se os triângulos da geometria não efetuem a intersecção.

OBSERVAÇÃO Por padrão esta opção é desativada. Para ativá-la, clique no

botão do aplicativo  ➤ Options. No Options Editor, expanda o nó
Interface , clique em Developer, e selecione a caixa de seleção Show
Internal Properties.

■ Clearance - dois objetos são tratados como efetuando a intersecção quando
estão dentro de uma distância especificada um do outro. A seleção deste
tipo de interferência também detecta quaisquer interferências duras.

Por exemplo, você pode utilizar este tipo de interferência quando os tubos
precisam ter espaço em torno deles para a isolação.

■ Duplicates - para efetuar a intersecção os dois objetos precisam ser
idênticos no tipo e posição.

Este tipo de teste de interferência pode ser utilizado para efetuar a
interferência do todo o modelo contra si próprio. Isso permite detectar
quaisquer itens na cena que podem ter sido duplicados por erro.

Tolerance Controla a gravidade das interferências reportadas e a habilidade
de filtrar interferências insignificantes, que podem ser assumidas para serem
solucionadas em torno do terreno. A tolerância é utilizada para os tipos Hard,
Clearance e Duplicate de teste de interferência.

Link Permite vincular um teste de interferência com o planejamento do
TimeLiner ou com uma cena de animação de objeto.

Step Permite controlar o Tamanho do intervalo a ser utilizado para
pesquisar por interferências em uma sequência de simulação.

Start Executa o teste de interferência selecionado.

Found Exibe o número de interferências encontradas.

Guia Results

A guia Results permite examinar interativamente as interferências
encontradas. Ela contém a lista de interferências e diversos controles para
gerenciá-las.

Você pode agrupar as interferências em pastas e subpastas para simplificar o
gerenciamento de grandes números de interferências ou de interferências
relacionadas.
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OBSERVAÇÃO Um resumo do teste de interferência selecionado no momento é
exibido no topo da guia.

A área Results

As interferências encontradas são mostradas em uma tabela com múltiplas
colunas. É possível usar a barra de rolamento à direita e na parte inferior da
guia  Results.

Por padrão, as interferências são numeradas e classificadas por gravidade na
página 883.

Você pode classificar e redimensionar colunas, se necessário.

OBSERVAÇÃO Se um teste de interferência foi alterado de alguma forma desde
que foi definido (isso pode incluir a alteração de uma opção ou o carregamento
da revisão mais recente do modelo), um aviso será exibido informando que os
resultados podem não refletir o modelo ou as configurações mais recentes. É
possível verificar os testes contra o modelo mais recente, executando os testes
novamente na guia Select ou atualizando todos os testes na guiaBatch.
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Os ícones de interferência

Um ícone é exibido na esquerda de cada nome de interferência. Ele identifica
visualmente um status de interferência, como segue:

 - New

 - Active

 - Reviewed

 - Approved

 - Resolved

O status da interferência

Cada interferência tem um status associado com a mesma. Este status é
automaticamente atualizado pelo Clash Detective cada vez que o mesmo
teste é executado, e você também pode atualizar o status.

■ New - uma interferência encontrada pela primeira vez na execução atual
do teste.

■ Active - uma interferência encontra em uma execução anterior do teste
e não solucionada.

■ Reviewed - uma interferência anteriormente encontrada e marcada por
alguma pessoa como revisada.

Isso pode ser usado em conjunto com a opção de atribuir a operação,
consulte Assign a Clash na página 751.

■ Approved - uma interferência anteriormente encontrada e aprovada por
alguma pessoa.

Caso o status seja alterado manualmente para "Approved", o usuário
atualmente conectado é gravado como o aprovador, e a hora do sistema
atual é adotada como a hora de aprovação.

Se o teste for novamente executado e a mesma interferência for encontrada,
o status permanece como 'Approved'.

■ Resolved - uma interferência encontrada em uma execução anterior do
teste e não na execução atual do teste. Portanto, o problema é supostamente
solucionado através de alterações no arquivo de projeto e o status é
automaticamente atualizado.

Caso o status seja manualmente alterado para "Resolved", e um novo teste
encontra a mesma interferência, seu status será alterado de volta para
"New".
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Os botões do grupo de interferências

New Clash Group  - cria um novo grupo vazio de interferências. Por
padrão, este é chamado de “New Clash Group (x)”, onde "x" é o último número
disponível.

Explode Group  - desagrupa o grupo selecionado de resultados de
interferência.

Os menus de atalho

Clicar com o botão direito numa interferência na guia Results abre o menu
de atalho a seguir:

■ Add Comment - adiciona um comentário na interferência selecionada.

■ Assign - abre a caixa de diálogo Assign Clash na página 785.

■ Focus on Clash - redefine o ponto de vista de interferência para que ele
fique focado no ponto original de interferência, se o ponto original estiver
longe.

■ Rename - renomeia a interferência selecionada.

■ Group - agrupa todas as interferências selecionadas. Uma nova pasta é
adicionada. Por padrão ele é denominado como New Clash Group (x),
onde x é o próximo número disponível.

OBSERVAÇÃO  Você precisa selecionar múltiplos itens para poder utilizar esta
opção.

■ Unassign - cancela a atribuição da interferência selecionada.

Clicar com o botão direito num grupo de interferência na guia Results abre
o menu de atalho a seguir:

■ Assign - abre a caixa de diálogo Assign Clash na página 785.

■ Collapse/Expand - expande ou retrai a pasta do grupo de interferências.

■ Add Comment - adiciona um comentário no grupo selecionado.

■ Focus on Clash - redefine o ponto de vista de interferência para que ele
fique focado no ponto original de interferência, se o ponto original estiver
longe.

■ Rename - renomeia o grupo selecionado.

■ Explode Group - desagrupa o grupo selecionado de resultados de
interferência.
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■ Explode Groups - somente disponível quando você seleciona múltiplos
grupos. Desagrupa todos os grupos selecionados de resultados de
interferência.

■ Unassign - cancela a atribuição do grupo de interferências selecionado.

Clicar com o botão direito numa interferência, que faz parte de um grupo de
interferências, na guia Results abre o menu de atalho a seguir:

■ Assign - abre a caixa de diálogo Assign Clash na página 785.

■ Add Comment - adiciona um comentário na interferência selecionada.

■ Focus on Clash - redefine o ponto de vista de interferência para que ele
fique focado no ponto original de interferência, se o ponto original estiver
longe.

■ Rename - renomeia a interferência selecionada.

■ Remove from a Group - remove as interferências selecionadas do grupo
de interferências.

■ Unassign - cancela a atribuição da interferência selecionada.

A área de exibição

Utilize as seguintes opções para ativar a revisão eficaz das interferências:

Select Filter Selecione esta caixa de verificação para mostrar somente as
interferências que envolvem os itens selecionados na Scene View na guia
Results. Se um grupo de interferências não contém quaisquer interferências
envolvendo o item selecionado, todo o grupo e seu conteúdo são ocultos da
vista.

Apague a caixa de verificação para exibir todos os resultados das interferências
na guia Results.

OBSERVAÇÃO Pastas de grupos vazias sempre permanecem invisíveis. Se um
grupo contém qualquer interferência envolvendo o item selecionado, o grupo (e
todas as interferências nele contidas) permanecem visíveis. No entanto, quaisquer
interferências individuais no grupo que não estejam diretamente envolvidas com
o item selecionados são exibidas em itálico.

Auto Reveal Para uma interferência individual, a seleção desta caixa de seleção
temporariamente oculta qualquer coisa que estiver obstruindo os itens com
interferência, para que você possa ver a interferência selecionada ao aproximar
o zoom nela, sem ter que mover sua localização.

Para um grupo de interferências, selecionar esta caixa de seleção mostra
automaticamente o 'pior' ponto de interferência no grupo na Scene View.
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Auto Zoom A seleção desta caixa de seleção efetua o zoom automático da
câmera, para mostrar todos os itens envolvidos na interferência selecionada
ou com o grupo de interferências selecionado.

Desmarcar esta caixa de seleção permite manter estático o ponto de vista
principal ao clicar através das interferências uma a uma.

Save Viewpoint A seleção desta caixa de seleção salva a vista atual da
interferência ou um grupo de interferência, para que quando a interferência
ou o grupo de interferências for novamente selecionado, a vista salva é exibida.

Animate Transitions Selecione esta caixa de seleção se requer um transição
com animação entre as interferências. Ao clicar numa interferência na guia
Results, a vista transita levemente da vista atual para a próxima. Você pode
utilizar o Options Editor para personalizar a duração das transições com
animação.

Por padrão, esta caixa de seleção está desmarcada.

DICA Para obter o benefício deste efeito, é preciso também selecionar a caixa de
seleção Auto Zoom ou a caixa de seleção Save Viewpoint.

Highlight All Selecione esta caixa de seleção para realçar todas as interferências
encontradas na Scene View.

Dim Other Selecione esta caixa de seleção para tornar todos os itens que não
envolvidos na interferência selecionada ou grupo de interferências selecionado
como cinza. Torna mais fácil ver os itens com interferência.

Transparent Dimming Esta caixa de seleção somente está disponível quando
você seleciona a caixa de seleção Dim Other.

Selecione esta caixa de seleção para renderizar todos os itens que não estão
envolvidos na interferência transparente, assim como em cinza. Você pode
usar o Options Editor para personalizar o nível de esmaecimento transparente
e selecionar a opção que determina que os itens não envolvidos na interferência
sejam exibidos como estruturas de arame. Por padrão, 85% de transparência
é utilizado.

Hide Other Selecione esta caixa de seleção para ocultar todos os outros itens,
exceto os envolvidos na interferência selecionada ou no grupo de interferências
selecionado. Isso permite focar melhor nos itens com interferência.

OBSERVAÇÃO A seleção desta caixa de seleção torna a opção Dim Other
indisponível. Desmarque esta caixa de seleção se deseja utilizar o esmaecimento
transparente.

Simulation Selecione esta caixa de seleção para utilizar a interferência com
base no tempo e suave (animação). Ela move o deslizador de reprodução na
sequência do TimeLiner ou em uma animação da cena para o ponto exato
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onde ocorre a interferência, e permite investigar os eventos que acontecem
imediatamente antes e depois da interferência. Para grupos de interferência,
o deslizador de reprodução é movido para o ponto no tempo da 'pior'
interferência no grupo. Consulte Resultados de teste de interferência com base
no tempo e suave na página 758.

A área View in Context

Utilize as opções nesta área para ajustar a forma pela qual os resultados de
interferência são exibidos na Scene View.

View in Context As opções nesta caixa permitem afastar temporariamente o
zoom para um ponto de referência no modelo, fornecendo contexto para a
localização da interferência. Escolha entre as seguintes opções:
■ View All - o zoom é afastado da vista para tornar toda a cena visível na

Scene View.

■ View File Extents - o zoom é afastado da vista (utilizando uma transição
animada), para que as extensões dos arquivos contendo os itens envolvidos
na interferência selecionada sejam visíveis na Scene View.

■ Go to Home View - leva você para uma previamente definida Vista inicial
na página 303.

Mantenha pressionado o botão View in Context  para mostrar a vista
de contexto escolhida na Scene View.

OBSERVAÇÃO O zoom permanece afastado da vista enquanto este botão estiver
pressionado. Se você clicar rapidamente (ao invés de manter pressionado) no
botão, o zoom é afastado da vista, fica afastado por alguns segundos, e a seguir
imediatamente aproxima novamente o zoom.

Os painéis Item 1 e Item 2

Estes painéis contêm dados dos itens com interferência e da interferência
selecionada na Results Area.

Isto inclui as Quick Properties relativas a cada item na interferência, e
também o caminho através da Selection Tree padrão, da raiz para a geometria
do item.

Clicar com o botão direito do mouse no painel Esquerdo ou Direito abre
um menu de atalho:

■ Select - seleciona os itens na Scene View, substituindo qualquer seleção
atual.
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■ Import Current Selection - os itens selecionados atualmente na Scene
View são selecionados na árvore, se o item existir na hierarquia visível no
momento.

■ Group Clashes Involving Item: cria um novo Clash Group contendo
todas as interferências envolvidas com o item ou itens nos quais você clicou
com o botão direito do mouse.

A caixa de seleção Highlight

Selecione esta caixa de seleção para sobrepor a cor do item na Scene View
com a cor do status da interferência selecionada.

O botão Select

Selecionar um item na área Item 1 ou Item 2 , e a seguir clicar neste botão,
seleciona um item com interferência na Scene View e na Selection Tree.

O botão SwitchBack

Selecionar um item na área Item 1 ou Item 2 e, a seguir, clicar neste botão,
permite que a vista atual e o objeto selecionado no momento sejam enviados
de volta para o pacote CAD de origem (somente aplicativos baseados em
AutoCAD, Revit 2012 e Microstation).

OBSERVAÇÃO Quando múltiplos itens são selecionados na árvore, este botão
está indisponível.

Guia Report

A guia Report permite definir e gerar relatórios contendo os detalhes de todos
os resultados de interferência encontrados no teste selecionado.

OBSERVAÇÃO Um resumo do teste de interferência selecionado no momento é
exibido no topo da guia.
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A área Contents

Selecione as caixas de seleção requeridas para especificar quais dados relativos
a interferência devem ser incluídos em seu relatório.

Por exemplo, você pode incluir Quick Properties relativas aos itens envolvidos
na interferência, informações sobre a tarefa do TimeLiner, imagem da
interferência, e assim por diante.

A área Include Clashes

For Clash Groups, Include Utilize as opções nesta caixa para especificar como
exibir os grupos de interferências em seu relatório. Escolha entre as seguintes
opções:
■ Group Headers Only - os relatórios somente irão incluir resumos das

pastas de grupos de interferências que você criou.

■ Individual Clashes Only - os relatórios somente irão conter resultados
de interferências individuais. Para cada interferência que pertença a um
grupo, um campo extra, denominado como Clash Group, pode ser
adicionado no relatório para identificá-la. Para ativar esta funcionalidade,
selecione a caixa de seleção Clash Group na área Contents.

■ Everything - os relatórios irão conter os resumos das pastas de grupos de
interferências que você criou e os resultados de interferências individuais.
Para cada interferência que pertença a um grupo, um campo extra,
denominado como Clash Group, pode ser adicionado no relatório para
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identificá-la. Para ativar esta funcionalidade, selecione a caixa de seleção
Clash Group na área Contents.

OBSERVAÇÃO Se seu teste não contém nenhum grupo de interferência, esta
caixa está indisponível.

Incluir tipos de interferência Selecione as caixas de seleção neste campo para
especificar quais interferências serão incluídas em seu relatório.

O tipo de relatório

Selecione o tipo de relatório na lista suspensa:

■ Current Test - cria um relatório único somente para o teste atual.

■ All Tests (Combined) - cria um relatório único para todos os testes.

■ All Tests (Separate) - cria um relatório separado para cada teste.

O formato do relatório

Selecione o formato do relatório na lista suspensa:

■ XML - cria um arquivo XML.

■ HTML - cria um arquivo HTML com as interferências listadas
sequencialmente.

■ HTML (Tabular) - cria um arquivo HTML (tabular) com os testes de
interferência exibidos·como tabela. Esse relatório pode ser aberto e editado
no Microsoft Excel 2007 e posterior.

■ Text - cria um arquivo TXT.

■ As Viewpoints - cria uma pasta denominada [Test_Name] na janela
encaixável Saved Viewpoints, e contém cada interferência salva como
um ponto de vista com um comentário anexado descrevendo a
interferência.

OBSERVAÇÃO Ao utilizar as opções de formato XML, HTML ou Texto,
considere o seguinte:

■ Por padrão, Clash Detective tenta incluir uma imagem de ponto de
visão JPEG para cada interferência. Assegure em selecionar a caixa de
seleção Image na caixa Contents , caso contrário o relatório irá conter
vínculos de imagem quebrados.

■ Para grupos de interferência, a imagem do ponto de vista é o ponto de
vista agregado para o grupo.
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■ É preciso criar uma pasta separada para o relatório e para suas imagens
de ponto de vista.

O botão Write Report

Cria o relatório selecionado e o salva na localização selecionada.

Definir e executar um teste de interferência

Para definir e executar um teste de interferência

1 Selecione um teste anteriormente selecionado de um lote na página 729,
ou inicie um novo teste.

2 Defina as regras na página 737 para o teste.

3 Selecione na página 739 os itens requeridos a serem incluídos no testem
e defina as opções de tipo de teste.

4 Reveja os resultados Resultados da interferência na página 747 e especificar
questões para entidades responsáveis.

5 Gerar um relatório na página 761 dos problemas identificados e distribuir
para revisão e resolução.

Lotes de interferências
Nesta seção você irá aprender como definir e gerenciar testes e lotes de testes.

Executar testes de interferência

Para executar testes de interferência

1 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .

2 Clique na guia Batch.

3 Para executar todos os testes no lote, clique no botão Update.

Para executar um teste único de um lote, selecione-o na Tests Area, e
clique em Guia Select na página 716, e clique no botão Start.
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Gerenciar lotes de testes de interferência

Para gerenciar lotes de testes de interferência

1 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home ➤ painel Tools ➤ Clash Detective  .

2 Clique na guia Batch.

OBSERVAÇÃO Um resumo do status de todos os testes de interferência é
exibido, o que permite identificar rapidamente os problemas "open" ou não
resolvidos.

3 Utilize os botões para gerenciar os testes:
■ Clique em Add para anexar um novo teste no lote atual.

■ Clique em Delete para excluir o teste no momento selecionado na
Tests Area do lote.

■ Clique em Compact para excluir todos os resultados de interferência
com um status de interferência na página 883 de Resolved do teste
para criar um arquivo menor.

■ Clique em Clean para redefinir todos os testes, para que eles sejam
os mesmos caso não os tivesse executado. Em outras palavras, isso
transformará o status do teste de interferência em  na página 883New.

■ Clique em Clear All para remover todos os testes do lote para poder
começar do zero.

OBSERVAÇÃO É possível renomear um teste selecionando-o e também
pressionando F2, ou clicando novamente no texto ressaltado. Você também pode
classificar as colunas na área Tests na ordem alfanumérica ao clicar nos cabeçalhos
de coluna. Clicar novamente alterna entre a ordem ascendente e descendente.

Mesclar testes de interferência de múltiplos
arquivos

Quando você mescla arquivos (guia Home ➤ painel Project ➤ Merge
), o Autodesk Navisworks combina todos os dados do teste de interferência.
Nenhuma geometria duplicada dos arquivos será carregada.
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Consulte também:

Mesclar arquivos na página 241

Importar testes de interferência

Os testes de interferência podem ser importados para o Autodesk Navisworks
e utilizados para definir testes de interferência predefinidos e genéricos.

OBSERVAÇÃO Se um teste de interferência que você deseja importar contém um
conjunto de pesquisa como uma das seleções de interferência, então o conjunto
de pesquisa também será importado junto com todas as outras regras de teste,
opções e informações de seleção.

Para importar um teste de interferência

1 Clique no botão do aplicativo  ➤ Import ➤ Clash Tests  .

2 Na caixa de diálogo Import , procure pela pasta que contém os dados
do teste de interferência, selecione-a, e clique em Open.
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Exportar testes de interferência

Os testes podem ser definidos para itens de interferência com base em
propriedades genéricas, incluindo a seleção direta de propriedades nos painéis
Left e Right na página 716 na guia Select, ou utilizando conjuntos de pesquisa
predefinidos.

Por exemplo, talvez tenha salvo um conjunto de pesquisa que localiza todos
os tubos de um tamanho específico, chamado “100mm Pipes”. Seu teste então
efetua a interferência de todos os tubos de 100mm contra todo o modelo. A
exportação deste teste de interferência permite importá-lo em outro modelo,
que irá definir automaticamente um teste de interferência entre tubos de
100mm e todo o modelo.

OBSERVAÇÃO Quaisquer testes de interferência que tenham base nas seleções
explícitas não serão exportados. Por exemplo, a interferência de uma camada
contra a outra não é um testes válido para exportação. Para realizar isto, utilize a
janela de encaixe Find Items (Shift+ F3) para procurar pelas camadas que têm
base em uma propriedade específica (por exemplo: Item, Name). Essas pesquisas
podem então ser salvas como Conjuntos de pesquisa, e finalmente selecionadas
nos painéis Left e Right na página 716 na janela Clash Detective.

Também é possível selecionar todos os arquivos carregados nos painéis Left e
Right na página 716 e o Clash Detective irá tratá-los como uma seleção de
todo o modelo.

Múltiplos testes genéricos podem ser definidos como um lote e exportados
para utilização por outros usuários do Autodesk Navisworks, ou por você
mesmo em outros projetos.

Para exportar um teste de interferência

1 Clique na guia Output painel  ➤ Export Data ➤ Clash Tests XML

 .

2 Na caixa de diálogo Export , insira um novo nome e localização de
arquivo, caso deseje utilizar outro que não seja o sugerido.
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3 Clique em Save.

Criar testes personalizados de interferência

Os testes de interferência exportados podem ser utilizados como um base para
definir testes personalizados de interferência. Se você tiver um conjunto comum
de testes de interferência que reutiliza em múltiplos projetos, pode torná-lo
um teste personalizado de interferência. Após ter sido instalado como um teste
personalizado de interferência, todo o lote de testes pode ser selecionado e
executado diretamente do Guia Select na página 716. Os resultados de todos
os testes no lote são combinados e apresentados como o resultado do teste
personalizado de interferência. O nome de cada teste no lote é exibido no
campo Description dos resultados.

Os testes personalizados de interferência são uma excelente forma de distribuir
um conjunto padronizado de testes através da organização. Eles permitem que
a perícia dos usuários "avançados" seja reutilizada por todos. Finalmente, eles
podem ser vistos como uma forma de implementar a inteligência de objeto.
Por exemplo, um teste personalizado de interferência poderia ser escrito e
verificado quanto a conformidade com o código de postura municipal para
construção com base nas informações do objeto e propriedades definidas em
um determinado sistema de CAD.
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Para definir e utilizar um teste personalizado de interferência

1 Exportar testes de interferência na página 732 para um arquivo XML. O
nome do arquivo é utilizado como o nome padrão para o teste
personalizado.

2 Se você desejar, altere o nome do teste personalizado ao editar
diretamente o arquivo XML. O elemento de nível superior no arquivo
XML é chamado "batchtest". O nome do teste personalizado como é
exibido ao usuário é definido pelo atributo "name". O nome do teste
personalizado como é salvo em um arquivo é definido pelo atributo
"internal name".

3 Para instalar o teste personalizado, copie o arquivo XML exportado para
a pasta custom_clash_tests de um dos diretórios de pesquisa do Autodesk
Navisworks, por exemplo: C:\Documents and Settings\All

Users\Application Data\Autodesk Navisworks Manage

2012\custom_clash_tests. Consulte Pesquisar diretórios na página 171
para obter mais informações.

4 Reinicie o Autodesk Navisworks. Na inicialização, o Clash Detective
verifica se nestes diretórios de pesquisa existem testes personalizados de
interferência.

5 Para utilizar o teste personalizado, abra a janela Clash Detective , e
clique na guia Select.

6 Selecione seu teste personalizado na caixa suspensa Type na página 716.

7 Clique no botão Start. Todas as outras opções e regras são especificadas
pelo teste personalizado.

Regras de interferência
Utilizar ignorar regras de interferência reduz o número de resultados de
interferência ao ignorar determinadas combinações de itens com interferência.
A ferramenta Clash Detective inclui a regras de interferência padrão e os
modelos de regras de interferência que podem ser utilizadas para criar regras
personalizadas de interferência.

Regras personalizadas de interferência

As seguintes regras para ignorar interferências estão embutidas:

■ Items in Same Layer - quaisquer itens com interferência encontrados
que estão na mesma camada, não são reportados nos resultados.
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■ Items in Same Group/Block/Cell - quaisquer itens com interferência
encontrados que estão no mesmo grupo (ou bloco inserido), não são
reportados nos resultados.

■ Items in Same File - quaisquer itens com interferência encontrados que
estão no mesmo arquivo (referenciado externamente ou anexado), não são
reportados nos resultados.

■ Items in Same Composite Object - quaisquer itens com interferência
encontrados que estão no mesmo objeto composto (um item composto
de múltiplas partes da geometria), não são reportados nos resultados.

■ Items in Previously Found Pair of Composite Objects - quaisquer
itens com interferência encontrados que façam parte do objeto composto
(um item composto de múltiplas partes da geometria), não são reportados
nos resultados.

■ Items with Coincident Snap Points - quaisquer itens com interferência
que tenham pontos de snap coincidentes, não são reportados nos
resultados. Isso pode ser particularmente útil para redes de tubulações feitas
de cilindros.

Modelos de regras

Você também pode criar suas próprias regras para ignorar interferências. Os
seguintes modelos de regras estão disponíveis (além das regras de interferência
padrão):

■ Insulation Thickness - quaisquer itens com interferência encontrados
que tenham um valor de obstrução maior do que a espessura da isolação
especificada, não são reportados nos resultados. Esta regra deveria ser
utilizada com um teste Clearance na página 716.

Se você tem um tubo que requer um espessura específica de isolação, então
poderá desejar executar um teste de obstrução naquele tubo, definindo a
tolerância de obstrução para a espessura requerida de isolação. Isso iria
identificar quaisquer áreas onde não há espaço suficiente em torno do tubo
para instalar a isolação.

Se você tem diversos tubos, todos requerendo diferentes espessuras de
isolação, ao invés de definir um teste de obstrução separado para cada
espessura, poderá definir um teste com a maior tolerância necessária, ou
seja, assumir que todos os tubos requerem a espessura máxima de isolação.
Esta regra pode ser aplicada para ignorar quaisquer interferências que são
falsamente identificadas, já que sua espessura real de isolação é menor do
que o espaço máximo utilizado.

Regras de interferência | 735



Consulte o diagrama baixo para obter um exemplo de onde esta regra para
ignorar seria aplicada:

O tubo 1 tem espessura de isolação t e C é o espaço máximo (isolação mais
espessa) requerida em qualquer lugar no modelo. Quaisquer itens (2) que
estejam na faixa de t a C não serão reportados nos resultados.

■ Same Property Value - quaisquer itens de interferência encontrados
que compartilham um valor de propriedade específico, não serão reportados
no resultados. Este modelo pode ser utilizado quando as informações estão
armazenadas na mesma propriedade.

■ Same Selection Sets - quaisquer itens de interferência encontrados que
estejam contidos no mesmo conjunto de seleção especificado, não serão
reportados no resultados.

■ Specified Selection Sets - quaisquer itens de interferência encontrados
que estejam contidos nos dois conjuntos de seleção especificados, não
serão reportados no resultados.

736 | Capítulo 15   Localizar e gerenciar interferências



■ Specified Properties with the Same Value - quaisquer itens de
interferência encontrados que compartilham o mesmo valor, mas estão
em duas propriedades diferentes, não serão reportados no resultados. Este
é um novo modelo de regras. Esta regra também permite procurar pela
propriedade em qualquer objeto principal. Por exemplo, a gaxeta
encontrada na extremidade de um tubo é registrada como uma interferência
com o bico de uma bomba. Estes itens deveriam estar conectados. A própria
gaxeta não tem nenhuma propriedade diretamente nela para identificar
que deviria ser conectada ao bico da bomba, no entanto, o objeto principal
da gaxeta o tem. Se você utilizar este modelo, o teste de interferência ignora
as interferências entre estes dois itens.

Para utilizar as regras de interferência

1 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home ➤ painel Tools ➤ Clash Detective  .

2 Clique na guia Batch , e selecione o teste que deseja configurar na Tests
Area.

3 Clique na guia Rules , e selecione as caixas de seleção para todas as regras
de exceção que deseja aplicar em seu teste.

Para adicionar um regra personalizada de interferência

1 Se a janela do Clash Detective ainda não estiver aberta, clique na guia

Home ➤  Tools painel  ➤  Clash Detective  .

2 Na guia Rules , clique no botão New.

3 Na caixa de diálogo Rules Editor , insira um novo nome para sua regra.
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4 Na lista Rule Templates , clique no modelo que deseja utilizar.

5 Na caixa Rule Description, clique em cada um dos valores sublinhados
para definir as regras personalizadas. Os valores personalizáveis
disponíveis com os modelos embutidos, são:
■ Name. Utilize o nome da categoria ou propriedade como estiver

exibido na interface (recomendado). Você também pode escolher
Internal Name que é acessado através da API (somente para usuários
avançados).

■ “<category>”. Escolha na lista disponível, em qual a categoria a
propriedade que deseja definir se encontra. Somente as categorias
que estão contidas na cena estão disponíveis na lista suspensa.

■ “<property>”. Escolha a propriedade que deseja definir na lista
disponível. Somente as propriedades na cena dentro da categoria
escolhida estão disponíveis.

■ Any Parent. Pesquisa pela propriedade definida na seleção
especificada. Any Parent é a opção padrão, embora seja possível
escolher também um Model, uma Layer, ou Last Object ou a
Geometry

■ o Last Object. Pesquisa pela propriedade definida na seleção
especificada. O Last Object é a opção padrão, embora seja possível
escolher também Any Parent, um Model, uma Layer ou a
Geometry.
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■ “<set>”. Escolha a partir da lista disponível, qual Set é necessário para
definir a regra. Apenas os Sets predefinidos Selection e Search estão
disponíveis na lista suspensa.

6 Clique em OK. A regra é adicionada na área Ignore Clashes Between
na guia Rules.

Para editar uma regra de interferência

1 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .

2 Na guia Rules , clique na regra para ignorar que deseja editar.

3 Clique no botão Edit.

4 Na caixa de diálogo Rules Editor , renomeie a regra se deseja modificar
seu nome atual.

5 Escolha outro Rule Template se deseja utilizá-lo em lugar de seu modelo
atual.

6 Na caixa Rule Description, clique em cada um dos valores sublinhados
para redefinir as regras personalizadas.

7 Clique em OK para salvar as alterações feitas na regra.

Para excluir uma regra de interferência

1 Se a janela do Clash Detective ainda não estiver aberta, clique na guia

Home ➤ painel Tools ➤ Clash Detective  .

2 Na guia Rules , clique na regra para ignorar que deseja excluir.

3 Clique no botão Delete para excluir a regra de interferência.

Selecionar itens para serem testados
Nesta seção você irá aprender como definir diversos parâmetros para seus
testes.
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Selecionar itens para um teste de
interferência

Para selecionar itens

1 Se a janela do Clash Detective ainda não estiver aberta, clique na guia

Home ➤ painel Tools ➤ Clash Detective  .

2 Clique na guia Batch e selecione o teste que deseja configurar.

3 Clique na guia Select.

Há dois painéis idênticos neste guia denominados Esquerdo e Direito.
Estes painéis contêm a Tree View dos dois conjuntos de itens que serão
testados um contra o outro durante o teste de interferência, e você precisa
selecionar os itens em cada um deles. Você pode selecionar os itens ao
escolher uma guia na árvore de seleção e manualmente selecionar itens
nas hierarquias da árvore. Quaisquer conjuntos de seleção na cena
também estão incluídos em uma guia, que é um método útil e rápido
para definir itens entre sessões (consulte Seleção interativa da geometria
na página 361).

Você também pode transferir a seleção atual para uma das caixas ao
selecionar itens na forma usual na Scene View ou na Selection Tree
, e clicando no botão Select Current apropriado.

4 Opcional: Selecione a caixa de seleção Self Intersect apropriada para
testar o conjunto correspondente para a auto-intersecção, assim como
uma intersecção contra o outro conjunto.

5 Opcional: Você pode incluir a interferência de pontos,, ou de linhas ou
de superfícies em seu teste. Abaixo de cada janela há três botões que
correspondem a superfícies, linhas e pontos. Para ativar um botão, clique
nele.

Portanto, por exemplo, se você deseja executar um teste de interferência
entre alguma geometria da superfície e uma nuvem de ponto, é possível
configurar a geometria no painel Left e clicar no botão Point Cloud

 sob o painel Right. O botão Surface  sob o painel Left está ativado
por padrão. Adicionalmente, você poderia definir o Type de interferência
como Clearance com uma Tolerance de um metro.

OBSERVAÇÃO Se o Type está definido como Hard, as linhas e superfícies
irão precisar de fato efetuar a intersecção com quaisquer pontos para registrar
a interferência.
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Selecionar as opções de teste de
interferência

Há quatro tipos padrão de teste de interferência dentre os quais escolher:
■ Hard. Escolha esta opção se você deseja que o teste de interferência detecte

as intersecções reais entre a geometria.

■ Hard (Conservative). Esta opção executa o mesmo teste de interferência
que a opção Hard, no entanto, ela aplica adicionalmente um método de
interseção conservadora na página 889.

OBSERVAÇÃO Este tipo de teste de interferência somente está disponível
quando no perfil Developer. Consulte Perfis na página 170 para obter mais
informações.

■ Clearance. Escolha esta opção se você deseja que o teste de interferência
verifique a geometria dentro de uma distância específica a partir de outra
geometria (consulte tolerância na página 889 para obter mais informações).
Você pode utilizar este tipo de interferência quando, por exemplo, os tubos
precisam ter espaço para isolação entre eles.

OBSERVAÇÃO As interferências de obstrução não são as mesmas que as
interferências "soft". As interferências de obstrução detectam a geometria
estática vindo de uma distância de outra geometria, enquanto a interferência
suave detecta interferências potenciais entre componentes em movimento. O
Clash Detective suporta a verificação de interferência suave quando você o
vincula com o Object Animation.

■ Duplicates. Escolha esta opção se você deseja testar a interferência para
detectar geometria duplicada. Você pode utilizar este tipo de teste de
interferência para verificar um modelo contra si próprio, para assegurar
que a mesma parte não foi desenhada ou referenciada duas vezes, por
exemplo.

Para selecionar as opções de teste de interferência

1 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .

2 Na guia Select , selecione o teste que deseja executar na lista suspensa
Type. Quaisquer testes personalizados de interferência que foram
definidos (consulte Criar testes personalizados de interferência na página
733) são exibidos no final da lista.
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3 Insira a Tolerância exigida, que estará em Unidades de exibição na
página 169. Consulte Terminologia do Clash Detective na página 883 para
obter mais informações.

4 Se você deseja executar um teste de interferência com base no tempo ou
suave, selecione a opção apropriada na caixa Link. Por exemplo, a seleção
do TimeLiner fará com que o Clash Detective produza um relatório
de interferência com base nas configurações do Clash Detective, nas
configurações de simulação do TimeLiner , e nos dados do projeto
contidos no TimeLiner. Para obter mais informações e exemplos de
utilização, consulte Teste de interferência com base no tempo e suave
na página 742.

Teste de interferência com base no tempo
e suave

A vinculação com um planejamento do TimeLiner integra os recursos do
Clash Detective e do TimeLiner , permitindo a automação da verificação
de interferência através do ciclo de vida de um objeto do TimeLiner.

De forma similar, a vinculação com um cena de animação de um objeto integra
os recursos do Clash Detective e do Object Animation, fornecendo a
habilidade de verificar automaticamente as interferências entre objetos em
movimento.

Finalmente, você pode vincular com um planejamento TimeLiner com
animação (um planejamento no qual algumas tarefas são vinculadas com
cenas de animação), e executar testes automáticos de interferência com base
no tempo e suave.

Interferência com base no tempo

Os modelos do projeto podem incluir a representação estática de itens
temporários, como pacotes de trabalho, navios, guindastes, instalações, e assim
por diante. Tais objetos estáticos podem ser adicionados no projeto do
TimeLiner , tabulados para aparecerem e desaparecerem em determinadas
localizações, sobre um período específico de tempo.

Quando estes objetos de pacotes estáticos se 'movem' em torno to terreno do
projeto, com base em um planejamento do TimeLiner , é possível que alguns
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objetos de pacotes estáticos poderiam, em algum ponto do planejamento,
ocuparem o mesmo espaço, ou seja 'interferirem'.

A definição de interferência com base no tempo, permite a verificação
automática disto através do tempo de vida do projeto. Quando uma sessão de
interferência com base no tempo é executada, a cada etapa da sequência do
TimeLiner , o Clash Detective é utilizado para verificar se ocorreu uma
interferência. Se tiver ocorrido, uma data de quando a interferência ocorreu
é registrada, junto com o evento que causou a interferência.

Você pode rever a Resultados da interferência na página 747 e, por exemplo,
replanejar a aparência do objeto para eliminar tais interferências.

Para preparar para a interferência com base no tempo

1 Cada pacote estático que você deseja utilizar, precisa ser modelado no
modelo do projeto cobrindo a área ou volume requeridos, pro exemplo,
é possível utilizar blocos semitransparentes.

2 Estes pacotes estáticos precisam ser adicionados nas tarefas do
planejamento do TimeLiner.

3 Tipos de tarefas extras precisam ser adicionados no TimeLiner (na guia
Configure) , para representar diferentes tipos de pacotes estáticos. Você
também precisa configurar a aparência de cada tipo de tarefa adicionada.

Para vincular com um planejamento do TimeLiner

1 No Autodesk Navisworks abra o arquivo de modelo do projeto que
contém o planejamento do TimeLiner com as tarefas de pacotes
estáticos.

2 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

3 Clique na guia Tasks e verifique se as tarefas de pacotes estáticos estão
exibidas.

4 Clique na guia Configure e verifique se os tipos de tarefas forma
adicionados para coincidirem com os pacotes estáticos.

5 Clique na guia Simulation e reproduza a simulação para visualizar os
pacotes estáticos sendo exibidos. Verifique se eles estão exibidos na
localização correta e ao longo dos períodos de tempo corretos.

6 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .
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7 Clique na guia Select.

8 Nos painéis Esquerdo e Direito selecione os objetos que deseja testar.

9 Na caixa suspensa Link selecione TimeLiner.

10 Clique no botão Start. Clash Detective fará uma verificação em cada
intervalo no projeto para ver se há alguma interferência presente. O
número de interferências encontradas é exibido na caixa Found.

OBSERVAÇÃO Se o projeto do TimeLiner tem um tamanho muito grande,
a execução deste tipo de teste de interferência, irá invariavelmente levar
mais tempo para ser completado do que uma execução de teste normal de
interferência.

Você pode agora rever na página 747 as interferências encontradas.

Interferência suave

Os modelos de projeto podem incluir a representação dinâmica de itens
temporários, como pacotes de trabalho, navios, guindastes, instalações, e assim
por diante.

Você pode utilizar a janela Animator para criar cenas com animação com
estes objetos, para que eles se movam em torno do terreno do projeto, mudem
de tamanho, e assim por diante. É possível que alguns objetos em movimento
possam colidir.

A definição da interferência suave permite a verificação automática disto.
Quando uma sessão de interferência suave é executada, em cada etapa de uma
sequência da cena, o Clash Detective é utilizado para verificar se ocorreu
uma interferência. Caso tenha, a hora da ocorrência da interferência é
registrada, junto com o evento que causou a interferência.

Você pode rever a Resultados da interferência na página 747 e, por exemplo,
replanejar os movimentos do objeto para eliminar tais interferências.

Para preparar para a interferência suave

1 cada objeto para o qual deseja efetuar uma animação, precisa ser
modelado no modelo do projeto cobrindo a área ou volume requerido,
pro exemplo, é possível utilizar blocos semi transparentes.

2 As cenas com animação com os objetos desejados precisam ser criadas
utilizando a janela Animator no Autodesk Navisworks.
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Para vincular com um Object Animation

1 No Autodesk Navisworks abra o arquivo do modelo do projeto que
contém as cenas com animação de objetos.

2 Se a janela do Animator ainda não estiver aberta, clique na guia

Home ➤ painel Tools ➤ Animator  .

3 Reproduza a animação. Verifique se os objetos com animação estão
exibidos na localização correta, no tamanho correto, e assim por diante.

4 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .

5 Clique na guia Select.

6 Nos painéis Esquerdo e Direito selecione os objetos que deseja testar.

7 Na caixa suspensa Link , selecione a cena com animação para a qual
vincular, por exemplo Scene1.

8 Na caixa Step insira o Tamanho do intervalo a ser utilizado ao
procurar por interferências na animação.

9 Clique no botão Start. Clash Detective fará uma verificação em cada
intervalo na animação para ver se há alguma interferência presente. O
número de interferências encontradas é exibido na caixa Found.

OBSERVAÇÃO Se a cena da animação tem um tamanho muito grande, a
execução deste tipo de teste de interferência, irá invariavelmente levar mais
tempo para ser completado do que uma execução de teste normal de
interferência.

Você pode agora rever na página 747 as interferências encontradas.

Interferência suave com base no tempo

Os modelos de projeto podem incluir a representação de itens temporários,
como pacotes de trabalho, navios, guindastes, instalações, e assim por diante.
Se você deseja utilizar objetos estáticos eles precisam ser adicionados no projeto
do TimeLiner , tabulados para aparecerem e desaparecerem em determinadas
localizações, sobre um período específico de tempo.

Adicionalmente, você pode criar cenas com animação dinâmica, para que os
objetos que se movem em torno do terreno do projeto, mudem de tamanho,
e assim por diante. Uma vez criadas, tais cenas precisam ser vinculadas com
tarefas no planejamento do projeto do TimeLiner.
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É possível que o aparecimento e desaparecimento de objetos estáticos possam
obstruir o movimento de objetos com animação no terreno.

A definição de interferência suave com base no tempo, permite a verificação
automática disto através do tempo de vida do projeto. Quando uma sessão de
interferência suave com base no tempo é executada, a cada etapa da sequência
do TimeLiner , o Clash Detective é utilizado para verificar se ocorreu uma
interferência. Se tiver ocorrido, uma data de quando a interferência ocorreu
é registrada, junto com o evento que causou a interferência.

Você pode rever a Resultados da interferência na página 747 e, por exemplo
mudar o roteiro de alguns objetos para evitar quaisquer conflitos de
espaço/tempo.

Para preparar para a interferência suave com base no tempo

1 É preciso definir os pacotes estáticos na página 743 necessários.

2 É preciso definir os pacotes dinâmicos na página 744 necessários.

3 É preciso vincular os pacotes dinâmicos (cenas com animação) com as
tarefas corretas no TimeLiner.

Para vincular com um planejamento do TimeLiner

1 No Autodesk Navisworks abra o arquivo de modelo do projeto que
contém o planejamento com animação do TimeLiner.

2 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  .

3 Clique na guia Tasks e verifique se as tarefas do pacote estáticos estão
exibidas, e se ao menos uma cena com animação foi vinculada com uma
das tarefas do TimeLiner.

4 Clique na guia Configure e verifique se os tipos de tarefas forma
adicionados para coincidirem com os pacotes estáticos.

5 Clique na guia Simulation e reproduza a simulação. Verifique se os
pacotes estáticos e dinâmicos estão exibidos na localização correta e ao
longo dos períodos de tempo corretos.

6 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .

7 Clique na guia Select.

8 Nos painéis Esquerdo e Direito selecione os objetos que deseja testar.

9 Na caixa suspensa Link selecione TimeLiner.
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10 Na caixa Step insira o Tamanho do intervalo a ser utilizado ao
procurar por interferências na cena com animação.

11 Clique no botão Start. Clash Detective fará uma verificação em cada
intervalo no projeto para ver se há alguma interferência presente. O
número de interferências encontradas é exibido na caixa Found.

OBSERVAÇÃO Se o projeto do TimeLiner tem um tamanho muito grande,
a execução deste tipo de teste de interferência, irá invariavelmente levar
mais tempo para ser completado do que uma execução de teste normal de
interferência.

Você pode agora rever na página 747 as interferências encontradas.

Executar um teste de interferência
individual

Para executar um teste de interferência individual

1 Se a janela Clash Detective ainda não estiver aberta, clique na guia

Home painel  ➤ Tools ➤ Clash Detective  .

2 Clique na guia Batch e selecione o teste que deseja executar.

3 Clique na guia Select e defina as opções de teste requeridas.

4 Após selecionar os conjuntos esquerdo e direito e o tipo de interferência
e tolerância ter sido definido, clique no botão Start para iniciar a
execução do teste.

A caixa Found mostra quantas interferências foram encontradas até este
momento durante este teste.

OBSERVAÇÃO A barra de andamento mostra o andamento do teste do
Clash Detective. Se você deseja parar o teste a qualquer momento,
pressione o botão Cancel. Todas as interferências encontradas até a
interrupção serão reportadas, e o teste será salvo com um status de Partial.

Resultados da interferência
Nesta seção você irá aprender como interagir com os resultados de seus testes
de interferência.
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Entender os resultados de interferências

Todas as interferências são mostradas na guia Results na tabela multi colunas.
Você pode clicar em qualquer cabeçalho de coluna para classificar a tabela
utilizando os dados da coluna. Essa classificação pode ser alfabética, numérica,
relacionada à data ou, para a coluna Status, na ordem do fluxo de trabalho:
New, Active, Reviewed, Approved e Resolved. Clicar repetidamente no
cabeçalho da coluna alterna a ordem de classificação entre ascendente e
descendente.

Se você executa um teste de interferência com base no tempo, suave ou suave
com base no tempo, a data inicial/final de quaisquer interferências são
registradas junto a interferência apropriada nas colunas Start e End , junto
com o nome do evento (uma cena com animação ou uma tarefa do
TimeLiner) na coluna Event. Se múltiplas interferência foram encontradas
em uma determinada data, cada interferência individual é listada com
informações de simulação idêntica.
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Os painéis Item 1 e Item 2 mostram as Quick Properties relativas a cada
item na interferência, e também o caminho através da Selection Tree padrão,
da raiz para a geometria do item.

Clicar em uma interferência realça os dois objetos envolvidos na interferência
na Scene View. Por padrão, o centro da interferência é o centro da vista, no
qual o zoom é aproximado para que as partes do objeto envolvidos na
interferência preencham a vista. Você pode utilizar as opções nas áreas Display
e View in Context para controlar como os resultados da interferência são
mostrados.

Quando seus resultados de interferências contêm múltiplas interferências que
estão associadas com um única questão de projeto, considere agrupá-las
manualmente. A organização das interferências em pastas pode simplificar o
acompanhamento das questões do projeto. Quando as interferências são
agrupadas, elas são listadas como uma interferência única nos resumos e nos
relatórios. A distância exibida para um grupo de interferências é a distância
da maior interferência "open" (aberta) em relação ao grupo.

OBSERVAÇÃO Quando você seleciona um grupo de interferências·que contém
interferências "open" (New, Active, Reviewed) e "closed" (Approved, Resolved),
as interferências abertas serão realçadas nos painéis Item 1 e Item 2 em vez das
interferências fechadas, independentemente do tamanho real das interferências.

Finalmente, a seleção de um item no painel Item 1 ou Item 2 , e a seguir
clicar no botão SwitchBack , envia a vista atual e o objeto no momento
selecionado de voltar para o pacote de CAD de origem. Isso torna muito simples
mostrar as interferências no Autodesk Navisworks, levá-las de volta para o
pacote de CAD, alterar o projeto, e a seguir recarregá-las no Autodesk
Navisworks, para uma rápida execução de revisão de projeto.

Gerenciar resultados de interferência

Você pode gerenciar individualmente os resultados de interferência. Você
também pode criar e gerenciar grupos de interferências. Isso pode ser útil se
você tem múltiplas interferências envolvendo um determinado item ou se
uma certa área contém múltiplas interferências que podem ser consideradas
como um problema único. Crie grupos que estejam representados na guia
Results como pastas.

Você também pode atribuir interferências e grupos de interferências a um
indivíduo ou negócio, de maneira que seja possível especificar quem é o
responsável por resolver uma interferência.
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Para renomear uma interferência desagrupada

1 Na guia Results, clique com o botão direito na interferência na guia
Results e clique em Rename.

2 Digite um novo nome e pressione Enter.

Entrada do comando: F2

Para criar um grupo de interferência

1 Clique no botão New Clash Group  na guia Results. Uma nova
pasta denominada Clash Group X é adicionada acima da interferência
no momento selecionada (no topo da lista se nada estiver selecionado).

2 Digite um nome para o grupo e pressione Enter.

3 Selecione as tarefas que deseja adicionar neste grupo, e arraste-as para a
pasta.

4 Quando você clica no grupo de interferências criado, os painéis Item 1
e Item 2 mostram todos os itens de interferência contidos naquele grupo
de interferências, e todas as interferências correspondentes são mostradas
na Scene View.

Para agrupar múltiplas interferências

1 Na guia Results , selecione todas as interferências que deseja agrupar.

2 Clique com o botão direito do mouse em sua seleção, e clique em Group.

3 Digite um nome para o grupo e pressione Enter.

4 Quando você clica no grupo de interferências criado, os painéis Item 1
e Item 2 mostram todos os itens de interferência contidos naquele grupo
de interferências, e todas as interferências correspondentes são mostradas
na Scene View.

Para renomear um grupo de interferências

1 Clique com o botão direito no grupo de interferência na guia Results
e clique em Rename.

2 Digite um novo nome e pressione Enter.

Entrada do comando: F2

Para remover interferências de um grupo

1 Na guia Results , expanda o grupo de interferências requerido.
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2 Selecione todas as interferências que deseja remover.

3 Clique com o botão direito do mouse na seleção, e clique em Remove
from Group.

Para desagrupar resultados de interferência

1 Na guia Resultas clique no grupo de interferências desejado.

2 Clique no botão Explode Group  .

Menu de atalho: Explodir grupo

Para alterar o status de interferências desagrupadas

1 Na guia Results selecione as interferências que requerem a alteração.

2 Clique no botão suspenso na caixa Status e selecione o status apropriado.

OBSERVAÇÃO Múltiplas interferências podem ser alteradas ao manter pressionada
a tecla Ctrl enquanto seleciona interferências individuais (a última interferência
selecionada sendo mostrada na Scene View), ou ao manter pressionada a tecla
Shift e selecionar outra interferência, portanto, selecionando todas as interferências
entre as duas incluindo a primeira e a última (novamente, a última interferência
selecionada sendo mostrada na Scene View).

Para alterar o status de um grupo de interferências

1 Na guia Rules , clique no grupo de interferências desejado.

2 Clique no botão suspenso na caixa Status e selecione o status apropriado.

OBSERVAÇÃO A alteração do status de uma grupo de interferência altera o status
de todas as interferências neste grupo.

Para atribuir uma interferência

1 Na guia Results, selecione uma interferência, grupo de interferência ou
múltiplas interferências.

2 Clique com o botão direito do mouse na seleção e clique em Assign.

3 Digite o nome da pessoa/empresa para a qual a seleção será atribuída.

OBSERVAÇÃO Se a interferência já estiver atribuída, o destinatário será
exibido quando for aberta a caixa de diálogo.

4 Insira observações, se necessário.
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5 Clique em OK.

Para cancelar a atribuição de uma interferência

1 Na guia Results, selecione uma interferência, grupo de interferência ou
múltiplas interferências.

2 Clique com o botão direito do mouse na seleção e clique em Unassign.

OBSERVAÇÃO Um comentário é automaticamente inserido relativo a uma
interferência ou grupo de interferências quando ele é não atribuído.

Rever os resultados de interferência

O Autodesk Navisworks Manage 2012 fornece ferramentas para adicionar
comentários e linhas de marcação nos resultados de interferência. Se múltiplas
interferências são associadas com uma única questão de desenho, considere
agrupá-las manualmente no início de seu processo de revisão. Consulte
Gerenciar resultados de interferência na página 749.

Identificar visualmente as interferências no modelo

Quando você clica em um resultado de interferência, o zoom é
automaticamente aproximado na localização da interferência na Scene View.
A ferramenta Clash Detective contém diversas opções deExibição, que
permitem ajustar a forma pela qual as interferências são renderizadas no
modelo.

Por exemplo, você pode isolar visualmente os itens de interferência na Scene
View tornando mais fácil focar neles.

Você também pode ajustar o contexto de visualização para identificar
visualmente onde cada interferência está no modelo e para personalizar a
forma pela qual o Autodesk Navisworks efetua as transições entre as
interferências.

Ao navegar nos resultados das interferências na Scene View, qualquer
alteração que você empregar nos pontos de vista de interferência será salva
automaticamente, se a caixa de seleçãoSave Viewpoint estiver selecionada
na guia Results. Esta opção é projetada para permitir o ajuste do ponto de
vista para um resultado de interferência e para armazenar a linha de marcação.
Se você navegou de modo a se afastar da interferência e não pode localizá-la
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na Scene View, é possível redefinir o ponto de vista para focar no ponto de
interferência novamente.

Para somente mostrar os resultados de interferência que envolvem sua seleção
atual

1 Selecione a geometria desejada na Selection Tree ou na Scene View.

2 Abra a janela Clash Detective e clique na guia Results, e selecione a
caixa de seleção Select Filter.

Somente as interferências que envolvem os itens selecionados são agora
mostrados na área Results.

Para alterar como os itens com interferência são realçados

1 Na janela Clash Detective e clique na guia Results.

2 Selecione as caixas de seleção Highlight para o Item 1 e Item 2 , para
sobrepor a cor dos itens com interferência na Scene View pela cor do
status da interferência selecionada.

Para realçar todas as interferências na Scene View

1 Na janela Clash Detective e clique na guia Results.

2 Selecione a caixa de seleção Highlight All  na área Display. Todas as
interferências encontradas são realçadas no cor de seu status.

Desmarque a caixa de seleção para voltar a vista padrão de realce de
somente os itens envolvidos na interferência selecionada na área Results.

Para isolar os resultados de interferência na Scene View

1 Na janela Clash Detective e clique na guia Results.
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2 Para ocultar todos os itens que obstruem a visualização dos itens com
interferência na Scene View, selecione a caixa de seleção Auto Reveal.
Quando você clica em um resultado de interferência, poderá ver que a
interferência tem o zoom aproximado nela, sem ter que mover a
localização.

Visualizar itens com interferência com a caixa de seleção
Auto Reveal selecionada

Visualizar itens com interferência com a caixa de seleção
Auto Reveal desmarcada

3 Para ocultar todos os itens envolvidos na interferência, selecione a caixa
de seleção Hide Other. Isto permite focar melhor nos itens com
interferência na Scene View.

Visualizar itens com interferência com a caixa de seleção
Hide Other selecionada

Visualizar itens com interferência com a caixa de seleção
Hide Other desmarcada

4 Para esmaecer todos os itens não envolvidos na interferência, selecione
a caixa de seleção Dim Other. Quando você clica em um resultado de
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interferência, o Autodesk Navisworks esmaece todos os itens não
envolvidos na interferência.

Visualizar itens com interferência com a caixa de seleção
Dim Other selecionada

Visualizar itens com interferência com a caixa de seleção
Dim Other desmarcada

5 Para definir o esmaecimento transparente de todos os objetos não
envolvidos na interferência, selecione a caixa de seleção Transparent
Dimming. Esta opção somente pode ser utilizada com a opção Dim
Other, e irá renderizar todos os itens que não estão envolvidos na
interferência transparente, assim como em cinza. O nível de
esmaecimento transparente pode ser personalizado no Options Editor.
Por padrão, 85% de transparência é utilizado.

DICA Tente utilizar esta opção ao realçar todas as interferências na Scene
View (ao selecionar a caixa de seleção Highlight All). Você pode ver as
interferências através de objetos circundantes.
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Para definir as transições entre interferências

1 Na janela Clash Detective e clique na guia Results.

2 Na área Display , assegure que a caixa de seleção Auto Zoom esteja
selecionada.

3 Clique em um resultado de interferência na lista Results. O zoom é
aproximado na localização da interferência na Scene View.

4 Selecione a caixa de seleção Animate Transitions.

5 Clique em outro resultado de interferência. A vista efetua a transição
suave da vista atual para a próxima vista. Você pode utilizar o Options
Editor para personalizar a duração das transições com animação.

Para visualizar as interferências no contexto

1 Na janela Clash Detective e clique na guia Results.

2 Clique em um resultado de interferência na lista Results.

3 Na área Display , assegure que as caixas de seleção Auto Zoom e
Animate Transitions estejam selecionadas.

4 Para tornar toda a cena visível na Scene View, selecione View All na
caixa View in Context.
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Para limitar a vista para as extensões dos arquivos contendo os itens
envolvidos na interferência selecionada, selecione View File Extents
na caixa View in Context.

5 Mantenha pressionado o botão View in Context  para mostrar a
vista de contexto escolhida na Scene View. O zoom permanece afastado
da vista enquanto este botão estiver pressionado. Se você clicar
rapidamente (ao invés de manter pressionado) no botão, o zoom é
afastado da vista, fica afastado por alguns segundos, e a seguir
imediatamente aproxima novamente o zoom.

Para salvar pontos de vista com resultados de interferência

1 Na janela Clash Detective e clique na guia Results.

2 Na área Display , assegure que a caixa de seleção Save Viewpoint
esteja selecionada.

3 Clique em um resultado de interferência na lista Results. Isso permite
ajustar o ponto de vista para um resultado de interferência. Também
permite que as linhas de marcação sejam armazenadas com um resultado
de interferência.

OBSERVAÇÃO Após adicionar a linha de marcação, alterações subsequentes
no ponto de vista devido a navegação não serão salvas. Para poder salvar
um ponto de vista diferente, a linha de marcação precisa ser primeiro
removida utilizando a ferramenta Erase para a linha de marcação.

Para redefinir o ponto de vista para focar a interferência

1 Clique na guia Results da janela Clash Detective.

2 Clique com o botão direito do mouse na interferência ou no grupo de
interferências desejado e clique em Focus on Clash no menu de atalho.

Adicionar comentários de revisão e linhas de
marcação

Você pode adicionar comentários e linhas de marcação nos resultados de
interferência. Para obter mais informações, consulte  Usar comentários, linhas
de marcação e identificadores  na página 427.
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Resultados de teste de interferência com
base no tempo e suave

Para rever resultados de interferência com base no tempo

1 Na janela Clash Detective, defina e execute um teste de interferência
com base no tempo (consulte Interferência com base no tempo na página
742).

2 Clique na guia Results.

3 Selecione a caixa de seleção Simulation na área Display.

4 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  e clique na guia Simulation.

5 Na janela Clash Detective , guia Results , selecione a interferência na
lista Results.

6 O deslizador de simulação na janela TimeLiner é movido para o ponto
exato no qual ocorre a interferência. Você pode mover o deslizador para
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investigar os eventos que estão acontecendo imediatamente antes e após
a interferência.

7 Repita este processo para rever todas as interferências encontradas.

Para rever os resultados de interferência suave

1 Na janela Clash Detective, defina e excute um teste de interferência
leve (consulte Interferência suave na página 744).

2 Clique na guia Results.

3 Selecione a caixa de seleção Simulation na área Display.

4 Na janela Clash Detective , guia Results , selecione a interferência na
lista Results.

5 Clique na guia Animação na faixa de opções. O deslizador Playback
Position no painel Playback é movido ao ponto exato no qual a
interferência ocorre. Você pode mover o deslizador para investigar os
eventos que estão acontecendo imediatamente antes e após a
interferência.

6 Repita este processo para rever todas as interferências encontradas.
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Para rever os resultados de interferência suave com base no tempo

1 Na janela Clash Detective, defina e execute um teste de interferência
leve com base no tempo (consulte Interferência suave com base no tempo
na página 745).

2 Clique na guia Results.

3 Selecione a caixa de seleção Simulation na área Display.

4 Se a janela do TimeLiner ainda não estiver aberta, clique na guia Home

painel  ➤ Tools ➤ TimeLiner  e clique na guia Simulation.

5 Na janela Clash Detective , guia Results , selecione a interferência na
lista Results.

6 O deslizador de simulação na janela TimeLiner é movido para o ponto
exato no qual ocorre a interferência. Você pode mover o deslizador para
investigar os eventos que estão acontecendo imediatamente antes e após
a interferência.

7 Repita este processo para rever todas as interferências encontradas.
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Reportar resultados de interferência
Você pode produzir diversos relatórios do Clash Detective. Por exemplo, os
relatórios podem ser utilizados para comunicar problemas de coordenação
para as equipes de projeto que não têm acesso ao Autodesk Navisworks.

Para interferências com base no tempo, pode ser útil incluir informações
adicionais no relatório sobre cada pacote estático na interferência. Estas
informações podem ser definidas no Options Editor ao utilizar as definições
de Quick Properties.

Para criar um relatório de interferência

1 Na janela Clash Detective execute o teste desejado (individualmente
ou como um lote). Se você executa um teste em lote, na guia Batch ,
selecione o teste para o qual deseja ver os resultados.

2 Clique na guias Report.

3 Na caixa For Clash Groups Include , área Include Clashes ,
especifique como exibir os grupos de interferências em seu relatório.

OBSERVAÇÃO Se seu teste não contém nenhum grupo de interferência,
esta caixa está indisponível.

4 Escolha entre as seguintes opções:

■ Group Headers Only - os relatórios somente irão incluir resumos
das pastas de grupos de interferências que você criou.
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Um exemplo de um relatório HTML com somente os cabeçalhos do grupo

■ Individual Clashes Only - os relatórios somente irão conter
resultados de interferências individuais. Para cada interferência que
pertença a um grupo, um campo extra, denominado como Clash
Group, pode ser adicionado no relatório para identificá-la. Para ativar
esta funcionalidade, selecione a caixa de seleção Clash Group na
área Contents.

Um exemplo de um relatório HTML com somente interferências individuais

■ Everything - os relatórios irão conter os resumos das pastas de
grupos de interferências que você criou e os resultados de
interferências individuais. Para cada interferência que pertença a um
grupo, um campo extra, denominado como Clash Group, pode ser
adicionado no relatório para identificá-la. Para ativar esta
funcionalidade, selecione a caixa de seleção Clash Group na área
Contents.
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Um exemplo de um relatório HTML com os cabeçalhos do grupo e
interferências individuais

5 Utilize a caixa Include Clash Types para selecionar os resultados de
interferência sobre os quais deseja reportar.

6 Na área Contents selecione as caixas de seleção para os dados que deseja
que apreçam no relatório para cada resultado de interferência. Este pode
incluir Quick Properties relativas aos itens envolvidos na interferência,
como encontrá-las na Selection Treepadrão, da raiz para a geometria,
se as imagens ou informações de simulação deveriam ser incluídas, e
assim por diante.

7 Selecione o tipo de relatório na caixa Report Type:
■ Current Test - cria um relatório único somente para o teste atual.

■ All Tests (Combined) - cria um relatório único contendo os
resultados de todos os testes.
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■ All Tests (Separate) - cria um relatório separado para cada teste
contendo todos os resultados.

8 Selecione o formato do relatório na caixa Report Format:
■ XML cria um arquivo XML contendo todas as interferências e um

jpeg para seus pontos de visão juntamente com seus detalhes. Ao
escolher esta opção, será preciso selecionar ou criar uma pasta para
os arquivos e inserir um nome para o arquivo XML.

■ HTML criará um arquivo HTML contendo todas as interferências e
um jpeg para seus pontos de visão juntamente com seus detalhes. Ao
escolher esta opção, será preciso selecionar ou criar uma pasta para
os arquivos e inserir um nome para o arquivo HTML.

■ HTML (Tabular) criará um arquivo HTML tabular contendo todas
as interferências e um jpeg de seus pontos de vista juntamente com
seus detalhes. Ao escolher esta opção, será preciso selecionar ou criar
uma pasta para os arquivos e inserir um nome para o arquivo HTML.
Os arquivos tabulares HTML podem ser abertos e editados no
Microsoft Excel 2007 e posterior.

OBSERVAÇÃO Para personalizar a aparência ou o layout do arquivo
HTML/HTML (tabular), é necessário editar o arquivo
clash_report_html.xsl/clash_report_html_tabular_xsl. O arquivo
instalado está localizado no subdiretório de folhas de estilo do diretório de
instalação do Autodesk Navisworks. Você pode copiar o arquivo editado no
subdiretório de folhas de estilo de qualquer diretório de pesquisa do Autodesk
Navisworks. Consulte Pesquisar diretórios na página 171 para obter mais
informações.

■ Text cria um arquivo TXT contendo todos os detalhes das
interferências e a localização para um jpeg de cada interferência. Ao
escolher esta opção, será preciso selecionar ou criar uma pasta para
os arquivos e inserir um nome para o arquivo TXT.

■ As Viewpoints cria uma pasta na janela encaixávelSaved
Viewpoints, denominada como o nome do teste. Cada interferência
é salva como um ponto de vista nesta pasta, com um comentário
anexado contendo os detalhes do resultado da interferência.

9 Clique no botão Write Report para gerar o relatório.

Configurar Quick Properties para o seu relatório

1 Clique no botão do aplicativo  ➤ Options.
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2 Expanda o nó Interface no Options Editor, expanda a opção Quick
Properties , e clique em Definitions.

3 Selecione TimeLiner na caixa Category.

4 Selecione Attach to Task: 1 na caixa Property.

5 Adicione diversas outras definições com o TimeLiner selecionado na
caixa Category , e as propriedades desejadas na caixa Property.

6 Clique em OK para salvar as alterações.

Ao selecionar agora a caixa de verificação Quick Properties  na área
Contents na guia Report da janela Clash Detective, o relatório irá
incluir os dados adicionais especificados aqui.
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Utilizar o
complemento
Autodesk Vault

O complemento Autodesk Vault permite executar funções comuns do Vault em
arquivos do Autodesk Navisworks (.nwc,.nwd,.nwf).

Sobre o complemento Autodesk Vault
Um Vault é um repositório onde são salvos e gerenciados documentos e arquivos.
O Autodesk Vault é um sistema de gerenciamento de dados que oferece segurança
de arquivos, controle de versões e suporte multiusuário. O complemento
Autodesk Vault está disponível com o Autodesk Navisworks Manage e o Autodesk
Navisworks Simulate, e suporta conexão com o Autodesk Vault, p Autodesk
Vault Workgroup, o Autodesk Vault Collaboration e o Autodesk Vault
Professional.

O complemento Autodesk Vault permite executar funções comuns do Vault em
arquivos do Autodesk Navisworks (.nwc,.nwd,.nwf). Por padrão, o complemento
Vault não é mostrado na interface do Autodesk Navisworks. Para controlar a
exibição do complemento Vault, utilize a configuração Vault no Options
Editor.

Para exibir o complemento Vault na interface do Navisworks

1 Clique no botão do aplicativo  ➤ Options.

2 No Options Editor, expanda o nó Tools e clique em Vault.

3 Selecione a caixa de seleção Show in User Interface.

4 Clique em OK.
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5 Reinicie o programa. O complemento Vault agora está disponível no
menu do aplicativo e na faixa de opções.

Iniciando o aplicativo Vault
É possível iniciar o aplicativo Autodesk Vault pelo Navisworks Manage para
gerenciar o Vault e executar a manutenção dos arquivos. Você precisa ter ao
menos um produto Autodesk Vault instalado em sua máquina para fazer isso.

Múltiplos produtos Vault podem ser instalados em sua máquina ao mesmo
tempo. Se você estiver conectado em um servidor do Vault, iniciar o aplicativo
Vault irá abrir o Vault Explorer para a versão autônoma do Vault Client que
coincida com a atual informação de registro. Se você não estiver conectado a
um servidor do Vault, ele irá abrir o Vault Explorer para o produto Vault
instalado que esteja no nível mais alto.

Para iniciar o Autodesk Vault

1 No aplicativo Autodesk Navisworks, clique na guia Vault ➤ painel

Access ➤ Go to Vault  . O Vault Explorer abre, permitindo que
você procure os dados no Vault.

Efetuar o login em um Vault
Trabalhar com um Vault permite que você armazene arquivos de forma segura
e acompanhe as versões dos arquivos.

Para trabalhar com arquivos armazenados no Vault, você deve efetuar o login
no servidor do Vault da Autodesk. Se um Vault não foi configurado, contate
o administrador do Vault. Para garantir um ambiente de trabalho seguro, é
importante ter contas de usuário exclusivas.

Para efetuar o login em um Vault

1 Clique na guia Vault ➤ painel Access ➤ Log In  .

2 Na caixa de diálogo Log In, insira o nome de usuário e a senha atribuídos
a você pelo administrador do Vault.
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3 Insira o nome do computador onde o servidor está instalado, por
exemplo, SERVERNAME. Se você não souber o nome do servidor, entre em
contato com o administrador.

4 Insira o nome do banco de dados do Vault no qual deseja efetuar login.

5 Selecione a caixa de seleção Automatically Log in Next Session para
efetuar login automaticamente na próxima vez.

6 Se você tiver uma conta do Microsoft Windows Active Directory, é
possível efetuar o login no servidor do Vault da Autodesk usando as
credenciais da sua conta de usuário do Microsoft Windows. Para fazer
isso, selecione a caixa de seleção Windows Authentication.

OBSERVAÇÃO Esta opção se aplica somente às edições do Autodesk Vault
Collaboration e do Autodesk Vault Professional.

■ A autenticação do Windows somente está disponível para domínios
do Active Directory.

■ Se você não utiliza a autenticação do Windows, então, é necessário
dispor de uma conta válida do servidor do Vault da Autodesk.

OBSERVAÇÃO Se a autenticação do Windows estiver ativada, a caixa User
Name exibirá o nome de domínio combinado com o nome de usuário do
Windows. O nome de usuário e a senha não podem ser alterados.

7 Clique em OK.

Efetuar o logout do Vault
Quando você terminar de trabalhar em um Vault, efetue o logout do Autodesk
Data Management Server.

O comando Log Out  somente está disponível na faixa de opções quando
você estiver conectado.

Para efetuar o logout do Vault

1 Clique na guia Vault ➤ painel Access ➤ Log Out  .

2 Clique em Close.
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Entendendo a pasta de trabalho
A pasta de trabalho é o diretório local onde os arquivos nos quais é possível
trabalhar estão armazenados.

O Vault é uma solução de administração de dados de servidor/cliente que
fornece armazenamento de dados centralizado. Este mecanismo de
armazenamento de dados centralizado permite acessar os mesmos dados
durante todo o processo de projeto. Quando é feito check-out de um arquivo
ou quando você abre um arquivo de um Vault, o arquivo é copiado do Vault
para uma pasta local denominada como pasta de trabalho. Uma pasta de
trabalho é definida por padrão, permitindo que você comece a trabalhar com
um Vault imediatamente. A pasta de trabalho padrão é:

Meus documentos\Vault

Isso significa que cada usuário tem uma pasta de trabalho exclusiva, isolada
de outros usuários. No entanto, dependendo dos requisitos do projeto, é
possível especificar uma pasta de trabalho em uma unidade de rede
compartilhada, criando uma pasta de trabalho compartilhada à qual todos os
usuários terão acesso. Em um ambiente de múltiplos usuários, uma pasta de
trabalho compartilhada mantém todos os arquivos de trabalho na mesma
pasta de trabalho consistentemente. Isso evita o atraso entre o carregamento
para o servidor por um usuário e o download subsequente para todos os outros
usuários.

Para utilizar uma pasta de trabalho compartilhada, o administrador do sistema
configura e define uma pasta de trabalho em uma localização de rede
compartilhada para que todos os membros do projeto possam usá-la.

Regras para utilizar uma pasta de trabalho compartilhada

Utilizar uma pasta de trabalho compartilhada permite que múltiplos usuários
trabalhem nos mesmos arquivos simultaneamente. Para proteger os dados do
grupo, todos os usuários devem efetuar login no Vault antes de executar
qualquer operação no arquivo.

OBSERVAÇÃO Se um usuário não efetuar login, não há como verificar se foi feito
check-out de um arquivo e os dados correm o risco de serem sobrescritos.
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As seguintes diretrizes lhe ajudarão a evitar que você sobrescreva as alterações
executadas por outra pessoa.

1 Se for feito check-out de um arquivo para outro usuário, não será possível
executar as seguintes operações:
■ Check Out

■ Undo Check Out

2 Não é possível fazer o check-out de um arquivo que esteja aberto e cujo
check-out tenha sido feito por outro usuário.

OBSERVAÇÃO Você pode fazer o check-out de um arquivo que esteja aberto
como somente leitura por outro usuário.

3 É possível abrir um arquivo como somente leitura quando o check-out
dele tiver sido feito para outra pessoa utilizando a mesma pasta de
trabalho.

Para configurar uma pasta de trabalho compartilhada

OBSERVAÇÃO É necessário ter atribuída a função de administrador para executar
esta ação.

1 Inicie o Autodesk Vault e efetue login como administrador.

2 Selecione Tools ➤ Administration.

3 Na caixa de diálogo Options, clique na guia Files.

4 Na seção Working Folder, clique em Define.

5 Selecione Enforce a Consistent Working Folder for All Clients.

6 Especifique a localização da rede compartilhada para a pasta de trabalho
na caixa Client Working Folder ou procure uma localização.

DICA O caminho para a pasta de trabalho compartilhada pode ser:

■ um caminho de rede: \\designco\users\keyg

■ um caminho que contenha uma variável de sistema para um diretório:
\\designco\users\%username%

7 Clique em OK.

8 Na caixa de diálogo Administration, clique em Close.

Para obter mais informações sobre o uso obrigatório da pasta de trabalho,
consulte a ajuda do Autodesk Vault Client.
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Efetuar o check-out de um arquivo
É possível efetuar o check-out do arquivo aberto atualmente. O check-out de
um arquivo altera o atributo somente leitura da cópia local para ler/gravar.

Uma vez que o check-out é efetuado em um arquivo do Vault, ele pode ser
editado. Somente um membro da equipe pode fazer o check-out de um arquivo
por vez. Ninguém mais pode modificar um arquivo em check-out até que o
check-in seja efetuado no Vault novamente. Utilize o Autodesk Vault para
verificar quem efetuou check-out de um arquivo. Essa informação pode ser
obtida na coluna User Name.

Para efetuar o check-out de um arquivo do Vault

1 Clique na guia Vault ➤ painel File Status ➤ Check Out  .

Obter arquivos do Vault
É possível utilizar os comandos de abrir, anexar e mesclar para obter arquivos
do Vault. O download dos arquivos foi efetuado para a pasta de trabalho local
definida pelo Vault (por exemplo, C:\Usuários\ <USUÁRIO>\Meus
documentos\Vault no Windows 7).

Os comandos estão localizados na guia Vault, no painel Access:

■ Open  . Fecha o arquivo aberto no momento no Autodesk Navisworks
e abre o arquivo selecionado no Vault. Você tem a opção de abrir o arquivo
como somente leitura ou fazer seu check-out para edição.

■ Append  . Adiciona os arquivos selecionados para a cena aberta no
momento.

■ Merge  . Mescla os arquivos selecionados na cena aberta no momento.
Qualquer geometria duplicada e nota de revisão é removida
automaticamente.

Para abrir um arquivo do Vault

1 Clique na guia Vault ➤ painel Access ➤ Open  .
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2 Na caixa de diálogo Select File, utilize a caixa Files of Type para
selecionar o tipo de arquivo apropriado, e navegue para a localização do
Vault onde os arquivos que deseja adicionar estão localizados.

3 Clique no botão suspenso junto ao botão Open e clique em Open
(Check Out) ou Open Read-Only como apropriado. Isso fecha o
arquivo aberto no momento no Autodesk Navisworks e abre o arquivo
selecionado no Vault.

Para anexar arquivos do Vault em uma cena atual

1 Abra um arquivo do Autodesk Navisworks.

2 Clique na guia Vault ➤ painel Access ➤ Append  .

3 Na caixa de diálogo Select File, utilize a caixa Files of Type para
selecionar o tipo de arquivo apropriado, e navegue para a localização do
Vault onde os arquivos que deseja adicionar estão localizados.

4 Selecione os arquivos requeridos e clique em Open.

DICA Para selecionar múltiplos arquivos utilize as teclas Shift e Ctrl.

Para mesclar arquivos de um Vault em uma cena atual

1 Abra um arquivo do Autodesk Navisworks.

2 Clique na guia Vault ➤ painel Access ➤ Merge  .

3 Na caixa de diálogo Select File, utilize a caixa Files of Type para
selecionar o tipo de arquivo apropriado, e navegue para a localização do
Vault onde os arquivos que deseja adicionar estão localizados.

4 Selecione os arquivos requeridos e clique em Open.

DICA Para selecionar múltiplos arquivos utilize as teclas Shift e Ctrl.

Atualizar um arquivo do Vault
É possível recuperar de um Vault a versão mais recente de um arquivo aberto
e os arquivos referenciados a ele.

Se a versão local for mais antiga que a versão no Vault, a versão mais recente
é copiada do Vault para a pasta de trabalho local, e o arquivo é recarregado.
Se a cópia de trabalho do arquivo for mais nova que a versão mais recente do
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arquivo no Vault, você será solicitado a selecionar entre perder as alterações
efetuadas na cópia de trabalho atual ou não obter a última versão do arquivo.

Para atualizar um arquivo do Vault

1 Clique na guia Vault painel  ➤ File Status ➤ Refresh  . O arquivo
aberto e seus arquivos de referência serão atualizados para a versão mais
recente no Vault, se apropriado.

Efetuar check-in de um arquivo no Vault
É possível usar a opção Check In na faixa de opções para adicionar arquivos
ao Vault.

Utilize Check In quando estiver pronto para efetuar check-in de arquivos no
Vault pela primeira vez. Além disso, use Check In quando tiver terminado
de trabalhar em um arquivo do Autodesk Navisworks no qual tenha sido
efetuado check-out e volte a fazer check-in com ele no Vault para salvar as
alterações com o histórico da nova versão. Inclua um comentário com o
arquivo descrevendo as alterações executadas nesta versão ao fazer check-in
nele. A versão mais recente de um arquivo no Vault é a última versão na qual
foi efetuado o check-in. Uma vez feito o check-in do arquivo, a versão do Vault
será incrementada e as últimas alterações agora estarão disponíveis para outros
para fazerem check-out.

Somente uma pessoa pode fazer o check-out de um arquivo por vez. Se você
deseja tornar disponível para outros usuários um arquivo no qual você tenha
efetuado check-out, sem salvar suas alterações, é possível Undo Check Out.
Se não foram feitas alterações em um arquivo no qual é efetuado o check-in
no Vault novamente, o histórico de versão não é incrementado. Utilize o
Autodesk Vault para verificar quem efetuou check-out de um arquivo. Essa
informação pode ser obtida na coluna User Name.

Para efetuar o check-in de um arquivo no Vault

OBSERVAÇÃO Antes de efetuar o check-in de um arquivo no Vault, salve as
alterações.

1 Clique na guia Vault ➤ painel File Status ➤ Check In  .

2 Se o arquivo ainda não tiver sido salvo, você será solicitado a salvá-lo.
Forneça um nome para o arquivo e clique em Save.

774 | Capítulo 16    Utilizar o complemento Autodesk Vault



3 Se você estiver efetuando o check-in do arquivo no Vault pela primeira
vez, você será solicitado a selecionar uma localização para o arquivo no
Vault. Na caixa de diálogo Select Vault Location, selecione uma pasta
do Vault ou clique no botão New Folder para criar uma pasta no Vault
e, a seguir, clique em OK.

4 Na caixa de diálogo Check In:
■ Se você deseja manter os arquivos em check-out para editá-los

posteriormente, selecione a caixa de seleção Keep Files Checked
Out.

■ Se você deseja remover a cópia local depois que o arquivo estiver em
checki-in, clique na caixa de seleção Close File and Delete
Working Copy.

5 Insira um comentário na caixa de texto descrevendo as alterações
efetuadas nessa versão do arquivo, se apropriado.

6 Clique em OK.

Desfazer o check-out de um arquivo
A opção Undo Check Out transforma um arquivo aberto no qual foi feito
check-out para o estado de check-in no Vault sem criar uma versão recente
do arquivo. Quaisquer alterações feitas no arquivo não serão armazenadas no
Vault.

OBSERVAÇÃO Se você escolher o comando Undo Check Out, perderá as
alterações executadas na cópia local do arquivo.

Para desfazer o check-out de um arquivo

1 Clique na guia Vault ➤ painel File Status ➤ Undo Check Out
.

2 Se o seu arquivo local tem alguma alteração não salva, será solicitado
que você confirme que a alteração será substituída pelos dados do Vault.
Clique em OK.

3 Se o seu arquivo local já foi salvo, será solicitado que você confirme se
deseja sobrescrever os novos dados com os dados antigos do Vault. Clique
em OK.
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Configurações do Vault

Caixa de diálogo Log In

Utilize esta caixa de diálogo para efetuar o login no banco de dados do Vault.

Insira o nome de usuário atribuído a você pelo administrador do
sistema.

User Name

Insira a senha atribuída a você pelo administrador do sistema.Password

Insira o nome do computador onde o servidor do Vault está
instalado, por exemplo, SERVERNAME. Se você não souber o

Server

nome do servidor do Vault, entre em contato com o
administrador do sistema.

Especifica o nome do banco de dados do Vault no qual você
deseja efetuar login. Se você não souber o nome do banco de

Database

dados do Vault, entre em contato com o administrador do
sistema.

Define a opção para efetuar login automaticamente no Vault
especificado sem ser solicitado a inserir as informações de User
Name, Password, Server e Database.

Automatically Log in Next
Session

Define a opção para efetuar login no servidor de gerenciamento
de dados usando as credenciais da conta de usuário do Microsoft

Windows Authentication

Windows. Isso desativa as caixas de texto User Name e
Password e preenche automaticamente a conta de login de
domínio Windows.

Faixa de opções:  Guia Vault ➤ painel Access ➤ Log In

Caixa de diálogo Check In

Utilize essa caixa de diálogo para adicionar os arquivos ao Vault.
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Utilize a guia Files Tree para visualizar os arquivos hierarquicamente no
Vault. Quando os arquivos são mostrados como uma árvore, é possível ver a
estrutura dos arquivos como eles serão adicionados ao Vault.

A guia Files Table exibe os arquivos no Vault como uma lista plana.

Mantém os arquivos em check-out após fazer o check-in deles
no Vault. Você pode fazer o check-in de alterações para que
outros usuários possam obter as alterações mais recentes.

Keep Files Checked Out

Exclui a cópia local do arquivo uma vez feito o check-in no Vault.
Se houver restrições sobre um arquivo que o impeçam de ser

Close Files and Delete Working
Copies

excluído, você será notificado de que o arquivo não pode ser
excluído.

OBSERVAÇÃO Não selecione a caixa de seleção Close Files
and Delete Working Copies ao efetuar o check-in de
arquivos se estiver utilizando uma pasta de trabalho
compartilhada. Excluir a cópia de trabalho de uma pasta de
trabalho compartilhada pode excluir arquivos acessados por
outros usuários.

Abre a caixa de diálogo Settings e permite organizar a estrutura
de pastas.

Settings

O texto inserido aqui é adicionado à propriedade Comment e
associado com esta versão do arquivo no Vault.

Enter Comments to Include
with This Version

Faixa de opções:  Guia Vault ➤ painel File Status ➤ Check In

Caixa de diálogo Settings

Utilize esta caixa de diálogo para organizar os arquivos no Vault.

Insere todos os arquivos e as pastas em uma única pasta. A
estrutura de pastas original é mantida, contanto que todos os

Use Organized Folder Structure

arquivos referenciados existam no mesmo nível ou abaixo da
pasta na qual o arquivo host reside. Os arquivos que não
estiverem localizados no mesmo nível ou estão acima do arquivo
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host serão colocados abaixo do arquivo host automaticamente.
Esta é a opção padrão.

Torna plana toda a estrutura de pastas e todos os arquivos são
colocados no mesmo nível que o host de nível superior no Vault.

Place All Files in One Folder

Esse comando não irá continuar quando dois ou mais nomes de
arquivo forem iguais dentro da mesma pasta.

Mantém a estrutura de arquivos nos quais está sendo efetuado
o check-in da pasta de trabalho local.

Preserve Locations if in
Working Folder

DICA Essas configurações do Vault ajudam a garantir que os dados sejam
organizados de forma adequada ao uso com o Vault. Como prática recomendada,
use uma estrutura de pasta organizada e conserve as localizações dos arquivos.

Dispositivo apontador:  Caixa de diálogo Check In ➤ Settings

Caixa de diálogo Select Vault Location

Utilize esta caixa de diálogo para especificar uma pasta para a qual efetuar o
check-in de arquivos no Vault pela primeira vez.

OBSERVAÇÃO Você deve salvar um arquivo antes de selecionar uma localização
do Vault e efetuar o check-in.

Exibe a estrutura da pasta atual. Realce uma pasta existente para
efetuar o check-in de arquivos no Vault ou criar uma nova pasta.

Select a Vault Folder

Abre a caixa de diálogo Create Folder.New Folder
Você também pode criar pastas no Autodesk Vault.

Conclui a operação de seleção de pasta. A caixa de diálogo Check
In é exibida.

OK

Cancela a operação de seleção de pasta e fecha a caixa de
diálogo.

Cancel

Faixa de opções:  Guia Vault ➤ painel File Status ➤ Check In
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Caixa de diálogo Create Folder

Utilize esta caixa de diálogo para criar uma nova pasta no diretório atualmente
selecionado na caixa de diálogo Select Vault Location.

Insira o nome da pasta que será criada no Vault. O nome de
pasta deve ser exclusivo no diretório selecionado.

New Folder

Selecione esta caixa de seleção se você deseja que a nova pasta
seja uma pasta de biblioteca.

Library

Dispositivo apontador:  Caixa de diálogo Select Vault Location ➤ New
Folder

Caixa de diálogo Select File

Utilize esta caixa de diálogo para obter arquivos do Vault.

Navegue para a localização desejada no Vault.Look In

Uma lista de arquivos na pasta do Vault selecionada. Clique em
um arquivo para selecioná-lo. Quando você mesclar ou anexar

Seção File List

arquivos, é possível selecionar vários arquivos utilizando as teclas
Shift e Ctrl.

O nome do arquivo que deseja obter do Vault.File Name

Seleciona o tipo de arquivo que deseja obter do Vault.Files of Type

Uma vez selecionado o arquivo, clique no botão Abrir. Se você
conseguir ver o botão suspenso junto ao botão Abrir, é possível

Abrir

optar por abrir o arquivo como somente leitura ou para fazer o
check-out para edição. Essa opção não está disponível quando
você mesclar ou anexar arquivos.

Faixa de opções:  Guia Vault ➤ painel Access ➤ Open

Faixa de opções:  Guia Vault ➤ painel Access ➤ Append
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Faixa de opções:  Guia Vault ➤ painel Access ➤ Merge
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Reference

Caixa de diálogo Animation Export
Utilize esta caixa de diálogo para exportar uma animação para um arquivo AVI
ou uma sequência de arquivos de imagens.

Source

Source Selecione a origem da qual exportar a animação. Escolha entre:
■ Current Animator Scene A animação do objeto selecionado atualmente.

■ TimeLiner Simulation A sequência atualmente selecionada TimeLiner.

■ Current Animation A animação do ponto de visão atualmente selecionado.

Renderer

Renderer Seleciona a renderização da animação. Escolha entre:
■ Presenter. Utilize esta opção quando for necessário a mais alta qualidade

de renderização.

■ OpenGL. Renderiza rapidamente sua animação. Esta opção também é ideal
para visualizar as animações.

Output

Format Seleciona o formato da saída. Escolha entre:
■ JPEG. Exporta a sequência de imagens estáticas, que são tiradas de quadros

individuais na animação. Utilize o botão Options para selecionar os níveis
Compression e Smoothing.
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■ PNG. Exporta uma sequência de imagens estáticas, tiradas de quadros
individuais na animação. Utilize o botão Options para selecionar os níveis
Interlacing and Compression.

■ Windows AVI. Exporta a animação com um arquivo AVI comumente
legível. Utilize o botão Options para selecionar o compressor de vídeo na
lista suspensa e ajuste as configurações de saída.

OBSERVAÇÃO Se a compressão de vídeo não estiver disponível em seu
computador, o botão Configure pode estar indisponível.

■ Windows Bitmap. Exporta a sequência de imagens estáticas, que são
tiradas de quadros individuais na animação. Não há Opções para este
formato.

Opções Permite configurar as opções para o formato de saída selecionado.

Size

Type Utilize a lista suspensa para especificar como definir o tamanho da
animação exportada.

DICA Para animações, uma resolução bem menor pode ser utilizada para imagens
estáticas, pro exemplo, 640x480.

Escolha entre:

■ Explicit. Fornece o controle completo da largura e altura (as dimensões
são em pixels).

■ Use Aspect Ratio. Permite especificar a altura. A largura é
automaticamente calculada a partir da relação de aspecto de sua vista atual.

■ Use View. Utiliza a largura e a altura de sua vista atual.

Width Permite inserir a largura em pixels, quando disponível.

Height Permite inserir a altura em pixels, quando disponível.

OBSERVAÇÃO Há um tamanho máximo de 2048 x 2048 pixels, para a saída
OpenGL no Autodesk Navisworks.

Options

FPS Especifica o número de quadros por segundo. Esta configuração é relevante
para arquivos AVI.
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OBSERVAÇÃO Quando maior o FPS, mais suave será a animação. No entanto, a
utilização de um FPS alto irá aumentar consideravelmente o tempo de renderização.
Normalmente, é aceitável utilizar entre 10 a 15 FPS.

Anti-Aliasing Esta opção somente se aplica para a renderização OpenGL. A
suavização de serrilhado é utilizada para suavizar as arestas das imagens
exportadas. Selecione o valor apropriado na lista suspensa. Quando maior o
número, mais suave a imagem, mas leva mais tempo para ser exportada. 4x
é adequado para a maioria das situações.

Faixa de opções:  Guia Output painel  ➤ Visuals ➤ Animation
Menu: Botão Application  ➤ Export ➤ Images &

Animations ➤ Animation
Menu: Classic user interface: File ➤ Export ➤ Animation

Caixa de diálogo Appearance Profiler
Use esta caixa de diálogo para criar e gerenciar perfis de aparência e aplicá-los
em seu modelo.

Área do seletor

Use esta área para definir e testar o critério de seleção de objeto que será usado
por um seletor de perfil de aparência.

Guia By Property

Category Use este campo para inserir a categoria da propriedade a ser
pesquisada, por exemplo, 'Item', 'Tipo de sistema', 'Material'.

Property Use este campo para inserir o tipo da propriedade a ser pesquisada,
por exemplo, 'Nome', 'Tipo de sistema', 'Material'.

Equals/Does Not Equal Utilize a lista suspensa para selecionar o operador de
condição apropriado, por exemplo 'Igual'. Insira o valor da propriedade a ser
pesquisado no campo fornecido, por exemplo 'Equipamento'.

Botão Test Selection Após ter definido o critério de pesquisa, clique no botão
Seleção de teste. Todos os objetos que satisfazem o critério serão selecionados
no modelo.

Guia By Set
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Lista Sets Esta é uma lista de todos os conjuntos de pesquisa e seleção
disponíveis no arquivo que está aberto no momento. Para escolher um
conjunto clique no mesmo.

Botão Refresh Você pode adicionar ou remover conjuntos de pesquisa e seleção
em seu modelo. Para sincronizar suas alterações com a lista de conjuntos
mostrada na caixa de diálogo Appearance Profiler, clique no botão Refresh.

Test Selection Clique neste botão para testar o conjunto escolhido. Todos os
objetos que satisfazem o critério serão selecionados no modelo.

Área da aparência

Use esta área para configurar as sobreposições de aparência que serão associadas
com um seletor de perfil de aparência.

Color Use o seletor de cores para escolher a cor que será usada para sobrepor
a aparência dos objetos selecionados.

Transparency Use o deslizador para escolher o nível de transparência (0 a
100%) que será usada para sobrepor a aparência dos objetos selecionados. Você
também pode digitar o valor na caixa correspondente. Um valor mais alto
torna o objeto mais transparente. Um valor mais baixo torna o objeto mais
opaco.

Lista de seletores

A Lista de seletores mostra todos os seletores de perfil de aparência
configurados. Você pode atualizar as configurações para cada um dos seletores
na lista, mas não pode mover os seletores de posição. Para corrigir as ordem
dos seletores, pode ser necessário exclui-los da lista e começar de novo.

Botões

Add Use o seletor de cores para escolher a cor que será usada para sobrepor a
aparência dos objetos selecionados.

Update Você pode modificar o critério de seleção do objeto e as configurações
de aparência de cada um dos seletores adicionados na lista de seletores. Para
salvar as alterações, clique no botão Update.

Delete Clicar neste botão exclui o seletor de aparência selecionado da lista.

Delete All Clicar neste botão exclui todos os seletores de aparência da lista.
Você será solicitado a confirmar sua decisão.

Load Permite abrir e usar um perfil de aparência anteriormente salvo.
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Save Permite salvar o perfil de aparência atual com a extensão de arquivo .dat.

Run Aplica sequencialmente todos os seletores no perfil de aparência atual
em seu modelo.

Faixa de opções:  Guia Home painel  ➤ Tools ➤ Appearance Profiler

Caixa de diálogo Assign Clash
Utilize esta caixa de diálogo para atribuir uma interferência ou grupo de
interferências para uma pessoa/negócio.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

Assign To Insira o nome da pessoa ou negócio à qual a interferência, o grupo
de interferências ou as múltiplas interferências devem ser atribuídos.

OBSERVAÇÃO Se a interferência já estiver atribuída, o destinatário será exibido
quando for aberta a caixa de diálogo.

Notas Insira qualquer nota, conforme necessário. Elas podem ser visualizadas
na janela Comments na página 428.

OBSERVAÇÃO As notas inseridas anteriormente não são exibidas quando a caixa
de diálogo está aberta.

Menu de atalho: Clique com o botão direito do mouse em uma interferência,
múltiplas interferências ou um grupo de interferências na guia Results e clique
em Assign no menu de atalho.

Caixa de diálogo Background Settings
Utilize esta caixa de diálogo para escolher um efeito de segundo plano para
utilização na Scene View.

Mode Seleciona o tipo de efeito de segundo plano. Escolha entre:
■ Plain

■ Graduated

■ Horizon

OBSERVAÇÃO Modo horizonte e as cores associadas somente estão disponíveis
para modelos 3D.
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Color Define a cor para um segundo plano simples.

Top Color Define a cor superior em um segundo plano graduado.

Bottom Color Define a cor inferior em um segundo plano graduado.

Sky Color Define a cor do céu (topo) em um segundo plano de horizonte.
Esta opção somente está disponível para os modelos 3D.

Horizon Sky Color Define a cor do céu (inferior) em um segundo plano de
horizonte. Esta opção somente está disponível para os modelos 3D.

Horizon Ground Color Define a cor do chão (topo) em um segundo plano
de horizonte. Esta opção somente está disponível para os modelos 3D.

Ground Color Define a cor do chão (inferior) em um segundo plano de
horizonte. Esta opção somente está disponível para os modelos 3D.

Faixa de opções:  Guia View ➤ painel Scene View ➤ Background
Menu de atalho: Clique em uma área em branco na cena, e clique em
Background no menu de atalho.

Menu: Classic user interface: Tools ➤ Background

Caixa de diálogo Collision
Utilize essa caixa de diálogo para ajustar as configurações de colisão para o
ponto de vista selecionado em um espaço de trabalho 3D.

Por padrão, as vistas Collision, Gravity, Auto Crouch, e Third Person
estão desativadas.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

Collision Selecione esta caixa de seleção para definir um visualizador como
um volume de colisão nos modos Walk e Fly. Como resultado, um
visualizador adquire alguma massa e não pode passar através de outros objetos,
pontos ou linhas na Scene View.

OBSERVAÇÃO A seleção desta caixa de seleção altera a prioridade de renderização,
para que os objetos em torno do visualizador sejam exibidos com muito mais
detalhes do que o normal. O tamanho da região de alto detalhe tem base no raio
do volume de colisão e na velocidade do movimento.
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Gravity Selecione esta caixa de seleção para fornecer alguma espessura ao
visualizador no modo Walk. Esta opção somente funciona em conjunto como
Collision.

Auto Crouch Selecione esta caixa de seleção para ativar um visualizador para
agachar sob objetos que estão muito baixos para passar por baixo no modo
Walk. Esta opção somente funciona em conjunto como Collision.

Viewer

Radius Especifica o raio do volume de colisão.

Height Especifica a altura do volume de colisão.

Eye Offset Especifica a distância abaixo do topo do volume de colisão, onde
a câmera irá focar se a caixa de seleçãoAuto Zoom estiver selecionada.

Third Person

Enable Selecione esta caixa de seleção para utilizar a vista Third Person. Em
uma vista Third Person, um avatar é exibido na Scene View para representar
o visualizador.

A seleção desta caixa de seleção altera a prioridade de renderização, para que
os objetos em torno do avatar sejam exibidos com muito mais detalhes do
que o normal. O tamanho da região de alto detalhe tem base no raio do volume
de colisão, na velocidade do movimento e na distância da câmera atrás do
avatar.

Auto Zoom Selecione esta caixa de seleção para trocar automaticamente da
vista Third Person para a vista de primeira pessoa sempre que a linha de
visão fique obscurecida por um item.

Avatar Especifica o avatar que é utilizado na vista Third Person.

Ângulo Especifica o ângulo no qual a câmera olha para o avatar.

Por exemplo, 0º posiciona a câmera diretamente atrás do avatar, 15º faz com
que a câmera olhe para baixo para o avatar em um ângulo de 15º graus.

Distance Especifica a distância entre a câmera e o avatar.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Dispositivo apontador:  Caixa de diálogo Edit Viewpoint ➤ Settings
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Caixa de diálogo Convert Object Properties
Utilize esta caixa de diálogo para selecionar aplicativos de terceiros para que
o leitor de arquivos DWG e DXF leia informações do mesmo.

O leitor de arquivos DWG e DXF podem converter informações do objeto de
diversos aplicativos de terceiros que são desenvolvidos no AutoCAD.

Selecione as caixas de seleção para todos os aplicativos requeridos.
Dispositivo apontador:  Caixa de diálogo Options Editor nó  ➤ File
Readers opção  ➤ DWG/DXF ➤ Advanced

Caixa de diálogo Culling Options
Com o plugin AutoCAD File Exporter em um aplicativo AutoCAD, a caixa
de diálogo Culling Options permite ajustar a seleção de geometria quando
você navega em um modelo na Navigator Palette.

Area

Enable  Especifica se a seleção da área é utilizada ou não.

Number of Pixels Below Which Objects Are Culled Especifica um valor para
a área de tela em pixels abaixo do qual os objetos são selecionados. Por
exemplo, definir este valor como 100 pixels, significa que qualquer objeto
dentro modelo que seria desenhado com um tamanho menor do que 10x10
pixels, será descartado.

Backface

Ativa a seleção da face traseira para todos os objetos. Selecione entre as
seguintes opções:
■ Off. Desativa a seleção de face traseira.

■ Solid. Ativa a seleção da face traseira para objetos sólidos somente. Esta é
a opção padrão.

■ On. Ativa a seleção da face traseira para todos os objetos.

Near Clip Plane

Furthest Distance  Especifica a distância mais afastada entre a câmera e a
posição Near Clip Plane.
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Automatically Generated Especifica se o Autodesk Navisworks controla
automaticamente controla a posição Near Clip Plane para lhe fornecer a
melhor vista do modelo.

Far Clip Plane

Closest Distance  Especifica a menor distância entre a câmera e a posição Far
Clip Plane.

Automatically Generated Especifica se o Autodesk Navisworks controla
automaticamente controla a posição Far Clip Plane para lhe fornecer a
melhor vista do modelo.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Menu de atalho: Interface de usuário Classic: Clique com o botão direito
na Navigator Palette e clique em Options ➤ Culling Options no menu
de atalho.

Caixa de diálogo Personalizar
Use esta caixa de diálogo para personalizar a aparência e o conteúdo das barras
de ferramentas do Autodesk Navisworks na interface de usuário Classic.

Menu: Classic user interface: Tools ➤ Customize
Menu de atalho: Classic user interface: clique com o botão direito em
qualquer barra de ferramentas, e clique em Customize no menu de atalho.

Guia Toolbars

Utilize esta guia para especificar quais barras de ferramentas devem aparecer
e quais devem estar ocultas, e para adicionar e gerenciar as suas próprias barras
de ferramentas na interface de usuário Classic.

Toolbars Selecione a caixa de seleção para exibir a barra de ferramentas
correspondente. Desmarque a caixa de seleção para ocultar a barra de
ferramentas correspondente.

Botões

New Exibe a caixa de diálogo New Toolbar e cria uma nova barra de
ferramentas personalizada. Por padrão, as novas barras de ferramentas são
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nomeadas como "Custom X" onde 'X' é o próximo número disponível
adicionado à lista.

Rename Exibe a caixa de diálogo Rename Toolbar e permite renomear uma
barra de ferramentas personalizada.

Delete Permite excluir uma barra de ferramentas personalizada selecionada.

Guia Commands

Use esta guia para adicionar e remover comandos da barra Menu e das barras
de ferramentas na interface de usuário Classic.

OBSERVAÇÃO Você pode adicionar e remover comandos de menus de atalho.

Categories Contém o grupo de comandos que podem ser personalizados.

Commands Contém todos os comandos disponíveis para a categoria
selecionada.

Selected Command

Description É ativado quando você coloca o comando em uma barra de
ferramentas ou menu. Clicar neste botão lhe fornece mais informações sobre
o comando.

Modify Selection É ativado quando você coloca o comando em uma barra
de ferramentas ou menu. Clicar neste botão permite editar a aparência do
comando.
■ Reset. Redefine o comando selecionado para sua aparência padrão.

■ Delete. Exclui o comando selecionado.

■ Name. Especifica o nome do comando. Coloque um & ('e' comercial) na
frente da letra que deseja utilizar como um atalho de teclado. Pressionar
ALT junto com esta letra ativa o comando.

■ Default Style. Utiliza o estilo padrão para o comando.

■ Text Only. O comando é exibido como um texto (como é inserido na
caixa Name).

■ Image and Text. O comando é exibido como texto e imagem.

■ Begin a Group. Adiciona um separador à esquerda do comando se este
está adicionado em uma barra de ferramentas, ou acima do comando se
este está adicionado em um menu.
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Guia Options

Use esta guia para personalizar a aparência de barras de ferramentas e menus
na interface de usuário Classic.

Personalized Menus and Toolbars

Always Show Full Menus Indica se a barra Menu contém todos os comandos
ou não. Por padrão, esta caixa de seleção é selecionada.

Se você somente deseja mostrar comandos básicos e de uso frequente em
versões mais curtas do menu, desmarque esta caixa de seleção.

Show Full Menus After a Short Delay É ativado quando a caixa de seleção
Always Show Full Menus estiver desmarcada. Selecione esta caixa de seleção
se você deseja mostrar todos os comandos no menu após uma breve pausa
quando deixa o ponteiro do mouse sobre um menu aberto.

Reset Menu and Toolbar Usage Data Redefine quaisquer aliterações feitas
na aparência de barras de ferramentas e menus para as configurações padrão.

Other

Large Icons Alterna o tamanho dos botões da barra de ferramentas. Isto não
afeta os ícones utilizados nos menus.

List Font Names in Their Font Alterna a forma com que os nomes de fontes
são mostrados na lista de fontes.

Show ScreenTips on Toolbars Alterna a exibição de dicas de ferramentas
quando cursor do mouse passa sobre um botão da barra de ferramentas.

Show Shortcut Keys in ScreenTips É ativado quando a caixa de seleção Show
ScreenTips on Toolbars estiver selecionada. Alterna a exibição de atalhos
de teclado nas dicas de ferramentas.

Menu Animations Define como os menus recebem a animação.

Caixa de diálogo Default Collision
Utilize esta caixa de diálogo para especificar e salvar suas configurações de
colisão preferidas em um espaço de trabalho 3D.

Por padrão, as vistas Collision, Gravity, Auto Crouch, e Third Person
estão desativadas. Quando você modifica as configurações padrão de colisão,
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suas alterações não afetam o arquivo do Autodesk Navisworks aberto no
momento. Elas são utilizadas assim que abrir um novo arquivo do Autodesk
Navisworks ou iniciar uma nova sessão do Autodesk Navisworks.
Collision Selecione esta caixa de seleção para definir um visualizador como
um volume de colisão nos modos Walk e Fly. Como resultado, um
visualizador adquire alguma massa e não pode passar através de outros objetos,
pontos ou linhas na Scene View.

OBSERVAÇÃO A seleção desta caixa de seleção altera a prioridade de renderização,
para que os objetos em torno do visualizador sejam exibidos com muito mais
detalhes do que o normal. O tamanho da região de alto detalhe tem base no raio
do volume de colisão e na velocidade do movimento.

Gravity Selecione esta caixa de seleção para fornecer alguma espessura ao
visualizador no modo Walk. Esta opção somente funciona em conjunto como
Collision.

Auto Crouch Selecione esta caixa de seleção para ativar um visualizador para
agachar sob objetos que estão muito baixos para passar por baixo no modo
Walk. Esta opção somente funciona em conjunto como Collision.

Viewer

Radius Especifica o raio do volume de colisão.

Height Especifica a altura do volume de colisão.

Eye Offset Especifica a distância abaixo do topo do volume de colisão, onde
a câmera irá focar se a caixa de seleçãoAuto Zoom estiver selecionada.

Third Person

Enable Selecione esta caixa de seleção para utilizar a vista Third Person. Em
uma vista Third Person, um avatar é exibido na Scene View para representar
o visualizador.

A seleção desta caixa de seleção altera a prioridade de renderização, para que
os objetos em torno do avatar sejam exibidos com muito mais detalhes do
que o normal. O tamanho da região de alto detalhe tem base no raio do volume
de colisão, na velocidade do movimento e na distância da câmera atrás do
avatar.

Auto Zoom Selecione esta caixa de seleção para trocar automaticamente da
vista Third Person para a vista de primeira pessoa sempre que a linha de
visão fique obscurecida por um item.

Avatar Especifica o avatar que é utilizado na vista Third Person.
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Ângulo Especifica o ângulo no qual a câmera olha para o avatar.

Por exemplo, 0º posiciona a câmera diretamente atrás do avatar, 15º faz com
que a câmera olhe para baixo para o avatar em um ângulo de 15º graus.

Distance Especifica a distância entre a câmera e o avatar.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Dispositivo apontador:  Caixa de diálogo Options Editor nó  ➤ Interface
página  ➤ Viewpoint Defaults ➤ Settings

Caixa de diálogo Edit Key Frame
Use esta caixa de diálogo para editar quadros-chave para conjuntos de
animação, câmeras, e planos de corte.

Os campos nesta caixa de diálogo são sensíveis ao contexto, dependendo do
tipo de animação, e permitem editar as operações de animação que o
quadro-chave selecionado representa.

OBSERVAÇÃO Os conjuntos de animações e os planos de corte somente estão
disponíveis para modelos 3D.

Edit Key Frame - Animation Set

Todos os valores são relativos ao quadro-chave anterior, ou, se for o primeiro
quadro-chave, relativos a posição inicial do modelo.

Time Permite reposicionar o tempo deste quadro-chave. O valor é o número
de segundos desde o início da cena e não é relativo ao último quadro-chave.

Translate Insira os valores de coordenadas X, Y, e Z para mover os objetos
selecionados para a posição.

Center Insira os valores de coordenadas X, Y, e Z para mover o ponto central
da rotação ou escala para esta posição.

Rotate Insira os graus de rotação em torno dos eixos X, Y, e Z para mover os
objetos selecionados para esta posição.

Orientation Insira os graus de rotação em torno dos eixos X, Y, e Z para
modificar a orientação da rotação.

OBSERVAÇÃO  0,0,0 representa universo acima.
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Scale Insira o fator de escala em torno dos eixos X, Y, e Z; 1 sendo o tamanho
atual, 0.5 metade, 2 sendo o dobro, e assim por diante.

Color Esta caixa de seleção indica se a mudança de cor é gravada no
quadro-chave. Insira os valores R (red), G (green), e B (blue) para a nova cor.

Caso não deseje inserir os valores R, G, B manualmente, clique em  e
selecione a cor desejada.

Transparency Esta caixa de seleção indica se a mudança de transparência é
gravada no quadro-chave.

Insira o valor % par ajustar o nível de transparência (0 a 100%). Um valor
mais alto torna o elemento mais transparente. Um valor mais baixo torna o
elemento mais opaco.

Caso não deseje inserir manualmente os valores de transparência, use o
deslizador  para ajustar o nível de transparência.

Interpolate Determina se o Autodesk Navisworks interpola automaticamente
entre os quadros-chave atual e último. Esta é a opção padrão. Quando
desativada, não haverá um movimento gradual entre dois quadros-chave. Ao
invés disso, a animação irá instantaneamente pular para a posição/visualização
do segundo quadro-chave quando for alcançado. Também, não haverá uma
barra colorida de animação entre os quadros-chave.

Edit Key Frame - Camera

Time Permite reposicionar o tempo deste quadro-chave. O valor é o número
de segundos desde o início da cena e não é relativo ao último quadro-chave.

Position Insira os valores das coordenadas X, Y e Z para mover a câmera para
esta posição.

Look At Insira os valores das coordenadas X, Y e Z para alterar o ponto focal
para a câmera.

Vertical Field of View, Horizontal Field of View Define a área da cena que
pode ser visualizada através da câmera. Você pode ajustar os valores para os
ângulos de visão vertical e horizontal. Um valor maior produz um ângulo mais
largo de visão e um valor menor produz um ângulo mais estreito ou um ângulo
de visão para precisamente focado.

OBSERVAÇÃO Quando você modifica o Vertical Field of View, o Horizontal
Field of View é automaticamente ajustado, e vice-versa, para coincidir com a
relação de aspecto no Autodesk Navisworks.

Rolar Rotaciona a câmera em torno de seu eixo frontal-traseiro. Um valor
positivo rotaciona a câmera no sentido anti-horário e um valor negativo
rotaciona no sentido horário.
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Interpolate Determina se o Autodesk Navisworks interpola automaticamente
entre os quadros-chave atual e último. Esta é a opção padrão. Quando
desativada, não haverá um movimento gradual entre dois quadros-chave. Ao
invés disso, a animação irá instantaneamente pular para a posição/visualização
do segundo quadro-chave quando for alcançado. Também, não haverá uma
barra colorida de animação entre os quadros-chave.

Edit Key Frame - Section Plane

Time Permite reposicionar o tempo deste quadro-chave. O valor é o número
de segundos desde o início da cena e não é relativo ao último quadro-chave.

Section Planes Uma lista do planos de corte atuais.

Adiciona um plano de corte na lista Section Planes.

Exclui o plano de corte da lista Section Planes.

Distance A distância do plano de corte selecionado através do modelo.

Plane Seleciona o vetor que representa o ângulo do plano de corte. A lista
suspensa contém uma gama de valores predefinidos. Se selecionar a opção
Define Custom, poderá definir manualmente o vetor "acima" para o plano.

Enabled Indica se o plano de corte selecionado está ativo ou não.

Interpolate Determina se o Autodesk Navisworks interpola automaticamente
entre os quadros-chave atual e último. Esta é a opção padrão. Quando
desativada, não haverá movimento gradual entre os dois quadros-chave. Ao
invés disso, a animação irá instantaneamente pular para a posição/visualização
do segundo quadro-chave quando for alcançado. Também, não haverá uma
barra colorida de animação entre os quadros-chave.

Dispositivo apontador: Clique duas vezes em uma quadro-chave.
Menu de atalho: Clique com o botão direito em um quadro-chave, e clique
em Edit no menu de atalho.

Caixa de diálogo Edit Link
Utilize esta caixa de diálogo para modificar o link do banco de dados
selecionado.

Para obter mais informações sobre as configurações nesta caixa de diálogo,
consulte a caixa de diálogo New Link na página 808.
Dispositivo apontador:  Caixa de diálogo File Options ➤  guia
DataTools ➤  Edit
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Caixa de diálogo Edit Viewpoint
Utilize esta caixa de diálogo para editar atributos do ponto de vista.

Camera

Position Insira os valores das coordenadas X, Y e Z para mover a câmera para
esta posição. Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.

Look At Insira os valores das coordenadas X, Y e Z para alterar o ponto focal
para a câmera. Os valores da coordenada Z não estão disponíveis em uma área
de trabalho 2D.

Vertical Field of View, Horizontal Field of View Define a área da cena que
pode ser visualizada através da câmera somente em um espaço de trabalho
3D. Você pode ajustar os valores para os ângulos de visão vertical e horizontal.

Um valor maior produz um ângulo mais largo de visão e um valor menor
produz um ângulo mais estreito ou um ângulo de visão para precisamente
focado.

OBSERVAÇÃO Quando você modifica o Vertical Field of View, o Horizontal
Field of View é automaticamente ajustado, e vice-versa, para coincidir com a
relação de aspecto no Autodesk Navisworks.

Rolar Rotaciona a câmera em torno de seu eixo frontal-traseiro. Um valor
positivo rotaciona a câmera no sentido anti-horário e um valor negativo
rotaciona no sentido horário.

OBSERVAÇÃO Este valor não é editável quando o vetor superior do ponto de
vista permanece em pé (isto é, quando você usa as ferramentas de navegação
Walk, Orbit e Constrained Orbit).

Motion

Linear Speed A velocidade do movimento em uma linha reta para o ponto
de vista em um espaço de trabalho 3D. O valor mínimo é 0 e o valor máximo
tem base no tamanho da caixa de delimitação da cena.

Angular Speed A velocidade na qual a câmera gira em um espaço de trabalho
3D.
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Saved Attributes

Esta área somente se aplica para pontos de vista salvos. Se você está editando
um ponto de vista atual, esta área fica acinzentada.

Hide/Required Selecione esta caixa de seleção para salvar informações de
revisão ocultas/requeridas sobre objetos em seu modelo com o ponto de vista.
Quando você utiliza novamente um ponto de vista, as revisões
ocultas/requeridas definidas quando o ponto de vista foi salvo são aplicadas.

OBSERVAÇÃO Salvar o estado da informação com cada ponto de vista requer
um quantidade relativamente grande de memória.

Override Material Selecione esta caixa de seleção para salvar informações de
sobreposição de material com o ponto de vista. Quando você utiliza novamente
um ponto de vista, as sobreposições de material definidas quando o ponto de
vista foi salvo são aplicadas.

OBSERVAÇÃO Salvar o estado da informação com cada ponto de vista requer
um quantidade relativamente grande de memória.

Collision

Settings Abre a caixa de diálogo Collision na página 786. Esta função está
disponível somente em um espaço de trabalho 3D.

Faixa de opções:  Guia Viewpoint ➤ painel Save, Load &

Playback ➤ Edit Current Viewpoint
Menu: Interface do usuário Classic: Viewpoint ➤ Edit Current

Viewpoint

Caixa de diálogo Export Rendered Image
Utilize esta caixa de diálogo para exportar uma cena renderizada em um dos
tipos de arquivos suportados pelo Autodesk Navisworks.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

Type Utilize a lista suspensa para selecionar um dos tipos de arquivos
suportados pelo Autodesk Navisworks.

Escolha entre:

■ Targa

■ TIFF
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■ JPEG

■ Windows Bitmap

■ EPix

■ PostScript

■ LWI

■ HDR (High Dynamic Range Image)

■ OpenEXR (High Dynamic Range Image)

■ PNG

■ QTVR Panoramic Movie

OBSERVAÇÃO O QTVR Panoramic Movie irá efetivamente exportar 32
imagens, rotacionando em torno da posição da câmera atual para formar um
panorama de 360º graus. O melhores resultados são obtidos quando a câmera
tem uma inclinação zero e está localizada em uma posição que tenha uma
vista panorâmica de 360º graus, no centro de um ambiente.

■ QTVR Object Movie

OBSERVAÇÃO O QTVR Object Movie exportará efetivamente um número
extenso de imagens (com base no número de quadros de pan x o número de
quadros de inclinação, consulte Caixa de diálogo QTVR Object Movie Settings
na página 881) girando o modelo em torno de seu ponto central. Melhores
resultados são obtidos quando o modelo é relativamente menor ou compacto.

■ Printer

Browse Abre a caixa de diálogo Save As , e permite especificar a localização
e o nome do arquivo para o qual deseja renderizar.

Size

Type Utilize a lista suspensa para especificar como definir o tamanho da
imagem exportada.

Escolha entre:

■ Explicit. Fornece o controle completo da largura e altura (as dimensões
são em pixels).

■ Use Aspect Ratio. Permite especificar a altura. A largura é
automaticamente calculada a partir da relação de aspecto de sua vista atual.

■ Use View. Utiliza a largura e a altura de sua vista atual.

798 | Capítulo 17    Reference



■ Use Printer Page. Dimensiona a imagem para o tamanho configurado
da página da impressora padrão.

Width Permite inserir a largura em pixels, quando disponível.

Height Permite inserir a altura em pixels, quando disponível.

Faixa de opções:  Guia Output painel  ➤ Visuals ➤ Rendered Image

Menu: Botão Application  ➤ Export ➤ Images &
Animations ➤ Rendered Image

Menu: Classic user interface: File ➤ Export ➤ Rendered Image

Caixa de diálogo File Options
Utilize esta caixa de diálogo para controlar a aparência do modelo e a
velocidade de navegação em torno do mesmo, e também para criar e configurar
links para bancos de dados externos.

OBSERVAÇÃO Algumas das guias estão disponíveis somente ao trabalhar com
modelos 3D.

Quando você modifica qualquer uma das opções nesta caixa de diálogo, suas
alteração são salvas no arquivo do Autodesk Navisworks no momento aberto,
e somente se aplica à este arquivo.
Faixa de opções:  Painel Home ➤ guia Project ➤ File Options

Menu: Interface de usuário Classic: Tools ➤ File Options.

Guia Culling

Utilize esta guia para ajustar a seleção da geometria no arquivo aberto do
Autodesk Navisworks.

OBSERVAÇÃO As opções de planos de corte e face traseira estão disponíveis
somente para modelos 3D.

Area

Enable Especifica se a seleção da área é utilizada ou não.
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Number of Pixels Below Which Objects Are Culled Especifica um valor para
a área de tela em pixels abaixo do qual os objetos são selecionados. Por
exemplo, definir este valor como 100 pixels, significa que qualquer objeto
dentro modelo que seria desenhado com um tamanho menor do que 10x10
pixels, será descartado.

Clipping Planes

Near
Automatic Selecione este botão para que o Autodesk Navisworks controle
automaticamente a posição dos planos de recorte próximos para oferecer a
melhor vista do modelo. A caixa Distance se torna indisponível.

Constrained Selecione este botão para restringir o plano de recorte próximo
para o valor definido na caixa Distance.

O Autodesk Navisworks utiliza os valores fornecidos, a menos que isso afete
o desempenho do sistema (por exemplo, tornar todo o modelo invisível).
Nesse caso, ele ajusta a posição dos planos de recorte como necessário.

Fixed Selecione este botão para definir o plano de recorte próximo para o
valor fornecido na caixa Distance.

Distance Especifica a distância mais afastada entre a câmera e a posição do
plano de recorte próximo no modo restringido.

Especifica a distância exata entre a câmera e a posição do plano de recorte
próximo no modo fixo.

OBSERVAÇÃO Nada é desenhado entre a câmera e o plano de recorte próximo.
Quando você sobrepõe o modo automático, torne este valor suficientemente
pequeno para exibir seus dados. Também, a sobreposição do modo automático
com valores abaixo de 1 pode produzir resultados imprevisíveis.

Far
Automatic Selecione este botão de opção para que o Autodesk Navisworks
controle automaticamente a posição dos planos de recorte afastados para
oferece a melhor vista do modelo. A caixa Distance se torna indisponível.

Constrained Selecione este botão para restringir o plano de recorte afastado
com o valor definido na caixa Distance.

O Autodesk Navisworks utiliza os valores fornecidos, a menos que isso afete
o desempenho do sistema (por exemplo, tornar todo o modelo invisível).
Nesse caso, ele ajusta a posição dos planos de recorte afastados como necessário.

Fixed Selecione este botão para definir o plano de recorte afastado com o valor
definido na caixa Distance.
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Distance Especifica a menor distância entre a câmera e a posição do plano de
recorte afastado no modo restringido.

Especifica a distância exata entre a câmera e a posição do plano de recorte
afastado no modo fixo.

OBSERVAÇÃO Nada é desenhado além deste plano. Quando você sobrepõe o
modo automático, torne este valor suficientemente grande para incluir seus dados.
Adicionalmente, a utilização da relação do plano de recorte afastado para o plano
de recorte próximo em excesso de 10.000 pode produzir efeitos indesejados.

Backface

Ativa a seleção da face traseira para todos os objetos. Selecione entre as
seguintes opções:
■ Off. Desativa a seleção de face traseira.

■ Solid. Ativa a seleção da face traseira para objetos sólidos somente. Esta é
a opção padrão.

■ On. Ativa a seleção da face traseira para todos os objetos.

DICA Se você pode ver através de alguns objetos ou algumas partes do objeto
estão faltando, desative a seleção da face traseira.

DICA Caso deseje restaurar os valores padrão, clique no botão Reset to Defaults.

Guia Orientation

Utilize esta guia para ajustar a orientação no mundo real de seu modelo.

OBSERVAÇÃO Esta guia está disponível somente para os modelos 3D.

Up

X, Y, Z Especifique os valores de coordenada X, Y, e Z. Por padrão, o Autodesk
Navisworks identifica o eixo Z positivo como Up.

North

X, Y, Z Especifique os valores de coordenada X, Y, e Z. Por padrão, o Autodesk
Navisworks identifica o eixo Y positivo como o North.
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DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Guia Speed

Utilize esta guia para ajustar a velocidade da taxa de quadro para reduzir o
montante de navegação descartada.

DICA Caso isto não aprimore a navegação, tente desativar a opção Guarantee
Frame Rate.

Frame Rate Especifica o número de quadros por segundo (FPS) que são
renderizados na Scene View.

A configuração padrão é 6. Você pode definir a frequência de quadro de 1 a
60 quadros por segundo. A redução do valor reduz o descarte, mas pode causar
um movimento com sobre-saltos durante a navegação. Aumentar o valor
assegura uma navegação mais suave, mas aumenta o descarte.

DICA Caso deseja restaurar os valores padrão clique no botão Defaults.

Guia Headlight

Utilize esta guia para alterar a intensidade da luz ambiente da cena e a luz
frontal para o modo Head Light.

OBSERVAÇÃO Esta guia está disponível somente para os modelos 3D.

Ambient Mova o deslizador para controlar o brilho da cena.

Headlight Utilize o deslizador para controlar o brilho da luz localizada na
câmera.

OBSERVAÇÃO Para ver os efeitos de suas alterações no modelo na Scene View,
aplique o modo Head Light na faixa de opções.

Guia Scene Lights

Utilize esta guia para alterar a intensidade da luz ambiente da cena para o
modo Scene Lights.
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OBSERVAÇÃO Esta guia está disponível somente para os modelos 3D.

Ambient Mova o deslizador para controlar o brilho da cena.

OBSERVAÇÃO Para ver os efeitos de suas alterações no modelo na Scene View,
aplique o modo Scene Lights na faixa de opções.

Guia DataTools

Utilize esta guia para criar e gerenciar links entre o arquivo do Autodesk
Navisworks aberto e bancos de dados externos.

DataTools Links Exibe todos os links de bancos de dados no arquivo do
Autodesk Navisworks. Selecione a caixa de seleção próxima ao link para ativá-lo.

IMPORTANTE Você não pode ativar links com informações insuficientes ou
inválidos de configuração.

Botões

New Abre a caixa de diálogo New Link na página 808, onde você especifica os
parâmetros do link.

Edit Abre a caixa de diálogo Edit Link na página 795 , onde é possível modificar
os parâmetros para o link do banco de dados selecionado.

Delete Exclui o link de banco de dados selecionado.

Import Permite selecionar e abrir arquivos datatools anteriormente salvos.

Export Salva o link de banco de dados selecionado como um arquivo datatools.

OBSERVAÇÃO Caso deseja restaurar os valores padrão clique no botão Defaults.

Caixa de diálogo Units and Transform
Utilize esta caixa de diálogo para ajustar as unidades e as transformações do
arquivo para o arquivo 3D selecionado na Selection Tree ou para a folha
2D aberta no momento.

OBSERVAÇÃO Somente é possível ajustar as unidades e a transformação para um
arquivo 3D ou uma folha 2D de cada vez.
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Unidades de modelo

Units Permite escolher as unidades para o modelo 3D carregado.

Unidades de folha

Units Permite escolher as unidades para a folha 2D carregada.

Origin

Origin Insira os valores das coordenadas X, Y, e Z para mover a geometria do
arquivo para esta posição.

OBSERVAÇÃO Os valores da coordenada Z não estão disponíveis para as folhas
2D.

Reflected Transform Selecione esta caixa de seleção se você utiliza uma escala
negativa para sua transformação.

OBSERVAÇÃO Reflected Transform não está disponível para as folhas 2D.

Rotação

Insira o ângulo de rotação.

Selecione o eixo de rotação ao inserir valores maiores do que 0. A geometria
do modelo ou da folha rotaciona em torno de seu ponto de origem. Os números
positivos rotacionam o modelo ou a folha no sentido anti-horário, e os
números negativos rotacionam o modelo ou a folha no sentido horário.

Escala

Insira o fator de escala em torno dos eixos X, Y e Z para a geometria do
arquivo; 1 sendo o tamanho atual, 0.5 metade, 2 o dobro, e assim por diante.
Para alterar a escala proporcionalmente, assegure que os valores de X, Y e Z
sejam iguais. A inserção de uma valor negativo vira a geometria do arquivo
de dentro para fora.

OBSERVAÇÃO Os valores negativos da escala não podem ser utilizados em folhas
2D. Os valores da coordenada Z também não estão disponíveis para folhas 2D.

Menu de atalho: Modelo 3D: clique com o botão direito do mouse no item
desejado na Selection Tree e clique em Units and Transform no menu
de atalho
Menu de atalho: Folha 2D: clique com o botão direito do mouse na folha
na Scene View e clique em Units and Transform no menu de atalho

804 | Capítulo 17    Reference



Caixa de diálogo Image Export
Utilize esta caixa de diálogo para exportar o ponto de vista atual para um dos
tipos de arquivos suportados pelo Autodesk Navisworks.

Output

Format Utilize a lista suspensa para selecionar um dos tipos de imagens
suportados pelo Autodesk Navisworks.

Escolha entre:

■ JPEG

■ PNG

■ Windows Bitmap

Opções Permite especificar as opções para arquivos PNG e JPG. Para imagens
PNG, você pode selecionar as configurações Interlacing e Compression
Level, e para imagens JPEG pode selecionar os níveis de Compression e
Smoothing.

Size

Type Utilize a lista suspensa para especificar como definir o tamanho da
imagem exportada.

Escolha entre:

■ Explicit. Fornece o controle completo da largura e altura (as dimensões
são em pixels).

■ Use Aspect Ratio. Permite especificar a altura. A largura é
automaticamente calculada a partir da relação de aspecto de sua vista atual.

■ Use View. Utiliza a largura e a altura de sua vista atual.

Width Permite inserir a largura em pixels, quando disponível.

Height Permite inserir a altura em pixels, quando disponível.

Options

Anti-Aliasing Esta opção somente se aplica para a renderização OpenGL. A
suavização de serrilhado é utilizada para suavizar as arestas das imagens
exportadas. Selecione o valor apropriado na lista suspensa. Quando maior o
número, mais suave a imagem, mas leva mais tempo para ser exportada. 4x é
adequado para a maioria das situações.
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Faixa de opções:  Guia Output painel  ➤ Visuals ➤ Image
Menu: Botão Application  ➤ Export ➤ Images & Animations ➤ Image
Menu: Classic user interface: File ➤ Export ➤ Image

Caixa de diálogo Configurações do InfoCenter
Use esta caixa de diálogo para especificar as configurações de InfoCenter e
Communication Center.

Botões

OK Salva as alterações e fecha a caixa de diálogo InfoCenter Settings.

Cancel Descarta as alterações e fecha a caixa de diálogo InfoCenter Settings.

Help Exibe a ajuda sensível ao contexto.

Dispositivo apontador: Na caixa InfoCenter, clique no botão Subscription
Center/Communication Center/Favorites  ➤ botão InfoCenter Settings

Nó General

Use o nó General para selecionar a sua localização atual, frequência para
verificar por novo conteúdo on-line e para ativar ou desativar os efeitos de
transição animados para os painéis do InfoCenter.
Please Indicate the Country/Region Nearest to Your Current Location
Define o país no qual os usuários do Autodesk Navisworks trabalham. Isso é
utilizado para ajustar o conteúdo específico da localização para o
Communication Center.

Check for New Online Content Especifica a frequência com que o
Communication Center verifica a existência de novo conteúdo.

Use Animated Transition Effects for Panels Selecione para animar transições
de painéis.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ General
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Nó Communication Center

Use o nó Communication Center para definir a idade máxima dos artigos
exibidos no painel Communication Center.
Hide Results Which Are More Than X Days Old Selecione esta caixa de
seleção para que o InfoCenter oculte resultados de pesquisa mais antigos do
que o valor numérico especificado.

CAD Manager Channel Usado por outros produtos da Autodesk para
especificar as alimentações RSS publicadas por um gerente de CAD, o CAD
Manager Channel não está ativado no Autodesk Navisworks.

Display Name Digite o nome a ser exibido no painel Search Results.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ Communication Center

Página Autodesk Channels

Utilize as configurações desta página para ajustar as configurações para o
Communication Center.

Por padrão, todos os canais são selecionados. Você não pode adicionar ou
remover canais da grade e não pode editar os dados na grade.
Select Channels to Display in the Communication Center Panel Selecione
os canais e o número de artigos que você deseja exibir no painel
Communication Center.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ Communication Center página  ➤ Autodesk Channels

Página Balloon Notification

Utilize as configurações nesta página para ajustar as notificações em balão.
Enable Balloon Notification for These Sources Selecione esta caixa de seleção
para ativar notificações em balão no produto. Notificações em balão aparecem
sobre a caixa do InfoCenter quando qualquer nova informação está disponível
das origens selecionadas.

Live Update Channel (New Software Updates) Selecione esta caixa de seleção
para receber notificações em balão de atualizações de software disponíveis.
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Product Support Information Channel Selecione esta caixa de seleção para
receber notificações em balão de novas informações do produto.

CAD Manager Channel O CAD Manager Channel não está ativado no
Autodesk Navisworks.

RSS Feeds Selecione esta caixa de seleção para receber notificações em balão
de novas alimentações RSS.

Number of Seconds Balloon Notification Displays Insira um valor numérico
para indicar a quantidade de tempo para exibir notificações em balão.

% Transparency of Balloon Notification Insira um valor numérico para
indicar a transparência das notificações em balão.

Alternativamente, arraste o deslizador em direção a Opaque para diminuir a
porcentagem da transparência da notificação em balão ou em direção a
Transparent para aumentar a porcentagem da transparência.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings ➤ nó
Centro de comunicações ➤ página Balloon Notification

Página RSS Feeds

Use as configurações nesta página para alimentações RSS.
RSS Subscription Add. Especifica o caminho para a alimentação RSS que você
deseja adicionar. Após a alimentação RSS ter sido adicionada à lista RSS
Subscription, em Items to Display insira um valor numérico para indicar
o número de itens a serem exibidos.

Remove. Remove uma alimentação RSS selecionada na lista RSS
Subscription.

Dispositivo apontador:  Caixa de diálogo InfoCenter Settings nó
 ➤ Communication Center página  ➤ RSS Feeds

Caixa de diálogo New Link
Utilize esta caixa de diálogo para adicionar um link de banco de dados no
arquivo do Autodesk Navisworks aberto.

Name  Especifica o nome do link do banco de dados. Este nome aparece como
uma guia na barra de controle Properties. Cada nome de link deve ser
exclusivo.
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Connection

ODBC Driver Define o tipo de banco de dados para o link. Utilize a lista
suspensa para selecionar o ODBC Driver apropriado.

Setup Abre o assistente Database Setup. Utilize-o para inserir as opções de
conexão. Caso tenha dificuldades para configurar seus detalhes de conexão,
contate seu administrador do banco de dados.

Quando terminar, a caixa abaixo irá mostrar a sequência de conexão.

Hold Open for Application Lifetime Especifica se o link do banco de dados
fica aberto até você sair do Autodesk Navisworks.

SQL String

Define qual tabela do banco de dados a ser consultada. Caso não esteja
familiarizado com o SQL, você pode ter que pedir que seu administrador de
banco de dados defina a declaração SQL.

Fields

Define quais colunas a serem exibidas como categorias de link na barra de
controle Properties.

Field Name Especifica o nome da coluna na tabela do banco de dados
selecionado. É preciso inserir o nome exato.

Display Name Especifica o nome da categoria mostrado na barra de controle
Properties. Este nome é automaticamente completado por você, mas é
possível modificá-lo, se necessário.

Dispositivo apontador:  Caixa de diálogo File Options guia
 ➤ DataTools ➤ New

Caixa de diálogo Options Editor
Utilize o Options Editor para ajustar as configurações do programa para as
sessões do Autodesk Navisworks.

As configurações definidas no Options Editor são persistentes em todas as
sessões do Autodesk Navisworks. Você também pode compartilhar as
configurações personalizadas com outros membros de sua equipe.

As opções são apresentadas em uma estrutura de árvore hierárquica. Clicar em
 expande os nós, clicar em  retrai os nós.
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Faixa de opções: Botão do aplicativo  ➤ Options
Menu: Classic user interface: Tools ➤ Global Options

Menu de atalho: Scene  ➤ Global Options

Botões

Export Exibe a caixa de diálogo Select Options to Export, onde é possível
selecionar as opções globais que você deseja exportar (ou "serializar"). Se uma
opção não pode ser exportada, ela não está disponível.

Import Exibe a caixa diálogo Open , onde é possível navegar para o arquivo
com as configurações de opções globais.

OK Salva as alterações e fecha o Options Editor.

Cancel Descarta as alterações e fecha o Options Editor.

Help Exibe a ajuda sensível ao contexto.

Nó General

Utilize estas configurações neste nó para ajustar o tamanho do buffer,
localizações de arquivo, número de atalhos de arquivo recente que você deseja
que o Autodesk Navisworks armazene e as opções de salvar automático.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Dispositivo apontador:  Caixa de diálogo Options Editor nó  ➤ General

Página Undo

Utilize as configurações nesta página nesta página para ajustar o tamanho do
buffer.

Dispositivo apontador: caixa de diálogo Options Editor ➤ nó
General ➤ página Undo
Buffer Size (KB) Especifica o montante de espaço que o Autodesk Navisworks
aloca para salvar as ações de desfazer/refazer.
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Página Locations

Utilize as opções nesta página para compartilhar as configurações globais do
Autodesk Navisworks, espaços de trabalho, ferramentas de dados, avatars,
regras do Clash Detective, arquivos do Presenter, testes personalizados do
Clash Detective, scripts de animação de objeto, e assim por diante, com outros
usuários.

Estas configurações podem ser compartilhadas através de todo um local de
projeto, ou através de um grupo de projetos específico, dependendo no nível
de granularidade requerido.

Quando você executa o Autodesk Navisworks pela primeira vez, as
configurações são obtidas do diretório de instalação. Subsequentemente, o
Autodesk Navisworks examina o perfil do usuário atual e os perfis de todos os
usuários na máquina local e, a seguir, verifica as configurações no Project
Directory e no Site Directory. Os arquivos no Project Directory tem
prioridade.

Project Directory Clique em  para abrir a caixa de diálogo Browse for
Folder, e localize o diretório que contém as configurações do Autodesk
Navisworks específicas do grupo de projetos.

Site Directory Clique em  para abrir a caixa de diálogo Browse for Folder,
e localize o diretório que contém as configurações padrão do Autodesk
Navisworks em todo o local do projeto.

Consulte também:

Opções de localização  na página 166

Como compartilho as configurações do programa com base no projeto e
no local?  na página 80

Página Environment

Utilize as configurações nesta página para ajustar o número de atalhos de
arquivo recente armazenados pelo Autodesk Navisworks.

Maximum Recently Used Files Especifica de quantos atalhos de arquivo o
Autodesk Navisworks pode se lembrar. Por padrão, os atalhos para os quatro
arquivos mais recentemente abertos podem ser exibidos.
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Página Auto-Save

Utilize a configuração nesta página para ajustar as opções de salvar automático.

Enable Auto-Save Indica se o Autodesk Navisworks salva automaticamente
os arquivos do Autodesk Navisworks. Por padrão, esta caixa de seleção é
selecionada.

Desmarque esta caixa de seleção se não desejar salvar automaticamente os
arquivos do Autodesk Navisworks.

Auto-Save File Location Especifica como os arquivos de backup são salvos.
Selecione entre as seguintes opções:
■ Auto-Save to a Specific Directory - esta é a opção padrão.

Directory
O diretório padrão para salvar automático é: <USERPROFILE>\ Application
Data\<PRODUCTFOLDER>\AutoSave

Clique em  para abrir a caixa de diálogo Browse for Folder  , e
selecione a localização desejada para salvar automático.

Manage Disk Space
Indica se o tamanho do espaço em disco restringe a criação de arquivos de
backup. Esta caixa de seleção é selecionada por padrão.

Purge Old Auto-Save Files When This Folder Exceeds (MB)
Ativo quando a caixa d seleção Manage Disk Space estiver selecionada,
Especifica o tamanho máximo do diretório para arquivos de backup. O
valor-padrão é 512 MB. Quando o tamanho da pasta salvar automático
excede o valor especificado, o Autodesk Navisworks exclui o arquivo de
backup mais antigo (com base na data de modificação).

■ Auto-Save Alongside the Current File

Frequency

Time Between Saves (Minutes) Define o intervalo de tempo entre o salvar
automático de significativas alterações no arquivo.

Por padrão, um arquivo de backup é salvo a cada 15 minutos após uma
significativa alteração no arquivo do Autodesk Navisworks.

History

Maximum Previous Versions Determina quantos arquivos de backup são
armazenados. Por padrão, é três arquivos. Quando o número de arquivos salvar
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automático excede o valor especificado, o Autodesk Navisworks exclui o arquivo
de backup mais antigo (com base na data de modificação).

Nó Interface

Utilize as configurações neste nó para personalizar a interface do Autodesk
Navisworks.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Página Display Units

Utilize esta página para personalizar as unidades utilizadas pelo Autodesk
Navisworks.

Linear Units Utilize a lista suspensa para selecionar o valor linear desejado.
Metro é utilizado por padrão.

Angular Units Utilize a lista suspensa para selecionar o valor angular desejado.
Graus são utilizados por padrão.

Decimal Places Especifica o número de casas decimais utilizadas por unidades.

Fractional Display Precision Especifica o nível de fração utilizado por
unidades. Esta caixa somente é ativada por unidades fracionais.

Página Selection

Utilize as opções nesta página para configurar a forma pela qual os objetos de
geometria são selecionados e realçados.

Pick Radius Especifica o raio em pixels no qual o item tem de estar para poder
ser selecionado.

Resolution Especifica o nível de seleção utilizado por padrão.

Ao clicar na Scene View, o Autodesk Navisworks requer um ponto inicial
para o caminho do objeto na caixa Selection Tree para identificar o item
selecionado. É possível selecionar entre as seguintes opções:

■ Model - o caminho do objeto começa no nó do modelo, e como resultado,
todos os objetos no modelo são selecionados.
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■ Layer - o caminho do objeto começa no nó da camada, e como resultado,
todos os objetos em uma camada são selecionados.

■ First Object - o caminho do objeto começa no nível mais alto de objetos
abaixo do nó da camada, se aplicável.

■ Last Object - o caminho do objeto começa no nível baixo alto de objetos
na Selection Tree. O Autodesk Navisworks procura primeiro por objetos
compostos e se nenhum for encontrado, o nível de geometria é utilizado.
Esta é a opção padrão.

■ Last Unique - o caminho do objeto começa no primeiro nível único de
objetos (não com múltiplas instâncias) na Selection Tree.

■ Geometry - o caminho do objeto começa do nível da geometria na
Selection Tree.

Compact Tree Especifica o nível de detalhes mostrados na guia Compact da
Selection Tree.

Utilize uma das seguintes opções:

■ Models - a árvore é restrita para somente exibir arquivos de modelo.

■ Layers - a árvore pode ser expandida para o nível de camada.

■ Objects - pode ser expandida para o nível de objetos, mas sem os níveis
de instâncias mostrados na guia Standard.

Highlight

Enabled Indica se o Autodesk Navisworks realça os itens selecionados na
Scene View.

Desmarque esta caixa de seleção se não desejar realçar os itens selecionados.

Method Especifica como os objetos são realçados. Selecione uma das seguintes
opções:
■ Shaded

■ Wireframe

■ Tinted

Color Clique em  para especificar a cor de realce.

Tint Level (%) Utilize o deslizador para ajustar o nível de matiz.
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Página Measure

Utilize as opções nesta página para ajustar a aparência e estilo das linhas de
medição.

Line Thickness Especifica a espessura das linhas de medição.

Color Clique em  para especificar a cor das linhas de medição.

In 3D Selecione esta caixa de seleção para desenhar linhas de medição em 3D.

Se as linhas de medição se tornam obscurecidas por outra geometria, desmarque
esta caixa de seleção para desenhar as linhas em 2D acima do topo da
geometria.

Show Measurement Values in Scene View Selecione esta caixa de seleção se
deseja exibir as legendas de cota na Scene View.

Use Center Lines Quando esta caixa de seleção estiver selecionada, as medições
de distância mais curta efetua o snap nas linhas centrais dos objetos
paramétricos.

Quando esta caixa de seleção estiver desmarcada, a superfície de objetos
paramétricos é utilizada para a medição da menor distância.

OBSERVAÇÃO A alteração desta opção não afeta qualquer medição em efeito.
Para visualizar quaisquer alterações, limpe a medição e comece novamente.

Página Snapping

Utilize as opções nesta página para ajustar o snap do cursor.

Picking

Snap to Vertex Selecione esta caixa de seleção para efetuar o snap do cursor
para o vértice mais próximo.

Snap to Edge Selecione esta caixa de seleção para efetuar o snap do cursor
para a aresta triangular mais próxima.

Snap to Line Vertex Selecione esta caixa de seleção para efetuar o snap do
cursor para a extremidade da linha próxima.

Tolerance Define a tolerância de snap. Quanto menor o valor, mais perto o
cursor precisa estar para aparecer no modelo antes de efetuar o snap.
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Rotation

Angles Especifica o multiplicador para o ângulo de snap.

Angle Sensitivity Define a tolerância de snap. O valor aqui inserido determina
quão perto o cursor precisa estar do ângulo de snap para que o snap tenha
efeito.

Página Viewpoint Defaults

Utilize as opções nesta página para definir atributos que sãos alvos com pontos
de vista quando você os cria.

Quando você modifica as configurações padrão do ponto de vista, suas
alterações não afetam o arquivo do Autodesk Navisworks aberto no momento.
Elas são utilizadas assim que você abre um novo arquivo do Autodesk
Navisworks ou inicia uma nova sessão do Autodesk Navisworks.
Save Hide/Required Attributes Selecione esta caixa de seleção para salvar
pontos de vista com informações de revisão ocultas/requeridas sobre objetos
em seu modelo. Quando você utiliza novamente um ponto de vista, as revisões
ocultas/requeridas definidas quando o ponto de vista foi salvo são aplicadas.

Por padrão, esta caixa de seleção está desmarcada, já salvar as informações de
estado com cada ponto de vista requer um quantidade relativamente grande
de memória.

Override Material Selecione esta caixa de verificação para salvar pontos de
vista com informações de sobreposição de material. Quando você utiliza
novamente um ponto de vista, as sobreposições de material definidas quando
o ponto de vista foi salvo são aplicadas.

Por padrão, esta caixa de seleção está desmarcada, já salvar as informações de
estado com cada ponto de vista requer um quantidade relativamente grande
de memória.

Override Linear Speed Por padrão, a velocidade de navegação linear está
diretamente relacionada ao tamanho de sue modelo. Selecione esta caixa de
seleção se você deseja definir manualmente uma velocidade específica de
navegação. Esta opção está disponível somente em um espaço de trabalho 3D.

Default Linear Speed Especifica o valor padrão da velocidade linear. Esta
opção está disponível somente em um espaço de trabalho 3D.

Default Angular Speed Especifica a velocidade padrão na qual a câmera gira.
Esta opção está disponível somente em um espaço de trabalho 3D.
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Collision

Settings Abre a caixa de diálogo Default Collision na página 791 onde é possível
ajustar as configurações de colisão, gravidade, de agachar e de vista de terceira
pessoa.

Página Links

Utilize as opções nesta página para personalizar a forma como os links são
exibidos na Scene View.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Show Links Alterna a exibição dos links na Scene View.

In 3D Indica se os ícones de link são desenhados em 3D na Scene View.

Selecione esta caixa se deseja que os links flutuem no espaço 3D justo em
frente de seus pontos de anexação à geometria.

Se os links se tornam obscurecidos por outra geometria, desmarque esta caixa
de seleção para desenhar os ícones de link em 2D acima do topo da geometria.

Max Icons Especifica o número máximo de ícones a serem desenhados na
Scene View.

Hide Colliding Icons Selecione esta caixa de seleção para ocultar os ícones
de link que aparecem sobrepostos na Scene View.

Cull Radius Especifica quão perto os links da câmera têm de estar antes de
serem desenhados na Scene View. Quaisquer links mais longe do que esta
distância não são desenhados. O valor padrão de 0 significa que todos os links
são desenhados.

X Leader Offset, Y Leader Offset Os links podem ser desenhados com linhas
de chamada de detalhe (setas) apontando para o ponto de anexação na
geometria à qual o link está anexado. Insira os valore de X- e Y- para especificar
o número de pixels para a direita e para acima que estas linhas de chamada
de detalhe irão utilizar.

Página Standard Categories

Utilize as configurações nesta página para alternar a exibição de links com
base em suas categorias.
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Hyperlink

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão  e  na Scene View.

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Legenda

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão  e  na Scene View.

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Clash Detective

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão na Scene View.

 - links para novas interferências■

■  - links para interferências ativas

■  - links para interferências solucionadas

■  - links para interferências revisadas

■  - links para interferências aprovadas

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.
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Hide Icons Without Comments Selecione esta caixa de seleção para somente
exibir os links que tenham comentários na Scene View.

TimeLiner

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão na Scene View.

 - links para tarefas manualmente criadas■

■  - links para tarefas com links válidos

■  - links para tarefas com links quebrados

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Hide Icons Without Comments Selecione esta caixa de seleção para somente
exibir os links que tenham comentários na Scene View.

Viewpoints

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão na Scene View.

 - links para pontos de vista salvos no modo de perspectiva■

■  - links para pontos de vista salvos no modo ortográfico

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Hide Icons Without Comments Selecione esta caixa de seleção para somente
exibir os links que tenham comentários na Scene View.

Redline Tags

Icon Type Especifica como exibir esta categoria de link.
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Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão  na Scene View.

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Hide Icons Without Comments Selecione esta caixa de seleção para somente
exibir os links que tenham comentários na Scene View.

Sets

Icon Type Especifica como exibir esta categoria de link.

Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão na Scene View.

 - links para conjuntos de seleção■

■  - links para conjuntos de pesquisa

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Visible Selecione esta caixa de seleção para exibir esta categoria de link na
Scene View.

Hide Icons Without Comments Selecione esta caixa de seleção para somente
exibir os links que tenham comentários anexados na Scene View.

Página User-Defined Categories

Utilize esta página para visualizar categorias de links personalizados.

O ícone de cadeado  indica que você não pode adicionar ou remover
categorias diretamente daqui.

Botões

Grid View Clique em  para exibir categorias de links personalizados em
um formato tabular.
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List View Clique em  para exibir categorias de links personalizados em
um formato de lista (da mesma forma que categorias de links padrão são
exibidas).

Records View Clique em  para exibir categorias links como registros.

Previous and Next Element Utilize  e  para navegar entre categorias
de links. Se você clicou no botão Records View , esta é a única forma para
mover entre registros.

Visible Selecione esta caixa de seleção para exibir a categoria de link
correspondente na Scene View.

Icon Type Selecione uma das seguintes opções:

■ Icon - os links são representados por ícones padrão  e  na Scene View.

■ Text - os links são representados por caixas de texto com descrições do
link na Scene View.

Página Quick Properties

Utilize as opções nesta página para personalizar a forma como as propriedades
rápidas são exibidas na Scene View.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Show Quick Properties Alterna a exibição das propriedades rápidas na Scene
View.

Hide Category Desmarque esta caixa de seleção para incluir nomes de
categorias nas dicas de ferramenta das propriedades rápidas.

Caso não deseje visualizar nomes de categorias nas dicas de ferramentas das
propriedades rápidas, selecione esta caixa de seleção.

Página Definitions

Utilize as opções nesta página para definir as categorias de propriedades rápidas.
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Botões

Add Element Clique em  para adicionar definições de propriedades rápidas.

Remove Element Clique em  para excluir as definições de propriedades
rápidas selecionadas.

Grid View Clique em  para exibir as definições de propriedades rápidas
em um formato tabular.

List View Clique em  para exibir as definições de propriedades rápidas
em um formato de lista.

Records View Clique em  para exibir as definições de propriedades rápidas
como registros.

Previous and Next Element Utilize  e  para navegar entre as definições
de propriedades rápidas.

Se você clicou no botão Records View , esta é a única forma para mover
entre registros.

Category Especifica a categoria de propriedade que você deseja personalizar.

Property Especifica a propriedade que é exibida nas dicas de ferramentas para
a categoria selecionada.

Página Developer

Utilize as opções nesta página para ajustar a exibição de propriedades do objeto.

Show Internal Properties Indica se as propriedades adicionais do objeto são
exibidas no Autodesk Navisworks.

Selecione esta caixa de seleção se deseja ter acesso à guia Geometry e à guia
Transform na barra de controle Properties.

Página Display

Utilize as opções nesta página para ajustar o desempenho de exibição.
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Gráficos 2D

Nível de detalhe  É possível ajustar o nível de detalhe de seus gráficos 2D, o
que significa que você pode trocar entre o desempenho da renderização e a
fidelidade 2D. Selecione entre as seguintes opções:
■ Low - fornece fidelidade 2D inferior, mas um melhor desempenho de

renderização.

■ Medium - fornece fidelidade 2D média e desempenho médio de
renderização, esta é a opção padrão.

■ High - fornece fidelidade 2D maior, mas menor desempenho de
renderização.

Detail

Guarantee Frame Rate Indica se o mecanismo do Autodesk Navisworks
mantém a frequência de quadros especificada na guia Speed na página 802 da
caixa de diálogo File Options.

Por padrão, esta caixa de seleção é selecionada e a taxa alvo é mantida ao
mover. Quando o movimento para, todo o modelo é renderizado.

Se esta caixa de seleção estiver desmarcada, o modelo completo é sempre
renderizado durante a navegação, não importando quanto tempo levar.

Fill In Detail Indica se o Autodesk Navisworks preenche qualquer detalhe
descartado quando a navegação é parada.

Sistema de gráficos

Seleção automática  O Autodesk Navisworks suporta dois sistemas de gráficos:
gráficos do Presenter e gráficos da Autodesk. Por padrão, esta caixa de seleção
é selecionada e o Autodesk Navisworks controla qual sistema de gráficos que
deseja utilizar. Desmarque esta caixa de seleção se você mesmo deseja selecionar
o sistema. Isso ativa a caixa suspensa System.

Hardware Acceleration Selecione esta caixa de seleção para utilizar qualquer
aceleração por hardware OpenGL disponível em sua placa de vídeo.

Se os drivers de sua placa de vídeo não funcionam bem com o Autodesk
Navisworks, desmarque esta caixa de seleção.

OBSERVAÇÃO Se sua placa de vídeo não suporta a aceleração por hardware
OpenGL, esta caixa de seleção não está disponível.

Caixa de diálogo Options Editor | 823



System  Esta caixa suspensa está disponível quando você desmarca a caixa de
seleção Auto-Select. Selecione entre as seguintes opções:
■ Presenter - suporta a exibição dos materiais do Presenter e usa hardware

ou software OpenGL.

■ Autodesk - suporta a exibição dos materiais da Autodesk e usa o Direct3D
ou o Hardware OpenGL.

OBSERVAÇÃO Os modelos 3D podem usar um sistema de gráficos; o sistema
Presenter é a opção padrão. As folhas 2D só podem utilizar o Autodesk Graphics
e não serão renderizadas sem uma placa gráfica Direct 3D/OpenGL compatível.

Occlusion Culling Selecione esta caixa de seleção para ativar a seleção da
obstrução. Isto significa que o Autodesk Navisworks somente desenha objetos
visíveis e ignora quaisquer objetos localizados atrás de outros objetos.

A seleção desta caixa de seleção aprimora o desempenho de exibição onde a
maior parte do modelo não está visível. Por exemplo, ao navegar por um
corredor de um edifício.

IMPORTANTE A seleção da oclusão somente pode ser utilizada em uma máquina
com uma placa gráfica compatível com o OpenGL. Além disso, a seleção da oclusão
não é utilizada em uma área de trabalho 2D.

Alerta

XYZ Axes Indica se o indicador XYZ Axes está exibido na Scene View.

Show Position  Indica se o Position Readout está exibido na Scene View.

Primitives

Point Size Insira um número de 1 a 9 para definir o tamanho em pixels de
pontos desenhados na Scene View.

Line Size Insira um número de 1 a 9 para definir a largura (em pixels) de linhas
desenhadas na Scene View.

Snap Size Insira um número de 1 a 9 para definir o tamanho (em pixels) de
pontos de snap desenhados na Scene View.

Enable Parametric Primitives Indica se o Autodesk Navisworks renderiza de
forma dinâmica primitivos paramétricos durante a navegação interativa.

A seleção desta caixa de seleção significa que o nível de detalhe muda durante
a navegação dependendo da distância da câmera.

824 | Capítulo 17    Reference



Desmarque esta caixa de seleção para utilizar representações padrão de
primitivos. O nível de detalhe permanece o mesmo durante a navegação.

Transparency

Interactive Transparency Selecione esta caixa de seleção para renderizar itens
transparentes de forma dinâmica durante a navegação interativa.

Por padrão, esta caixa de seleção está desmarcada e, portanto, os itens
transparentes somente são desenhados quando a interação é parada.

OBSERVAÇÃO  Se sua placa de vídeo na suporta a aceleração por hardware
OpenGL, a seleção desta caixa de seleção pode afetar o desempenho de exibição.

Página de drivers

Utilize as opções nesta página para ativar/desativar os drivers de exibição
disponíveis.

Drivers disponíveis

Esta é uma lista de todos os drivers que o Autodesk Navisworks pode suportar.
Por padrão, todos os drivers são selecionadas.

Software (OpenGL) Este é um driver legado, que funciona somente em
geometrias 3D. Se a caixa de seleção estiver desmarcada, o Autodesk Navisworks
irá ignorar o driver durante a renderização das geometrias.

Presenter (OpenGL) Este driver suporta o sistema de gráficos do Presenter e
somente funciona em geometrias 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (DirectX 9) Este driver suporta o sistema de gráficos da Autodesk
e funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (DirectX 10) Este driver suporta o sistema de gráficos da Autodesk
e funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (DirectX 11) Este driver suporta o sistema de gráficos da Autodesk
e funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
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o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Autodesk (OpenGL) Este driver suporta o sistema de gráficos da Autodesk e
funciona com as geometrias 2D e 3D. Se a caixa de seleção estiver desmarcada,
o Autodesk Navisworks irá ignorar o driver durante a renderização das
geometrias.

Página da Autodesk

Utilize as opções nesta página para ajustar os efeitos e os materiais usados no
modo de gráficos da Autodesk.

Efeitos da Autodesk

Shader Style Define o estilo de sombreamento da Autodesk nas faces. Selecione
entre as seguintes opções:
■ Basic Material: exibição realista das faces, semelhante à maneira como

apareceriam no mundo real. Esta é a opção padrão.

■ Gooch: usa cores frias e quentes, em vez de escuras e claras, para melhorar
a exibição de faces que poderiam ficar sombreadas e difíceis de ver em uma
exibição realista.

Materiais da Autodesk

Use Fall Back  Esta opção fornece controle da exigência de usar o Basic Material
(material básico) em vez do material consistente da Autodesk. Se sua placa de
vídeo não funciona bem com o material consistente da Autodesk, esta opção
será utilizada automaticamente.

Use Lod Texture  Selecione esta caixa de seleção se desejar utilizar texturas
LOD.

Reflection Enabled  Selecione esta caixa de seleção para ativar a reflexão de
cores para o material consistente da Autodesk.

Highlight Enabled  Selecione esta caixa de seleção para ativar a cor de espectro
para o material consistente da Autodesk.

Bump Enabled  Selecione esta opção se você deseja usar um mapa de saliência,
o que faz com que um objeto pareça ter uma superfície com saliências ou
irregular. Por exemplo, quando você renderiza um objeto com um material
mapeado com saliência, as áreas mais claras (mais brancas) do mapa parecem
ser áreas elevadas e áreas mais escuras (mais pretas) parecem estar baixas. Se

826 | Capítulo 17    Reference



a imagem estiver em cores, o valor de escala de cinza de cada cor é usada. O
mapeamento de curvas aumenta significativamente o tempo de renderização
mas adiciona ao realismo.

Image Library  Seleciona a biblioteca de materiais consistentes da Autodesk
com base na resolução da textura. Escolha entre as seguintes opções:
■ Base Resolution: biblioteca de materiais básicos, com resolução de

aproximadamente 256 x 256 pixels. Esta biblioteca é instalada por padrão
e é requerida pelo Autodesk Navisworks para suportar uma faixa completa
de funcionalidades de estilo visual e de cor.

■ Low Resolution: imagens de baixa resolução, aproximadamente 512 x
512 pixels.

■ Medium Resolution: imagens de resolução média, aproximadamente
1024 x 1024 pixels.

■ High Resolution: imagens de alta resolução. Esta opção não é suportada
no momento.

Max Texture Dimensions  Esta opção afeta os detalhes visuais de texturas
aplicadas na geometria. Insira o valor desejado em pixels. Por exemplo, um
valor de "128" significa que o tamanho máximo da textura é de 128 x 128
pixels. Quanto maior o valor, maior a carga em sua placa gráfica, já que mais
MB de memória é necessário para renderizar texturas.

Procedural Texture Size  Esta opção fornece o tamanho das texturas geradas
a partir de mapas processuais. Por exemplo, um valor de "256" significa que o
tamanho da textura é de 256 x 256, gerada a partir de mapas processuais.
Quanto maior o valor, maior a carga em sua placa gráfica, já que mais MB de
memória é necessário para renderizar texturas.

Múltiplas amostras de suavização de serrilhado

MSAA Level Define o valor da suavização de serrilhado para renderizar no
modo de gráficos da Autodesk. A suavização de serrilhado é utilizada para
suavizar as arestas da geometria. Quanto maior o número, mais suave é a
geometria, mas a renderização levará mais tempo. 2x é a opção padrão.

OBSERVAÇÃO Se a sua placa de vídeo não suporta um MSAA maior, utilize um
MSAA inferior que a placa de vídeo possa suportar automaticamente.
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Página 3Dconnexion

Utilize as opções nesta página para personalizar o comportamento de
dispositivos 3Dconnexion.

OBSERVAÇÃO Todas as opções são selecionados por padrão. Se você efetuar
quaisquer alterações, é possível clicar no botão Default para restaurar as
configurações originais.

Estas opções são oferecidas em adição aos ajustes que podem ser feitos
utilizando o Painel de controle para o dispositivo que é fornecido pelo
fabricante do dispositivo com a instalação.
Speed (Velocidade) Utilize o deslizador para ajustar a sensibilidade do
controlador.

Keep Scene Upright Selecione esta caixa de seleção para desativar o eixo de
rolagem. Quando selecionado, não será possível rolar o modelo para os lados.

Center Pivot on Selection (Centralizar giro na seleção) Selecione esta caixa
de seleção para mover o ponto de giro para o centro de quaisquer seleções
feitas por você.

Pan/Zoom Selecione esta caixa de seleção para ativar a funcionalidade de pan
e zoom no dispositivo 3Dconnexion.

Tilt/Spin/Roll (Inclinar/Girar/Rolar) Selecione esta caixa de seleção para
ativar a funcionalidade de inclinação, giro e rolagem do dispositivo
3Dconnexion.

Página Navigation Bar

Utilize as opções nesta página para personalizar o comportamento das
ferramentas na barra de navegação.

Ferramentas Orbit

Use Classic Orbit Selecione esta caixa de seleção se deseja mudar da ferramenta
Órbita padrão para o modo Órbita clássico do Autodesk Navisworks na barra
de navegação.

Use Classic Free Orbit (Examine) Selecione esta caixa de seleção se deseja
mudar da ferramenta Órbita livre padrão para o modo Examinar clássico do
Autodesk Navisworks na barra de navegação.
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Use Classic Constrained Orbit (Turntable) Selecione esta caixa de seleção se
deseja mudar da ferramenta Órbita restringida padrão para o modo clássico
Mesa giratória do Autodesk Navisworks na barra de navegação.

Ferramenta Walk

Use Classic Walk Selecione esta caixa de seleção se deseja mudar da ferramenta
Navegar padrão para o modo Navegar clássico do Autodesk Navisworks na
barra de navegação.

Constrain Walk Angle Quando esta caixa de seleção é selecionada, a
ferramenta Walk manterá a câmera em pé ao navegar. Se esta caixa de seleção
for desmarcada, a ferramenta permitirá que a câmera role enquanto navega
(resultando em um comportamento quase parecido com a ferramenta Fly).

Use Viewpoint Linear Speed Quando esta caixa de seleção é selecionada, a
ferramenta Walk irá respeitar a configuração de Viewpoint Linear Speed. Neste
caso, o deslizador de velocidade Walk irá agir como um multiplicador.

Quando esta caixa de seleção é desmarcada, a ferramenta Walk irá trabalhar
independente da configuração de Viewpoint Linear Speed, usando um valor
fixo definido com o deslizador.

Walk Speed Define e velocidade da ferramenta Walk de 0.1 (muito lenta) para
10 (muito rápida).

Página ViewCube

Utilize as opções nesta página para personalizar o comportamento ViewCube.

Show the ViewCube Indica se o ViewCube é ou não exibido na Scene View.

DICA Também é possível alternar o ViewCube ao clicar na guia View  ➤  painel

Navigation Aids  ➤  ViewCube  .

Size Especifica o tamanho do ViewCube. Você pode escolher entre as seguintes
opções:
■ Automatic

■ Tiny

■ Small

■ Medium

■ Large
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OBSERVAÇÃO No modo automático, o tamanho do ViewCube é relativo ao
tamanho da Scene View, e se encontra médio e bem pequeno.

Opacidade de inatividade Quando o ViewCube está inativo, ou seja, seu
cursor está distante do ViewCube, e ele aparece transparente. Para controlar
o nível de opacidade, escolha entre as seguintes opções:
■ 0%

■ 25%

■ 50%

■ 75%

■ 100%

Keep Scene Upright Indica se as orientações de cabeça para baixo da cena é
permitida quando você utiliza o ViewCube.

Quando esta caixa de seleção estiver selecionada, arrastar o ViewCube produz
um efeito de mesa giratória.

Ao arrastar no ViewCube

Enquanto estiver sendo arrastado, o ViewCube e a cena rotacionam de uma
forma como um bola de arco, a não ser que a caixa de seleção Manter cena
em pé esteja selecionada.

Snap to the Closest View Indica se o ViewCube efetua o snap para uma das
vistas fixas quando estiver angularmente perto de uma das vistas fixas.

Ao clicar no ViewCube

Fit-to-View on Change Quando esta caixa de seleção estiver selecionada,
clicar no ViewCube rotaciona em torno do centro da cena e afasta o zoom
para que a cena caiba na Scene View. Antes de arrastar o ViewCube, a vista
muda para olhar para o centro da cena (mas não efetua o zoom) e continua a
usá-lo como o ponto de rotação ao arrastá-lo.

Se esta caixa de seleção estiver desmarcada, clicar ou arrastar o ViewCube,
rotaciona em torno do ponto de giro atual e não aproxima ou afasta o zoom.

Use Animated Transitions When Switching Views Se esta caixa de seleção
estiver selecionada, uma transição animada é exibida quando se clica em uma
seção do ViewCube para ajudá-lo a visualizar o relacionamento espacial entre
o ponto de vista atual e o ponto de vista selecionado.
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OBSERVAÇÃO Ao navegar em cenas 3D que contêm grandes quantidades de
geometria, a taxa do quadro do aplicativo pode cair e tornar difícil para o sistema
animar com suavidade uma transição de ponto de vista.

Show the Compass Below the ViewCube Indica se a bússola é exibida abaixo
da ferramenta ViewCube.

SteeringWheels

Utilize as opções nesta página para personalizar os menus do SteeringWheels.

Big Wheels

Size Especifica o tamanho dos círculos grandes. Você pode escolher entre as
seguintes opções:
■ Small (64x64)

■ Normal (128x128)

■ Large (256x256).

Normal  esta é a opção padrão.

Opacity Controla o nível de opacidade dos círculos grandes. O valor-padrão
é 50%. Você pode escolher entre as seguintes opções:
■ 25% (o mais transparente)

■ 50%

■ 75%

■ 90% (o mais opaco)

Mini Wheels

Size Especifica o tamanho dos minicírculos. Você pode escolher entre as
seguintes opções:
■ Small (16x16)

■ Normal (32x32)

■ Large (64x64).

■ Extra Large (256x256)

Normal  esta é a opção padrão.
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Opacity Controla o nível de opacidade dos minicírculos. O valor-padrão é
50%. Você pode escolher entre as seguintes opções:
■ 25% (o mais transparente)

■ 50%

■ 75%

■ 90% (o mais opaco)

Mensagens na tela

Show Tool Messages Alterna a exibição de dicas de ferramentas para as
ferramentas de navegação. Quando esta caixa de seleção é selecionada, as dicas
de ferramentas são exibidas abaixo do cursor quando você utiliza as
ferramentas.

OBSERVAÇÃO Esta configuração está sempre ativa para os círculos View Object
e Tour Building, e não pode ser desativada.

Show Tooltips Alterna a exibição de dicas de ferramentas de círculos. Quando
esta caixa de seleção é selecionada, as dicas de ferramentas são exibidas quando
você passa o cursor sobre os setores nos círculos.

OBSERVAÇÃO Esta configuração está sempre ativa para os círculos View Object
e Tour Building, e não pode ser desativada.

Show Tool Cursor Text Alterna a exibição da legenda da ferramenta abaixo
do cursor.

OBSERVAÇÃO Esta configuração está sempre ativa para os círculos View Object
e Tour Building, e não pode ser desativada.

Ferramenta Look

Invert Vertical Axis A seleção desta caixa de seleção troca o eixo acima-abaixo
pela ferramenta Look, ou seja, empurrando o mouse adiante olha para baixo
e puxando o mouse para atrás olha acima.

Ferramenta Walk

Constrain Walk Angle A seleção desta caixa de seleção faz com que a
ferramenta Walk respeite o vetor acima universal (como definido em File
Options  ➤  Orientation). Como resultado, a ferramenta Walk faz com que a
câmera efetue o snap ao vetor acima atual.
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Quando esta caixa de seleção está desmarcada, a ferramenta Walk desconsidera
o vetor acima e a câmera é movimentada com esta orientação acima atual não
afetada.

Use Viewpoint Linear Speed Quando esta caixa de seleção é selecionada, a
ferramenta Walk irá respeitar a configuração de Viewpoint Linear Speed. Neste
caso, o deslizador de velocidade Walk irá agir como um multiplicador.

Quando esta caixa de seleção é desmarcada, a ferramenta Walk irá trabalhar
independente da configuração de Viewpoint Linear Speed, usando um valor
fixo definido com o deslizador.

Walk Speed Define e velocidade da ferramenta Walk de 0.1 (muito lenta) para
10 (muito rápida).

Ferramenta Zoom

Enable Single-Click Incremental Zoom In Quando esta caixa de seleção
estiver selecionada, clicar uma vez sobre a seção Zoom aumenta a ampliação
do modelo. Quando esta caixa de seleção está desmarcada, nada acontece
quando você clica uma vez na seção Zoom.

Ferramenta Orbit

Keep Scene Upright Quando esta caixa de seleção estiver selecionada, a
ferramenta Orbit se comporta de forma similar ao modo Orbit clássico, com
a órbita restringida ao longo do eixo XY e na direção Z.

Quando esta caixa de seleção está desmarcada, a ferramenta Orbit se comporta
de forma similar ao modo Examine clássico, e é possível rolar o modelo em
torno do ponto de giro.

Center Pivot on Selection (Centralizar giro na seleção) Quando esta caixa
de seleção estiver selecionada, os objetos selecionados antes da ferramenta
Orbit são usados para calcular o ponto de giro para uso ao orbitar. O ponto
de giro é calculado com base no centro das extensões dos objetos selecionados.

Página User Interface

Utilize as opções nesta página para escolher a interface de usuário (padrão ou
clássica), e selecionar o tema de cor.

User Interface Selecione entre as seguintes opções:
■ Classic. Alterna para a interface clássica do Autodesk Navisworks com

menus e barras de ferramentas antigos.
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■ Standard (recomendado). Alterna para a nova interface com uma paleta
de ferramentas da faixa de opções. Esta é a opção padrão.

Theme Utilize a lista suspensa para aplicar um dos temas de interface
predefinidos.

Nó Model

Utilize as configurações neste nó para otimizar o desempenho do Autodesk
Navisworks e para personalizar parâmetros para os arquivos NWD e NWC.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Página Performance

Utilize as opções nesta página para otimizar o desempenho do Autodesk
Navisworks.

Memory Limit

Auto Indica se o Autodesk Navisworks determina automaticamente a memória
máxima que pode ser utilizada. A seleção desta caixa de seleção define o limite
de memória para a menor memória física disponível ou espaço de endereço,
menos o requerido por seu sistema operacional.

Limit (MB) Especifica a memória máxima que o Autodesk Navisworks pode
utilizar.

Merge Duplicates

Esta opção aprimora o desempenho ao multiplicar as instâncias de coincidência
de itens. Em vez de armazenar cada item na memória, se quaisquer itens forem
os mesmos, o Autodesk Navisworks pode armazenar uma instância deles e
"copiar" aquela instância em outras posições. Isso tem particular benefício em
modelos grandes, onde há significativo número destas geometrias duplicadas.

On Convert Selecione esta caixa de seleção para mesclar duplicados quando
um arquivo CAD é convertido para o formato do Autodesk Navisworks.

On Append Selecione esta caixa de seleção para mesclar duplicados quando
um novo arquivo é anexado ao arquivo do Autodesk Navisworks aberto no
momento.
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On Load Selecione esta caixa de seleção para mesclar duplicados quando um
arquivo é carregado no Autodesk Navisworks.

On Save NWF Selecione esta caixa de seleção para mesclar duplicatas quando
a cena atual é salva no formato de arquivo NWF.

On Load

Collapse on Convert Retrai a estrutura de árvore na Selection Tree para o
nível especificado quando arquivos CAD nativos são convertidos ao Autodesk
Navisworks. Selecione entre as seguintes opções:
■ None - toda a árvore é expandida. Use esta opção para permitir que

polilinhas sejam divididas em segmentos individuais ao importar DWGs
e DGNs para suportar múltiplas intersecções de interferência. Para arquivos
DGN, também é preciso selecionar File Readers ➤ DGN ➤ caixa de
seleção Split Lines, e desmarcar File Readers ➤ DGN ➤ caixa de
seleção Merge Lines and Arcs. Para arquivos DWG, também é preciso
definir File Readers ➤ DWG/DXF ➤ menu suspenso Line Processing
como Separate All Lines.

■ Composite Objects - a árvore é retraída ao nível de objetos compostos.

■ All Objects - a árvore é retraída ao nível de objetos.

■ Layers - a árvore é retraída ao nível de camadas.

■ Files - a árvore é retraída ao nível de arquivos.

Isto permite que o desempenho seja priorizado acima da estrutura/propriedades
e tem o benefício adicional de aprimorar a racionalização ao cortar para baixo
da estrutura lógica.

OBSERVAÇÃO Embora o Autodesk Navisworks tente retrair itens para o menor
número possível, pode ser necessário prevenir a retração em alguns casos para
preservar a fidelidade do modelo. Por exemplo, se um item tem propriedades ou
materiais que lhe são únicos, então a retração iria prejudicar esta informação e,
portanto, ele não será retraído.

Close NWC/NWD files on Load Indica se os arquivo NWC e NWD são
fechados após serem carregados na memória.

Quando você abre arquivos NWC/NWD, o Autodesk Navisworks, eles são
bloqueados para edição. Ao selecionar esta caixa de seleção, você instrui o
Autodesk Navisworks a fechar os arquivos NWC ou NWD assim que estiverem
carregados na memória. Isso significa que os arquivos podem ser abertos e
editados por outros usuário enquanto você os está visualizando.
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Create Parametric Primitives Selecione esta caixa de seleção para permitir a
criação de modelos paramétricos (modelos descritos por fórmula e não por
vértices).

A utilização desta opção permite obter visualização de melhor aparência,
renderização mais rápida, menor espaço de memória (especialmente ao carregar
arquivos DGN e RVM com alto volume de dados paramétricos que não mais
precisam ser convertidos em vértices no Autodesk Navisworks).

OBSERVAÇÃO A modificação desta opção entra em feito após a próxima carga
ou atualização do arquivo.

Create Presenter Materials Selecione esta caixa de seleção para permitir a
criação de materiais do Presenter quando arquivos NWC são carregados.

Desmarcar esta caixa desativa a criação de materiais do Presenter.

Temporary File Location

Auto Indica se o Autodesk Navisworks seleciona automaticamente sua pasta
Temp.

Location  Clique em  para abrir a caixa de diálogo Browse for Folder
, e selecione a localização desejada da pasta Temp.

Página NWD

Utilize as opções nesta página para ativar e desativar a compressão de geometria
e selecionar se a precisão de determinadas opções é reduzida ao salvar ou
publicar arquivos NWD.

Geometry Compression

Enable Selecione esta caixa de seleção para ativar a compressão da geometria
quando arquivos NWD são salvos.

A compressão da geometria resulta em menos memória necessária e, portanto,
arquivos NWD menores.

Reduce Precision

Coordinates Selecione esta caixa de seleção para reduzir a precisão de
coordenadas.

Precision Especifica o valor de precisão para coordenadas. Quanto maior o
valor menor a precisão das coordenadas.
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Normals Selecione esta caixa de seleção para reduzir a precisão de normais.

Colors Selecione esta caixa de seleção para reduzir a precisão de cores.

Texture Coordinates Selecione esta caixa de seleção para reduzir a precisão
de coordenadas de textura.

Consulte também:

Formato de arquivo nativo  na página 175

Página NWC

Utilize as opções desta página para gerenciar a leitura e gravação de arquivos
cache (NWC).

Por padrão, quando o Autodesk Navisworks abre um arquivo CAD nativo (por
exemplo, AutoCAD ou MicroStation), primeiro ele verifica no mesmo diretório
se um arquivo cache está presente com o mesmo nome que o arquivo CAD,
mas com uma extensão .nwc. Se houver e este arquivo cache for mais recente
que o arquivo CAD nativo, o Autodesk Navisworks abre esse arquivo, já que
o mesmo já foi convertido para o formato do Autodesk Navisworks e, portanto,
abre muito mais rápido. No entanto, se não houver um arquivo cache presente
ou se o arquivo cache for mais antigo do que o arquivo CAD nativo, o Autodesk
Navisworks precisa abrir o arquivo CAD e convertê-lo. Por padrão, ele grava
um arquivo cache no mesmo diretório e com o mesmo nome do arquivo CAD,
mas com a extensão .nwc, para acelerar a abertura deste arquivo no futuro.

Caching

Read Cache Selecione esta caixa de seleção para utilizar arquivos cache quando
o Autodesk Navisworks abre arquivos CAD nativos.

Desmarque esta caixa de seleção se não desejar utilizar arquivo cache. Isto
assegura que o Autodesk Navisworks converta arquivos CAD nativos sempre
que eles são abertos.

Write Cache Selecione esta caixa de seleção para salvar arquivos cache quando
o arquivo CAD nativo é convertido. Geralmente, os arquivo cache são bem
menores do que os arquivos CAD originais e, portanto, a seleção desta opção
não ocupa muito espaço em disco.

Desmarque esta caixa de seleção se não desejar salvar arquivos cache.
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Geometry Compression

Enable Selecione esta caixa de seleção para ativar a compressão da geometria
quando arquivos NWC são salvos.

A compressão da geometria resulta em menos memória necessária e, portanto,
arquivos NWC menores.

Reduce Precision

Coordinates Selecione esta caixa de seleção para reduzir a precisão de
coordenadas.

Precision Especifica o valor de precisão para coordenadas. Quanto maior o
valor menor a precisão das coordenadas.

Normals Selecione esta caixa de seleção para reduzir a precisão de normais.

Colors Selecione esta caixa de seleção para reduzir a precisão de cores.

Texture Coordinates Selecione esta caixa de seleção para reduzir a precisão
de coordenadas de textura.

Consulte também:

Formato de arquivo nativo  na página 175

Nó File Readers

Utilize as configurações neste nó para configurar os leitores de arquivo
necessários para abrir CAD nativo e formatos de arquivos de aplicativo de
digitalização no Autodesk Navisworks.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Página 3DS

Utilize esta página para ajustar as opções para o leitor de arquivos 3DS.

Convert Hidden Selecione esta caixa de seleção se você deseja que o Autodesk
Navisworks converta entidades ocultas em arquivos 3DS. Elas são
automaticamente marcadas como ocultas pelo Autodesk Navisworks.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os itens ocultos.
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Bitmap File Search Paths Os caminhos de arquivos de mapas de textura não
são armazenados com os mapas de textura no modelo. Insira os caminhos
requeridos nesta caixa separando-os com ponto e vírgula.

Default Units Especifica o tipo de unidades que o Autodesk Navisworks usa
ao abrir arquivos 3DS.

DICA Se o tipo de unidade escolhido for errôneo, você pode redimensionar o
modelo ao utilizar a opção Units and Transform. (Clique com o botão direito
em Scene View e clique em File Units and Transform no menu de atalho.)

Consulte também:

Leitor de arquivos 3DS  na página 182

Página ASCII Laser

Utilize esta página para ajustar as opções para o leitor de arquivos de varredura
de laser ASCII.

Sample Rate Especifica a frequência de pontos extraídos do arquivo de entrada.

Aumentar a taxa de amostra reduz o número de pontos extraídos. Isso tem o
efeito de reduzir a resolução da imagem, mas aumenta a velocidade com a
qual o arquivo é carregado.

Use Point Intensity Values Selecione esta caixa de verificação para extrair os
valores de intensidade do arquivo de entrada.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os valores de intensidade.

Use Point Color Values Selecione a caixa de seleção para extrair valores de
cores do arquivo de entrada.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os valores de cores.

Consulte também:

Leitor de arquivos ASCII Laser Scan  na página 184

Página CIS/2

Utilize esta página para ajustar as opções para o leitor de arquivos CIS/2.
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Convert Features Indica se os recursos são convertidos.

OBSERVAÇÃO A conversão de um grande número de recursos pode ter um
impacto negativo no desempenho da carga.

Convert Unknown Section into Rectangle Selecione esta caixa de seleção
para converter perfis de corte desconhecidos em retângulos com parâmetros
estimados, mas a escala pode não ser apropriada.

Quando esta caixa está desmarcada, o leitor de arquivos ignora perfis de corte
desconhecidos.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real. Se esta distância for maior do que o
valor de Max Facet Deviation, o Autodesk Navisworks adiciona mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Página DGN

Utilize esta página para ajustar as opções para o leitor de arquivos 3D DGN e
PROP.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.
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Convert Hidden Items Selecione esta caixa de seleção para converter entidade
ocultas em arquivos DGN. Elas são automaticamente marcadas como ocultas
pelo Autodesk Navisworks.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os itens ocultos.

Show Hidden Items Selecione esta caixa de seleção, se você deseja exibir todas
as entidades nos arquivos DGN convertidos, sem respeitar se são ou não ocultas.

OBSERVAÇÃO Para utilizar esta opção, é preciso selecionar a caixa de seleção
Convert Hidden Items.

Convert Lines and Arcs Selecione esta caixa de seleção para converter linhas,
splines, curvas, arcos, círculos ou elipses em arquivos DGN.

Merge Lines and Arcs Selecione esta caixa de seleção, caso você deseja reduzir
a complexidade do modelo na Selection Tree ao interpretar linhas adjuntas
com a mesma cor, nível e principal como um item único.

Desmarque esta caixa de seleção se desejar deixar esses elementos como itens
separados no Autodesk Navisworks.

Split Lines Esta opção instrui o leitor de arquivos para desagrupar objetos de
polilinha. Como resultado, os elementos de linha são divididos em nós
separados para cada segmento de linha.

Use esta opção quando precisar aprimorar análises de detecção de interferências.
Por padrão, o Clash Detective trata entidades com múltiplos segmentos
como um único objeto, reportando uma interferência para cada par de objetos.
Desagrupar objetos de polilinha significa que cada segmento de linha pode
interferir independente de outros segmentos da linha. Como resultado, todas
as interferências em potencial são reportadas, e não somente a primeira a ser
encontrada.

IMPORTANTE Para que esta função funcione de acordo, é preciso desmarcar a
caixa de seleção Merge Lines and Arcs , já que ela tem prioridade sobre a opção
Split Lines. Adicionalmente, é preciso definir no menu suspenso
Model ➤ Performance ➤ Collapse on Convert para None, de outro modo
os objetos de polilinha serão retraídos em um único nó de geometria.

Convert Text Selecione esta caixa de seleção para converter texto em
propriedades rápidas no Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
texto nos arquivos DGN.

Default Font Indica qual fonte a ser usada para o texto convertido.
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Shape Merge Threshold Especifica o número de vértices para as formas do
MicroStation.

Se o número de vértices for menor ou igual ao valor de Shape Merge
Threshold, o Autodesk Navisworks mesclará todas as formas no mesmo nível
ou na mesma célula e com a mesma cor em um "Shape Set".

Convert References Selecione esta caixa de seleção para converter arquivos
de referência nos arquivos DGN.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os arquivos de referência.

Ignore Unres. References Selecione esta caixa de seleção para ignorar arquivos
de referência não solucionados em arquivos DGN.

Se esta caixa de seleção estiver desmarcada, o leitor de arquivos tenta converter
todos os arquivos de referência e lhe apresenta uma caixa de diálogo para
encontrar quaisquer arquivos de referência não solucionados no momento de
execução.

Use Level Symbology Selecione esta caixa de seleção para ativar a simbologia
do MicroStation. Isso faz com que os itens no Autodesk Navisworks assumam
sua cor do nível em vez de utilizar a cor padrão de elemento no MicroStation.

Align Global Origins Indica se o Autodesk Navisworks alinha as origens
globais em arquivos DGN referenciados com a origem do arquivo DGN mestre.

Quando os arquivos DGN são anexados juntos com esta caixa de seleção, suas
origens globais são posicionadas no mesmo lugar.

Use Materials Indica se os materiais do MicroStation são exportados e
atribuídos aos elementos.

Selecione esta caixa de seleção para atribuir as mesmas texturas difusa, ambiente
e core de espectro para os elementos como na cena do MicroStation.

Desmarque esta caixa de seleção para atribuir as mesmas cores aos elementos
na cena do MicroStation.

Material Search Paths Insira uma lista de caminhos separados por ponto e
vírgula para a paleta do MicroStation (.pal) e arquivos de materiais (.mat).
Esses caminhos são utilizados pelo leitor de arquivos para converter materiais
do MicroStation.

Convert PDS Data Selecione esta caixa de seleção para ler informações do
objeto do Plant Design System™ da Intergraph ao converter os arquivos DGN.

A informação PDS é lida do arquivos DRV do Intergraph. O leitor de arquivos
procura por um arquivo DRV com o mesmo nome base que o arquivo DGN
no mesmo diretório.
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Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os dados PDS.

Convert TriCAD Data Selecione esta caixa de seleção para ler informações do
objeto do TriCAD™ da Triplan ao converter arquivos DGN.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os dados TriCAD.

Convert TriForma Data Selecione esta caixa de verificação para ler a
informação sobre o objeto do Bentley’s TriForma™, enquanto converte os
arquivos DGN.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os dados TriForma.

TriForma Dataset Search Paths Insira uma lista de caminhos separados por
ponto e vírgula que o leitor de arquivos utiliza para localizar arquivos de
conjunto de dados Triforma. É preciso incluir os caminhos para os conjuntos
de dados definidos pelo usuário.

View Number Insira o valor requerido para selecionar uma vista específica
para ser carregada. O leitor de arquivos utiliza a visibilidade do nível desta
vista ao converter itens.

Por exemplo, insira 0 para utilizar a primeira vista ativa.

Consulte também:

Leitor de arquivos DGN  na página 193

Página DWF

Utilize esta página para ajustar as opções para o leitor de arquivos DWF.

Fator de facetamento em modelos 3D Insira o valor requerido para controlar
o nível de criar facetas que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores para facetar maiores resultam em mais polígonos para um modelo
e arquivos maiores do Autodesk Navisworks.

Desvio máximo de facetas em modelos 3D (m) Esta configuração controla
a maior distância entre a aresta de uma faceta e a geometria real.
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Se esta distância for maior do que o valor de Desvio máximo de facetas
em modelos 3D (m), o Autodesk Navisworks adiciona mais facetas.

Se o Desvio máximo de facetas em modelos 3D (m) for definido como
0, então esta função é ignorada.

Extrair texturas em modelos 3D Selecione esta caixa de seleção para extrair
mapas de textura e ambiente associados com o arquivo.

OBSERVAÇÃO Os mapas de ambiente não são definidos na cena por padrão e
precisam ser configurados manualmente no Presenter.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
mapas e texturas.

Consulte também:

Leitor de arquivos DWG  na página 192

Página DWG/DXF

Utilize esta página para ajustar as opções para o leitor de arquivos DWG/DXF.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores para facetar maiores resultam em mais polígonos para um modelo
e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Split by Color Os objetos compostos podem ser divididos em partes com base
em suas cores. Selecione esta caixa de seleção se desejar utilizar esta
funcionalidade.

Por exemplo, um objeto de janela do Architectural Desktop pode ser dividido
em uma moldura e um painel. Se esta caixa de seleção estiver desmarcada,
você somente pode selecionar o objeto de janela como um todo, mas se
selecionar esta caixa de seleção, poderá selecionar o painel e a moldura
individualmente.
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OBSERVAÇÃO  O Autodesk Navisworks nomeia as partes de objetos compostos
com base em sua cores.

Default Decimal Units Selecione os tipos de unidades que o Autodesk
Navisworks utiliza para abrir arquivos DWG e DXF que foram criados com
unidades de desenho decimais.

OBSERVAÇÃO Os arquivos DWG e DXF não especificam as unidades nas quais
forma criados. Para ajustar as unidades no Autodesk Navisworks, utilize a opção
Units and Transform (Unidades e transformação).

Merge 3D Faces Indica se o leitor de arquivos interpreta faces adjuntas com
a mesma cor, camada e principal, como um item único na Selection Tree.

Desmarque esta caixa de seleção para manter as entidades como itens separados
na Selection Tree.

Line Processing Especifica como o leitor de arquivos processa linha e
polilinhas. Selecione uma das seguintes opções:
■ Merge Lines by Color. Esta opção mescla quaisquer linhas na mesma

camada ou na mesma entidade proxy que coincidam por cor. Use esta
opção quando quiser um processamento de arquivos e navegação mais
eficientes.

■ As Provided. Esta opção lê as linhas e polilinhas da mesma forma que
foram especificadas pelo DWG original.

■ Separate All Lines. Esta opção divide elementos de linha em nós
separados para cada segmento da linha.

Use esta opção quando precisar aprimorar análises de detecção de
interferências. Por padrão, o Clash Detective trata entidades com
múltiplos segmentos como um único objeto, reportando uma interferência
para cada par de objetos. Desagrupar objetos de polilinha significa que
cada segmento de linha pode interferir independente de outros segmentos
da linha. Como resultado, todas as interferências em potencial são
reportadas, e não somente a primeira a ser encontrada.

IMPORTANTE Para que esta função funcione de acordo, é preciso definir o
menu suspenso Model ➤ Performance ➤ Collapse on Convert como
None; caso contrário, os objetos de polilinha serão retraídos em um único nó
de geometria.

Convert Off Selecione esta caixa de seleção para converter camadas que são
ativadas e desativadas em arquivos DWG e DXF. Elas são automaticamente
marcadas como ocultas pelo Autodesk Navisworks.
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Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
camadas desativadas.

Convert Frozen Selecione esta caixa de seleção para converter camadas que
estão congeladas em arquivos DWG e DXF. Elas são automaticamente marcadas
como ocultas pelo Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
camadas congeladas.

Convert Entity Handles Selecione esta caixa de seleção se deseja converter
manipuladores de entidade e anexá-los às propriedades do objeto no Autodesk
Navisworks.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
manipuladores de entidade.

Convert Groups Selecione esta caixa de seleção para reter grupos em arquivos
DWG e DXF; isto adiciona outro nível de seleção na Selection Tree.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
grupos.

Convert XRefs Selecione esta caixa de seleção para converter automaticamente
arquivos de referência externa contidos no arquivo DWG.

Desmarque esta caixa de seleção se não desejar anexar arquivos no Autodesk
Navisworks mais tarde você mesmo.

Merge XRef Layers Selecione esta caixa de seleção para mesclar camadas em
arquivos de referência externa com camadas no arquivo DWG principal na
Selection Tree.

Desmarque esta caixa de seleção para manter os arquivos de referência externa
separados do arquivo DWG principal na Selection Tree.

Convert Views Selecione esta caixa de seleção se deseja converter vistas
nomeadas para pontos de vista do Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
vistas.

Convert Points Selecione esta caixa de seleção para converter pontos em
arquivos DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
pontos.

Convert Lines Selecione esta caixa de seleção para converter linhas e arcos
em arquivos DWG e DXF.
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Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
linhas.

Convert Snap Points Selecione esta caixa de seleção para converter pontos
de snap em arquivos DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos pontos
de snap.

Convert Text Selecione esta caixa de seleção para converter texto em arquivos
DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
texto.

Default Font Indica qual fonte a ser usada para o texto convertido.

Convert Point Clouds Selecione esta caixa de seleção para converter as
entidades Point Cloud do AutoCAD. Isso se aplica ao AutoCAD e ao Autodesk
Navisworks Autodesk Navisworks ou versões posteriores. Versões anteriores
irão ignorar as nuvens de ponto ou exibir gráficos de proxy (geralmente como
uma caixa de estrutura de arame).

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
as nuvens de ponto.

Point Cloud Detail Especifica quanto de detalhe extrair da nuvem de ponto.
As entradas válidas estão entre 1 e 100, onde 100 = todos os pontos, 10 = cerca
de 10% dos pontos, 1 = cerca de 1% dos pontos.

Use Point Cloud Colors Controla as cores da nuvem de ponto. Selecione esta
caixa de seleção para usar valores de cor para os pontos na nuvem de ponto.

Quando esta caixa de seleção estiver desmarcada, qualquer valor de cor para
os pontos na nuvem de ponto será ignorado e a cor normal do AutoCAD para
a entidade será usada. Esta opção é útil se as cores específicas são armazenadas
como muito escuras ou sem utilidade.

DWG Loader Version Especifica qual versão do ObjectDBX deve ser utilizada
ao carregar arquivos do AutoCAD. Esta opção permite selecionar o suporte
para a versão correta dos manipuladores de objeto que podem ser utilizados
dentro do arquivo.

OBSERVAÇÃO Quando você modifica esta configuração, reinicie o Autodesk
Navisworks para aplicar as alterações. Isso acontece porque quando qualquer
determinada versão do ObjectDBX é carregada durante a leitura do arquivo DWG
ou DXF, a versão em uso não muda até que o programa seja reiniciado.

Load Material Definitions Selecione esta caixa de seleção para extrair
definições de materiais de arquivos DWG.
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Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
definições de materiais.

Use ADT Standard Configuration Selecione esta caixa de seleção para
converter geometria e materiais em arquivos DWG utilizando a configuração
de exibição padrão.

Desmarque esta caixa de seleção para converter geometria e materiais de acordo
se estão exibidos na configuração de exibição no momento salva.

Convert Hidden ADT Spaces Indica se os objetos de espaço que não têm
qualquer geometria 3D visível em arquivos DWF são convertidos (por exemplo,
objetos que não têm espessura de piso ou forro).

Quando esta caixa de seleção for ativada, os objetos ocultos correspondentes
serão exibidos no Autodesk Navisworks.

OBSERVAÇÃO Esta opção não afeta o comportamento normal dos objetos de
espaço que tenham geometria 3D visível em arquivos DWG.

Material Search Paths  O Autodesk Navisworks automaticamente pesquisa
pelos caminhos padrão de material da Autodesk.

Utilize esta caixa para especificar quaisquer caminhos adicionais para arquivos
de textura utilizados em materiais do Autodesk Architectural Desktop. Separe
os caminhos com ponto e vírgula.

Render Type Especifica o estilo de renderização utilizado para objetos ao
carregar arquivos DWG.

A seleção da opção Automatic significa que o Autodesk Navisworks utiliza
o estilo de renderização salvo nos arquivos DWG.

Se a geometria não for corretamente exibida, ajuste o estilo de renderização
com uma das seguintes opções: Rendered, Shaded ou Wireframe.

Botões

Defaults Restaura os valores padrão.

Advanced Abre a caixa de diálogo Convert Object Properties na página 788
onde é possível selecionar aplicativos de terceiros dos quais ler informações
de objetos.

Consulte também:

Leitor de arquivos DWG/DXF  na página 188
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Página Faro

Utilize esta página para ajustar as opções para o leitor de arquivos Faro Scan.

Point Colors Especifica como os pontos são extraídos do arquivo de entrada.

Selecione entre as seguintes opções:

■ None - os pontos vêm em branco.

■ Intensity - os pontos utilizam os valores de intensidade armazenados no
arquivo.

■ Color - os pontos utilizam os valores de cores armazenados no arquivo.

OBSERVAÇÃO Se a opção disponível não estiver disponível, então o leitor de
arquivos padroniza para os valores utilizados no arquivo. Por exemplo, se você
definir Point Colors como Color, mas somente intensidades estão disponíveis
no arquivo, então o leitor de arquivos utiliza as intensidades.

Consulte também:

Leitor de arquivos Faro Scan  na página 194

Página FBX

Utilize esta página para ajustar as opções para o leitor de arquivos FBX.

Convert Autodesk Materials  Os arquivos FBX podem conter materiais da
Autodesk ou nativos. Selecione esta caixa de seleção para converter os materiais
da Autodesk. O exportador tentará converter os materiais da Autodesk, se
estiverem disponíveis. Desmarque esta caixa de seleção se deseja converter
materiais FBX nativos em materiais do Presenter.

OBSERVAÇÃO Os materiais do Presenter somente estão disponíveis quando for
utilizado o sistema de gráficos do Presenter, e os materiais da Autodesk (também
denominados materiais consistentes) somente estão disponíveis quando for utilizado
o sistema de gráficos da Autodesk. Consulte Graphics System na página 168.

Convert Lights Selecione esta caixa de seleção para converter as luzes.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
as luzes.

Convert Skeletons Selecione esta caixa de seleção para converter os esqueletos.
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Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os esqueletos.

DICA Uma técnica comum para a animação de um modelo 3D consiste na criação
de uma estrutura articulada hierárquica, esqueleto nomeado, cuja deformação
deriva da deformação do modelo associado. A localização e o deslocamento das
juntas do esqueleto ditam como o modelo se move.

Convert Textures Selecione esta caixa de seleção para converter as texturas.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
as texturas.

Faceting Factor  Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Consulte também:

Leitor de arquivos FBX  na página 194

Página IFC

Utilize esta página para ajustar as opções para o leitor de arquivos IFC.

Convert Bounding Boxes Selecione esta caixa de seleção para trazer e visualizar
as caixas de delimitação.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
caixas de delimitação.

Convert Spaces Selecione esta caixa de seleção para trazer e visualizar espaços.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
espaços.
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Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Quando você dobra o valor, irá obter
o dobro do número de facetas. Quando você divide o valor por dois, irá obter
metade das facetas. Fatores para facetar maiores resultam em mais polígonos
para um modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Representation Detail Especifica o nível da representação visual de elementos
IFC.

Os elementos IFC podem ter múltiplas representações visuais, como caixas de
delimitação (mais simples), linhas, linhas com estilos, polígonos e polígonos
com estilo (mais complexo). Carregar e exibir todas essas representações pode
levar a visuais entupidos e sobrecarga de memória.

Selecione entre as seguintes opções:

■ Highest Only - para carregar e exibir o nível mais complexo de detalhe
disponível ao ignorar níveis mais simples.

■ Show Highest - para carregar todas as representações, mas somente exibir
o maior nível de detalhe disponível.

■ Show All - para carregar e exibir tudo o disponível.

Show Spatial Hierarchy Selecione esta caixa de seleção para exibir modelos
IFC como uma estrutura de árvore na Selection Tree.

Desmarque esta caixa de seleção para exibir o modelo IFC com uma lista
simples de elementos na Selection Tree.

Use Property-Based Colors Selecione esta caixa de seleção para converter e
utilizar cores com base na propriedade.

DICA Se um arquivo IFC for predominantemente preto ao ser carregado,
desmarque esta caixa de seleção para reverter para a utilização de cores padrão
IFC.

Consulte também:

Leitor de arquivos IFC  na página 195
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Página Inventor

Utilize esta página para ajustar as opções para o leitor de arquivos Inventor.

Active Project Especifica o caminho do projeto atual do Inventor.

Convert Work Surfaces Selecione esta caixa de seleção para converter
superfícies de trabalho. Quando esta caixa de seleção estiver desmarcada, o
leitor de arquivos ignora as superfícies de trabalho. Esta é a opção padrão.

Load assembly with last active representation (Carregar montagem com
a última representação ativa) Selecione esta caixa de seleção para carregar a
montagem do Inventor com a última representação ativa. Quando esta caixa
de seleção está desmarcada, os arquivos do Inventor são abertos como no
Autodesk Navisworks 2011.

Consulte também:

Leitor de arquivos do Inventor  na página 196

Página Leica

Utilize esta página para ajustar as opções para o leitor de arquivos Leica Scan.

Sample Rate Especifica a frequência de pontos extraídos do arquivo de entrada.

Aumentar a taxa de amostra reduz o número de pontos extraídos. Como
resultado, a resolução da imagem será reduzida e o arquivo é convertido mais
rápido.

Point Colors Especifica como os pontos são extraídos do arquivo de entrada.

Selecione entre as seguintes opções:

■ None - os pontos vêm em branco.

■ Raw Intensity - os pontos utilizam os valores de intensidade armazenados
no arquivo.

■ Color - os pontos utilizam os valores de cores armazenados no arquivo.

■ Color-Mapped Intensity - os pontos utilizam o espectro de cores RGB.

■ Gamma Correction Intensity - os pontos utilizam valores de
intensidade bruta com correção de gama armazenados no arquivo.
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Gamma Correction Level Especifica um valor de correção de gama utilizado
para ajustar os valores de intensidade de ponto normalizado obtidos do arquivo,
e resulta em imagens mais calaras ou mais escuras dependendo da configuração.

O valor de correção de gama na faixa entre 0.1 e 0.99 ajusta a espessura dos
valores de intensidade para a parte inferior da faixa de intensidade e, portanto,
a imagem aparece mais clara.

Um nível de correção de gama acima de 0.1 tem o efeito de escurecer a imagem.

OBSERVAÇÃO Uma correção de gama de 1 significa nenhuma alteração.

Consulte também:

Leitor de arquivos Leica Scan  na página 198

Página JTOpen

Utilize esta página para ajustar as opções para o leitor de arquivos JTOpen.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Retriangulate JT Brep Models Selecione esta caixa de seleção para utilizar
entidades BREP para criar a geometria.

Desmarque esta caixa de seleção para utilizar estripas triplas para criar a
geometria.

Consulte também:

Leitor de arquivos JTOpen  na página 196

Caixa de diálogo Options Editor | 853



Página MAN

Utilize esta página para ajustar as opções para o leitor de arquivos MAN.

Include Line-Geometry Selecione esta caixa de seleção para converter
primitivos de linha MicroGDS.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
geometria de linha.

Set Facet Circle Especifica o número de facetas para arcos.

Insira o número de segmentos de linha reata requeridos para facetar todo um
círculo. Esta opção corresponde a preferência Set Facet  do MicroGDS.

Texture Path Especifica o caminho para a pasta que contém imagens utilizadas
em materiais do MicroGDS. Este caminho é utilizado como a base para
caminhos relativos para materiais que utilizam arquivos de imagens.

Esta opções corresponde a preferência Renderer Textures do MicroGDS.

Define Presenter Materials Selecione esta caixa de seleção para definir estilos
de materiais do MicroGDS como materiais do Presenter no Autodesk
Navisworks.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
estilos de materiais do MicroGDS.

Consulte também:

Leitor de arquivos MAN  na página 198

Página Parasolid

Utilize esta página para ajustar as opções para o leitor de arquivos Parasolid.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real. Se esta distância for maior do que o
valor de Max Facet Deviation, o Autodesk Navisworks adiciona mais facetas.
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Se o Desvio máximo da faceta for definido como 0, então esta função é
ignorada.

Scale O fator de escala a ser aplicado ao modelo. O fator de escala precisa ser
maior ou igual a 0, onde 0 resulta na desativação do fator de escala.

Default Units Especifica o tipo de unidades que o Autodesk Navisworks usa
ao abrir arquivos Parasolid.

DICA Se o tipo de unidade escolhido for errôneo, você pode redimensionar o
modelo ao utilizar a opção Units and Transform. (Clique com o botão direito
do mouse na Scene View e clique em Units and Transform no menu de
atalho.)

Consulte também:

Leitor de arquivos Parasolid  na página 200

Página PDS

Utilize esta página para ajustar as opções para o leitor de arquivos PDS.

Load Tags Selecione esta caixa de seleção se você deseja que o Autodesk
Navisworks leia arquivos TAG associados com o arquivo DRI.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os arquivos de identificadores.

Load Display Sets Selecione esta caixa de seleção se você deseja que o Autodesk
Navisworks leia arquivos Display Set DST associados com o arquivo DRI.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os arquivos Display Set DST.

Input Files Seleciona o tipo de arquivo de entrada.

Selecione entre as seguintes opções:

■ DGN Files - para converter os arquivos DGN originais.

■ NWC Files - para abrir versões de cache NWC dos arquivos.

Este opção é útil quando você rotineiramente executa uma conversão em
lote dos arquivos DGN para arquivos NWC, e gostaria de abrir os arquivos
NWC ao ler um arquivo DRI.

Consulte também:

Leitor de arquivos PDS  na página 200
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Página Riegl

Utilize esta página para ajustar as opções para o leitor de arquivos Riegl Scan.

Use Point Color Values Selecione a caixa de seleção para extrair valores de
cores do arquivo de entrada.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os valores de cores.

Use Point Intensity Values Selecione esta caixa de seleção para extrair os
valores de intensidade do arquivo de entrada.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os valores de intensidade.

Triangulate Point Data Selecione esta caixa de seleção para extrair triângulos
do arquivo de entrada.

A seleção desta caixa de seleção diminui a velocidade da conversão do arquivo.

Apply Scanner Transformation Selecione esta caixa de seleção para exibir a
imagem em coordenadas locais relativas ao scanner.

Desmarque esta caixa de seleção para exibir a imagem em coordenadas globais.
Utilize esta opção quando o arquivo contém mais de um quadro.

Consulte também:

Leitor de arquivos Riegl  na página 201

Página RVM

Utilize esta página para ajustar as opções para o leitor de arquivos RVM.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Quando você dobra o valor, irá obter
o dobro do número de facetas. Quando você divide o valor por dois, irá obter
metade das facetas. Fatores para facetar maiores resultam em mais polígonos
para um modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.
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Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Convert Attributes Selecione esta caixa de seleção para converter atributos
de arquivos. Todos os arquivos localizados pelo leitor de arquivos são
considerados na mesma ordem em que forma encontrados. Os atributos são
coincididos com os elementos na cena pelo nome. Quaisquer atributos que
não foram encontrados são contados e o número é reportado nas estatísticas
da cena.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os atributos dos arquivos.

Search All Attribute Files Controla a forma pela qual o leitor de arquivos
localiza atributos de arquivos. As extensões do arquivo são especificadas na
caixa Attribute File Extensions.

Quando esta caixa de seleção estiver desmarcada (a opção padrão), o leitor de
arquivos verifica o diretório onde o arquivo RVM está localizado para procurar
por um arquivo de atributos com o mesmo nome. Se ele não puder encontrar
um arquivo de atributos, então ele procura em um subdiretório com o mesmo
nome do arquivo RVM por todos os arquivos com as extensões de arquivo
especificadas.

Quando esta caixa de seleção estiver selecionada, o leitor de arquivos utiliza
o método de pesquisa padrão. Se ele não puder encontrar qualquer arquivo
de atributos, então ele retorna para o diretório onde o leitor RVM está
localizado, e procura por todos os arquivos com as extensões de arquivo
especificadas.

Attribute File Extensions Especifica as extensões de arquivo que o leitor de
arquivos utiliza para reconhecer arquivos de atributos. As extensões padrão
são *.ATT, *.ATTRIB e *.TXT. Separe os valores na lista com ponto e vírgula.

Generate Texture Coordinates Selecione esta caixa de seleção para criar
coordenadas de textura para cada ponto no modelo.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
as coordenadas de textura.

Keep Empty Groups Selecione esta caixa de seleção para converter grupos
que não contenham geometria. Utilize esta opção, por exemplo, quando estes
grupos contêm atributos.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
grupos vazios. Esta é a opção padrão.
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Load RVS File Selecione esta caixa de seleção para ler um arquivo RVS ao
mesmo tempo do arquivo RVM correspondente. Esta é a opção padrão.

OBSERVAÇÃO Para funcionar corretamente, o arquivo RVS precisa ter o mesmo
nome e caminho do arquivo RVM associado, mas com uma extensão .rvs.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
os arquivos RVS.

RVS Transparencies as Materials Selecione esta caixa de seleção para anexar
materiais transparentes aos objetos. Por exemplo, utilize esta opção quando
objetos grandes na cena são permanentemente transparentes e você os deseja
converter como estão.

Quando esta caixa de seleção estiver desmarcada (a opção padrão), o leitor de
arquivos ignora as configurações de transparência RVS. Por exemplo, utilize
esta opção quando você deseja sobrepor as configurações de transparência no
arquivo RVS.

OBSERVAÇÃO Você também pode sobrepor a transparência do objeto diretamente
no Autodesk Navisworks. (Clique na guia Item Tools ➤ painel
Appearance ➤ controle deslizante Transparency.)

Convert Origins Selecione esta caixa de seleção para converter os pontos de
origem do componente em pontos snap no Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, os pontos de origem são
descartados.

Convert Zero-Thickness Solids Selecione esta caixa de seleção para converter
sólidos 3D com uma espessura zero em geometria 2D.

Quando esta caixa de seleção estiver desmarcada, os sólidos 3D com uma
espessura zero são descartados.

Consulte também:

Leitor de arquivos RVM  na página 201

Página SAT

Utilize esta página para ajustar as opções para o leitor de arquivos SAT.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
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facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real. Se esta distância for maior do que o
valor de Max Facet Deviation, o Autodesk Navisworks adiciona mais facetas.

Se o Desvio máximo da faceta for definido como 0, então esta função é
ignorada.

Default Units Especifica o tipo de unidade que o Autodesk Navisworks usa
ao abrir arquivos SAT.

DICA Se o tipo de unidade escolhido for errôneo, você pode redimensionar o
modelo ao utilizar a opção Units and Transform. (Clique com o botão direito
na Scene View e clique em Units and Transform no menu de atalho.)

Consulte também:

Leitor de arquivos SAT  na página 202

Página SKP

Utilize esta página para ajustar as opções do leitor de arquivo SketchUp SKP.

Convert Hidden Items Selecione esta caixa de seleção para converter entidade
ocultas em arquivos SKP. Elas são automaticamente marcadas como ocultas
pelo Autodesk Navisworks.

Quando esta caixa de verificação estiver desmarcada, o leitor de arquivos ignora
os itens ocultos.

Merge Faces Indica se o leitor de arquivos interpreta faces adjuntas com a
mesma cor, camada e principal, como um item único na Selection Tree.

Desmarque esta caixa de seleção para manter as faces como itens separados
na Selection Tree.

Merge Lines Indica se o leitor de arquivos interpreta linhas adjuntas com a
mesma cor, camada e principal, como um item único na Selection Tree.

Desmarque esta caixa de seleção para manter as linhas como itens separados
na Selection Tree.

Consulte também:

Leitor de arquivos do SketchUp SKP  na página 202
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Página STL

Utilize esta página para ajustar as opções para o leitor de arquivos STL.

Default Units Especifica o tipo de unidades que o Autodesk Navisworks usa
ao abrir arquivos STL.

DICA Se o tipo de unidade escolhido for errôneo, você pode redimensionar o
modelo ao utilizar a opção Units and Transform. (Clique com o botão direito
do mouse na Scene View e clique em Units and Transform no menu de
atalho.)

Override Normals Os normais controlam como os objetos aparecem quando
acesos. Por padrão, esta caixa de seleção está desmarcada, e o leitor de arquivos
utiliza os dados fornecidos no arquivo STL, fornecendo os resultados visíveis
mais precisos.

Selecione esta caixa de seleção caso deseje que o Autodesk Navisworks ignore
os normais, e gere dados de iluminação, por exemplo, quando o modelo
fornecido contém dados inválidos de iluminação.

OBSERVAÇÃO A utilização desta opção é menos precisa que a utilização dos
dados de iluminação real em arquivos STL.

Consulte também:

Leitor de arquivos STL  na página 203

Página VRML

Utilize esta página para ajustar as opções para o leitor de arquivos VRML.

Default Units Especifica o tipo de unidades que o Autodesk Navisworks utiliza
ao abrir arquivos VRML.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Quando você dobra o valor, irá obter
o dobro do número de facetas. Quando você divide o valor por dois, irá obter
metade das facetas. Fatores para facetar maiores resultam em mais polígonos
para um modelo e arquivos maiores do Autodesk Navisworks.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.
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Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Override Normals Os normais controlam como os objetos aparecem quando
acesos. Por padrão, esta caixa de seleção está desmarcada, e o leitor de arquivos
utiliza os dados fornecidos no arquivo VRML, fornecendo os resultados visíveis
mais precisos.

Selecione esta caixa de seleção caso deseje que o Autodesk Navisworks ignore
os normais, e gere dados de iluminação, por exemplo, quando o modelo
fornecido contém dados inválidos de iluminação.

OBSERVAÇÃO A utilização desta opção é menor precisa do que utilizar os dados
de iluminação real nos arquivos VRML.

Override Orientation Por padrão, esta caixa de seleção está desmarcada, e o
leitor de arquivos processa as informações da geometria na ordem indicada
nos arquivos VRML, que pode ser no sentido horário e no sentido anti-horário.

Quando esta caixa de seleção está selecionada, o leitor de arquivos ignora a
ordem nos arquivos VRML, e processa as informações da geometria no sentido
anti-horário. Esta opção é útil se o seu modelo, quando visualizado no Autodesk
Navisworks, tem furos ou áreas pretas.

Override Switch Statements Por padrão, esta caixa de seleção está desmarcada.
Isto significa que o leitor de arquivos utiliza o comportamento padrão das
declarações de chave nos arquivos VRML.

Para declarações de chave que são utilizadas no script VRML, a geometria
relacionada somente é convertida se a chave correspondente estiver ativada.
Como resultado, você pode obter um modelo quase vazio no Autodesk
Navisworks.

Quando esta caixa de seleção estiver selecionada, o leitor de arquivos processa
todas as declarações de chave e traz geometria extra.

OBSERVAÇÃO Overriding Switch Statements pode resultar, por exemplo,
na criação de geometria duplicada, se a declaração de chave contém diversas
formas para representar o mesmo objeto.

Consulte também:

Leitor de arquivos VRML  na página 204
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Página Z + F

Utilize esta página para ajustar as opções para o leitor de arquivos Z+F Scan.

Sample Rate Especifica a frequência de pontos extraídos do arquivo de entrada.

Aumentar a taxa de amostra reduz o número de pontos extraídos. Como
resultado, a resolução da imagem será reduzida e o arquivo é convertido mais
rápido.

Remove Spurious Points Selecione esta caixa de seleção para ignorar pontos
espúrios do arquivo de entrada.

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos pontos
espúrios.

Point Intensity Especifica como os pontos são extraídos do arquivo de entrada.

Selecione entre as seguintes opções:

■ None - os pontos vêm em branco.

■ Raw Intensity - os pontos utilizam os valores de intensidade armazenados
no arquivo.

■ Color-Mapped Intensity - os pontos utilizam o espectro de cores RGB.

■ Gamma Correction Intensity - os pontos utilizam valores de
intensidade bruta com correção de gama armazenados no arquivo.

Gamma Correction Level Especifica um valor de correção de gama utilizado
para ajustar os valores de intensidade de ponto normalizado obtidos do arquivo,
e resulta em imagens mais calaras ou mais escuras dependendo da configuração.

O valor de correção de gama na faixa entre 0.1 e 0.99 ajusta a espessura dos
valores de intensidade para a parte inferior da faixa de intensidade e, portanto,
a imagem aparece mais clara.

Um nível de correção de gama acima de 0.1 tem o efeito de escurecer a imagem.

OBSERVAÇÃO Uma correção de gama de 1 significa nenhuma alteração.

Consulte também:

Leitor de arquivos Z+F Scan  na página 205
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Nó File Exporters

Utilize as configurações neste nó para configurar os exportadores de arquivos
necessários para exportar arquivos nativos do Autodesk Navisworks diretamente
para aplicativos de CAD.

DICA Caso deseje restaurar os valores padrão clique no botão Defaults.

Página DWG

Utilize esta página para ajustar as opções para o exportador de arquivos DWG.

Convert Entity Handles Selecione esta caixa de seleção se você deseja converter
manipuladores de entidades e anexá-los às propriedades dos objetos no
Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportado de arquivos
ignora manipuladores de entidade.

Convert Frozen Selecione esta caixa de seleção para converter camadas que
estão congeladas em arquivos DWG e DXF. Elas são marcadas como ocultas
automaticamente pelo Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora camadas congeladas.

Convert Groups Selecione esta caixa de seleção para reter grupos em arquivos
DWG e DXF; isto adiciona outro nível de seleção na Selection Tree.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora grupos.

Convert Hidden ADT Spaces Indica se os objetos de espaço que não têm
qualquer geometria 3D visível em arquivos DWF são convertidos (por exemplo,
objetos que não têm espessura de piso ou forro).

Quando esta caixa de seleção for ativada, os objetos ocultos correspondentes
serão exibidos no Autodesk Navisworks.

OBSERVAÇÃO Esta opção não afeta o comportamento normal dos objetos de
espaço que tenham geometria 3D visível em arquivos DWG.

Convert Lines Selecione esta caixa de seleção para converter linhas e arcos
em arquivos DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora linhas.
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Convert Off Selecione esta caixa de seleção para converter camadas que são
ativadas e desativadas em arquivos DWG e DXF. Elas são marcadas como
ocultas automaticamente pelo Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora camadas desativadas.

Convert Points Selecione esta caixa de seleção para converter pontos em
arquivos DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora pontos.

Convert Snap Points Selecione esta caixa de seleção para converter pontos
de snap em arquivos DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
pontos de snap.

Convert Text Selecione esta caixa de seleção para converter texto em arquivos
DWG e DXF.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora texto.

Convert Views Selecione esta caixa de seleção para converter vistas nomeadas
em pontos de vista do Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora vistas.

Convert XRefs Selecione esta caixa de seleção para converter automaticamente
arquivos de referência externa contidos no arquivo DWG.

Desmarque esta caixa de seleção se você deseja anexar arquivos no Autodesk
Navisworks mais tarde.

Default Decimal Units Seleciona os tipos de unidades que o Autodesk
Navisworks utiliza para abrir arquivos DWG e DXF que foram criados com
unidades de desenho decimais.

OBSERVAÇÃO Os arquivos DWG e DXF não especificam as unidades nas quais
forma criados. Para ajustar as unidades no Autodesk Navisworks, utilize a opção
Units and Transform (Unidades e transformação).

Default Font Especifica a fonte padrão utilizada para texto convertido no
Autodesk Navisworks.

Convert Point Clouds Selecione esta caixa de seleção para converter as
entidades Point Cloud do AutoCAD. Isso se aplica ao AutoCAD e ao Autodesk
Navisworks Autodesk Navisworks ou versões posteriores. Versões anteriores
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irão ignorar as nuvens de ponto ou exibir gráficos de proxy (geralmente como
uma caixa de estrutura de arame).

Quando esta caixa de seleção estiver desmarcada, o leitor de arquivos ignora
as nuvens de ponto.

Point Cloud Detail Especifica quanto de detalhe extrair da nuvem de ponto.
As entradas válidas estão entre 1 e 100, onde 100 = todos os pontos, 10 = cerca
de 10% dos pontos, 1 = cerca de 1% dos pontos.

Use Point Cloud Colors Controla as cores da nuvem de ponto. Selecione esta
caixa de seleção para usar valores de cor para os pontos na nuvem de ponto.

Quando esta caixa de seleção estiver desmarcada, qualquer valor de cor para
os pontos na nuvem de ponto será ignorado e a cor normal do AutoCAD para
a entidade será usada. Esta opção é útil se as cores específicas são armazenadas
como muito escuras ou sem utilidade.

DWG Loader Version Especifica qual versão do ObjectDBX deve ser utilizada
ao carregar arquivos do AutoCAD.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores maiores para facetar resultam em mais polígonos para um modelo
e em arquivos maiores do Autodesk Navisworks.

Load Material Definitions Selecione esta caixa de seleção para extrair
definições de materiais de arquivos DWG.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora definições de materiais.

Material Search Paths  O Autodesk Navisworks busca automaticamente os
caminhos padrão de materiais da Autodesk.

Utilize esta caixa para especificar quaisquer caminhos adicionais para arquivos
de textura utilizados em materiais do Autodesk Architectural Desktop. Separe
os caminhos com ponto e vírgula.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.
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Merge 3D Faces Indica se o exportador de arquivos interpreta faces adjuntas
com a mesma cor, camada e principal, como um item único na Selection
Tree.

Desmarque esta caixa de seleção para manter as entidades como itens separados
na Selection Tree.

Line Processing Especifica como o leitor de arquivos processa linha e
polilinhas. Selecione uma das seguintes opções:
■ Merge Lines by Color. Esta opção mescla quaisquer linhas na mesma

camada ou na mesma entidade proxy que coincidam por cor. Use esta
opção quando quiser um processamento de arquivos e navegação mais
eficientes.

■ As Provided. Esta opção lê as linhas e polilinhas da mesma forma que
foram especificadas pelo DWG original.

■ Separate All Lines. Esta opção divide elementos de linha em nós
separados para cada segmento da linha.

Use esta opção quando precisar aprimorar análises de detecção de
interferências. Por padrão, o Clash Detective trata entidades com
múltiplos segmentos como um único objeto, reportando uma interferência
para cada par de objetos. Desagrupar objetos de polilinha significa que
cada segmento de linha pode interferir independente de outros segmentos
da linha. Como resultado, todas as interferências em potencial são
reportadas, e não somente a primeira a ser encontrada.

IMPORTANTE Para que esta função funcione de acordo, é preciso definir o
menu suspenso Model ➤ Performance ➤ Collapse on Convert para None,
de outro modo os objetos de polilinha serão retraídos em um único nó de
geometria.

Merge XRef Layers Selecione esta caixa de seleção para mesclar camadas em
arquivos de referência externa com camadas no arquivo DWG principal na
Selection Tree.

Desmarque esta caixa de seleção para manter os arquivos de referência externa
separados do arquivo DWG principal na Selection Tree.

Render Type Especifica o estilo de renderização utilizado para objetos ao
carregar arquivos DWG.

A seleção da opção Automatic significa que o Autodesk Navisworks utiliza
o estilo de renderização salvo nos arquivos DWG.

Se a geometria não for corretamente exibida, ajuste o estilo de renderização
com uma das seguintes opções: Rendered, Shaded ou Wireframe.
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Split by Color Os objetos compostos podem ser divididos em partes com base
em suas cores. Selecione esta caixa de seleção se desejar utilizar esta
funcionalidade.

Por exemplo, um objeto de janela do Architectural Desktop pode ser dividido
em uma moldura e um painel. Se esta caixa de seleção estiver desmarcada,
você somente pode selecionar o objeto de janela como um todo, mas se
selecionar esta caixa de seleção, poderá selecionar o painel e a moldura
individualmente.

OBSERVAÇÃO  O Autodesk Navisworks nomeia peças de objetos compostos com
base em suas cores.

Use ADT Standard Configuration Selecione esta caixa de seleção para
converter geometria e materiais em arquivos DWG utilizando a configuração
de exibição padrão.

Desmarque esta caixa de seleção para converter geometria e materiais de acordo
se estão exibidos na configuração de exibição no momento salva.

Consulte também:

Exportador do arquivo do AutoCAD na página 205

Página Revit

Utilize esta página para ajustar as opções para o exportador de arquivos Revit.

Convert Construction Parts (Converter peças de construção) Ao utilizar a
operação de montagens e modelagem de construções do Revit 2012, você tem
a opção de exportar as peças de construção ou o objeto original para o Autodesk
Navisworks. Selecione esta caixa se você deseja exportar as peças de construção;
desmarque-a se deseja exportar o objeto original.

Convert Element Ids (Converter IDs de elementos) Selecione esta caixa de
seleção para exportar os números de ID para cada elemento do Revit.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora IDs.

Convert Element Parameters (Converter parâmetros de elementos)
Especifica como os parâmetros do Revit são lidos. Selecione entre as seguintes
opções:
■ None - o exportador de arquivos não converte parâmetros.

■ Elements - o exportador de arquivos converte parâmetros para todos os
elementos encontrados.
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■ All - o exportador de arquivos converte parâmetros para todos os elementos
encontrados, incluindo os elementos referenciados. Como resultado, outras
guias de propriedades estão disponíveis no Autodesk Navisworks.

Convert Linked Files (Converter arquivos vinculados) Os projetos do Revit
podem incorporar arquivos externos como links. Quando esta caixa de seleção
estiver selecionada, os arquivos vinculados serão incluídos no arquivo NWC
exportado. Por padrão, esta caixa de seleção está desmarcada.

OBSERVAÇÃO Somente os arquivos RVT vinculados podem ser exportados; o
DWG vinculado e quaisquer outros formatos de arquivos não são suportados.

Convert Room as Attribute (Converter ambiente como atributo) Indica se
os atributos de ambientes são suportados. Por padrão, esta caixa de seleção
fica selecionada e os dados de cada ambiente são convertidos em um atributo
de ambiente compartilhado único.

Convert URLs (Converter URLs) Indica se os dados de propriedades da URL
são convertidos. Por padrão, esta caixa de seleção é ativada e os hiperlinks são
suportados no arquivo convertido.

Coordinates Especifica se serão utilizadas coordenadas internas ou
compartilhadas na agregação de arquivos. Por padrão, as coordenadas
sombreadas serão usadas. As coordenadas compartilhadas podem ser
visualizadas e alteradas fora do Revit. Export Especifica como a geometria é
exportada. Selecione entre as seguintes opções:
■ Entire Project - toda a geometria no projeto é exportada.

■ Current View - tudo que estiver no momento visível é exportado.

■ Selection - somente a geometria no momento selecionada é exportada.

Export Room Geometry (Exportar geometria do ambiente) Indica se a
geometria do ambiente é exportada.

Try and Find Missing Materials (Tentar encontrar materiais em falta)
Quando esta caixa de seleção estiver selecionada (a opção padrão), o exportador
de arquivos procura por uma coincidência para materiais faltando na
exportação.

OBSERVAÇÃO Se quaisquer materiais inapropriados são aplicados na geometria
do modelo como resultado, desmarque esta caixa de seleção para corrigir o
problema.

Units for Area/Volume Properties (Propriedades de unidades por
área/volume) Seleciona o tipo de unidades que o Autodesk Navisworks utiliza
para converter propriedades baseadas em volume e área.
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Consulte também:

Exportador de arquivos Revit na página 214

Página DGN

Utilize esta página para ajustar as opções para o exportador de arquivos 3D
DGN.

Align Global Origins Indica se o Autodesk Navisworks alinha as origens
globais em arquivos DGN referenciados com a origem do arquivo DGN mestre.

Quando os arquivos DGN são anexados juntos com esta caixa de seleção, suas
origens globais são posicionadas no mesmo lugar.

Convert Hidden Items Selecione esta caixa de seleção para converter entidade
ocultas em arquivos DGN. Elas são automaticamente marcadas como ocultas
pelo Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora os itens ocultos.

Convert Lines and Arcs Selecione esta caixa de seleção para converter linhas,
splines, curvas, arcos, círculos ou elipses em arquivos DGN.

Convert PDS Data Selecione esta caixa de seleção para ler informações do
objeto do Plant Design System™ da Intergraph ao converter os arquivos DGN.

A informação PDS é lida do arquivos DRV do Intergraph. O exportador de
arquivos procura por um arquivo DRV com o mesmo nome base do arquivo
DGN no mesmo diretório.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora os dados PDS.

Convert References Selecione esta caixa de seleção para converter arquivos
de referência nos arquivos DGN.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora os arquivos de referência.

Convert Text Selecione esta caixa de seleção para converter texto em
propriedades rápidas no Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora texto nos arquivos DGN.

Convert TriCAD Data Selecione esta caixa de seleção para ler informações do
objeto do TriCAD™ da Triplan ao converter arquivos DGN.
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Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora os dados TriCAD.

Convert TriForma Data Selecione esta caixa de verificação para ler a
informação sobre o objeto do Bentley’s TriForma™, enquanto converte os
arquivos DGN.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora os dados Tri-Forma.

Default Font Especifica a fonte padrão utilizada para texto convertido no
Autodesk Navisworks.

Faceting Factor Insira o valor requerido para controlar o nível de criar facetas
que acontece.

O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação
do fator para facetar. O valor-padrão é 1. Para obter o dobro de número de
facetas, dobre este valor. Para obter a metade das facetas, divida por dois este
valor. Fatores de facetamento maiores resultam em mais polígonos para um
modelo e arquivos maiores do Autodesk Navisworks.

Ignore Unres. References Selecione esta caixa de seleção para ignorar arquivos
de referência não solucionados em arquivos DGN.

Se esta caixa de seleção estiver desmarcada, o exportador de arquivos tenta
converter todos os arquivos de referência e lhe apresenta uma caixa de diálogo
para encontrar quaisquer arquivos de referência não solucionados no momento
de execução.

Material Search Paths Insira uma lista de caminhos separados por ponto e
vírgula para a paleta do MicroStation (.pal) e arquivos de materiais (.mat).
Esses caminhos são utilizados pelo exportador de arquivos para converter
materiais do MicroStation.

Max Facet Deviation Esta configuração controla a maior distância entre a
aresta de uma faceta e a geometria real.

Se esta distância for maior do que o valor de Max Facet Deviation , o
Autodesk Navisworks adicionará mais facetas.

Se o Max Facet Deviation for definido como 0, então esta função é ignorada.

Merge Lines and Arcs Selecione esta caixa de seleção, caso você deseja reduzir
a complexidade do modelo na Selection Tree ao interpretar linhas adjuntas
com a mesma cor, nível e principal como um item único.

Desmarque esta caixa de seleção se desejar deixar esses elementos como itens
separados no Autodesk Navisworks.
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Split Lines Esta opção instrui o leitor de arquivos para desagrupar objetos de
polilinha. Como resultado, os elementos de linha são divididos em nós
separados para cada segmento de linha.

Use esta opção quando precisar aprimorar análises de detecção de interferências.
Por padrão, o Clash Detective trata entidades com múltiplos segmentos
como um único objeto, reportando uma interferência para cada par de objetos.
Desagrupar objetos de polilinha significa que cada segmento de linha pode
interferir independente de outros segmentos da linha. Como resultado, todas
as interferências em potencial são reportadas, e não somente a primeira a ser
encontrada.

IMPORTANTE Para que esta função funcione de acordo, é preciso desmarcar a
caixa de seleção Merge Lines and Arcs , já que ela tem prioridade sobre a opção
Split Lines. Adicionalmente, é preciso definir no menu suspenso
Model ➤ Performance ➤ Collapse on Convert para None, de outro modo
os objetos de polilinha serão retraídos em um único nó de geometria.

Shape Merge Threshold Especifica o número de vértices para as formas do
MicroStation.

Se o número de vértices for menor ou igual ao valor de Shape Merge
Threshold, o Autodesk Navisworks mesclará todas as formas no mesmo nível
ou na mesma célula e com a mesma cor em um "Shape Set".

Show Hidden Items Selecione esta caixa de seleção, se você deseja exibir todas
as entidades nos arquivos DGN convertidos, sem respeitar se são ou não ocultas.

OBSERVAÇÃO Para utilizar esta opção, é preciso selecionar a caixa de seleção
Convert Hidden Items.

TriForma Dataset Search Paths Insira uma lista de caminhos separados por
ponto e vírgula que o leitor de arquivos utiliza para localizar arquivos de
conjunto de dados Triforma. É preciso incluir os caminhos para os conjuntos
de dados definidos pelo usuário.

Use Level Symbology Selecione esta caixa de seleção para ativar a simbologia
do MicroStation. Isso faz com que os itens no Autodesk Navisworks assumam
sua cor do nível em vez de utilizar a cor padrão de elemento no MicroStation.

Use Materials Indica se os materiais do MicroStation são exportados e
atribuídos aos elementos.

Selecione esta caixa de seleção para atribuir as mesmas texturas difusa, ambiente
e core de espectro para os elementos como na cena do MicroStation.

Desmarque esta caixa de seleção para atribuir as mesmas cores aos elementos
na cena do MicroStation.
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View Number Insira o valor requerido para selecionar uma vista específica
para ser carregada. O exportador de arquivos utiliza a visibilidade do nível
desta vista ao converter itens.

Por exemplo, insira 0 para utilizar a primeira vista ativa.

Consulte também:

Exportador do arquivo do MicroStation na página 215

Página Viz/Max

Utilize esta página para ajustar as opções para o exportador de arquivos 3DS.

Convert Hidden Items Selecione esta caixa de seleção para converter entidade
ocultas em arquivos 3DS. Elas são marcadas automaticamente como ocultas
pelo Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora os itens ocultos.

Convert User Properties Selecione esta caixa de seleção para anexar quaisquer
propriedades do usuário que você definiu no Viz ou Max aos itens convertidos
do Autodesk Navisworks.

Quando esta caixa de seleção estiver desmarcada, o exportador de arquivos
ignora as propriedades do usuário.

Pre-Render Scene Por padrão, esta caixa de seleção está desmarcada.

Selecione esta caixa de seleção se faltam no exportador de arquivos alguns
mapas de textura. Isto força que Viz/Max faça uma renderização interna e faça
o cache de todos os mapas de textura. Como resultado, todos os mapas de
textura são exportados com o modelo.

Consulte também:

Exportador de arquivos Viz e Max na página 219

Nó Tools

Utilize as configurações neste nó para ajustar as opções para Clash Detective,
Presenter, TimeLiner, Scripter, Animator e o complemento Vault.
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Página Clash Detective

Utilize esta página para ajustar as opções do Clash Detective.

View in Context Zoom Duration (Seconds) Especifica a duração de tempo
que leva para afastar o zoom da vista (utilizando uma transição com animação).

Esta opção é aplicável quando você utiliza a funcionalidade View in Context
na guia Results da janela Clash Detective.

View in Context Pause (Seconds) Especifica a duração de tempo em que o
zoom permanece afastado da vista.

A executar um View in Context, o zoom permanece afastado da vista, desde
que você mantenha o botão pressionado. Se você clicar rapidamente ao invés
de manter o botão pressionado, este valor especifica a duração de tempo em
que o zoom permanece afastado da vista, para que a transição não seja cortada
no meio do fluxo.

Animated Transition Duration (Seconds) Especifica a duração de tempo que
leva para mover entre as vistas.

Quando você clica em uma interferência na grade de resultados da janela
Clash Detective, este valor é utilizado para suavizar as transições da vista
atual para a próxima.

OBSERVAÇÃO Esta opção somente é aplicável quando a caixa de seleção Animate
Transitions é selecionada na guia Results da janela Clash Detective.

Dimming Transparency Utilize o deslizador Dimming Transparency para
especificar o nível de transparência de itens não envolvidos em interferências.

OBSERVAÇÃO Esta opção somente é aplicável quando as caixas de seleção Dim
Other e Transparent Dimming estão selecionadas na guia Results da janela
Clash Detective.

Use Wireframes for Transparent Dimming Quando você seleciona esta
opção, os itens não envolvidos em interferências serão exibidos como estruturas
de arame.

OBSERVAÇÃO Esta opção somente é aplicável quando as caixas de seleção Dim
Other e Transparent Dimming estão selecionadas na guia Results da janela
Clash Detective.

Página TimeLiner

Utilize as opções nesta página para personalizar as opções do TimeLiner.
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Auto Select Attached Items Indica se a seleção de tarefas na janela TimeLiner
automaticamente seleciona objetos anexados na Scene View. Esta caixa de
seleção é selecionada por padrão.

Beginning of Working Day (24h) [Início do dia de trabalho (24h)] Define
o horário de início padrão para o dia de trabalho.

Date Format (Formato de data) Define o padrão de formato de data.

Enable Find (Ativar Localizar) Ativa o comando Find na guiaTasks, que
permite localizar itens de modelo relacionados às tarefas.

OBSERVAÇÃO  Ativar o comando Find pode reduzir o desempenho do Autodesk
Navisworks.

End of Working Day (24h) [Final do dia de trabalho (24h)] Define o horário
final padrão para o dia de trabalho.

Report Data-Source Import Warnings (Avisos do relatório de importação
de origens de dados) Se selecionado, serão exibidas mensagens de aviso se
um problema for encontrado ao importar dados na janela TimeLiner guia
Data Sources.

Show Time (Mostrar horário) Mostra o horário nas colunas de data na guia
Tasks.

Página CSV

Utilize as opções nesta página para personalizar as opções de
importação/exportação de CSV.

CSV File: Read Encoding Especifique o formato do arquivo de texto que será
usado ao importar o arquivo CSV para o TimeLiner. Escolha entre UTF-8
(para o código tradicional de caractere 8-bit) e Multibyte (para conjuntos de
caracteres codificados maiores).

CSV File: Write Encoding Especifique o formato do arquivo de texto que será
usado ao exportar o arquivo CSV para o TimeLiner. Escolha entre UTF-8,
UTF-8 com BOM (marca de ordem de byte) e Multibyte.

OBSERVAÇÃO Os dados são exportados na ordem padrão, sem considerar a
ordem ou a seleção de colunas do TimeLiner.
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Página Presenter

Utilize a configuração nesta página para ajustar as opções do Presenter.

Profile É possível ajustar o Presenter para seu nível de conhecimento.

Selecione entre as seguintes opções:

■ Basic - fornece os recursos básicos do Presenter , com uma funcionalidade
de edição limitada. Esta é a opção padrão.

■ Standard - fornece o acesso à alguns dos recursos avançados do Presenter.

■ Advanced - fornece o acesso aos recursos avançados do Presenter , como
materiais extras, luzes e estilos de renderização.

Smoothed Textures Selecione esta caixa de seleção se você deseja que as
texturas pareçam suaves. Isso leva mais tempo para ser renderizado.

Quando esta caixa de seleção estiver desmarcada, as texturas são renderizadas
mais rápido, mas aparecem em pixels.

Filtered Textures Selecione esta caixa de seleção para ativar o mapeamento
de mip. A utilização desta opção aprimora a aparência de texturas na distância.

Interactive Materials Indica se os materiais do Presenter aplicados são
mostrados durante a navegação. Por padrão, esta caixa de seleção é selecionada.

Quando esta caixa de seleção estiver desmarcada, as texturas não são exibidas
durante a navegação. A utilização desta opção reduz a carga nas placas gráficas
e fornece menos descarte em cenas pesadamente texturizadas. Os materiais
reaparecem automaticamente quando a navegação para, desde que o Autodesk
Navisworks utilize o modo de renderização completa.

Interactive Lighting Indica se as luzes do Presenter aplicadas são mostradas
durante a navegação. Por padrão, esta caixa de seleção é selecionada.

Quando esta caixa de seleção estiver desmarcada, as luzes não são exibidas
durante a navegação. A utilização desta opção reduz a carga nas placas gráficas
e fornece menos descarte em cenas pesadamente iluminadas. As luzes
reaparecem automaticamente quando a navegação para, desde que o Autodesk
Navisworks utilize o modo de iluminação completa.

Max Texture Size Esta opção afeta os detalhes visuais de texturas aplicadas
na geometria. Insira o valor desejado em pixels. Por exemplo, um valor de 128
significa que o tamanho máximo da textura é de 128 pixels x 128 pixels.

Quanto maior o valor, maior a carga em sua placa gráfica, já que mais MB de
memória é necessário para renderizar texturas.
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Max Image Texture Size Especifica o tamanho máximo para imagens de
textura em pixels. Por exemplo, um valor de 256 significa que o tamanho
máximo da textura é de 256 pixels x 256 pixels.

Quanto maior o valor, maior a carga em sua placa gráfica, já que mais MB de
memória é necessário para renderizar texturas.

Max Background Texture Especifica o tamanho máximo para texturas em
segundo plano em pixels. Por exemplo, um valor de 256 significa que o
tamanho máximo da textura é de 256 pixels x 256 pixels.

Quanto maior o valor, maior a carga em sua placa gráfica, já que mais MB de
memória é necessário para renderizar texturas.

Blend Transparent Textures Selecione esta caixa de seleção para utilizar
objetos parcialmente transparentes. Esta opção aprimora a qualidade geral,
mas leva mais tempo para ser renderizada.

Quando esta caixa de seleção está desmarcada, os itens com transparência
maior do que 50%, são tratados como completamente transparentes e não são
renderizados.

Use Texture Anti-Aliasing Indica se a suavização de serrilhado é utilizada
para texturas processuais. A seleção desta caixa de seleção aprimora a qualidade,
mas leva mais tempo para ser renderizada.

Uma textura processual é uma imagem matematicamente gerada, que
representa elementos naturais, como madeira, mármore, granito, metal, pedra,
e assim por diante. No Presenter, as texturas processuais tem ícones de
visualização em estilo de bola.

Hardware Shading Seleciona o sombreamento acelerado por hardware.

OBSERVAÇÃO Esta opção pode ser utilizada em máquinas com uma placa gráfica
compatível com o OpenGL 5.1.

Escolha entre as seguintes opções:

■ Off - desativa o sombreamento acelerado por hardware.

■ Lighting - somente luzes são mostradas.

■ Passive Shadows - as luzes e sombras são desativadas durante a
navegação, e reaparecem automaticamente quando a navegação para.

■ Interactive Shadows - as luzes e sombras são mostradas durante a
navegação.

Hardware Bump Maps Selecione esta caixa de seleção exibir mapas de saliência
de textura durante a navegação. Para utilizar esta opção, ative primeiro
Hardware Shading.
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OBSERVAÇÃO Esta opção pode ser utilizada em máquinas com uma placa gráfica
compatível com o OpenGL 5.1.

Hardware Marble Selecione esta caixa de seleção exibir materiais de mármore
renderizados por hardware durante a navegação. Para utilizar esta opção, ative
primeiro Hardware Shading.

OBSERVAÇÃO Esta opção pode ser utilizada em máquinas com uma placa gráfica
compatível com o OpenGL 5.1.

Página do Vault

Utilize as configurações nesta página para exibir ou ocultar o complemento
do Vault na interface do Autodesk Navisworks.

Show in User Interface Indica se o complemento do Vaulté mostrado na
interface do Autodesk Navisworks. Por padrão, esta caixa de seleção não é
selecionada.

Página Scripter

Utilize as configurações nesta página para personalizar as opções do Scripter.

Message Level Seleciona o conteúdo do arquivo de mensagens.

Escolha entre as seguintes opções:

■ User - o arquivo de mensagens somente contém mensagens do usuário
(ou seja, mensagens geradas por ações de mensagem em scripts).

■ Debug - o arquivo de mensagens contém mensagens do usuário e
mensagens de depuração (ou seja, mensagens geradas internamente pelo
Scripter). A depuração permite visualizar o que está acontecendo em
scripts complexos.

Path to Message File Utilize esta caixa para inserir a localização do arquivo
de mensagens. Caso não exista ainda um arquivo de mensagem, o Autodesk
Navisworks tenta criar um.

OBSERVAÇÃO Não é possível usar variáveis no caminho do arquivo.
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Página Animator

Utilize as configurações nesta página para personalizar as opções do Animator.

Display Manual Entry Indica se a barra Manual Entry é mostrada na janela
Animator. Por padrão, esta caixa de seleção é selecionada.

Caixa de diálogo Publish
Utilize esta caixa de diálogo para ajustar as configurações de segurança para
um arquivo NWD publicado.

Title Exibe o título do documento. O título não precisa ter o mesmo nome
que o nome do arquivo.

Subject Exibe o assunto do documento.

Author Exibe o autor do documento.

Publisher Exibe o publicador do documento.

Published For Exibe as partes para as quais o documento está sendo publicado.

Copyright Exibe informações de direito autoral.

Keywords Lista de palavras-chave que podem ser utilizadas para pesquisar por
este documento.

Comments Exibe informações adicionais sobre o documento.

Password Você pode limitar o acesso à um arquivo NWD ao inserir uma senha
nesta caixa. Você é solicitado à confirmar a senha quando clica em OK.

Agora, qualquer pessoa que deseja abrir este arquivo NWD, precisa digitar a
senha que você especificou.

IMPORTANTE Caso se esqueça da senha, não será possível recuperá-la do arquivo
NWD publicado.

Display at Password Esta caixa de seleção indica se a caixa de diálogo Publish
é mostrada para usuários que estão tentando abrir arquivos NWD protegidos
por senha.

Selecionar esta caixa de seleção fornece aos usuários acesso de somente leitura
às propriedades do documento, permitindo que eles descubram os detalhes
da pessoa a quem podem solicitar uma senha.
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Desmarque esta caixa de seleção se não desejar fornecer informações do
documento aos usuários.

Expires Selecione esta caixa de seleção para definir uma data de expiração
para o arquivo publicado. Isso ativa a caixa Calendar , onde é possível
selecionar a data requerida. Após a data selecionada tiver sido passada, o
arquivo não pode ser aberto.

OBSERVAÇÃO As cópias de avaliação do Autodesk Navisworks Manage 2012
podem publicar arquivos NWD; no entanto, esses arquivos têm a mesma data de
expiração que o software de avaliação. Para remover a data de expiração de um
arquivo NWD criado por uma cópia de avaliação, é preciso republicar novamente
o arquivo com uma licença completa do Autodesk Navisworks Manage 2012.

May be Re-saved Esta caixa de seleção controla se os usuários podem republicar
este arquivo como um NWD.

Se esta caixa de seleção estiver desmarcada, a alterações de revisão feitas no
arquivo publicado somente podem ser salvas como um arquivo NWF.

Display on Open Esta caixa de seleção indica se a caixa de diálogo Publish
é mostrada para usuários assim que eles abrem o arquivo.

Se o arquivo está protegido por senha, a caixa de diálogo é mostrada após os
usuários terem inserido a senha correta.

Embed Textures Selecione esta caixa de seleção se você deseja embutir todas
as texturas no arquivo publicado. Isso permite proteger por senha as texturas,
incluindo quaisquer texturas personalizadas ou importadas.

Por padrão, esta caixa de seleção está desmarcada. Quaisquer superfícies
aplicadas ao arquivo publicado são salvas numa pasta com o mesmo nome
que um arquivo publicado, mas com o sufixo a_Presenter_Maps. A pasta está
na mesma localização que um arquivo publicado.

IMPORTANTE Caso não selecione Embed Textures e tenha a intenção de
compartilhar o arquivo publicado, deve fornecer a pasta relacionada
_Presenter_Maps, com as texturas e a instrução de que o destino para inserir a
pasta é o mesmo local que o do arquivo publicado, assegurando assim, a fidelidade
da visualização.

Embed Database Properties Selecione esta caixa de seleção se você deseja
exibir embutir todas as propriedades através de bancos de dados externos no
arquivo publicado.

Por padrão, esta caixa de seleção está desmarcada, e somente os links do banco
de dados são armazenados no arquivo publicado.
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Prevent Object Property Export Selecione esta caixa de seleção se não deseja
incluir propriedades do objeto que vêm de pacotes CAD nativos no arquivo
publicado. Isso permite proteger propriedade intelectual.

Faixa de opções:  Guia Output ➤  painel Publish ➤  NWD 

Faixa de opções: Botão Application  ➤ Publish
Barra de ferramentas: Interface de usuário clássica:

Standard ➤ Publish
Menu: Interface de usuário clássica: File ➤ Publish

Caixa de diálogo Piranesi EPix
Use esta caixa de diálogo para exportar a vista atual como um arquivo Piranesi
EPix.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

Browse Abre a caixa de diálogo Save As , e permite especificar a localização
e o nome do arquivo para o qual deseja renderizar.

Size
Type Utilize a lista suspensa para especificar como definir o tamanho da
imagem exportada.

Escolha entre:

■ Explicit. Fornece o controle completo da largura e altura (as dimensões
são em pixels).

■ Use Aspect Ratio. Permite especificar a altura. A largura é
automaticamente calculada a partir da relação de aspecto de sua vista atual.

■ Use View. Utiliza a largura e a altura de sua vista atual.

Width Permite inserir a largura em pixels, quando disponível.

Height Permite inserir a altura em pixels, quando disponível.

Anti-Aliasing Esta opção somente se aplica para a renderização OpenGL. A
suavização de serrilhado é utilizada para suavizar as arestas das imagens
exportadas. Selecione o valor apropriado na lista suspensa. Quando maior o
número, mais suave a imagem, mas leva mais tempo para ser exportada. 4x é
adequado para a maioria das situações.
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Faixa de opções:  Guia Output ➤ painel Visuals ➤ Piranesi EPix
Menu: Botão Application  ➤ Export ➤ Images &

Animations ➤ Piranesi EPix

Caixa de diálogo QTVR Object Movie Settings
Utilize esta caixa de diálogo para especificar o número de quadros de pan e o
número de quadros inclinados que são utilizados para exportar o QuickTime
VR object movie.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

Pan Settings

Pan Min e Pan Max  Define a extensão possível de revolução do modelo
(como em uma mesa giratória).

Pan Initial Define de onde você visualiza o modelo no início (novamente,
como em uma mesa giratória, 0 ou 360, seria o mesmo ponto no lado oposto
e 180 seria onde a câmera está agora).

Pan Frame No. O número de quadros a ser utilizado para revolver o modelo
da posição Pan Min  para a posição Pan Max.

Tilt Settings

Tilt Min e Tilt Max  Define a extensão de inclinação do modelo (para atrás
e para adiante de sua posição atual).

Tilt Initial Define onde você visualiza o modelo do início (assumindo que
você esteja olhando reto em direção ao modelo, -90 seria de baixo e 90 seria
de cima).

Tilt Frame No. O número de quadros a ser utilizado para inclinar o modelo
da posição Tilt Min para a posição Tilt Max.

Dispositivo apontador:  Caixa de diálogo Export Rendered
Image ➤ lista suspensa Type ➤ QTVR Object Movie e clique em OK
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Caixa de diálogo Section Plane Settings
Use esta caixa de diálogo para editar configurações de plano de corte.

OBSERVAÇÃO Esta caixa de diálogo somente está disponível para modelos 3D.

É possível definir a visibilidade e alinhamento de cada plano de corte,
selecionar o plano atual, e vincular planos de corte visíveis.
Link Section Planes Permite vincular planos de corte.

Controla a visibilidade do plano de corte correspondente. Quando a caixa
de seleção é selecionada, o efeito do plano de corte fica visível (isto é, ele corta
a cena). Quando a caixa de seleção é desmarcada, o efeito do plano de corte
não fica visível e todos os outros controles para aquele plano são desativados.

Plane O número do plano. Clicar no nome do plano seleciona toda a linha,
e torna o plano selecionado o atual e visível.

Alignment Selecione o alinhamento do plano de corte correspondente de
uma das 9 opções disponíveis. Consulte Personalizar o alinhamento do plano
de corte na página 490.

Clique neste botão para reaplicar um alinhamento de vista, linha ou
superfície.

Faixa de opções:  Guia Sectioning Tools ➤ painel Planes
Settings ➤ inicializador de ferramentas·Section Planes Settings
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Glossário

Glossário de termos técnicos relativos ao Autodesk Navisworks Manage 2012.

Terminologia de exibição

taxa média de quadros Mostra a taxa de quadro medida atual, com a média calculada sobre
o último segundo.

tempo médio de quadros Mostra o tempo decorrido para renderizar o último quadro.

taxa média triangular Mostra a taxa na qual os triângulos estão sendo renderizados e é uma
medida de quão bem sua placa gráfica está funcionando.

seleção A seleção é um processo para determinar itens para que não sejam desenhados durante
a renderização de uma cena. O Autodesk Navisworks cria um nível de seleção priorizada com
o método de descarte na página 883 para renderizar cenas interativas, mas você tem algum
controle sobre os aspectos da seleção, como face traseira e planos de recorte próximo e afastado.

descarte Para manter a interatividade e garantir uma frequência de quadros na página 883
definida pelo usuário, o Autodesk Navisworks somente renderiza o que pode na fração de
segundo que ele tem. O restante é 'descartado' ou não renderizado.

O Autodesk Navisworks prioriza o que é renderizado e o que é descartado, com base no
tamanho da caixa de delimitação do item, distância do visualizador e tamanho na cena,
portanto, somente os itens menos significativos na cena são descartados.

Após a navegação tiver terminada, a cena continua a ser renderizada até que todos itens
estejam visíveis.

taxa de quadro A taxa de quadro é o número de quadros por segundo (FPS) que são
renderizados na janela de navegação principal. O Autodesk Navisworks garante um frequência
de quadros definida pelo usuário para manter a interatividade.

Terminologia de exportação

Estes são termos específicos ao Autodesk Navisworks que são utilizados em relação a exportação.
codec Codec é o acrônimo de "Compression-Decompression" e é um programa que comprime
e descomprime animações ao criar e reproduzir arquivos .avi. Os Codecs são instalados
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independente do Autodesk Navisworks e estão disponíveis quando instalados no sistema
Windows™ , e o mesmo codec que é usado para criar um arquivo AVI é necessário para
reproduzi-lo.

Terminologia de arquivo

arquivos de cache (.nwc) Quando qualquer arquivo nativo do CAD estiver aberto ou
anexado, o Autodesk Navisworks cria um arquivo em cache (.nwc), caso a opção gravar em
cache estiver ativada. Quando o arquivo é aberto ou anexado da próxima vez, o Autodesk
Navisworks irá ler os dados do arquivo de cache correspondente em vez de reconverter os
dados originais se o cache for mais novo do que o arquivo original. Se o arquivo original
for alterado, o Autodesk Navisworks irá recriar o arquivo de cache da próxima vez que for
carregado. Os arquivos de cache aceleram o acesso aos arquivos de uso comum. Eles são
particularmente úteis para modelos compostos de muitos arquivos, entre os quais apenas
alguns são modificados entre as sessões de visualização. Os arquivos de cache também podem
ser exportados de alguns aplicativos de CAD onde um leitor de arquivo nativo não está
disponível com o Autodesk Navisworks. As opções em cache podem ser editadas no Options

Editor (botão do aplicativo  ➤  Options  ➤  nó Model).

referências externas Referências externas (algumas vezes chamados arquivos de referência
ou "Refexs") são mostrados no Autodesk NavisworksSelection Tree como um grupo inserido.
O Autodesk Navisworks procura por arquivos externamente referenciados no mesmo lugar
que o AutoCAD ou o MicroStation iria procurar.

Se a caixa de diálogo Unresolved XRef for mostrada, então este link foi de alguma forma
quebrada e os arquivos referenciados precisam ser realocados para onde o AutoCAD ou
MicroStation espera que estejam.

Se estas XRefs não são importantes para a sessão atual, então você pode selecionar Ignore
para ignorar a referência e o arquivo será carregado sem aquela XRef inserida. De forma
similar, Ignore All irá carregar o arquivo sem nenhuma XRef não solucionada.

Também é possível personalizar as opções para os arquivos leitores DWG/DXF e DGN no
Options Editor para definir se as referências externas foram carregadas ou não. Isso lhe
fornece um maior controle sobre a anexação de arquivo no Autodesk Navisworks.

fator para facetar Durante uma exportação do pacote do CAD para o formato NWC, ou
enquanto o Autodesk Navisworks estiver lendo um arquivo CAD nativo, devem ser tomadas
decisões de como superfícies curvas serão reduzidas à facetas planas. Para a maioria dos
aplicativos e formatos de arquivos, você tem o controle sobre o nível de facetas que acontece.

Todos os itens, não importando seu tamanho, irão utilizar o mesmo fator para facetar e,
portanto,têm o mesmo número de lados para entidades curvadas. Portanto, você precisa
experimentar um pouco com diferentes valores para levar em conta o tamanho em que estes
itens irão aparecer na tela.
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O fator para facetar precisa ser maior ou igual a 0, onde 0 resulta na desativação do fator
para facetar. O valor padrão é 1, e se você dobra o valor terá o dobro de número de facetas,
e se divide o valor irá obter a metade de facetas. Fatores para facetar maiores resultarão em
mais polígonos para um modelo e arquivos maiores do Autodesk Navisworks. Não faz muito
sentido ter uma fator de faceta grande, se estas entidades curvadas são bolas de golfe
visualizadas de 200 jardas!

Para exportações do AutoCAD, o fator para facetar é definido com o comando NWCOPT.
O fator de facetar do MicroStation é definido no Options, que está disponível na caixa de
diálogo de exportação NWCOUT. Para definir o fator de facetamento em arquivos de leitura

do CAD, vá em Options Editor (clique em  ➤ Options, amplie o nó File Readers
e escolha a página pertinente do leitor do arquivo).

desvio máximo da faceta O desvio máximo da faceta é utilizado em conjunto com o fator
para facetar, para assegurar que objetos maiores, com um desvio muito grande do original,
tenham facetas adicionais adicionadas. Se uma diferença maior do que o valor inserido for
encontrada em um modelo, ele adiciona mais facetas. Os valores são medidos nas unidades
do modelo.

Onde "d" for maior que o valor de desvio máximo de facetamento, mais facetas serão
adicionadas ao projeto.

Se o desvio máximo de faceta for definido como 0, estão esta função é ignorada e apenas o
fator para facetar é utilizado.

arquivos de dados publicados (NWD) Os arquivos NWD publicados são úteis ao se desejar
obter um instantâneo do modelo em determinado momento. Toda a informação de geometria
e revisão é salva nos arquivos NWD, não podendo assim ser alterada. Os arquivos NWD
publicados também podem conter informações sobre o arquivo, assim como são capazes de
serem protegidos por senha e marcados no tempo para fins de segurança. Estes arquivos são
também bem pequenos, comprimindo os dados de CAD em até 80% de seu tamanho original.
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Os arquivos NWD publicados são úteis ao emitir modelos para a visualização com o
visualizador grátis Autodesk Navisworks Freedom 2012, assim como podem ser anexados
no Autodesk Navisworks para construir uma cena maior.

arquivos revisados (NWF) Os arquivos de revisão são úteis ao utilizar os arquivos CAD
nativos anexados ao Autodesk Navisworks. Eles armazenam a localização dos arquivos
anexados, junto com quaisquer revisões do projeto feitas no Autodesk Navisworks, como
comentários, linhas de marcação, pontos de vista, animações e assim por diante.

Se um grupo de arquivos é anexado a uma cena do Autodesk Navisworks e salvo como um
arquivo NWF, então, ao reabrir este arquivo NWF mais tarde, uma vez que os arquivos
originais do CAD tenham sido alterados, os arquivos atualizados do CAD serão carregados
na cena para revisão.

limite de mescla de forma As formas do MicroStation são polígonos que podem ter 3 ou
mais vértices. Elas são usadas com frequência para modelar objetos mais complexos, os quais
podem desperdiçar memória. Assim, o Autodesk Navisworks funde todas as formas no mesmo
nível ou na mesma célula com a mesma cor em um "Conjunto de formas", caso estas formas
tenham menos vértices ou um número igual de vértices dados pela Shape Merge
Threshold.

Terminologia de seleção

Estes são termos específicos ao Autodesk Navisworks que são utilizados em relação a seleção
de itens.
objetos compostos Um objeto composto é um grupo de geometrias que é considerado um
objeto único na árvore de seleção. Por exemplo, um objeto de janela pode ser comporta de
uma esquadria e um painel. Se um objeto composto, o objeto de janela seria a esquadria e
o painel e seriam selecionados todos de uma só vez.

instâncias Uma instância é um objeto único, que é referido diversas vezes em um modelo,
por exemplo uma árvore. Isso tem a vantagem de cortar o tamanho do arquivo ao não repetir
desnecessariamente um objeto.

nome do item O identificador atribuído ao CAD original ou ao Autodesk Navisworks.
Qualquer item podem ter um nome e este nome normalmente cem do pacote de CAD
original no qual o modelo foi criado.

tipo de item Cada item no Autodesk Navisworks tem um tipo. Exemplos de tipos são os
arquivos de referência, as camadas, as instâncias (algumas vezes chamadas de inserção), e
os grupos. Cada pacote CAD possui também um número de tipos de geometria, por exemplo,
polígonos, sólidos 3D, e assim por diante.

resolução de seleção A resolução de seleção é o nível na árvore de seleção no qual você
começa a selecionar. É possível percorrer itens na árvore ao manter pressionada a tecla SHIFT
durante uma seleção.
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nome do usuário e nome interno Cada categoria e nome de propriedade tem duas partes
- uma sequência de usuário visível que está localizada e uma sequência interna que não está
e é usada principalmente pelo API. Por padrão, ao coincidir nomes nas caixas de diálogo
Smart Tags  e Find Items , ambas as partes precisam ser as mesmas, mas você pode utilizar
identificadores para coincidir somente uma parte. Você pode utilizar Ignore User Name
se desejar coincidir algo sem relação com a versão localizada que está sendo utilizada.

Terminologia do ponto de vista

velocidade angular A velocidade na qual a câmera se move ao virar para a direita e esquerda
em qualquer modo de navegação.

suavização de serrilhado A suavização de serrilhado aprimora a qualidade da imagem ao
suavizar a aparência da aresta com desvio de linhas afiadas. 2x para 64x se refere ao número
extra de quadros que são necessários para o processo de suavização de serrilhado. Quanto
maior o número de quadros, mais fino o efeito (com o consequente aumento no tempo de
renderização).

relação de aspecto A relação de aspecto é a proporção do tamanho dos eixo X e Y. Por
exemplo, ao exportar um bitmap de um ponto de vista, manter a relação de aspecto iria
manter a proporção da vista, mesmo se o número de pixels fosse diferente.

centrado na câmera Os modos de navegação nos quais a câmera é movida em torno do
modelo.

campo de visão O campo de visão da câmera é o ângulo que a câmera pode ver. Um campo
e visão largo irá caber mais na vista, mas parecerá distorcido, e um campo de visão pequeno
terá a tendência de tornar a vista mais plana, tendendo em direção de uma vista ortogonal.
Há dois campos de visão no Autodesk Navisworks - vertical e horizontal. A edição de um
deles alterará o outro e os dois estão relacionados pela relação de aspecto na página 887 do
ponto de vista.

ponto focal O ponto focal é a posição no espaço 3D no qual a câmera irá rotacionar em
torno ou aproximar o zoom nos modos de examinar, orbitar, mesa giratória e zoom.

centrado no modelo Os modos de navegação nos quais o modelo é movido em frente da
câmera.

rolagem A rolagem da câmera é seu ângulo em torno do eixo de visualização. Este não pode
ser editado em um modo de navegação onde o vetor acima universal fica de pé (navegar,
orbitar e mesa giratória).

atributos salvos Cada ponto de visão pode opcionalmente salvar o estado dos seus itens
ocultos e "exigidos", assim como qualquer substituição de material (cor e transparência).
Então, ao chamar novamente o ponto e visão, estes itens são novamente ocultos, tornados
novamente requeridos, e os materiais são recolocados. Isso pode ser útil na criação de
animações ao arrastar em pontos de vista em uma animação vazia.
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ângulo de inclinação Isto é indicado nas unidades de cena abaixo (negativa) ou acima
(positiva) horizontal (0) na base da janela Tilt.

vetor acima do ponto de vista A direção que o Autodesk Navisworks considera "para cima"
é chamada de "vetor para cima do ponto de vista". Esta é mantida nos modos de navegação,
órbita e de mesa giratória. Este pode ser também referido como "vetor mundial para cima".

Terminologia do Clash Detective

status da interferência Cada interferência tem seu status atual associado com a mesma, e
cada status tem um ícone colorido para identificá-lo. Este status pode ser atualizado
automaticamente pelo Clash Detective ou pode ser manualmente sobreposto se desejado.
Os status são como segue:

New - uma interferência encontrada pela primeira vez na execução atual do teste.

Active - uma interferência encontra em uma execução anterior do teste e não solucionada.

Reviewed - uma interferência anteriormente encontrada e marcada por alguma pessoa
como revisada.

Approved - uma interferência anteriormente encontrada e aprovada por alguma pessoa.

Resolved - uma interferência encontrada em uma execução anterior do teste e não na
execução atual do teste. Portanto, assume-se que tenha sido solucionada.

Se o status mudou para Approved, o Clash Detective seleciona o usuário no momento
conectado como a pessoa que aprovou a interferência.

A ativação de hiperlinks irá mostrar os resultados de interferência utilizando o ícone de

status relevante  .

status do teste de interferência Um teste de interferência pode ter um de quatro status:

New indica um teste de interferência que ainda não foi executado no modelo atual.

Done indica um teste de interferência que foi executado com êxito na última versão do
modelo.

Old indica um teste de interferência que foi de certa forma alterado desde que foi definido.
Isso pode incluir a alteração de uma opção ou por ter sido carregada a revisão mais recente
do modelo.

OBSERVAÇÃO Os status de interferência individual ainda podem ser editados em um teste de
interferência com um status Old.

Partial indica um teste de interferência que foi interrompido durante a execução. Os
resultados estão disponíveis até o ponto da interrupção.

interferência de espaço livre Uma interferência na qual a geometria do item 1 pode ou
não efetuar a intersecção com a geometria do item 2, mas está em uma distância menor do
que a tolerância na página 889 definida.
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interferência duplicada Uma interferência na qual a geometria do item 1 é a mesma da
geometria do item 2, localizada dentro da distância entre zero e a tolerância na página 889
definida. Uma tolerância de zero iria, portanto, somente detectar geometria duplicada
exatamente na mesma localização.

interferência aguda Uma interferência na qual a geometria do item 1 efetua interseção com
a geometria do item 2 por uma distância maior do que a tolerância na página 889 definida.

método de intersecção Um tipo de teste de interferência Aguda padrão aplica o Método
de intersecção normal, que configura o teste de interferência para verificar se há
intersecções entre qualquer um dos triângulos que definem os dois itens sendo testados
(lembre-se de que toda a geometria do Autodesk Navisworks é composta de triângulos). Isso
pode não detectar as interferências entre itens onde nenhum dos triângulo efetuam a
intersecção. Por exemplo, dois tubos que estão exatamente em paralelo e que se sobrepõem
ligeiramente em sua extremidades. Os tubos efetuam a intersecção, mas nenhum dos
triângulos que definem sua geometria o fazem e, portanto, esta interferência não seria
detectada utilizando o tipo de teste de interferência Aguda padrão. No entanto, escolhendo
Aguda (Conservadora) reporta todos os pares de itens, que podem ter interferência. Isso
pode fornecer positivos falsos nos resultados, mas é um método de detecção de interferência
mais preciso e seguro.

gravidade Para interferências agudas, a gravidade da interferência depende da intersecção
dos dois itens que efetuam a intersecção. As interferências agudas são registradas como uma
distância negativa. Quando mais negativa a distância, mais grave a interferência. A gravidade
da interferência aguda depende se o Método de intersecçãoConservador ou Normal
foi aplicado (consulte método de intersecção na página 889 para obter mais detalhes). Se
Normal, a maior penetração entre um par de triângulos é medida. Se Conservador, a
maior penetração do espaço em torno de um item no espaço em torno do outro é medida.

Para interferências de obstrução, a gravidade depende de quão perto um item invade a
distância requerida em torno do segundo item. Por exemplo, um item vindo dentre 3mm
é mais grave de que um item vindo dentre 5mm do outro item.

Para interferências duplicadas, a gravidade depende de quão perto um item esta perto do
outro item. Quando distância entre eles for zero, é mais provável que isto seja uma geometria
duplicada, onde quando os itens estão mais distantes um do outro, mais provável que sejam
objetos diferentes e, portanto, têm um menor gravidade.

tolerância Tolerance controla a severidade das interferências reportada e a habilidade de
filtrar interferências insignificantes, que podem ser assumidas para serem contornadas no
site. Tolerance é utilizado para os tipos de teste de interferência aguda na página 889,
interferência de espaço livre na página 888 e interferência duplicada na página 889. Qualquer
interferência encontrada que esteja dentro desta tolerância será reportada, mas as
interferências fora desta tolerância serão ignoradas. Portanto, para uma interferência Aguda,
uma interferência com uma gravidade na página 889 entre zero e o valor da tolerância será
ignorada, mas para as interferências de Espaço livre, uma interferência com uma gravidade
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maior do que o valor da tolerância será ignorada, já que está mais distante do que a distância
requerida. De uma forma similar, uma interferência Duplicate com a severidade de mais
de um valor de tolerância será ignorada como é susceptível de ser uma separada, embora
sendo peça idêntica de geometria.
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